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1 SAP Oil & Gas (PRA - Production and 
Revenue Accounting) 

This product is subject to a separate license from SAP which may involve additional costs. For more 
information, please contact your SAP account manager.
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2 Ownership 

Purpose

Ownership is an ownership management component designed to manage division order interests for 
producing properties and operating interests (gross working interests) for both producing and non-producing 
properties. Ownership is used to create the master data used throughout PRA. It provides a single source for 
ownership to support Revenue Distribution. SAP JVA is designed to manage joint interest billing. The SAP 
components are integrated and share both ventures and cost center assignments for linking revenues and 
expenses for custom or SAP-specific corporate reporting.

Ownership supports date-sensitive tracking of ownership, including a complete online ownership history, and 
the ability to link burden groups to specific working interest owners. It can also track unit property information.

It also includes mass data change processes that make possible changes across multiple division orders. The 
ownership transfer, provision change, suspend/suspense release owners, and division order approval are 
examples of mass change processes.

The ownership transfer process (see: Ownership Transfers (Transfer Requests) [page 46] ) in PRA can handle 
various scenarios of ownership change. It can be used to transfer interest from one owner to other owners. It 
creates a history for old owners, and handles burden group transfer automatically for the source and 
destination owners. It can also combine the owners based on combine criteria to allow division order 
consolidation. The combine process allows for an online simulation and review to reduce situations where 
ownership cannot combine automatically and allow you to adjust the combinability criteria as needed.

Ownership is integrated with the accounting processes necessary to transfer funds from suspense to pay, and 
from pay to suspense based on owner interest transfer requests and changes, or by direct funds-only transfer 
requests.

Ownership is integrated with all SAP PRA components, and as such, generates prior period notifications 
(PPNs) for changes that impact both Valuation and Contract Allocation processes, including automatic 
updates of marketing group changes, when necessary.

Ownership works on the concept of ‘checking out’ DOIs for maintenance, and ‘checking in’ DOIs for updating 
the data in the processing stream (see: DOI Check-In and Check-Out [page 27] ). That process controls when 
maintenance can be applied to the system without impacting work in progress from the other components.

The component also allows for a correction process outside of transferring ownership. This process can 
become vital to fix errors without impacting chain of title records or owner payments based on current 
ownership.

Ownership also contains functionality for:

● Linking well completions and measurement points to division orders (see: Creating a DOI to MP/WC Cross-
Reference [page 64] ).

● Maintaining DOI revenue accounting rules (see: Defining Tax and Revenue Attributes for a DOI (DOI 
Accounting) [page 45] ).

● Managing production payment balances ( Maintaining Production Payment Information [page 42]
● Reviewing owner suspended balances (legal suspense balances, see: Displaying Outstanding Summary 

(Legal Suspense) Balances [page 41] ).
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2.1 Creating a Business Associate (PRA Owner) 

Use

Use this to create a business associate in PRA.

In PRA, you create owners as master records to represent owners in divisions of interest (DOIs), who will 
receive revenue in subsequent revenue processes in PRA. An owner master record in PRA consists of a 
business associate (BA) record linked to a vendor record from SAP Core.

In order to create an owner, it is thus necessary to create a business associate, and link the BA to a vendor, or 
create a BA and also create a vendor in Core. Every owner that you create or use in PRA has to be linked to a 
business associate record and a vendor.

The main reason that you use vendors from Core is that when you set up an owner in PRA, you will need some 
of the attributes attached to that vendor in Core, which will not exist in Ownership. So for the overall attributes 
of the owner, some come from the Core vendor attributes, and some you set up in the BA record when you 
create it here. The BA type identifies the type of owner (working interest, royalty interest, etc.) that you are 
creating.

The graphic below illustrates the link between business associate and Core vendor.
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In ownership, you will almost always link business associates (owners) to Core vendors. Outside of Ownership 
in PRA, it is possible to use Core customers instead of vendors (see the table below for a list of which entities 
are vendors and which are customers in the system). Customers can represent third parties, with whom 
Upstream companies trade and do business. These third parties – sometimes referred to as “partners” in the 
industry – can also be set up in the system as business associates. For example, you could do business with a 
transporter or shipper, and set up the transporter or shipper in the system as a customer in Core (and an 
owner in PRA).

From a PRA point of view:

In Ownership: Core Vendors are used to represent owners.

In PRA, outside of Ownership: Customers can be used. They can be: marketing representatives, transporters, 
or operators.

After the BA master record is created, it can then be used by the PRA Ownership, Revenue Distribution, Journal 
Entry, Check Input, and tax applications of SAP PRA. The entity type that you define (on the BA Overview 
Screen) is used by the system for tax computations. BA residence information identifies where the business 
associate is located. Resident country and region are used for non-resident tax calculations.

The specific BA type is chosen to reflect the business situation that the owner is in. It determines whether that 
BA record is to be linked with a vendor or a customer record (see the table below). In choosing a BA type, you 
thus choose a BA type that reflects the relation your company has to the business associate. For example, if the 
business associate that you want to create is a working interest owner in the DOI, you would select “working 
interest” (WI) as the BA type, and “V” (for vendor) for the vendor/customer.

It is no longer a requirement in PRA that you create a Core vendor (or customer) at the same time as you create 
a business associate. It is now possible to create a business associate, and then link it to an already-existing 
vendor record (on the BA creation screen, the Link BA to Master Record screen tab is used for that).

Once you have created a business associate record, you should not attempt to change the vendor that is linked 
to that BA from within the Core SAP vendor master transaction. Doing that could result in inconsistencies 
between the BA data and the Core data. Always maintain BA-related core master data through the BA 
application.

 

The table below shows the BA types and whether each BA type links to a vendor or to a customer in SAP Core:

Table 1:

BA type BA Type Description Vendor/customer (in Core)

BI Billing interest C (Customer)
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BA type BA Type Description Vendor/customer (in Core)

CI Carried interest V (Vendor)

OI Non-working interest V

OP Operator C

PR Purchaser C

RM Remitter C

SH Shipper V

SL Seller C

TA Taxing authority V

TR Transporter V

WI Working interest V

The BA Type options above are delivered by SAP as a standard part of PRA Ownership customizing. However, 
you can add your own BA Types to this list in Customizing. To do that, in the IMG, select Industry Solution Oil & 
Gas (PRA) à Ownership à Business Associate à Business Associate Types

Procedure

1. At the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Ownership Business 
Associate .

The Business Associate: Initial Screen is displayed.

There are two ways that you can now proceed:

1. Create a business associate ‘from scratch’:

Select Create and then begin entering your BA master data (for descriptions of the screen tabs, please see the 
table below), or

1. Create a business associate with reference:

You can create a BA that references an already-existing BA record. To reference existing data: in the Parameters 
screen area, enter data and then select Execute , and use the results of your search as a worklist. For example, 
you could enter the company code and run your search, and then use all the records that are displayed after 
you select Execute as a worklist from which to create a new BA master record. If you decide to do that, to select 
a record, double-click one record from the ALV list after selecting Execute . The system will take you back to the 
Business Associate: Initial Screen . From there, proceed as follows:
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On the Business Associate: Initial Screen , at the top of the screen, enter the header data for the BA record: 
Business Associate ID , a sequence number (used to further break down BAs into additional records – 
representing separate ownership interest situations – such as one for carried interest owner, and one for 
royalty interest owner, for example), whether the record is to be a vendor or customer in Core (choose vendor 
for Ownership situations), and the relevant company code that the BA is to be assigned to.

On the Business Associate – Create screen, there are several screen tabs. They are used to do the following:

 

Table 2:

General data As the tab suggests, General Data contains general, header-level data on the BA, such as address and entity 
type. Enter the business associate type (what type of owner you would like the BA to be), the entity type (used for tax pur­
poses), the country and region in which the business associate is located, and whether the BA is in escheat or not.

Escheat is a situation in which there is no owner, and the property then reverts to the government. For escheat, enter Y = 
yes (this business associate is in escheat), N = no (this business associate is not in escheat), or S = Owner has been proc­
essed after having been in escheat, and the relevant date if the owner is in escheat.

 

Payment data Onthis screen tab, you enter payment master data for the business associate. For vendor BAs, if the entity 
type is “U.S. Indian” or “Taxable U.S. Indian”, the Allottee payment method field will dynamically appear on the Payment 
data screen (but if the entity type is not one of those Indian entity types, that field will not be displayed).

 

Address data This screen tab is for display use only. The data that appears here is based on the BA that you chose, and will 
be defaulted from that BA record. The address data is maintained for the vendor in Core. You can view the address data 
here, but you cannot make any changes to it (you would have to go into Core for the vendor in order to make changes).

 

Alternate addresses (only available in change/display mode) – One requirement is to be able to store more than one ad­
dress type per business associate, to be used in specific reporting situations. In some business situations, sending docu­
ments to an alternate address is required.

On the BA screen, there is a main address that is usually used for the BA. The main address is pulled from the Core record 
by the system, to be used in Checkwrite, for example. The alternate addresses, when entered, are used by various reporting 
programs. The goal is to be able to send a report to an address other than the main address on the BA screen.

It is now possible to do that. Within the BA change mode, there is an Alternate Addresses screen tab. You can use this to 
create multiple different address types for your business associate, to be used in situations in which you want to use differ-
ent addresses from the defaulted one.

On the Business Associate: Change screen, you select the drop-down list for Address type and choose one (example: 
Balancing ). Next, in the icon on the right, select it and maintain the actual address, and save it.
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Link BA to Master Record You can use this screen tab to link your business associate record to a Core vendor record (in rare 
cases: to a Core customer record).

There are two options on this screen tab:

Option A

Create a new vendor (or customer).

The system displays a vendor/customer master creation dialog box.

You then enter vendor data that you would like to create.

The system then takes you to Core maintenance for the vendor/customer. You maintain either customer or vendor, and 
save the record.

That saves the record so that you now have two records: an oil BA master record, and a Core vendor master record.

Option B

Assign an already-existing Core vendor (or customer) master record to the BA.

Select the Assign existing vendor to the BA pushbutton.

Then, in the Customer (or Vendor) field (the field changes dynamically, depending on what you are working with: customer 
or vendor), enter a customer or vendor.

Now select Assign .

The system will, at this point, carry out validations to make sure that the data is allowed. The Save icon will now appear 
active on the screen.

Choose Save to save the record.

That saves the business associate record and links it to the vendor or customer record in Core.

 

Result

A business associate record is created, with reference to a vendor (or customer).

2.2 Joint Venture 

A joint venture (JV) is an association of two or more parties formed to diversify risks, achieve operational 
efficiencies, and share in costs and revenues.Sharing is proportional according to each party’s interest in the 
venture.Each cost object that is used to post joint venture accounting expenses must be assigned to a single 
joint venture.

In PRA-Ownership, you create ventures as “extensions“ of JVA joint ventures. If you do not have Joint Venture 
Accounting installed and active, you can, however, still create ventures in PRA (see: Setting Up JVA Master Data 
for Non-JVA Systems [page 20] ).
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See also:

Creating a PRA Venture [page 23]

2.2.1  Setting Up JVA Master Data for Non-JVA Systems 

Purpose

The usual process for creating a venture in PRA-Ownership is as follows:

Step 1 – You create a joint venture in JVA (in a JVA system)

Step 2 – In PRA-Ownership, you set up the venture, as an ‘extension’ to the joint venture (see: Creating a PRA 
Venture [page 23] ).

Usually, you set up joint ventures (“ventures”) in the Joint Venture Acounting JVA system, within the Joint 
Venture Master: Initial screen. This entails creating a master data object called the joint venture, with the 
following attributes: venture type, venture class, joint operating agreement (JOA) assignment, description, and 
posting method. The attributes define what kind of venture it is, for example, for revenue and tax purposes. The 
venture type can be one of the following: operated – tax, operated – non-tax, non-operated, and non-operated 
on billing.

You can also create master data for a group of business partners – as an equity group, which operates the 
(joint) venture. That is the usual way to create a joint venture in the system, when you are using Joint Venture 
Accounting (you have JVA installed and activated). After the joint venture has been set up in JVA, you can then 
create a joint venture extension in Ownership – which is called a venture.

However, you might want to create a venture, but you do not have JVA installed and activated. You thus cannot 
carry out the first step, detailed above, which is necessary.

This process is designed to re-create that first step, in situations in which you do not have JVA. It allows you to 
create the required master data for venture creation.

Prerequisites

This process is only to be used if you do not have access to a JVA system – in other words, JVA is not installed, 
and also not activated.
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Process Flow

To recreate the JVA-step (Step 1 mentioned above, in which you create a joint venture), specifically, you:

Assign operators to the relevant JVA company code (see: Assigning an Operator to a JVA Company Code [page 
21] ).

Assign partners (“customers”) to the company code (see: Assigning a Partner to a JVA Company Code [page 
22] ).

Create all the relevant attributes for the venture (see: Creating Venture Attributes for JVA [page 23] ).

Result

A joint venture is created, and you can now create a venture in PRA-Ownership (to continue on to the create a 
venture, please refer to: Creating a PRA Venture [page 23] ).

2.2.1.1 Assigning an Operator to a JVA Company Code 

Use

Use this to assign an operator to a JVA company code, for venture creation in situations in which you do not 
have access to a JVA system (see: Setting Up JVA Master Data for Non-JVA Systems [page 20] ).

You can also use this to define a JVA company code in your system.

Prerequisites

You want to create a venture in PRA-Ownership, but you do not have a JVA system installed and activated.

Procedure

From the SAP Easy Access menu, choose Logistics à Production and Revenue Accounting à Ownership à Master 
Data Setup for Non-JVA Systems à PRA JVA Companies

The PRA JVA Companies: Maintenance screen is displayed.

Enter the relevant company code.
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Select Create .

The PRA JVA Companies: Create screen is displayed.

On that screen, you assign an operator (customer) to the company code.

Save your record by choosing Save.

There is an icon, List Entries , on the initial screen, which you can use to list and view the operators per 
company code. The list also has complex display functionality. Select List Entries and then New Field Selection .

Result

The operator is linked to the company code.

2.2.1.2 Assigning a Partner to a JVA Company Code 

Use

Use this to assign a partner to a JVA company code.

In the JVA (Joint Venture Accounting) system, partners are customers. Partners are assigned at the company 
code level. It is also used to assign a venture and specify the venture type: operated, or non-operated.

Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Ownership → 
Master Data Setupfor Non-JVA Systems → PRA Partner Table from JV.
The PRA Partner Table from JV screen is displayed.

2. Enter the relevant company code, and a customer (partner). The customer is a business associate (owner).
3. Select Create .
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2.2.1.3 Creating Venture Attributes for JVA 

Use

Use this to create the relevant JVA venture attibutes for the venture.

This step provides the attributes for the JVA venture, so that the venture is complete. You can provide, among 
other things, the following venture attributes:

● Venture type
● Venture class
● Block joint venture for cutback and billing (flag)

After you have created the attributes, the venture can be maintained.

Procedure

● At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Ownership → 
Master Data Set-up for Non-JVA Systems → PRA Joint Venture Master Data .

The Change View Venture Maintenance (Company Code activation): Overview screen is displayed.

● On this screen, you can define the attributes for the venture. Per company code and venture, you can 
define the following: venture type, venture class, operator ID, and whether the venture is to be blocked for 
cutback and billing.

Result

The attributes for your joint venture now have been set up. The attributes define how the venture will be 
handled, from a revenue point of view. After this step, you can create the venture in PRA (see: Creating a PRA 
Venture [page 23] ).

2.3 Creating a PRA Venture

Use

Use this transaction to create master data for a PRA venture, which represents a property with one or several 
leases. The PRA venture is an extension of the joint venture record set up in joint venture accounting.
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When you create a PRA venture, you will have to define the following venture attributes for the venture (each 
one of these corresponds with a screen tab on the PRA venture maintenance screen):

Table 3:

General General information on the type of venture, and revenue-
related attributes for the venture.

Location Information on the geographical location of the venture 
(country, state, and whether the venture is located onshore 
or offshore).

Legal description Information on the surveying method used for that DOI.

Acquisition information Information on when a venture was acquired, sold, etc., and 
the parties involved

Unit venture If the venture is a PRA Unit Venture [page 54] , you specify 
the applicable combined product codes.

Creating a PRA venture does NOT create a new venture in the system, rather, it is an extension of the joint 
venture that has already been created in the SAP Joint Venture Accounting system.

You cannot delete ventures in PRA, due to that link.

Procedure

1. At the SAP Easy Access screen, choose Logistics  Production and Revenue Accounting  Ownership 
 Venture  Create  .

The Create Joint Venture Maintenance: Initial Screen is displayed.
2. Enter a joint venture and company code (or you can create one with reference).
3. Choose Enter .
4. The Create Joint Venture Maintenance: Overview Screen is displayed.
5. Enter a short description of the venture.
6. Within the General screen tab, enter the following required data:

○ The interest code (specifying who receives interest from the venture), the usage type (how the venture 
is being used), the status of the venture (active, non-producing, sold, etc.), as well as the status 
effective date (the date on which the status that you listed is to be active).

○ Field ID (optional), which will appear in the Schedule A Reports (if entered here) – (for more 
information on that see: Generating a DOI Schedule A Report [page 61] ).

○ If the venture that you are creating is a PRA Unit Venture [page 54] , set the Unit venture flag. Set the 
DOI by tract flag to indicate whether ownership and the resulting revenue disbursement for the unit 
that is being set up is under one division order, or under multiple division orders – that is, one for each 
tract in the unit.

○ DOI Print Flag – Set this if you want the DOI name, instead of the venture name, to be printed on 
checks.

1. Select the Location screen tab, and enter the relevant data. This defines what state and region the venture 
is in, and whether the venture is an onshore or offshore venture.

24 C U S T O M E R
SAP Oil & Gas (PRA - Production and Revenue Accounting)

Ownership 



2. Select the Acquisitions tab. Note that the acquired from party, and the sold-to party have to be valid 
customers in the SAP System.

  

1. Legal description – You can only access the Legal Description screen tab if you have already entered a legal 
description on the General screen tab. Based on the legal description type that you enter, the system 
displays a list of legal description fields, for which you enter data in the Value column. The unit of measure 
is also displayed.

2. Unit Venture screen tab – In order to be able to select this, both the Unit venture flag, as well as the DOI by 
tract flags have to already be set on the General screen tab. Select the Unit venture screen tab. Within that 
screen tab, select the applicable combined product codes for the unit venture.

You can also create a long text description for the venture that you are creating. To do that, from the screen that 
you are on ( Create Joint Venture Maintenance: Overview Screen ), select Edit → Long Text .

Save the PRA venture.

More Information

Joint venture [page 19]

2.3.1  Creating a Base Division of Interest 

Use

Use this transaction to create a base division of interest (base DOI).

A base division of interest is a master record for a division of interest, that represents an ownership group 
within a venture. You can maintain details about the base division of interest as well.

Creating a base DOI entails specifying the following attributes, under the following areas (screen tabs):

● General – DOI attributes and location information (where the DOI is geographically located)
● Legal description – the surveying method used for the base DOI.

Creating a DOI by reference gives you the ability to copy the ownership information from the referenced DOI. 
You can do that here by selecting a source DOI.

A new DOI is automatically pre-set in the system to “checked out“ and“not approved“. Approval and check-in 
brings the owners and burdens into the system area, deletes the data from the work area, and performs the 
requisite edits and validations (see also: DOI Check-In and Check-Out [page 28] ).

Prerequisites

The company/venture must already be set up in PRA, before you can set it up here.
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Procedure

1. At the SAP Easy Access screen, choose Logistics  Production and Revenue Accounting Ownership 
Base DOI  Create  .

2. The Create Base DOI Maintenance: Initial Screen is displayed.
3. Enter the relevant Joint Venture, DOI number, and company code (or you can create one with reference), 

and choose Enter .

The Create Base DOI Maintenance: Overview screen is displayed.

1. Enter a description of the base DOI.
2. On the General screen tab: select either < permanent> or < temporary> as the DOI type (this is only for 

informational purposes for your later reference, it does not affect how PRA processes the DOI. As a rule, 
select permanent), a DOI start and end date, and combined product code, which represents the type of 
product(s) that the DOI produces. Also, enter a location (the country and primary geographic location is 
then defaulted from the venture master).

3. On the Legal Description screen tab, enter a legal description type for the DOI. In legal documents for 
divisions of interest (the actual paper documents used to define DOIs for legal purposes), there is often a 
legal description, which describes the surveying method used for that DOI. For example, a land title might 
have a legal description contained in it, called "metes and bounds", or "longitude and latitude". In the 
system, legal descriptions are grouped into legal description types. You choose one of the legal description 
types from the drop down list box, that represents the legal description in the legal document. You can 
enter a long text free-form description at the bottom of the screen, to better describe the legal description.

1. Legal description screen tab:
The legal description type that you selected on the General screen tab will be defaulted into the Legal 
Description Type field.
Based on the legal description type, there will be various entries in the Field column, for which you maintain 
entries in the Value column.
You can also enter a unit of measure and a long text for each entry.
To display the legal description, select Preview legal description .

2. Save your base DOI record.

Result

The base DOI is saved in checked out status.Once owners are maintained for the base DOI, the status changes 
from checked out to checked in and approved .
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2.3.1.1 DOI Check-In and Check-Out

Purpose

In Ownership, divisions of interest are checked in and checked out. The reason for doing that is the following:

● Check-out : In order to make changes to a DOI that is already created, you have to check the DOI out. 
Check – out copies the data from the check-in area to the check – out area (work area). Ownership data 
can then be modified by ownership transactions in the check – out area. Once changes are complete, the 
DOI can be validated and checked in again, using the check–in process. You can reset the ownership 
information that was previously checked out by selecting the DOI refresh option in the Base DOI 
transaction, or the DOI list processing transaction. See: Checking Out a Division of Interest (DOI) [page 
29] ).

● Check-in : In order to use a DOI in PRA, it has to be checked in. Check-in also triggers edits and validations, 
by which the system makes sure that the data in the DOI being checked in is valid and does not contain 
errors. Check-in can also trigger funds processing, if funds processing is relevant to the DOI. Check-in also 
copies ownership changes from the check-out area to the check-in area. In addition, as part of the check-in 
process, the system updates marketing groups, and generates prior period notifications (PPNs) – if 
required, which are a result of changes that have been made to ownership data in the work area. The 
check-in process also can trigger funds processing, if funds-relevant data is in the DOI.

 In PRA-Ownership, there are three ways to check in DOIs:

Table 4:

Location Mode

● From the Change Base DOI Maintenance screen (descri­
bed in this document, below) – dialog mode (see: 
Checking in a Base DOI (DOI Change Mode [page 
28] ).

dialog mode

● From the DOI List Processing screen and subsequent 
DOI Workarea screen – batch mode (see: Displaying 
and Processing Base DOI Records [page 30] ).

batch mode

● From Owner Request Processing – batch mode batch mode

Every DOI in Ownership has a status: either checked-in, or checked-out.

Funds processing integration in DOI check-in :

Funds processing is integrated with owner request processing. Funds processing will only be triggered during 
DOI check – in, if there are funds to be processed in the DOI. Funds processing involves a movement of data – 
in a background job between the Owner Payable Line Item Table in PRA, and the PRA Legal Suspense Ledger 
(for example, amounts could be moved from Suspense to Owner Payable).

If customized in the IMG, the funds movement can occur, with subsequent journal entry posting to the SAP 
Financial Accounting (FI) module. This is triggered when the division of interest is checked in, and the transfer 
document is complete, or, for funds-only transfers, when the document is complete.

SAP Oil & Gas (PRA - Production and Revenue Accounting)
Ownership C U S T O M E R 27



DOI check-in log / JE posting summary :

You can display funds movement reports in Ownership. The journal entry posting summary report is available 
in the DOI check-in log.

Prerequisites

Prerequisites for check-in are: The Base DOIs have to have been created, owners assigned for the DOI, and 
bearer groups properly set up, if required. Another prerequisite for DOI check-in is that the DOI has already 
been checked out. A prerequisite for check-out is that the DOI is approved, and checked in previously.

Result

The DOI can be changed (DOI check-out), or the DOI can be used in Ownership, subject to a validity check and 
the relevant edits.

2.3.1.1.1 Checking In a Base DOI (DOI Change Mode)

Use

Use this to check in a base DOI, in Base DOI change mode.

For general information on DOI check-in and check-out, see: DOI Check-In and Check-Out [page 27] .

Checking in a division of interest updates marketing groups defined at the unit level.

Prerequisites

Prerequisites for check-in are: The base DOIs have to have been created, owners assigned for the DOI, and 
bearer groups properly set up, if required. Another prerequisite for DOI check-in is that the DOI is currently in 
checked out status.
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Procedure

For check in :

1. At the SAP Easy Access Menu , choose Logistics → Production and Revenue Accounting → Ownership → Base 
DOI → Change .

The Change Base DOI Maintenance: Initial Screen is displayed.

● Enter a venture/DOI and a company code, and then select Enter .

The Change Base DOI Maintenance: Overview screen is displayed.

● At the top of the screen, Select Check In.

(The pushbutton here is dynamically generated: it will display relevant to the current status of the DOI. Check In 
will be displayed if the status of the DOI is currently checked out. If the current status of the DOI is check in, the 
Check Out button will appear).

The Display logs screen is displayed, if there are errors. The log displays any errors having to do with the check-
in process, as well as any edits that have failed for ownership data.

If there are no errors, the system displays a Log pushbutton (at the top of the screen). Select Log . The Display 
logs screen appears. It displays a list of all changes to various system tables that will be carried out if you 
continue on and save the transaction. At that point – after you choose Save , the changes will be commited to 
the database. This allows you to view the potential changes before making the change.

For check out :

1. At the SAP Easy Access Menu , choose Logistics → Production and Revenue Accounting → Ownership → Base 
DOI → Change .

The Change Base DOI Maintenance: Initial Screen is displayed.

● Enter a venture/DOI, and a company code, and then select Enter .

The Change Base DOI Maintenance: Overview screen is displayed.

● Select Check Out .

● From there, you can make changes to the DOI and save those changes. (After which, you will then need to 
check the DOI back in. See: Checking In a Base DOI (DOI Change Mode) [page 28] ).

2.3.1.1.2 Checking Out a Division of Interest (DOI) 

Use

Use this to check out a division of interest.

You check out a DOI in order to make changes to it (for more information on DOI check-out, please refer to DOI 
Check-In and Check-Out [page 27] ).
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Prerequisites

In order to check out a division of interest, the current status of the DOI must be “checked in”.

Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Ownership → Base 
DOI → List Processing .

The DOI List Processing screen is displayed.

This screen is a report selection screen. The first thing to do is enter data and run the report, to retrieve records 
that match your search.

1. Enter data relevant to your search: company code, venture, and DOI.
2. Select Execute .

The DOI List Processing screen is displayed.

1. Select the record that you would like to check out, and then select Check Out .

Result

The record is checked out (the status of the record is “checked out”), and you can now make changes to the 
record.

2.3.1.2 Displaying and Processing Base DOI Records 

Use

Use this to display and process base DOI records.

This transaction is the main “work area“ for processing divisions of interest. This transaction consists of two 
separate processes:

A report for displaying DOIs

A work area for processing DOIs

In the work area, you can do the following:

Approve individual base DOIs (in batch)

Check out individual DOIs (in batch)
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Check in individual DOIs (in batch)

Refresh the DOI (in dialog mode)

View the activity log (session activity: DOIs check in, checked out, etc.).

See the table below for a full description of the actions that you can take on individual DOIs.

Display

You can display DOIs based on the following selection criteria: company code, venture, and date range, division 
of interest, approval status (approved, unapproved, or “all”), and check-out status (checked out, checked in, or 
“all”).

Procedure

1. From the SAP Easy Access menu, choose Logistics àProduction and Revenue Accounting àOwnership àBase 
DOI àList Processing

The DOI List Processing screen is displayed. Enter the relevant selection criteria for your search. Select a 
company code, and also select an approval status and check-in/check-out status for the DOI.

Select Execute.

The DOI List Processing screen is displayed, which contains the records retrieved from your search. This screen 
is the work area for processing DOI records.

Aside from viewing the displayed base DOI records, you can do a number of things for each retrieved DOI 
record at this point (Note that for the actions listed below, to view the results of each action, select the Activity 
Log pushbutton):

Table 5:

Action: Purpose: How to do it:

Approve the base DOI (see: Approving a 
DOI [page 32] )

Before you use a DOI in Ownership, you 
have to approve it.

Select the record, and then select 
Approve .

Check out the base DOI. You check out base DOIs in order to 
change data in them.

Select the record, and then select 
Check Out .

Check in the base DOI. You check in base DOIs in order to vali­
date the data in the system (meaning 
that the system checks for any errors in 
the DOI).

Select the record, and then select 
Check In .

Refresh the list. Update all changes made in the list. Select Refresh the List .
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Display the activity log for the base DOI. To view results of the actions taken on a 
DOI (approve, check in, check out, re­
fresh)

Select the record, and then select 
Activity Log . You will see a list of check-
in and check-out jobs. Select a record. 
Report selection dialog box is dis­
played. You can choose from the push­
buttons, to view logs.

View details of the base DOI. Allows you to view all saved, checked-in 
details for a base DOI.

Select the record, and then select 
Display record .

Change/display/delete the base DOI. To make changes to the DOI: change it, 
display it, or delete it.

Select the record, and then select 
Change/Display/Delete (also located in 
the menu).

Refresh the DOI. Erases changes made (if you find er­
rors). Refreshes the DOI, but does not 
impact chain of title (see: Viewing 
Chain of Title List Processing [page 
43] ). Reverts back to the previous 
version.

Select the record, and then select 
Refresh DOI .

View the jobs for a DOI.

 

To view what jobs exist for a DOI 
(check-in, check-out jobs, etc.). If you 
want to see the details of the jobs for a 
DOI.

Select the record, and then select Jobs .

2.3.1.3 Approving a Division of Interest (DOI) 

Use

Use this to approve a division of interest (DOI), which is required before the DOI can used in the Ownership 
system.

DOI approval is only carried out once for a division of interest. That results in the status of a DOI being set to 
“approved“.

When you approve a DOI, the system does two things:

- It validates (checks for validity) the ownership information contained in the DOI, including DOI owners, and 
bearer groups.

- It triggers the check-in process.
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It is not possible to “unapprove“ a DOI once you have approved it. It is also not possible to change the DOI start 
date and the combined product code, after the DOI has been approved.

The check-in process is used to do the following: to validate ownership data, and copy ownership changes from 
the check-out area to the check-in area. In addition, as part of the check-in process, it updates marketing 
groups, and generates prior period notifications (PPNs), which are a result of changes that have been made to 
ownership data. The check-in process can be called from the Base DOI transaction ( Displaying and Processing 
Base DOI Records [page 30] ), or from the Owner Request background job.

Resetting, in addition to replacing the work area ownership data with the check-in data, also removes the 
refreshed DOI from owner requests.

Prerequisites

You have to have first set up a base DOI and ownership information, which includes DOI owners and bearer 
groups.

Procedure

At the SAP Easy Access Menu, choose Logistics Production and Revenue Accounting Ownership Base DOI 
Change .

The Change Base DOI Maintenance: Initial Screen is displayed. Enter a venture and DOI, and a company code, 
and then select Enter .

The Change Base DOI Maintenance: Overview screen is displayed.

Select Approve/Check In .

This approves the base DOI.

The Display logs screen will be displayed, if there are errors. The log displays any errors having to do with the 
check-in process, as well as any edits that have failed for ownership data.

If there are no errors – a dialog box prompting you to continue with the check-in is shown. You have the option 
of either proceeding further with check-in, or cancelling the action. If you select <OK>, the system will apply 
the relevant edits, delete the work area, copy the division of interest into the system area, and set the approval 
flag; the log button will be available to view the check-in log and results.
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Result

The result is that the approval process is complete, and the DOI approval status is changed, and is set to 
“approved“, and the ownership data is checked in.

2.3.1.4 Maintaining Division of Interest Owners 

Use

Use this transaction to maintain master data for owners within a particular division of interest (DOI).

Procedure

1. At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Ownership 
DOI Owner Maintain  .
The Maintain DOI Owners: Initial Screen is displayed.

2. Enter data as required to maintain the DOI owner (venture/DOI, company code, and selection date) and 
choose Enter .
The Maintain DOI Owners: Overview Screen appears.

3. As required, maintain net revenue interest, pay code, and joint interest billing data, as well any additional 
required data.
On the Overview screen, there are three icons that you can use to add, change, or delete records to the list 
at the bottom of the screen: Cut , Copy , and Paste . Select an item and then select either, delete, cut, or 
copy, and then paste, to add, change, or delete items.

Once data has been entered in all key fields, double-click on the owner (item), which will present a dialog box 
that displays all owner details.

Save the owner data.

Result

Owner data is saved in checked-out status.
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2.3.1.4.1 Creating DOI Owner Sliding Scale Values 

Use

Use this to create and maintain sliding scale range values and decimal increment/decrement values.

Sliding scale is a method used to calculate the decimal interest applicable to a royalty owner, when the owner’s 
interest varies depending on the amount of volume produced. The sliding scale calculation is used in the 
formula process of Valuation (see: Valuation Formula [page 287] ).

Sliding scale details are valid for non-working interest owners only. Sliding scale data is comprised of sliding 
scale range values and decimal incremental/decremental values. The information is used when a royalty 
owner‘s NRI is calculated using the sliding scale in batch.

Sliding scale records cannot be created for working interest owners.

Sliding scale methods are:

Sliding scale

Sliding scale with gravity

Step scale

Ranley sliding scale with gravity

Rangley step scale

Prior period adjustment notifications are automatically generated when changes are made to either the sliding 
scale range values or to the decimal values.

Procedure

At the SAP Start Menu , choose Logistics Production and Revenue Accounting Ownership DOI Owner à Display . 
From there, there are three ways to create and maintain sliding scale range values:

a. From the DOI Owner Overview screen, select an owner, and then select Sliding Scale .

b. From the DOI Owner Detail screen , select Sliding Scale Maintenance .

c. Select the Sliding Scale pushbutton for the relevant owner (within the table control for the item that you are 
interested in). If sliding scale records exist for the owner, a green icon is displayed on the pushbutton; if no 
records exist for the item, the pushbutton will have a red icon.

After selecting one of those three options, continue as follows:
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From there, the Maintain Sliding Scale dialog box is displayed.

Select a sliding scale method (if the method selected requires a gravity measurement, the gravity , greater 
than/equal to , and less than radiobutton will be activated and are then mandatory.

Now choose the range for the scale by selecting either the volume/value radiobutton.

Fill in all the fields, as required.

Select Enter .

To enter a sliding scale, you have to enter the From value and the Decimal increment . The To value is 
automatically calculated to be the highest permissable value (by two decimal places) based on the next higher 
range From value. If no higher range From value exists, the To value defaults to the highest possible value. Once 
the scale is created, the record is saved, edits and validations are carried out, and the records are saved in the 
database.

Header information becomes inactive while the table control becomes active. The scale ranges table control 
allows you to create the ranges for a royalty owner’s NRI calculation based on the sliding scale. The calculation 
is carried out as a batch job.

2.3.1.4.2 DOI Owner Marketing Free 

Use

Use this to designate an owner in the system as exempt from paying internal marketing costs. You can also use 
it to indicate whether or not an owner will receive external marketing reimbursements.

When an owner is exempt from paying internal or external marketing expenses, those expenses are not 
considered in calculating the owner’s net amount. Likewise, if an owner is exempt from receiving marketing 
reimbursement amounts, those additional income amounts are not included in calculating the owner’s net 
amount.

If a royalty owner is exempt from paying marketing expenses, the working interest owners who are responsible 
for bearing the royalty owner must pay the royalty owner’s share of the expenses. When a royalty owner is 
exempt from receiving marketing reimbursements, the bearing working owners receive the royalty owner’s 
share of the reimbursement amount.

A notable exception to the above rule relates to special transportation reimbursements for gas products. 
Special transportation reimbursements are reimbursement amounts using marketing cost type 05 or 06 for 
gas products. When a royalty owner is not exempt from receiving this marketing reimbursement amount (i.e. 
he receives his share), the working interest owners who bear him must pay for his share of the reimbursement. 
When a royalty owner is exempt from receiving special transportation reimbursement, his bearing working 
interest owners do not receive the royalty owner’s share of the reimbursement amount.
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When a working interest owner is exempt from paying internal and/or external marketing costs, the amount 
that the owner would have paid is not allocated. Likewise, if a working owner is exempt from receiving 
marketing reimbursement amounts, the owner’s share is not allocated.

Procedure

At the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Ownership DOI Owner 
Maintain . The Maintain DOI Owners: Initial Screen is displayed.

On the Maintain DOI Owners: Initial Screen , enter the required DOI data and select Enter.

The Maintain DOI Owners: Overview screen is displayed.

Now do one of the following:

a. Select an owner, and then select Marketing Free .

b. From that screen ( Maintain DOI Owners: Overview Screen ), select the relevant owner, and then select 
Marketing Free ).

c. From the DOI Owners Detail screen, select Marketing Free .

With respect to the pushbuttons mentioned directly above, if records exist for the item (owner), a green icon is 
displayed on the pushbutton for the item; if no records exist for the owner, a red icon is displayed.

The Maintain Marketing Free Detail dialog box is now displayed.

You can now maintain your data (select the external deduction checkbox, external reimbursement checkbox, 
and/or the internal deduction checkbox to create, change, and delete records), and then select Save .

Explanation of the fields on the Maintain Marketing Free Detail screen

Table 6:

Major product code Identifies the type of product produced or sold.

Marketing type A cost that can be incurred for the expense of selling prod­
ucts.

External deduction checkbox Indicates whether the owner is exempt from paying the ex­
ternal costs associated with the selected marketing type. 
Set this if the owner is to be exempt.
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External reimbursement checkbox Indicates whether the owner is exempt from receiving exter­
nal reimbursements associated with the selected marketing 
type. Set it if the owner is to be exempt.

Internal deduction checkbox Indicates whether the owner is exempt from paying the in­
ternal costs associated with the selected marketing type. 
Set this if the owner is to be exempt.

The marketing type and major product code are non-editable fields. They are filled based on the DOI combined 
product code. All marketing type and major product code combinations will populate the table control based 
on a major product code (derived from the combined product code) and the marketing type valid for the major 
product code.

 

2.3.1.4.3 Creating Owner Tax Exemption Records 

Use

Use this to create DOI owner exemption records (exemptions from taxes). Owner exemption is part of the DOI 
Owner Maintenance transaction.

Procedure

At the SAP Easy Access Menu , select Logistics Production and Revenue Accounting Ownership DOI Owner 
Maintain , or Display .

The Maintain DOI Owners: Initial Screen is displayed (or the Browse/Display DOI Owners screen is displayed).

Enter the required data, and select Enter.

The Maintain DOI Owners: Overview Screen (or display screen) is displayed. From this screen, do one of the 
following:

a. Select an owner and then select Owner Exemption Maint .

b. Select the Owner Exemption (icon in the item row) for the relevant owner on that screen.
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c. From the DOI Owner Detail Screen , select Owner Exemption .

With respect to the pushbuttons mentioned in Step 3, if there are records for the item, the icon on the 
pushbutton will appear green on the screen; if there are no records, the icon will be red.

The Maintain Owner Exempt Detail dialog box is now displayed.

The purpose of the owner exempt dialog box is to maintain DOI owner exempt records that will be stored in the 
system.

In the Maintain Owner Exempt dialog box, all major product codes derived from the combined product code are 
displayed. For each major product code displayed, set the owner exempt checkbox indicating that the owner is 
exempt from state withholding tax for that product code. You can create, change, display, and delete 
exemptions.

2.3.1.4.4 Displaying Owner Interest Records 

Use

Use this to view owner records for divisions of interest in list form, and to recalculate GRI for specific records in 
the list.

Procedure

1. At the SAP Easy Access Menu, choose Logistics → Production and Revenue Accounting → Ownership → DOI 
Owner → Owner Interest List Processing .

The Owner Interest List Processing screen is displayed.

2. Enter the owner for which you would like to view records, and the interest category (carried, royalty, override 
royalty, or working, as well as an effective date range). You can also specify either checked in or checked out 
DOIs.

3. Select Execute .

The system displays records based on your search criteria. Note: you can recalculate the GRI for a record. To do 
so, select the item (record) and then select Calculate GRI . The system will then prompt you to enter a date for 
the GRI calculation.
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2.3.1.4.5 Displaying Interest-Type Records, Per DOI 

Use

Use this to view DOI interest records (per venture/DOI, what records exist, per interest type).

When you make your selections, you specify the venture/DOI, and the interest category that you would like to 
see records for. The options for the interest category are:

● Working interest
● Royalty interest
● Carried interest

Procedure

1. At the SAP Easy Access Menu, choose Logistics → Production and Revenue Accounting → Ownership → DOI 
Owner → DOI Interest List Processing .

The DOI Interest List Processing screen is displayed.

● Enter the relevant data for your search (company code, joint venture, DOI, interest category, date range, 
and whether you would like to run the search for a checked in or checked out DOI area).

● Select Execute .

The DOI Interest List Processing screen is displayed, which displays the records, based on interest category.

2.3.1.4.6 Displaying Owner Changes 

Use

Use this to view changes for a PRA owner; more specifically, to display all change documents for a specific 
owner.

You can use it to display field-by-field changes that have been made to an owner in PRA. The retrieval of the 
records is based on several parameters that can be entered on the selection screen. Selection criteria includes 
the owner, owner interest type, owner interest sequence number, company, venture, DOI, and effective date 
range.

For example, you can view all changes to a specific owner for a specific date range.

Procedure

1. At the SAP Easy Access Menu, choose Logistics → Production and Revenue Accounting → Ownership → DOI 
Owner → Owner Change List Processing .
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The Owner Change List Processing screen is displayed.

1. Enter the relevant data for your search, and then select Execute .

1. The Owner Change List Processing screen is displayed. On that screen, you can view the records based on 
your search criteria. On that screen, there is also a Chain of Title pushbutton that you can select to navigate 
to the chain of title transaction.

See also:

Displaying Chain of Title Records [page 43]

2.3.1.4.7 Displaying Outstanding Summary (Legal 
Suspense) Balances 

Use

Use this to display owner summary balances from owner payable or legal suspense line item tables.

You can view summary balances at the owner level, venture level, or venture/DOI level for a specified range of 
sales dates. The summary balances are displayed at two levels of detail: at the first level, the summary is shown 
by pay code and suspense reason. At the second level, the first level summary balance is displayed, broken 
down by batch type and accounting period. At this summary level, the gross owner values, volumes, tax, costs, 
and deducts are totaled and displayed.

Procedure

1. At the SAP Easy Access Menu, choose Logistics → Production and Revenue Accounting → Ownership → 
Owner Request → Outstanding Summary Balance .

2. The Owner Payable/Legal Suspense Summary Balance screen is displayed. Enter the owner ID (business 
associate) for which you would like to query the summary balance(s).

3. In the Scope of List screen area, select either:
4. - Owner payable summary
5. - Legal suspense summary
6. Select Execute .

The system displays the Owner Payable / Legal Suspense Summary Balance: Details screen.

On the split-screen that is now displayed, at the left, there is a hierarchy listing the venture(s) and the divisions 
of interest for which the owner balances can be displayed.

At each node of the hierarchy, you can display the summary balance(s), by double-clicking on the node, or by 
chosing the View owner summary context menu option (right click on the node to display the context menu).

When you select a node on the hierarchy tree, the Enter additional selection criteria dialog box can be displayed 
- depending on whether you have set that – (see the information box directly below this), where a range of sales 
dates is required to be entered for displaying the summary overview.
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Table 7:

Whether or not the Enter additional selection dialog box appears or not when you select a specific node, depends on 
whether or not you have set the Show popup for defaults (double click) flag on the Owner Payable/Legal Suspense 
Summary Balance: Defaults screen (which you can access from the hierarchy screen by selecting Defaults – the Defaults 
pushbutton on that screen).

The system will automatically ask you to maintain sales date ranges to be used as defaults when you request summary 
balance overview for the first time.

On the Owner Payable/Legal Suspense Summary Balance: Details screen, the right-hand side of that screen 
the Summary Overview list is displayed. The list shows transaction amount totals at the following levels:

● DOI level totals
● Property level totals
● Owner interest type level totals

You can drill down on a particular summary overview row by either double-clicking the row, or by selecting the 
row and choosing Summ->Detail .

The summary overview list is split (split screen) and the summary details list, showing the breakdown totals by 
batch type and accounting period are shown.

To leave the split screen, select Close when in split screen mode.

2.3.1.4.8 Maintaining Production Payment Information

Use

Use this to create and maintain production payment information. Production payments can be set up with 
either volume or value as the basis (but not with both). You can also display production payment information 
records, and then change or delete them.

The balance information is updated with amounts paid to the owners after the payment is tied to ownership 
information (there is no automatic notification when a balance is paid in full).

Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Ownership → DOI 
Owner → Production Payment .

The Production Payment: Initial Screen is displayed.

1. Enter the relevant owner (and Volume , Value , or Both ) and the material, and then select Create .
2. The Create Production Payment: Maintenance View is displayed.
3. Enter the owner and then select Enter . (Note: only enter data in fields that are "key fields" – which are the 

"open" fields – the white, non-greyed out ones - at the top of the screen).
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4. Enter data in the relevant fields (see below), and then select Save to save the record.

Fields on the Production Payment have the following meaning:

Combined product code = The product that is associated with the production payment.

Gross volume/UoM = The total production payment amount in volume.

Gross value/curr = The total production payment amount in value.

Include on Report = By selecting this, it means that the production payment information is to be included on 
the report that is generated by the production payment owner balance job.

Volume balance/UoM = The balance field shows the amount that remains to be paid.

Value balance/Curr = The amount that remains to be paid.

A second processing option exists :

1. From the Production Payment: Initial Screen , enter the relevant owner and any other selection criteria 
(payment method, combined product code), and then select Execute .

The system displays the Production Payment List Viewer , which contains a list of records that match your 
selection criteria.

1. You can now change or delete the records that are displayed.

From there, you can either create new records either by selecting an existing record from the list and selecting 
Create , or by reference, by selecting an existing record from the list and selecting Create with reference .

In the former case, the system displays the FormView screen, with the key fields open, and the data fields 
closed. No data is defaulted or present in the fields. For subsequent navigation, see the standard procedure 
above. In the situation with create by reference , the selected record key and data fields are transferred to the 
Form View, and the key fields are open for input.

Save the record.

When you are creating by reference, when you are in the Form View with the key fields open, the key fields need 
to be changed in order to be able to proceed.

2.3.1.4.9 Displaying Chain of Title Records

Use

Use this to view chain of title records for an owner.

Chain of title list processing is used to determine the chain of title (who owned what, when) for a PRA owner.
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Procedure

1. At the SAP Start Menu, choose Logistics → Production and Revenue Accounting → Ownership → DOI Owner 
→ Chain of Title .

2. The Chain of Title List Processing screen is displayed.

● Enter the selection criteria that you would like to use.

● Select Execute .

The Chain of Title List Processing screen is displayed, with records which correspond to your selection criteria.

From the list, you can drill down to the owner transfer request document. To do that, from the list of records 
that is displayed based on your search, select a record, and then select Display . The owner transfer request 
document will be displayed.

2.3.1.4.10  Maintaining Owner Interest Calculation Data 

Use

Use this to maintain interest calculation data for use by the interest calculation jobs for suspended balances. 
Interest can be calculated on either previously-paid royalties payable accounts, or on amounts recently 
released from suspense.

Procedure

1. At the SAP Easy Access Menu, choose Logistics → Production and Revenue Accounting → Ownership → DOI 
Owner → Owner Interest Calculation .

2. The Owner Interest Calculation: Initial Screen is displayed.
3. Select Create .
4. On the subsequent screen ( Owner Interest Calculation - Create ), enter the relevant data (select: Check or 

Suspense Release , company , property , owner , check , default interest rate , and suspense pay code ).
5. Save your record.

2.3.1.5 Creating a Bearer Group 

Use

Use this to create a bearer group.
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A bearer group represents the relationship between working interest owners and the respective royalty owners. 
The bearer group is used in burdening in PRA. "Burdening" in PRA is the process of the working interest owners 
"bearing" the costs from a PRA venture for the royalty interest (RI) owners.

A bearer bears the costs associated with exploration/development and production. The bearer group describes 
the relationship (obligations and percentage share) that each working interest owner has to their respective 
royalty interest owners.

The bearer group is linked to a division of interest to indicate the working interest owners that are responsible 
for paying the non-working interest owners. The bearer group is also used to determine working interest 
owners' gross revenue interest (GRI), which is used to determine working interest (WI) owners' entitled 
volumes for marketing and production.

The following are the bearer group types:

- Carried bearer group (links WI owners with CI owners)

- Royalty bearer group (links WI owners with RI owners)

Procedure

1. At the SAP Easy Access screen, choose Logistics  Production and Revenue Accounting  Ownership 
 DOI Bearer Group  Create  .

2. The Create Bearer Group: Initial Screen appears.
3. Enter data as required and choose Enter . A dialog box is displayed, in which you choose whether the 

burden group will be “royalty” or “carried”.
4. The Create Bearer Group: Overview screen is displayed.

All working interest owners from the DOI are listed in a table.
5. Enter the owner’s percentage of the bearer group.
6. Save the bearer group by choosing Save.

2.3.2  Defining Tax and Revenue Attributes for a DOI (DOI 
Accounting) 

Use

Use this to define tax and revenue information specific to a division of interest (DOI).

Each accounting record is set up by major product code, making it possible to have multiple accounting 
records for the same DOI.
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Procedure

1. At the SAP Easy Access screen, choose Logistics  Production and Revenue Accounting  Ownership 
 DOI Accounting  Create  .

The Create DOI Accounting: Initial Screen is displayed.
2. Make entries as required, and choose Enter

The Create DOI Accounting: Overview screen appears.
3. On the Accounting screen tab, enter the relevant data.

Table 8:

Accounting : Here, you can choose the revenue process, for example: system valued, check input, or settlement state­
ment, whether billing is to be current or historical, and whether payment should be for actual or entitled volumes and 
values. You can also set up information on the checkwrite process (pay in 30 days, pay in 60 days, etc.).

1. On the Severance Tax screen tab, enter data as required.

Table 9:

Severence tax payment indicators are maintained here.

For example, if $1,000 is to be received from the purchaser as a result of a sale, but severance tax of $ 50.00 is due 
from the sale, RD allocations will distribute both the revenue and the tax amounts to the lease owners. The net payable 
amount to all of the lease owners combined is $ 950.00, which leaves the processing company with $ 50.00, which 
should be remitted to the taxing authorities.

The tax payment flags are not an indication of whether payment of severance taxes is required; they are an indication 
of who is responsible for remitting tax payment amounts to the taxing authorities (this later influences Revenue Distri­
bution Allocation [page 395] ).

(If the processing company is responsible for remitting the tax, a Taxes Payable Journal Entry will be created. If the 
purchaser is responsible, the tax amount is subtracted from the receivable amount, which will effectively transfer the 
funds with which to pay the tax to the purchaser. If the operator is payable, the taxes will be remitted to him via a royal­
ties payable credit.

1. If necessary, enter data as required for the Plant Cond Sev Tax tab and Scrubber Oil Tax tab.These two tabs 
are used for entering tax details relevant to natural gas liquids.

2. Save the DOI accounting data.

2.3.3  Ownership Transfers (Transfer Requests) 

Purpose

In PRA-Ownership, you can transfer ownership interests within a division order.

Various owner request types can be processed: Funds transfers, ownership change requests (with or without 
funds), ownership consolidations (with or without funds), and ownership transfers (with or without funds).
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Functionality exists for “approving“ or not approving owner requests. Transfer reports can be created and 
printed. You can use this process to create, create with reference, change, and delete owner requests, as well as 
to set or change the status of the request (a background process exists, which only processes approved 
requests).

The transaction also offers the option of simulating a request, to show the results of transfer, consolidation, or 
change, before any ownership tables are updated. A funds transfer request can be carried out separately, or at 
the same time as an owner transfer/consolidation/ or change request.

The following is a short description of the ownership transfer types (you can carry them out with or without 
funds transfer):

Table 10:

Owner transfer Allows the ownership within a division of interest or several 
divisions of interest to be transferred from one owner to an­
other, or to many owners.

Owner consolidation Allows the ownership within a single division of interest to be 
transferred to a single owner.

Mass owner change Allows certain attributes of an owner to be changed across 
mulitple divisions of interest.

Funds transfer Moves funds from one owner to another, or transfers an 
owner’s funds from or to “suspense“.

Depending on which request type is chosen, the system will display tabs for that type of request on the 
subsequent screen.

Owner requests are given status codes. The following status codes exist: maintained, released, approved, 
completed, and failed.

Process Flow

On the initial screen, you either immediately create an owner request, which takes you to the Form View Screen 
with the various request types, and which displays the relevant tab, based on your selection. From there, you 
enter owner request information.

Or, from the initial screen, you can create selection criteria, and carry out a selection, whereupon the system 
displays a list processing screen. The list processing screen displays all the records that correspond with your 
selections. From list processing, you can select a record, and create or create with reference (which then takes 
you to the Form View screen where you can create a request). From the list processing screen, you can also 
refresh the list, approve individual requests (setting the status of the request to “approved“, or execute the 
request (which processes the owner request in background mode and updates the request status).
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Result

Based on your selections, transfer of ownership is carried out, as are changes to divisions of interest, and 
changes to the statuses of requests.

2.3.3.1 Creating an Owner Transfer 

Use

Use this to create an owner transfer request (which transfers ownership within a division of interest).

For more information on owner transfers, see: Ownership Transfers [page 46] .

Procedure

At the SAP Start menu, choose Logistics Production and Revenue Accounting Ownership Owner Request Owner 
Transfer/Maintenance Request .

The Owner Request: Initial Screen is displayed. This is your starting point for creating, displaying, or deleting 
owner requests.

There are two possible options, starting from the Initial Screen:

Option A: Create an owner request

1. On the Initial Screen (Owner Request: Initial Screen), select Create .
2. A dialog box is now displayed, which requests that you select a document type. The “document type“ is the 

type of owner request that you would like to create.
3. Select a document type (for example: <Funds transfer>).

The screen that now appears is directly dependent on the document type that you chose in the previous step. 
The Create Owner Request : xxxxx screen is displayed. (The precise title of that screen depends on the 
document type that you selected in the previous step; please refer to the table below, which explains the 
various screens that can be accessed, based on the document type that you selected).

1. Enter the relevant data for the owner request. Enter the owner, effective date range, a reason code, etc. You 
can enter transfer details and new owner values as well.

The Description field allows you to enter a short text description for the ownership transfer.

1. Save the record.
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Depending on which document type you choose, the subsequent screen (Form View screen) will be one of the 
following … (the screen tab can vary, depending on your selections).

Use the screen tabs to enter the relevant information for the ownership transfer: old owner, new owner, 
ownership to transfer, comments, etc.

Table 11:

Ownership transfer request with funds: (Used for transferring interest and funds from one owner to multiple owners)

- Old owner - Includes old owner and other key information of transfer

- Ownership to transfer – Table control to select & display DOIs to be included in transfer

- New owners – Table control where new owners are created

- Funds – Provides option to transfer all funds from a specific date

- Comments – Free form editor; you can write internal extended comments related to the request.

 

Ownership transfer request without funds: (Used for transferring only interest from one owner to multiple owners)

- Old owner – Includes old owner and other key information or transfer

- Ownership to transfer – Table control to select & display DOIs to be included in transfer

- New owners – Table control where new owners are created

- Comments – Free form editor to write extended comments related to request

Ownership consolidation request with funds: (Used for transferring interest or funds from multiple owners in a DOI to one 
new owner)

- New owner – Includes new owner and other key information of transfer

- Ownership to consolidate – Where DOI(s) is entered & old owners are selected & displayed

- Funds - Provides option to transfer all funds or from a specific date

- Comments - Free form editor to write extended comments related to request

 

Ownership consolidation request without funds:(used for transferring interest only from multiple owners in a DOI to one 
new owner)

- New owner – Includes new owner and other key information of transfer

- Ownership to consolidate – Where DOI(s) is entered & old owners are selected & displayed

- Comments - Free form editor to write extended comments related to request
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Ownership change request with funds:(used for changing DOI ownership records and moving an owner’s funds from/to 
“suspense”)

- Owner – Includes owner to change & other key info. of change request

- Ownership to change – Table control to select & display DOIs to be included in change

- New values – List of owner fields to be changed

- Funds – Provides option to transfer all funds or from a specific date

- Comments – Free form editor to write extended comments related to request

 

Ownership change request without funds:(used for changing DOI ownership records only)

- Owner – Includes owner to change & other key info. of change request

- Ownership to change – Table control to select & display DOIs to be included in change

- New values – List of owner fields to be changed

- Comments – Free form editor to write extended comments related to request

 

Funds transfer request: (used to transfer funds from one owner to another, or move an owner’s funds from/to suspense)

- Old owner – Includes old owner and other key information of transfer

- Ownership to transfer – Table control to select & display DOIs to be included in transfer

- New owners – Table control where new owners are entered

- Funds – Provides option to transfer all funds or from a specific date

- Comments – Free form editor to write extended comments related to request

 

Option B Create an Owner Request by Reference

1. On the Owner Request: Initial Screen , you can create a list of owner requests by running an ABAP report. 
Select relevant parameters for your search (document type, year, document number, effective date range, 
status, and venture/DOI data).

2. Select Execute .
3. The Owner Request: List Viewer screen is displayed. This displays all of the records that correspond to your 

search. Here, you can do the following:

- By selecting a row or multiple rows, you can carry out the following actions on a record: create , create by 
reference , change , display , or delete .

Carrying out one of the actions above will take you to the Form Viewer screen to process the individual request 
chosen.

If multiple records are selected, you are taken to the Form View to process the first record. The next record is 
displayed when you select “Back”. The create icon is used for both Create and Create by reference .
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In addition, you can also do the following in the list viewer:

- Refresh List – Refreshes the data in the ALV list after any changes have been made during the transaction.

- Approve – Sets the request status to “approved”. The request must be in released status before this action 
can be performed. A record must be selected.

- Execute – This action will process the owner request in the background and will update the request status to 
“completed” or “failed” based on the successful completion of the request. The request must be approved 
before you can execute the process. This process will update the ownership tables in the checked out area. You 
have the option of automatically checking the DOIs back in or not.

- Show Detail– Brings up another list of all ventures/DOIs for the given request selected.

- Show DOIs

- Show Trace/Funds Report

Result

An owner transfer request is created, displayed, approved, etc.

2.3.3.2 Displaying Ownership Transfers 

Use

Use this to display ownership transfers (owner transfer requests), based on a variety of selection criteria.

Procedure

1. At the SAP Easy Access Menu, choose Logistics → Production and Revenue Accounting → Ownership → 
Owner Request → Owner Request Execution Reporting .

The Execute Owner Requests screen is displayed.

2. On that screen, select the relevant document type (the specific ownership transfer document), document 
year (the year that the ownership transfer was created), document number, effective date range, owner type, 
and the document status (approved, complete, failed) as your selection criteria.

● You can also run the search based on who created the transfer request (using the Created by field).
● You can also search based on the request process date. That is the date on which the request was 

processed.

3. Select Execute .
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The Execute Owner Requests screen is displayed. That screen displays job overviews, and you can choose an 
individual item (an individual owner request) and then execute the transfer (select the item, and then select 
Execute Transfer ).

The following subsequent actions are also possible at this point (from the list screen):

Table 12:

To: Select the pushbutton:

Refresh the list after you make changes. Refresh list

View job logs and reports. Job / logs reports

Job Overview – (takes you to the “Simple Job Selection” 
screen).

2.3.3.2.1 Displaying a Schedule A Report (Transfer Order) 

Use

Use this to view a Transfer Schedule A Report.

The Transfer Schedule A Report is created at the time of a transfer from a current owner to one or more new 
owners. It is attached to a transfer order, letter in lieu, or some other document and sent to the new owners to 
confirm the conveyance of interest to the new owners.

Procedure

1. At the SAP Easy Access Menu , choose Logistics → Production and Revenue Accounting → Ownership → 
Owner Request → Owner Request Execution Reporting .
The Execute Owner Requests screen is displayed.

2. Use this screen to make selections in order to select and execute the desired request, and create a batch 
job ( Execute in background ) to carry out the required update processing.

3. Continue to refresh the screen using the refresh pushbutton, until the job status for the request is displayed 
as “finished“ in the background job list.

4. Now select the relevant job in the list line and double click on it.
A dialog box provides pushbuttons for possible reports.

5. To view the report, select Transfer Report .
6. If no report was generated, the system will display the message “ There is no report for that selection “.
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2.3.3.2.2 How a Combine Report is Viewed

Use

The CombineReport highlights reasons why ownerships cannot be combined during an ownership transfer.

The report can be viewed in either of two ways:

● In dialog mode, for ownership transfer request creation
● In background mode, for updating ownership records from ownership transfer requests

Features

The report displays a list containing the following fields:

Table 13:

CoCd Company code

JV Venture

DOI Division of interest

Old owner Old owner’s number

IT Interest type

ISQ Interest sequence number of old owner

Eff.fr.dt. Effective from date of ownership being transferred

Eff To Dt Effective to date of ownership being transferred

Reason Description of the reason why ownership cannot be com­
bined

Old Value Combinability criterion value for old owner

New Owner New owner’s owner number

IT Interest type of new owner (combine target)

ISQ Interest type of new owner (combine target)

Eff.fr.dt. Effective from date of combine target

Eff To Dt Effective to date of combine target

New val. Combinability criterion value for new owner
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Activities

Within the path SAP Easy Access → Logistics → Production and Revenue Accounting → Ownership → Owner 
Request → Owner Request: Initial Screen , you create a transfer request for the desired ownership and owners. 
You then select Combine (a pushbutton). (Note: there are various ways of carrying out this process, so the 
description here is not in great detail; the exact process depends on how you want to use the Combine Report).

If all records can be combined, see message OIURVOW 490 ("Match found: all records can combine"). 
Otherwise, the Combine Report is displayed, listing reasons why records cannot combine.

In the Owner Transfer Execution Report (transaction O3UOW_OTX), select the relevant request, creating a 
batch job to carry out the required update processing. Continue to refresh the screen by selecting Refresh until 
the job status for the request is displayed as "finished" in the background job list. Then, select the list line for 
the relevant job and double-click on it.

A dialog box is displayed, which provides buttons for possible reports. Select Compatibility Report to view the 
report.

If all records combined, there will be no report. In that case, the system message "There is no report for that 
selection" will appear at the bottom of the screen.

2.4 PRA Unit Venture 

Purpose

A unit venture is a type of venture in Ownership, in which several wells/ventures from different owners are put 
together into a unit (unit venture) for ownership and revenue purposes. Each unit venture (sometimes referred 
to as a 'unitized venture') is made up of individual tracts, which represent individual wells or divisions of 
interest.

For example, on a single piece of land, there might be two owners who own land next to one another on that 
property. Owner A decides to drill on the land, and sends a well into a reservoir. However, the underground 
reservoir from which he is drawing product is not 100 % located under his land, but also extends under the land 
of owner B. So, because the product in question is fluid, there is no 'stable' ownership situation underground 
with respect to the minerals, because the fluid product extends across more than one property.

In response to seeing that he is losing product from his land to Owner A, Owner B begins to drill into the 
reservoir under his own land. Now, there are two separate wells on two adjacent pieces of land, both drilling into 
the same reservoir. Instead of treating these two as separate, the government wants them to be treated as one 
unit. That it why it is referred to as a unit venture. The adjacent wells are then put together as one unit venture, 
and instead of each owner deriving product in a ‘competitive’ environment, they divide up the interest from the 
drilling (unit ventures are desired by the government for environmental and regulatory reasons. The 
government does not want competing owners to drill into land in order to forestall a competing owner from 
gaining access to liquid minerals. Thus unit ventures are requested by government). The divisions of the unit 
are henceforth referred to as "tracts" of the unit.
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PRA units are Ownership master data objects that are created in the system for a company code and combined 
product code. Units are created for a specific date range and material. Unit ventures consist of “tracts“, which 
are divisions of interest (DOIs). A unit venture is a single entity in the system that can be defined by the user 
based on company code/venture/combined product code. The unit venture can be created, changed, 
displayed, and checked in and out of the system for maintenance from the PRA Joint Venture screen. In list 
processing, the user can display and check in and check out unit ventures.

Based on the PRA unit venture, the following processes can be carried out:

● Unit to tract participation (see: Maintaining Unit / Tract Records [page 55] ).
● Unit venture list processing (see: Displaying Unit Ventures [page 58] )
● DOI tract by tract list processing (see: Tract by Tract List Processing [page 59] ).
● DOI tract by owner processing (see: Displaying DOI Tract by Owner (List Processing) [page 60] ).

The unit venture is set up on a check-in/check-out basis. Unit to tract maintenance can only be performed 
when the unit venture is checked out.

Prerequisites

A PRA venture has to first have been created.

Process Flow

1. You create a PRA unit venture (having first created a PRA venture). You set up a venture as a unit venture 
by setting the Unit Venture flag on the PRA Venture screen (see: Creating a PRA Venture [page 23] ).

2. After that, you can carry out unit to tract participation, unit venture list processing, DOI tract by tract list 
processing, and DOI tract by owner processing.

3. Checking In/Checking Out a Unit Venture [page 57]

2.4.1   Maintaining Unit / Tract Records 

Use

Use this to maintain and display tract records per unit records (“unit to tract participation”). It shows which 
tracts “participate” in the unit venture.

Unit to tract participation is used to group divisions of interest (DOIs) into groups, which are then referred to as 
unit ventures, or units, for one company code/venture/combined product code, and effective date.

Thereafter, the DOIs are referred to as “tracts“ of the unit venture. Each tract is valid for the specific date range. 
The system gives each tract a tract number, tract name, and tract participation factor. The participation factor 
can be anywhere between 0.00 and 1.00 (1.00 representing 100 % of ownership, so each participation factor is 
a part of that 100%). The system also creates a Property Use Control record (PUC), which lists tracts and tract 
participation factors.
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Prerequisites

Divisions of interest have to be approved first in the system before they can be processed as part of this 
process.

In addition, on the PRA venture maintenance screen ( General screen tab), the Unit venture and DOI by tract 
flags have to be set, for the venture to be able to be used here.

Procedure

At the SAP Easy Access Menu, select Logistics → Production and Revenue Accounting → Ownership → Unit 
Venture → Unit to Tract Participation .

The Unit to Tract Participation: Initial Screen is displayed.

There are two ways to proceed from here:

Table 14:

Display already-created records :

If you simply want to view records that were already created, enter the relevant data for your search and then select 
Execute . The system will display a list of unit to tract records that match your search.

From that list, you can then select an individual record (a unit venture record) and then select display. The screen that fol­
lows lists the tracts and tract participation factors for that unit. To display details of the record, select the record, and then 
select Details .

To create new records , on the Unit to Tract Participation: Initial screen, select Create .

The Create Unit to Tract Participation: Application maintenance from screen appears.

1. Fill in the relevant fields (company code, unit venture, combined product code. Note: company code, 
venture, and combined product code are mandatory, as is the effective date).

2. Choose Enter .

When you choose Enter, the system will validate the data that you entered. If there are no errors, the item fields 
– below, where you enter the tract information – will be accessible (tract number, tract name, company code, 
venture, DOI, and tract participation factor).

3. Enter the tract participation information.

4. Save your data.
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Table 15:

Cut and paste for tract maintenance :

You can use a clipboard within this transaction to cut and paste tracts from the screen, back into the screen, or into another 
screen. From either the Create or Detail screens, you can use the icons: Cut, Copy, and Paste to copy tracts into (a system) 
clipboard, and then paste them back onto the screen. This allows you to copy and paste many tract records at once.

Result

A unit record is created with the divisions of interest as “tracts” of the unit venture. The unit is created for a 
company code/venture/combined product code. The system assigns a tract number, tract name, and 
participation factor to each tract. The system also creates a Property Use Control (PUC) record – which lists 
tracts and tract participation factors.

2.4.2  Checking In/Checking Out a Unit Venture

Use

Use this to check in units that were set up using unit to tract participation. You can also use it to check out units 
for maintenance in the check out area (work area).

Unit ventures have to be checked in to be used in the PRA system, and checked out, if you want to make any 
changes to them. The process is the same as for DOI Check-In and Check-Out [page 27] .

Check-in/check-out checks in or checks out all units belonging to the unit venture, for all combined product 
codes, for which it is valid.

The reason that you check in unit ventures is so that the system can carry out the required edits. For example, 
the system checks to see if any prior period notifications are required for that unit venture.

The reason that you check out the unit venture is so that you can change data in the unit venture.

You cannot check in unit ventures whose tracts are defined at a product level.

Checking in unit ventures updates marketing groups defined at the unit level for plant NGLs and oil/
condensate. The check-in of divisions of interest also updates marketing groups defined at the unit level.
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Prerequisites

For check-in :

Units have been created and the total tract participation factor is 1.00.Additionally, the necessary edits were 
successful in the check-in process.

For check-out :

The unit should have already been checked in.

Procedure

For check-in :

1. At the SAP Easy Access Menu, Choose Logistics → Production and Revenue Accounting → Ownership → 
Venture → Change .

2. The Change Joint Venture Maintenance: Initial Screen is displayed.
3. Enter the unit venture and company code, and then select Enter .

The Change Joint Venture Maintenance: Overview Screen is displayed. If units have been defined for this 
unit venture, a check-in pushbutton will be dynamically displayed on the application toolbar at the top of 
the screen.

4. To check in all the units defined for this unit venture, select Check-in .

Prior period notifications will be generated if you changed or edited the units that were checked out. If there 
were any errors during processing, an error log is displayed. If check-in was successful, there will now be a Log 
pushbutton at the top of the screen. You can now select that pushbutton to view the results of the check-in.

For check out :

The procedure is the same as above (at step 3., select Check-Out), only, no logs are displayed.

2.4.3   Displaying Unit Ventures 

Use

Use this to display all ventures that have been defined as unit ventures in the “ Create Joint Venture 
Maintenance ” transaction. You can list unit ventures that are “checked in”, or “checked out” (in other words – 
in the “check in area” or the “check out area”).
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Procedure

1. At the SAP Easy Access Menu, select Logistics Production and Revenue Accounting Ownership Unit Venture 
Unit Venture List Processing

The Unit Venture List Processing screen is displayed.

On this selection screen, company code, combined product code, and effective from date are required fields. 
The venture is also required, if the company code is not entered. A “scope of selection” choice: “checked in 
area” or “checked out area” is also required.

Fill in the relevant selection screen fields.

In the Scope of List screen area, select either Checked-In Area or Checked-Out Area .

Select Execute .

The Unit Venture List Processing screen is displayed.

Result

The system produces a list based on the selection criteria chosen, of records that conform with that selection.

2.4.4  Tract by Tract List Processing 

Use

Tract by tract list processing is a standard selection process that allows you to, given specific selection criteria, 
produce a list of units, unit details, and tract details. For example, for a given division of interest (DOI), you can 
display a list of units that have that DOI as one of the tracts. You can limit selection either by DOI and/or by date 
range.

Procedure

At the SAP Easy Access Menu, choose Logistics → Production and Revenue Accounting → Ownership → Unit 
Venture → DOI Tract by Tract List Processing .

1. Carry out your selections, based on DOI and/or date range (in other words, enter a company code, venture, 
DOI, combined product code, and effective date range for the selection).
Select Execute .
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The system now displays a list based on your selections.

Result

A list is produced, which lists units based on the selections chosen. The list contains the following: units and 
unit details (company code, unit venture, combined product code), and tracts and tract details (tract name, 
tract number, and tract participation factor).

2.4.5   Displaying DOI Tracts per Owners 

Use

Use this to list tracts with DOI information, in which a specific owner appears. It also lists the net revenue 
interest (NRI) and the gross revenue interest (GRI). Once the list of records is displayed, you can select a 
record, and recalculate the gross revenue interest.

Procedure

● At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Ownership → Unit 
Venture → DOI Tract by Owner List Processing .

The DOI Tract by Owner List Processing screen is displayed.

● On that screen, enter the relevant data for your search (company code, venture, and owner are required 
entries); you can also enter an effective date range to further limit selection).

3. Select Execute .

The DOI Tract by Owner List Processing: List Viewer screen appears, which lists tracts with DOI information, in 
which the specified owner appears (“tracts by owner”). It lists the owner, the unit GRI, unit NRI, tract, tract 
name, and effective date range, along with other information.

Table 16:

Recalculating the GRI :

If you want to, you can now recalculate the GRI for an owner from the list screen.

1. To do that, in the list, select an owner and then select Calculate GRI .
The system displays a dialog box asking you for the GRI start date.

2. Select a start date for the (re)calculation.
3. Select Continue .

The system now (re)calculates the GRI.
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2.5 Generating a DOI Schedule A Report 

Use

Use this to generate a division of interest Schedule A Report – which is a report that lists the division of 
interest, owner details, and decimal amount per owner, for a specific division order (property), for a specific 
date.

After you have generated the report, you can then print it out and send it to the owners involved in the DOI. The 
main purpose of the report is for anyone working in, for example, the land department of an oil and gas 
company, at any time, to print the division order details. You can also sort and print the owner records by 
interest type.

Details of the report include:

Header details:

Table 17:

● State and county information
● Field ID
● Effective date
● Operator

Legal description

 

Owner details:

Table 18:

● Owner (number)
● Taxpayer ID
● Owner interest sequence
● Owner name and address
● Decimal interest
● Combined product of the division order
● Pay status of the owner

 

By making settings in the IMG, you can suppress some of the fields listed above from display when the report is 
run (in the IMG, choose Industry Solution Oil & Gas (PRA) Ownership Schedule ‘A’ report field settings ).
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Procedure

From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Ownership DOI 
Schedule ‘A’ Report

The DO Schedule A Report screen is displayed.

On the DO Schedule A Report screen, on the Business Key Fields screen tab , enter data in the following fields: 
Company code, venture (‘joint venture’), division of interest, and effective date (the relevant date for your 
search).

Here, the mandatory fields are: company code, venture, combined product, and effective date. The DOI field is 
not mandatory for running the report.

If you enter data in the DOI field, the system will print the Schedule A Report for the specific DOI that you 
entered; otherwise, the system prints schedule A Reports for all division of interests for the specified venture.

Select the Additional Parameters screen tab.

In the Owner Selection area, the following options exist:

- Full DO print – Select this to print all the owners in the DOI

- Partial DO print – Select this to print less than all of the owners. If you select Partial DO print , you must then 
select either:

- Working interest owners (to print only working interest owners), or

- Non-working interest owners

- Regardless of the option you choose, you can also enter the owner numbers you would like to print (if you 
know the specific owner numbers). To do that, in the Owner field, enter the owner number (or a range of owner 
numbers, for example, 1 to 99999).

- If you want to have each owner printed on its own separate page, set the Print 1 owner per page flag.

Define exactly what you want to print out in the Form Print Options section of the Additional Parameters screen 
tab:

- Schedule A – To print the Schedule A Report.

- Labels – To print labels for envelopes when you send out the reports.

Note that you can choose either Schedule A and Labels , or just Schedule A . You cannot choose just Labels .

In the Sort by screen area, you can apply a sort to the list that is generated, by:

- Owner number  

- Owner name

Note that sorting only occurs by interest type (for example: for working interest owners).
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2.6 Using the Responsibility ID in Ownership 

Use

Use this to create, display, change, or delete a record that links a venture/DOI, product code, and responsibility 
ID, for data access and security purposes.

Responsibility IDs are used throughout the SAP system, and are data and user-specific security master 
records. The responsibility ID gives a user specific data access privileges to certain key items, based on the 
assigned responsibility. This distinction allows the classification of specific items according to the 
organization’s responsibility relationships. For example, a user must have responsibility for a contract to 
maintain that contract.

A responsibility hierarchy can be created to allow certain responsibility groups access to specific items. 
Responsibility is assigned at both the user level and object level. The responsibility ID consists of three parts.

Examples:

Table 19:

Responsibility ID Description User Responsibility ID Item Responsibility ID

‘******’ Global responsibility Can update all items regard­
less of Responsibility ID

Can be updated by all Re­
sponsibility IDs

‘AC****’ AC Group Responsibility Can update any item with a 
Responsibility ID beginning 
with an AC

Can be updated by global re­
sponsibility and all Responsi­
bility IDs beginning with AC

‘999999’ Individual Responsibility 
999999

Can update items with Global 
Responsibility or Individual 
Responsibility of 999999

Can be updated by Global 
Responsibility or Individual 
Responsibility 999999

For example, a company might want to create an Accounting Responsibility Group, a Marketing Responsibility 
Group, and an Engineering Responsibility Group. Individual responsibility IDs could then be created for each of 
thosegroups (some users may fit into their company’s responsibility hierarchy in more than one group). For 
example, a user might be responsible for ten items under his responsibility ID. When a responsibility ID is set 
up, a description is entered to describe what the Responsibility ID is for.

You can create a responsibility ID for more than one venture/DOI/product code.

Procedure

● From the SAP Easy Access Menu, choose Logistics → Production and Revenue Accounting → Ownership → 
Responsibility ID .

The Responsibility ID: Initial Screen is displayed.
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1. From that screen, you can create, display, or delete responsibility ID – venture/DOI – product code 
records.

Table 20:

To create Select Create , and then enter a venture, DOI, product 
code, and a responsibility ID that you would like assigned 
to that combination. Save your record.

To display / change Enter selection criteria and select Execute .

To delete Select a record and then choose Responsibility ID → 
Delete .

2.7 Creating a DOI to MP/WC Cross-Reference 

Use

Use this to maintain (create) a relationship between a well completion and a base DOI, for a given material 
(major product) and effective date range.

The purpose of the DOI/WC cross reference is to link a division of interest (DOI) to well completion(s) and 
measurement point(s). This information must be set up before a Valuation cross reference can be set up at 
either the measurement point or the well completion level.

You can also process a list of DOI relationships (all relationships for a given company and venture, or a given 
well completion, etc.).

The list is generated based on your selection criteria. The system looks at which pushbutton you choose as the 
starting point: well completion , measurement point , or company/venture/DOI . From the list that is then 
generated, you can select an individual record for maintenance, display, deletion, or creation with reference . For 
example: all relationships for a given company and venture, or a given well completion can be retrieved and 
displayed in report (list) form.

Procedure

1. At the SAP Easy Access menu, Choose Logistics → Production and Revenue Accounting → Ownership → DOI to 
MP/WC Cross Reference .

The DOI Cross Reference: Initial Screen is displayed.

● Select Create .

The DOI Cross Reference: Create screen is displayed.

● Choose the creation method - based on either: well completion or measurement point .
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1. Enter the relevant data (measurement point or well completion and company/venture/DOI); additional 
fields are: major product code and effective from and effective to dates).
Choose Enter
Enter the relevant data and then select Save .
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3 Upstream Graphics 

Purpose

The Upstream Graphics application is a highly integrated component of the Production and Revenue 
Accounting system; the data that you enter into the application updates the corresponding SAP databases with 
virtually no delay.

Upstream Graphics is a graphics engine that allows you to maintain and view data graphically.The Upstream 
Graphics display includes icons representing different types of entities, such as well completions.

3.1 Upstream Graphics Functions

The features of upstream graphics are divided into functions that are standard as well as functions that are 
view-specific .

The standard functions are available for any view, while the view-specific features are currently available for use 
with the Production application area.

For detailed information about standard functions, see Standard Upstream Graphics Functions [page 66] .

For detailed information about view-specific functions, see View-Specific Upstream Graphics Functions [page 
73] .

3.2 Standard Upstream Graphics Functions

The standard functions are available for any view, while the view-specific functions are currently available for 
use with the Production application area.

Standard Upstream Graphics functions are listed below.

Using Upstream Graphics Views [page 67]

Inserting Entities into the Upstream Graphics Display [page 68]

Inserting a Free Form Bitmap into the Upstream Graphics Display [page 69]

Inserting Free Form Text into the Upstream Graphics Display [page 70]

Maintaining Entities in Upstream Graphics [page 71]

Using Variants in Upstream Graphics [page 72]

See also:

View-Specific Upstream Graphics Functions [page 73]
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3.2.1  Using Upstream Graphics Views 

Use

Use the upstream graphics view function to arrange the display.

Prerequisites

At the Upstream Graphics Editor: Initial Screen , use the Display Info field to specify how to display the entity. 
For example, specify Entity Description to display each entity in a network with a description label. Or specify 
Volumes to display monthly or daily allocation amounts for each entity in a network.

In a Traverse Starting Point section, choose from one of the following:

Complete Delivery Network to view all of the entities in a network

Start on Measurement Point to view a network downstream or upstream of a measurement point

Start on Well Completion to view a network downstream of the well completion that you specify

Activities

Customizing Your View/Zooming

You can arrange the icons displayed by clicking and dragging them as required. Also, you can either enlarge the 
view of your document by choosing View Zoom in or you can reduce the view of your document by choosing 
View Zoom out .

Displaying a Section of Large Network

If a network is large and you would like to display only a section of it, you can select which section to display by 
sizing and moving the highlighted rectangle at the bottom left corner of the screen.

Using the Complete View

To display the entire network on the screen, not just a section of it, choose View Complete view

Grouping Nodes

Sometimes there are large numbers of entities connected to one node. To reduce the number of entities 
displayed, you can group them under one icon.

To group entities, select all the entities that you want to group together by holding down the SHIFT key and 
clicking the mouse button. Then choose Edit Group nodes .

The Please enter desired text dialog box appears.

In the Group text field enter a name for the group of entities. Then choose Enter .

The system highlights the selected group of entities.

Choose Edit Groups Collapse .
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The system displays an icon labeled with the name you assigned to the entities.

Using the Alignment Feature

To automatically align all of the nodes, choose Edit Align . The Confirm Operation dialog box appears. Select 
whether to adjust only selected nodes or links, or the entire graph. The system then aligns the nodes vertically 
and horizontally.

To align one node, select the node and then choose Select Align

Refreshing the Screen

To refresh the screen, choose View → Refresh Display as required.

Saving the Default View

To save the default view in the particular way that you have arranged it, choose Save .

When you choose save, the system replaces the default view that was saved previously.

3.2.2  Inserting Entities into the Upstream Graphics Display 

Use

Use this function to insert entities into the graphics display.

Prerequisites

At the Upstream Graphics Editor: Initial Screen , use the Display Info field to specify how to display the entity. 
For example, specify Entity Description to display each entity in a network with a description label. Or specify 
Volumes to display monthly or daily allocation amounts for each entity in a network.

In a Traverse Starting Point section, choose from one of the following:

Complete Delivery Network to view all of the entities in a network

Start on Measurement Point to view a network downstream or upstream of a measurement point

Start on Well Completion to view a network downstream of the well completion that you specify

Activities

Option 1

To insert an existing entity, at the bottom right corner of the screen, click on an icon to select it and then 
release the mouse button.
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The cursor changes to a white box outlined in black.

Position the cursor where the entity should be inserted, and then click the mouse again.

Either choose Add an existing object to enter the ID for an entity that already exists or choose Create a new 
object to set up a new entity. Then choose Enter and make additional entries as required.

The system displays the entity.

To view the icon label, place the cursor over the icon.

Option 2

If you choose to hide the free-form area of the screen by choosing View→ Display , you must insert an existing 
well completion or measurement point by choosing Add Well Completion or Add Measurement Point .

In the next dialog box enter either the well completion ID or the measurement point ID. Then choose Enter .

The system displays the entity.

 

3.2.3  Inserting a Free Form Bitmap 

Use

Use this function to insert a bitmap into the display. You can configure this function in Customizing to establish 
your own particular set of bitmaps.

Prerequisites

At the Upstream Graphics Editor: Initial Screen , use the Display Info field to specify how to display the entity. 
For example, specify Entity Description to display each entity in a network with a description label. Or specify 
Volumes to display monthly or daily allocation amounts for each entity in a network.

In the Traverse Starting Point section, choose from the following:

Complete Delivery Network to view all of the entities in a delivery network

Start on Measurement Point to view a network downstream or upstream of a measurement point

Start on Well Completion to view a network downstream of the well completion that you specify
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Activities

To insert a free form bitmap, at the bottom right corner of the screen, click the Free Form Bitmap icon and 
release the mouse.

The cursor changes to a white box outlined in black.

Position the cursor where the bitmap should be inserted, and then click the mouse again.

The Please select a bitmap to insert dialog box appears.

Complete the Free From Entity dialog box appears.

Complete the Line 1 and Tool Tip fields as required. Then choose Enter .

The system displays the bitmap.

When inserting entities, bitmaps, and text, keep in mind that when the cursor is not positioned to mark a point 
of insertion, the system inserts the object in the upper left corner of the screen, which is the default location.

 

3.2.4  Inserting Free Form Text into the Upstream Graphics 
Display

Use

Use this function to insert free-form text into the display.

Prerequisites

At the Graphics Editor: Initial Screen , specify the entity and use the Display Info field to specify how to display 
the entity. For example, specify Entity Description to display each entity in a network with a description label. 
Or specify Volumes to display monthly or daily allocation amounts for each entity in network.

In the Traverse Starting Point section, choose from one of the following:

● Complete Delivery Network to view all of the entities in a delivery network
● Start on Measurement Point to view a network downstream or upstream of a measurement point

● Start on Well Completion to view a network downstream of the well completion that you specify
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Activities

Using free form text is useful, for example, when you need to include a text note to be included on a print out.

● To insert free form text, at the bottom right corner of the screen, click the Free Form Text icon and release 
the mouse.

The cursor changes to a white box outlined in black.

● Position the cursor where the text should be inserted, and then click the mouse again.

The Please select a text format to insert dialog box appears.

● Complete the Free Form Entity dialog box and then choose Enter .

The Please change to desired text dialog box appears.

● Complete the Line 1 and Tool Tip fields as required. Then choose Enter .

The system displays the text box.

3.2.5  Maintaining Entities in Upstream Graphics

Use

Use this function to maintain data for entities in upstream graphics.

Prerequisites

At the Graphics Editor: Initial Screen , specify the entity and use the Display Info field to specify how to display 
the entity. For example, specify Entity Description to display each entity in a network with a description label. 
Or specify Volumes to display monthly or daily allocation amounts for each entity in network.

In the Traverse Starting Point section, choose from one of the following:

● Complete Delivery Network to view all of the entities in a delivery network
● Start on Measurement Point to view a network downstream or upstream of a measurement point

● Start on Well Completion to view a network downstream of the well completion that you specify

Activities

Creating Entities with Reference

● If an entity already exists with the data that is required for a new entity that you need to create, you can 
copy the data from the existing entity.

To do so, click the existing entity and then choose Edit  Copy Entity  .
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● The system displays another icon for the entity in the upper left corner of the screen.

Adding a Connection Between Entities

● Choose Edit  Connect Entities  .

The cursor appears as a pencil icon.

● Click the cursor on one icon and continue holding the mouse button. Then draw the connection and 
release the button over the second icon to complete the connection.

Changing or Displaying an Entity or Icon

● To change or display an entity or connection, click the entity or connection and then choose either Edit 
 Change Entity  or Edit  Display Entity  . In the Select field, designate the attribute you would like 

to change or display.

3.2.6  Using Variants in Upstream Graphics 

Use

Use this function to create or retrieve variants as required. A variant represents a unique view that you 
establish.

Prerequisites

At the Graphics Editor: Initial Screen , specify the entity and use the Display Info field to specify how to display 
the entity. For example, specify Entity Description to display each entity in a network with a description label. Or 
specify Volumes to display monthly or daily allocation amounts for each entity in network.

In the Traverse Starting Point section, choose from one of the following:

Complete Delivery Network to view all of the entities in a delivery network

Start on Measurement Point to view a network downstream or upstream of a measurement point

Start on Well Completion to view a network downstream of the well completion that you specify

Activities

Creating a Variant

To create a variant, which saves the current arrangement of the view without affecting the default view, choose 
Save As New Variant .

The Please enter a new variant & description dialog box appears.
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Enter a name for the variant in the Graphics Var field and a description for the variant in the Graph Var Descs 
field. Then choose Enter .

Retrieving a Variant

When you first access the Graphics Editor for any network, the system automatically displays the default view. 
If instead you would like to retrieve a variant with a different arrangement of the view, choose Apply Variant .

The Please select a variant to apply dialog box appears.

Select a variant in the Graphics Var field. Then choose Enter .

The view for the variant appears.

3.3 View-Specific Upstream Graphics Functions 

The following view-specific functions are currently available for use with the Production application area.

Inserting an Existing Well Completion or Measurement Point in a Network [page 73]

Creating Effective Dated Records [page 74]

Creating Entities [page 75]

Inserting Multiple Entities at Once [page 77]

Changing or Displaying Entities and Connections [page 78]

Maintaining and Displaying Connections [page 79]

Validating the Network [page 80]

Launching Other PRA Transactions from the Upstream Graphics [page 81]

See also:

Standard Upstream Graphics Functions [page 66]

3.3.1  Inserting an Existing WC or MP in a Network 

Use

Use this function to insert an existing well completion or measurement point into a network.

Prerequisites

At the Graphics Editor: Initial Screen , specify the entity and use the Display Info field to specify how to display 
the entity. For example, specify Entity Description to display each entity in a network with a description label. Or 
specify Volumes to display monthly or daily allocation amounts for each entity in network.
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In the Traverse Starting Point section, choose from one of the following:

Complete Delivery Network to view all of the entities in a delivery network

Start on Measurement Point to view a network downstream or upstream of a measurement point

Start on Well Completion to view a network downstream of the well completion that you specify

Activities

Option 1

To insert an existing entity in the network, at the bottom right corner of the screen, click either the Well 
Completion or the Measurement Point icon and release the mouse.

The cursor changes to a white box outlined in black.

Position the cursor where the well completion or measurement point should be inserted, and then click the 
mouse again.

Either the Well/Well completion dialog box or the Measurement Point dialog box appears.

Either choose Add existing object to enter the ID for an entity that already exists or choose Create a new object 
to set up a new entity. Then choose Enter and make additional entries as required.

The system displays the entity.

To view the icon label, place the cursor over the icon.

Option 2

If you choose to hide the free-form area of the screen by choosing View → Display , you must insert an existing 
well completion or measurement point by choosing Add Well Completion or Add Measurement Point .

In the next dialog box enter either the well completion ID or the measurement point ID. Then choose Enter .

The system displays the entity.

3.3.2  Creating Effective Dated Records 

Use

Use this feature to create effective-dated records for measurement points and well completions in the network. 
You can create records for the following transactions.

Measurement Point Dated

Measurement Point Profile

Measurement Point Volumes
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Well Completion Dated

Well Test

Well Completion Downtime

Prerequisites

At the Graphics Editor: Initial Screen , specify the entity and use the Display Info field to specify how to display 
the entity. For example, specify Entity Description to display each entity in a network with a description label. Or 
specify Volumes to display monthly or daily allocation amounts for each entity in network.

In the Traverse Starting Point section, choose from one of the following:

Complete Delivery Network to view all of the entities in a delivery network

Start on Measurement Point to view a network downstream or upstream of a measurement point

Start on Well Completion to view a network downstream of the well completion that you specify

Activities

Select a measurement point or well completion. Then choose Edit → Change Entity

The Create addition dialog box appears.

Select the transaction and choose Enter .

The initial screen of the transaction appears.

Complete the fields, including the effective date fields, in the transaction as required. Then save the 
transaction.

 

 

3.3.3  Creating Entities 

Use

Use this function to create a new entity, enter the required information in the entity’s record, and then insert 
the new entity into the display.
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Prerequisites

At the Graphics Editor: Initial Screen , specify the entity and use the Display Info field to specify how to display 
the entity. For example, specify Entity Description to display each entity in a network with a description label. Or 
specify Volumes to display monthly or daily allocation amounts for each entity in network.

In the Traverse Starting Point section, choose from one of the following:

Complete Delivery Network to view all of the entities in a delivery network

Start on Measurement Point to view a network downstream or upstream of a measurement point

Start on Well Completion to view a network downstream of the well completion that you specify

Activities

Creating a New Well Completion or Measurement Point and Inserting it in a Network

To insert a new entity into the network, at the bottom right corner of the E&P Graphics Editor screen, click 
either the Well Completion or the Measurement Point icon and release the mouse.

The cursor changes to a white box outlined in black.

Position the cursor where the well completion or measurement point should be inserted , and then click the 
mouse again.

The Insert dialog box appears.

Choose Create a new object and then choose Enter .

The Create <Measurement Point or Well>: Initial Screen appears.

Complete the fields in the transaction as required, and then save it.

To review information about completing the Create Measurement Point or Well transaction, choose Help → 
Application Help from either of the transactions.

After you save the well completion or measurement point, go back to view the icon for the newly-created entity.

To view the icon label, place the cursor over the icon.

Creating an Entity with Reference

If an entity already exists with the data that is required for a new entity that you need to create, you can copy 
the data from the existing entity.

To do so, click the existing entity in the Graphics Editor, then choose Edit → Copy Entity .

The Create <Measurement Point or Well>: Initial Screen appears.

Complete the fields in the transaction as required, and then save it.
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To review information about completing the Create Measurement Point or Well transaction, choose Help → 
Application help from either of the transactions.

After you save the well completion or measurement point, go back to the E&P Graphics Editor to view the icon 
for the newly-created entity.

3.3.4  Inserting Multiple Entities at Once 

Use

Use this function to insert two or more entities into the display at one time.

Prerequisites

At the Upstream Graphics Editor: Initial Screen , specify the entity and use the Display Info field to specify how 
to display the entity. For example, specify Entity Description to display each entity in a network with a 
description label. Or specify Volumes to display monthly or daily allocation amounts for each entity in network.

In the Traverse Starting Point section, choose from one of the following:

Complete Delivery Network to view all of the entities in a delivery network

Start on Measurement Point to view a network downstream or upstream of a measurement point

Start on Well Completion to view a network downstream of the well completion that you specify

Activities

This function is available for entities that already exist; it is not available for creating and inserting multiple, new 
entities at once.

Choose Mass Insertion of Entities .

The Delivery Network Mass Insert screen appears.

Select either the Measurement Points or Well Completions radio buttons, as required. Then enter the entity 
IDs. Then choose Execute .

The Delivery Network Mass Insert screen (2) appears.

Select the entities to be included. Then choose Insert Checked Entities .

The system displays the entities in the upper left corner of the screen.
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Connect the entities as required.

3.3.5  Changing or Displaying Entities and Connections 

Use

Use this function to change or display either an entity or a connection.

Prerequisites

At the Upstream Graphics Editor: Initial Screen , specify the entity and use the Display Info field to specify how 
to display the entity. For example, specify Entity Description to display each entity in a network with a 
description label. Or specify Volumes to display monthly or daily allocation amounts for each entity in network.

In the Traverse Starting Point section, choose from one of the following:

Complete Delivery Network to view all of the entities in a delivery network

Start on Measurement Point to view a network downstream or upstream of a measurement point

Start on Well Completion to view a network downstream of the well completion that you specify

Activities

Changing or Displaying an Entity or Connection

To change or display an entity or connection, click the entity or connection and then choose either Edit → 
Change Entity or Edit → Display Entity . In the Select field, designate which attribute you would like to change or 
display.

The change or display screen for the transaction appears.

Complete the fields in the transaction as required, and then save it.

To review information about completing the transaction, choose Help → Application help .

After you save the transaction, go back to the Graphics Editor to view the icon for the entity that you changed or 
displayed.

Hiding / Showing Well Completions

To hide the well completions displayed on the screen choose Hide/Show Well Completions . (This is useful 
when working with a network that includes hundreds of wells.)

To display the well completions, choose Hide/Show Well Completions again.
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Changing or Displaying Delivery Network Information

To change or display information about the delivery network, choose Change Delivery Network Information .

The Delivery Network dialog box appears.

In the Delivery Network field select the type of delivery network record that you would like to change or display. 
Then choose Change , Display or Create additional .

The Create additional feature allows you to change effective dates as required.

Displaying Effective Dates for Connections

Choose Toggle Effective Dated Information on Links to display the effective dates for the connections. To 
remove the display of effective dates, choose Toggle Effective Dated Information on Links again.

3.3.6  Maintaining and Displaying Connections 

Use

Use this function to maintain and display connections between entities.

Prerequisites

At the Upstream Graphics Editor: Initial Screen , specify the entity and use the Display Info field to specify how 
to display the entity. For example, specify Entity Description to display each entity in a network with a 
description label. Or specify Volumes to display monthly or daily allocation amounts for each entity in network.

In the Traverse Starting Point section, choose from one of the following:

Complete Delivery Network to view all of the entities in a delivery network

Start on Measurement Point to view a network downstream or upstream of a measurement point

Start on Well Completion to view a network downstream of the well completion that you specify

Activities

End Date Link

To change the date through which the link is effective, choose End Date Link .

The Change Downstream Node: Overview screen appears.

Change the date as required in the Effective To field. Save your change, then go back.
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Adding a Connection Between Entities

Choose Edit → Connect Entities .

Click the cursor on one icon and continue holding the mouse button. Then draw the connection and release the 
button over the second icon.

The Create DN Downstream Node: Initial Screen appears.

A black line represents normal product flow downstream, while a red line represents gas lift, and a green line 
represents return lease fuel.

● Complete the fields in the transaction as required, and then save it.

To review information about completing the transaction, choose Help → Application help .

After you save the transaction, go back to the Graphics Editor to view the connection.

Deleting a Connection Between Entities

To delete a connection between entities, click the connection. Then choose Delete Entities .

The Delete DN Downstream Node: Overview screen appears.

Choose save to delete the connection.

Deleting connections deletes only the effective-dated links from the system. Measurement point and well 
completion records are not deleted as well; they remain in the system.

Moreover, when deleting effective-dated links, verify that the true intent is to delete the link and not end-date a 
link. To end-date a link, see the End Date Link section above.

3.3.7  Validating the Network 

Use

Use this function to verify that a delivery network is set up without errors.

Prerequisites

At the Upstream Graphics Editor: Initial Screen , specify the entity and use the Display Info field to specify how 
to display the entity.For example, specify Entity Description to display each entity in a network with a 
description label.Or specify Volumes to display monthly or daily allocation amounts for each entity in network.

In the Traverse Starting Point section, choose from one of the following:
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● Complete Delivery Network to view all of the entities in a delivery network
● Start on Measurement Point to view a network downstream or upstream of a measurement point
● Start on Well Completion to view a network downstream of the well completion that you specify

Activities

● To verify that the delivery network is set up without errors, choose Validate Errors . This function verifies 
that all required nodes are connected together. For example, if there is a receipt point in a network, the 
function checks for a corresponding supply point.

3.3.8  Launching Other PRA Transactions from the Graphics 
Editor 

Use

Use this function to launch PRA transactions from Upstream Graphics.

Prerequisites

At the Graphics Editor: Initial Screen , specify the entity and use the Display Info field to specify how to display 
the entity. For example, specify Entity Description to display each entity in a network with a description label. Or 
specify Volumes to display monthly or daily allocation amounts for each entity in network.

In the Traverse Starting Point section, choose from one of the following:

Complete Delivery Network to view all of the entities in a delivery network

Start on Measurement Point to view a network downstream or upstream of a measurement point

Start on Well Completion to view a network downstream of the well completion that you specify

Activities

To launch PRA transactions from Upstream Graphics, choose Launch Pad .

The Display Structure screen appears.

Navigate to the required transaction and choose Execute .
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When you access a standard SAP transaction in this way, keep in mind that if you navigate to another standard 
SAP transaction and then go back, you will return to the SAP Easy Access menu, not the Upstream Graphics.

For example, if you access the Change Measurement Point ID transaction from Upstream Graphics, then 
choose Measurement Point → Display and then go back, you will return to the SAP Easy Access menu.

 

 

 

3.4 Downloading Upstream Graphics Bitmaps 

Use

Use this transaction to download Upstream Graphics bitmaps, which are used in the Upstream Graphics 
display of a network.

Activities

1. From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Tools
Upstream Graphics Bitmaps/Icons Maintenance Download Upstream Graphics/Bitmaps  .
The Download Bitmaps screen appears.

2. Select Execute .
The Download Bitmaps/Flashforms screen appears.

3. From the list, select the bitmap(s) that you would like to download. Then select Download Selected Entries .
The Download Bitmaps/Flashforms screen appears, displaying the file path to which the system 
downloaded the bitmap(s).

3.5 Uploading Upstream Graphics Icons/Bitmaps 

Use

Use this transaction to upload bitmaps from a local file so that they can be downloaded for use in the Upstream 
Graphics display of a network.

Note
SAP delivers standard bitmaps that are stored in the ERP System, but it is possible to upload your own 
bitmaps to the ERP system using this transaction.
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Activities

1. From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Tools
Upstream Graphics Icons/Bitmaps Maintenance Upload Upstream Graphics Icons/Bitmaps  .
The Upload Bitmaps screen appears.

2. Select Execute .
The Select bitmaps to upload dialog box appears.

3. Select the bitmap(s) that you would like to upload, and then select Open .
The Bitmap/Flashform Maintenance screen appears, displaying the bitmap(s)that you uploaded, as well as 
the status (such as “uploaded successfully”).

3.6 Deleting Upstream Graphics Bitmaps 

Use

Use this transaction to delete bitmap files that have been uploaded.

Caution
Deleting bitmap files makes them not only unavailable to you, but also unavailable to other users.

SAP recommends that you consider this before deleting any files, and that you ensure that the file is indeed 
outdated and that no other users will need to use it in the future.

Procedure

1. From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Tools
Upstream Graphics Icons/Bitmaps Maintenance Maintain Upstream Graphics Icons/Bitmaps  .
The Bitmaps/Flashform Maintenance screen appears.

2. Select Execute .
3. Select the files that you would like to delete.
4. Select Delete .
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4 Production

Purpose

Allocating Volumes

The Production application area in the Production and Revenue Accounting (PRA) product is designed to 
define allocation rules and to process master data for entities including well completions, measurement points, 
and delivery networks.The Production application area allocates volumes for a material such as oil or gas from 
a measurement point back to all relevant well completions.

Allocation rules are defined in the Production application area in order to define how volume allocation is to be 
carried out (see: Volume Allocation [page 128]). Allocation rules are defined at well completion, measurement 
point, and delivery network levels within a delivery network in order to determine a specific well completion 
proportion of the production of a measured volume.

In addition, a well completion production can be determined using functions specific to your company.

Processing Master and Transactional Data

Master data is entered in records with start and end dates, thereby protecting the original version of a record, 
as well as storing each subsequent version of the record.In addition to processing master data for entities, the 
Production application area features transactions that capture data resulting from daily activities such as 
tracking well downtime, and recording well test information.

4.1 PRA General Master Data Set-Up 

Purpose

There are two types of master data set-up required to run PRA:

● General master data set-up (described here)
● Master data entity set up (described in:

General master data set-up is necessary, so that the materials you want to use will be able to be used in 
subsequent processes in PRA, such as PRA-Revenue and Statistical Key Figures (SKF) in SAP-Controlling (the 
Core CO module). 
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PRA uses many master data entities such as materials, wells and product codes. Some of the master data 
entities need to be linked (cross-referenced) to SAP Core objects or other PRA entities, for use in specific PRA 
and Core processes.

In this process, you can create those required links.

● The general master data set-up process involves the following three transactions:
● Setting up a product code reference for materials. This allows your PRA materials that you are using to be 

cross-referenced to Core materials, which is necessary to use the materials in certain PRA processes 
which are ‘downstream’ from (subsequent to) Production (see: Creating Material to Product Code Cross-
References [page 85] ).

● Reclassification of materials to product codes. Reclassification of materials allows PRA-Revenue to identify 
materials, in specific Revenue processes (see: Reclassifying Materials with Product Codes [page 86] ).

● SKF cross-referencing allows you to cross-reference PRA materials to statistical key figures (SKF) for 
reporting to the SAP CO (Controlling) module (see: Creating an SKF Cross-Reference [page 88] ).

There are two aspects to setting up master data for PRA-Production:

● The three transactions detailed here
● Setting up PRA-Production master data entities such as wells, well completions, etc. (see: PRA Master 

Data Entities [page 89] ).

Prerequisites

Materials that you are linking to have to already exist in the SAP General Material table, which is a Core table.

Process Flow

Carry out the cross referencing in the transactions, as required.

Result

The materials will be able to be used in PRA-Revenue and CO-SKF.

4.1.1  Creating Material to Product Code Cross-References 

Use

Use this to set up the requisite material to product code cross reference record.
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The record that you create here ties a material in the SAP Core General Material Data table, to a PRA product 
code. This allows Core materials to be used in PRA-Production.

Prerequisites

The material that you are linking here has to first exist in the SAP Core General Material Data table.

Procedure

1. From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production → 
General Master Data Maintenance → Material and Product Code Proc Xref .

The Material and Product Code (processing) Xref: Maintenance screen is displayed.

1. Use the matchcode list box for the Material field to choose a material that already exists (in the SAP Core 
General Data table). Enter that material number in the Material field.

1. Select Create .

The Material and Product Code (processing) Xref: Create screen is displayed.

The material ID that you chose will be defaulted into the Material field.

1. In the Major Product field, enter a PRA major product code that you would like to link to the Core material. 
In the Product Code field, enter a PRA minor product code that you would like to link the Core material to.

2. Save your record.

Example

For example, you could take a material HIMP-MAH, and link it with major product “Water“, which is product 
code 05.

4.1.2  Reclassifying Materials with Product Codes 

Use

Use this to reclassify PRA product codes.

In PRA-Production, materials do not have to be linked to wells, but in PRA-Revenue, materials are linked to 
wells. If you know that you will need to use a material in Revenue, you can create a record here that assigns the 
material a new product code: a major product code and a minor product code. When Revenue runs, specific 
processes in Revenue will ‘look for’ materials that have been reclassified. The reclassified product code is used 
to determine the material that should occur at certain types of wells.
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A material is created in Production, and allocated, but that material has to be “recognized” by PRA-Revenue. 
The material has to be reclassified to be recognized by Revenue. You create (reclassify) the material under a 
different material ID for Revenue. The new reclassified material that you enter will depend on what type of well 
the material has been allocated to.

Here, you can create not just one, but all the possible reclassifications for a specific material (in other words, 
multiple reclassifications).

For more information on this, please see the Example section below in this document.

Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production → 
General Master Data Maintenance → Reclassification of Product Codes .

The Reclassification of Product Codes: Maintenance screen is displayed.

1. On that screen, in the Material field, enter the material that you would like to reclassify. In the Reclass 
MajPd field, enter the major product code that you would like to reclassify the material as, and in the 
Reclass PD field, enter the minor product code that you would like to use reclassify the material under.

1. Select Create .

The Reclassification of Product Codes: Create screen is displayed. The fields on the screen show the 
reclassification that you have already made. In the Reclass Matnr field, enter the material that you would like to 
reclassify the material under.

1. Select Save .

Result

The result is that the material is reclassified, and can be used in PRA-Revenue processes, which require 
reclassified materials.

Example

For example, I might have a material, HIMP-MAH set up in PRA as “oil condensate mix”. I know that the material 
is used not only in Production, but also in Revenue processes, and I need to reclassify it.

Using this transaction, I can create a record that reclassifies the material to material 100 = oil, and a record that 
reclassifies the material to 300 = condensate.

Subsequent programming logic exists in Revenue, which dictates: if an oil well is involved, use material 100, and 
if a condensate well is involved, use material 300.
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4.1.3  Creating an SKF Cross-Reference 

Use

Use this to create a record that links a material / volume type to an SKF Type code (Statistical Key Figure type 
code). The record is used so that material volume data can be used in SKF controlling (see: Carrying Out an 
SKF Job Submission [page 197] ).

SKF information: Production well completion volumes for pre-configured material / volume type (VT) 
combinations and production day information are extracted and collected in the system, in order to post the 
summed up results to the SAP CO Module as statistical key figure (SKF) volumes.

Prerequisites

The material has to exist, that you are cross-referencing.

Procedure

1. From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production → 
General Master Data Maintenance → Volumetric SKF .

The Volumetric SKF: Maintenance screen is displayed.

1. To create the cross reference, enter an SKF Type code, the material, and volume type.

1. Select Save .

Displaying records

Table 21:

If you want to view records that have been created, from the Volumetric SKF: Maintenance screen, choose List Entries .

Result

A record is created, which ties a material / volume type to an SKF figure code.

Example

For material EP400, you could assign a volume type of 01 = measured production, and an SKF type code of 
DRILL.
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4.2 PRA Master Data Entities 

Purpose

The Production application area operates using four basic types of master data entities:

● Producing entities, which include fields, reservoirs, platforms, and wells
● Well completions
● Measurement points
● Delivery networks

The combination of the master data for producing entities, well completions, and measurement points forms 
the structure of a delivery network.

Process Flow

Set up the producing entities as required.

For wells, set up well completions and well completion dated characteristics (see: Creating a Well Completion 
ID [page 94] , Creating Well Completion Dated Characteristics [page 95] ).

For measurement points, set up measurement point dated characteristics (see: Creating a Measurement Point 
ID [page 112] , Creating   an MP Dated Characteristics Record [page 113] ).

Use the producing entities, well completions, and measurement points as required to set up a delivery network 
(see: Creating a Delivery Network ID [page 123] ).

View the delivery network downstream nodes in order to review the structure of the delivery network.

4.2.1  Producing Entities

Definition

There are four types of producing entities used for processing upstream oil and gas transactions:

● Field - Represents an area comprising one or more reservoirs relating to the same geological structure
● Reservoir - Represents a porous and permeable body of rock below the surface that contains oil and/or gas
● Platform - Represents an offshore production platform, such as a drilling rig, barge, or platform
● Well - Represents a hole drilled in the earth to obtain geological information, to find or produce oil and gas 

hydrocarbons, and/ or to provide service for the operation of another oil or gas well
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Use

Data related to producing entities is captured in the form of ID records, or master records, and these master 
records are the foundation of a delivery network.

Integration

Master records for producing entities are used along with well completion, measurement point, and delivery 
network master records to build the structure of a delivery network in SAP.

4.2.1.1 Creating a Field ID 

Use

Use this to create a record representing a field.

A field is an area comprising one or more reservoirs relating to the same geological structure.

The field ID number resulting from this transaction is included in the corresponding SAP well completion 
record.

Procedure

At the SAP Easy Access screen, choose Logistics     Production and Revenue Accounting     Production     
Producing Entities     Field ID     Create

The Create Field: Initial Screen is displayed.

Enter the following data:

Field ID

If the field number range group is internal (system-generated), leave the Field ID field blank. The system then 
automatically assigns a number for the field ID.

FL Number Group (the field range used in the assignment of a new delivery network).

Choose Enter .

The Create Field: Overview screen is displayed.
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In the second field of the Field row, enter a description. Enter additional data, as required.

Save the field ID.

Using a Reference for a Field ID

If a field ID record already exists with data similar to that of the new field ID you are creating, you can copy data 
from the existing record into the new record.

To copy data from the existing record into the new record, enter the number of the existing field ID in the 
reference section of the initial screen for the new field ID.

4.2.1.2 Creating a Reservoir ID 

Use

Use this to create a record representing a reservoir, which is an underground area from which hydrocarbons are 
obtained.

Reservoirs can be defined as one single whole, or they can be defined as consisting of multiple zones, with each 
zone representing a natural structure dividing the reservoir.

Procedure

At the SAP Easy Access screen, choose Logistics à Production and Revenue Accounting à Production à 
Production Entities à Reservoir à Create

The Create Reservoir: Initial Screen is displayed.

2. Enter the following data:

Reservoir ID

If the reservoir number range group is internal, leave the Reservoir ID field blank. The system then 
automatically assigns a number for the reservoir ID at the end of the procedure.

RS Number Group (the number range used in the assignment of a new reservoir ID). If the reservoir number is 
internal (generated by the system), choose Internal . If the number is not generated by the system, choose 
External .

Choose Enter .

The Create Reservoir: Overview screen is displayed.
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3. In the second field of the Reservoir ID row, enter a description for the reservoir ID. Then, enter other data as 
required.

4. Save the reservoir ID.

Using a Reference for a Reservoir ID

If a reservoir ID record already exists with data similar to that of the new reservoir ID record you are creating, 
you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter the number of the existing reservoir ID in the 
reference section of the initial screen for the new reservoir ID.

4.2.1.3 Creating a Platform ID 

Use this to create a platform ID. A platform isan offshore structure from which production wells are drilled.

At the SAP Easy Access screen, choose Logistics àProduction and Revenue Accounting àProduction àProducing 
Entities àPlatform ID àCreate

The Create Platform: Initial Screen is displayed.

2. Enter the following:

Platform

If the platform number range group is internal (system-generated), leave the Platform field blank. The system 
then automatically assigns a number for the platform.

PF Number Group (the number range used in the assignment of a new platform ID).

Choose Enter .

The Create Platform <platform number>: Overview screen appears.

3. In the second field of the Platform row, enter a description, then enter data as required.

4. Save the platform ID.

Using a Reference for a Platform ID

If a platform ID record already exists with data similar to that of the new platform ID you are creating, you can 
copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter the number of the existing platform ID in the 
reference section of the initial screen for the new platform ID.
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4.2.1.4 Creating a Well ID 

Use

Use this to create a well ID record. The well ID represents a physical production well in the field.

When you do this, it establishes a record in the system for a well, that:

Is used to obtain geological information

Produces oil and gas hydrocarbons

Provides support to the operation of another oil or gas well

Procedure

At the SAP Easy Access screen, choose Logistics   →    Production and Revenue Accounting   →   Production   →   
Producing Entities   →   Well ID   →   Create

The Create Well: Initial Screen is displayed.

In the Well field, enter the relevant well.

Choose Enter .

The Create Well <well number>: Overview screen is displayed.

In the second field on the Well row, enter a text description for the well. Then enter the API well number (the 
API well number for the well is sent to you by the government), and choose the Physical Description tab .

In the Physical Description tab, enter data as required. Here, you can enter data that physically describes the 
well.

Choose the Legal Description tab, and enter data as required (the legal description describes the surveying 
method used for the well).

Save the well ID.

Using a Reference for a Well ID

If a well ID record already exists with data similar to that of the new well ID that you are creating, you can copy 
data from the existing record into the new record.

To copy data from the existing record into the new record, enter number of the existing well in the reference 
section of the initial screen for the new well.
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4.2.2  Well Completion 

Definition

A well completion is one individual, physical completion made within a well.A well completion is represented by 
a well completion ID in the standard system.

Structure

A well completion ID, along with dated well completion characteristics, serve as the basis for defining data 
about a well completion.

Some data for well completions may need to be captured on a conditional basis, that is, only in certain 
situations.The following conditional data related to well completions can be captured in the standard system.

● Contamination override - Allocating a contamination percentage from the lease for a non-injection field 
back to the lease(s) for the injection fields

● Downhole commingled well completions - Setting up cross references to well completions that are 
commingled downhole in the same well

● Downtime summary - Recording periods of downtime for a well completion
● Reproduced materials - Identifying the percentage of reproduced material that exists in a well completion
● Supply source - Defining an alternative method to be used by volume allocation when determining the 

source of volume to be allocated to an upstream well completion
● Transporter Cross Reference - Setting up a cross reference to the transporter for a well completion.
● Volumes - Capturing volumetric information at a well completion level for either daily or month-end 

volumes

4.2.2.1 Creating a Well Completion 

Use

Use this to create a well completion record.

The well completion ID transaction establishes a record in the system, representing a physical well completion 
formation or a zone that has been penetrated by the drilling of a well, and is producing in commercial quantities 
into the wellbore.

In order to be able to create a well completion, you first will have had to create a well, to which the well 
completion will be assigned (see: Creating a Well ID [page 93] ).
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Procedure

1. At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting  Production 
Well Completion  Well Completion ID  Create  .

2. The Create Well Completion: Initial Screen is displayed.
3. Enter the relevant well and well completion and choose ENTER.

The Create Well Completion: Overview Screen appears.
4. In the second field on the well completion row (the field immediately to the right of the Well Completion 

field), enter a description for the well completion. Enter other data, as required.
5. Select the Location tab, and enter the relevant data. The data that you enter here provides details on the 

state and country that the well completion is located in. You can also enter precise longitude and latitude 
data on the well completion.

6. Select the Related Entities tab, and enter the relevant data. Related entities can provide information on: the 
field and reservoir that the well completion is linked to, as well as information on the company code and 
company that the well completion is linked to.

7. Select the Engineering Information tab, and enter the relevant data. The engineering information includes: 
the purpose of the well – from a financial point of view, the program (project and phase of the well 
completion), the base pressure, and informaton on the depth and elevation of the well completion.

8. If the well is a lease line well, select the Lease Line Well indicator.A lease line well is a well that is located on 
a lease line, adjoining more than one lease, and the operators agree to share the revenue on a percentage 
basis.

9. Enter any other relevant data.
10. Save the well completion.

Using a Reference for a Well Completion ID

If a well completion ID record already exists with data similar to that of the new well completion ID you are 
creating, you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter the data for the existing well completion ID in 
the reference section of the initial screen for the new well completion ID.

4.2.2.2 Creating Well Completion Dated Characteristics 

Use

Use this to create a well completion dated record.

This transaction defines details about a well completion that are effective within a specified date range. This is 
used for situations in which you want to create a well completion ID specific to a set date range.

Procedure

1. At the SAP Easy Access screen, choose Logistics  Production and Revenue Accounting  Production 
 Well Completion  Well Compl. Dated  Create  .
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The Create Well Completion Dated: Initial Screen is displayed.
2. Enter the well completion, and effective date range, and choose Enter .

The Create Well Completion Dated <well completion number> Effective <date>: Overview screen is 
displayed.

3. Enter data as required.
4. If the status of the well completion is “producing”, enter data in the Producing Method field, then set the 

appropriate production cycle indicator.
5. Save the well completion dated characteristics.

Using a Reference for Well Completion Dated Characteristics

If a well completion dated characteristics record already exists with data similar to that of the new well 
completion dated characteristics you are creating, you can copy data from the existing record into the new 
record.

To copy data from the existing record into the new record, enter data for the existing well completion dated 
characteristics in the reference section of the initial screen for the new well completion dated characteristics.

4.2.2.3 Creating a Well Completion Supply Source 

Use

Use this to create a well completion supply source.

This transaction establishes a record in SAP that lists well completions to be used as alternative fuel supply 
sources in certain situations. The record also lists specific leases, represented by joint ventures, that may 
access the alternative supply sources.

During volume allocations, alternative well completions may need to be used as supply sources when a well 
that is part of a lease does not:

Produce enough gas to supply its own gas lift gas

Produce enough return to lease fuel injection gas

In these situations, the PRA application uses the well completions listed in this record as alternative sources for 
the venture identified in this record.

The order in which the alternative well completions are listed is important, because SAP uses the alternative 
well completions according to the order in which they are listed.

Well completion supply source details are used for processing prior period, volume allocation transactions.
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Prerequisites

The standard method for the volume allocation cycle that supplies volume to an upstream well completion 
needs to be overridden.

Procedure

At the SAP Easy Access screen, choose Logistics   →   Production and Revenue Accounting   →   Production   →   
Well Completion   →   WC Supply Source   →   Create

The Create Supply Source: Initial Screen is displayed.

Enter data as required and choose Enter .

The Create Supply Source: Overview Screen is displayed.

In the Sequence field, enter the number identifying the sequence in which the system is to use the alternative 
well completions. Then enter other data as required.

Save the well completion supply source.

Using a Reference for a Well Completion Supply Source

If a well completion supply source record already exists with data similar to that of the new well completion 
supply source you are creating, you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter the data for the existing well completion supply 
source in the reference section of the initial screen for the new well completion supply source.

4.2.2.4 Creating a Well Completion Reproduced Material 

Use

Use this to create a well completion reproduced material record.

A reproduced material is a product injected into a well completion formation for the purpose of simulating 
production.

This transaction involves specifying the percentage of the reproduced product that naturally exists in the well 
completion formation.

The percentage determines what portion of the extracted product is a result of first-time production. The 
percentage is also important because reproduced product that has been injected, and is not a result of first-
time production, should be paid only once.
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Procedure

At the SAP Easy Access screen, choose Logistics à Production and Revenue Accounting à Production

Table 22:

Function Follow-on menu

Create reproduced materials for a well completion   →  Well Completion   →  WC/MP Reproduced Materials   → 
 Create

Create reproduced materials for a measurement point   → Measurement Point   →  WC/MP Reproduced Materials   → 
 Create

Choose Measurement Point .

The Create <well completion or measurement point> Reproduced Materials: Initial Screen appears.

Enter the following data:

Well Completion

Reproduced material data can be entered only for well completions that are downhole commingled parents. 
Reproduced material data in a parent record applies to all children records.

Effective From

Then choose Enter .

The Create <well completion or measurement point> Reproduced Materials: Overview Screen appears.

Enter the reproduced material and formation percentage.

Save the reproduced materials record.

Using a Reference for Reproduced Materials

If a reproduced materials record already exists with data similar to that of the new reproduced materials you 
are creating, you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter data for the existing reproduced materials in 
the reference section of the initial screen for the new reproduced materials.

4.2.2.5 Creating a Well Completion Theoretical Override 
Use

Use this to create a well completion theoretical override.

This transaction defines an override of the delivery network theoretical method at a well completion or 
measurement point. This transaction causes the estimated production value, calculated by the volume 
allocation cycle, to be overridden with the value specified in this transaction.
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This is used to create master data for situations in which you do not want to use the estimated theoretical 
production value calculated by the volume allocation cycle based upon the delivery network theoretical 
calculation method.

Prerequisites

The production value calculated by the volume allocation cycle needs to be overridden.

Procedure

At theSAPEasy Access screen, choose Logistics→Production and Revenue Accounting→Production.

Function Follow-on menu

Create reproduced materials for a well completion Well Completion→ WC/MP Theo Override→ Create.

Create reproduced materials for a measurement pointMeasurement Point → WC/MP Theo Override → Create

Choose Measurement Point.

At the Create <WC / MP> Theoretical Override: Initial Screen , enter data as required and choose Enter . The 
Create WC Theoretical Override: Overview screen is displayed.

You can also specify a Delivery Network Number on the Well Completion/Measurement Point Theoretical 
Override screen.

On that screen verify the effective to date, and enter the Theoretical Override

Save the theoretical override record.

Using a Reference for a Theoretical Override

If a theoretical override record already exists with data similar to that of the new theoretical override you are 
creating, you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter data for the existing theoretical override in the 
reference section of the initial screen for the new theoretical override.

4.2.2.6 Creating a WC Lease-Wide Gas/Oil Ratio (GOR) 

Use

Use this to create a well completion gas oil ratio (GOR) record.

The lease wide GOR transaction defines a ratio of gas production to oil production used in fluid-only well tests. 
The GOR is expressed in MCF of gas per barrel of oil.

The ratio can be defined at one of three levels:

All well completions on a specified property

All well completions within a field on a specified property

All well completions within a reservoir located on a field for a specified property
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Procedure

At the SAP Easy Access screen, choose Logistics   →   Production and Revenue Accounting   →   Production   →   
Well Completion   →  Lease Wide GOR   →   Create

The Create Lease-wide GOR: Initial Screen appears.

Enter data as required (company code, venture, and reservoir), and choose Enter .

The Create Lease-wide GOR: Overview screen appears.

Enter the gas oil ratio (GOR) percent.

Save the lease wide GOR.

Using a Reference for a Lease Wide Gas to Oil Ratio

If a lease wide gas to oil ratio record already exists with data similar to that of the new lease wide gas to oil ratio 
you are creating, you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter the data for the existing lease wide gas to oil 
ratio in the reference section of the initial screen for the new lease wide gas to oil ratio.

4.2.2.7 Creating a Well Completion - Downhole 
Commingled Record 

Use

Use this to create a well completion downhole commingled record.

Commingling in the oil and gas context means: producing oil and gas from two or more reservoirs at different 
depths.

This transaction links a well completion with all well completions that are commingled downhole in the same 
well. The term child refers to the well completions commingled downhole, while the term parent refers to the 
well completion to which all the child well completions are linked.

This transaction identifies the percentage of child well completions that are commingled, with respect to the 
parent well completion.

You can use this transaction to allocate material to well completions producing out of the same tubing stream.
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Procedure

At the SAP Easy Access screen, choose Logistics   → Production and Revenue Accounting   → Production   →   
Well Completion   → WC Downhole Commingled   →   Create

The Create Well Completion Downhole Commingled: Initial Screen appears.

Enter the following data:

Well Completion

The well completion entered here represents the parent.

Effective From

Major Product

Choose Enter .

The Create Well Completion Downhole Commingled: Overview screen appears.

Enter the following data:

Effective To

Well Completion

Each well completion entered in this table represents a child that is part of the commingled well completion.

The commingled percentage is the percentage that each child well completion contributes to the total 
production of a product through a single tubing stream, with respect to other well completions that are 
commingled.

Continue to enter data for each child well completion as required.

Save the downhole commingled well completion.

Using a Reference for a Well Completion Downhole Commingled Record

If a well completion downhole commingled record already exists with data similar to that of the new well 
completion downhole commingled record you are creating, you can copy data from the existing record into the 
new record.

To copy data from the existing record into the new record, enter data for the existing well completion downhole 
commingled record in the reference section of the initial screen for the new well completion downhole 
commingled record.
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4.2.2.8 Well Completion Hierarchy 

Definition

The well completion hierarchy represents a group of well completions at a hierarchical level.The hierarchical 
level can consist of one well completion group, or multiple well completion groups.

Use

A well completion hierarchy can be set up as an organizational level for multiple users.Or, a single user can set 
up a well completion hierarchy for individual use, as required.

See also:

Creating a Well Completion Hierarchy [page 102]

4.2.2.8.1 Creating a Well Completion Hierarchy 

Use

This transaction links multiple well completions together into a group. Multiple sets of well completion groups 
can be established as hierarchy levels under one well completion hierarchy.

Procedure

1. At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Production 
Well Completion Well Completion Hierarchy Create  .
The Create Well Completion Hierarchy: Initial Screen appears.

2. Enter data as required and choose Hierarchy .
The Create Well Completion Hierarchy: Structure screen appears.

3. The following options are available at this screen:
Adding a Level to the Well Completion Hierarchy
To add a level to the well completion hierarchy, click the cursor on the well completion group and choose 
Lower Level .Then, in the first field for the hierarchy level, enter an identification number, and in the second 
field enter a description.
Adding Well Completions to the Hierarchy
To add well completions to the hierarchy, click the cursor on the required level and choose Well 
Completion .Then, in the first field for the well completion, enter the well completion number.Choose Enter 
to display a description of the measurement point.
Creating Additional Levels for the Well Completion Hierarchy
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To create additional hierarchy levels for the well completion hierarchy, select a level and either (1) choose 
Same Level to create a new level at the same level as the one that is selected, or (2) choose Lower Level to 
create a new level one level lower than the one that is selected.
Viewing the Hierarchy Details
After creating levels for a well completion hierarchy, choose Expand All to view a list of each well 
completion in a level.
Viewing the Well Completion Group Hierarchy Levels Only
After using Expand All to view well completion group details, choose Collapse All to return the view to only 
the well completion levels.

Selecting Items

To select an item, place the cursor on the appropriate row and choose Select .

Deselecting Items

To deselect selected items, choose Deselect All .

Deleting Well Completion Groups

To delete the well completion group, select it and choose Delete .

Determining Well Completion Hierarchy Use

To retrieve a listing of where the well completion hierarchy is used in SAP, place the cursor on the well 
completion hierarchy name and choose Where-Used List for Group .

Exit the well completion hierarchy.

Using a Reference for a Well Completion Hierarchy

If a well completion hierarchy record already exists with data similar to that of the new well completion 
hierarchy you are creating, you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter the number of the existing well completion 
hierarchy in the reference section of the initial screen for the new well completion hierarchy.

4.2.3  Measurement Point 

Definition

A measurement point defines a place or point where product is measured, used, or sold. A measurement point 
may represent a physical device in the field, or a theoretical point required for the volume allocation process.

A measurement point is represented by a measurement point ID in the system.

There are various measurement point types in PRA. For a full description of each measurement point type, and 
how it is used in PRA, see: Measurement Point Types [page 104] ).
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Structure

A measurement point ID, along with measurement point dated characteristics, serve as the basis for capturing 
data about a measurement point.

Some data for measurement points may need to be captured on a conditional basis, that is, only in certain 
situations.The following conditional data related to measurement points can be captured in the system:

Fuel Usage - Defining the specifications for both hourly rate-based and liquid-based fuel consumption devices

Heating value cross reference - Setting up a cross reference between two measurement points, or between a 
well completion and a measurement point, when the heating value cannot be determined at volume entry time

Meter Specifications - Recording volume at liquid displacement meters

Transporter cross reference - Setting up a cross reference to the transporter for a measurement point

4.2.3.1 Measurement Point Types / Valid Volume Types 

Definition

The measurement point type is used to designate what type of equipment or allocation point is being 
represented by a measurement point. Specific measurement point types have unique restrictions and 
processing rules in PRA.

The following table lists the standard PRA measurement point types and the valid volume types for each 
measurement point type (for more information on each volume type, see: Volume Categories and Volume 
Types [page 136] ).

Use

The following measurement point types can be used in PRA:

Table 23:

Measurement point type (MP type 
code):

Use / comments: Valid volume type(s) for this meaure­
ment point type:
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Tank (01) Normally, the ending inventory or sales 
will be recorded here. Whenever a sales 
volume is recorded, a transporter must 
also be recorded. When recording a 
tank volume, the volume determination 
transaction will require tank specifica-
tions and tank strappings to be set up.

03 Sales

04 inventory

21 Sales 2

25 Waste/slop oil sales

26 skim oil sales

28 scrubber oil sales

L1 load oil sales

LACT meter (02) – (lease automatic 
custody transfer point meter)

This MP usually records metered liquid 
sales volumes. Whenever a sales vol­
ume is recorded, a transporter must be 
recorded with it. Meter specifications 
will need to be set up for the MP if the 
volume is to be calculated from meter 
readings.

03Sales 1

21 sales 2

Sales meter (03) Normally, the ‘Sales-1’ volume type will 
recorded here. Whenever a sales vol­
ume is recorded, a transporter must 
also be recorded. The volume determi­
nation transaction will require that me­
ter specifications be set up for this 
measurement point.

03 sales 1

21 sales 2

25 slop oil sales

26 skim oil sales

28 scrubber oil sales

FU fuel usage in a fuel system

Deduct meter (04) Normally, this meter will have a VT80 
(allocation volume) associated with it. 
This volume will act as a DEDUCT vol­
ume during the allocation process ‑ 
meaning that it will keep the volume 
“whole”, and will NOT absorb any swing 
in the allocation of dispositions.

80 allocation volume

01 measured production
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Compressor (07) This measurement point can have any 
fuel use volume type entered on it (VTs 
11-15, R1-R5). The volume at this MP 
may be 1) entered directly through the 
gas volume entry screen in PRA, 2) cal­
culated from hourly or throughput rates 
using fuel usage specifications, or 3) 
uploaded to PRA from a field data col­
lection device.

11 fuel use downstream

12 lease use 2

13 lease use 3

14 lease use 4

15 lease use 5

24 plant fuel

38 lease use off lease

R1 RLF received 1

R2 RLF received 2

R3 RLF received 3

R4 RLF received 4

R5 RLF received 5

FU fuel usage in a fuel system

Heater/Treater (08) This measurement point can have any 
fuel use volume type entered on it (VTs 
11-15, R1-R5). The volume at this MP 
may be: 1) entered directly through the 
gas volume entry transaction in PRA, 2) 
calculated from hourly or throughput 
rates using fuel usage specifications, or 
3) uploaded to PRA from a field data 
collection device.

11 fuel use downstream

12 lease use 2

13 lease use 3

14 lease use 4

15 lease use 5

38 lease use off lease

R1 RLF received 1

R2 RLF received 2

R3 RLF received 3

R4 RLF received 4

R5 RLF received 5

FU fuel usage in a fuel system
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Dehydrator (09) This measurement point can have any 
fuel use volume type entered on it (VTs 
11-15, R1-R5). The volume at this MP 
may be: 1) entered directly through the 
gas volume entry screen in PRA, 2) cal­
culated from hourly or throughput rates 
using fuel usage specifications, or 3) 
uploaded to PRA from a field data col­
lection device.

11 fuel use downstream

12 lease use 2

13 lease use 3

14 lease use 4

15 lease use 5

24 plant fuel

38 lease use off lease

R1 RLF received 1

R2 RLF received 2

R3 RLF received 3

R4 RLF received 4

R5 RLF received 5

FU fuel usage in a fuel system

Lease fuel upstream (10) Normally, this MP will record volume 
type 10 - lease upstream of PM. This 
volume/MP type is specifically for lease 
use dispositions between the well com­
pletion and deduct/allocation meters 
downstream . The volume at this MP 
may be: 1) entered directly through the 
gas volume entry transaction, 2) calcu­
lated from hourly or throughput fuel us­
age rates, or 3) uploaded from a field 
data collection device.

10 lease use before PM – on lease
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Lease fuel downstream This measurement point can have any 
fuel use volume type entered on it (VTs 
11-15, R1-R5). The volume at this MP 
may be: 1) entered directly through the 
gas volume entry transaction in PRA, 2) 
calculated from hourly or throughput 
rates using fuel usage specifications, or 
3) uploaded to PRA from a field data 
collection device.

11 fuel use downstream

12 lease use 2

13 lease use 3

14 lease use 4

15 lease use 5

38 lease use off lease

R1 RLF received 1

R2 RLF received 2

R3 RLF received 3

R4 RLF received 4

R5 RLF received 5

FU fuel usage in a fuel system

Theoretical production meter (12) This meter will never have an entered 
volume associated with it. It is strictly 
used as a repository of summed theo­
reticals up to a “leg” in a delivery net­
work to properly adjust theoretical vol­
umes in volume allocation.

(no volumes entered at this MP)

Water chain (14) This is a “pseudo-meter” used as a 
point to determine the amount of water 
contributed by producing oil and gas 
completions in a water chain network.

WC water chain

Check meter (16) This traps VT07 check meter volumes. 07 check meter

Allocation meter (17) Normally, this meter will have a VT80 
allocation volume associated with it. 
This volume will NOT act like the DE­
DUCT volume during the allocation 
process. It will absorb swings in the al­
location of dispositions.

80 allocation meter
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Separator (18) This measurement point can have any 
fuel use volume type entered on it (VTs 
11-15, R1-R5). The volume at this MP 
may be: 1) entered directly through the 
gas volume entry transaction in PRA, 2) 
calculated from hourly or throughput 
rates, using fuel usage specifications, 
or 3) uploaded to PRA from a field data 
collection device.

10lease use before PM – on lease

11 fuel use downstream

12 lease use 2

13 lease use 3

14 lease use 4

15 lease use 5

38 lease use off lease

R1 RLF received 1

R2 RLF received 2

R3 RLF received 3

R4 RLF received 4

R5 RLF received 5

FU fuel usage in a fuel system

VRU meter (19) Vapor recovery unit measurement type, 
used within a gas plant processing to 
represent a vapor recovery unit, and 
capture vapor recovery dispositions.

(N/A)

Fuel use meter (20) This measurement point can have any 
fuel use volume type entered on it (VTs 
11-15, R1-R5). The volume at this MP 
may be: 1) entered directly through the 
gas volume entry transaction in PRA, 2) 
calculated from hourly or throughput 
rates using fuel usage specifications, or 
3) uploaded to PRA from a field data 
collection device.

11 fuel use downstream

12 lease use 2

13 lease use 3

14 lease use 4

15 lease use 5

24 plant fuel

38 lease use off lease

R1 RLF received 1

R2 RLF received 2

R3 RLF received 3

R4 RLF received 4

R5 RLF received 5

FU fuel usage in a fuel system
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Vent / flare (22) Normally, this captures VT30 Field 
Vent/Flare ‑ On Lease. The volume at 
this MP may be: 1) entered directly 
through the gas volume entry transac­
tion, 2) calculated from hourly or 
throughput fuel usage rates, or 3) up­
loaded to a field data collection device.

30 field vent / flare – on lease

31 field vent / flare – on lease

45 plant vent / flare

Tank battery (35) VT04 closing inventory liquids can be 
captured at the tank battery. At this MP, 
the inventory can be captured without 
having to set up tank specs or meter 
factors. Any network that contains a 
tank (MP Type 01) must contain a tank 
battery node upstream of the tanks.

04 closing inventory

Purchased fuel (40) Allows a Purchase Volume (VT 40) to 
be recorded either using the gas or liq­
uid volume entry transactions in PRA.

40 purchased lease fuel

NGL meter (41) Natural gas liquid meter. (NA)

Terminal This is used as an oil transfer point, nor­
mally to a pipeline. It is not considered 
a meter. PRA allows it to be used “like a 
tank.” The exception here is that when 
recording tank volumes , the system 
will NOT require tank specifications. It 
can be used to capture inventory, sales, 
etc.

03 sales

21 sales 2

04 inventory

Injection / disposal meter (52) Normally, this meter will capture vol­
ume type 18 (formation injection) for 
water products, or volume types WI 
(water injected) and WD (water dis­
posed) in a water chain network.

18 formation injection – on lease

WD water disposal

WI water injected

Supply meter (53) This MP can capture volume type WS, 
water supplied, in a water chain deliv­
ery network.

WS water supplied
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Gas liftmeter receipt point (54) This MP can capture volume type 50, 
gas lift received. The volume at this MP 
will be summed to the gas lift supply 
point in a gas lift network during vol­
ume/plant allocation. The total gas lift 
receipts will be allocated from the sup­
ply point in volume allocation; the re­
ceipt volumes may be used as a prora­
tion basis for an entered gas lift supply 
in plant allocations.

50 gas lift gas received

Gas lift supply point (55) All gas lift receipt volumes in a gas lift 
network are summed and posted at this 
MP during volume allocation as volume 
type 50. The allocation of gas lift will 
proceed from the supply point with ei­
ther the summed receipt volumes, or 
an entered gas lift supply volume in 
plant allocations.

50 gas lift gas received

64 gas lift gas supplied

Injection meter receipt point (56) This MP will capture volume type 68, 
gas injection received. The volume at 
this MP will be summed to the injection 
meter supply point for gas injection 
during volume allocation. The total in­
jection receipts will be allocated form 
the supply point.

68 injection received

Return lease fuel receipt point (57) This MP will capture any RLF receipt 
volume type (74, R1 - R5). The volume 
at this MP will be summed to the RLF 
supply point during volume allocation. 
The total RLF receipts will be allocated 
from the supply point in volume alloca­
tion; the receipt volumes may be used 
as a proration basis for an entered RLF 
supply in plant allocations.

74 return lease fuel received

R1 RLF received 1

R2 RLF received 2

R3 RLF received 3

R4 RLF received 4

R5 RLF received 5

FU fuel usage in a fuel system

Gas plant measurement point (58) Used within gas plant processing to 
represent a gas plant facility.

(NA)

Return lease fuel supply point (59) All RLF receipt volumes in a RLF net­
work are summed and posted at this 
MP during volume allocation as volume 
type 50. This is how all RLF gets in­
cluded in proration of total production 
to all well completions.

50 gas lift received

73 return lease fuel supplied

74 return lease fuel received

Plant fuel (60) MP type used to capture plant fuel. 24 plant fuel
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RLF consolidation point (62) Used to simplify network configurations 
involving return lease fuel. Once de­
fined multiple RLF receipt points can be 
consolidated and connected to RLF 
supply point via the RLF consolidation 
point.

(NA)

Gas injection supply point (65) All gas injection volumes are summed 
and posted at this MP during volume al­
location as type 68. The allocation of 
gas injection will proceed form the sup­
ply point.

67 gas injection supplied

68 gas injection received

Produced fuel point (72) This MP can capture the produced fuel 
volume type, FP. This mp type is used 
exclusively in a fuel system delivery net­
work. It represents the total produced 
volume of gas to be used in proration to 
final dispositions in a fuel system.

FP fuel produced in a fuel system

Produced water (73) This MP captures the produced water 
volume type (PW).

PW produced water

Well-level 04 closing inventory – liquids

L2 load / transfer oil received

System created 36 Hydrocarbon extraction loss

43 meter differential

91 calculated production

99 total sales

L2 load transfer oil received

L3 load transfer oil inventory

L4 load transfer oil recovered

This is not an exhaustive list, rather, it contains the standard PRA measurement point types.

4.2.3.2 Creating a Measurement Point ID 

Use

Use this to create a measurement point ID.
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This transaction creates a record for a measurement point.

An ID record may be set up for a measurement point that represents a physical device in the field, or for a 
measurement point that represents a theoretical point required for the volume allocation process.

Procedure

At the SAP Easy Access screen, choose Logistics   →  Production and Revenue Accounting   →  Production   → 
 Measurement Point   →  Measurement Point ID   →  Create

The Create Measurement Point: Initial Screen appears.

Enter the following data:

Measurement Point

If the number range group for the measurement point is internal, leave the Measurement Point field blank. The 
system then automatically assigns a number for the measurement point.

MP Group

MP Type

Choose Enter .

The Create Measurement Point: Overview screen appears.

In the second field of the Measurement Point row, enter a description. Then enter additional data as required.

Save the measurement point.

Using a Reference for a Measurement Point ID

If a measurement point ID record already exists with data similar to that of the new measurement point ID you 
are creating, you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter the number of the existing measurement point 
ID in the reference section of the initial screen for the new measurement point ID.

4.2.3.3 Creating an MP Dated Characteristics Record 

Use

Use this to create an MP dated characteristics record.

This transaction defines details about a measurement point that are effective within a specified date range.
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Procedure

1. At the SAP Easy Access screen, choose Logistics  Production and Revenue Accounting  Production 
 Measurement Point  Measurement Point Dated  Create  .

The Create Measurement Point Dated: Initial Screen is displayed.
2. Enter the relevant measure point and effective date, and choose Enter .

The Create Measurement Point Dated <measurement point number>: Overview screen appears.
3. Enter the multiple stream type and set the appropriate indicators.Then enter other data as required.
4. If required, set the gas plant indicators.
5. Save the measurement point dated characteristics.

Using a Reference for a Measurement Point Dated Characteristics

If a measurement point dated characteristics record already exists with data similar to that of the new 
measurement point dated characteristics you are creating, you can copy data from the existing record into the 
new record.

To copy data from the existing record into the new record, enter data for the existing measurement point dated 
characteristics in the reference section of the initial screen for the new measurement point dated 
characteristics.

4.2.3.4 Creating Measurement Point Meter Specifications 

Use

Use this to create MP meter specifications.

This transaction defines the specifications for liquid displacement meters.

Procedure

1. At the SAP Easy Access screen, choose Logistics  Production and Revenue Accounting 
Measurement Point  MP Meter Specs  Create  .
The Create Measurement Point Meter Specification: Initial Screen is displayed.

2. Enter the relevant data.Then choose Enter .
The Create Measurement Point Meter Specifications <measurement point number> Effective <date>: 
Overview screen is displayed.

3. Enter data as required.Then set the indicators for Temperature Compensation and Meter On/Off Validation 
Readings , as required.

4. Save the measurement point meter specifications.

Using a Reference for a Measurement Point Meter Specification

If a measurement point meter specification record already exists with data similar to that of the new 
measurement point meter specification you are creating, you can copy data from the existing record into the 
new record.
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To copy data from the existing record into the new record, enter the data for the existing measurement point 
meter specification in the reference section of the initial screen for the new measurement point meter 
specification.

4.2.3.5 Creating Measurement Point Tank Specifications 

Use

Use this to create an MP tank specification record.

This transaction captures specification and strapping information for tanks. The tank specifications define the 
volume capacity information for a tank at a high level, while the strappings define the detailed volume 
information for a tank at a gauge level (the strappings refer to the lines along a tank that are used to measure 
the level of product in a tank).

Procedure

1. At the SAP Easy Access screen, choose Logistics  Production and Revenue Accounting  Production 
 Measurement Point  MP Tank Specs  .

The Maintain Storage Object Characteristics screen is displayed.
2. In the Object ID field, enter the measurement point number for the tank, then select Measurement 

Point .Choose Enter .
The Change Meas. point object: SILO: Detail Screen is displayed.

3. In the Storage object type, enter E&P tank .
4. In the Maximum capacity field, enter the maximum number of barrels that the tank holds.
5. Select Cal.history to activate the tank strapping.
6. If the tank is sold, or is no longer in use, select Entry is blocked .
7. Choose Save .

The initial Maintain Storage Object Characteristics screen is displayed.
8. Verify that the correct measurement point number for the tank is displayed in the Object ID field, and that 

Measurement Point is selected.Choose Enter .
9. Choose LVCC (Linear Volume Conversion Constants).

Note
LVCC is an abbreviation for Linear Volume Conversion Constants.By choosing LVCC, you proceed to the 
Change lin/vol conversion (strapping constants) screen, which is where strapping data is entered.

10. If you need to change the units of measure for any of the readings, choose Edit Set UoMs.  .At the 
Set Units of measure dialog box, enter data as required, and choose Enter .

11. To enter volume below the gauge plate, enter the volume in the first row of the Volume column.
12. If you do not need to enter volume below the gauge plate, enter volume as required, starting with the 

second row.
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13. Choose Consistency check .
A dialog box with the message Should missing entries be calculated? is displayed .

14. Choose Yes .
15. In the Select Calculation mode dialog box, choose Calculate volumes .
16. Choose Activate .
17. At the Set activation start date time dialog box, enter data as required to establish the date that the 

strapping becomes effective.
18. Save the strapping information.

4.2.3.6 Creating Measurement Point Fuel Usage 
Specifications 

Use

This transaction defines the specifications for both hourly rate-based and liquid-based fuel consumption 
devices.

The hourly rate-based devices record consumption in the following formats:

Barrels per hour

MCF per hour

MMBTU per hour

The liquid-based devices record consumption using an MCF per barrel format, for barrels containing a specific 
liquid product.

Measurement point fuel usage details are used for prior period processing of fuel usage volumes, as well as 
volume allocation transactions.

Prerequisites

The measurement point is a fuel consumption device that measures fuel use either in hours, or barrels of liquid, 
as outlined above.

Procedure

At the SAP Easy Access screen, choose Logistics   →   Production and Revenue Accounting   →   Production   →   
Measurement Point   →   MP Fuel Usage Specs   →   Create

The Create Measurement Point Fuel Usage: Initial Screen appears.

Enter data as required and choose Enter .

The Create Measurement Point Fuel Usage <measurement point number>: Overview screen appears.
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Enter data for the rate.

Save the measurement point fuel usage record.

Using a Reference for a Measurement Point Fuel Usage

If a measurement point fuel usage record already exists with data similar to that of the new measurement point 
fuel usage you are creating, you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter data for of the existing measurement point fuel 
usage in the reference section of the initial screen for the new measurement point fuel usage.

4.2.3.7 Creating an MP / WC Transporter Cross Reference 

Use

Use this to create a link between a measurement point or a well completion and a transporter.

A transporter is a third party who picks up and delivers product to a purchaser. The relationship between 
transporter and purchaser is defined in a contract (see: Creating or Maintaining a MP / WC Transporter 
Contract Cross Ref [page 221] ). Contracts are only valid for sales meter measurement points.

Here, you link a transporter with a specific measurement point, which means that the transporter can be used 
to transport volumes from that measurement point in subsequent PRA Production transactions.

Prerequisites

● Sales volumes are captured directly at the measurement point or well completion.
● When assigning a contract to a measurement point, the contract must exist in SAP Core Sales and 

Distribution (SD).Also, the contract must be linked to a marketing representative.

Procedure

1. From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production …

Table 24:

To: Choose:

Create a transporter cross reference for a measurement 
point

...  Measurement Point  MP/WC Transporter XRef 

 Create.
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To: Choose:

Create a transporter cross reference for a well completion ...  Well Completion MP/WC Transporter XREF 

Create

Choose Well Completion .

The Create <WC or MP> to Transporter Cross Reference: Initial Screen appears.

2. Enter the relevant measurement point and the relevant transporter that you want to assign, as well as the 
relevant effective from date, and then choose Enter .

3. The Create Well Completion or Measurement Point to Transporter Cross Reference: Overview screen 
appears.

4. To assign contracts to a measurement point, enter the contract number and corresponding information.

Note
Contract assignments are valid for each measurement point, based on the date range established in this 
transaction.

5. Save the transporter cross reference.

Using a Reference for a Transporter Cross Reference

If a transporter cross reference record already exists with data similar to that of the new transporter cross 
reference you are creating, you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter the number of the existing transporter cross 
reference in the reference section of the initial screen for the new transporter cross reference.

4.2.3.8 Creating an MP / WC Default Heating Value Point 

Use

Use this to create a default heating value (BTU value) for a well completion or measurement point, which can 
be used in situations in which PRA volume allocation cannot determine a heating value for a WC or MP.

This transaction creates a cross reference (link) between two measurement points, or between a well 
completion and a measurement point, when the heating value (that is, the BTU factor) for a measurement 
point or a well completion cannot be determined during volume entry. The “heating“ value for a measurement 
point or well completion, in British Thermal Units (BTU), is a value that expresses the energy content of 
product flowing through the well completion or measurement point.

In those situations in which a heating value cannot be determined for a well completion or measurement point, 
PRA volume allocation processes the metered volumes of the default measurement point or default WC that 
you specifiy in this transaction, in order to obtain a heating value.
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Procedure

1. At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Production .

Table 25:

Function Follow-on menu

Create a heating value cross reference for a measurement 
point

 Measurement Point  MP/WC Default HV Point 

Create

Create a heating value cross reference for a well comple­
tion

Well Completion  MP/WC Default HV Point 

Create

Choose Well Completion .

The Create a <Measurement Point or Well Completion> Heating Value X-Ref: Initial Screen is displayed.

2. Enter data as required, then choose Enter .
The Create a <Measurement Point or Well Completion> Heating Value <well completion or measurement 
point number> Effective <date> screen is displayed.

3. Enter the default measurement point, or default well completion.
4. Save the heating value default (cross reference).

Using a Reference for a Heating Value Cross Reference

If a heating value cross reference record already exists with data similar to that of the new heating value cross 
reference you are creating, you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter the number of the existing heating value cross 
reference in the reference section of the initial screen for the new heating value cross reference.

4.2.3.9 Measurement Point Hierarchy 

Definition

The measurement point hierarchy represents a group of measurement points at a hierarchical level.The 
hierarchical level can consist of one well completion group or multiple well completion groups.

Use

A measurement point hierarchy can be set up as organizational data for multiple users.Or, a single user can set 
up a measurement point hierarchy for individual use, as required.

See also:

Creating a Measurement Point Hierarchy [page 120]
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4.2.3.9.1 Creating a Measurement Point Hierarchy 

Use

This transaction links multiple measurement points together into a hierarchy.Multiple sets of measurement 
point groups can be established as hierarchy levels under one measurement point hierarchy.

Procedure

1. At the SAP Easy Access screen, choose Logistics  Production and Revenue Accounting  Production 
 Measurement Point  Measurement Point Hierarchy  Create  .

The Create Measurement Point Hierarchy: Initial Screen is displayed.
2. Enter a name for the measurement point hierarchy group.(You can use an alphanumeric name).Then 

choose Hierarchy .
The Create Measurement point group: Structure screen appears.

3. The options available on this screen are listed below.
Adding a Level to the Measurement Point Hierarchy
To add a level to the measurement point hierarchy, select the measurement point group and then choose 
Lower Level .Then, in the first field for the hierarchy level, enter an identification number, and in the second 
field enter a description.
Adding Measurement Points to the Hierarchy
To add measurement points to the hierarchy, select the required level and then choose Measurement 
Point .Then, in the first field for the measurement point, enter the measurement point number.After you 
choose Enter , the second field will display a description of the measurement point.
Creating Additional Levels for the Measurement Point Hierarchy
To create additional hierarchy levels for the measurement point hierarchy, select the level and either (1) 
choose Same Level to create a new level at the same level as the one that is selected, or (2) select Lower 
Level to create a new level one level lower than the one that is selected.
Viewing the Hierarchy Details
After creating levels for a measurement point hierarchy, choose Expand All to view a list of each 
measurement point in a level.
Viewing the Measurement Point Group Levels Only
After using Expand All to view measurement point group details, choose Collapse All to return the view to 
only the measurement point levels.
Selecting Items
To select an item, select the appropriate row and then choose Select .
Deselecting Items
To deselect selected items, choose Deselect All .
Deleting the Measurement Point Group
To delete the measurement point group, select it and choose Delete .
Viewing a Single Measurement Point Record
To access a measurement point record, click the measurement point and choose Display Measurement 
Point .
Determine Measurement Point Hierarchy Use
To retrieve a listing detailing where the measurement point hierarchy is used in the system, select the 
measurement point group name and choose Where-Used List for Group .
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4. Exit the measurement point hierarchy.

Using a Reference for a Measurement Point Hierarchy

If a measurement point hierarchy record already exists with data similar to that of the new measurement point 
hierarchy you are creating, you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter the number of the existing measurement point 
hierarchy in the reference section of the initial screen for the new measurement point hierarchy.

4.2.3.10  Creating a Measurement Point Supply Source 

Use this to create a measurement point supply source.

During volume allocations, alternate measurement points may need to be used as supply sources when a 
measurement point that is part of a lease does not:

Produce enough gas to supply its own gas lift gas

Produce enough return to lease fuel injection gas

In those situations, SAP PRA uses the measurement points listed in this record as alternative sources for the 
joint venture identified in this record.

The order in which the alternate measurement points are listed is important, because the system uses the 
alternate measurement points according to the order in which they are listed.

Measurement point supply source details are used for processing prior period, volume allocation transactions.

Prerequisites

The standard method for the volume allocation cycle that supplies volume to an upstream measurement point 
needs to be overridden.

Procedure

At the SAP Easy Access menu, choose Logistics   →   Production and Revenue Accounting   →  Production   → 
 Measurement Point   →  MP Supply Source   →  Create

The Create Supply Source: Initial Screen is displayed.

Enter the relevant data, and then choose Enter .

The Create Supply Source: Overview Screen is displayed.

In the Sequence field, enter the number(s) identifying the sequence in which you would like the system to use 
the alternative measurement points. Then make any other relevant entries.

Save the measurement point supply source.

Using a Reference for a Measurement Point Supply Source
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If a measurement point supply source record already exists with data similar to that of the new measurement 
point supply source that you would like to create, you can copy data from the existing record into the new 
record.

To copy data from the existing record into the new record, enter the data for the existing measurement point 
supply source in the reference section of the initial screen for the new measurement point supply source.

4.2.4  Delivery Network 

Definition

The delivery network models the flow of product from well completions through any consumption or metering 
measurement points, and on to the final sales or custody transfer point.A delivery network is represented by a 
delivery network ID in the system.

In PRA, there are three types of delivery network:

Table 26:

Network Standard network in PRA for transporting oil and gas and 
other volumes.

Fuel system A fuel system is a network of purchased and produced gas 
volumes, lease use devices, meters and other final disposi­
tion points where produced and purchased fuel gas is dis­
persed (through meters or directly) to lease use devices 
(such as compressors, heaters, or flare) and other disposi­
tion points (such as sales).The results of a fuel system allo­
cation will be used as the gas lease use volumes by the lease 
use devices in the producing delivery network.

Gas plant A gas plant is a plant that extracts liquefiable hydrocarbons 
(or sulphur) from natural gas.

Structure

The delivery network ID, combined with the delivery network dated characteristics and delivery network 
downstream nodes, serve as the basis for capturing information about a delivery network.

Delivery network dated characteristics establish the way in which a network will be processed throughout the 
Production, Contractual Allocation, and Valuation application areas.Delivery network downstream nodes 
connect either well completions or measurement points to one primary measurement point, thereby 
establishing the structure of the delivery network.

See also:

Creating a Delivery Network ID [page 123]
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4.2.4.1 Creating a Delivery Network 

Use

Use this to create a delivery network ID.

This transaction establishes a delivery network structure. The delivery network models the flow of product 
from well completions through any consumption or metering measurement points, and on to the final sales or 
custody transfer point.

Procedure

At the SAP Easy Access menu, choose Logistics   →   Production and Revenue Accounting   →   Production   →   
Delivery Network   →   Delivery Network   →   Create

The Create Delivery Network: Initial Screen is displayed.

Enter the following data:

Delivery Network

DN Num Grp

If the delivery network number range group is internal, leave the Delivery Network field blank. SAP will then 
automatically assign a number to the delivery network.

DN Type

Choose Enter .

The Create Delivery Network: Overview screen appears.

In the second field on the Delivery Network row, enter a description for the delivery network. Enter additional 
data, as required.

Save the delivery network.

Using a Reference for a Delivery Network Record

If a delivery network ID record already exists with data similar to that of the new delivery network ID you are 
creating, you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter the number of the existing delivery network ID 
in the reference section of the initial screen for the new delivery network.
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4.2.4.2 Creating Delivery Network Dated Characteristics 

Use

Use this to define the details of a delivery network, and to set up the way in which a network is processed 
throughout the Production, Contractual Allocation, and Valuation components of PRA.

Data can be entered in this transaction to specify whether a network should be processed in Contractual 
Allocation once the network has been closed successfully in Production. Likewise, data can be entered to 
specify whether a network should be processed in Valuation once the network has been closed successfully in 
the Contractual Allocation component.

Procedure

1. At the SAP Easy Access screen, choose Logistics  Production and Revenue Accounting  Production 
 Delivery Network Delivery Network Dated  Create  .

2. The Create Delivery Network Dated: Initial Screen is displayed.
3. Enter the delivery network ID and verify the effective from date.Then choose Enter .

The Create Delivery Network Dated <delivery network number> <date> Effective: Overview screen appears.
4. On the Production tab, enter the measurement group, and set the indicators, as required.Then choose 

Contract Allocation .
5. Enter the following data:

Process frequency
Allocation method
Tolerance percentage

6. Set the indicators as required.Then choose the Valuation tab.

Note
For the Gas Allocation Basis, select Volume to indicate that the gas volumes will be allocated based on 
volume (MCF), or select Energy to indicate that the gas volumes will be based on energy (MMBTU).

7. Enter the process frequency, then set the indicators as required.
8. Save the delivery network dated record.

Using a Reference for a Delivery Network Dated Characteristics

If a delivery network dated characteristics record already exists with data similar to that of the new delivery 
network dated characteristics you are creating, you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter data for the existing delivery network dated 
characteristics in the reference section of the initial screen for the new delivery network dated characteristics.

4.2.4.3 Delivery Network Measurement Group 

Use
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A delivery network measurement group helps in the collection of information, when volumes are captured. The 
way in which volumes are captured varies -- for example, gas volumes can be captured at many different 
temperatures and pressures, and the delivery network measurement group provides a means of placing 
volumes in the same frame of reference.

The delivery network measurement group specifies both a standard unit of measure group for volumes within a 
major product group, such as oil or natural gas, as well as conditions that relate to the standard unit of measure 
group, such as a specific pressure base for MCF gas.

Further, the delivery network measurement group specifies which industry standard conversion routine should 
be used.The conversion routines determine how volume conversions are calculated.

See also:

Creating a Delivery Network Measurement Group [page 125]

4.2.4.3.1 Creating a Delivery Network Measurement Group 

Procedure

You use this to create a delivery network measurement group.

1. At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Production
Delivery Network Measurement Group Create  . The Create Measurement Group: Overview screen is 
displayed.

2. Enter a name for the measurement group (you can use an alphanumeric name). Then choose Enter . The 
Create Measurement Group: Overview Screen is displayed.

3. In the second field specify the Material for this material group.
The specification of material is however optional .

4. In the third field on the Measurement (UoM) Group row, enter a Description of the measurement 
group.Then enter the unit of measure group, which sets criteria such as the pressure base for gas, as well 
as the Conversion Group , which defines the conversion routines that determine how volume conversions 
are calculated.

5. Save the measurement group.

Using a Reference for a Delivery Network Measurement Group

If a measurement group record already exists with data similar to that of the new measurement group you are 
creating, you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter the number of the existing measurement 
group in the reference section of the initial screen for the new measurement group.

Example

This transaction could be used to capture compression temperatures.

SAP Oil & Gas (PRA - Production and Revenue Accounting)
Production C U S T O M E R 125



4.2.4.4 Delivery Network Downstream Node

The delivery network downstream node is the measurement point to which upstream measurement points 
and/or well completions are linked.

The downstream node represents the measurement point that is farthest downstream.

See also:

Creating a Delivery Network Downstream Node [page 126]

4.2.4.4.1 Creating a Delivery Network Downstream Node 

Use

This transaction links measurement points and/or well completions to one primary measurement point, 
representing a delivery network downstream node.

The connection links the “upstream“ measurement points and/or well completions to the downstream node.

Procedure

At the SAP Easy Access screen, choose Logistics   →   Production and Revenue Accounting   →  Production   →   
Delivery Network   →   DN Downstream Node   →   Create

The Create Delivery Network Downstream Node: Initial Screen is displayed.

Enter the following data:

Delivery Network

Effective From

From/Upstream MP

Well Completion

To connect a measurement point to the primary downstream measurement point, enter data in the From/
Upstream MP field. Or, to connect a well completion to the primary downstream measurement point, enter 
data in the well completion fields.

To/DownstreamMP

Choose Enter .

The Create Delivery Network Downstream Node: Overview screen.

Verify the date in the Effective To field.
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Save the delivery network downstream node.

4.2.4.5 Delivery Network Hierarchy

Definition

The delivery network hierarchy represents a group of delivery networks at a hierarchical level. The hierarchical 
level can consist of one delivery network group or multiple delivery network groups.

Use

A delivery network hierarchy can be set up as organizational data for multiple users. Or, a single user can set up 
a delivery network group for individual use as required.

See also:

Creating a Delivery Network Hierarchy [page 127]

4.2.4.5.1 Creating a Delivery Network Hierarchy 

Use

This transaction links multiple delivery networks together into a group.

Multiple sets of delivery network groups can be established as hierarchy levels under one delivery network 
group.

Procedure

1. At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting  Production 
Delivery Network Hierarchy Create  .

The Create Delivery Network Hierarchy: Initial Screen is displayed.
2. In the Delivery network group field, enter a name for the delivery network group.(You can use an 

alphanumeric name.)Then choose Hierarchy .
The Create Delivery Network Hierarchy: Structure screen is displayed.

3. The options available on this screen are listed below.
Adding a Level to the Delivery Network Hierarchy
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To add a level to the delivery network hierarchy, select the delivery network hierarchy and then choose 
Lower Level .Then, in the first field for the hierarchy level, enter an identification number, and in the second 
field enter a description.
Adding Delivery Networks to the Hierarchy
To add delivery networks to the hierarchy, select the required level and choose Delivery Network .Then, in 
the first field for the delivery network, enter the delivery network number.After you choose Enter , the 
second field will display a description of the delivery network.
Creating Additional Levels for the Delivery Network Hierarchy
To create additional hierarchy levels for the delivery network hierarchy, click a level to select it and either 
(a) choose Same Level to create a new level at the same level as the one that is selected, or (b) choose 
Lower Level to create a new level one level lower than the one that is selected.
Viewing Hierarchy Details
After creating levels for a delivery network group, choose Expand All to view a list of each delivery network 
in a level.
Viewing the Delivery Network Group Levels Only
After using Expand All to view delivery network details, choose Collapse All to return the view to only the 
delivery network levels.
Selecting Items
To select an item, click the appropriate row and choose Select .
Deselecting Items
To deselect selected items, choose Deselect All .
Deleting the Delivery Network Group
To delete the delivery network group, choose Delete .
Viewing a Single Delivery Network Record
To access a delivery network record, place the cursor on a delivery network number and choose Display 
Delivery Network .
Determining Delivery Network Hierarchy Use
To retrieve a listing detailing where a level of a delivery network hierarchy is used in SAP, place the cursor 
on the appropriate hierarchy level and choose Where Used List for Group .

4. Exit the delivery network group.

Using a Reference for a Delivery Network Group

If a delivery network group record already exists with data similar to that of the new delivery network group you 
are creating, you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter the ID of the existing delivery network group in 
the reference section of the initial screen for the new delivery network group.

4.3 Volume Allocation 

Purpose

A network is a series of nodes that are linked for the purpose of allocating a product back to the well 
completion level, ultimately, to provide PRA Revenue with the data it needs. A network hierarchy is built on a 
series of different levels. The concept of level is very important, as PRA uses levels in applying allocation 
formulas and network validity edits.
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Volume allocation is carried out by the PRA system for each product code / volume type. You select volume 
jobs to allocate from the allocation selection screen (see: Allocating a Delivery Network [page 192] ). You use 
this screen to start the volume allocation job.

Before a network can be allocated, you have to first verified that the network can be allocated. Theoreticals are 
used to estimate production from: well tests, metered volumes, or the allocation base.

Allocation rules define how volume allocation operates.Allocation rules are defined at well completion, 
measurement point, and delivery network levels within a delivery network. Once the allocation rules are 
established, volume allocation executes the steps required to carry out allocation.

There are three volume allocation rules. These rules are defined at: well completion level, measurement point 
leve, and delivery network level:

Table 27:

Theoretical calculation method Defined at well completion level The theoretical calculation method 
(TCM) dictates how the volume alloca­
tion process will determine a well com­
pletion’s estimated or theoretical pro­
duction for a given period. The TCM is 
established for each major product pro­
duced out of a well completion.

Delivery network allocation profile Defined at delivery network level The DN allocation profile directs the 
volume allocation process in the alloca­
tion of all product volumes within a de­
livery system. The DN allocation profile 
lists the products and volume types 
that will be allocated to well comple­
tions within a delivery network.

MP allocation profile Defined at measurement point level The MP allocation profile directs the 
volume allocation process on what type 
of volume to allocate from a measure­
ment point. The MP allocation profile 
also indicates the manner in which vol­
umes for a product and volume type 
are derived at the measurement point.

Three reports can be generated as a result of the allocation process:

Table 28:

The Error Report (VAB3505)

The Volumetric Source Report (VAB3105)

The Well Completion Dispositions Report (VAB3205)

In addition to the standard reports generated out of an allocation, two trace reports can be generated:

● Trace Report 1 – Theoreticals
● Trace Report 2 – Allocations
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After volume allocation has been run, it is a good idea to view the error, volumetric source, and well completion 
disposition reports in order to verify the data.

Trial vs. Final Allocations :

Volume allocation can be run in either trial mode, or final mode. An explanation of the differences follows:

Table 29:

Trial allocation run Trial allocations can be requested at any time during the pro­
duction month. Well completion dispositions will not be 
posted to the WC volumes table. The network will not be 
closed. Trial allocations allow you to carry out a test run of 
the allocation process, and to verify, using allocation reports, 
that actual results match expected results. This allows you 
to see and correct errors, before final allocation.

Final allocation run In final allocation, well completion dispositions are posted to 
the WC Volumes table. The network is closed.

Prerequisites

Establishing Allocation Rules

Allocation rules cover the following:

1. If volume is to be captured at a measurement point, complete a delivery network allocation profile, and a 
measurement point allocation profile.

2. If volume is to be captured at a well completion, complete a delivery network allocation profile.
3. Complete a theoretical calculation method for each well completion, as required.
4.

Note
Theoretical calculation methods are required for well completions, unless no test data or metered 
volume is available for deriving theoretical volumes. When no test data or metered volume is available, 
the allocation base is defined.

5. If a formula is required, enter formula rules.

Process Flow

Once the allocation rules are established, volume allocation then:

1. Determines theoretical volumes, usually from well test and downtime data (beginning theoreticals)
2. Determines inputs, which are the sum of theoreticals and estimates
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3. Determines outputs, which are the sum of actuals
4. Determines the percentage difference between inputs and outputs
5. Determines any applicable tolerance(s)
6. Adjusts inputs (when the difference is within tolerance) to match outputs
7. Allocates volumes
8. Reduces theoreticals
9. An explanation of these processes follows:
10.

Table 30:

1. Step 1 – Determination of Theoreticals
2. Beginning theoretical = Production x hours up / (test duration time / 60)

1. Step 2 – Determine inputs, which are the sum of theoreticals and estimates
2. Inputs = Sum of beginning theoreticals

1. Step 3 – Determine outputs, which are the sum of actuals
2. Outputs = Sales + (ending inventory – beginning inventory)

1. Step 4 – Determine the percentage difference between inputs and outputs
2. Outputs = [(outputs – inputs) / inputs] x 100

Step 5 – Determine tolerances

1. Step 6 - Adjust inputs (when the difference is within tolerance) to match outputs
2. Adjusted inputs = (total outputs – adj. inputs) x node theo./(total inputs – processed theo.)

1. Step 7 – Allocate volumes
2. Allocated volume = (total volume – allocated volume) x node adj. input /(total adj. inputs – processed node adj. 

inputs)

1. Step 8 – Reduce theoreticals

11. Results of allocation :
12. An allocation has the following results on other PRA components:
13. PRA-Production:
14. o Crude oil is allocated (back to participating well completions)
15. o Processed gas is allocated
16. o Unprocessed gas is allocated
17. PRA-Contractual Allocation (CA)
18. o Gas volumes are allocated to contract level, based on well production
19. o Oil is not processed, due to lack of contract diversity
20.PRA-Valuation
21. o Values product
22. o Updates tax tables
23. o Derives marketing costs

4.3.1  Volume Allocation - Example 
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We begin with a network made up of 5 well completions, and two measurement points.

1-1 through 1-5 are well completions. T1 is a tank. L2 is a LACT meter (sales point).

Well completions 1-1 and 1-4 are down (not producing).

Beginning theoreticals (weighted calculation):

1-1 – 0 (down)

1-2 – well completion has a test of 30 bbls/day.

1-3 – well completion has a test of 10 bbls/day.

1-4 – well completion has a test of 70 bbls/day.

1-5 – 0 (down)

Inputs: The inputs are the sum of the beginning theoreticals.

We set up theoretical calculation methods for each well completion.

We set up a delivery network allocation profile for the network. The DN allocation profile is:

- Oil / inventory
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- oil / sales

Volume readings:

- 3,000 bbls sold at L2 (LACT meter).

- 300 bbls stored in the tank (T1)

Table 31:

Theoretical calculation method (TCM) WC estimated production, per major product code.

MP allocation profile Defines what kind of volume to allocate for a specific meas­
urement point.

DN allocation profile Directs the volume allocation process in the allocation of all 
product volumes within a delivery network. It lists the prod­
ucts and volume types (see Volume Categories and Volume 
Types [page 136] ), and the order of allocation of those 
products and volume types.

Steps (for a full description of the volume allocation process, please see: Volume Allocation [page 128] ):

1. Determine Theoretical volumes
2. Determine Inputs
3. Determine outputs
4. Determine % difference between inputs and outputs
5. Determine tolerance
6. Adjust inputs
7. Allocate volumes
8. Reduce theoreticals
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Table 32:

Step 1. Determine Theoretical volumes

Well completions 1-1 and 1-4 are down; therefore, the beginning theoretical for each is 0.

For WC 1-2: TCM is the latest test, showing production of 30 bbls/day.

Beg. Theo. = Production x Hours Up / ( Test Duration time / 60)

= 30 x 744 / (1440/60)

= 930

For WC 1-3: TCM is the latest test, showing production of 10 bbls/day

Beg. Theo. = 10 x 744 / (1440/60)

= 310

For WC 1-5 TCM is the latest Test, showing production of 70 bbls/day

= 70 x 744 / (1440/60)

= 2170

 

Step 2. Determine theoreticals

Inputs = Sum of beg. theos.

= 930 +310 +2170

= 3,410 bbls

Step 3. Determine outputs

Outputs = sales + (ending inventory – beg. inventory)

= 3000 + (300 – 0)

= 3300 bbls

 

Step 4. Formula for determining the % difference between inputs / outputs

Outputs = [(outputs – inputs) / inputs] x 100

= [(3300 – 3410) / 3410] x 100

= 3.23 %
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Step 6. Adjust inputs to outputs

Adjusted Inputs = (total outputs - adj inputs) x node theo/(total inputs - processed theo)

adj input @ 1-1 = (3300 - 0) x 930 /(3410 - 0) = 900

adj input @ 1-3 = (3300 - 900) x 310 / (3410 - 930) = 300

adj input @ 1-5 = (3300 - 900 - 300) x 2170 / (3410 - 930 - 310) = 2100

Total adj. Inputs = 900 + 300 + 2100 = 3300

 

Step 7 – Allocate inventory volumes

Allocated volume = (total vol. - allocated vol.) x

node adj input/( total adj inputs - processed node adj. inputs)

Allocate 300 bbl of Oil/inventory:

alloc. Vol @ 1-1 = (3300 - 0) x 900 /(3300 - 0) = 81.82

alloc. vol @ 1-3 = (3300 - 81.82) x 300 / (3300 - 900) = 27.27

alloc. vol @ 1-5 = (3300 - 81.82- 27.27) x 2100 / (3300 - 900 - 300) = 190.91

Adj wc inputs:

@ 1-1 = 900 - 81.82 = 818.18

@ 1-3 = 300 - 272.73 = 272.73

@ 1-5 = 2100 - 1909.09 = 1909.09

Total adj inputs = 818.18 + 272.73 + 1909.09 = 3000
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Step 8 – Allocate Sales Volume

Allocated volume = (total vol. - allocated vol.) x

node adj input/( total adj inputs - processed node adj. inputs)

Allocate 300 bbl of Oil/Sales:

alloc. Vol @ 1-1 = (3000 - 0) x 818.18 /(3000 - 0) = 818.17

alloc. vol @ 1-3 = (3000 - 818.17) x 272.73 / (3000 - 900) = 272.73

alloc. vol @ 1-5 = (3000 - 818.17 - 272.73) x

1909.09 / (3000 - 818.18 - 272.73) = 1909.10

Adj wc inputs:

@ 1-1 = 818.18 - 818.17 = .01

@ 1-3 = 272.73 - 272.73 = 0

@ 1-5 = 1909.09 - 1909.10 = (-.01)

Total adj inputs = .01 + 0 + (-.01) = 0

 

4.3.2  Volume Categories and Volume Types 

Definition

Volume types are defined for production, and are linked with volume categories. Volume types are used in PRA 
allocation processes.
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Use

The following are the volume categories used in PRA:

Table 33:

Volume category Volume category description

Actual (A) Defines volume types that are calculated by the system. The 
alternative is manually-maintained volume types.

Fuel (F) Defines product dispositions (volume types) that are consid­
ered fuel consumption volumes. These can be calculated by 
the system based on operating hours and consumption /
firing rates of the device, or by providing the volumes.

Inventory (I) Defines volume types that are considered product storage/
inventory volumes. These VTs potentially represent both 
opening and closing inventory volumes. When recorded at a 
measurement point level, these VTs will be considered “clos­
ing” inventory.

Lease (L) Defines dispositions (volume types) that are part of an ex­
change between well completions on the same lease. These 
will be calculated by the system when exchanges for gas lift, 
formation injection, etc. are required. In an exchange, PRA 
(Production) will create two transactions: the “exchange 
from” side is a “lease” VT category volume and the “ex­
change to” side is a “non-sales” VT category volume.

Non-sales (N) Defines product dispositions (volume types) that are consid­
ered all product dispositions other than sales or fuel/lease 
use. This volume type (VT) is also used in exchanges be­
tween wells on the same lease on the “exchanged to” side.

Other (O) Defines volume types that are considered non‑final product 
disposition volume types (plant total PVR is an example of 
“other”). This VT is NOT considered to be part of “calculated 
production, ” but its volume needs to be captured. This VT 
has little affect on PRA processing.

Production (P) Defines volume types that are considered to be measure­
ment of product production. These VTs are not part of “cal­
culated production, ” but are used in the allocation process 
(as allocation basis) and for determination of meter differen-
tials.
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Receipts (R) Defines volume types that are considered to have been re­
ceived from an outside source - from another well on the 
same lease, from a well on another lease, from a plant, fa­
cility, or a third party. This VT does not include the portion of 
a product disposition produced by the well.

Sales (S) Defines product dispositions (volume types) that are consid­
ered to have been sold. Note that calculated production is 
determined at a well level, based on the volume type catego­
ries:

CALCULATED PRODUCTION = Fuel + Inventory + Non Sales 
+ Sales ‑ Lease ‑Receipts

The following volume types can be used in PRA:

Each volume type is associated with a specific volume category, which is listed as part of the volume type 
descriptions. The number ID before each volume type refers to the volume type code ID. “System-generated” 
refers to whether or not the volume type is generated as part of the system processing, or, if not, that it is 
manually entered (by a user).

Table 34:

00 - Directed Volume

VOLUME CATEGORY: Other PRA USES - Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: No Plants: Yes

01 - Measured Production

This is a measured volume that represents the amount of flow of product through a particular stream. This volume is usu­
ally a ‘real’ (as opposed to theoretical) measured volume that is associated with a meter. In PRA, this volume can be en­
tered on allocation or deduct meter MP types. This volume type can also be used on an allocation or deduct meter, if the 
volume is to be calculated from stream downtime and well tests, if used in multiple stream allocations.

VOLUME CATEGORY: Sales PRA USES - Production: Yes

SYSTEM GENERATED: No Revenue: Yes (OA, VL, RD)

PRODUCT SPECIFIC: Gas Plants: Yes

PRODUCTION: Volume used as the “metered” volume, if downstream from a well completion whose theoretical calculation 
method is “metered” volumes. Also used to control proration of volumes at the measurement point level.
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02 ‑ Adjusted Plant Production

This is the volume that is calculated from metered plant inlet (83), less plant loss (48), vent/flared (45), plant fuel (24), 
unaccounted for in transportation (96), residue sold (57) and adjusted for meter differential (43). This volume type is used 
in plant allocations.

VOLUME CATEGORY: Production RA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: Gas Plants: Yes

03 ‑ Sales 1

This is the volume that is considered sold to third parties and/or from leases to plants or to other leases.

VOLUME CATEGORY: Sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue:

PRODUCT SPECIFIC: No (CA, VL, RD, JE):

Yes

PRODUCTION: Observed conditions MUST be recorded with the volume. Defaults are not used on VD screens. A trans­
porter must be recorded with a sales volume. If there is one purchaser related to this particular sales point and transporter, 
then PRA production will also set the purchaser.

04 ‑ Closing Inventory‑Liquids

Stored liquid product volumes including plant products, oil, and condensate. This volume indicates the end of the month 
inventory.

VOLUME CATEGORY: Inventory PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Yes (1xx, 3xx, 4xx, 5xx)

PRODUCTION: Can be determined using gauge readings, meter readings, or by simply entering a “measured” volume on 
the measurement point volumes screen. It is normally recorded at either a tank measurement point or a tank battery meas­
urement point. The tank battery CAN be used in the instance where there are multiple tanks and a single inventory volume 
is to be recorded. Closing inventory for one month (allocated to wells) is rolled forward as beginning inventory for the sub­
sequent month (at the well level).

05 – Retrograde Sales  

VOLUME CATEGORY: Production
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06 ‑ Stored Gas

Volume of gas stored.

VOLUME CATEGORY: Inventory PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Yes (2xx, 6xx) Plants: Yes

PRODUCTION: Used as a gas product final disposition (not in a fuel system).

PLANTS: Stored gas can be associated with a plant.

07 ‑ Check Meter Volume

Volume measured (metered) to verify sales meter readings or other measured production (VT 01) amounts. It is NOT used 
to adjust the allocation to wells.

VOLUME CATEGORY: Production PRA USES: Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: No

PRODUCTION: Allocated back to a well and can be used as a theoretical volume for dependency allocations.

08 ‑ Plant Other

VOLUME CATEGORY: Other PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: No

09 ‑ Lease Fuel ‑ Exchanged To

When a well completion uses more lease use volume than what it produced during a month, the first action in PRA is to 
transfer product from other well completions on the same lease to the extent that the other well completions have the 
product available. This volume type identifies the volume transferred to the well completions that is short from another/
other well completions on the same lease to make up the shortage. See VT 19 for the receipt side.

VOLUME CATEGORY: Non‑sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: Used in volume allocations and in allocated results. PRA will automatically determine and record at the well 
completion-level on both sides of the exchange: on the well completion receiving the exchange (VT 19 ‑ exchange from) and 
on the well completions contributing to the exchange (VT 09 ‑ exchange to).
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10 ‑ Lease Fuel Before PM ‑ On Lease

Lease use gas (fuel) used on the same lease that produced the gas. The gas is used prior to being measured by a “produc­
tion meter” (PM) (i.e., used upstream of a “production meter” and prior to being measured).

VOLUME CATEGORY: Fuel PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue:

PRODUCT SPECIFIC: Gas CA, RD, JE: No

VL: Yes

PRODUCTION: This is an estimated or metered volume used as fuel on any fuel consumption device that is upstream of an 
allocation or deduct meter that is capturing “measured production” (VT 01).

REVENUE: Volume is valued.

11 ‑ Lease Fuel - Compression

Lease use product used on the same lease that produced the product. VT 11 will be the normal “lease use on lease” disposi­
tion used, unless the requirements for VT 10 are met, or unless VTs 12 through 15 are needed for allocation purposes.

VOLUME CATEGORY: Fuel PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue -

PRODUCT SPECIFIC: 2xx CA, RD, JE: No

VL: Yes

PRODUCTION: This is an estimated or metered volume used as lease-use on the lease that produced the product. Often, 
this volume will be calculated (and this holds for any fuel consumption device) in PRA in combination with a monthly “hours 
up” or throughput volume transaction specified in PRA.

REVENUE: Volume is valued.

12 ‑ Lease Fuel - Dehydration

Lease use product used on the same lease that produced the product. VT 12 will be used mainly if two or more “lease use 
on same lease” volume types are used, and each is allocated to a different well through the use of the allocation profiles. 
However, if VT 12 is used instead of VT 11, it will be treated just like VT 11.

VOLUME CATEGORY: Fuel PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue -

PRODUCT SPECIFIC: Yes (2xx) CA, RD, JE: No

VL: Yes

PRODUCTION: This is an estimated or metered volume used as lease use on the lease that produced the product. Often, 
this volume will be calculated (and this holds for any fuel consumption device) in PRA in combination with a monthly “hours 
up” or throughput volume transaction specified in PRA.

REVENUE: Volume is valued.
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13 ‑ Lease Fuel - Steam

Lease use product used on the same lease that produced the product. VT 13 will be used mainly if two or more “lease use 
on same lease” volume types are used, and each is allocated to a different well through the use of the allocation profiles. 
However, if VT 13 is used instead of VT 11, it will be treated just like VT 11.

VOLUME CATEGORY: Fuel PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue -

PRODUCT SPECIFIC: Yes (2xx) CA, RD, JE: No

VL: Yes

PRODUCTION: This is an estimated or metered volume used as lease use on the lease that produced the product. Often, 
this volume will be calculated (and this holds for any Fuel Consumption Device) in PRA in combination with a monthly 
“hours up” or throughput volume transaction specified in PRA.

REVENUE: Volume is valued.

14 ‑ Lease Fuel - Co-Gen Steam

Lease use product used on the same lease that produced the product. VT 14 will be used mainly if two or more “lease use 
on same lease” volume types are used, and each is allocated to a different well through use of the allocation profiles. How­
ever, if VT 14 is used instead of VT 11, it will treated just like VT 11.

VOLUME CATEGORY: Fuel PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue -

PRODUCT SPECIFIC: Yes (2xx) CA, RD, JE: No

VL: Yes

PRODUCTION: This is an estimated or metered volume used as lease use on the lease that produced the product. Often, 
this volume will be calculated (and this holds for any fuel Consumption Device) in PRA in combination with a monthly 
“hours up” or throughput volume transaction specified in PRA.

REVENUE: Volume is valued.
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15 ‑ Lease Fuel - Co-Gen Electric

Lease use product used on the same lease that produced the product. VT 15 will be used mainly if two or more “lease use 
on same lease” volume types are used and each is allocated to a different well through the use of the allocation profiles. 
However, if VT 15 is used instead of VT 11, it will treated just like VT 11.

VOLUME CATEGORY: Fuel PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue -

PRODUCT SPECIFIC: Yes (2xx) CA, RD, JE: No

VL: Yes

PRODUCTION: This is an estimated or metered volume used as lease use on the lease that produced the product. Often, 
this volume will be calculated (and this holds for any Fuel Consumption Device) in PRA in combination with a monthly 
“hours up” or throughput volume transaction specified in PRA.

REVENUE: Volume is valued.

16 ‑ Reproduced G/L Gas

Volume of gas lift gas injected and then reproduced. This is not a product disposition VT. This VT is determined at well com­
pletion level and based on gas lift volumes from various sources. This VT represents the total amount of gas lift gas recy­
cled and reproduced for a particular well completion.

VOLUME CATEGORY: Actual PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: Yes (2xx)

PRODUCTION: System-generated VT based as a sum of gas lift VTs at the well completion level:

Reproduced G/L Gas (VT16) = GLG Own Well Compl (VT 51) + GLG Exchange From(VT 53) + GLG Prchd From Off Lse (VT 
55).

17 ‑ Formation Production When Gas Lift

Volume of gas produced in excess of gas lift gas reproduced, determined at well completion level.

VOLUME CATEGORY: Actual PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: Yes (2xx)

PRODUCTION: System-generated VT based on the difference between reproduced gas lift gas (VT 16) and calculated pro­
duction (VT 91), both at the well completion level.

Formation Production When Gas Lift (VT 17) = Gas Lift Gas Reproduced (VT 16)(-) minus Calculated Production (VT 91)

If the difference is negative (more calculated production), then the difference is considered formation production when gas 
lift (VT 17). If the difference is positive (more reproduced gas lift gas (VT 16), then the difference is considered gas lift gas 
loss (VT 60).
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18 ‑ Formation Inject‑ On Lse

Volume of product injected in the same formation and on the same lease where the product was produced.

VOLUME CATEGORY: Non‑Sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: No

PRODUCTION: This is an estimated or metered volume used as formation injection on the lease that produced the product.

19 ‑ Lease Use ‑ Exch From

When a well completion uses more lease use product than what it produced during a month, the first action in PRA is to 
transfer product from other well completions on the same lease to the extent that the other well completions have the 
product available. This volume type identifies the volume received by the well completion that is short from other well com­
pletion(s) on the same lease to make up the shortage. See VT 9 for the Exchanged-to side.

VOLUME CATEGORY: Lease PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: Yes (2xx)

PRODUCTION: Used in volume allocations and in allocated results. PRA will automatically determine and record at the well 
completion level both sides of the exchange: on the well completion receiving the exchange (VT 19 ‑ exchange from) and on 
the well completion(s) contributing to the exchange (VT 09 ‑ exchange to).

21 ‑ Sales ‑ 2

Exactly the same as Sales ‑ 1 (VT 03).

VOLUME CATEGORY: Sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: Yes

PRODUCT SPECIFIC: No (CA, VL, RD, JE): Yes

PRODUCTION: Use of the sales ‑ 2 can facilitate the control of the allocation process by allowing special sales to be allo­
cated separate from regular sales (VT 03). This is accomplished through the specifications in the Delivery Network Alloca­
tion Profile transaction in PRA.

24 ‑ Plant Fuel

Gas used as fuel in a plant.

VOLUME CATEGORY: Fuel PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: Used in volume determination, plant volume allocation, and allocation results.

144 C U S T O M E R
SAP Oil & Gas (PRA - Production and Revenue Accounting)

Production



25 ‑ Slop Oil Sales

Sales of reclaimed or “slop” oil. This type of oil is defined to be “waste” oil, whose quality has been affected during extrac­
tion, processing, or storage. It also could be oil that was spilled. This can be either oil or condensate.

VOLUME CATEGORY: Sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue -

PRODUCT SPECIFIC: Oil, cond. (CA, VL.RD, JE):

Yes

PRODUCTION: This volume type is handled like any other sales volume.

26 ‑ Skim Oil Sales

Sales of oil skimmed from the surface of a pit or tank into which both oil and water have been placed. Normally, this will 
reflect the oil accumulated with the water disposal system. This can be either oil or condensate.

VOLUME CATEGORY: Sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue -

PRODUCT SPECIFIC: Yrd (1xx (Oil), 3xx (Cond)(CA, VL, RD, JE):

Yes

PRODUCTION: This is handled like any other sales volume type. Can be allocated with a water volume as a dependency, if 
water volumes have been previously allocated to those well completions.

27 ‑ Tank Cleaning

Also referred to as water draw-off. PRA treats it as a disposition of production. It is a reduction in stocks when tanks are 
cleaned or “bled-off” to remove excess or all BS&W (basic sediment and water) from an oil storage tank. This can be oil or 
condensate.

VOLUME CATEGORY: Non‑Sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Yes (1xx (Oil), 3xx (Cond)

PRODUCTION: This volume should be entered as a negative volume, resulting in a reduction of calculated production.

28 ‑ Scrubber Oil Sales

Sales of oil from a scrubber which is a vessel, in which liquids are removed from a mixture of gas and liquids. Not a part of 
any processing plant operations. Can be either oil or condensate.

VOLUME CATEGORY: Sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue -

PRODUCT SPECIFIC: Oil, Cond. (CA, VL, RD, JE):

Yes

PRODUCTION: This volume type handled like any other sales volume.
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29 ‑ By‑passed Gas Supplied

Volume of gas that is sold out of the tailgate of the plant without being processed or consumed in the plant.

VOLUME CATEGORY: Sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: Used in volume determination, plant volume allocation, and allocation results.

30 ‑ Vent/Flare ‑ On Lease

Gas vented or flared on the lease where it was produced (either directly or returned and then vented or flared) without be­
ing used in operations such as gas lift etc. This VT is NOT considered “lost.”

VOLUME CATEGORY: Non‑sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Yes (2xx, 6xx)

PRODUCTION: This is an estimated or metered volume that was either vented or flared on the lease.

NOTE: Though this is NOT a fuel consumption volume, it CAN be estimated using fuel specs and be calculated as if it were a 
fuel usage volume in PRA.

31 ‑ Vent/Flare ‑ Off Lease

Gas vented or flared off the lease where it was produced without being used in operations such as gas lift etc. This VT is 
NOT considered “lost.”

VOLUME CATEGORY: Non‑sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Gas, CO2

PRODUCTION: This is an estimated or metered volume that was either vented or flared off the lease where it was produced.

NOTE: This VT is NOT a fuel consumption volume and CANNOT be calculated as if it were a fuel usage volume in PRA.

32 ‑ By-Passed Gas Received

Volume of gas received that is sold out of the tailgate of the plant without being processed or consumed in the plant.

VOLUME CATEGORY: Receipt PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: Used in volume determination, plant volume allocation and allocation results.
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36 ‑ Hydrocarbon Extraction Loss (Texas)

Reduction/loss in the volume of gas through the processing/separation of the condensate from the wet gas stream in pro­
duction facilities. This VT applies only to selected wells in Texas.

VOLUME CATEGORY: Non-salesPREMAS USES ‑ Production: Yes

SYSTEM GENERATED: Yes / No Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: If the well meets the following criteria, then the system will create this VT and calculate the volume to go 
with it. This VT is calculated and maintained at the well completion if: 1) it is an onshore Texas gas well, 2) it is producing ‑ 
UNLESS ‑ An override is used on the W/C Dated Characteristics screen in PRA to indicate that it should NOT be calculated. 
The extraction loss factor used by default is 1.1. However, the factor can be specified for a well completion on the W/C 
Dated Characteristics screen. It is calculated as:

Hydrocarbon Extraction Loss = Calculated Production * Extraction Factor.

(VT 36) (VT 91).

37 ‑ Casualty Loss

Volume of product lost, stolen, or otherwise unaccounted for. NOTE: VT 96 is used for “unaccounted for” in transportation.

VOLUME CATEGORY: Non‑sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: No

PRODUCTION: This VT can be set up and recorded for any product. There is no specific reference in Production Volume 
Allocation.

38 ‑ Lease Use ‑ Off Lease

Lease use product used on another lease than the lease that produced the product. See VT 39 for purchase side.

VOLUME CATEGORY: Sale PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue -

PRODUCT SPECIFIC: Yes (2xx) CA, RD, JE:

VL: Yes

PRODUCTION: This VT is determined by PRA at the well completion level. PRA will automatically record both sides of this 
sale & purchase; on the well purchasing the volume (VT 39), and on the well selling the volume (VT 38). Handled like a 
sales, but is included in VT 93 ‑ total off lease use.

REVENUE: Volume is valued.
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39 ‑ Lease Fuel - Purchased From

Product purchased from off-lease for lease use. See VT 38 for sale side.

VOLUME CATEGORY: Receipt PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: Yes (2xx)

PRODUCTION: This VT is determined by PRA at the well completion level. PRA will automatically record both sides of this 
sale and purchase; on the well purchasing the volume (VT 39), and on the well selling the volume (VT 38).

40 ‑ Purchase Fuel (Included in Lease Use)

Product purchased from off lease for on lease use.

VOLUME CATEGORY: Receipt PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue -

PRODUCT SPECIFIC: Yes (2xx) (CA, VL, RD, JE): Yes

PRODUCTION: This is an estimated or metered volume purchased from another lease or from a third party for lease, used 
as opposed to being generated (see VT 39 above).

41 – Calculated Acid Gas Extr. Loss

VOLUME CATEGORY: Non-Sales

Gas plant disposition which represents the sum of H2S and C02 components of gas plant inlet volumes.

42 – Plant Compression Fuel

VOLUME CATEGORY: Fuel

43 ‑ Meter Differential

The volume differential between “measured” and “calculated” production.

VOLUME CATEGORY: Other PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: No

PRODUCTION: This VT is a calculated volume that represents the difference between calculated production (VT 91) and 
measured production (VT 01) (see the specific formula below). A meter differential will only be calculated and maintained 
at the well completion level, if this VT is specified in the Network Allocation Profile.

Meter Differential (VT 43) = Measured Production (VT = 01) ‑ Calculated Production (VT = 91) + Lease Use Before PM‑On 
Lse (VT = 10).
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44 ‑ Hydrocarbon Extraction Loss

Reduction in the volume of wet gas processed in a gas plant from the extraction of natural gas liquids (NGLs). Does not 
include volume of wet gas lost from such things as plant fuel (VT 24), plant vent/flared (VT 45), unaccounted for (VT 96), 
etc.

VOLUME CATEGORY: Non‑sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: Used in gas plant allocations.

45 ‑ Plant Vent/Flared

Gas vented or flared in a plant. This VT is NOT considered “lost.”

VOLUME CATEGORY: Non‑sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Gas, CO2

PRODUCTION: Used in gas plant allocations.

48 ‑ Plant Gain/Loss

VOLUME CATEGORY: Actual

Plant wet gas volume received (meter plant inlet (VT 83)), less adjusted plant production (02).

VOLUME CATEGORY: Actual PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: Used in gas plant allocations.

50 ‑ GLG Received

Volume of gas received for gas lift. This volume is an offset for other places in the delivery network that are the supply 
points for this gas lift gas. It includes gas from any and all sources received at the reception point.

VOLUME CATEGORY: Non-sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: This VT is recorded with the volume received at the GL measurement point (MP type 54). When allocated to 
wells, this VT will change to reflect the sources of the GL gas (own well completion, exchanged from on-lease, purchase 
from off-lease, etc). This disposition will not be seen at the well completion level.
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51 ‑ GLG Own Well Compl

Volume of gas supplied by a well completion to itself for gas lift.

VOLUME CATEGORY: Non‑sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: This VT is system-generated at the well completion level. Note: PRA will always go to the well completion 
receiving GL gas to get the GL supplied, before trying to resolve the supply through on-lease exchanges and off-lease pur­
chases.

52 ‑ GLG Exchange To

Volume of gas supplied by a well completion to another well completion on the same lease for gas lift purposes. See VT 53 
for exchange from volume.

VOLUME CATEGORY: Non‑sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: This VT is system-generated at the well completion level, resulting from the allocation of gas lift gas, when 
more GL gas was injected than a well produced. The volume recorded will be the amount that the supplying well completion 
has available, when GL gas is allocated. PRA will automatically record both sides of the exchange: on the well completion 
receiving the exchange (VT 53) and on the well completions contributing to the exchange (VT 52). The volume is the differ-
ence between the amount the well completion produced and the amount it had injected for gas lift purposes.

53 ‑ GLG Exchange From

Volume of gas received by a well completion from other well completion(s) on the same lease, for gas lift purposes.

VOLUME CATEGORY: Lease PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: This VT is system-generated at the well completion level, resulting from the allocation of gas lift gas, when 
more GL gas was injected than a well produced. PRA will automatically record both sides of the exchange: on the well com­
pletion receiving the exchange (VT 53) and on the well completion(s) contributing to the exchange (VT 52). The volume is 
the difference between the amount the well completion produced and the amount it had injected for gas lift purposes.
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54 ‑ Gas Lift Sold To Off-lease

Gas sold by a well (lease) to supplement the gas lift requirements of another well on a different lease.

VOLUME CATEGORY: Sale PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue -

PRODUCT SPECIFIC: Gas CA, RD, JE: Yes

VL: Yes

PRODUCTION: This VT is system-generated at the well completion level, resulting from the allocation of gas lift gas, when 
more GL gas was injected than a well produced, or was available from other wells on the same lease. PRA generates both 
sides of the sale: on the well completion receiving the gas lift gas (VT 55), and on the well completion(s) contributing to the 
gas lift gas (VT 54). The volume is the difference between the amount the well completion produced plus what other wells 
on the same lease contributed, and the amount injected for gas lift purposes. This VT is included in the calculation of total 
off-lease use (VT 93).

55 ‑ Gas Lift Purchased From Off-lease

Gas received by a well (lease) to supplement the well’s gas lift requirements. The gas is produced from well(s) on a different 
lease.

VOLUME CATEGORY: Receipt PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: This VT is system-generated at the well completion level, resulting from the allocation of gas lift gas, when 
more GL gas was injected than a well produced or was available from other wells on the same lease. PRA generates both 
sides of the sale: on the well completion receiving the gas lift gas (VT 55) and on the well completion(s) contributing the gas 
lift gas (VT 54). The volume is the difference between the amount the well completion produced plus what other wells on 
the same lease contributed, and the amount injected for gas lift purposes.

56 ‑ Residue Available for Sale

Volume of processed gas remaining, after sales and after residue returned to producing leases.

VOLUME CATEGORY: Production PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: Used in gas plant allocations.

57 ‑ Act Residue Delivered

Volume of processed gas measured at sales meter, plus measured residue returned to the producing lease.

VOLUME CATEGORY: Other PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: Yes

PRODUCT SPECIFIC: Gas

PRODUCTION: Used in gas plant allocations.
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58 ‑ Excess Residue

Volume of processed gas available for sale or return that is greater than the theoretical residue available.

VOLUME CATEGORY: Other PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: Used in gas plant allocations.

60 ‑ Gas Lift Gas Loss

Gas lift gas deemed to have been lost in the formation/well bore. This situation occurs when more gas lift gas is measured 
as received at a well, than the amount of gas lift gas recovered.

VOLUME CATEGORY: Actual (Other) PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: This VT is system-generated. The volume is the difference between calculated production and the total of 
gas lift gas received by a well.

Gas Lift Loss (VT 60) = Gas Lift Gas Reproduced (VT 16) ‑ Calculated Production (VT 91)

When calculated production, is less than gas received, a loss is recorded against VT 60 at the well. When calculated produc­
tion is more than GL gas received, a gain needs to be recorded (VT 17) at the well.

61 – Plant CO2 Production

VOLUME CATEGORY: Actual

62 – Plant Nitrogen Production

VOLUME CATEGORY: Actual

63 – Measured Acid Gas Extr. Loss

VOLUME CATEGORY: Non-sales

64 ‑ GLG Supplied

Measured volume of gas supplied for gas lift.

VOLUME CATEGORY: Non‑sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Gas                                                                       

PRODUCTION: This VT is normally recorded on the gas lift supply measurement point (MP Type 55). When allocated to 
wells, the VT is changed to reflect the source VTs of the supply (Own W/C, exchanged from on-lease, sold to off-lease, etc.). 
This VT will not be seen at the well level.

65 – Plant CO2 Injection

VOLUME CATEGORY: Non-sales
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66 ‑ NGL Production

Volume of natural gas liquids (NGLs) recovered from an extraction process against a wet gas product stream in a plant or 
facility.

VOLUME CATEGORY: Production PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: Yes

PRODUCT SPECIFIC: NGL

PRODUCTION: Used in gas plant allocations.

67 ‑ Formation Inj Supplied

Measured volume of product supplied for formation injection purposes.

VOLUME CATEGORY: Non‑sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Yes (2xx, 5xx, 6xx)

PRODUCTION: When PRA allocates volumes to wells, this VT will be changed to reflect the source VTs of the supply (ex­
changed to on-lease, sold to off-lease, etc.). This VT will not be seen at the well completion level.

68 ‑ Formation Inj Received

Measured volume of product supplied for formation injection purposes.

VOLUME CATEGORY: Non-Sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Yes (2xx, 5xx, 6xx)

PRODUCTION: When PRA allocates volumes to wells, this VT will be changed to reflect the source VTs of the supply (ex­
changed from on-lease, purchased from off-lease, etc.). This VT will not be seen at the well completion level.

69 ‑ Formation Inj Exchanged To

Volume of product exchanged from a well completion on a lease to another well on the same lease, for formation injection 
purposes.

VOLUME CATEGORY: Non‑Sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: Yes (2xx, 5xx, 6xx)

PRODUCTION: When PRA allocates volumes to wells, PRA will automatically record both sides of the exchange: on the well 
receiving the exchange (VT 70 exchange from) and on the well contributing to the exchange (VT 69 exchange to).
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70 ‑ Formation Inj Exchanged From

Volume of product exchanged to a well completion on a lease from another well on the same lease, for formation injection 
purposes.

VOLUME CATEGORY: Lease PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: Yes (2xx, 5xx, 6xx)

PRODUCTION: When PRA allocates volumes to wells, PRA will automatically record both sides of the exchange: on the well 
receiving the exchange (VT 70 exchange from) and on the well contributing to the exchange (VT 69 exchange to).

71 ‑ Formation Inj – Off-Lse.

Volume of product sold off lease to another lease, for formation injection purposes.

VOLUME CATEGORY: Lease PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue -

PRODUCT SPECIFIC: Yes (2xx, 5xx, 6xx) CA, RD, JE: Yes

VL: Yes

PRODUCTION: PRA will automatically record both sides of the sale: on the well receiving the product (purchased VT 72) 
and the well contributing the product (VT 71). This VT is included in the calculation of total calculated off-lease use (VT 93).

72 ‑ Formation Inj ‑ Purchase From

Volume of product purchased from another lease, for formation injection purposes.

VOLUME CATEGORY: Receipt PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: Yes (2xx, 5xx, 6xx)

PRODUCTION: PRA will automatically record both sides of the sale: on the well receiving the product (purchased VT 72) 
and the well contributing the product (VT 71).

73 - Returned lease fuel (RLF) Supplied

Volume of gas returned to a producing lease to ‘fire’ fuel use devices.

VOLUME CATEGORY: Non-Sales PRA USES - Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: This and other re-circulated ‘supply volume types’ are entered in the Delivery Network Allocation Profile 
transaction as ‘non-allocated volume types (sequence number 000 ). It is entered on the MP Allocation Profile at the RLF 
supply point. It will trigger volume allocation to sum all RLF receipt volumes to the supply point so that all RLF volumes are 
included in the proration of total production to well completions.

154 C U S T O M E R
SAP Oil & Gas (PRA - Production and Revenue Accounting)

Production



74 ‑ RLF Received

Volume of residue gas received from a plant by the producing lease, to fuel lease use devices.

VOLUME CATEGORY: Non-Sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: This volume type is used for recording measured or calculated RLF received volumes at RLF receipt points. 
Other volume types may also be used (R1, R2, R3, R4, R5).

75 ‑ RLF Exchange To

Volume of gas returned to the producing lease for lease use purposes limited to the volume of gas exchanged from a well 
completion on a lease to another well on the same lease.

VOLUME CATEGORY: Non‑sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue: Yes

PRODUCT SPECIFIC: Gas

PRODUCTION: When PRA allocates gas volumes to wells, and the amount of gas returned allocated to a well completion 
exceeds the volume available for that well, PRA will automatically record both sides of the exchange: on the well receiving 
the exchange (VT 76 exchange from) and on the well contributing to the exchange (VT 75 exchange to).

76 ‑ RLF Exchanged From

Volume of residue gas received from a plant by the producing lease for lease use purposes limited to the volume of residue 
exchanged to a well completion on a lease from other well(s) on the same lease.

VOLUME CATEGORY: Lease PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: When PRA allocates gas volumes to wells, and the amount of gas returned allocated to a well completion 
exceeds the volume available for that well, PRA will automatically record both sides of the exchange: on the well receiving 
the exchange (VT 76 exchange from) and on the well contributing to the exchange (VT 75 exchange to).

77 ‑ RLF Sold To

Volume of gas sold by the producing lease to another lease, for lease use purposes.

VOLUME CATEGORY: Sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue -

PRODUCT SPECIFIC: Gas CA, RD, JE: Yes

VL: Yes

                                                                                                             

PRODUCTION: When PRA does an allocation of volumes to wells, PRA will automatically record both sides of the sale: on 
the well purchasing the residue (VT 78) and on the well selling the residue (VT 77). Also, VT 77 is included in total calculated 
lease use‑off lease (VT 93).
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78 ‑ RLF Purch From

Volume of gas purchased by a lease from a producing lease, for lease use purposes on the purchasing lease.

VOLUME CATEGORY: Receipt PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: When PRA does a plant allocation of volumes to wells, PRA will automatically record both sides of the sale: 
on the well purchasing the residue (VT 78) and on the well selling the residue (VT 77).

79 ‑ RLF Own Well Compl

Volume of residue returned to the well completion that produced the wet gas for lease use purposes.

VOLUME CATEGORY: Fuel PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue -

PRODUCT SPECIFIC: Gas CA, RD, JE: No

VL: Yes

PRODUCTION: This volume type is system-generated at well completion level. Note: PRA will always first look to the well 
completion receiving RLF to get residue supplied, before trying to resolve the supply through on-lease exchanges and off-
lease purchases. This VT is included in the calculation of VT 92 ‑ Total Calc Lse Use‑On Lse.

80 ‑ Allocation Volume

The volume determined at some real or imaginary (logical) measurement point, in order to control the allocation of disposi­
tions in production.

VOLUME CATEGORY: Production PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: No

PRODUCTION: This VT is to be recorded at an allocation or deduct meter. It is used to control the allocation process and in 
some cases, for regulatory reporting. If the theoretical calculation method (TCM) for the well is MV (metered volumes), 
then either this volume type, or VT 01 may be used at the meter immediately downstream of the well completion. Any num­
ber of VT 80 volumes can be found downstream from a well completion. This volume will be used to control the pro-rating 
of volumes at the measurement point level. It can only be recorded on an allocation meter (MP type 17) or a deduct meter 
(MP Type 04).

83 ‑ Meter Plant Inlet

Volume of wet gas measured as received for processing by a gas plant.

VOLUME CATEGORY: Production PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Yes (2xx)

PRODUCTION: Used in gas plant allocations.
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85 ‑ Total Injection

Total volume of a product injected into the formation (not GL injected) from any and all sources.

VOLUME CATEGORY: Other PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Yes (2xx, 5xx, 6xx)

87 ‑ STK Adjustment in Calculated Production

VOLUME CATEGORY: Non-sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: No

88 ‑ STK Adjustment not in Calculated Production

VOLUME CATEGORY: Other PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: No

90 ‑ Outside Operated Production

Production determined at a well level for an outside operated well. In most cases, this will be pseudo wells, not actual wells.

VOLUME CATEGORY: Other PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: No

PRODUCTION: This volume can be recorded directly at the well level. This volume can also be recorded at the MP level, but 
unless there are multiple wells, there is little business reason for recording at the MP level.

91 ‑ Calculated Production

Production determined at a well level. It is equivalent to closing stock, plus actual product dispositions, less opening stock, 
less acquisitions.

VOLUME CATEGORY: Actual PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue -

PRODUCT SPECIFIC: No (CA, VL, RD, JE): Yes

PRODUCTION: This is a system-calculated volume. This volume is considered to be the pro‑rated “allocated” production of 
the well for that product. It is calculated by adding and subtracting allocated volumes, based on the volume categories of 
their VTs:

CALCULATED PRODUCTION = Fuel + Inventory + Non Sales + Sales ‑ Lease ‑ Receipts

This is the VT that PRA uses to report to regulatory agencies, in order to indicate production.
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92 ‑ Total Calc Lse Use ‑ On Lse

Volume determined at a well level, is the sum of the following lease-use volume dispositions:

VT 92 = VT 10: Lease Use Before PM ‑ On Lse + VT 11: Lease Use ‑1‑ On Lse

+ VT 12: Lease Use ‑2‑ On Lse + VT 13: Lease Use ‑3‑ On Lse

+ VT 14: Lease Use ‑4‑ On Lse + VT 15: Lease Use ‑5‑ On Lse

+ VT 79: Return Lease fuel own well completion

+ VT R1: Return Lease fuel 1 + VT R2: Return Lease fuel 2

+ VT R3: Return Lease fuel 3 + VT R4: Return Lease fuel 4

+ VT R5: Return Lease fuel 5

VOLUME CATEGORY: Actual PRA USES ‑ Production: No

SYSTEM GENERATED: Yes Revenue: Yes

PRODUCT SPECIFIC: No

PRODUCTION: This VT is a system-calculated volume.

93 ‑ Total Calc Lse Use ‑ Off Lse

Volume determined at a well level, is the sum of the following lease use volume dispositions:

VT 93 = VT 38: Lease Use ‑ Offlse + VT 54: GLG Sold to Off-lease

+ VT 71: Gas Inj Sold + VT 77: RLF Sold to

VOLUME CATEGORY: Actual PRA USES ‑ Production: No

SYSTEM GENERATED: Yes Revenue: Yes

PRODUCT SPECIFIC: No

PRODUCTION: This VT is a system-calculated volume.

94 ‑ Summed NGL Products

Calculated total volume of plant products (all NGLs) for a gas plant ‑and/or‑ for a lease.

VOLUME CATEGORY: Actual PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue: Yes

PRODUCT SPECIFIC: NGL

PRODUCTION: Used in gas plant allocations.
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95 ‑ Theoretical Residue

Theoretical volume of residue remaining for each well completion ‑and/or‑ for a gas plant after subtracting plant shrinkage, 
plant fuel, and plant vent/flare from adjusted plant inlet measured volumes.

VOLUME CATEGORY: Actual PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: Used in gas plant allocations.

96 – Unaccounted for

VOLUME CATEGORY: Actual

99 ‑ Total Sales

Sum of allocated sales dispositions at a well completion level.

VOLUME CATEGORY: Actual PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: No

PRODUCTION: This VT is a system-calculated volume, determined by adding all the volumes with a category of sales for a 
particular product.

A1 – Purchased Fuel   - Compression

A2 – Purchased Fuel - Dehydration

A3 – Purchased Fuel - Steam

A4 – Purchased Fuel – CO-Gen Steam

A5 – Purchased Fuel – CO – Gen Electric

A6 – Purchased Fuel - undistributed

CI ‑ Cumulative Injection (Wyoming)

Cumulative injection volume is at the well completion level for Wyoming wells only. This CI volume is the cumulative injec­
tion volume over the life of the well.

VOLUME CATEGORY: Other PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Yes (2xx, (5xx, 6xx)

PRODUCTION: VT is entered into PRA volume entry screens at the well completion level. It is not allocated and its only use 
is to report its volumes on regulatory reports for Wyoming (WYOMING‑Form 2).
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CM ‑ Commercial Disposal Facility (Co)

Water production volumes disposed at a commercial disposal facility (commercial means that the operator of the facility is 
paid for disposing water and other oil field products). The volume may contain a mixture of water and oil waste product, but 
it is identified as water.

VOLUME CATEGORY: Non‑sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Yes (5xx)

PRODUCTION: VT is entered into PRA volume entry screens at the well completion level. It is not allocated and its only use 
is to report its volumes on regulatory reports for Colorado Form 7.

CP – CO2 Purchased From Offset WC

CR – Condensate Reduction

VOLUME CATEGORY: Non-Sales

CS – CO2 Sold to Off-lease

CT ‑ Central Disposal Facility (Co)

Water production volumes disposed at a facility used for disposal of water. The facility is operated by one or more oil and 
gas operators in conjunction with a field operator’s agreement, approved by the commission. The volume may contain a 
mixture of water and oil waste product, but it is identified and considered as water.

VOLUME CATEGORY: Non‑sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Yes (5xx)

PRODUCTION: VT is entered into PRA volume entry screens at the well completion level. It is not allocated and its only use 
is to report its volumes on regulatory reports for Colorado Form 7.

F1 – Plant Fuel – Recovery

VOLUME CATEGORY: Fuel

F2 – Plant Fuel – Distillation

VOLUME CATEGORY: Fuel

F3 – Plant Fuel – Fractionation

VOLUME CATEGORY: Fuel

FC – Plant Fuel – Credit

VOLUME CATEGORY: Other

FG – Formation Gas
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FP - Fuel Produced in a Fuel System

Total volume of gas to be used to either return to lease for fuel use, flare, or other final dispositions in a fuel system delivery 
network.

VOLUME CATEGORY: Fuel PRA USES - Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: This volume type is used exclusively in fuel system delivery networks at produced fuel measurement points 
(type 72). This volume is allocated from produced fuel points through allocation/deduct meters to final dispositions in the 
fuel system. It can be entered on the normal gas volume entry screen in PRA or uploaded in the fuel system through a field 
data collection device interface.

FR - Fuel Purchased in a Fuel System

Volume of gas brought into the fuel system through an outside source, but is then commingled with produced fuel to use on 
leases as fuel, flare, or other dispositions.

VOLUME CATEGORY: Fuel PRA USES - Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: This volume type is used exclusively in fuel system delivery networks at purchased fuel measurement points 
(type 40). This volume is allocated from purchased fuel points through allocation/deduct meters to final dispositions in the 
fuel system. It is usually entered on the normal gas volume entry screen in PRA. Although in a fuel system, this volume type 
is considered a ‘disposition in the allocation, when the volume is transferred to the producing network after fuel system 
allocation, it would be considered a receipt.

FU - Fuel Usage in a Fuel System

Estimated volume of gas usage at final dispositions in a fuel system.

VOLUME CATEGORY: Production PRA USES - Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: This volume type is used exclusively in fuel system delivery networks. They can be entered for various 
measurement point types, but these MPs must be final dispositions (furthest upstream nodes) in the fuel system. Volume 
can be entered on-line as a ‘measured volume’ on the gas volume entry screen in PRA, or calculated using fuel use/
throughput specs and transactional hourly /throughput rates either on-line or in the volume allocation batch processes. 
The volume is used as the ‘theoretical volume’ at final dispositions for proration of allocated produced or purchased fuel.

GC – GCNM Extraneous Gas

VOLUME CATEGORY: Production

IJ – Monthly Injection Volume

VOLUME CATEGORY: Non-Sales
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IT – Intermitter

VOLUME CATEGORY: Non-Sales

LF – Total On-Lease Fuel – Rep. Well

L1 ‑ Load/Transfer Oil Sales

Volume of oil sold for the purpose of load oil or for tank to tank transfer.

VOLUME CATEGORY: Sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue -

PRODUCT SPECIFIC: Yes (1xx, 3xx) CA: No

VL, RD, JE: Yes

PRODUCTION: This VT is handled like other sales VTs in PRA. A difference is in the recording of these volumes. When an L1 
volume is recorded, the destination is also recorded. In the case of load oil, the destination well completion is indicated. In 
tank to tank transfers, the destination tank (measurement point) is indicated.

L2 ‑ Load/Transfer Oil Received

Volume of oil received as a result of a transfer for load oil or for a tank to tank transfer, or for a purchase from a third party.

VOLUME CATEGORY: Actual PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue -

PRODUCT SPECIFIC: Yes (1xx, 3xx) CA - No

VL, RD, JE: Yes

PRODUCTION: Volume of oil received at a tank (tank to tank transfer) or at a well completion (load oil). If a VT L1 is re­
corded, a VT L2 is automatically created / maintained by the system or a volume for a VT L2 can be manually entered for 
volumes purchased from a third party.

L3 ‑ Load/Transfer Oil Inventory

Volume of oil on hand resulting from a load oil movement or from a tank to tank transfer. It can represent part of the volume 
on hand with traditional inventory volumes (closing inventory ‑ liquids VT 04).

VOLUME CATEGORY: Other PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: Yes (1xx, 3xx)

PRODUCTION: Inventory of load/transfer oil on hand will only be present at a well completion level. This inventory will be 
increased or be created automatically with L2 volumes and will be reduced automatically by L4 and L5 volumes. The reduc­
tion of L3 inventory is restricted by the rule that load/transfer oil inventory cannot be disposed until it has been received. 
Therefore, no L4 or L5 volume can reduce L3 volume if the L1 or manually entered L2 run ticket date occurs after the L4 or 
L5 run ticket date.
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L4 ‑ Load/Transfer Oil Recovered

Sales volume of oil deemed to have been recovered against load oil or tank to tank transfer inventories VTs L3. This is con­
sidered a “sales” disposition. PRA always attributes sales to be a recovery of load/ transferred oil received/inventory prior 
to deeming it to be part of production. The rule stating that load/transferred oil inventory cannot be disposed until it has 
been received, restricts L4 volume from reducing L3 volume, if the L1 or manually entered L2 run ticket date creating the L3 
inventory occurs after the L4 run ticket date.

VOLUME CATEGORY: Actual PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue -

PRODUCT SPECIFIC: Yes (1xx, 3xx) CA, RD: No

VL, JE: Yes

PRODUCTION: Volume of load oil subsequently recovered, present only at a well completion level. VT L4 is system gener­
ated. The run ticket volume will contain a VT 03 sales ‑ 1 or VT 21 sales ‑ 2. Volume allocation will determine, if all or just part 
of the VT 03 or VT 21 should be VT L4.

L5 ‑ Transfer 100% Oil

Transfer of oil deemed to have been recovered against load oil or tank to tank transfer inventories VTs L3. L5 is a transfer 
just like VT L1, but PRA will attribute L5 to be a recovery of load/transferred oil received/inventory prior to deeming it to be 
part of production. The rule stating that load/transferred oil inventory cannot be disposed until it has been received, re­
stricts L5 volume from reducing L3 volume, if the L1 or manually entered L2 run ticket date creating the L3 inventory occurs 
after the L5 run ticket date.

VOLUME CATEGORY: Actual PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue -

PRODUCT SPECIFIC: Yes (1xx, 3xx) CA, RD: No

VL, JE: Yes

PRODUCTION: Volume of load oil subsequently recovered, present only at a well completion level. VT L5 is system gener­
ated. The run ticket volume will contain a VT L1 Load/Transfer Oil Sales. Volume allocation will determine, if all or just part 
of the VT L1 should be VT L5.

REVENUE: If this L5 oil is 100% company-owned oil and therefore no taxes or royalties will be paid on it.

NU – Non-unit Extraneous Gas

VOLUME CATEGORY: Production

OB ‑ Overboard (OGOR)

Water production volumes disposed OVERBOARD off an offshore production platform.

VOLUME CATEGORY: Non‑sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Yes (5xx)

PRODUCTION: VT is loaded into PRA through FDE or VD screens at the Well completion level. It is not allocated and its only 
use is to report its volumes on OGOR regulatory reports.
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OS – Onshore/Offshore (OGOR)

VOLUME CATEGORY: Production

PA ‑ Prchd GL Used As Sales

This gas volume was purchased and used in a gas lift system after it was reproduced, this VT indicates it was sold to a third 
party, to a plant, or to another lease.

VOLUME CATEGORY: Receipts PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue -

PRODUCT SPECIFIC: Gas (CA, VL, RD, JE): Yes

PRODUCTION: PRA should generate the volume for this VT based on delivery network configuration (determines whether 
GL system is rotative or non-rotative) and the fact the GL well did not supply all of its own GLG. This VT is handled like any 
other sales VT.

PC ‑ Prchd GL Used As Lease Use ‑ On Lse

This gas volume was purchased and used in a gas lift system and then this VT indicates it was used on the same lease that 
produced the product.

VOLUME CATEGORY: Receipts PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue -

PRODUCT SPECIFIC: Yes (2xx) CA, RD, JE, VL:

Yes

PRODUCTION: PRA should generate the volume for this VT based on delivery network configuration (determines whether 
GL system is rotative or non-rotative) and the fact the GL well did not supply all of its own GLG. This VT is handled like any 
other fuel VT.

REVENUE: Volume is valued.

PD – Purchased Lease Fuel - Dehydration

PE – Purchased Lease Fuel - Steam

PF – Purchased Lease Fuel – Co Gen Steam

PG – Purchased Lease Fuel – Co Gen Electric

PH – RLF – Purchased for Lease Fuel

PI – Inj. Purchased from Plant

VOLUME CATEGORY: Receipts

PJ – Exch. from Sales

PK – Exch. from for Lease Fuel
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PL – Exch. from for Lease Fuel – Compression

VOLUME CATEGORY: Receipts

PM – Exchange from Lease fuel - dehydration

PN – Exchange from for Return Lease Fuel

PO – Exch from for Lease Fuel - Steam

PP – Exch from for lease fuel – CO Gen.

PQ – Exch. from for Lease fuel – CO Gen. Elec.

PR – RLF purchased from Plant

VOLUME CATEGORY: Receipts

PS ‑ Prchd GL Used As Gas Lift Gas Loss

This gas volume was purchased and used in a gas lift system and this VT indicates the difference between the measured 
volume injected for gas lift exceeding the measured gas lift volume produced during a month of operations, limited to the 
portion that was purchased gas.

VOLUME CATEGORY: Receipts PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue -

PRODUCT SPECIFIC: Gas (CA, VL, RD, JE): Yes

PRODUCTION: This VT is system generated. First, the difference between calculated production and the total of gas lift gas 
received by a well is calculated as follows:

Gas Lift Loss (VT 60) = Gas Lift Gas Reproduced (VT 16) ‑ Calculated Production (VT 91)

When calculated production is less than gas received, a loss is calculated for VT 60 at the well. Next, the calculated VT 60 
attributed to VT 55 GLG purchased from off-lease will be recorded to VT PS at the well. This recording will reduce the actual 
volume recorded to VT 60.

PT – Purchased Vent / Flare

VOLUME CATEGORY: Receipts

PU – Purchased Gas for Lease Use

VOLUME CATEGORY: Other

PV – Exch from for Vent/Flare

VOLUME CATEGORY: Receipts
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PW - Produced Water

Volume type to record a total water production volume at a measurement point.

VOLUME CATEGORY: Non-Sales PRA USES - Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Yes (5xx (Water))

PRODUCTION: This volume type is used to capture a produced water volume at a MP so that the volume can be allocated 
upstream to well completions.

P1 – Returned Plant Fuel 1

VOLUME CATEGORY: Fuel

P2 – Returned Plant Fuel 2

VOLUME CATEGORY: Fuel

P3 – Purchased Returned Plant Fuel 1

VOLUME CATEGORY: Other

P4 – Purchased Returned Plant Fuel 2

VOLUME CATEGORY: Other

RA ‑ Rprd Extraneous Gas Sales

This gas volume was purchased and injected into a formation. This VT indicates it was sold to a third party, to a plant or to 
other leases. Note that this is not all reproduced injected gas that is sold, but only the volume that was purchased and in­
jected.

VOLUME CATEGORY: Sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue -

PRODUCT SPECIFIC: Gas CA, VL, JE: Yes

RD: No

PRODUCTION: A percentage of extraneous gas will be entered in PRA, either at the well or measurement point level. This 
percentage will be used to calculate the amount of sales volumes (VT 03 and 21) allocated to well completions, as VT RA.

RG - Reproduced Gas

Special volume type to record reproduced CO2.

VOLUME CATEGORY: Other PRA USES - Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: This volume type is used to record reproduced CO2 gas in volume allocation. It does not count against cal­
culated production.
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RR – Residue Received (Chained Nwk.)

VOLUME CATEGORY: Fuel

RS – Residue Supplied (Chained Nwk.)

VOLUME CATEGORY: Fuel

R1 - RLF Received 1

Volume of gas returned to lease for fuel / flare disposition.

VOLUME CATEGORY: Fuel PRA USES - Production: Yes

SYSTEM GENERATED: No Revenue: Yes

PRODUCT SPECIFIC: Gas

PRODUCTION: This volume type is used exclusively in return lease fuel allocations. The volumes are entered at measure­
ment points designated as RLF usage points. These volumes will be the returned lease fuel receipt volumes that are sum­
med to the RLF supply point during proration of total production to well completions (VAB3050/PAB3050). They are es­
tablished along with the other RLF received volume types (R2-R5, 74) in that they allow for allocation of RLF in the same 
delivery network on different dependencies. The volume can be entered as a measured volume on the gas volume entry 
screen in PRA, calculated from hourly/throughput rates, uploaded, or be calculated from allocated fuel usage volumes in a 
fuel system delivery network.

R2 - RLF Received 2

Volume of gas returned to lease for fuel/flare disposition.

VOLUME CATEGORY: Fuel PRA USES - Production: Yes

SYSTEM GENERATED: No Revenue: Yes

PRODUCT SPECIFIC: Gas

PRODUCTION: This volume type is used exclusively in return lease fuel allocations. The volumes are entered at measure­
ment points designated as RLF usage points. These volumes will be the returned lease fuel receipt volumes that are sum­
med to the RLF supply point during proration of total production to well completions (VAB3050/PAB3050). They are es­
tablished along with the other RLF received volume types (R1, R3-R5, 74) in that they allow for allocation of RLF in the same 
delivery network on different dependencies. The volume can be entered as a measured volume in the gas volume entry 
transaction in PRA, calculated from hourly/throughput rates, uploaded, or be calculated from allocated fuel usage volumes 
in a fuel system delivery network.
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R3 - RLF Received 3

Volume of gas returned to lease for fuel/flare disposition.

VOLUME CATEGORY: Fuel PRA USES - Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: This volume type is used exclusively in return lease fuel allocations. The volumes are entered at measure­
ment points designated as RLF usage points. These volumes will be the returned lease fuel receipt volumes that are sum­
med to the RLF supply point during proration of total production to well completions (VAB3050/PAB3050). They are es­
tablished along with the other RLF received volume types (R1, R2, R4, R5, 74), in that they allow for allocation of RLF in the 
same delivery network on different dependencies. The volume can be entered as a measured volume on the gas volume 
entry screen in PRA, calculated from hourly/throughput rates, uploaded, or be calculated from allocated fuel usage vol­
umes in a fuel system delivery network.

R4 - RLF Received 4

Volume of gas returned to lease for fuel/flare disposition.

VOLUME CATEGORY: Fuel PRA USES - Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: This volume type is used exclusively in return lease fuel allocations. The volumes are entered at measure­
ment points designated as RLF usage points. These volumes will be the returned lease fuel receipt volumes that are sum­
med to the RLF supply point during proration of total production to well completions (VAB3050/PAB3050). They are es­
tablished along with the other RLF received volume types (R1-R3, R5, 74) in that they allow for allocation of RLF in the same 
delivery network on different dependencies. The volume can be entered as a measured volume on the gas volume entry 
screen in PRA, calculated from hourly/throughput rates, uploaded, or be calculated from allocated fuel usage volumes in a 
fuel system delivery network.

R5 - RLF Received 5

Volume of gas returned to lease for fuel/flare disposition.

VOLUME CATEGORY: Fuel PRA USES - Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Gas

PRODUCTION: This volume type is used exclusively in return lease fuel allocations. The volumes are entered at measure­
ment points designated as RLF usage points. These volumes will be the returned lease fuel receipt volumes that are sum­
med to the RLF supply point during proration of total production to well completions (VAB3050/PAB3050). They are es­
tablished along with the other RLF received volume types (R1-R4, 74) in that they allow for allocation of RLF in the same 
delivery network on different dependencies. The volume can be entered as a measured volume on the gas volume entry 
screen in PRA, calculated from hourly/throughput rates, uploaded, or be calculated from allocated fuel usage volumes in a 
fuel system delivery network.
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SA ‑ Sold GL Used As Sales

This gas volume was sold and used in a gas lift system. This VT indicates after it was used for gas lift, it was sold to a third 
party, to a plant, or to other leases. This VT is recorded against the well that produced the gas, not the well that received the 
gas, and used it in its gas lift operations.

VOLUME CATEGORY: Sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue -

PRODUCT SPECIFIC: Gas (CA, VL, RD, JE): Yes

PRODUCTION: PRA should generate the volume for this VT based on delivery network configuration (determines whether 
GL system is rotative or non‑rotative) and the fact the GL well did not supply all of its own GLG. This VT is handled like any 
other sales VT.

SB – Sale for Lease Fuel

SC ‑ Sold GL Used As Lease Use ‑ On Lse

This gas volume was sold and used in a gas lift system. This VT indicates after it was used for gas lift, the gas was then used 
as lease use gas on the same well that used the gas for gas lift. This VT is recorded against the well that produced the gas, 
and not the well that received the gas and used it in its gas lift operations.

VOLUME CATEGORY: Sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue -

PRODUCT SPECIFIC: Yes (2xx) CA, RD, JE: No

VL: Yes

PRODUCTION: PRA should generate the volume for this VT based on delivery network configuration (determines whether a 
GL system is rotative or non‑rotative) and the fact the GL well did not supply all of its own GLG. This VT is handled like any 
other fuel VT and is included in VT 93 ‑ total calculated lease use ‑ off lease.

REVENUE: Volume is valued.

SD – Sale for Lease Fuel -   Dehydration

SE – Sale for Lease Fuel – Steam

SF – Sale for Lease Fuel – CO-Gen Steam

SG – Sale for Lease Fuel – CO-Gen Electric

SH – Sale for Return lease Fuel

SI – Sale for Lease Fuel – Compression

VOLUME CATEGORY: Sales

SJ – Exch To For Sales

SK – Exch To For Lease Fuel
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SL – Exch. To For Lease Fuel – Compression

VOLUME CATEGORY: Sales

SM - Exch. To For Lease Fuel – Dehydration

SN - Exch. To For Return Lease Fuel

SO – Exch. To For Lease Fuel – Steam

SQ - Exch. To For Lease Fuel – CO-Gen Electric

SS ‑ Sold GL Used As Gas Lift Gas Loss

This gas volume was sold and used in a gas lift system. This VT indicates the difference between the measured volume 
supplied for gas lift and the calculated production (VT 91) during a month of operations, limited to the volume supplied (VT 
54). This VT is recorded against the well that produced the gas, not the well that received the gas.

VOLUME CATEGORY: Sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: Yes Revenue -

PRODUCT SPECIFIC: Gas CA, VL, RD, JE: No

PRODUCTION: This VT is system-generated. First, the difference between calculated production and the total of gas lift gas 
received by a well is calculated as follows:

Gas Lift Loss (VT60) = Gas Lift Gas Reproduced (VT16) ‑ Calculated Production (VT 91)

When calculated production is less than gas received, a loss is calculated for VT 60 at the well. Next the calculated VT 60 
attributed to VT 55 GLG purchased from off-lease will be recorded to VT PS at the well. The offset or VT 54 GLG sold to off-
lease will be used to determine the volume recorded to VT SS for the well supplying the gas.

ST – Sale for Vent / Flare

VOLUME CATEGORY: Sales

SV – Sale To for Vent / Flare

VOLUME CATEGORY: Sales

T1 – Uncorrected Run Volume

VOLUME CATEGORY: Production

T2 – Uncorrected Production Volume

VOLUME CATEGORY: Production
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T3 ‑ Irrigation Gas Sales

Volume of gas sold to a farmer for the purpose of running irrigation equipment in the fields. It receives special tax breaks.

VOLUME CATEGORY: Sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue -

PRODUCT SPECIFIC: Yes (2xx) CA: No

VL, RD, JE: Yes

PRODUCTION: Handled like any other sales VT in PRA production. There are special reporting requirements in tax reports, 
and special handling in PRA revenue.

T4 – Theoretical Exchanged to On-Lease

VOLUME CATEGORY: Other

T5 – Theoretical Exchanged to Off-Lease

VOLUME CATEGORY: Other

TC – Theoretical Condensate

VOLUME CATEGORY: Other

TO – Trucked Off

VOLUME CATEGORY:Non-Sales

VR – Measured VRU Production

VOLUME CATEGORY: Production

WC -Water Chain

Water production from oil and gas producing wells in a water chain delivery network.

VOLUME CATEGORY: Non-Sales PRA USES - Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: Water

PRODUCTION: This volume type is generated at a water chain measurement point in a water chain network. The equation it 
uses is: WC = (WI+WD) - WS; where WI is water injected, WD is water disposed, and WS is water supplied. The resulting 
volume is allocated to contributing oil and gas producing wells.
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WD - Water Disposed into a Formation

Water disposed in a water chain delivery network.

VOLUME CATEGORY: Receipt PRA USES - Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Water

PRODUCTION: This volume type is used to denote water injected into disposal wells in a water chain network. Volume is 
either designated at the well completion or entered at the appropriate measurement point.

WI -Water Injected

Water injected into an injection/cyclic well.

VOLUME CATEGORY: Non-sales PRA USES - Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Water

PRODUCTION: This volume type is used to denote water injected into injection wells. Volume is either designated at the 
well completion, or entered at the appropriate measurement point.

WP ‑ Water Pit

Water production volumes disposed in a retaining pit.

VOLUME CATEGORY: Non‑sales PRA USES ‑ Production: Yes

SYSTEM GENERATED: No Revenue: No

PRODUCT SPECIFIC: Yes (5xx)

PRODUCTION: VT is loaded into PRA through the VD screens at the well completion level. It is not allocated, but it can be 
used to report its volumes on OGOR regulatory reports or for other water production dispositions (if water disposed in a 
pit).

WS -Supplied Water

Water from supply or service wells in a water chain delivery network.

VOLUME CATEGORY: Non-Sales PRA USES - Production: Yes

SYSTEM GENERATED: Yes Revenue: No

PRODUCT SPECIFIC: Water

PRODUCTION: This volume type is used to denote water produced from supply or service wells in a water chain network. 
Volume is either designated at the well completion, or entered at the appropriate measurement point.

XS – Excess Scrubber Oil

VOLUME CATEGORY: Production

1C – Compression Fuel – 1st Stage

2C – Compression Fuel – 2nd Stage
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3C – Compression Fuel – 3rd Stage

4.3.3  Creating a Delivery Network Allocation Profile 

Use

This transaction defines the allocation rules for a particular delivery network. The allocation rules established in 
this transaction directly affect how the volume allocation cycle processes allocations for the delivery network 
specified in this transaction.

Allocation rules include details about:

The product to be allocated (note that you allocate one product per network, as a rule).

The volume type to be allocated (see: Volume Categories and Volume Types [page 136] ).

The order in which the products and volume types are to be allocated

Prerequisites

When determining how to structure the order in which the products and volume types are to be allocated, 
allocate the dispositions as they occur from the most upstream node (wells) to the most downstream node 
(generally, a sales point).

Procedure

From the SAP Easy Access menu, choose Production and Revenue Accounting   → Production   → Allocation 
Rules   →   DN Allocation Profile   →   Create

The Create DN Allocation Profile: Initial Screen is displayed.

Enter the delivery network and the relevant Effective from date, and define the allocation frequency. Then 
choose Enter .

The Create Delivery Network Allocation Profile <delivery network number> Effective <date>: Overview screen is 
displayed.

Enter the following data:

Sequence

The number entered in the Sequence field designates the sequence in which materials will be allocated.
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Material

Volume Type (for details on each volume category and volume type, see: Volume Categories and Volume Types 
[page 136] ).

If you want a full product allocation, then leave the Volume Type field blank.

Set the following indicators as required:

Table 35:

If you want to: Then:

Have auto flow turned on. Auto flow is on for a given volume 
type and product code combination handled by the network.

Select Auto Flow

Note: If Auto Flow is not selected, then thevolume type must 
be defined using the Measurement Point Allocation Profile 
transaction for every volume type and product code combi­
nation that applies to a particular upstream measurement 
point.

Add all the daily allocated volumes of a well completion's 
specified product and volume type, and then use as the 
month-end product and volume type for all well completions 
in the delivery network.

Select Sum Dly

Specify that volumes will be allocated in the gas plant vol­
ume allocation.

Select Allocate Mat/VT

Enter the following data:

Dependent material

Dependent materials must have a smaller sequence number than the primary material. The dependent 
material is allocated only after product on which it is dependent has been allocated.

Dependent volume type

The dependent volume type is allocated only after the volume type on which it is dependent has been 
allocated.

Calculated volume type

The calculated volume type is the volume type associated with the calculation of production at all well 
completions with the delivery network.

Save the delivery network allocation profile.
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Using a Reference for a Delivery Network Allocation Profile

If a delivery network allocation profile record already exists with data similar to that of the new delivery network 
allocation profile you are creating, you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter data for the existing delivery network allocation 
profile in the reference section of the initial screen for the new delivery network allocation profile.

4.3.4  Creating a Measurement Point Allocation Profile 

Use

This transaction defines allocation rules for a given measurement point within a delivery network.

The allocation rules determine:

● The products and volume types of all volumes to be captured at the measurement point
● The method used to capture the volume

Procedure

At the SAP Easy Access screen, choose Logistics  Production and Revenue Accounting Production 
Allocation Rules  MP Allocation Profile  Create.

The Create Measurement Point Allocation Profile: Initial Screen is displayed.

1. Enter data as required and select the allocation frequency.Then choose Enter .
The Create Measurement Point Allocation Profile: Overview Screen is displayed.

2. Verify the Effective To date, and enter data as required.
3. Save the measurement point allocation profile.

Using a Reference for a Measurement Point Allocation Profile

If a measurement point allocation profile record already exists with data similar to that of the new 
measurement point allocation profile you are creating, you can copy data from the existing record into the new 
record.

To copy data from the existing record into the new record, enter the data for the existing measurement point 
allocation profile in the reference section of the initial screen for the new measurement point allocation profile.
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4.3.5  Creating a WC / DN Theoretical Calculation Method 

Use

The Well Completion / Delivery Network Theoretical Calculation Method transaction establishes the method by 
which the volume allocation cycle determines the theoretical, or estimated, production at a well completion. 
The method is based on the combination of a major product and allocation frequency. The theoretical 
production, therefore, may vary according to:

The product being allocated

The allocation frequency, either monthly or daily

A theoretical calculation method at the well completion level overrides any theoretical calculation method at 
the corresponding delivery network level.

You can also specify an End Date to this theoretical calculation method specified at the well completition (WC) 
level.

Procedure

At the SAP Easy Access screen, choose Logistics   →   Production and Revenue Accounting   →   Production   →   
Allocation Rules   →   DN/WC Theo Calc Meth   →   Create

The Create <Delivery Network or Well Completion> Theoretical Calculation Method: Initial Screen is displayed.

Enter data as required and choose Enter to continue.

The Create <Delivery Network or Well Completion> Theoretical Calculation Methods: Overview Screen is 
displayed.

At the Create <WC or DN> Theoretical Calculation Method: Overview screen, enter data as required.

Save the theoretical calculation method.

Using a Reference for a Theoretical Calculation Method

If a theoretical calculation method record already exists with data similar to that of the new theoretical 
calculation method you are creating, you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter data for the existing theoretical calculation 
method in the reference section of the initial screen for the new theoretical calculation method.
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4.3.6  Creating Formula Rules 

Use

This transaction establishes a formula that is used for the calculation of product disposition at the specified 
measurement points.

A formula can include constants and measurement points.When measurement points are included in a 
formula, the volume at the measurement point is retrieved and used in the formula calculation.

Procedure

1. At the SAP Easy Access menu, choose Logistics  Production and Revenue Accounting  Production 
Allocation Rules  Formula Maintenance  Create  .
The Create Formula Rules: Initial Screen appears.

2. Enter a name for the formula to be created(you can use an alphanumeric name). Then enter the following 
data:
Effective from
Choose Enter .
The Create Formula Rules - Formula <formula name>: Overview screen is displayed.

3. In the second field of the Formula row, enter a description for the formula.Then enter other data as 
required.

4. Save the formula.

Using a Reference for Formula Rules

If a formula maintenance record already exists with data similar to that of the new formula(s) you are creating, 
you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter the number of the existing formula 
maintenance record in the reference section of the initial screen for the new formula(s).

4.3.7  Using Component Typification

Use

Component typification determines the level of measurement to be used in chemical analysis (see: Creating a 
Chemical Analysis Record [page 181] ), and is used only for the component allocations of gas plants (NGLs). 
One required entry for chemical analysis for gas plants (which lets you see what components are going into a 
gas plant at a more detailed level than is usually the case), is the component typification. The typification sets a 
threshold limit for analysis, for example, C5+, C6+, C7+, etc. This sets the level for the chemical analysis – you 
are in effect telling the system, beyond that specified level, I am not interested in the component breakdown.

Component typification allows a chemical analysis of a liquid or gas stream to be characterized to a specific 
typification level. It identifies the compound percentages within each of the heavier components of a gas or 
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liquid stream. Those percentages are obtained from extended component analysis performed on the gas or 
liquid stream. They are maintained in a typification table in PRA. The typification table permits the storage and 
maintenance of multiple component typifications. Each component typification is identified with a typification 
ID. The typification ID is a required entry for each chemical analysis established in PRA.

When determining the ratios for C6 and heavier components, the system uses those percentages associated 
with the typification ID chosen for the chemical analysis, along with data from TP-17 to calculate a weighted 
average value for the compound.

This is analogous to a well test, but here, it is used with a gas plant, and is used to determine the threshold for 
what you will view, in terms of components.

Procedure

1. At the SAP Easy Access Menu, choose Logistics → Production and Revenue Accounting → Production → 
Allocation Rules → Component Typification → Create .
The Create Component Typification: Initial Screen is displayed.

2. In the Typification field, enter a value that you would like to use as the typification value. The value can be 
any increment in the range from C5+ to C10+. Also enter an effective date.

3. Choose Enter .
4. The Create Component Typification: Overview screen is displayed. On this screen, you can enter values that 

were received from a laboratory on the components for the relevant gas plant.
5. Save your record.

4.3.8  Creating Plant Allocation Methods 

Use

Plant allocation methods are used to specify how residue and NGL (natural gas liquid) dispositions are 
allocated back to the furthest upstream nodes in a gas plant network (wells or measurement points). Use this 
to create plant allocation methods of that type.

Plant allocation methods for a given delivery network can be set up using casinghead, straddle, processing 
agreement, processing agreement with take in kind, NGL purchase, or wet gas purchase type contracts.

Plant allocation methods (PAMs) are established at a contract/product code combination level. PAMs attached 
to a given contract/product code combination are related in turn to specific measurement points through the 
contract/measurement point cross-references. The plant allocation application connects all PAMs tied to a 
measurement point upstream to all well completions or measurement points supporting the product code. At a 
furthest upstream node, one and only one plant allocation method must exist for each residue and NGL plant 
disposition that is to be allocated. For each major product code that is to be allocated to a furthest upstream 
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node, a valuation cross reference must also exist either at the furthest upstream node or downstream of the 
furthest node.

There are six standard plant allocation methods :

Table 36:

CMPMOL% - Component Mole Percent CMPMOL% can be used for residue or NGLs, and it is only 
valid for allocating dispositions on the component 
level.When CMPMOL% is specified, adjusted theoretical vol­
umes are created at the furthest upstream nodes for each 
component in the network.Each furthest upstream node's 
adjusted theoretical serves as a 'cap' for the amount of the 
specific component that can be allocated to that node.

COMPGPM – Component GPM COMPGPM should only be used for NGLs, and it is only valid 
for allocating dispositions on the component level.When 
COMPGPM is specified, each NGL component disposition is 
allocated based on the gallons per MCF of the corresponding 
gas disposition that was specified as the dependent product 
code/volume type.The user must specify a dependency 
when allocating on COMPGPM, and must also be aware that 
there is no GPM for Methane (C 1 ).

C1C2TRA – Methane/ethane reduction C1C2TRA should only be used for residue, and it is valid for 
allocating dispositions at either the product or component 
level.When C1C2TRA is specified, each residue disposition is 
allocated based on a theoretical volume at each furthest up­
stream node.That theoretical volume is calculated as the 
sum of the methane and ethane (C1 and C2) of the plant in­
let volume, minus the MCF equivalent of the methane and 
ethane in the NGL production volumes.

SUB1TRA – Subtraction method SUB1TRA should only be used for residue, and it is valid for 
allocating dispositions on the component or product 
level.When SUB1TRA is used to allocate component residue 
dispositions, the results will be the same as if CMPMOL% 
was used.When SUB1TRA is specified, each furthest up­
stream node's adjusted theoretical serves as the 'cap' for 
the amount of the specific component that can be allocated 
to that node.When no dependency is specified for allocating 
a given product code/volume type, the dispositions for the 
specific product code/volume type are allocated based on 
the remaining theoretical volume at each furthest upstream 
node.When a dependency is specified for a product code/
volume type, each disposition for the specific product code/
volume type is allocated based on the corresponding allo­
cated disposition of the dependent product code/volume 
type.
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TOTLMCF – Total MCF TOTLMCF can be used for both NGLs and residue, and it is 
valid for allocating dispositions at either the product or com­
ponent level.When TOTLMCF is specified, each plant disposi­
tion is allocated based on the total allocated MCF of the de­
pendent product code/volume type.

TOTMOLE – Total Moles TOTMOLE may be used for residue and NGLs, and it is only 
valid for allocating dispositions at the component level.TOT­
MOLE cannot be used if any other plant allocation methods 
are being used in the network.When TOTMOLE is specified, 
adjusted theoretical mole volumes are created at the fur­
thest upstream nodes for each component in the net­
work.Each furthest upstream node's adjusted theoretical 
serves as a 'cap' for the amount of the specific component 
that can be allocated to that node.Adjusted theoreticals for 
TOTMOLE include any liquid volumes that are entering the 
plant, whereas all other adjustment methods only include 
gas volumes entering the plant.

If you want to use a method other than these six standard methods, you can create your own plant allocation 
method. The user-defined plant allocation methods consist of the designation of the user of mole percentage, 
volume percentage, or gpm in the determination of a product or component theoretical.

These methods can be used for residue or NGLs (natural gas liquids), and are valid for allocating dispositions at 
the component or product level.

Prerequisites

The contract has to be a valid gas plant contract (being one of the following: processing agreement with TIK 
rights, straddle third party agreement, or casinghead purchase)

Procedure

1. At the SAP Easy Access Menu, Choose Logistics → Production and Revenue Accounting → Production → 
Allocation Rules → Plant Allocation Method → Create .
The Create Plant Allocation Methods: Initial Screen is displayed.

2. Enter a contract and an effective from date.
3. Choose Enter .

The Overview screen is now displayed.
4. Enter the material(s) and select an allocation method for each material.
5. Select SAVE.
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4.4 Production Daily Transactions 

Purpose

Daily transactions processing in Production is used to create records for:

● Chemical analysis – allowing you to create records that detail the chemical analysis of the product flowing 
through a measurement point.

● Well completion downtime summary – which details why a well is “down”
● Well test record – a record detailing the results of a well test
● Well completion volumes
● Measurement point volumes
● Well completion / measurement point observed readings

4.4.1  Creating a Chemical Analysis Record 

Use

Use this to create a chemical analysis record for specific measurement points within a gas plant delivery 
network.

Chemical analysis (also referred to as “component chromatography”) describes the process of analyzing the 
makeup of a liquid or gas stream, primarily as input into component allocations. It is used to break a product 
down into more detailed components, and is primarily used in support of product pricing.

From a gas network, a gas sample can be taken, and sent to a lab for analysis. This is known as “chemical 
analysis” in PRA. The first step before that analysis takes place is, the water is condensed out of the gas (in a 
natural, unprocessed state, water molecules are attached to the gas molecules, and have to be first removed). 
Then, chemical analysis takes place, resulting in a “water-free” chemical analysis. The system uses industry-
standard calculations to calculate “water-free” production volumes. Those production volumes are only used in 
the calculation of a theoretical used as a basis of allocation.

Much of the gas produced from a reservoir contains water molecules that are attached to the gas molecules. 
The volume of water in this gas is directly related to the flowing pressure and flowing temperature of the gas. If 
this gas is measured prior to processing through a glycol unit, dehydrator or gas plant, the measured volume 
includes these water vapors. When a gas sample is taken for analysis purposes, the water is condensed out of 
the sample before the component chromatography (chemical) analysis is performed. Thus, the gas analysis is 
"water free" and the measured gas volume is "water saturated". If we apply the "water saturated" production 
volume to a "water free" chemical analysis to determine a "theoretical", this theoretical would be overstated 
due to the water vapors. The system allows for the designation of a delivery network to be allocated on a water-
saturated basis or on a water-free basis. When the delivery network is specified as saturated the plant 
allocation cycle will use the "water-saturated" production volumes to determine the theoreticals.

When the delivery network is specified as “dry“, the plant allocation cycle will calculate a "water- free" 
production volume for all “water-saturated” gas volumes that exists at measurement points specified as 
saturated. The system uses industry standard calculations to calculate “water-free” production volumes. The 
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flowing pressure (PSIA), flowing temperature of the gas, and data from the water properties at saturation 
pressure table are factors included in these calculations. Once “water-free” production volumes are calculated, 
Plant Allocations will use them to determine node theoreticals. It is important to understand that this "water 
free" production volume is only used in the calculation of a theoretical used as a basis of allocation. This should 
not be confused with the "saturated" and "dry" values of the BTU Type designated on the Measurement Point 
volumes.

- Chemical analysis data is captured at the measurement point level.

- A single analysis measurement can be assigned to multiple measurement points.

- Chemical analysis allows for the detailed description of the components of a gas or liquid product.

Once the data is captured, the chemical analysis information can be used to govern how product-level volumes 
are split into component volumes.

MOL % or Volume %

Table 37:

For a liquid analysis – you must specify whether the calculated chemical analysis will be carried out in MOL % or volume %.

For gas analysis – only MOL % can be used.

Gas and liquid chemical analyses are contrasted by the type of data and ratios required for each on the 
subsequent component and properties screen.

Table 38:

For gas chemical analysis – the MOL % and GPM (gallons per MCF) data is maintained for each component.

For liquid chemical analysis – the MOL %, VOL % and weight % are maintained for each component.

The system also supports the capture of additional gas chemical analysis properties such as the saturated and 
dry data for gross heating value, specific gravity, and molecular weight. For the liquid chemical analysis 
properties, the gross heating value of the liquid (as a gas) is maintained in the same manner as it is for gas. 
Other data for the liquid properties include specific gravity, molecular weight, API gravity, the ratio of cubic feet 
of gas per 1 gallon of liquid, pounds per gallon, true vapor pressure, and gasoline data. This chemical analysis 
information is defined to be only effective over a specified date range, allowing the characteristics to change, 
while still retaining a view at any date in time.

This allows data to be saved on what is flowing through a measurement point – at a very specific level of 
chemical breakdown analysis. This supports pricing. Component typification determines the level of 
measurement to be used in chemical analysis (see: Using Component Typification [page 177] ).

A full gas plant is a plant that extracts liquefiable hydrocarbons or sulfur from natural gas. The Production and 
Revenue application components of PRA help upstream companies manage the complex allocation of physical 
and contractual volumes to plants and lease owners based on user-defined methods for both residue and 
natural gas liquids (NGLs).

The system also provides chemical analysis functionality to enable component allocation and multiple pricing 
capabilities. The complex allocation of physical volumes, such as wet gas measured volumes, and contractual 
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volumes, such as NGL and/or residue sales volumes to plant and lease owners can occur at the full product 
stream and/or product component stream levels.

In order for allocations to occur at a product component stream level, lab chemical analyses are carried out at 
various measurement points throughout a gas plant delivery system, and they are entered in the system.

The lab chemical analyses fall under two types:

- Gas analysis

- Liquid analysis

Gas analyses are set up at those measurement points where gas volumes are found, and liquid analyses are set 
up at those measurement points where NGL (natural gas liquid) volumes are found. In each case, the chemical 
analysis represents the chemical breakdown of the product flowing through those measurement points.

Chemical analysis compatibility

Table 39:

To ensure that compatible analyses exist throughout a gas plant delivery system, a user-defined chemical analysis compati­
bility is assigned to gas plant delivery systems. Chemical analyses can be summarized into several levels, most notably 
C6+, C7+, and C10.

If a gas delivery system is assigned a compatibility of C6+, the system will not permit the entry of a C7+ 
analysis at a measurement point within that gas plant delivery system.

Prerequisites

Only those measurement points that have multiple chemical analysis assigned for the processing period can 
have chemical analysis generated. In addition, a measurement point must also have chemical analysis set, 
before this process can be carried out for a measurement point. You can reference an already-existing 
measurement point in order to use its characteristics for this process.

Procedure

1. From the SAP Easy Access Menu, choose Logistics Production and Revenue Accounting à Production à Daily 
Transactions Chemical Analysis Create .

The Create Chemical Analysis: Initial Screen is displayed.

2. Select a measurement point and effective dates for the analysis. You can also select a referencing 
measurement point. Select a typification level (which is a product type and sets the general range of what you 
want to analyze). Choose either gas or liquid as the analysis type (gases are measured in mole, liquid is 
measured in volume, generally).
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3. Choose Enter .

The Create Chemical Analysis: Overview screen is displayed.

Within the Chemical Analysis Details screen tab, enter the relevant chemical analysis details (the laboratory 
where the analysis was carried out, sample pressure, sample temperature, etc.).

On the Components screen tab, enter the relevant component percentages.

On the Properties screen tab, enter the relevant data.

Choose SAVE.

Result

A chemical analysis record is created for the measurement point.

4.4.2  Creating a Well Completion Downtime Summary 

Use

This transaction captures data that records the period of downtime for a well completion (the downtime is the 
period in which the well completion is not producing).Downtime for a well completion may be recorded for a 
specific number of hours, or indefinitely.The reason for downtime must be specified.

Procedure

1. At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Production 
Daily Transactions  WC Downtime  Create  .
The Create WC Downtime Summary: Initial Screen is displayed.

2. Determine which of the following options to choose.

Table 40:

If you would like to: Then:

Enter downtime for a specific number of hours. Choose Hour-Hour , enter data as required and choose 
Enter .

Enter downtime for an indefinite period. Enter data as required and choose Enter .

The Create Well Completion Downtime <Hour/Hour or Summary>: Overview screen is displayed.

3. Specify an ending condition for the well completion.
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Table 41:

If you would like to: Then:

Specify that at the end of the day, identified as the effec-
tive from date, downtime was no longer a condition at the 
well completion.

Choose Up

Specify that at the end of the day, identified as the effec-
tive from date, downtime was still continuing at the well 
completion.

Choose Down .Then enter the number of hours of down­
time on the effective from date.

Note
Choosing Down records downtime for the well completion as continuous through the effective to date.

4. Enter the downtime reason.
5. Save the downtime record.

Using a Reference for a Well Completion Downtime Summary

If a well completion downtime record already exists with data similar to that of the new well completion 
downtime record you are creating, you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter the number of the existing well completion 
downtime record in the reference section of the initial screen for the new well completion downtime record.

4.4.3  Creating a Well Test Record 

Use

Use this to enter well test details for a well completion or a well completion stream.

The well test helps to determine the estimated volume of various products hydrocarbon and other materiasl 
within the well completion during the given testing period. You can use this, for example, in situations in which 
you do not know what a specific well contains, and you want to know precisely what is in the well or formation. 
For example, it might be that you think a well is producing mostly oil, but in reality, the well formation contains 
large amounts of salt water (brine). You can run a well test on the well formation, to determine the specific 
contents of the well.

This also provides you with a better financial picture of what your well is producing, which is critical in terms of 
production financial data.

You can test the following:

● Oil, gas, and water content in barrels
● Heating value
● Flow line pressure
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You can test per well completion.

In addition to recording volume information, this transaction is also used to record information such as ratios, 
temperatures, and pressures.

You can customize this to:

Add fields needed to capture well test data

Alter calculations that compute the ratios

Well test data is used for processing prior period volume allocations.

Procedure

At the SAP Easy Access screen, choose Logistics   →   Production and Revenue Accounting   → Production   →    
Daily Transactions   →   Well Test   →   Create

The Create Well Test: Initial Screen appears.

Enter the following data:

Well Completion

Well test data can be entered only for well completions that are downhole commingled parents. Well test data in 
a parent record applies to all associated children records.

Test Date

The combination of the test date and time must be unique. If there are multiple tests for a single date, the 
theoretical processes for volume allocation use the latest test for a given date.

Multi Strm Type

The batch process determines the multiple stream type.

Test Type

Choose Enter .

The Create Well Test: Overview screen is displayed.

At the Production Volumes tab, enter the values of the well test as required, and choose Edits / Calculations to 
refresh the screen with the values. Then choose the Ratios tab.

Review the ratios, and then choose the Well Test Parameters tab.

Enter the values of the well test parameters.
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To review details about the well completion, such as well class or producing method, choose Well Completion 
Details .

Save the well test.

Using a Reference for a Well Test

If a well test record already exists with data similar to that of the new well test you are creating, you can copy 
data from the existing record into the new record.

To copy data from the existing record into the new record, enter data for the existing well test in the reference 
section of the initial screen for the new well test.

4.4.4  Creating Well Completion Volumes 

Use

Use this transaction to capture volumetric information at a well completion level for either daily or month end 
volumes.

Procedure

1. At the SAP Easy Access menu, choose Logistics Production and Revenue Accounting   Production 
Daily Transactions WC Volumes Create  .
The Create Well Completion Volumes: Initial Screen is displayed.

2. Enter data as required.Then select the allocation frequency and choose Enter .
The Create Well Completion Volumes: Detail Screen is displayed.

3. Enter data as required for the reading(s).Then if you need to access header information choose Header , or 
to calculate standard volumes, choose Edits/Calculations .

4. Save the well completion volumes.

Using a Reference for Well Completion Volumes

If a well completion volumes record already exists with data similar to that of the new well completion volumes 
record you are creating, you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter the number of the existing well completion 
volumes record in the reference section of the initial screen for the new well completion volumes record.
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4.4.5  Creating Measurement Point Volumes 

Use

This transaction captures volumetric information at a measurement point level for either daily or month-end 
volumes.The measurement point volumes are allocated to all well completions that are upstream of the 
measurement point in a given delivery network structure.All measurement point volumes, regardless of 
product, are entered in this transaction.

Each type of volume (that is, Liquid, Gas, and NGL) captured at observed conditions is then converted to 
standard volumes at user-defined standard conditions.Based on the optional specifications that have been 
created for a measurement point (such as Fuel Specification, Tank Specification, Meter Specification), this 
transaction can also allow the entry of field readings to compute an observed volume.

Procedure

1. At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Production 
Daily Transactions MP Volumes Create  .
The Create Measurement Point Volumes: Initial Screen is displayed.

2. Enter data as required, then choose Enter .
The Create Measurement Point Volumes Detail Screen is displayed.

3. Select the allocation frequency and choose Enter .
4. Enter the value of the reading.
5. If you need to access header information, choose Header.

Note
Header information can be useful when retrieving the measurement point volume record at a later date, 
because the header information contains the document number.

6. If you would like to review the calculations before saving, choose Edits/Calculations .
7. Save the measurement point volumes.

Using a Reference for a Measurement Point Volumes

If a measurement point volume record already exists with data similar to that of the new measurement point 
volume you are creating, you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter the document number of the existing 
measurement point volume in the reference section of the initial screen for the new measurement point 
volume.

4.4.6  Using Mass Data Entry to Enter MP Volumes 

Use
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Use this to enter measurement point observed readings “en masse”.

You may have measurement point volumes on an Excel spreadsheet – representing MP readings that were 
taken in the field, which you want to enter quickly into the system. You can use this transaction to do that.

This allows you to enter MP field reading data en masse, rather than entering each one separately. It is 
designed to save time and effort in data entry.

You enter observed readings from the field. The system retrieves the relevant measurement points, volume 
types, and measurement types for the measurement points.

The functionality is the same as the functionality in the create measurement 
point volumes transaction (see:Creating Measurement Point Volumes).

Prerequisites

Master data for measurement points has to exist in PRA Production

Procedure

From the SAP Easy Access menu, choose Logistics à Production and Revenue Accounting à Production à Daily 
Transactions à MP Volumes MDE

The Mass Data Entry – MP Volumes screen is displayed.

Note that the measurement group that you enter will determine the measurement points that the system 
retrieves. When measurement points are set up as master data records in PRA, each one is linked to a 
measurement group. Thus, when you enter a measurement group and date range here, the system will retrieve 
every measurement point in that range, for that measurement point. Measurement groups that begin MD_* are 
specific to mass data entry. The system goes to the Measurement System and looks for MD_* measurement 
types.

In the MP Group field, enter the relevant measurement group. Enter the date range, and the allocation 
frequency (monthly or daily).

Choose Enter .

The Mass Data Entry – Mass Volumes screen is displayed. On that screen, there are several screen tabs:

Gas Fuel Rate
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Generic Gas

Generic Liquid

Generic Water

Depending on what type of volumes data you want to maintain, choose one of the screen tabs. In the ALV list on 
the screen tab, all the measurement points for that MP group and date range will be displayed.

You can now enter your data. You can “cut and paste” data from an Excel sheet into the screen in the ERP 
system, for example.

Save your data.

4.4.7  Creating Well Completion Measurements Dialog 

Use

Use this to create well completion (WC) and measurement point (MP) observed reading records, which can 
then be used in subsequent processes in PRA, such as well tests. It is linked to the PRA generic measurement 
tool (the "Measurement System").

You enter observed readings here for either a well completion or a measurement point, and store those 
readings. The Measurement System [page 199] takes the data entered at a well completion, measurement 
point, or other PRA entity, at observed conditions, and creates "generic" (standardized) records out of them.

 

Procedure

From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production → Daily 
Transactions → MP/WC Generic Meas. → Create .

Start from (choose) either Well Completion or Measurement Point (which is the "measurement class" from the 
perspective of the Measurement System).

Based on that, you can now enter the measurement type. The measurement class that you chose in step 1. 
determines the measurement type that you can select here. Enter the entity ID (WC or MP ID) and a date and 
time for the data. Also enter the Measurement Type (for example, for well completion daily pressures, choose 
WC_DPS from the drop-down list).

Select ENTER. The system displays the overview screen, where you can enter your observed data for the entity 
(WC or MP), measurement type, and date that you chose.

Select SAVE.
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The system saves the "generic" (standardized) data to the database. That record can be used in subsequent 
PRA processes, such as well tests.

Example

For example, you would like to create a record for "generic" (standardized) well completion daily pressures. 
Starting from the " Create WC Measurements Dialog: Initial Screen ", you select Well Completion. You now enter 
the well completion (well ID plus well completion number), the date, and the relevant measurement type. The 
measurement type will be determined by the measurement class that you entered, which is simply the 
"application" - in this case, well completion. In this case, the measurement type is "WC_DPS" - for "WC Daily 
Pressures". You now select "ENTER".

The " Create WC Measurements Dialog: Overview " screen is displayed. On that screen, you enter the reading 
data (strokes, choke size for the well completion, etc.) and SAVE the record.

There is now a "generic" well completion pressure record for that well completion and date and time.

4.4.8  Creating Well Completion Daily Pressures 

Use

Use this to create daily pressure records for well completions.

Daily pressures are captured for informational purposes - for tracking the performance of a well completion, as 
input for determining theoreticals, using PQ curves and choke size adjustments. The information is also used in 
regulatory reporting. WC daily pressure readings can be used, for example, to track the change in pressure at a 
well completion over time.

Procedure

From the SAP Start Menu, choose Logistics → Production and Revenue Accounting → Production → Daily 
Transactions → Well Completion Daily Pressures .

The WC Daily Pressures: Initial Screen is displayed.

1. Enter the well completion for which you would like to create daily pressures information.
In the Parameters screen section, enter the date range that applies for the record.
Select Create .

The WC Daily Pressures: Create screen is displayed.

● Enter the relevant values for the daily pressures on the screen (the flow tubing pressure and the choke size 
are required entries; all other fields are optional).

● Save the information.
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Result

Daily well pressures are created for the selected date range and well completion

4.5 Allocate and Report

Purpose

The allocation process involves determining how volumes should be calculated back to well completions. 
Reports are available to retrieve data about well completion oil and gas volumes.

Process Flow

1. When you make a change that results in a display of a dialog box that lists the prior period notification(s) to 
be generated if you proceed, determine whether to proceed with the change.

2. Process the prior period notifications as required in order to carry out the adjustment(s).

1. Retrieve data about well completion oil and gas volumes as required to evaluate the effect of the prior 
period notification(s).

4.5.1  Allocating a Delivery Network 

Use

Use this to allocate a delivery network.

This transaction:

● Controls the allocation or validation of delivery networks or delivery network groups
● Provides information about the status of delivery networks
● Generates reports from the allocation and validation process

Procedure

1. From the SAP Easy Access screen, choose the menu path Logistics  Production and Revenue 
Accounting    Production Allocate & Report  Allocation Selection  .
The Allocation Selection screen is displayed.
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2. Either click D. Network to work with an individual delivery network or multiple delivery networks, or click DN 
Group to work with a group of networks previously set up in the system.
A green check appears on the pushbutton you select.

3. Enter data as required.
4. Enter the application area code to specify in which application area (Production, Contractual Allocation, or 

Valuation) the allocation should be processed.Verify the other parameters and the allocation 
frequency.Choose Execute .

5. Review the list of delivery networks.The first section lists the delivery networks that are available to be 
selected for allocation processing.The second section lists any delivery networks that are currently being 
processed.

6. Note that the Results column indicates the allocation results of a delivery network for the application area 
specified on the first screen, while the Close Ind. column indicates the status of the delivery network for the 
application area specified on the first screen.

7. Select the delivery network(s) to be allocated and choose Allocate network .
The Allocate Network dialog box appears with the list of delivery networks to be allocated.

8. At the Allocate Network dialog box, set the following indicators as required.

Table 42:

If you would like to: Then:

Make successful allocation results at the measurement 
point and well completion level available for subsequent 
processing, and you would like to set the delivery net­
work’s processing status for the application area to 
Closed

Select Final Allocation .

Generate reports from the WC Theoretical Calculation 
Method, and Volume Allocation functions

Select Trace .

Generate a report identifying the source and destination 
of a volume

Select Volume Source .

Generate a report identifying the allocated results for the 
well completions

Select WC Disposition .

9. Choose Execute to allocate the selected delivery network(s).
10. To display the details of an allocated network, see: Displaying Allocation Details [page 193] .

4.5.1.1 Displaying Allocation Details 

Use

Use this to display the details of a network that has been allocated in Allocating a Delivery Network [page 192] .

You can use this to view network allocation details on the following:

● Processing results and status
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● The job log and the system steps involved in allocation
● The spool list
● Review error messages

Procedure

1. To review details about an allocation, proceed as follows:
2. 1. Follow the procedure as detailed in Allocating a Delivery Network [page 192] , up to the point at which a 

network is allocated.
3. 2. From the list of allocated networks, double-click a network that you would like to view details on.

The <Delivery Network Number> Network Oil dialog box appears.
4. At the <Delivery Network Number> Network Oil dialog box, choose one of the following, based on what you 

would like to display:

Table 43:

If you would like to: Do the following:

Review the processing results and status Choose Display Process status

Review the steps the system performed to carry out the 
jobs, and the amount of time required for each step

Choose Display Job Log

Review a list of reports generated for the delivery network Choose Display Spool List

Review warning or error messages Choose Display Message Log .

To view the network in hierarchical structure (which wells 
and measurement points the network contains)

Choose Network Structure

You can also carry out selection for gas plant and fuel system as of PRA Phase II. Gas plant is different than the 
usual type of unit in the network in PRA, in that gas can have two components: natural gas and NGL (natural 
gas liquid), and you can break gas down intoT components such as ethane, pentane, etc. Fuel system is a 
special case in which gas is not sold, but is used in production processes – to get oil out of the ground in the 
production process. One party uses gas from another party to do that, and the gas is not sold.

4.5.2  Carrying Out a Delivery Network Status Query 

Use

Use this to run a report that queries the status of a specified delivery network.
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When you run this report for a specified network ID, the system produces a list with status entries for that 
network, which provide information on:

● The production date
● The production frequency (either monthly or daily)
● The product that is produced
● Allocation results (successful, unsuccessful)
● Status (processing, completed, or available)
● Open / close – whether the delivery network is open or closed
● The application area of PRA that uses the network (Production, Contractual Allocation)

Procedure

1. From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production → 
Allocate & Report → Display Allocation Status .

The Display DN Status screen is displayed.

● Enter the delivery network that you are interested in.
Select Execute .

The Status for DN … screen is displayed. It lists the delivery network status entries for the delivery network.

4.5.3  Volumetric Prior Period Notifications 

Use

Use this transaction to:

View a list prior of period notifications that have already been generated.

Determine which prior period notifications on the list should be submitted for reallocation.

Either delete prior period notifications or submit prior period notifications for reallocation as required.

A change to any master or transactional data that may affect a previously closed allocation is logged as a prior 
period notification. During the successful reallocation of a network, any prior period notification for the network 
being processed is deleted automatically.

Procedure

At the SAP Easy Access screen, choose Logistics   → Production and Revenue Accounting   →  Production   → 
 Allocate & Report   →  Prior Period Notifications

SAP Oil & Gas (PRA - Production and Revenue Accounting)
Production C U S T O M E R 195



The Volumetric Prior Period Notification screen is displayed.

Enter data as required and choose Execute .

To enter a delivery network group instead of a delivery network, choose DN Group .

To view one of the prior period notifications listed, set the indicator for the prior period notification to be viewed 
and choose Display .

The system displays the changed data that generated the prior period notification under the New Value 
column. Likewise, the system displays the data in its condition before the change in the Old Value column.

To submit networks for reallocation, set the indicator for each network to be submitted for reallocation and 
choose Reallocate Network(s) .

If you decide that you do not want to reallocate a prior period notification, you can delete it. To delete a prior 
period notification, set the indicator for the prior period notification to be deleted and choose Delete .

Deleted prior period notifications can still be retrieved at a later date by using the Historical radio button on the 
first screen. In addition to deleted prior period notifications, the Historical radio button retrieves any prior 
period notifications that VA incorporated.

Exit the prior period notification list.

4.5.4  Prior Period Notification 

Use

Use this procedure to determine the impact of prior period notifications, and to decide whether to proceed with 
a change that generates prior period notification(s).

Procedure

1. At the Prior Period Notification dialog box, review the prior period notifications that will be generated if you 
proceed with the change.

2. If you decide to proceed with the change, choose Enter .
3. If you do not want to proceed with the change, cancel the function to return to the screen where you 

changed the data.
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4.5.5  Carrying Out Statistical Key Figure (SKF) Jobs

Use

Use this to run an Statistical Key Figure (SKF) job.

You can use the SKF job to do the following:

● Extract production well completion (WC) volumes for pre-configured material/volume type combinations 
and production day information

● Post the summed up results to the SAP-CO (Controlling) Module as statistical key figure (SKF) volumes
● Display the results of the postings

The volumes are summed up per cost center and for a specific period of time (a number of months prior to the 
current accounting period). You can choose either volumes or energy as the basis for summing. You can use 
the screen to define the posting period (the accounting period and the WC volume statistical key) for the 
process.

Within the Job Submission screen tab, you can choose which function/program you would like to run:

● Well completion volumes
● Drilling days
● Well counts
● All

If you want to produce a list of records for the selection that you chose, select the Reporting screen tab, and 
then select the option that you would like to see the records for (well completion volumes, drilling days, well 
counts, or all). For example, you could select Job Submission and then one of the options to run the function in 
the background, and then select Reporting to view the results of the run for that same option.

Procedure

From the SAP Start Menu, choose Logistics  Production and Revenue Accounting  Production  Allocate 
& Report  SKF Submission  .

The SKF Job Submission: Overview screen appears.

1. On the Job Submission screen tab, select one of the following SKF jobs for processing:
Well completion volumes
Drilling days
Well counts
All selections

Select the posting date (note: the posting day has to be the final day of the month, as the posting period is 
month-end).

4. Select Execute .

The program now uses the posting date and the selection that was chosen to post the summed results from 
the well completion volumes (depending on the selection made) to the SAP-CO Module.
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4.5.5.1 Displaying SKF Job Results 

Use

Use this to display the results of SKF jobs, which were processed in Carrying Out Statistical Key Figure (SKF) 
Jobs [page 197] .

Prerequisites

You have to have run SKF jobs in Carrying Out Statistical Key Figure (SKF) Jobs [page 197] .

Procedure

From the SAP Easy Access Screen, choose Logistics → Production and Revenue Accounting → Production → 
Allocate and Report → SKF Submission .

The SKF Job Submission: Overview screen appears.

1. On the SKF Job Submission Overview screen, select the Reporting screen tab.
2. Select one of the following SKF report types:

- Well completion volumes
- Drilling days
- Well counts
- All

1. Select the Document Date (the posting date, effective from and effective to dates)
2. Select Execute .

The system now displays a screen with a list of spool numbers, date, time, status, page number, and title. You 
can display any of the spool requests from the list and view the individual contents.
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5 Measurement System 

Purpose

It is important in the oil and gas industry to be able to take readings such as measurement point volumes at 
observed conditions, and convert those to reading data and measurement documents in standardized units.

It is particularly important due to the vast quantities of product involved in the oil and gas industry. It is also 
important to be able to flexibly configure the calculations and units that are used to do that to reflect company 
specifics or country specifics.

The PRA Measurement System provides the functionality to do that. It is used to convert measurements 
(which consist of one or more readings) at observed conditions to measurements at standardized conditions, 
and to create documents for the measurements, which are centrally saved to a database. The Measurement 
System also contains reports for viewing those measurement records.

Various types of PRA business objects are defined as a Measurement Class [page 201] (for example, there is a 
well completion measurement class and a measurement point measurement class). Each measurement class 
is assigned to one or more measurement types. A Measurement Type [page 201] defines a consistentset of 
readings that are to be taken together. When a PRA object (such as a well completion) is created, it is assigned 
one or more measurement types, which allows measurements to be recorded for that object.

The main part of the Measurement System consists of calculation functions and routines which run “behind 
the scenes“ in the ERP system, and which, while being provided as standard SAP functions, can be customized 
to reflect the individual requirements of your company. The Measurement System uses many national and 
international standards. Measurement readings can be entered either online or in batch mode.

Although a “generic“ measurement transaction is provided, an include screen is included in business-object 
specific transactions for well, well completion and measurement point, allowing you to directly access the 
Measurement System from those screens in order to enter data. This allows data specific to the business 
object to be recorded separately, while still recording measurement data in a generic way on a single database.

Features:

The Measurement System supports the following:

● A measurement document that is created and resides on the database for each measurement that is 
taken, and which consists of one or more measurement readings (observed readings, standardized by the 
Measurement System).

● Each measurement document is assigned a number. The number is assigned by the system, based on 
number ranges (which can be customized).

● Number ranges are assigned to measurement types (that can be customized in the system)
● When PRA business objects (such as wells, well completions, and measurement points) are created, the 

system creates a dialog for you to enter a measurement type for the business object; the business object is 
assigned one or more measurement types, which allows measurements to be recorded for the object.
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● Measurement types define a consistent set of readings for a business object (and can be customized). The 
measurement type is a central element of the Measurement System

● Measurement classes are also a central element of the Measurement System (they can be customized). 
Measurement classes define the type of business object for which measurements are recorded, for 
example, one measurement class for well completion, one measurement class for measurement point, etc.

● Measurement types are assigned to business objects, and measurement types are also assigned to 
measurement classes. A measurement type defines a consistent set of readings that are to be taken 
together. The asssignment of a measurement type to a measurement class defines the types of 
measurement that can be recorded for business objects in the class (that assignment is customizable).

● Calculations (“calculation functions“) are assigned to measurement types. The calculations themselves 
come standard in SAP PRA, but can also be customized. SAP provides standard calculation functions 
(such as the Quantity Conversion Interface) for all measurement types.

● Reading types are assigned to readings, and define the format and attributes (and validation) for readings. 
Different types of measurement reading are defined as reading types and assigned to a characteristic 
record from the SAP classification system in order to provide information about the characteristics of the 
reading (such as maximum & minimum values, unit of measure, and data type). One or more reading types 
are assigned to each measurement type to define a default set of readings to be taken for the 
measurement type. When a measurement is recorded for a particular object, it must belong to a particular 
measurement type. Thus the system prompts you to enter a value for each of the reading types assigned 
to the measurement type. When a reading type is assigned to a measurement type, it may be active or 
inactive, optional or mandatory. Those attributes may be changed for a particular business object.

● Unit of measure groups are customized and define the standard measurement units. In PRA, they are 
assigned to a delivery network

See also:

Using the Measurement System to Convert MP Volumes [page 210]

5.1 PRA Business Object

Definition

A business object is a master record within the Measurement System, and is defined as part of the 
measurement class within Customizing. Examples of business objects are wells, well completions, and 
measurement points.

Use

Once the measurement object is maintained, it is saved with the business object so that when viewed, the 
measurement object is part of the business object.
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5.2 Measurement Class

Definition

A classification of the business objects for which measurements are taken. Each business object for which 
separate naming and numbering is required is assigned to a separate measurement class.

Some examples of those measurement classes that currently exist are chemical analysis and well completion 
volumes. Each measurement class has measurement types assigned to it. Those will be the only valid 
measurements for that business object. The measurement types can be activated and deactivated to the 
measurement class as the need arises.

The measurement class is one of the three main customizing objects in the Measurement System (along with 
measurement type and reading type).

Use

The measurement class is used to group measurement types by application. Measurement classes are 
assigned to one or more measurement types. That assignment defines the types of measurement that can be 
recorded for business objects in the class.

5.3 Measurement Type

Definition

A consistent set of readings that are taken together for a specific PRA business object (for example, a well 
completion or measurement point) in a Measurement Class [page 201] . Each measurement class is assigned a 
set of valid measurement types. The measurement type includes rules for the input of measurements, 
including expected frequency, user authorization, and a link to SAP validation.

The measurement type stores readings and their specific characteristics. Characteristis include: reading type, 
reading group, status, position, derived or observed conditions, and display control.

The measurement type is one of the three main customizing objects in the Measurement System (the other 
two are: measurement type and reading type) and is the most important object in the Measurement System).

Each measurement category is assigned a set of valid measurement types. The measurement type includes 
rules for the input of measurements, including expected frequency, user authorization, and a link to the SAP 
Validation sub-module.
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If a measurement type is not assigned for an PRA business object, no readings can be made for that object.

Use

The measurement type is used, for example when taking measurement point readings, and converting them 
into standard values.

See also:

Using the Measurement System to Convert MP Volumes [page 210]

In order for the Measurement System to be able to display readings, the reading must first be entered in the 
measurement type.

Each Measurement Class [page 201] is assigned one or more measurement types. A measurement type 
defines a consistent set of readings that are to be taken together. When a PRA object (such as a well 
completion or a measurement point) is created, it is assigned one or more measurement types, which allows 
measurements to be recorded for the object. Some measurement types are identified as mandatory for a 
specific measurement class. Any business object created within a measurement class must be assigned to all 
mandatory measurement types.

Different types of measurement readings are defined as reading types and assigned to a characteristic record 
from the SAP classification system to provide information about the characteristics of the reading (such as 
max & min values, unit of measure, data type).

One or more Reading Type [page 203] s are assigned to each measurement type to define a default set of 
readings to be taken for the measurement type. When a measurement is recorded for a particular object, it 
must belong to a particular measurement type. Thus, you are prompted by the system to enter a value for each 
of the reading types assigned to the measurement type. When a reading type is assigned to a measurement 
type, it may be active or inactive, optional or mandatory. Those attributes may be changed for a particular 
business object.

In PRA, several applications call the Measurement System. In each case, the calling application determines the 
measurement type (collection or readings types) to be used.

The following are examples of measurement types :

Table 44:

Measurement type Measurement type description

MV_TKINV Tank inventory

MV_TKVOL Tank volume

WC_DPS WC daily pressures

WC_WTGI Gas injection well tests

WC_WTPS Submersible pump well tests
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WCDVLGAS Well completion volumes - gas

WCDVLGNGL WC volumes naturla gas liquids

5.4 Reading Type

Definition

The definition of a particular type of reading. The definition includes formatting information, validation, and edit 
checks.

The reading type is one of the main customizing objects in the Measurement System (the other two are the 
measurement class and the measurement type).

The reading type defines the following for a reading:

● Format
● Unit of measure
● Dimension

● Output format

Reading types can be:

● Active
● Inactive
● Optional
● Mandatory

Use

Reading types have to exist before the Measurement System can display and store data. Each reading in a 
measurement type uses a reading type to define its characteristics.

Customizing tables include a cross-reference between Measurement Type [page 201] and reading type; from 
that cross-reference, the readings that are to be taken for a specific measurement type are derived. That cross 
reference is known as the measurement reading.

5.5 Measurement Type Reading

Definition

A list of the reading types available for a measurement type. Some reading types will be active and others 
inactive – the list of reading types that are active for a measurement type represents the default set of readings 
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that will be made for a business object that is assigned to the measurement type. This default set of readings 
may be modified for a particular business object by activating or deactivating reading types. Information held 
for the measurement type reading includes validation and edit checks, tolerances, and optionality. In addition, 
reading types may be identified as "system required", in which case they cannot be deactivated for a particular 
business object.

Information held for the measurement type readings include validation and edit checks, tolerances, and 
optionality. In addition, readings may be identified as "system required", in which case, they cannot be 
deactivated for a particular business object.

5.6 Measurement Object

Definition

Any object within the system, for which Measurement System readings can be taken.

Since a business object may use a measurement type any number of times for different purposes, the 
measurement object is identified with its own internal number (the use of all active reading types within the 
measurement type is assumed, but if required, these may be activated or deactivated for a particular 
measurement object).

Use

Business objects using the measurement system are required to maintain a cross-reference between the 
business object and the measurement object. A measurement object is created for any business object for 
which measurements are to be recorded using the Measurement System.

The measurement object acts as a collection of measurement types for a particular business object, and each 
measurement type represents a consistent set of readings that are to be taken for the business object. Any 
number of measurement types may be assigned any number of times to a measurement object, provided the 
measurement type is assigned to the same measurement class as the business object.

The measurement object is identified using a unique internal number that is derived independently of the 
business object.

5.7 Measurement Reading

Definition

A measurement consists of one or more readings, which are individual data for transactions such as 
measurement point volumes. The measurement reading is derived from a cross-reference of measurement 
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type and reading type. Each reading is assigned to a measurement and a measurement category to allow 
cross-referencing between the measurement and the readings.

The configuration tables include a cross-reference between Measurement Type and Reading Type that defines 
the readings that are to be taken for a particular Measurement Type. This cross-reference is known as a 
Measurement Reading.

Use

The measurement reading defines the rules governing the input of readings for a particular measurement. 
Some readings are optional, others mandatory. Some readings are input directly, others derived from initial 
readings. Readings may be derived using a function with a standardized interface that is specified in the 
measurement reading table. In this case, the original readings that form the basis of the derivation are defined 
in a sub-table, the measurement reading derivation rules table.

5.8 Creating Customizing Settings for the Measurement 
System

Use

Use this to create customizing settings for the Measurement System.

You can customize the following in the Measurement System:

● Reading Type [page 203] - set up in order to define the attributes for the reading
● Measurement Class [page 201] - defined for business objects (well completion, measurement point, etc.)
● Measurement Type [page 201] - defined for business objects, and are assigned to measurement classes
● Number ranges - defined for internal number assignment of numbers to measurement documents on the 

database, and assigned to measurement types
● Unit of measure groups
● Calculations - defined and assigned to measurement types
● Measurement sources

Measurement classes define classes of measurement that correspond to particular classes of business object 
such as well completion volumes and measurement point volumes.

Measurement types are assigned to measurement classes in the measurement type assignment table. There, a 
measurement type may be mandatory for a measurement class, in other words, when a measurement is made 
for a business object in the measurement class, at least one measurement of that type must be taken.

Reading types define the characteristics of a particular type of reading, including a description of the reading. 
The characteristics of a reading type are represented by a characteristic record that is defined in the SAP 
Classification System.
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The customizing tables include a cross-reference between the Measurement Type and Reading Type that 
defines the readings that are to be taken for a particular measurement type. That cross-reference is known as a 
measurement reading.

The measurement reading defines the rules governing the input of readings for a particular measurement. 
Some readings are optional, others mandatory. Some readings are input directly, others derived from the initial 
readings. Readings may be derived using a function with a standardized interface that is specified in the 
measurement reading table. In that case, the readings that form the basis of the derivation are defined in a sub-
table, the Measurement Reading Derivation Rules table.

The measurement tables are used to record measurement readings for particular measurement objects. The 
readings are stored with a small header that includes information about the measurement object, the owning 
business object, and the measurement document number. It is the responsibility of the calling business 
application to record all the information necessary for the application in an extended measurement document 
header. That document header includes a reference to the measurement document number under which the 
measurement document is stored.

The measurement readings are identified by the measurement document number (of the calling application) 
and the reading ID. The reading ID is taken from the measurement type reading defined in customizing.

The elements listed below in customizing are pre-configured as standard by SAP. That means that you do not, 
in all cases, have to make customizing settings for them. You can make customizing settings for them to reflect 
company or country-specific settings.

Procedure

Within Customizing (which you can reach also via transaction SPRO, and then by choosing the SAP Reference 
IMG ), choose Industry Solution Oil & Gas (PRA) → Global Settings . Within that area, you can make the following 
customizing settings in order to customize the Measurement System for your specific purposes:

Table 45:

Setting in Customizing Effect

Quantity Conversion Interface (QCI) Allows you to customize the Quantity Conversion Interface: 
Define QCI parameters, activate SAP conversion routines for 
natural gas, define conversion group and external function 
module settings, configure QCI message handling, and 
maintain physical properties data for natural gas compo­
nents. The QCI Interface is one of the SAP standard calcula­
tion functions.

Units of measure (UoM) Defines standard measurement units. In PRA, UoM groups 
are linked to delivery networks.You can also define company 
or customer-specific rounding rules here.
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Calculation Use this to define calculations for the Measurement System. 
Calculation settings are used to convert (observed) meas­
urement readings into standard readings. You define calcula­
tion parameters here.

Assign calculations to measurement types When calculations are assigned to measurement types, that 
allows readings within a measurement type to be calculated 
automatically. Here, you also assign measurement readings 
to observed and derived parameters.

Measurement document number ranges Measurement documents that are saved to the database are 
assigned numbers by the system based on a number range. 
Here, you can define the number range.

Define reading types Use this to define reading types for readings. Reading types 
are used by the Measurement System to define attributes 
for a reading, such as the formatting rules (number of deci­
mal places, reading length, etc.) and validation rules.

Define measurement types Use this to define a consistent set of readings to be taken for 
a business object such as a delivery network measurement 
point.

Define measurement classes Use this to define the type of business object for which 
measurements are recorded, for example, well completion 
and measurement point.

Define measurement sources This is used to define the applications that record measure­
ments using the Measurement System (Example: MPNT = 
Measurement Points)

5.9 Creating Measurement Classes in Customizing

Purpose

This process defines measurement classes, and is presented here to illustrate an example of how the 
Measurement System is customized in PRA.

Process Flow

Measurement classes are defined in Customizing, under Industry Solution Oil & Gas (PRA) → Global Settings → 
Measurement System Configuration → Measurement Document Number Ranges → Define Measurement 
Classes .
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1. You create a measurement class
2. You assign one or more measurement types to the measurement class
3. You set up readings (for the measurement)
4. You create reading types for the reading
5. You assign characteristics to the reading types

  EXAMPLE

The requirement is to be able to take measurements (all of the readings) for a tank.

Note that this example is actually from IS-Oil Downstream, but it illustrates how the Measurement System 
functions. The functions are similar in Upstream. It is included here to illustrate the process.

1. The first step is to create a "measurement class" called TANK.

1. You know that this particular type of measurement is required, so, you create a "measurement type" called 
TANK STRAPPING and assign it to the measurement class TANK.

2. You know what readings must be taken for this measurement, so you create "reading types" and assign 
them characteristics, as follows:

Table 46:

Reading Type Format UoM Derivation function

Gravity NUMC Kg/m3  

Gravity Temp. NUMC ºC  

BS&W NUMC Percent(?)  

Gauge Level NUMC mm  

Tank Volume NUMC m3 OIU_ME_TANK_VOLUME

Note that the format and unit of measure (UoM) are determined from the characteristic from the SAP 
Classification System, not actually entered in the table.

Tank volume is a "derived" reading, so we specify which "original" readings the derivation function requires as 
input.

Table 47:

Reading Type Seq. No Original reading type

Tank Volume 1 Gravity

Tank Volume 2 Gravity temp.

Tank Volume 3 BS&W
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Tank Volume 4 Gauge level

We assign the reading types (defined in Customizing) to the measurement type so that the measurement 
type - TANK STRAPPING - is assigned the reading types: gravity, gravity temp., BS&W, gauge level and tank 
volume.

Master data

When you create a tank master record, the tank maintenance transaction calls the measurement object dialog 
with TANK as the "measurement class". You are presented with a list of "measurement types" belonging to the 
"measurement class", so that you can decide which are appropriate to use. In this case, the type TANK 
STRAPPING would be mandatory – all TANKs must have a TANK STRAPPING measurement type.

The measurement object dialog creates a measurement object for the new TANK and includes the TANK 
STRAPPING measurement type in the measurement object. The measurement object is linked to the tank 
master record using an index in the Measurement Object Table.

From customizing, the TANK STRAPPING has five SAP-mandatory readings, one of which is "derived". Because 
they are mandatory in SAP, you cannot make them optional. Whenever a TANK STRAPPING measurement is 
taken for the tank, all five readings must be taken. Four (gravity, gravity temp. BS&W, gauge level ) have to be 
entered by you, the last (tank volume) is derived by the system (using function OIU_ME_TANK_VOLUME).

Measurement Data

Measurement data may be entered using a measurement transaction designed for tanks (or measurement 
points in general). This transaction must call the measurement data dialog, which presents you with a screen 
for entering readings.

When you select "calculate" or "save" (or just "enter"), the dialog program calculates all derived measurements 
- in this case, the tank volume. The tank volume reading is "greyed out", in other words, it cannot be entered.

When you select "save", the readings are stored, and control passes back to the calling application, in this case 
the tank strapping transaction. When the tank strapping transaction has finished its own processing (for 
example, creating a measurement record of its own, containing tank volume), it saves the measurement 
readings.

The measurement readings are saved with an internal unique measurement document number, and also an 
application-specific measurement document number. In this case, the application- specific measurement 
document number would correspond to the document number of the measurement record created by the tank 
strapping transaction.
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5.10 Calculating "Generic" WC and MP Data with the 
Measurement System

Use

Use this to calculate "generic" well completion and measurement point data with the Measurement System.

Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production → 
Daily Transactions → MP/WC Generic Meas. → Create .

The Create WC Measurement Dialog: Initial Screen is displayed. Here, you can either select Measurement point 
or Well completion (the Measurement Point pushbutton is displayed, if you want to calculate for a 
measurement point).

1. Proceed as follows:

Table 48:

For well completion Enter the well completion, date, and measuremnt type (such 
as WC_DPS).

For measurement point Enter the measurement point, date, and measurement type.

1. From either of those options, select Enter .

On the subsequent screen at the bottom, you can enter your observed readings (the fields that are displayed 
are dependent on the measurement type you entered on the first screen).

1. Select Save .

Result

The readings are saved for well completion or measurement point.

5.11 Using the Measurement System to Convert MP Volumes

Use

Use this to convert observed measurement point readings into standard measurement point values, using the 
Measurement System.
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Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production → 
Daily Transactions → MP Volumes → Create .

The Create MP Volumes:Initial Screen is displayed.

1. Enter data as required to create MP volumes.

You can use the following data (as an example) :

Table 49:

Measurement point 123654

Delivery network 970002

Effective from date Today’s date

Material EP503

Volume type Measured production

Volume class Estimated

Volume source Production

1. After entering your data, choose Enter .

The system uses the material (major product code), the volume type, and the volume source to determine 
which measurement type to load onto the screen that follows.

The Create MP Volumes: Overview screen is displayed. On that screen (at the bottom), are reading entry fields 
for that material, volume type, and measurement point.

1. Enter the observed data readings (observed volume, observed volumetric pressure, observed temperature 
volume, etc.).

2. Select Edits/Calculations .

Result

The system uses the observed data and calculates standard values for them, using the Measurement System.
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5.12 Using the Measurement System to Convert WC Daily 
Pressures 

Use

Use this to convert observed well completion daily pressures to standard WC daily pressure readings using the 
Measurement System.

Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production → Daily 
Transactions → Well Completion Daily Pressures .
The WC Daily Pressures: Initial Screen is displayed.

2. Select Create .
The WC Daily Pressures: Create screen is displayed.

3. Enterthe relevant data (well completion and date) and then select Enter .
That opens the measurement reading fields at the bottom of the screen.

4. Enter the observed readings in the fields at the bottom of that screen.
5. Select Save .

5.13 Using the Measurement System with Chemical Analysis 

Use

Use this to create measurement readings in conjunction with chemical analysis.

Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production → 
Daily Transactions → Chemical Analysis → Create.
The Create Chemical Analysis: Initial Screen is displayed.

The measurement type is determined by the analysis type, the typification level, the basis, and the 
calculation checkbox, which you now enter.

2. Enter a measurement point, date, and typification level (such as C6+). Select the Analysis type (either gas 
or liquid), and the Basis ( Mole or Volume ). Set the Calculated checkbox.
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3. Choose Enter .
The Create Chemical Analysis: Overview screen is displayed. At the bottom of that screen are the fields for 
entering readings for the Measurement System.

The Chemical Analysis Details and Properties screen tabs are always the same in terms of the fields 
displayed; the second tab – Components – varies depending on the entries you made previously.

4. Enter your observed readings in the fields on the screen tabs.
5. Save the readings.

5.14 Displaying Measurement Documents 

Use

Use this to view measurement documents that have been created in the Measurement System.

When measurements are taken, a measurement document is created and saved on the database. You can use 
this to view those documents.

Procedure

1. At the SAP Easy Access Menu, choose Logistics → Production and Revenue Accounting → Measurement → 
List documents.

2. Enter your selection criteria by entering data in the relevant fields for the search you would like to carry out.
3. Select Execute .

The system displays records that correspond to your search criteria.

5.15 Displaying Changes to Measurement Documents 

Use

Use this to view change documents for Measurement Documents in the PRA Measurement System.

Measurement documents are created and saved to a database for measurements. You can use this to display 
the changes to those documents.
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Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Measurement → 
List Changes.
The E&P Measurement: List Measurement Change Documents screen is displayed.

2. Make selections for the search that you would like to carry out, by entering data in all relevant fields 
(selections can be based on: year, measurement type, etc.).

3. Select Execute .
The system displays a screen with a list of records based on your selection.

214 C U S T O M E R
SAP Oil & Gas (PRA - Production and Revenue Accounting)

Measurement System 



6 Contractual Allocation 

Purpose

The Contractual Allocation (CA) application area allocates volumes of oil and gas transported from sales points 
or well completions to multiple contracts and owners.It allocates contract sales volumes, breaks down well 
completion-level contract volumes to the working interest owners in marketing groups, and makes these 
volumes available for balancing and valuation.

CA first allocates primary products (oil and gas) and then allocates plant products (residue and natural gas 
liquids).

CA retrieves sales volumes from Production and allocates volume and energy quantities in the following order:

● first to marketing groups
● then to contracts
● finally to working interest owners.

CA also allocates residue and natural gas liquid (NGL) plant products if an outside-operated gas plant 
processed any of the gas.

There are four allocation methods that can be used in CA:the Sales Point Originated method, the Division Order 
Sales method, and two manual entry methods that allow volume or energy quantities to be entered for each 
termination point in a delivery network.

Integration

CA calculates entitled volumes by working interest owner for a well completion or measurement point based on 
volumes maintained in Production and gross revenue interest (GRI) maintained in Ownership.

Further, when minor ownership changes occur after availability processing is complete, the Contractual 
Allocation executes a background process to update adjusted GRIs.

6.1 Sales Point Originated Allocation Method 

Purpose

The sales point originated allocation method provides a phased approach for allocating sales point volumes to 
termination points. The phased approach, which is usually used for gas networks, involves:

determining network totals by marketing group

allocating sales over adjusted entitlements
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eliminating imbalances based on a variety of criteria

Volumes are entered for each of the contracts at a sales point, and the volumes are usually based on a pipeline 
statement.

Before the Sales Point Originated Allocation Method begins, you build a monthly template by using production 
data based on the Measurement Point / Well Completion Transporter to Contract Cross Reference [page 221] 
transaction. Then the volumes entered are compared with production at the sales point level. If the difference 
between the volumes is outside the tolerance, which is set in the Delivery Network Dated transaction, then the 
network is rejected in the Contractual Allocation application area.

The Sales Point Originated Allocation Method can execute up to five phases of allocation in order to allocate 
volumes to contracts at termination points.

The Sales Point Originated Allocation Method allocates the lesser of adjusted entitlement or sales volumes, and 
it uses adjusted entitlement as a basis to allocate to termination points. Any remaining marketing group 
imbalances are then maintained at the network level to be carried forward to the next allocation date.

Only allocated networks are processed with the Sales Point Originated method because this method requires a 
network structure.

Process Flow

Allocation Pre-processing

The standard system performs calculations that include determining network totals by marketing group for:

Adjusted/Entitled Volume/Energy - This calculation totals the adjusted entitlements for all termination points 
for a marketing group in the network.

Sales Volume / Energy - This calculation totals sales quantities for a marketing group across all of the sales 
points in the network.

Keep Whole Entitled Volume / Energy - This calculation totals any keep whole entitlements for a marketing 
group throughout the network.

There is also a New Beginning Imbalance calculation that adjusts the original beginning imbalance for the 
marketing group with two factors: (1) the prior period adjustments carried forward from a prior month, and (2) 
any manual adjustments applied to the marketing group’s imbalances.

Marketing Group Imbalance Makeup

The standard system attempts to eliminate any network level marketing group cumulative imbalances, as long 
as the elimination is supported by marketing intent. Marketing intent is represented by the difference between 
a marketing group’s total adjusted entitlements, and its total sales.

Therefore, if a marketing group is under-delivered at the network level and sells more than its adjusted 
entitlement, it is assumed that the marketing group is trying to make up all or part of its imbalance.

Allocation Phase 1

In this step, the standard system attempts to execute marketing intent in the allocation of either a 
measurement point / transporter sales volume, or energy quantities back to the termination point. The 
execution of the marketing intent involves allocating either (1) the lesser of the marketing group’s adjusted 
entitlement for each termination point in which the marketing group has an interest, or (2) the marketing 
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group’s adjusted sales quantity, which is the allocated sales volume or energy adjusted by the imbalance 
makeup volume or energy.

If a marketing group sells less than its adjusted entitlement, then its adjusted sales quantity is allocated among 
termination points based on its relative adjusted entitlement in each termination point.

If there is only one termination point in the network with physical sales quantities for a month, then this step, 
Allocation Phase 1, allocates all volume or energy quantities from the measurement point/ transporter to the 
single termination point. The Sales Point Originated Allocation Process is then complete in such a situation, 
and the following Allocation Phases 2-5 are not performed.

Allocation Phase 2

Phase 2 allocates additional portions of the sales point contract quantities back to termination points with 
remaining unallocated volume or energy quantities. A termination point has a remaining quantity if one or more 
of its marketing groups sold less than its adjusted entitlements. The quantities allocated in this phase are those 
associated with marketing groups that sold more than their adjusted entitlements. Volumes are allocated in a 
structured process where all marketing groups are treated the same.

Allocation Phase 3

Phase 3 allocates any remaining sales point contract volume or energy quantities to termination points so that 
all sales point quantities are completely allocated. These quantities must be allocated to termination points 
that had no remaining available volume or energy quantities after Phase 1. If the termination points had had 
available quantities, then their remaining quantities would have been allocated in Phase 2. Termination point to 
termination point imbalances are therefore initially created in this phase.

If allocation reaches this phase, then allocation must continue with Phase 4.

Allocation Phase 4

Phase 4 attempts to eliminate any termination point level imbalances created in Phase 3 by identifying 
common ownership between (1) the over-delivered termination points from Phase 3 and (2) the remaining 
under-delivered termination points in the network. When common ownership is found, the imbalances are re-
allocated. All marketing groups are treated equally in this phase.

Allocation Phase 5

If common ownership is not found between over-delivered and under-delivered termination points, then 
termination point-to-termination point imbalances still exist after Phase 4. In this case, Phase 5 eliminates 
them and accumulates the termination point imbalances by marketing group within the delivery network. All 
termination points are therefore kept whole and the imbalance is maintained at a network level to promote 
manageability.

Use the Marketing Group Network Imbalances transaction to calculate termination point imbalances during the 
allocation of wet gas to working interest owners.

Allocation Post-processing

Allocation post processing includes:

Updating the appropriate contract results tables

Calculating and updating the marketing group cumulative ending imbalances

Creating the marketing group imbalance information for the next date

Calculating any adjustment associated with prior period adjustment (PPA) processing and rolling it to the 
current date
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Calculating the energy quantities for volumetric based gas allocations, or the volume for energy based gas 
allocations

See also:

Building a Monthly Template [page 232]

Maintaining a Marketing Group Network Imbalance [page 234]

Creating Delivery Network Dated Characteristics [page 124]

 

 

6.2 Division Order Sales Allocation Method 

Purpose

Division Order Sales

The Division Order Sales allocation method, usually used for oil networks, allocates sales volume and energy 
that Production has allocated to termination points as well as to contracts and working interest owners based 
on adjusted gross revenue interest (GRI).

In allocated networks, which use network structures defined in Production, the allocation method begins by 
retrieving Production volumes associated with a termination point. It then processes the data by originating 
measurement point and transporter and allocates volumes to each working interest owner in the contracts 
associated with the originating measurement point.

You can associate contracts with termination points and specify which owners are marketing together on valid 
contracts.

If a marketing representative participates in more than one contract, the marketing representative’s volume is 
allocated across contracts. If there is no marketing representative, then the system allocates the same volume 
and energy amounts to all available contracts.

There is no network structure in a non-allocated networks, which is used primarily for non-operated ventures 
(an operation by a third party that shares revenue with other working interest owners).

Because no network structure is used, volumes from Production have no originating measurement point and 
therefore contracts must be tied directly to the termination point with the MP / WC Transporter Contract Cross 
Reference transaction.

Division Order Sales – Sales Point

The Division Order Sales – Sales Point method is based on the Division Order Sales method, but allocates only 
to measurement points and not to wells.
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Process Flow

Use the Delivery Network Dated Characteristics transaction to select Assume ACRs and/or Assume Mkt. Grp as 
required.

When A ssume ACRs is selected, the system performs allocation only at a measurement point because 
contracts cannot be cross-referenced to termination points.

Use the Allocation Cross Reference transaction to do the following:

Link contracts to termination points

Enter data specifying how to allocate the marketing representative’s volume across contracts, if a marketing 
representative participates in more than one contract

Use the MP / WC Transporter to Contract Cross Reference transaction to establish cross references to 
contracts.

After Production has allocated volume or energy, CA creates entitlements, then runs the allocation method to 
retrieve those volumes along with originating measurement point and transporter.

If the originating measurement point is provided, CA carries the measurement point through the allocation 
process.

CA allocation to marketing groups under a termination point, which is based on adjusted GRI from the Product 
Control application component, creates entitlements.

If availability data is not available from Product Control, then true GRIs are used to allocate to working interest 
owners on the division of interest associated with the termination point.

CA allocates the volumes or energy to all applicable contracts.

The system uses the heating value factor to calculate either the energy or the volume.

CA allocates to owners.

If applicable, CA carries out natural gas liquid (NGL) and residue allocation in the Sales Point Originated 
allocation method.

6.3 Owner Level Allocation 

Purpose

Owner level allocation involves allocating termination point or contract sales quantities to working interest 
owners in a marketing group.This owner level allocation may be based on relative gross revenue interest (GRI) 
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when there is no makeup in a marketing group.Or, the allocation may be based on relative adjusted GRIs when 
one or more owners are involved in makeup.

Relative GRIs are used for marketing groups without makeup, while relative adjusted GRIs are used when one or 
more owners within a marketing group are involved in makeup.If allocation is based on relative adjusted GRIs, 
then the allocation is based on owner availability data captured with the Revised Owner Availability transaction.

For owner level allocation, keep whole arrangements are considered.Keep whole arrangements, whether for 
entitlements or makeup, affect how volume is split among owners in a given marketing group.

Process Flow

Owner Keep Whole on Entitlements

This is the process used when owners would like to receive their entitled volume irrespective of imbalances.

If the contract’s volume or energy is less than the owner’s entitled volume or energy, then the entire contract 
volume or energy is allocated to the owner.

If multiple owners are kept whole for entitlements, and the contract does not have enough volume or energy to 
satisfy both owners, the standard system splits the entire contract volume or energy between the owners 
based on relative GRIs.

Any volume or energy remaining after allocating to the keep whole owners is then allocated among the 
remaining owners based on relative GRIs or relative adjusted GRIs, as defined above.

If there is remaining volume or energy for the contract and no other owners to allocate to, then the standard 
system splits the remaining volume or energy between the keep whole owners, based on relative GRIs.

Owner Keep Whole on Makeup

This is the process used when owners would like to receive their adjusted entitled volume irrespective of 
imbalances.

If the contract volume or energy is less than the owner’s adjusted entitled volume or energy, then the owner is 
allocated the entire contract volume or energy.

If multiple owners are kept whole for makeup, and the contract does not have enough volume or energy to 
satisfy both owners, then the entire contract volume or energy is split between the owners based on relative 
adjusted entitled volume or energy quantities.

Any volume or energy remaining after allocating to the keep whole owners is allocated to the remaining owners 
based on relative GRIs, or relative adjusted GRIs, as defined above.

If there is remaining volume or energy for the contract and no other owners to allocate it to, then the standard 
system splits the remaining volume or energy between makeup keep whole owners based on relative adjusted 
entitled volume or energy quantities.

Note
Volume or energy quantities are not allocated to owners that are being kept whole for entitlements.

See also:

Revising Owner Availability [page 225]
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6.4 Creating or Maintaining a MP / WC Transporter 
Contract Cross Ref 

Use

Use this transaction to:

link a single contract with either a measurement point or well completion and a transporter cross reference

enter an ending effective date that specifies when the link between the contract, transporter, and 
measurement point or well completion expires

Procedure

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Sales and Balancing 
→ Contractual Allocations → MP / WC Transporter to CT Xref

The MP/WC Contract Cross Reference: Initial Screen appears.

Choose Create .

The MP/WC Contract Cross Reference: Create screen appears.

Options for Creating a Contract Cross Reference

Table 50:

Function Follow-on action

To enter a measurement point-contract cross reference Choose Measurement Point

To enter a well completion-contract cross reference Choose Well Completion

 

Enter the following data:

measurement point or well completion

transporter

contract

Save your entries.

Using a Reference to Create a Measurement Point or Well Completion Transporter to Contract Cross 
Reference

To create a measurement point or well completion transporter to contract cross reference with reference to an 
existing record, at the MP/WC Contract Cross Reference: Initial Screen , select one of the following:

Measurement Point

Well Completion
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Contract

Transporter

After entering data as required, choose Execute .

If more than one record matches the data you entered, select one of the measurement point or well completion 
cross references from the list.

OR

If only one record matches the data you entered, a single record is displayed.

Choose Create to create a new record with the data from the record you selected.

Changing or Displaying a Measurement Point or Well Completion Transporter to Contract Cross Reference

To create a measurement point or well completion transporter to contract cross reference with reference to an 
existing record, at the MP/WC Contract Cross Reference: Initial Screen , select one of the following:

Measurement Point

Well Completion

Contract

Transporter

After entering data as required, choose Execute .

If more than one record matches the data you entered, select one of the measurement point or well completion 
cross references from the list.

OR

If only one record matches the data you entered, a single record is displayed.

Choose Change or Display to change or display the record as required.

6.5 Allocation Cross Reference 

Use

This transaction links contracts to delivery network measurement points or well completions. The links dictate 
which contracts the system allocates at the measurement point or well completion.

This transaction is also used to maintain the allocation rules that are necessary for allocating gas plant residue 
volumes, as well as the marketing group contract percentage, which is used to split volumes across contracts 
within the same marketing group.

Only approved Allocation Cross References are used in the batch process.

Note
In order to make and save changes to an Allocation Cross Reference, it must be unapproved first.
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Changes in the volume basis or entitlement allocation percentage generate prior period adjustment 
notifications.

Prerequisites

● Measurement points and well completions are linked to a delivery network in the Production application 
component.

● The contracts to be used in the transaction exist in Sales and Distribution .

Activities

From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Sales and 
Balancing Contractual Allocations Allocation Cross Reference Create  .

Options for Creating an Allocation Cross Reference

Table 51:

Function Follow-on actions

Creating an allocation cross reference for a well completion Enter data as required, and then choose Enter .

Creating an allocation cross reference for a measurement 
point

Choose Measurement Point , enter data as required, then 
choose Enter .

Note
In the To field, enter the date on which the data entered in this transaction becomes ineffective.

6.6 Primary Product Allocation Processing

Purpose

Primary product allocation processing allocates either gas, oil, or condensate major products from sales points 
to the termination point. The termination point is either a well completion or measurement point, and is the 
furthest upstream node in the network structure.

There are three steps involved in primary product processing:

1. allocation to marketing groups
2. allocation to the contract level
3. allocation from the contract level to working interest owners.
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Further, there are five methods that can be used to carry out the allocation:

● Division Order Sales (mostly used for oil networks)
● Sales Point Originated (mostly used for gas networks)
● Manual Entry Equals Production
● Manual Entry Unrestricted
● None - Usually used in simple plant functionality for a company that wants to skip primary product 

allocation

All of the methods allocate contract results to the individual working interest owners marketing together on the 
given contract(s). For oil and condensate products, the allocation is volume based, while for gas the allocation 
can be either volume or energy based.

Table 52:

 Division Order Sales Sales Point Originated

Sales volumes are entered through 
Contractual Allocation

No Yes

Owners can be kept whole Yes Yes

Non-allocated networks are allowed Yes No

ACR and Marketing Group can be as­
sumed

Yes No

Integration

In order to carry out primary product allocation processing, the following four prerequisites must be met. 
( Note : The first three prerequisites are optional when the Division Order Sales Method is used with the 
Assume ACR option.)

1. Contracts must be tied to sales points with the Measurement Point Transporter Cross Reference 
transaction.

2. Marketing groups must be created.
3. Contracts must be tied to termination points using the Allocation Cross Reference transaction.
4. A Division of Interest -Well Completion Cross Reference must be set up in the Ownership application area.

See also:

Creating a MP / WC Transporter Cross Reference [page 117]

Creating a Marketing Group Assignment [page 226]

Creating an Allocation Cross Reference [page 222]
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6.6.1  Calculating Entitlements 

Use

Entitlements are calculated from volumes generated by the Production application area and stored at 
termination points.

The factors involved in calculating adjusted entitled volume or energy include:

● If the Product Control application area is implemented, availability data is incorporated.
● If availability data does not exist for the well, then availability data for any representative well from the 

venture / division of interest is used.
● If there is not a representative well, then entitled gross revenue interest is used as the adjusted entitled 

gross revenue interest.

6.6.1.1 Revising Owner Availability 

Use

Use this transaction to maintain owner adjusted entitlements after the month of flow, and to enforce ownership 
transfers that occurred after original nominations were created in the Product Control application area.(When 
minor ownership changes occur, Contractual Allocation executes a background process to update adjusted 
GRIs.)

This transaction can also be used to modify the adjusted gross revenue interest (GRI) calculated by the 
Product Control application area.When original nominations are created in Product Control, owner availability 
data, which is the basis for these nominations, cannot be altered, and ownership changes for that production 
month are no longer processed through Product Control. Because retroactive ownership changes occur, this 
procedure is required to update adjusted GRI information from Product Control using the ownership data 
which actually exists on the division of interest for that production month.

This transaction identifies the owners involved in ownership changes. These owners have an entitled availability 
but no adjusted availability. For all other owners not involved in ownership changes, the existing availability data 
remains the same. The user must manually determine the new adjusted GRIs for the owners involved in 
ownership changes. Once the new adjusted GRI data has been entered and totals 1.0, the standard system 
automatically calculates adjusted availability and makeup volumes, and then approves the revised owner 
availability.

Procedure

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Contractual 
Allocations Revised Owner Availability Change  .

Options for Revising Owner Availability
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Table 53:

Function Follow-on actions

Revising owner availability for a measurement point Enter data as required, and then choose Enter .

Revising owner availability for a well completion Choose Well Completion , enter data as required, then 
choose Enter .

The Change Revised Owner Availability for <date>: Overview screen appears.

Enter the new GRI and other data as required.

If there have been changes to the division of interest (DOI), such as an ownership transfer, choose Update 
Availability to retrieve the latest changes to the DOI into the screen.

To review the adjusted availability data from the Product Control application area, choose View Original Avail.

The Original Availability dialog box appears with the owners’ availability data from Product Control.

To review the most recent revision(s) of availability data, choose View Historical Avail .

The Historical Availability dialog box appears with the revised data.

Save the revised owner availability.

6.6.1.2 Creating Marketing Group Assignments 

Use

Use this transaction to assign working interest owners in a venture/division of interest (DOI) to marketing 
groups by designating a marketing representative for each owner.

A marketing group consists of one or more working interest owners jointly marketing a product under one or 
more contracts. The major product, the venture/DOI, and an effective date range are used to establish a 
marketing group. The marketing group ties working interest owners to the contract(s). (Each contract is 
assigned a marketing representative when it is entered into the system.)

Each marketing group can have multiple contracts, but a contract can be linked to only one marketing group.

Note that changing the marketing representative or the purchasing representative generates a prior period 
notification.

Integration

In the system, Ownership changes automatically update marketing group information. If a working interest 
owner is deleted, the owner is deleted form the marketing group for the unit property or DOI. Likewise, if a 
working interest owner is added and does not already exist in the marketing group, the owner is added to the 
marketing group for the DOI or unit property.
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Prerequisites

The venture/DOI exists, and is checked in.

All marketing representatives exist as valid customers.

Procedure

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Sales and Balancing 
→ Contractual Allocations → Marketing Group Assignment → Create

The Create Marketing Group Assignment: Initial Screen appears.

Enter data as required. Then choose Enter .

The start date acts as the effective from date that defaults for each owner who is a valid owner in the DOI prior 
to the start date. For owners that become valid in the DOI after the start date specified in this transaction, their 
ownership effective from date serves as the effective from date for the marketing group.

Enter the following data as required.

In the Marketing Rep. field, enter the marketing representative data for each owner

In the Gas Purchase Rep. field, enter the gas purchaser

Enter a date range to establish the period of time for which the marketing representative is assigned to the 
owner.

If necessary, complete the Owner Keep Whole field. (If you specify keep whole, then if possible the system gives 
complete entitlements or nominations to the marketing group. See additional information below.)

The following options are available at the Create Marketing Group Assignment: Detail screen.

Options for Creating a Marketing Group Assignment
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Table 54:

Adding a New Effective From Date for an Owner To add a new Effective From date for an owner, select the 
row of the owner for which the new range will be added, 
then choose Insert New Date Range .

You must use the Insert New Date Range to change effec-
tive dates in the resulting dialog box; it is not possible to 
change effective dates directly on the Create Marketing 
Group Assignment: Details Screen .

Creating Keep Whole Marketing Groups To create and maintain keep whole marketing groups, 
choose Keep Whole Marketing Group .

The keep whole function incorporates additional rules and 
restrictions during the allocation process.

When a marketing group is specified as keep whole, the 
standard system does not create an adjustment for that 
group provided that the difference between the total alloca­
tion basis volume and the physical sales volume can be ab­
sorbed by the marketing groups not being kept whole.

Therefore, a marketing group that is being kept whole usu­
ally receives its allocation basis volume as the final allocated 
volume.

When working with a keep whole marketing group, the Effec-
tive From date must be later than the start date and it must 
be the first day of the month, while the Effective To date 
must be later than the Effective From date and it must be the 
last day of the month.

Also, the marketing representative must already exist on the 
Create Marketing Group Assignment: Details screen.

Displaying the Gross Revenue Interest (GRI) for Each Owner To display each owner’s gross revenue interest (GRI), choose 
Calculate GRI.   The GRI is then displayed in the GRI field.

 

Save the marketing group assignment.
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6.6.1.3 Using Marketing Group List Processing 

Use

Use this transaction to retrieve and review a list of marketing groups (venture / division of interest 
combinations).

Procedure

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Sales and Balancing 
→ Contractual Allocations → Marketing Group Assignment → List Processing

The Marketing Group List Processing screen appears.

Enter data as required and choose Execute .

To view marketing groups affected by changes that the standard system made as a result of changes made in 
the Ownership application area, select either the Warning or Both radio button.

The Marketing Group List Processing screen (2) appears.

To review the data for a particular marketing group, select the row that corresponds with the marketing group 
you would like to review and then choose Display .

The Marketing Group Assignment: Detail screen appears.

When the standard system makes changes to a marketing group, the standard system also selects the Warning 
indicator for the marketing group.

Exit the function.

 

See also:

Creating a Marketing Group Assignment [page 226] Creating Marketing Group Assignments [page 226]
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6.6.1.4 Calculating Entitlement at the Contract Level (CA) 

Use

You can use this function to:

● Create contract level entitlements in contractual allocation (CA). The contract level entitlement creation 
takes place for sales volume types.

● Pick up contract level entitlements from contractual allocation (CA) while running valuation. When 
valuation run takes place, the system automatically picks up the contract level entitlements for sales 
volume types from contractual allocation.

The major processes within CA are to calculate entitled (and adjusted entitled) volumes and to allocate actual 
volumes by contract.You can maintain the actual results at the contract level by well completion/measurement 
point and also at the owner level within the contract and well completion/measurement point.You can maintain 
the entitled volumes at the owner level within the well completion or measurement point.

In some case, the entitled volumes are valued as well as actual volumes.In some cases, this is the basis on 
which royalties are paid.In addition, some companies book their revenue based on entitlements.Some users 
pay royalties on entitlements and book revenue on actuals. The way entitlements are valued is to associate 
them with a sales contract.

You can use this function to perform allocation of owner entitlement volumes to multiple contracts to which 
owners are tied to. In addition to allocating entitlements across contracts, adjusted entitlements are also 
allocated across contracts. The method for allocating adjusted entitlements is the same as that used for 
entitlements.Also, the source of the adjusted entitlement data is the same as that for entitlements.

Activities

To enable Contractual Allocation Entitlement Enhancement, you must do the following:

● In Customizing choose Industry Solution Oil & Gas (PRA) Global Settings Activate Configurable 
Edits

● Execute
● Choose Edit #38 - ACTIVAT CONTRACTUAL ALLOCATION ENTITLEMENT ENHANCEMENT
● Choose column St and set it to activate.

See Also

For more information, see Using the Allocated Volumes Inquiry [page 247] .
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6.6.2  Changing Contract Quantities by Sales Point 

Use

This transaction utilizes confirmed nominations for gas products or other override allocation quantities in order 
to determine actual volume or energy quantities by contract.This transaction is used only for the Sales Point 
Originated allocation method in the Contractual Allocation (CA) component.When this method is active, then 
the physical volume and energy for the measurement point and the transporter from the Production 
application area are allocated among contracts based on relative confirmed nominations or override 
quantities.The allocation is performed automatically based on changes to override nominations in the 
transaction, and the new, recalculated pro-rata amounts are displayed.

Since the volume and energy for a sales point could change in Production after you have already made 
adjustments in this transaction, the CA batch process also performs the pro-rata calculations if necessary.The 
batch process calculations involve determining and allocating differences between (1) the sales point volumes 
and energy and (2) the sum of the pipeline actual, pipeline imbalance, and marketing group imbalance 
volumes.

The batch process performs the allocation only if the difference is within tolerance.If the difference is not within 
tolerance, you must use this transaction to allocate the difference.

Prerequisites

● Contract cross references are included in the Measurement Point / Well Completion Transporter Cross 
Reference transaction.

● The monthly template build process is complete.

Procedure

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Sales and 
Balancing Contractual Allocations CT Quantities by Sales Point Change  .

The Change Contract Volume by Measurement Point: Initial Screen appears.

Enter data as required and choose Enter .

The Change Contract Quantities by Sales Point: Overview screen appears.

Enter the following data as required.

● In the Override Noms field, enter a value to override the confirmed nomination
● In the Pipeline Act. field, enter the pipeline actual volume or energy quantity
● In the Pipeline Imb. field, enter the pipeline imbalance quantity
● In the Mkt Group Adj field, enter the marketing group imbalance adjustments to be used during the 

makeup process of allocation
● Save the contract quantities.
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See also:

Creating a Measurement Point / Well Completion Transporter Cross Reference [page 117]

Building Monthly Templates [page 232]

6.6.3  Building Monthly Templates 

Use

Use this transaction to create a month’s worth of templates in order to maintain volumetric information, both 
for monthly and/or daily Contractual Allocation (CA) allocations.To create these templates, a monthly build 
process identifies, for the applicable sales date, all sales points and transporters which are within each CA 
network set to process through the Sales Point Originated allocation.

For each sales point/transporter combination, the contracts linked to that measurement point/transporter on 
the Measurement Point /Well Completion to Transporter Contract Cross Reference transaction during the 
sales date(s) are identified, and a template is built which contains the measurement point, transporter and 
associated contracts.

Volumetric or energy information can then be maintained via the Contract Quantities by Sales Point transaction 
for each contract.

Procedure

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Sales and 
Balancing Contractual Allocations CT Quantities by Sales Point Build Monthly Templates  .

The Contract Volumes by MP Build Template screen appears.

Enter the date for the production month and the frequency.Then choose Execute .

Result

Templates for the month are available in order to maintain volumetric information.

See also:

Changing Quantities by Sales Point [page 231]
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6.6.4  Refreshing Monthly Templates 

Use

When the contract volume template is built, the standard system uses existing measurement point, 
transporter, and contract cross references to determine what needs to be built.Since required cross references 
may not have been built, or existing cross references may be in error, there is a need to be able to update the 
contract volume template for cross reference changes.

When any new records are created with the Measurement Point / Well Completion Transporter to Contract 
Cross Reference transaction, or when any existing records are changed or deleted, the standard system uses 
the effective dates specified in the transaction to determine whether to make corresponding changes to 
existing templates in order to keep the data synchronized.

Procedure

At the SAP Easy Access screen, Logistics Production and Revenue Accounting Sales and Balancing
Contractual Allocations CT Quantities by Sales Point Refresh Network Templates  .

The Contract Volumes by Sales Point Refresh Template screen appears.

Enter the following data as required:

● production month
● delivery network
● frequency
● measurement point
● Choose Execute .

Result

The template is refreshed.

See also:

Building a Monthly Template [page 232]
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6.6.5  Maintaining Marketing Group Network Imbalances 

Use

Use this transaction to:

● track cumulative imbalances for a network’s marketing group
● display any updates to the imbalances generated by the Contractual Allocation batch process
● manually adjust the imbalances as required

Pipeline imbalances can be maintained with this transaction.

Network imbalances keep leases and wells whole for settlement and tax purposes, and they occur only when 
they cannot be avoided.An example is a situation involving a third party well that is not kept whole in a network.

The network balances generally result from lease-to-lease or well-to-well imbalances that have occurred in a 
previous date’s allocation.The imbalances consist of termination point imbalances calculated during the 
allocation of wet gas to working interest owner that are then rolled up to the network level by the Sales Point 
Originated allocation process.

When the Sales Point Originated allocation process is run, it creates the information for the next production 
date.

Procedure

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Sales and 
Balancing Contractual Allocations Network Imbalances Change  .

Enter data as required and choose Enter .

The Change Marketing Group Network Imbalances: Overview screen appears.

In the Unapp. Manual Adj. column, enter the adjustment volume for the marketing group.Then save the 
adjustment.

6.6.6  Creating a Contractual Allocation Manual Entry 

Use

Use this transaction to:

carry out allocation yourself and enter contract results

manually enter volume or energy quantities at each termination point in a delivery network

The volume or energy for each termination point is later allocated to all owners in the associated division of 
interest.
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Prerequisites

The allocation method for the network is designated as one of the following manual entry allocation methods, 
which are usually used for non-operated networks.

The Manual Entry Equals Production method - Involves verifying the volumes entered with production volumes 
at a termination point, originating measurement point, and transporter level. An exact match is required.

The Manual Entry Unrestricted method - The Production application area does not have to allocate the 
network. Therefore, this method does not validate volumes against Production.

Procedure

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Sales and Balancing 
→ Contractual Allocations → CA Manual Entry → Create

Options for Creating a CA Manual Entry

Table 55:

Function Follow-on actions

Creating a contractual allocation manual entry for a well 
completion

Enter data as required, and then choose Enter .

Creating a contractual allocation manual entry for a meas­
urement point

Choose Measurement Point , enter data as required, then 
choose Enter .

The Create CA Manual Entry screen appears.

Enter volume and heating value as required.

To enter volume and then have the system calculate energy, or vice versa, choose Volume ß> Energy as 
required.

To display Production data, such as the measurement point and the transport that it is linked to, choose 
Production Volume .

Save the manual entry.

Results

The networks for which you entered contract results are now ready to be run in order to ensure that the results 
total back to the Production numbers and that entitled volumes are calculated.

For details, see the Valuation Document Work List [page 339] .
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6.6.7  Simple Plant Functionality Statement Volumes 

Use

For plant properties requiring simple plant functionality (SPF), use this transaction to maintain natural gas 
liquid (NGL) and residue sales volumes.Volumes are entered for a material / sales contract combination for a 
specific measurement point.The volumes are then allocated to the working interest owners in well completions 
that are upstream of a measurement point.

When data is changed for networks that have already been allocated and closed, prior period notifications are 
generated for residue and NGL.

Procedure

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Sales and 
Balancing Contractual Allocations SPF Statement Volumes Create  .

The Create SPF Statement Volumes: Initial Screen appears.

Enter data as required and choose Enter .

The Create SPF Statement Volumes: Overview screen appears.

Enter the contract and material numbers, as well as the sales volume(s) for any observed conditions.

To enter an observed condition in a unit of measure that differs from the delivery network's unit of measure, 
enter the observed condition(s) and then choose Standardize Quantities .

Save the SPF statement volumes.

Using a Reference for SPF Statement Volumes

If an SPF statement volumes record already exists with data similar to that of the new SPF statement volume 
record you are creating, you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter data for the existing SPF statement volumes 
record in the reference section of the initial screen for the new SPF statement volumes record.

6.7 Gas Plant Processing 

Purpose

Simple plant functionality (SPF) is available in the Contractual Allocation (CA) application area. Only 
functionality for monthly allocations of gas is available since SPF is usually generated from outside-operated 
plant statements.
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Process Flow

You enter residue and natural gas liquid (NGL) quantities with the SPF Statement Volumes [page 236] 
transaction.

Residue and NGL plant products are allocated to a termination point based on one of two methods:

The products are allocated based on a termination point’s portion of the total delivery of wet gas to the plant 
for the network. The portion is determined by totaling the amount of gas delivered on contracts processing gas 
through the plant. This method is triggered when the Wet Gas Balancing indicator is selected in the 
corresponding Delivery Network Dated Characteristics [page 124] transaction.

The second allocation method occurs when the Wet Gas Balancing indicator in the corresponding Delivery 
Network Dated transaction is not selected. In this case, products are allocated to termination points based 
solely on the relative portions of gas allocated in the Production application area with a volume type of 
Measured Production .

NGL entitlements are calculated based on one of two methods:

NGL products are allocated in the Production application area with a volume type of NGL Production to serve as 
the basis for the entitlement calculation.

NGL entitlements are determined in order to handle cases where NGL inventories are supplying part of the 
monthly NGL sales volumes. This method is trigged when the Entitlement on Sales indicator is set on the 
Contract Allocation tab in the Delivery Network Dated transaction.

If CA allocation methods are not used, then results from the Production application area are used as the basis 
for allocating residue and NGLs.

Simple Plant Functionality
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6.7.1  Creating or Maintaining a Return to Lease Percentage 

Use

Use this transaction to establish and maintain percent return to lease information, which is used in gas plant 
agreements to calculate residue and NGL volume and value splits.

This percent return to lease value is used when the same entity owns both the property to which the product 
belongs as well as the gas plant in which the product is being processed. Since product that is owned by a 
property is taxed while product that is owned by a plant is not taxed, the government sometimes establishes a 
percent return to lease value in order to limit the amount of product that the plant can keep as part of the 
contract.

Examples of the Use of Percent Returned to Lease Data

Contractual Allocation uses percent returned to lease data to calculate volume splits for residue and NGL 
volumes under:

Straddle Agreements

Processing Agreements with NGL Take in Kind Rights
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Valuation formulas use percent returned to lease data to calculate percent of proceeds (value splits) for residue 
and NGL transactions and for NGL transactions under:

Processing Agreements without NGL Take in Kind Rights

Delivery networks processed as settlement statements as well as SPF delivery networks (processed as simple 
plant functionality networks) need percent returned to lease information for the sales contracts, or the percent 
of proceeds contract, when there is a reporting requirement to have 100% volumes prior to the application of a 
lease/plant split.

Procedure

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Sales and Balancing 
→ Contractual Allocation → Gas Plant Processing → Percent Returned to Lease

The Percent Return to Lease: Initial Screen appears.

Choose Create .

The Percent Return to Lease: Create screen appears.

To specify the entities for which the percent return to lease information is valid, choose one of the following:

Contract/Measurement Point

Contract/Well Completion

Contract

Enter the contract and, if required, the measurement point or well completion. Then enter the effective from 
date.

Choose Enter to refresh the screen. Then enter the material.

Enter EITHER the sliding scale code in the Sliding Scale Code field to allow for sliding scale lease/plant split 
percentages as defined in the Gas Plant Sliding Scale transaction, OR enter a fixed percentage in the Percent 
Return to Le field.

Save your entries.

Using a Reference to Create a Percent Return to Lease Record

To create a percent return to lease record with reference to an existing percent return to lease record, enter the 
contract number and either the measurement point or well completion number. Then choose Execute .

2. If more than one record matches the data you entered, the Percent Return to Lease: Overview screen 
appears. In this case, select one of the records from the list.

OR

If only one record matches the data you entered, a single record is displayed.

Choose Create to create a new record with the data from the record you selected.

 

Changing or Displaying Percent Return to Lease Records
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To change or display a percent return to lease record, enter the contract number and either the measurement 
point or well completion number. Then choose Execute .

2. If more than one record matches the data you entered, the Percent Return to Lease: Overview screen 
appears. In this case, select one of the records from the list.

OR

If only one record matches the data you entered, a single record is displayed.

Changing the sliding scale code or the return lease percent after they have been used to calculate a volume or 
value split automatically generates a prior period adjustment.

Choose Change or Display to change or display the record as required.

 

 

 

6.7.2  Creating or Maintaining Gas Plant Sliding Scales 

Use

Use this transaction to enter and maintain sliding scale percentage data. The data is then used to calculate 
volume and value splits for gas plant agreements when used with the Return to Lease Percentage transaction.

Sliding scales can have between one and three dimensions, which can be configured in customizing: Industry 
Solution Oil & Gas (PRA) → Sales and Balancing → Define Sliding Scale Properties . An example of a dimension is 
weighted average price.

Procedure

1. At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Contractual 
Allocations → Gas Plant Processing → Gas Plant Sliding Scale .

The Gas Plant Sliding Scale: Initial Screen appears.

Select one of the following methods for the sliding scale and then choose Create .

The Gas Plant Sliding Scale: Create screen appears.

Sliding Scale Methods
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Table 56:

VP (Volume Proportion of NGLs to wet gas) Determines the sliding scale percentage by the volume pro­
portion at the measurement point or well completion level 
for the selected volume proportion components.

WAP (Weighted Average Price) Determines the sliding scale percentage by the plant level 
weighted average price that is defined in Sales and 
Distribution .

If a dependent product is entered, the sliding scale percent­
age is determined by using the weighted average price for 
the dependent product, but if a dependent product is not 
entered, the percentage is determined by using the weighted 
average price for the product being split.

Residue (Producer’s Residue Volume Production per day) Determines the sliding scale percentage by the producer’s 
average daily volumetric production per day.

VPWAP (Volume Proportion and Weighted Average Price) Determines the sliding scale percentage by both volume 
proportion and weighted average price.

WAPVOL (Weighted Average Price and Total Plant Level NGL 
Volume per Day)

Determines the sliding scale percentage by both the 
weighted average price and the total NGL volume per day.

PRDVPPR (Total Wet Gas Production per Day, Volume Pro­
portion and Weighted Average Price)

Determines the sliding scale percentage by the total daily 
wet gas production per day for measurement point or well 
completion, volume proportion, and weighted average price.

SEPPRESS (Well Level Separator Pressure) Determines the sliding scale percentage by the separator 
pressure at the well completion (this is only valid for well 
completion splits).

 

In the Sliding Scale field, enter an identifier for the sliding scale. (The identifier may be alphanumeric.) Choose 
Enter .

The Dimension table appears.

Choose Edit .

The Gas Plant Sliding Scale: Create dialog box appears.

In the Range From field, enter the beginning value of a range of values for a condition, such as price, that the 
return lease fuel percentage is dependent on.

The system completes the Range To field when another range of values is entered.

To approve the sliding scale, select Approved .

Save your entries.
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See also:

Creating or Maintaining a Return to Lease Percentage [page 238]

Using a Reference to Create a Gas Plant Sliding Scale

To create a gas plant sliding scale with reference to the existing gas plant sliding scale, enter the sliding scale 
and the method. Then choose Execute .

If more than one record matches the data you entered, the Gas Plant Sliding Scale: Overview screen appears. In 
this case, select one of the gas plant sliding scales from the list.

OR

If only one record matches the data you entered, a single record is displayed.

Choose Create to create a new record with the data from the record you selected.

Changing (including Approving) or Displaying Gas Plant Sliding Scales

To change or display a gas plant sliding scale, enter the sliding scale and the method. Then choose Execute .

If more than one record matches the data you entered, the Gas Plant Sliding Scale: Overview screen appears. In 
this case, select one of the gas plant sliding scales from the list.

OR

If only one record matches the data you entered, a single record is displayed.

Choose Change or Display to change or display the record as required.

To approve a gas plant sliding scale, at the Gas Plant Sliding Scale: Change screen, set the Approved indicator. 
Then choose Save .

 

6.7.3  Creating or Maintaining Plant Selective Processing 
Options 

Use

Use this transaction to set component options for selective plant processing so that components either are 
available for election by individual working interest owners, or default for non-electing owners. Component 
options include:

Ethane (C2)

Propane (C3)

Iso-Butane (IC4)

Normal-Butane (NC4)

Pentane Plus (C5+)
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Selective processing works in the unit of moles.

Procedure

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Sales and Balancing 
→ Contractual Allocations → Gas Plant Processing → Plant Selective Processing

The Plant Selective Processing Options: Initial Screen appears.

Choose Create .

The Plant Selective Processing Options: Create screen appears.

Enter the delivery network and the effective from and to dates. Then select the possible components for 
election and/or the defaults for non-electing owners, as required.

Select a component in the Possible Components for Election to indicate that the component is available for 
election by individual working interest owners. A component that is not selected in the Possible Components 
for Election section will not be available for election; owners will not have a choice to include components that 
are not selected here in the NGLs.

Select a component in the Defaults for Non Election Owners to apply elections when the owner is not 
maintained in Owner Processing.

Save your selection(s).

Using a Reference to Create Plant Selective Processing Options

To create components options with reference to an existing record, at the Selective Processing: Initial Screen , 
enter data as required. Then choose Execute .

If more than one record matches the data you entered, the Plant Selective Processing Options: Overview screen 
appears. In this case, select one of the records from the list.

OR

If only one record matches the data you entered, the single record is displayed.

Choose Create to create a new record with the data from the record you selected.

Changing or Displaying Plant Selective Processing Options

To change or display component options, at the Plant Selective Processing Options: Initial Screen , enter the 
delivery network hierarchy node or the delivery network, as well as the effective from and to dates. Then 
choose Execute .

2. If more than one record matches the data you entered, the Plant Selective Processing Options: Overview 
screen appears. In this case, select one of the records from the list.

OR

If only one record matches the data you entered, the single record is displayed.
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Changing data for previously allocated and closed networks generates prior period adjustment notification for 
natural gas liquids and residue.

Choose Change or Display to change or display the record as required.

6.7.4  Creating or Maintaining Owner Selective Processing 

Use

Use this transaction to maintain component options for owners. Component options include:

Ethane (C2)

Propane (C3)

Iso-Butane (IC4)

N-Butane (NC4)

Pentanes+ (C5+)

This transaction is associated with the Plant Selective Processing transaction, which determines the 
components that are available for election by a working interest owner.

This Owner Selective Processing Options transaction records an owner’s election of the available components. 
If an owner’s elections are not maintained in this transaction, the default elections specified in the Plant 
Selective Processing Options transaction are then applied to the owner.

When an owner elects components, it is not guaranteed that the owner will receive entitlements in natural gas 
liquids (NGLs). NGL entitlements are based on total elected volume compared to total NGL volume.

When the total elected volume is less than the total physical NGL volume, owners who did elect receive all of 
their entitlements in NGLs, while owners who did not elect receive a portion of their entitlement in NGLs and 
residue.

When the total elected volume is greater than the total physical volume, owner who elect receive a portion of 
their entitlements in NGLs and residue, while owner who do not elect receive all of their entitlements in residue.

When the total elected volume is zero, owners receive a portion of their entitlements in NGLs.

Procedure

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Sales and Balancing 
→ Contractual Allocations → Gas Plant Processing → Owner Selective Processing

The Owners Selective Processing Options: Initial Screen appears.

Choose Create .
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The Owner Selective Processing Options: Create screen appears.

Options for Creating Owner Selective Processing Options

Table 57:

Function Follow-on action

To enter owner selective processing options for a measure­
ment point

Choose Measurement Point

To enter owner selective processing options for a well com­
pletion

Choose Well Completion

 

Enter the following data:

delivery network

measurement point or well completion

owner information

production month

Choose Enter to refresh the screen. Then select the components for election as required. Finally, save your 
selection(s).

See also:

Creating or Maintaining Plant Selective Processing Options [page 242]

Using a Reference to Create Owner Selective Processing Options

To create owner selective processing options with reference to an existing record, at the Owner Selective 
Processing Options: Initial Screen , enter data as required. Then choose Execute .

If more than one record matches the data you entered, the Owner Selective Processing Options: Overview 
screen appears. In this case, select one of the records from the list.

OR

If only one record matches the data you entered, a single record is displayed.

Changing data for previously allocated and closed networks generates prior period adjustment notification for 
natural gas liquids and residue.

Choose Create to create a new record with the data from the record you selected.

Changing or Displaying Owner Selective Processing Options

To change or display plant selective processing options, at the Owner Selective Processing Options: Initial 
Screen , enter data as required. Then choose Execute .

The Owner Selective Processing Options: Overview screen appears.
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If more than one record matches the data you entered, the Owner Selective Processing Options: Overview 
screen appears. In this case, select one of the records from the list.

OR

If only one record matches the data you entered, the single record is displayed.

Choose Change or Display to change or display the record as required.

Changing data for previously allocated and closed networks generates prior period adjustment notification for 
natural gas liquids and residue.

6.8 Using Entitled Volumes Inquiry 

Use

Use this inquiry to retrieve a list of termination points with entitled volumes.You can use the inquiry to retrieve a 
list of entitled volumes for either primary products (oil, gas, or condensate) or plant products.

The inquiry provides a real-time overview.

Procedure

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Sales and 
Balancing Contractual Allocations Entitled Volumes Inquiry  .

The Entitled Volumes Inquiry - Primary Products screen appears.

If you would like to use the inquiry to search for plant products, choose Search Plant Products .

Enter data as required.Set the frequency if you are using the inquiry for primary products, or set the lease / 
plant indicators if you are using the inquiry for plant products.Choose Execute .

The Entitled Volumes Inquiry - <Primary or Plant> Products screen appears.

To review details about a network’s allocated volume, select the row for the network you want to review, and 
then choose Details .

Exit the function.
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6.9 Using the Contract Results by Termination Point Inquiry

Use

Use this inquiry to display contract-level allocation results from Sales Point Originated or Division Order Sales 
methods, or to display contract-level volumes and energy from manual entry methods.

Procedure

1. At the SAP Easy Access screen, choose Logistics  Production and Revenue Accounting  Sales and 
Balancing  Contractual Allocations  Contract Results Inquiry  .

2. The Contract Results by Termination Point Inquiry screen appears.
3. Enter data as required and choose Execute .
4. The Contract Results by Termination Point screen appears.
5. Review the allocation results for each phase. Then exit the function.

6.10 Using the Allocated Volumes Inquiry 

Use

Use this inquiry to retrieve a list of termination points with allocated volumes for a delivery network.You can use 
the inquiry to retrieve a list of allocated volumes for either primary products (oil, gas, or condensate) or plant 
products.

The inquiry provides a real-time overview.

Procedure

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Sales and 
Balancing Contractual Allocations Allocated Volumes Inquiry  .

The Allocated Volumes Inquiry - Primary Products screen appears.

If you would like to use the inquiry to search for plant products, choose Search Plant Products .

Enter data as required, noting the frequency if you are using the inquiry for primary products, or noting the 
lease / plant indicators if you are using the inquiry for plant products.Choose Execute .

The Allocated Volumes Inquiry - <Primary or Plant> Products screen appears.
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To review details about a network’s allocated volume, select the row for the network you want to review, and 
then choose Details .

Exit the function.

6.11 SPF NGL Component Allocation Basis 

Use

Use this transaction to set up a link between a natural gas liquid (NGL) material code and a gas material code, 
which the system uses as a basis for allocating NGL/residue.

Prerequisites

● You use this transaction for a component-level delivery network.
● You set a delivery network at a component level by selecting the Component Level indicator at the 

Contractual Allocation tab of the Delivery Network Dated transaction ( Logistics  Production and 
Revenue Accounting Sales and Balancing Delivery Network Dated  ).

Procedure

At the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Contractual 
Allocations Master Data SPF NGL Component Allocation Basis  .

The SPF NGL Component Allocation Basis: Maintenance screen appears.

In the NGL Mat field, specify the NGL material to be allocated.Then in the Gas Basis field, specify the gas 
material, which the system uses as a basis for allocating NGL/residue.

Save your entries.

6.12 SPF Wet Gas Equivalent 

Use

Use this transaction to specify a wet gas component material to use as a basis for allocating a natural gas liquid 
(NGL) material that was specified on the plant statement.
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The system uses the production results of the wet gas component material as the allocation basis for the NGL 
material.

Prerequisites

● You use this transaction for a component-level delivery network.
● You set a delivery network at a component level by selecting the Component Level indicator at the 

Contractual Allocation tab of the Delivery Network Dated transaction ( Logistics Production and 
Revenue Accounting Sales and Balancing Delivery Network Dated  ).

Procedure

At the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Contractual 
Allocations Master Data SPF Wet Gas Equivalent  .

The SPF Wet Gas Equivalent: Maintenance screen appears.

In the NGL Mat field, enter the NGL material that was specified on the plant statement.Then choose Create .

The SPF Wet Gas Equivalent: Create screen appears.

In the Gplt Cmpnt field, enter the wet gas component material to use as a basis for allocating the NGL.

Save your entries.

Note
You can enter multiple wet gas component materials, in which case the system would sum up the production 
results of the multiple materials to determine the basis for the NGL.

6.13 Specifying a Summary Material for a Detail Material 

Use

Use this transaction so that the system can determine pricing for a detail material when processing NGLs on 
full plants through Contractual Allocation at a component level.

Normally, the system does not store prices at the level of a detail material; rather, the system stores pricing 
data for summary materials. Therefore, in this transaction, you specify the summary material to be associated 
with a detail material.

However, if you do not specify a summary material to be associated with a detail material, then the system 
does not summarize the volume of the detail material.
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Procedure

At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Sales and Balancing → 
Contractual Allocations → Gas Plant Processing → Material Sum – Gas Plant Comp Alloc

The Material Summary for Gas Plant Component Allocation: Maintenance screen appears.

In the Detail Material field, enter the detail material to be linked to the summary material. Then choose Create

The Material Summary for Gas Plant Component Allocation: Create screen appears.

In the Summary Mat field, enter the summary material to which the Detail Material will be linked.

The system uses the summary material to sum the volumes of the detail material that you specified (as well as 
any other detail materials that are linked to it) for pricing purposes in Valuation.

Save your entries.

6.14 Sliding Scale Methods – Dim Material 

Use

Use this transaction to specify a particular material for a sliding scale method.

Prerequisites

The sliding scale method to which the material will be linked is set up.To set up a sliding scale method, in 
Customizing choose Industry Solution Oil & Gas (Production and Revenue Accounting) Sales and Balancing
Define Sliding Scale Properties  .

Procedure

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Sales and 
Balancing Contractual Allocations Gas Plant Processing Sliding Scale Methods – Dim / Materl  .

The Sliding Scale Methods – Dimension / Materials: Maintenance screen appears.

In the Dim cd , enter the sliding scale method.Then in the Material field, enter the material for the sliding scale 
method.

Save your entries.
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7 Product Control 

Purpose

Overview

The Production Control application component represents the forecasting of product volumes available for sale 
for each working interest owner in a producing entity.

The forecasting of volumes enables each owner to begin the process of matching the respective supply for sale 
to the demand for volumes at the first custody transfer point from the production area. Volumes are nominated 
daily at the custody transfer point as a means for the facility operator to manage the volumes to be shipped 
from their location.

During the month of actual product flow, producing operators compare the daily nominated volumes with the 
actual daily flows. When discrepancies are found between the nominations and actual flows, the facility 
operator requires a nomination adjustment as communication for the anticipated overage or shortage which 
may or may not be allowed.

At the end of the producing month, the nominated volumes are used as a basis for calculating adjusted 
entitlements for each working interest owner.

The adjusted entitlements:

● Represent the intended sales percentage of the monthly flow for that month
● Are used as a basis in the sales volume allocation process for calculating owner sales when the owners are 

nominating the volumes as a group and not individually

Objectives

The Product Control application area has the following objectives:

● Generating producer nominations that are submitted either to pipelines directly or to a third-party 
marketing company

● Calculating adjusted gross revenue interest (GRI) percentages that are later used by the Contractual 
Allocation

Integration

The following integration features are related to the Ownership application component:

● The system retrieves all working interest owners (WIOs) that exist as vendors from the corresponding 
venture/division of interest (DOI) marketing group.

● The system retrieves all marketing representatives that exist as customers from the corresponding 
venture/DOI marketing group.

● The system calculates each WIOs gross revenue interest using burden groups that are set up for venture/
DOIs with carried WIOs.

There are also integration features related to the Production application component:
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● The system retrieves the unit of measure for each well completion and measurement point from the 
corresponding delivery network’s unit of measure group.

● The system retrieves gas sales contracts that are tied to gas sales points with the Measurement Point / 
Well Completion to Transporter Cross Reference transaction

Features

The process of generating producer nominations and calculating adjusted GRI starts with entering forecasted 
production volumes (by well completion, measurement point, or a representative well completion). The 
forecasted production volumes are allocated first to the working interest owners in the associated division of 
interest. The result is owner entitlements , which represent the volume that each owner is entitled to sell each 
day of the forecasted production month. Owner entitlements can be adjusted to account for makeup 
situations, when underproduced owners receive volume for a production month, as well as for not selling 
situations, when an owner either lacks approved marketing arrangements or has produced beyond reserve.

The owner entitlements are aggregated to the marketing representatives . The owner entitlements are then 
distributed to the gas sales contracts associated with each marketing representative. Next, original 
producer nominations and a template to allow daily nomination tracking are created. Changes to the 
aggregate volume for a marketing representative/contract/transporter combination in the daily template 
during the production month generate nomination changes , which are important in minimizing pipeline 
penalties.

Following the production month, a final adjusted GRI percentage based on nominations is calculated for each 
working interest owner and is used by Contractual Allocation.

Product Control Process
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Results of the Product Control Process

● The final adjusted GRI based on nominations is calculated for each working interest owners
● An interface sends availability information to Contractual Allocation
● Once availability information is sent to CA, it cannot be changed in Product Control
● In CA, availability can be modified with the Revised Owner Availability transaction

7.1 Creating Capacity

Use

This transaction provides the means to collect and maintain estimated daily flow volumes for one of the 
following over a forecast month:

● a well completion
● a representative well completion, which represents other wells on the venture/division of interest (DOI)
● a measurement point

The data entered in this transaction serves as the basis for forecasted production volumes by well completion, 
measurement point, or representative well completion.
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Note

You can enter data into this transaction using the Capacity Roll - Measurement Point or Well Completion 
transactions. These transactions take forecasted production volume from one month and copy it to the 
following production month.

Within this transaction, fluctuations can be recorded when the estimated production volume is expected to 
fluctuate during a production month.

Prerequisites

● The unit of measure group for the delivery network contains exactly one unit of measure for the volume 
dimension, and exactly one unit of measure for the energy dimension.

● The well completion or measurement point is established as a node in the corresponding delivery network.
● The well completion or measurement point is associated with a default venture/division of interest (DOI). 

(See the DOI to Well Completion Cross Reference procedure or the DOI to Measurement Point Cross 
Reference procedure, respectively.)

Procedure

1. At the SAP Easy Access screen, choose Logistics  Production and Revenue Accounting  Sales and 
Balancing  Product Control  Capacity  Create.

2. The Create Capacity: Initial Screen appears.
3. To enter data for a measurement point, choose Measurement Point . Enter data as required and choose 

Enter .
4. The Create Capacity: Overview screen appears.
5. Enter data as required.

6.
If you want to establish a well completion to represent other wells on the venture/DOI, set the 
Representative Well indicator. Using a representative well, a single accumulated, estimated production 
volume can be assigned to all the well completions on a property DOI or unitized property.
This is useful in cases when estimated production volumes are either not known or are too small to report 
individually.
When the indicator is set, the system then maintains availability information only for the representative 
well or for a subset of wells in the venture/DOI.

7. If you need to forecast downtime, choose Estimate Fluctuations . Then at the Create Capacity Estimate 
Fluctuations dialog box, enter the start and end dates for the corresponding sales volume(s) and choose 
Enter to return to the Create Capacity: Overview screen.

Note
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All fluctuation volumes must be entered with the same unit of measure. Also, start dates in existing 
fluctuation date ranges cannot be changed. To modify the date range, delete the line containing the date 
range that needs to be changed, and insert a new line to enter the new date range.

1. To direct the system to use capacity information available for an owner's percentage in order to extrapolate 
availability for the entire well, choose the Net Quantity indicator.

2.
The Net Quantity indicator is for use when non-operated wells only.
The system calculates the entire well capacity by taking the amount of the owner's share divided by the 
owner's GRI percentage, which results in the amount of the entire well capacity. The system then creates 
availability based on the capacity amount it extrapolated for the entire well.

3. Review the average daily volume. Also review the standard daily volume, which is based on the average 
daily volume. Finally, review the amount of energy, which is based on the standard daily volume.

4.
If fluctuations are estimated, the average daily volume is calculated from the fluctuations.

5. Save your entries.

Result

When the Create Capacity transaction is saved, the standard system automatically generates availability, 
sourcing, and transporter ranking records.

See also:

Creating Capacity with Capacity Roll - Well Completion [page 255]

Creating Capacity with Capacity Roll – Measurement Point [page 255]

7.2 Creating Capacity with Capacity Roll - Measurement 
Point 

Use

Use this transaction to copy forecasted production volumes from one month to another month when 
appropriate.
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Procedure

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Sales and 
Balancing Product Control Capacity MP Capacity Roll  .

The Capacity Roll - Measurement Point screen appears.

In the Roll From Month field, enter the month and year from which forecasted production volumes will be 
copied.

In the Roll To Month field, enter the month and year that will contain the copied data.

Choose Execute .

7.3 Creating Capacity with Capacity Roll - Well Completion 

Use

Use this transaction to copy forecasted production volumes from one month to another month when 
appropriate.

Procedure

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Sales and 
Balancing Product Control Capacity WC Capacity Roll  .

The Capacity Roll - Well Completion screen appears.

In the Roll From Month field, enter the month and year from which forecasted production volumes will be 
copied.

In the Roll To Month field, enter the month and year that will contain the copied data.

Choose Execute .

7.4 Creating or Maintaining Availability Grouping 

Use

Use this transaction to maintain cross references between capacity points and an availability point for an 
effective monthly period. Capacity points are grouped to an availability point, and all the capacity points within 
an availability point must be tied to the same delivery network and venture/division of interest (DOI).
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In order to create availability, a capacity point must be assigned to an availability point within the effective 
period.

Procedure

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Sales and Balancing 
→ Product Control → Availability Grouping

The Availability Grouping: Initial Screen appears.

Choose Create .

The Availability Grouping: Create screen appears.

Options for Entering Availability Grouping Data

Table 58:

Function Follow-on action

To create an availability grouping for a well completion Choose Well Completion

To create an availability grouping for a measurement point Choose Measurement Point

 

Enter the following data:

delivery network

well completion or measurement point

effective from date

Choose Enter to refresh the screen.

Enter well completion or measurement point data as required.

If you are entering measurement point data, choose Add Capacity Points to group multiple capacity points to 
one availability point (that is, a measurement point). This grouping generates the structure required for 
reporting at the availability point level.

Save your entries.

Using a Reference to Availability Groupings

To create an availability grouping with reference to an existing record, at the Availability Grouping: Initial Screen , 
enter data as required. Then choose Execute .

The Availability Grouping: Overview screen appears.

Select one of the records from the list.

Choose Create to create a new record with the data from the record you selected.

Changing or Displaying Availability Groupings
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To change or display availability groupings, at the Availability Grouping: Initial Screen , enter data as required.

The Availability Grouping: Overview screen appears.

Select one of the records from the list.

Choose Change or Display to change or display the record as required.

 

7.5 Maintaining Availability 

Use

The availability record results from the Create Capacity transaction. When the Create Capacity transaction is 
saved, the standard system automatically generates an availability record. Therefore, creating an availability 
record is not an option; only changing and displaying are options for availability records.

Availability refers to owner entitlements, and availability is maintained at the 8/8ths level by capacity point. 
Original entitlements are calculated based on each owner’s gross revenue interest, as established in the 
associated division of interest.

Original entitlements cannot be edited; however, they can be indirectly modified to account for makeup and not 
selling scenarios. When an owner’s original entitlement is modified, the result is the owner’s adjusted 
entitlement.

Prerequisites

The venture/division of interest (DOI) for the well completion or measurement point has a marketing group.

If the DOI contains a carried working interest owner, then the venture / DOI has a burden group as well.

The burden group is required to correctly calculate the gross revenue interest for each owner.

Procedure

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Sales and Balancing 
→ Product Control → Availability → Change

The Change Availability: Initial Screen appears.

Enter data as required and choose Enter .

The Change Availability for <date>: Overview screen appears.
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Enter data or make changes to the data as required.

When availability for the previous production month exists, the Payback, Makeup, and Not selling indicators 
default as selected. However, when capacity is created with Capacity Roll, these indicators default as selected 
based on the month before the Roll To month. The indicators do not default as selected based on the Roll From 
month.

Table 59:

Payback (indicator) Makeup volume

Payback percentage Not selling

Payback volume Swing (indicator)

Makeup (indicator) Swing volume

Choose Recalculate Avails to refresh the screen with the results of the changes you entered.

If you decide that you do not want to keep the changes, cancel the transaction.

Save the availability data.

 

 

7.6 Maintaining Multiple Sales Sourcing 

Use

The multiple sales sourcing record results from the Create Capacity transaction. When the Create Capacity 
transaction is saved, the standard system automatically generates a multiple sales sourcing record. Therefore, 
creating a multiple sales sourcing record is not an option; only changing and displaying are options for multiple 
sales sourcing records.

Gas marketing representatives may have multiple gas sales contracts (spot and/or dedicated) valid for a single 
production month. When there are multiple gas sales contracts, allocation percentages are required entries to 
determine how gas is sold under each contract. These allocation percentages specify the percentage of a 
marketing representative’s available volume that is sold under each contract.

If a marketing representative has only one contract on one sales point, it is assumed that the total adjusted 
entitlement volume is allocated to that contract.
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Prerequisites

Each marketing representative is set up as a customer.

Each marketing representative has at least one gas sales contract for the production month.

Each gas sales meter has an allocation profile for monthly sales in the Production application area.

Each gas sales contract is linked to a gas sales meter, and each gas sales meter is linked to a transporter. (See 
the Measurement Point to Transporter Cross Reference transaction.)

Each transporter is set up as either a customer or vendor.

Contract diversity is required.

Procedure

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Sales and Balancing 
→ Product Control → Multiple Sales Sourcing → Change

The Change Multiple Sales Sourcing: Initial Screen appears.

Enter data as required and choose Enter .

The Change Multiple Sales Sources for <date>: Overview screen appears.

In the Alloc. Percent field, enter the allocation percentage.

An allocation percentage defaults from the previous production month when:

(1) sourcing exists for the previous production month, and

(2) the current sales contracts for a marketing representative are the same as the previous month’s sales 
contracts.

When a marketing representative has only one sales contract for the production month, the allocation 
percentage defaults to 100.

When capacity is created with Capacity Roll, allocation percentages that default are based on the month before 
the Roll To month. The allocation percentages do not default based on the Roll From month.

Save the multiple sales sourcing transaction.

See also:

Creating a MP / WC Transporter Cross Reference [page 117]
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7.7 Maintaining Transporter Rankings 

Use

The transporter ranking record results from the Create Capacity transaction. When the Create Capacity 
transaction is saved, the standard system automatically generates a transporter ranking record. Therefore, 
creating a transporter ranking record is not an option; only changing and displaying are options for transporter 
ranking records.

Use this transaction to specify the order in which gas is delivered to each of the pipelines for split connect 
delivery networks (that is, delivery networks with multiple pipelines).

Rankings are required only for split connected wells, because wells that are single connected to one pipeline 
default to a ranking of one (1).

Prerequisites

Each gas sales meter has an allocation profile in the Production application area for monthly sales.

Each gas sales meter is linked to a transporter in the Production application area. (See the Well Completion / 
Measurement Point Transporter Cross Reference procedure.)

Procedure

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Sales and Balancing 
→ Product Control → Transporter Ranking → Change

The Change Transporter Ranking: Initial Screen appears.

Enter data as required and choose Enter .

The Change Transporter Ranking: Maintenance Screen appears.

In the Rank field, enter the rank for the measurement point to specify the order in which gas is delivered to 
each of the pipelines.

For concurrent flow, the default ranking should be set to zero. For non-allocated networks, the ranking is always 
set for concurrent flow, and it is not changeable.

When rankings default from the previous production month when:

(1) ranking exists for the previous production month, and

(2) the current sales points for a delivery network are the same as the previous month’s sales points
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When capacity is created with Capacity Roll, transporter rankings that default are based on the month before 
the Roll To month. The rankings do not default based on the Roll From month.

 

Save the transporter ranking.

See also:

Creating a WC / MP Transporter Cross Reference [page 117]

 

7.8 Using the Validations and Exceptions Report 

Use

Use the exceptions report to identify the entries that are required to complete the Create Original 
Nominations / Create Daily Availability process.

The exceptions report consists of a list of exceptions generated by the validation function. The exceptions 
represent changes made in other areas of PRA that affect the integrity of product control data, and reflect 
problems in the process of creating availability.

Examples of changes in other areas of PRA modules that may result in exceptions include: ownership transfers, 
marketing group changes, contract changes, contract / measurement point cross-reference changes, and 
measurement point allocation profile changes.

Features

To create a list of exceptions, the validations process:

Recreates availability

Compares the newly recreated availability with the existing availability

Returns any errors or warnings.

If no errors occur for availability, the validations process goes on to:

Recreate multiple sales sourcing

Compare the newly recreated multiple sales sourcing with the existing multiple sales sourcing

Returns any errors or warnings.

If no errors occur for sales sourcing, the validations continues the comparison process for transporter 
rankings.
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Activities

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Sales and Balancing 
→ Product Control → Run Validations & View Exceptions

The View Exceptions screen appears.

Choose Run Validation to generate exceptions for a particular production month. Information is validated 
without creating exceptions.

The validation process creates exceptions for: ownership transfers, contract changes, and contract / 
measurement point cross references.

Once data is validated, enter the production month and choose Execute .

The Exceptions Report screen appears.

To resolve an exception, select the required row and choose Resolve Exception . Then choose Back to return to 
the View Exceptions screen.

Choose View Exceptions to return to the Exceptions Report .

Enter data as required and determine whether the scope of the list is for operated or non-operated, or both. 
Then choose Execute .

Review the list of exceptions generated by validation. Review message text for detailed information about why 
an exception was generated.

Messages may indicate problems encountered in the process of creating availability.

Exit the report.

 

 

 

7.9 Creating Daily Availability and Nominations

Use

Executing this transaction creates:

● daily availability
● a nomination file

After this transaction is executed, the daily availability data is then available through other Product Control 
transactions, and the original nomination data is sent to ALE.
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Also, once the transaction is executed, availability and capacity cannot be changed for the production month.

Procedure

1. At the SAP Easy Access screen, choose Logistics  Production and Revenue Accounting  Sales and 
Balancing  Product Control  Create Daily Availability & Noms  .

2. The Create Daily Availability screen appears.
3. Enter the production month and choose Execute .

7.10 Maintaining Daily Availability 

Use

Use this transaction to maintain daily volumes for all availability points during the production month. You can 
maintain daily volumes at either an availability point level or at the owner level.

Procedure – Changing Daily Volumes for an Owner

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Sales and Balancing → 
Product Control → Daily Availability → Change

The Change Daily Availability: Initial Screen appears.

Enter data as required. Then choose Enter .

The Change Daily Availability for <Month/Year>: Overview screen appears.

To change daily volumes for an owner, select one of the Day 1 to Day 30 columns. Then select Edit Daily Avails .

Selecting Edit Daily Avails changes the status of the column from display to change in order to allow you to 
change the way the day’s total is distributed among owners.

Change the volumes as required.

To manually redistribute volumes, select Allocate Manually . When you choose this, you must manually 
redistribute volumes for all of the owners on the selected day so that they add up to the day’s total.

If you subtract 5 from the first owner, you must add 5 manually to another owner, or a combination of other 
owners, so that the total for the day remains the same.
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To check that the volumes add up to the day’s total, choose Recalculate Daily Avails .

To have the system automatically redistribute volumes, select Allocate to Non-Zero Interest Owners . Then 
change the volume for one or more owners on the selected day and choose Recalculate Daily Avails . The 
system then automatically allocates the remainder to the non-zero interest owners whose volumes have not 
changed.

If you add 5 to one owner and choose Recalculate Daily Avails , they system subtracts 5 from the remainder of 
the non-zero interest owners so that the day’s total remains the same.

To apply changes made for a single day to a range of days, choose Cascade Changes .

If you change day 3 in June 2001 and would like to apply the changes from June 4 to June 10 as well, you would 
choose Cascade Changes . Then in the Cascade Changes dialog box, you would enter 06/04/2001 to 
6/10/2001. The system then copies the changes made in day 3 to days 4, 5, 6, 7, 8, 9, and 10.

Save the entries.

Procedure – Changing Daily Volumes for an Availability Point

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Sales and Balancing → 
Product Control → Daily Availability → Change

The Change Daily Availability: Initial Screen appears.

Enter data as required. Then choose Enter .

The Change Daily Availability for <Month/Year>: Overview screen appears.

To change the amount for one day’s total (also known as the Availability Point Volume) or for multiple days at 
the same time, choose Edit Avail Point Vol .

The Edit Availability Point Volume dialog box.

Enter data as required.

When the new volume/total is changed, the system distributes the new volume to owners using the same 
distribution percentage as the old volume.

The Day 1 total=100 where Owner 1=25 and Owner 2=75. If you choose Edit Avail Point Vol and change the Day 1 
total to 200, the system automatically allocates Owner 1=50 and Owner 2=150.
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If required, change the effective date range. Choose Enter to return to the Change Daily Availability for <month/
year>: Overview screen.

Save the changes.

Result

If you make changes with this transaction that result in an overall volume changes for a marketing 
representative/transporter combination, the system generates Nomination Changes records, which you can 
review before submitting with the Review Nomination Changes [page 267] transaction.

7.11 Sales Point Adjustments 

Use

Use this transaction ( Logistics Production and Revenue Accounting Sales and Balancing Product 
Control Sales Point Adjustments  )to make nomination changes at the sales point level. Net changes are 
entered for a sales point (for example, -200, +100, and so on). Changes can be made for individual days within 
a production month.

Each change overrides the previous adjustment; the new adjustment is not a sum of the previous and new 
adjustment.

If sales point adjustments were created before the creation of original nominations, deletes are not allowed 
after the nomination changes. If sales point adjustments are created after the submission of original 
nominations, deletes are not allowed after nomination changes are sent.

Prerequisites

The Summary Level Nominations edit is set in the Activate Configurable Edits Customizing activity ( Industry 
Solutions Oil & Gas (Production and Revenue Accounting) Global Settings  ).

If this edit is not set, you will not be able to execute this transaction.

Activities

Note
Before entering adjustment data, you must choose Enter to lock the fields that come before the adjustment 
fields.
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7.12 Reviewing Nomination Changes 

Use

Use this transaction to review nomination changes before they are actually submitted. Reviewing nominations 
is useful in avoiding penalties that pipelines impose for incorrect nominations.

Nomination changes result from changes made in the Daily Availability transaction, and are created only when 
the total volume for a marketing representative / contract / transporter combination has changed.

Procedure

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Sales and 
Balancing Product Control Review Nomination Changes  .

The Review Nomination Changes screen appears.

Enter data as required and choose Execute .

The Review Nomination Changes screen appears.

Review the nomination changes.

See also:

Maintaining Daily Availability [page 264]

7.13 Submitting Nomination Changes 

Use

Nomination changes result from changes made in the Daily Availability transaction, and are created only when 
the total volume for a marketing representative / contract / transporter combination has changed.

Use this transaction to generate a nomination change notice by selecting the nomination changes to be 
included in the notice.The nomination notice is sent to the appropriate pipeline as required using Application 
Link Enabling (ALE).

Multiple nomination change notices can be created for each date in the production month.

Prerequisites

You have determined at what level nomination changes are to be generated.
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Note
You can configure nomination changes to be generated at a sales point level or at a termination point level.

To configure nomination changes, in the IMG choose Industry Solution Oil & Gas(PRA) GlobalSettings
Activate Configurable Edits.  .If the Enable summary level product control nominations indicator is set, 
nominations are generated at a sales point level.

Procedure

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Sales and 
Balancing Product Control Submit Nomination Changes  .

The Submit Nomination Changes screen appears.

Enter data as required and choose Execute .

The Submit Nomination Changes screen appears.

Select the rows for the nominations that are to be included in the nomination change notice and then choose 
F8 to generate the nomination change notice.

Choose Print to generate a hard copy that can be sent to the pipeline.

See also:

Maintaining Daily Availability [page 264]

7.14 Run the Contractual Allocation Interface 

Use

This transaction sends the final adjusted gross revenue interest amount to the Contractual Allocation 
application area.

The Product Control application area bases the calculation of the final adjusted gross revenue interest 
percentage on nominations for each working interest owner.

It is the last transaction to be executed in the Product Control monthly process.After this transaction is 
executed, daily availability cannot be changed in Product Control.

Procedure

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Sales and 
Balancing Product Control Run CA Interface  .
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The CA Interface screen appears.

Enter the production month, then choose Execute .

See also:

Maintaining Daily Availability [page 264]

7.15 Using the Availability by Owner Inquiry 

Use

Use this report to access all availability data across capacity points for one working interest owner.

Availability data is maintained at the 8/8ths level by capacity point.

Procedure

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Sales and 
Balancing Product Control Availability by Owner Inquiry  .

The Availability by Owner screen appears.

Enter the code for the owner and the production month.Then choose Execute .

The Availability by Owner screen appears.

Review the availability data.

Exit the function.
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8 Balancing Workplace 

Purpose

The Balancing Workplace ( Logistics Production and Revenue Accounting Sales and Balancing Product 
Balancing Balancing Workplace  ) is a single transaction in which you can carry out the following tasks.

● Creating, maintaining and displaying a product balancing agreement (PBA)
● Creating and maintaining a PBA to well completion / measurement point cross reference
● Creating and displaying manual adjustments
● Maintaining and displaying ownership transfers
● Generating, printing, and finalizing a monthly imbalance report

Functions

The Balancing Workplace comprises the following functions.

● Creating a Product Balancing Agreement (PBA) Master Record [page 271] – Used to create a record for 
the PBA legal document containing the specifications about how imbalances will be processed.

● Maintaining or Displaying PBAs [page 272] – Used to make changes to PBAs or to display PBAs.
● Creating or Maintaining a PBA WC / MP Cross References [page 273] – Used to maintain cross references 

between PBAs and either well completions or measurement points for a given monthly period.
● Creating a Manual Adjustment [page 274] – Used to make adjustments to an owner’s imbalance, such as a 

starting imbalance, which can be negative if required.
● Reviewing Adjustments and Owner Balance History [page 275] – Used to retrieve a list of adjustments to 

PBAs.Can also be used as an inquiry for an owner’s current balances.
● Reviewing Ownership Transfers [page 275] – Used to maintain the transfer of imbalances with an 

ownership transfer, and to retrieve a list of ownership transfers based on the selection criteria that you 
enter.

● Maintaining Transfer Settings and Retaining Imbalances Settings [page 276] - Used to specify whether the 
system should transfer imbalances to a new owner or to retain the imbalances of an old owner.

● Generating a Balancing Statement [page 277] – Used to generate and view monthly imbalance 
statements; you can generate a current report for each production month.

Note
To set up the Balancing Workplace so that upon opening the transaction after having closed it you return 
to the tab that you were last working on, go to System  User profile  Own data  .

Then choose the Parameters tab, and in the Parameters field, enter OIUBL01_WORKPLACE .Then save 
your entry.

● Balancing User Reports [page 279] - Used to run various utilities in order to verify and analyze the 
balancing data.
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8.1 Creating Product Balancing Agreement Master Records 

Use

Use this function to create master records for product balancing agreements (PBAs), the legal documents that 
contain specifications about how imbalances will be processed.

The PBA is used to generate reports about owner-level imbalances.

There can be multiple PBAs within a delivery network.

A measurement group enables the use of a PBA across networks.

Integration

The system obtains actual and entitled volumes from the Contractual Allocation (CA) application component 
and the entries in the Adjustments tab of the Balancing Workplace transaction.

The system adds manual adjustments to CA adjustments.

Procedure

1. From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Sales and 
Balancing → Product Balancing → Balancing Workplace

The Balancing Workplace screen appears.

1. Choose the PBA tab. Then choose Create .

The Balancing Workplace – Create screen appears.

1. Enter data as required.

In the field immediately to the right of the Effective To field, enter the year in which the PBA is effective.

To suppress the printing of a PBA, ensure that the External Rpt Flag is deselected. (The system generates 
reports only for those PBAs that have the External Rpt Flag selected.)

You define balancing product groups in Customizing within the Define/Maintain Balancing Product Groups 
activity, under Industry Solution Oil & Gas (Production and Revenue Accounting) → Sales and Balancing → 
Balancing Statement

Save your entries.

SAP Oil & Gas (PRA - Production and Revenue Accounting)
Balancing Workplace C U S T O M E R 271



Result

After you create a PBA master record, it must be linked to a well completion or measurement point. See 
Creating or Maintaining a PBA to WC/MP Cross Reference [page 273] for more details.

8.2 Maintaining or Displaying Product Balancing 
Agreements 

Use

Use this function either to make changes to a product balancing agreement (PBA) master record or to display 
a PBA master record.

Activities

At the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Sales and Balancing 
Product Balancing → Balancing Workplace

The Balancing Workplace screen appears.

Choose the PBA tab.

Enter the selection criteria for the system to use in order to retrieve the PBA(s).

In the PBA No field, enter the code for the PBA.

In the Effective From field, enter the month in which the PBA becomes effective.

In the field immediately to the right of the Effective From field, enter the year in which the PBA becomes 
effective.

In the PBA Group field, if the PBA is part of a PBA group, enter the code for the PBA group.

In the BlProduct Group field, specify the product group that applies to the PBA.

To retrieve report imbalances at the well completion or measurement point level, choose Detail Rpt Flg .

If there is a PBA number from a legacy system that you would like to reference, enter the legacy system 
number in the External PBA field.

In the Preparer Nm field, enter the name of the person preparing the PBA.

Choose Execute .

The system displays the PBA(s) that correspond with the selection criteria that you entered.
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8.3 Creating or Maintaining PBA to WC/MP Cross 
References 

Use

Use this function to maintain cross references between product balancing agreements (PBAs) and either well 
completions or measurement points for a given monthly period.

Activities

At the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Sales and Balancing 
Product Balancing → Balancing Workplace

The Balancing Workplace screen appears.

Choose the Master Data tab. Then choose the PBA to WC/MP Xref tab.

The Balancing Workplace – Change screen appears.

In the PBA No field, enter the PBA number.

To insert all well completions or measurement points that are linked to a division of interest into the PBA cross 
reference, choose Add Vent/DOI WC to PBA .

Enter the following data as required.

Either enter the well ID in the Well field and the well completion ID in the WC field, or enter the measurement 
point ID in the Measurement Point field.

You can attach a well/well completion or a measurement point to multiple PBAs as long as each PBA has a 
different product group.

In the From field, enter the month in which the cross reference becomes effective.

In the Year field, enter the year, corresponding to the month, on which the cross reference becomes effective.

In the To field, enter the month in which the cross reference becomes effective.

In the To field, enter the year, corresponding to the month, through which the cross reference is effective.

If you do not enter the effective to month and year, the system defaults the effective to month and year of the 
PBA.

6. Save your entries.
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8.4 Creating Manual Adjustments 

Use

This function makes adjustments to an owner’s imbalance, which can be negative if required. The system 
tracks adjustments as debit and credit entries are made in a ledger. That is, depending on whether the 
adjustment is negative or positive, the system adds to or subtracts from the current imbalance.

With the exception of manual adjustments, adjustments are system-generated.

Activities

At the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Sales and Balancing 
Product Balancing → Balancing Workplace

The Balancing Workplace - Display screen appears.

Choose the Adjustments tab. Then choose the Manual Adjustments tab.

Enter the following data as required.

Either enter the well in the Well field and the well completion in the Well Completion field, or enter the 
measurement point in the Measurement Point field.

Enter the balancing product group in the BlPRoductGroup field.

Enter the production month in the ProductionMonth field.

In the field immediately to the right of the ProductionMonth field, enter the year corresponding to the month.

Choose Change .

The Balancing Workplace – Change screen appears.

Enter the following data.

In the Owner field, enter the code for the owner.

In the Interest Type field, enter the type of ownership for the owner.

In the Own. ISQ , enter the owner’s sequence number, which differentiates between owner records.

In the Adjust. Reason field, enter a reason for the adjustment.

In the Adj. Quan field, enter the amount of the adjustment.

Save your entries.

If the balance of the adjustments is not zero, the system stores the data only temporarily and does not use the 
temporary data on a statement. The system also displays a red light next to the total when the balance is not 
zero.

274 C U S T O M E R
SAP Oil & Gas (PRA - Production and Revenue Accounting)

Balancing Workplace 



8.5 Reviewing Adjustments and Owner Balance History 

Use

Use this function to retrieve a list of adjustments to PBAs based on the selection criteria that you enter.

By retrieving the adjustments, you can review, for example, whether the system has run Contractual Allocation 
again, or whether manual adjustments have been entered.

This function can be used as an inquiry to an owner’s current and previous balances.Because it contains all 
adjustments ever made to an owner’s account, it also provides a history of an owner’s balances.

Activities

At the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Sales and 
Balancing Product Balancing Balancing Workplace  .

The Balancing Workplace - Display screen appears.

Choose the Adjustments tab.Then choose the Browse Adjustments tab.

Enter data as required to specify the selection criteria for the system to use in order to retrieve the 
adjustment(s).

Choose Execute .

The system displays adjustments and owner balance history that correspond with the selection criteria that 
you entered.

8.6 Reviewing Ownership Transfers 

Use

Use this function to retrieve a list of ownership transfers based on the selection criteria that you enter.

Unless specified otherwise, the system transfers all imbalances to the new owner.

For information about making settings to either transfer imbalances to a new owner or retain the imbalances of 
an old owner, see Maintaining Transfer Settings and Retaining Imbalances Settings [page 276] .
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Activities

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Sales and Balancing 
→ Product Balancing → Balancing Workplace .

The Balancing Workplace – Display screen appears.

2. Choose the Adjustments tab. Then choose the Ownership Transfers tab.

3. Enter data as required to specify the selection criteria for the system to use in order to retrieve the 
ownership transfer(s).

4. Choose Select .

The system displays ownership transfers that correspond with the selection criteria that you entered.

 

8.7 Maintaining Transfer Settings and Retaining Imbalance 
Settings 

Use

Use this function to specify whether the system should transfer imbalances to a new owner or retain the 
imbalances of an old owner.

Activities

At the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Sales and Balancing 
Product Balancing → Balancing Workplace

The Balancing Workplace – Display screen appears.

Choose the Adjustments tab. Then choose the Ownership Transfers tab.

Choose Select .

The system displays ownership transfers that correspond with the selection criteria that you entered.

Choose Change .

To specify that the old owner should retain imbalances at the time of transfer, select Retain Curr for the 
required record.

If you leave the Retain Curr indicator unselected, then any imbalances at the time of transfer are passed to the 
new owner.
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To specify that the old owner should retain any imbalances that are due to PPA activity during the months that 
the well was owned but that were entered into the system after the ownership transfer, select Ret PPA for the 
required record.

If you leave the Ret PPA indicator unselected, then these “after-the-fact” imbalances pass to the new owner.

Save your entries.

8.8 Generating Balancing Statements 

Use

Use this function to generate monthly imbalance statements. You can generate a current report for each 
production month.

The Balancing reporting functionality features a finalization feature. After you execute trial runs and determine 
that data for an imbalance statement is correct, you finalize the statement. The system keeps the last trial run 
as the final version and then rolls over any changes into the current report, thereby creating a previous balance 
(that is, a new starting imbalance) for the current month.

Further, if there is a change in Ownership, Contractual Allocation, or the PBA Cross Reference, the system 
changes the status of the statement from Current to Outdated .

The system prints a single current statement with all activity that occurred in the system since the last 
statement. When a prior period adjustment (PPA) occurs, you do not print an amended statement for each of 
the prior periods adjusted. Instead, the system rolls up any adjustments to previous production months into 
the current month’s statement.

For example, suppose the current month is June. In June you run the statement for May (the reporting month), 
which shows adjustments to the volumes in January (the production month).

After January’s production is adjusted in June (PPA activity), the system will not reprint separate statements 
for January, February, March, and April.

Instead, the system will print a single statement for May (per PBA) showing PPAs as adjustments to the current 
balance.

Activities

At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Sales and Balancing → 
Product Balancing → Balancing Workplace

The Balancing Workplace – Display screen appears.
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Choose the Balancing Statements tab.

Enter the following data as required.

In the ReportingMonth field, enter the month for which you will generate a balancing statement.

In the field immediately to the right of the ReportingMonth field, enter the year in which the PBA is effective.

In the BlProduct Group field, specify the product group that applies to the PBA.

A balancing product group comprises a combination of major and minor product groups. You define product 
groups in Customizing within the Define/Maintain Balancing Product Groups activity, under Industry Solution 
Oil & Gas (Production and Revenue Accounting) → Sales and Balancing → Balancing Statement.

If the PBA is part of a PBA group, enter the code for the PBA group in the PBA Group field.

Enter the number (or numbers) of the PBA(s) for which you want to generate a balancing statement.

To send the statement to the printing spool, select the Print to Spool indicator.

In the SmartForm field, enter the name of the SmartForm to be used in order to generate the balancing 
statement.

If you do not specify a SmartForm, then the system uses the default SmartForm.

You set the default SmartForm in Customizing at Industry Solution Oil & Gas (Production and Revenue 
Accounting) Sales and Balancing Balancing Statement → Maintain valid Smartforms for Balancing statement .

Choose Display Balancing Statements .

The system displays any PBAs that correspond with the selection with the selection criteria that you entered.

There are three PBA statuses:

-- Current, but not finalized – The PBA data is current and up-to-date.

-- Outdated – Indicates that the data has changed in one or more of the following areas since the report was 
last run.

Contractual Allocation

Manual Adjustments

Ownership Transfer

PBA Cross-reference

-- Finalized – The statement is stored in the system as a final version and can no longer be changed. If any 
changes occur in a previous production month, the system will incorporate the changes when the next report is 
run.

If you would like to manually set the status of a report to Outdated , select the row with the PBA number and 
then choose Outdated .
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To generate the imbalance report(s), select the row(s) with the PBA numbers(s) in the bottom left corner of the 
screen, and then either choose Generate Online to generate the reports online, or if there are multiple PBAs for 
which you are generating reports, you may want to choose Generate in Background to improve processing.

If you would like to print a statement showing changes that were entered after the statement was finalized, 
select the row(s) with the PBA number(s) in the bottom left corner of the screen and then choose Generate 
amnd. in Background .

The system sends the statement with the changes entered after finalization to the spool for printing. The 
system does not overwrite the original statement for that month.

To view the status of your jobs and use job overview functions, choose Jobs .

To view and print reports that you sent to the spool (reports are sent to the spool when the Print to Spool 
indicator is selected), choose Spool .

To display the balancing reports that correspond with a PBA, double-click on the row with the PBA number in 
the bottom left corner of the screen.

The system displays the balancing report(s) data that corresponds with a PBA.

To display imbalance details contained in a report, select a report and then choose Display Cum. Balances .

The system displays imbalance details such as the entitlement percentage, entitled and actual quantity, and 
adjustments by owner.

To display adjustments to a PBA, select a report and then choose Display Adjustments .

The system displays an adjustment details for the PBA, such as the adjustment type and adjustment quantity.

After you have verified the results, select the PBA and choose Finalize .

After you choose Finalize , the report can no longer be changed.

 

 

 

8.9 Balancing User Report 

Use

You use this report to:

● Run system verification utilities which include the following reports:
○ Contractual allocation, volume validation
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○ Historical ownership
○ Zero interest owners
○ Balancing exception report

● Control reports utilities which include the following reports:
○ Well/measurement point master data display
○ Owner balances by sales month

● Run partner reporting utilities which include the following reports:
○ Owner balances by the reporting month
○ Reprint product balancing agreement report

Activities

● To access the Balancing User Reports screen, go to the SAP Easy Access menu, choose Logistics
Production and Revenue Accounting Sales and Balancing Balancing User Reports  .

● Select the radio button for one of the Utility and choose Execute . The corresponding utility screen appears.

8.9.1   Running System Verification Utilities 

This section includes the following:

● Using Contractual Allocation (CA) Volume Validation Report [page 280]
● Using Historical Ownership Report [page 281]
● Using Zero Interest Owners Report [page 281]
● Using Balancing Exception Report [page 282]

8.9.1.1 Using Contractual Allocation (CA) Volume 
Validation Report 

Use

You use this report to verify the contractual allocation (CA) results reported in balancing workplace against the 
results reported in contractual allocation (CA).

Activities

You must do the following:

● Go to the Balancing User Report [page 279] screen.
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● Select the Contractual Allocation (CA) Volume Validation radio button and choose Execute . The 
Contractual Allocation (CA) Volume Validation screen appears.

● Enter the Balancing Product Group and Product Balancing Agreement (PBA) Number or PBA Group and any 
other additional selection criteria as required. Choose Execute .

● The Contractual Allocation (CA) Volume Validation Report appears. The report shows the records where 
there is discrepancy between contractual allocation (CA) results and the contractual allocation (CA) results 
reported in balancing.

● Review the differences columns.

8.9.1.2 Using Historical Ownership Report 

Use

You use this report to verify the beginning balance of a product balancing agreement (PBA) for the given 
reporting month with the last month’s ending balance. The balancing report status must be current or finalized 
for the given reporting month in order to use this report.

Activities

You must do the following:

● Go to the Balancing User Report [page 279] screen.
● Select Historical Ownership radio button and choose Execute . The Historical Ownership screen appears.
● Enter the Balancing Product Group , PBA Number , Reporting Month and any other additional selection 

criteria as required. Choose Execute .
The Historical Ownership report appears. The report shows the records where there is difference between 
beginning balance for the given reporting month and the last month’s ending balance.

● Review the differences column.

8.9.1.3 Using Zero Interest Owners Report 

Use

You use this report to list down the owners who have zero entitled interest (GRI) for the given month but who 
still hold the balances. The balancing report status should be current or finalized for the given reporting month 
in order to use this report.
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Activities

You must do the following:

● Go to the Balancing User Report [page 279] screen.
● Select Zero Interest Owners radio button and choose Execute . The Zero Interest Owners Report screen 

appears.
● Enter the Balancing Product Group , Product Balancing Agreement (PBA) Number , Reporting Month and 

any other additional selection criteria as required. Choose Execute . The Zero Interest Owners Report 
appears.
The report shows the owners who have zero entitled interest (GRI) for the given month but who still hold 
the balances.

● Review the Entitled Interest and Current Balance column.

8.9.1.4 Using the Balancing Exception Report 

Use

You use this report to generate a list of:

● Well completions and measurement points (MP) that have been allocated through contractual allocations 
(CA), but that are not attached to a product balancing agreement (PBA) for a specific month.

● Product balancing agreements (PBA) which do not have any well completions or measurement points 
attached for a specific month.

● Product balancing agreements for which PBA cross-references have changed for a specific month.
● Product balancing agreements which do not have any beginning balances.

Activities

● You can access Balancing Exception Report in the following 2 ways:

○ Go to the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Sales 
and Balancing Balancing Workplace  .The Balancing Workplace screen appears.
Choose Goto Exception Report  . The Balancing Exception Report screen appears.

○ Go to the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Sales 
and Balancing Balancing User Reports  . The Balancing User Reports screen appears.
Select Balancing Exception Report radio button and choose Execute . The Balancing Exception Report 
screen appears.

● Enter the production month and production year, and any other selection criteria as required.
● Select the radio button for one of the exception report and choose Execute . The corresponding Balancing 

Exception Report appears.
● Review the resulting list.
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8.9.2   Running Control Reports Utilities 

This section includes the following reports:

● Using Well/Measurement Point (MP) Master Data Display [page 283]
● Using Owner Balances by Sales Month Report [page 283]

8.9.2.1 Using Well/Measurement Point (MP) Master Data 
Display 

Use

You use this report to list down the product balancing agreement (PBA) cross-references and venture/ division 
of interest ( DOI) cross-references for given wells or measurement points (MPs).

Activities

● Go to the Balancing User Report [page 279] screen.
● Select Well/MP Master Data Display radio button and choose Execute . The Well/MP Master Data Display 

screen appears.
● Enter the Well , Well Completion or Measurement Point or PBA in the selection criteria. Choose Execute . 

The Well/MP Master Data Display Report appears.
● Review the list for venture/DOI information for the given Well , Well Completion or Measurement Point or 

PBA .

8.9.2.2 Using Owner Balances by Sales Month Report

Use

You use this report to display owner balances by sales month. The balancing report status should be current or 
finalized for the given sales month in order to use this report.

Activities

● Go to the Balancing User Report [page 279] screen.
● Select Owner Balances by Sales Month and choose Execute . The Owner Balances by Sales Month screen 

appears.
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● Enter the balancing product group, product balancing agreement (PBA) number, sales month, owner, 
owner sequence number and any other additional selection criteria as required.
Choose Execute . The Owner Balances by Sales Month Report appears.

● Review the list of adjustments for given PBA and sales month.
● Summarize the Adjustment Quantity column in order to get the owner balance on the given sales month.

8.9.3   Running Partner Reporting Utilities 

This section includes the following reports:

● Using Reprint Product Balancing Agreement (PBA) Statement [page 284]
● Using Owner Balances by Sales Report Month [page 283]

8.9.3.1 Using Reprint Product Balancing Agreement (PBA) 
Statement 

Use

You use this report to reprint the product balancing statement using your own smartform.

Activities

● Go to the Balancing User Report [page 279] screen.
● Select Reprint PBA Statement radio button and choose Execute . The Reprint PBA Statement screen 

appears.
● Enter the Balancing Product Group , PBA Number , Reporting Month , Smartform Name and any other 

additional selection criteria as required.Choose Execute . A pop-up window appears to ask for the printer 
parameters.

● Enter the printer parameters and select the checkbox. The hard copy of the PBA statement gets printed.

8.9.3.2 Using Owner Balances by Report Month 

Use

You use this report to display owner balances by report month. The balancing report status must be current or 
finalized for the given reporting month in order to use this report.
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Activities

● Go to the Balancing User Report [page 279] screen.
● Select Owner Balances by Report Month and choose Execute . The Owner Balances by Report Month screen 

appears.
● Enter the Balancing Product Group , PBA Number , Report Month , Owner , Owner Sequence Number and 

any other additional selection criteria as required.
Choose Execute . The Owner Balances by Report Month Report appears.

● Review the list of adjustments for the given PBA and report month.
● Summarize the Adjustment Quantity column in order to get the owner balance for the given report month.
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9 Valuation 

Purpose

The Valuation application area represents the process of valuing volumes for all products.Valuation utilizes 
various types of data to value volumes for all products and to calculate marketing and tax deducts , 
including volumetric, pricing, deduct, ownership, and accounting data.In addition, Valuation serves as the 
central point for processing prior period adjustments , and as the entry point for settlement statements .

The main areas of functionality for the Valuation application area are:

● Valuation Cross Reference (VCR) maintenance – maintenance for a link between the approved formulas 
and approved contracts, Production entities, Ownership entities, and marketing groups from Contractual 
Allocations

● The use of lists to process VCR approvals
● Formula maintenance
● Internal marketing rates and tax master data maintenance
● Settlement statements and oil and gas run statements
● Current selection – allows a user to manually select a network that is not set up to be processed 

automatically, and it allows the final processing status to be overridden if necessary
● Prior period selections
● Reject maintenance
● Job submission
● Job reporting

Integration

The Valuation application area requires product sales information from the Production application area or the 
Contractual Allocation application area; pricing information from contracts; and ownership, venture, and 
division of interest accounting information from division orders.

After summarizing data, the Valuation application area then transmits it to the Revenue Distribution and Tax 
and Regulatory Reporting application areas.
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9.1 Valuation Formula 

Use

Formulas use volume, ownership, and rates data, as well as formula master data, to calculate values.

Formulas are essential to Valuation processing; only a formula can attribute a calculated value to a volume of 
oil, gas, or natural gas liquid sold.Further, only a formula can apply the costs or reimbursements associated 
with the expenses of marketing a product to a calculated value.

All non-pricing reserve words and calculations are processed in Production Revenue Accounting (PRA), while 
data such as contract, well, measurement point, and material numbers are sent to Sales & Distribution to 
obtain prices and values.

Sales & Distribution provides the ability to extract pricing information from any contract, including contracts 
maintained at either a measurement point or well completion level.Further, Sales & Distribution serves as the 
repository for postings and gravity scales.
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Integration

Features

Marketing Costs

Marketing formulas feature the ability to process marketing costs with a variety of marketing formula reserve 
words.This supports situations when owners negotiate marketing amounts to be added or subtracted from 
their interest.

Marketing costs may or may not be included in taxable value.
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9.1.1  Creating Formula IDs 

Use

Use this transaction to set up an ID for a formula to be created. The formula contained within the ID can change 
over time, because each formula is effective dated. The ID itself, however, remains the same.

Procedure

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Sales and Balancing 
→ Revenue Accounting → Valuation → Valuation Formula ID → Create

In the Formula ID field, enter an ID code for the formula. It may be alphanumeric. Then choose Enter .

The Create Formula ID - Overview screen appears.

In the Formula ID <name> field, enter a description for the formula ID. Then enter other data as required.
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Set the Calculation Indicators as required. To determine what calculation should be executed in the formula, 
choose one of the following.

Options for Setting Calculation Indicators

Table 60:

To calculate Set the indicator(s)

Actual volumes Actual

Entitled and volumes Actual and Entitled

Entitled and settlement volumes Entitled and Settlement

For Settlement diversity owners Settlement

Entitled cannot be selected by itself.

Save the formula ID.

Using a Reference for a Valuation Formula ID

If a valuation formula ID record already exists with data similar to that of the new valuation formula ID you are 
creating, you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter the ID for the existing valuation formula ID in 
the reference section of the initial screen for the new valuation formula ID.

See also:

Creating a Valuation Formula [page 290]

 

 

 

9.1.2  Creating Valuation Formulas 

Use

Use this transaction to specify what calculation(s) a formula carries out.

Formulas, which are effective-dated, define how the system values a product. They provide the means for the 
system to value any volume type or disposition being maintained in sales, production, on-lease, off-lease, etc.

Formulas are a critical component of the valuation cross reference relationship providing the ability for the 
system to use production and revenue allocation information; contract, pricing, and marketing cost/
reimbursement information; and ownership and accounting information.

290 C U S T O M E R
SAP Oil & Gas (PRA - Production and Revenue Accounting)

Valuation 



Procedure

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Revenue Accounting 
→ Valuation Formula → Create

The Create Valuation Formula: Initial Screen appears.

Enter the formula ID and the effective from date. Then choose Enter .

The Create Valuation Formula: Overview screen appears.

Enter data for the formula as required, using the Reserved Words to define how the system performs revenue 
computations.

The Result field contains the reserved word that represents the result of the system’s computation of Factor 1 
and Factor 2, using the operator in the Function field. The format is RESULT = FACTOR 1 (OPERATOR) FACTOR 
2.

For a natural gas liquid (NGL) major product, the reserved word NGLPC can be used to value minor products 
differently. When you enter NGLPC, the system’s selections process creates new Valuation transactions for 
each material that the reserved word refers to.

Review the Alt indicator. When selected, this indicates that alternate data is being used in the formula.

To review alternate data or to enter data in order to override formula entries, choose Alternates .

The Alternates button could be used to specify an alternate measurement point or well completion in a formula 
instead of the measurement point or well completion normally stored in the formula.

To approve the formula, set the Approval indicator.

Save the valuation formula.

Using a Reference for a Valuation Formula

If a valuation formula record already exists with data similar to that of the new valuation formula you are 
creating, you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter data for the existing valuation formula in the 
reference section of the initial screen for the new valuation formula.

See also:

Creating a Formula ID [page 289]

Creating a Valuation Cross Reference [page 317]

Using Reserved Words [page 292] Using Reserved Words [page 292]
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9.1.2.1 Using Reserved Words 

The reserved words listed below are available for use when creating valuation formulas.

Table 61: Reserved Word Type Code

F Factor Word

R Result Word

B Both

Table 62: Reserved Word Use Code

A Adjustment Adjustment reserved words retrieve 
fixed values for use in formula calcula­
tions.

C Calculated Calculated reserved words are the re­
sult of calculations within the formula. 
The values associated with these words 
are placed in appropriate fields on the 
transaction and they override any previ­
ously existing values.

E Extract Extract reserved words retrieve previ­
ously calculated values (or volumes) 
from the transaction for use in formula 
calculations.

M Marketing Marketing reserved words retrieve mar­
keting rates or percentages for use in 
the formula calculation. The prefix EM 
stands for external marketing; IM 
stands for internal marketing; and ET 
stands for external transportation.

P Pricing Pricing reserved words retrieve or cal­
culate prices for use in formula calcula­
tions.

S Special Special reserved words perform a spe­
cial function unlike the functions of 
other reserved word. Special reserved 
words may be used in the result fields 
of the valuation formulas.

292 C U S T O M E R
SAP Oil & Gas (PRA - Production and Revenue Accounting)

Valuation 



V Volume Volume reserved words retrieve or ac­
cumulate specific volumes from Pro­
duction or Contractual Allocation. They 
are used in formula calculations only. 
They do not replace any volumes on the 
transaction.

Note
Some pairs of Reserved Words are the same, differentiated only by a D or an R at the end of the word.The D 
stands for Deduction , while the R stands for Reimbursement .

Table 63:

Reserved Word Code Reserved Word Name Reserved Word De­
scription

Re-served Word Type 
Code

Re-served Word Use 
Code

ACTBTUFAC Actual BTU Factor 
Override

The BTU Factor asso­
ciated with the actual 
volume preloaded with 
the system calculated 
amount. This word 
overrides thesystem-
calculated amount if 
used in a result field. 
None of the override 
source fields may be 
used with this word. 
The result of this word 
must be divided by 
1,000 in your formula.

B C

ACTMMBTU Actual MMBTU Vol­
ume

This word is pre-
loaded with the sys­
tem-calculated volume 
and overrides the sys­
tem calculated volume 
if used in a result field. 
None of the override 
source fields may be 
used with this word.

B C
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ACTVAL Actual Value The actual value asso­
ciated with a VL Trans­
action. The value of 
this word is passed in 
the Revenue system as 
the gross value of an 
actual transaction. 
None of the override 
source fields may be 
used with this word.

B C

ACTVOL Actual Volume The actual volume is 
pre-loaded with the 
system-calculated vol­
ume. This word over­
rides the system-cal­
culated volume if used 
in a result field. None 
of the override source 
fields may be used 
with this word.

B C

ACTWLR Actual PVR A field on the Valuation 
transaction is pre­
loaded with a system 
calculated volume for 
Actual PVR.

B C

ADANOPL Alternative dual ac­
counting non -plant 
owner

Indicates that the price 
multiplier does not 
represent gas plant in­
terest ownership.

F S

ADAPLOWN Alternative dual ac­
counting plant owners

Indicates that the price 
mulitplier does repre­
sent gas plant interest 
ownership.

F S
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BBLPWL Barrels per Well This reserved word re­
trieves the unit volume 
for a given product 
code and volume type 
in addition to the well 
count associated with 
the unit. The unit vol­
ume divided by the 
well count is the Bar­
rels per Well. The prod­
uct code and volume 
type cannot be en­
tered independently, 
but can be overridden 
together. If not en­
tered, they will default 
to the formula header. 
An override contract 
may be used with this 
word.

F V

BTUFAC BTU Factor Determina­
tion

The BTU factor for an 
override product code 
and determination vol­
ume type. BTU is at 
the determination 
method as entered in 
volume determination. 
The product code and 
volume type cannot be 
entered independently. 
The product code and 
volume type default to 
those entered on the 
formula header. Also, 
an override purchaser, 
measurement point, or 
well completion may 
be entered with this 
word. If an override 
measurement point or 
well completion is 
used, you must use the 
Transporter BA that 
corresponds with it. Do 
not divide the result of 
this BTU word by 
1,000 in your formula.

F V
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BUYSELLVAL Buy / Sell Value Buy/sell value for buy/
sell contract agree­
ment. The purchaser 
buys from itself 
through indirect sup­
ply contract.

Revenue Distribution 
makes journal entries 
for the portion of the 
buy/sell agreement re­
lating to a sale in a in­
direct supply contract. 
The contract number 
is required.

B C

COUNTABLEWELLS Countable Wells The number of counta­
ble wells on a lease for 
a settlement diversity 
formula.

B

DAYSINMO Days in the month This reserved word cal­
culates the days in the 
current production 
month. An override 
contract may be used 
with this word.

F S

DAYSPRMO Days in the prior 
month

This reserved word cal­
culates the days in the 
previous production 
month.An override 
contract may be used 
with this word.

F S

EMCMPRS Ext Compression Mar­
keting Type

The override portion of 
these words is re­
quired, including rate, 
percent, fixed or slid­
ing scale, and deduc­
tion or reimburse­
ment. A product over­
ride is optional. An 
override contract may 
be used with these 
words.

F M

EMDEHYD Ext Dehydration Mtkg 
Type

EMDISTR Ext Oil Distributed 
Transportation Mktg

EMFCDIF Ext Facility Fee/ Cost 
Diff Mktg Type

EMFUELS Ext Fuel Mktg Type
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EMGATHR Ext Gathering / Han­
dling Mktg Type

EMGGATH Ext Gas Gatherng 
Mktg Type

EMLAWGA Ext Loss Allow with 
Gathering Mktg Type

EMLAWOG Ext Loss / Allow with­
out Gathering Mktg 
Type

EMLCDIF Ext Location Differen-
tial Mktg Type

EMMAINL Ext Mainline Mktg Type

EMOILOT Ext Oil Other Mktg 
Type

EMOTHER Ext Other Mktg Type

EMPRCTR Ext Processing / Treat­
ing Mktg

EMQADIF Ext Quality Differential 
Mktg Type

EMSVFAC Ext Service Fee Acct - 
Mktg Type

EMSVFMK Ext Service Fee Mktg - 
Mktg Type

EMTOTTR Ext Total Transporta­
tion Mktg Type

ERSVFAC Ext Service Fee Mktg 
Amt

EMUNDIS Ext Oil Undistributed 
Transportation Mktg 
Type

ENTMMBTU Entitled MMBTU Vol­
ume

Pre-loaded with sys­
tem calculated vol­
ume. If used in a result 
field, these words over­
ride the system-calcu­
lated volume. None of 

B C
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ENTVOL Entitled Volumes the override source 
fields may be used 
with these words.

ENTVAL Entitled Value The entitled value as­
sociated with a Valua­
tion transaction.The 
value of the word will 
be passed in the Reve­
nue system as the 
gross value of the enti­
tled transaction.None 
of the override source 
fields may be used 
with this word.

B C
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ENTWLR Entitled PVR A field on the Valuation 
transaction is pre­
loaded with a system-
calculated volume.

Entitled PVR volume is 
calculated as follows.

For NGL Sales Trans­
actions in Wet Gas 
Balancing Networks:

Entitled PVR = 203/01 
Entitlement Attributa­
ble to wet gas sent to 
the plant - 204/03 En­
titlement - 2x4/xx Re­
turned Lease Fuels

For NGL Sales Trans­
actions in Non-Wet 
Gas Balancing Net­
works and NGL Ca­
singhead Transac­
tions:

Entitled PVR = 203/01 
Entitlement - 204/03 
Entitlement - 2x4/xx 
Returned Lease Fuels.

The returned lease fuel 
volume types are 
10-15 , 75 , and 79 .Re­
turned lease fuel is ad­
justed for excess lease 
fuel volumes.

The system-calculated 
value can be overrid­
den by using Entitled 
PVR as a result word in 
a valuation for­
mula.None of the over­
ride source fields may 
be used with this word.

Note :Because Entitled 
PVR is calculated us­
ing OA gas volumes, 
both NGLs and residue 
must be allocated be­

B C
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fore NGLs can be val­
ued.Entitled PVR is 
only valid when used 
for NGL transactions in 
an OA network.

ERSVFAC Ext Service Fee Mktg 
Amt

The override portion of 
these words is re­
quired, including rate, 
percent, fixed or slid­
ing scale, and deduc­
tion or reimburse­
ment. A product over­
ride is optional. An 
override contract may 
be used with these 
words.

B C

ERCMPRSD

ERCMPRSR

Ext Compression 
Amount

The override portion of 
these words are re­
quired, including ac­
tual, entitled, or settle­
ment. None of the 
override source fields 
may be used with 
these words.

R C

ERDEHYDD

ERDEHYDR

Ext Dehydration 
Amount

ERDISTD

ERDISTR

Ext Oil Transp Amount

ERFCDIFD

ERFCDIFR

Ext Facil Fee / Code 
Diff

ERGATHRD

ERGATHRR

Ext Oil Gath / Handle 
Amount

ERGGATHD

ERGGATHR

Ext Gas Gatherng 
Amount

ERLAWGAD

ERLAWGAR

Ext Loss Allow with 
Gathering

ERLAWOGD

ERLAWOGR

Ext Loss Allow without 
Gathering

ERLCDIFD

ERLCDIFR

Ext Location Diff 
Amount
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ERMAINLD

ERMAINLR

Ext Mainline Amount

EROILOTD

EROILOTR

Ext Oil Other Amount

ERPRCTRD

ERPRCTRR

Ext Processing / Treat­
ing Amt

ERQADIFD

ERQADIFR

Ext Quality Diff 
Amount

ERSVFMKD

ERSVFMKR

Ext Service Fee - Mktg 
Amt

ERTOTTRD

ERTOTTRR

Ext TOT Transportation 
Amount

ERTRANSD

ERTRANSR

Ext Transportation 
Mktg Amount

ERUNDISD

ERUNDISR

Ext Oil Undistrib 
Transp Amount

ERFUELSD

ERFUELSR

Ext Fuel Amount The override portion of 
this word is required, 
including actual, enti­
tled, or settlement. 
None of the override 
source fields may be 
used with this word.

B C

ESETVOL Settlement Owner Vol­
ume

Defines a settlement 
owner's portion of the 
contract and producer 
entitled volume.

ESETMMBTU Settlement Owner En­
ergy

Defines a settlement 
owner's portion of the 
contract and producer 
entitled energy.

ESETWLR Settlement Wet Less 
Residue

Defines a settlement 
owner's portion of the 
contract to hold enti­
tled wet less residue 
amount.
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GASPRICE Gas Price The contract calcu­
lated gas price or the 
contract override gas 
price.The override por­
tion of this word is op­
tional, including prod­
uct and whether the 
price is daily or 
monthly.If monthly/
daily indicator is not 
entered, it will default 
to monthly.An override 
purchaser, measure­
ment point, well com­
pletion, or contract 
may be entered with 
this word.

F P

GBBLPW Gravity Barrels per 
Well

This reserved word re­
trieves the unit volume 
for a givenproduct and 
volume type in addi­
tion to the well count 
associated with the 
unit. The unit volume 
divided by the well 
count is the Barrels 
per Well. This word 
also calculates the per­
centage of volume with 
gravity less than the 
limit specified on the 
sliding scale header 
and the percentage of 
volume with gravity 
greater than or equal 
to the limit specified 
on the sliding scale 
header. The product 
code and volume type 
cannot be entered in­
dependently, but can 
be overridden to­
gether. If not entered, 
they will default to the 
formula header. An 
override contract may 
be used with this word.

F V
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HILOPRES Hi / Lo Pressure HI/LO Pressure. Can 
only be used on a “D” 
network. Computes 
the ratio of volume for 
a given allocation me­
ter to the total volume 
for all allocation me­
ters. An override allo­
cation meter measure­
ment point type must 
be entered.

F V

IMCMPRS Int Compression Mktg 
Type

The override portion of 
these words is re­
quired, which is a rate 
or percent. The prod­
uct override is op­
tional. An override 
measurement point, 
well completion or 
contract may be used 
with these words.

B C

IMDEHYD Int Dehydration Mktg 
Type

IMFUELS Int Fuel Mktg Type

IMGGATH Int Gas Gathering 
Mktg Type

IMOILOT Int Other Mkt Type

IMOTHER Int Other Mktg Type

IMPRCTR Int Process / Treating 
Mktg Type

IMSVFAC Int Service Fee Acct - 
Mktg Type

IMSVFMK Int Service Fee Mktg - 
Mktg Type

IRCMPRS Int Compression Cost The override portion of 
these words is re­
quired, which includes 
actual, entitled, or set­
tlement. None of the 
override source fields 
may be used with 
these words.

F A

IRDEHYD Int Dehydration Cost

IRFUELS Int Fuel Cost

IRGGATH Int Gas Gathering Cost

IROTHER Int Other Mktg Cost

IRPRCTR Int Process / Treat 
Mktg Cost

IRSVFAC Int Service Fee Acct 
Cost
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IRSVFMK Int Service Fee Mktg 
Cost

IMMULTF Int Multiple Mktg Type Returns the internal 
marketing rate for the 
multiple fee marketing 
type.The resulting 
amount is available for 
further processing in 
RD.

F

IRMULTF Int Multiples Mktg Cost R

IMROYDE Int Royalty Deduction 
Mktg Type

Returns the internal 
marketing rate for the 
royalty deduction mar­
keting type.

F

IRROYDE Int Royalty Deduct 
Mktg Cost

R

IROILOT Int Other Mkt Cost The override portion of 
this word is required, 
which includes actual, 
entitled, or settlement. 
None of the override 
source fields may be 
used with this word.

B C

KANADPVAL Kansas Override Taxa­
ble Value

Applies an override 
taxable value for use in 
the calculation of Kan­
sas severance taxes.

F or R
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LSEVAL Lease Sales Value The value of lease 
sales under the oper­
ating company sales 
contract.Lease Sales 
Value is used in situa­
tions where both plant 
and lease owners 
marked NGLs under 
the operating com­
pany sales contract.It 
is used by Revenue 
Distribution to create 
entries for the plant 
clearing account when 
the lease has a proc­
essing agreement with 
the plant.Lease Sales 
Value is only valid 
when used with the 
operating company 
plant NGL sales con­
tract transac­
tions.None of the over­
ride source fields may 
be used with this word.

B C

LSEVOL Lease Sales Volume The volume of lease 
sales under the oper­
ating company sales 
contract.Lease Sales 
Volume is used in con­
junction with Lease 
Sales Value to create 
entries for the plant 
clearing account in 
Revenue Distribu­
tion.Lease Sales Vol­
ume is only valid when 
used with the operat­
ing company plant 
NGL sales transac­
tions.None of the over­
ride source fields may 
be used with this word.

F V
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MMSPROC MMS Processing Tax and Royalty MMS 
processing rate or per­
cent.The override por­
tion of the this word is 
optional, including 
product (which should 
be a processed gas 
product) and a rate or 
percent.An override 
measurement point, 
well completion, or 
contract may be en­
tered with this word.

F C

MMSTRANS MMS Transportation Tax and Royalty MMS 
transportation 
rate.The override por­
tion of this word is op­
tional, which is prod­
uct code.An override 
measurement point, 
well completion, or 
contract may be en­
tered with this word.

F C

NGLPC NGL Factor or NGL 
Transactions

Formula statements 
immediately following 
this word will be exe­
cuted only for transac­
tion with major prod­
uct code 4 and minor 
product code xx . An 
override contract may 
be used with this word. 
Generates separate 
transactions for major 
product code 4 and 
minor product code xx, 
where 4xx is a valid 
product code. All for­
mula statements prior 
to this word are exe­
cuted for all product 
codes listed using this 
word.

F S
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NGLPRICE NGL Price Plant price based on 
formula product code. 
The override portion of 
this word is optional, 
which includes prod­
uct code and whether 
the price is daily or 
monthly. If monthly/
daily indicator is not 
entered, it will default 
to monthly. An over­
ride measurement 
point, well completion, 
or contract may be en­
tered with this word.

F P

OILPRICE Oil Price The posted price for oil 
or condensate sales. 
This price is deter­
mined based on post­
ing company, posting 
area, crude type, and 
gravity. The posting 
area is optional, but 
can be overridden. An 
override posting com­
pany, measurement 
point, well completion, 
or contract may be 
used with this word.

F P

PERRETLSE Percent Returned to 
Lease

Used to calculate a 
value split for the set­
tlement of casinghead 
agreement con­
tracts.None of the 
override source fields 
may be used with this 
word.

F C
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PURMMBTU Purchaser MMBTU Returns an MMBTU for 
product and a pur­
chaser.There is an op­
tion to override the 
product code if re­
quired.An override 
purchaser, measure­
ment point, well com­
pletion, or contract 
may be entered with 
this word.

PURVOL Purchaser Volume Returns a volume for 
product and a pur­
chaser.There is an op­
tion to override the 
product code if re­
quired.An override 
purchaser, measure­
ment point, well com­
pletion, or contract 
may be entered with 
this word.

SETBTUFAC Settlement BTU Factor The BTU factor associ­
ated with the calcula­
tion of the settlement 
volume and value pre­
loaded with the system 
calculated amount. 
Will override system 
calculated amount if 
used in a result field. 
None of the override 
source fields may be 
used with this word. 
The result of this word 
should be divided by 
1,000 in the formula.

B C
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SETMMBTU Settlement MMBTU The Settlement 
MMBTU volume. Pre-
loaded with system-
calculated volume. 
This word overrides 
the system-calculated 
volume if used in a re­
sult field. None of the 
override source fields 
may be used with this 
word.

B C

SETVAL Settlement Value The Settlement value 
associated with a valu­
ation transaction. The 
value of this word is 
passed in the Revenue 
system as the gross 
value of a settlement 
transaction. None of 
the override source 
fields may be used 
with this word.

B C

SETVOL Settlement Volume Pre-loaded with sys­
tem-calculated actual 
volume. This word will 
override system calcu­
lated volume if used in 
a result field. None of 
the override source 
fields may be used 
with this word.

B C
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SETWLR Settlement PVR A field on the Valuation 
transaction is pre­
loaded with a system 
calculated volume.

Settlement PVR vol­
ume is calculated as 
follows.

For Contract Level 
Settlement NGL 
Transactions :Settle­
ment PVR = Contract 
Level ACTWLR * NRI 
Percent

For Producer Level 
Settlement NGL 
Transactions :Settle­
ment PVR = Producer 
Level ACTWLR * 
Bearer Group Percent 
* NRI Percent

The calculated value 
can be overridden by 
using Settlement PVR 
as a result word in a 
valuation for­
mula.None of the over­
ride source fields may 
be used with this word.

Note :Because Settle­
ment PVR is calculated 
using OA gas volumes, 
both NGLs and residue 
must be allocated be­
fore NGLs can be val­
ued.

B C
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THEOVL Theoretical Volume Accumulates theoreti­
cal quantity for a given 
product and volume 
type.The product code 
and volume type are 
optional as a group.An 
override purchaser, 
measurement point, 
well completion, or 
contract may be en­
tered with this word.

F V

TOTMMBTU Total MMBTU Total MMBtu for the 
product and volume 
type. Product code 
and volume type can­
not be entered inde­
pendently, but can be 
overridden together. If 
not entered, product 
code and volume type 
will default to the for­
mula header. An over­
ride purchaser, meas­
urement point, well 
completion, or con­
tract may be entered 
with this word.

F V

TOTVOL Total Volume Total volume for the 
product code and vol­
ume type. Product 
code and volume type 
cannot be entered in­
dependently, but can 
be overridden to­
gether. If not entered, 
product code and vol­
ume type will default 
to the formula header. 
An override purchaser, 
measurement point, 
well completion, or 
contract may be en­
tered with this word.

F V

TRACTPF Tract Participation Fac­
tor

Retrieves the tract par­
ticipation factor for a 
given tract number.

F
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UNSVOL Unsigned Volume Volume for product 
code and volume type. 
Product code and vol­
ume type cannot en­
tered independently, 
but can be overridden 
together. If not en­
tered, product code 
and volume type de­
fault to the formula 
header. An override 
property and DOI are 
required with this 
word. The well volume 
tied to the 
property/DOI is re­
quired and multiplied 
by the owners decimal 
from the override 
property/DOI.

F V

UNTGRVL Unit Gravity Volume This word retrieves the 
total unit volume for a 
product code and vol­
ume type. This word 
also calculates the per­
centage of volume with 
gravity less than the 
limit specified on the 
sliding scale header 
and the percentage of 
volume with gravity 
greater than or equal 
to the gravity specified 
on the sliding scale 
header. The product 
code and volume type 
cannot be entered in­
dependently, but can 
be overridden to­
gether. If not entered, 
they default to the for­
mula header. An over­
ride property may be 
entered with this word.

F V

UNTPRVL Unit Prior Month Vol­
ume

These words retrieve 
the total unit volume 

F V
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UNTVOL for the previous pro­
duction month for a 
product code and vol­
ume type. The product 
code and volume type 
cannot be entered in­
dependently, but can 
be overridden to­
gether. If not entered, 
they default to the for­
mula header. An over­
ride property may be 
entered with these 
words.

Unit Volume

VALSSCALE Sliding Scale OVR An override value to be 
used in lieu of transac­
tion values for scale 
purposes.None of the 
override source fields 
may be used with this 
word.

B C

VOLSSCALE Sliding Scale Volume 
OVR

VLACTBTUFAC Actual BTU Factor Ex­
tract

The Btu factor associ­
ated with the actual 
volume on the Valua­
tion transaction. None 
of the override source 
fields may be used 
with this word. The re­
sult of this word 
should be divided by 
1,000 in the formula.

F E

VLACTMMBTU Actual MMBTU Extract The Actual MMBtu Vol­
ume on the Valuation 
transaction. (See re­
sult reserved word Ac­
tual MMBtu Volume / 
ACTMMBTU ). None of 
the override source 
fields may be used 
with this word.

F E
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VLACTVOL Actual Volume Extract The Actual Volume on 
the Valuation transac­
tion. (See result re­
served word Actual 
Volume/ACTVOL ). 
None of the override 
source fields may be 
used with this word.

F E

VLCTRDEC Contract Decimal Ex­
tract

The decimal repre­
sents the percentage 
of a contract’s actual 
volume which is being 
valued. This percent­
age is 100% for con­
tract level transac­
tions. The percentage 
for producer or owner 
level transaction repre­
sents the producer’s 
or owner’s share of the 
contract’s volume. 
None of the override 
source fields may be 
used with this word.

F E

VLENTDEC Entitled Decimal Ex­
tract

This is 100%, the pro­
ducer GRI, or the 
owner NRI depending 
on the level of the 
transaction. None of 
the override source 
fields may be used 
with this word.

F E

VLENTMMBTU Entitled MMBTU Ex­
tract

The Entitled MMBtu 
volume on the valua­
tion transaction. (See 
Result Reserved Word 
Entitled MMBTU Vol­
ume/ENTMMBTU ). 
None of the override 
source fields may be 
used with this word.

F E
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VLENTVOL Entitled Volume Ex­
tract

The Entitled volume on 
the Valuation transac­
tion. (See Result Re­
served Word Entitled 
Volume/ENTVOL ). 
None of the override 
source fields may be 
used with this word.

F E

VLPRODDAYS Total Days Production 
Extract

The total number of 
days a well completion 
produced during a 
month for the volume 
previously extracted 
on the Valuation trans­
action. None of the 
override source fields 
may be used with this 
word.

F E

VLSETVOL Settlement Volume Ex­
tract

The settlement volume 
on the Valuation trans­
action. (See Result Re­
served Word Settle­
ment Volume/
SETVOL ). None of the 
override source fields 
may be used with this 
word.

F E

WELLCOUNT Property Well Count This word retrieves the 
well count for a prop­
erty. An override prop­
erty may be used with 
this word.

F V

WORK01 - WORK15 Work Word 01-15 Work words to be used 
for intermediate re­
sults. None of the over­
ride source fields may 
be used with this word.

B C
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9.1.3  Approving Valuation Formulas or Reviewing a List of 
Formulas 

Use

Use this transaction to:

retrieve a list of formulas and review the associated details

approve or unapprove individual formulas, or a group of formulas, for use in Valuation

Procedure

At the SAP Easy Access screen, choose Logistics →  Production and Revenue Accounting → Revenue Accounting 
→ Valuation → Valuation Formula → List Processing

The Valuation Formula List Processing screen appears.

Enter data as required and choose Execute .

The Valuation Formula List Processing screen appears with a list of formulas that matches the criteria you 
entered on the first screen.

Review the details of the list.

To approve or unapprove a formula, click a row to select the formula in the row, and then choose Approve or 
Unapprove as required.

Even though a formula has been used, or “booked”, it is still possible to unapprove it.

To review changes to the formulas, choose Log .

Exit the valuation formula list processing.

 

 

 

9.2 Valuation Cross Reference 

Definition

A valuation cross reference represents an effective-dated link by product.The link includes:

● Entities from Production – delivery networks, measurement points (MP), wells, and well completions (WC)
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● Marketing groups from Contractual Allocations
● Entities from Ownership – unit properties, divisions of interest (DOIs), DOI to MP Cross Reference, and DOI 

to WC Cross Reference
● Approved contracts and approved formulas

See also:

Creating a Valuation Cross Reference [page 317]

Approving Valuation Cross References or Reviewing a List of VCRs [page 318]

9.2.1  Creating a Valuation Cross Reference 

Use

Establishes a set of effective-dated data by product that allows product to be valued. The set of data includes:

Production entities – delivery networks, measurement points (MPs), wells, and well completions (WCs)

Contractual Allocation marketing groups

Ownership entities – unit properties, divisions of interest (DOIs), DOI to MP/WC Cross References

Approved contracts and approved formulas

Procedure

From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Valuation Cross Reference → Create

Enter data as required. Then choose Enter .

The Create Valuation Cross Reference: Overview screen appears.

Enter the formula ID.

When creating a valuation cross reference at an MP level, to enable grouping of WC volumes to an MP level, do 
one of the following:

If wells with differing ownership feed a common tank, select Ownership .

If wells with differing tax classifications (for example, a classification which either exempts a well completion 
from taxes or qualifies it for reduced rates) feed a common tank, select Tax Class .

To enter contract diversity details, choose Contract Diversity . Then verify or change the start date in the 
Contract Diversity dialog box.

Contractual diversity occurs when multiple producers in the DOI have responsibility for marketing a product.
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In situations where working interest owners are taking their product in kind, valuation will be calculated at the 
producer level. Since there are multiple contracts involved in this situation, the volume from the wells in the DOI 
is divided among the contracts and priced separately.

The value resulting from this division of volume is attributable only to a group of producers rather than the 
entire DOI.

Choose Enter to return to the Change Valuation Cross Reference: Overview screen.

To enter settlement diversity details, choose Settlement Diversity .

Settlement diversity occurs when one or more owners in the DOI needs to be handled differently than the other 
owners in the DOI regarding the contract. For example, one owner could be paid a price different than the price 
paid to the other owners, or a particular owner could be paid on a sliding scale basis.

By identifying settlement diversity owners on the DOI, a different formula can be tied specifically to these 
owners.

Options for Entering Settlement Diversity Data

Table 64:

Function Follow-on action

Retrieve all owners on the venture into the Settlement 
Diversity dialog box.

Choose Load All Owners .

In the Settlement Diversity Selection dialog box, enter the 
override formula number, which will apply to all the owners 
listed.

Specify a particular owner to be entered in the Settlement 
Diversity dialog box.

Choose Load Selected Owners .

In the Settlement Diversity Selection dialog box, enter data 
for the particular owner as well as the corresponding over­
ride formula number.

To verify that the data entered can be used in the VCR, choose Validate VCR.

To either approve or unapprove the valuation cross reference, choose Approve or Unapprove as required.

Save your entries.

9.2.2  Approving Valuation Cross References or Reviewing a 
List of VCRs 

Use

Use this transaction to retrieve a list of valuation cross references (VCRs), and to approve or unapprove 
multiple VCRs at the same time.
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Procedure

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Revenue 
Accounting Valuation Valuation Cross Reference List Processing  .

The Valuation Cross Reference List Processing screen appears.

Enter data as required.Verify and change as required the effective dates.Also verify the approval status of the 
VCRs that are to be retrieved for the list.Then choose Enter .

The Valuation Cross Reference List Processing screen appears.

As required, either choose Approve to approve a VCR, or choose Unapprove to unapprove the VCR.

Exit the valuation cross reference list.

9.3 Creating Internal Marketing Rates 

Use

Use this transaction to establish internal marketing deduct or cost information for company-operated 
equipment or for other internal charges to be assessed to owners when valuation process runs. These internal 
cost will be passed to owners within the Division of Interest unless they are marked as exempt.

In this transaction you specify the date that the marketing deduct information becomes effective as well as the 
date that it is no longer in effect.

Note
The detailed marketing costs are calculated and stored individually in journal entries.

Procedure

1. At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Revenue 
Accounting Valuation Internal Marketing Rates Create  .
The Create Internal Marketing Rates: Initial Screen appears.

2. Choose one of the following.
Options for Entering Internal Marketing Rates

Table 65:

Function Follow-on action

To enter data for a measurement point Enter data as required
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Function Follow-on action

To enter data for a well completion Choose Well Completion , then enter data as required.

1. Choose Enter .
The Create Internal Marketing Rates: Overview screen appears.

2. In the Mktg Type Code field, specify marketing costs to be deducted.
3. Either enter the marketing cost deduction percentage in the Deduct % field, or enter the flat marketing 

deduction rate in the Mkting Ded Rt field.
4. Enter other data as required, then save your entries.

Using a Reference for Internal Marketing Rates

If an internal marketing rates record already exists with data similar to that of the new internal marketing rates 
you are creating, you can copy data from the existing record into the new record.

To copy data from the existing record into the new record, enter data for the internal marketing rates in the 
reference section of the initial screen for the new internal marketing rates.

9.4 Setting Up Tax Master Data 

Purpose

Use this process to set up tax master data, which is essential for the system to process Tax and Royalty 
records.
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Process Flow

Identify entities (well completions, measurement points or divisions of interest) that qualify for reduced rates 
using the Creating or Maintaining a Tax Classification transaction.

Establish baseline volumes for either a well completion or a group of wells.A tier tax is applied to volumes that 
exceed the baseline quantity by using Creating or Maintaining Tier Taxes .

If you need to define the criteria for tax calculation by state, tax type, and major product, use the Creating or 
Maintaining Tax Calculation Data transaction.With this transaction, you can define other criteria such as exempt 
quantities, as well as marketing reimbursements.

After you use the above transactions as required, use the Creating or Maintaining State Tax Rates transaction to 
display a list of tax rates and/or establish tax rates , based on value or volume, by state, tax type, and product.

The results of the Creating or Maintaining State Tax Rates transaction are handled in the system’s Tax 
Processing , and are utilized in Tax and Royalty records .

The system also uses Tax Processing to handle the results of

(1) the Creating or Maintaining a Tax Processing Allowance transaction, which applies a state tax processing 
allowance when the state provides a tax discount instead of the contractually established value,

(2) the Creating or Maintaining a Marketing Cost Tax Allowance transaction, which deducts a marketing cost tax 
allowance from the taxable value
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(3) the Creating or Maintaining a Royalty Processing Allowance transaction, which applies a royalty processing 
override when one royalty owner’s settlement is based on a lease/plant split that is different from the 
contractual split with the associated gas plant

9.4.1  Tax Classification 

Definition

A category of data, such as deduction rules, that apply to each tax type.

Tax classifications are related to tax classes, which represent a variation of a specific tax rate. For example, the 
default rate for a severance tax may be 6%, but for a disadvantaged area, the rate may be less. There could be, 
therefore, within a tax classification, a tax class such as “disadvantaged area”, which represents a rate lower 
than the normal default rate

Use

Use the Tax Classification transaction ( Logistics Production and Revenue Accounting Revenue 
Accounting Valuation Tax Master Data Tax Classification  ) to identify well completions, measurement 
points, or divisions of interest that qualify for reduced rates.

You can assign a tax classes (and for New Mexico only, a school district code) to a particular property/division 
of interest (DOI), measurement point, or well/well completion by major product.

Note
Production and Revenue Accounting utilizes tax classification data when retrieving the correct tax rate from 
the State Tax Rates [page 325] transaction. The State Tax Rates transaction is required only when tax rates 
within a state vary by tax class and/or school district.

9.4.2  Creating or Maintaining Tier Taxes

Use

Use this transaction to maintain tier tax baseline volumes for either a well completion or a project, which is a 
group of wells that cover area over one reservoir.

The baseline volume that you specify is compared against the actual volume produced by the well or project. If 
the actual volume is greater than the baseline volume, then the tier tax is applied to all volumes exceeding the 
baseline volume quantity.
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Procedure

1. At the SAP Easy Access screen, choose Logistics  Production and Revenue Accounting  Revenue 
Accounting  Valuation  Tax Master Data  Tier Tax  .

The Tier Tax Maintenance: Initial Screen appears.

1. Choose one of the following.

Options for Entering Tier Tax Data

Table 66:

Function Follow-on action

To establish a baseline volume by well completion Choose Tier Tax by Well

To establish a baseline volume by project Choose Tier Tax by Project

1. Choose Execute .
2. The Create Tier Tax Maintenance: Application Maintenance Form screen appears.
3. Enter data as required, including the baseline volume.

4.
If the actual volume is greater than the amount that you specify in the Baseline volume field, then the tier 
tax is applied to volumes that exceed the amount.

5. Save your entries.

Using a Reference to Create Tier Taxes

1. To create a tier tax record with reference to an existing tier tax record, at the Tier Tax Maintenance: Initial 
Screen , either choose Tier Tax by Well to change or display baseline volumes by well completion, or choose 
Tier Tax by Project to change or display baseline volumes by project.

2. Enter data as required. Then choose Execute .
3. If more than one record matches the data you entered, the Tier Tax Maintenance: List Viewer screen 

appears. In this case, select one of the tier tax records from the list.
4. OR

If only one record matches the data you entered, a single record is displayed.
5. Choose Create to create a new record with the data from the record you selected.
6. Changing or Displaying Tier Taxes
7. To change or display a tier tax record, at the Tier Tax Maintenance: Initial Screen , either choose Tier Tax by 

Well to change or display baseline volumes by well completion, or choose Tier Tax by Project to change or 
display baseline volumes by project.

8. Enter data as required. Then choose Execute .
9. If more than one record matches the data you entered, the Tier Tax Maintenance: List Viewer screen 

appears. In this case, select one of the tier tax records from the list.

OR

If only one record matches the data you entered, a single record is displayed.

1. Choose Change or Display to change or display the record as required.
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9.4.3  Creating or Maintaining Tax Calculation Data 

Use

With this transaction, you define the criteria for tax calculation by state, tax type, and major product. You can 
define other criteria such as exempt entities, marketing costs, and reimbursements.

The criteria that you define determines how the system calculates taxable volume or value.

Procedure

From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Valuation → Tax Master Data → Tax Calculation Data

Choose Create .

Enter data and set indicators as required. Then at the Mktg on Taxable Value tab, review and maintain 
marketing costs as required.

If a marketing cost is to be deducted from the displayed tax type, set the Subtract Ded. indicator.

For value-based taxes, a Subtract Deductions indicator that is set specifies that the marketing cost is deducted 
from the actual value or volume to arrive at a new taxable value. If an appropriate reserved word is specified in a 
formula, the formula calculates the amount of the deduction.

If a reimbursement for a marketing cost is to be considered taxable for the displayed tax type, set the Add 
Reimb. indicator.

For value-based taxes, an Add Reimbursements indicator that is set specifies that the reimbursement is 
considered taxable, and that it needs to be added to the actual value or volume to arrive at a new taxable value. 
If an appropriate reserved word is specified in a formula, the formula calculates the marketing reimbursement.

Select the Entity Characteristics tab, which lists entities that may either (1) claim exemption on either a volume 
or a value basis or (2) participate in the distribution of reimbursements for the displayed tax type.

If the entity will share in the tax reimbursement amount, set the Reimbursements indicator.

If the entity type will be exempt from the displayed tax, set the Exemptions indicator.

Exempt amounts are critical to the tax calculations. The system uses exemptions to reduce both the taxable 
volume and taxable value, thereby reducing the actual tax payable amount.

To establish fixed deductions for the displayed tax type and major product code, select the Fixed Mktg 
Deduction tab.

On the Fixed Mktg Deduction tab, you can do one of the following:
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Enter a percentage in the Fix market rate amt field

Enter a fixed amount in the Fix market amount field

The system deducts the amount that you enter from the gross value in order to calculate the taxable value.

To select the volume types used to sum and compare the baseline volumes, select the Tier Tax Volume Type 
tab.

Save your entries.

Result

The indicators selected in this transaction are used in the Valuation Formula process to determine taxable 
volume and value.

For value-based taxes, the value tax rate specified in the State Tax Rates transaction is multiplied by the taxable 
value. Likewise, for volume-based taxes, the volume tax rate is multiplied by the taxable volume.

9.4.4  Creating or Maintaining State Tax Rates

Use

Use this transaction to:

● display a list of tax rates
● establish the tax rates, based on value or volume, by state, tax type, and product. These rates are then 

used to calculate taxable amounts.

Tax rates can also be established at a lower level such as county, tax class, or school district where applicable.

Procedure

1. At the SAP Easy Access screen, choose Logistics  Production and Revenue Accounting  Revenue 
Accounting  Valuation  Tax Master Data  State Tax Rates  .

2. The State Tax Rates: Initial Screen appears.
3. Choose Create .
4. The Create State Tax Rates: Application Maintenance From screen appears.
5. Enter the following data as required.

● Country
● In the Primary geo loc field, enter the state.

SAP Oil & Gas (PRA - Production and Revenue Accounting)
Valuation C U S T O M E R 325



● Major product
● Severance tax
● Tax class
● Effective dates

1. In the Tax Options section, enter the following data as required.

● To establish a rate based on volume, in the Volume Rate field, enter a rate that will be used to determine 
taxes based on volume.

● To establish a rates based on the value of a volume, in the Valuation Rate field, enter a rate that will be used 
to determine taxes based on value.

● To establish rates for tier taxation, in the Tier Tax Options section, complete the following fields.

-- To set minimum and maximum volume rates, in the Min Volume Rate field, enter the low rate to be used for 
Enhanced Oil Recovery (EOR) processing. Then in the Max Volume Rate field, enter the high rate to be used for 
EOR processing.

--To set minimum and maximum value rates, in the Min Val Rate field, enter the low rate to be used for EOR 
processing. The in the Max Val Rate field, enter the high rate to be used for EOR processing.

--In the Price Unit field, enter the baseline price for tier tax processing.

1. Save your entries.

Using a Reference to Create State Tax Rates

1. To create state tax rates with reference to existing state tax rates, at the State Tax Rates: Initial Screen , 
enter data as required . Then choose Execute .

2. If more than one record matches the data you entered, the State Tax Rates: List Viewer screen appears. In 
this case select one of the records from the list.

3. OR
If only one record matches the data you entered, a single record is displayed.

4. Choose Create to create a new record with the data from the record you selected.

Changing or Displaying State Tax Rates

1. To change or display state tax rates, at the State Tax Rates: Initial Screen , enter data as required . Then 
choose Execute .

2. If more than one record matches the data you entered, the State Tax Rates: List Viewer screen appears. In 
this case select one of the records from the list.

3. OR
If only one record matches the data you entered, a single record is displayed.

4. Choose Change or Display to change or display the record as required.

9.4.5  Maintaining State Tax Rates

Use

You define state tax rates based on value or volume, by state, tax type, and product for the tax classes.

Tax rates can also be established at a lower level such as country, tax class, or school district where applicable.
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Procedure

1. A the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Revenue 
Accounting Valuation Tax Master Data State Tax Rates .

2. Perform one of the following:

Creating State Tax Rates

1. In the State Tax Rates: Initial Screen screen, choose Create.
2. In the State Tax Rates: Application Maintenance From screen, enter the required data.
3. In the Tax Options screen area, enter the following data:

○ To establish a rate based on volume, in the Volume Rate field, enter a rate that will be used to 
determine taxes based on volume.

○ To establish a rate based on the value of a volume, in the Valuation Rate field, enter a rate that will be 
used to determine taxes based on value.

○ To establish the rates for tier taxation, in the Tier Tax Options screen area, enter the range for volumes 
and value rate and the baseline price.
This would be used for enhanced oil recovery (EOR) processing.

○ If you want to associate the tax class to EOR, select the EOR Enabled checkbox.
If not selected, this would be a regular tier tax scenario.

Creating State Tax Rates using a Reference

1. To create state tax rates with reference to existing state tax rates, in the State Tax Rates: Initial Screen, 
enter the required data.

2. Choose Execute.
3. Select a record from the list of records that match the selection criteria.
4. To create a record with the data from the selected record, choose Create.

9.4.6  Creating or Maintaining a Tax Processing Allowance 

Use

Use this transaction to apply a state tax processing allowance when the state chooses to specify the allowance 
and provide a tax discount instead of using the contractually established value. A processing allowance is 
established for a given property/division of interest (DOI) by product.

Under plant contractual agreements, a lease/plant split (contractual split) is defined frequently, and the 
portion of the product contractually owned by the plant is typically not subject to taxes.

However, certain states (MontanaNew MexicoUtah, andWyoming) have the right to specify the calculation 
methodology and approve the processing allowance subject to a tax discount, regardless of the contractual 
lease/plant split. In these situations, the state tax processing allowance must be applied to calculate the taxes 
payable.

SAP Oil & Gas (PRA - Production and Revenue Accounting)
Valuation C U S T O M E R 327



Procedure

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Revenue Accounting 
→ Valuation → Tax Master Data → Tax Processing Allowance

The ERP system screen appears.

Choose Create .

The Create Tax Processing Allowance: Application Maintenance Form appears.

Enter the following data as required.

Company code

Venture/DOI

Owner

Effective dates

Material

Severance tax

Tax allowance (that is, the portion subject to a tax discount)

Save your entries.

Using a Reference to Create a Tax Processing Allowance

To create a tax processing allowance with reference to an existing tax processing allowance, at the ERP system 
screen, enter the venture/DOI, the owner, and the effective from and to dates. Then choose Execute .

If more than one record matches the data you entered, the Tax Processing Allowance: List Viewer screen 
appears. In this case, select one of the records from the list.

OR

If only one record matches the data you entered, a single record is displayed.

Choose Create to create a new record with the data from the record you selected.

Changing or Displaying a Tax Processing Allowance

To change or display a tax processing allowance, at the ERP system screen, enter the venture/DOI, the owner, 
and the effective from and to dates. Then choose Execute .

If more than one record matches the data you entered, the Tax Processing Allowance: List Viewer screen 
appears. In this case, select one of the records from the list.

OR

If only one record matches the data you entered, a single record is displayed.

Choose Change or Display to change or display the record as required.
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9.4.7  Creating or Maintaining a Marketing Cost Tax 
Allowance

Use

Use this transaction to establish a marketing cost tax allowance for a division of interest, producer, product, 
state, and tax type. The allowance established is deducted from the taxable value, so that the taxable value is 
reduced.

Procedure

1. At the SAP Easy Access screen, choose Logistics  Production and Revenue Accounting  Revenue 
Accounting Valuation  Tax Master Data  Marketing Cost Tax Allowance.

2. The Marketing Cost Allowance - Selection Screen appears.
3. Choose Create .
4. The Marketing Cost Allowance - Create screen appears.
5. Enter the following data as required:

● Company Code
● Venture/DOI
● Oil
● Effective From
● Effective To

1. Choose Enter to activate the fields in the bottom of the screen.
2. Complete the remaining fields as required. Then save your entries.

Using a Reference to Create a Marketing Cost Tax Allowance

1. To create a marketing cost tax allowance with reference to an existing record, at the Marketing Cost 
Allowance - Selection Screen , enter data as required. Then choose Execute .

2. If more than one record matches the data you entered, the Marketing Cost Allowance - List Processing 
screen appears. In this case, select one of the records from the list.

3. OR
If only one record matches the data you entered, a single record is displayed.

4. Choose Create to create a new record with the data from the record you selected.

Changing or Displaying a Marketing Cost Tax Allowance

1. To change or display a marketing cost tax allowance, at the Marketing Cost Allowance - Selection Screen , 
enter data as required. Then choose Execute .

2. If more than one record matches the data you entered, the Marketing Cost Allowance - List Processing 
screen appears. In this case, select one of the records from the list.

OR

If only one record matches the data you entered, a single record is displayed.
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1. Choose Change or Display to change or display the record as required.

9.4.8  Creating or Maintaining a Royalty Processing 
Allowance 

Use

Use this transaction to apply a royalty processing override for situations in which one royalty owner’s 
settlement is based on a lease/plant split that is different from the contractual split with the associated gas 
plant. An allowance is established for a given plant property/division of interest (DOI) by product and contract.

The lease/plant split is defined under a gas plant contractual agreement, and it defines one of the following:

In a volume-based split, the portion of the product that is allocated to the lease DOI(s), as well as the portion 
that is attributable to the plant

OR

In a value-based split, the portion that will be used to make settlement to the leases

This ability to establish owner level overrides for the above situation reduces the number of settlement 
diversity transactions in a gas plant network.

Procedure

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Revenue Accounting 
→ Valuation → Tax Master Data → Royalty Processing Allowance

The ERP system screen appears.

Choose Create .

The Create Royalty Processing Allowance: Application Maintenance Form screen appears.

Enter the following data:

company code

venture/DOI

the effective from and to dates

Choose Enter to refresh the screen.

Enter the following data:

material

contract

owner

In the Tax Allowance field, enter the owner-level override percentage of the product that will go to the plant.
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Save your entries.

Using a Reference to Create a Royalty Tax Allowance

To create a royalty processing allowance with reference to an existing record, at the ERP system screen, enter 
the following data:

company code

the venture/DOI or range of venture/DOIs

the effective from and to dates

Then choose Execute .

If more than one record matches the data you entered, select one of the records from the list.

OR

If only one record matches the data you entered, a single record is displayed.

Choose Create to create a new record with the data from the record you selected.

Changing or Displaying a Royalty Processing Allowance

To change or display a royalty processing allowance, at the SAP ERP screen, enter the following data:

company code

the venture/DOI or range of venture/DOIs

the effective from and to dates

Then choose Execute .

If more than one record matches the data you entered, select one of the records from the list.

OR

If only one record matches the data you entered, a single record is displayed.

Choose Change or Display to change or display the record as required.

9.5 Settlement Statements 

Use

Settlement statements are entered directly into the system in lieu of system-valued volumes, and they allocate 
units and/or compute state production and severance taxes if needed.

Use the following procedures as required in order to enter data that is necessary for the system to process 
settlement statements.

Note
The difference between a prior period adjustment and a reversal is that the prior period adjustment involves 
rebooking, while a reversal executes a “cancellation” of what was entered without rebooking.
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Creating or Maintaining a Settlement Statement [page 332]

Creating a Prior Period Adjustment for a Settlement Statement [page 333]

Reversing a Settlement Statement [page 334]

9.5.1  Creating or Maintaining Settlement Statements 

Use

Use this transaction to enter settlement statement data for processing through the Revenue application 
component. Settlement statements are entered directly into the system in lieu of system-valued volumes, and 
they allocate units and/or compute state production and severance taxes if needed. Settlement statements 
transactions bypass Valuation Formula processing because value and marketing deduction amounts are 
entered here.

Further, this settlement statement transaction features a prior period adjustment function to adjust data, and a 
function to reverse a record.

Prerequisites

The appropriate cross reference is established in the Settlement Statement/DOI Cross Reference [page 335] 
transaction.

Procedure

From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Valuation → Settlement Statements → Settlement Statement

The Settlement Statement: Initial Screen appears.

Choose Create .

The Settlement Statement: Create screen appears.

Enter data as required.

In the Doc date field, enter the date on which the settlement statement should be posted.

To enter a negative amount, enter the number followed by a negative sign ( – ).

For oil products, complete the Act Gros Vol and the corresponding UoM fields.

For gas products, complete either the Actual Energy or Actual Heat Fct field, and the corresponding UoM field.

To specify that the system should calculate taxes automatically, set the Calculate Tax indicator.
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If you do not select this option, you must enter tax data manually. If you enter tax data manually, it is assumed 
that the data has already been reported, and so the system sends the settlement statement directly to the 
Revenue Distribution application component.

To enter tax amounts and/or reimbursements manually, choose Tax . At the Settlement Statement: Create 
dialog box, enter severance tax data as required. Then choose Enter .

To enter marketing details manually choose Marketing . At the Settlement Statement: Create dialog box, enter 
the marketing cost amount and/or the marketing reimbursement amount. Then choose Enter .

The total of marketing cost amounts is displayed in the Market Cost Amt field, and the total of reimbursement 
amounts is displayed in the Tot. reimb Amount field on the Settlement Statement: Create screen.

Choose the following as required.

To send data to the valuation application component and to book the settlement statement, user can choose 
Value + Post to directly post the document. The user has the flexibility to just Value the document to review the 
results before posting.

To display line items that have failed, and the reasons for the failures, choose Error Log

To change line items in error, choose Prior Period Adjustment

To offset the line items in error, choose Reversal

To display line items that have not passed system edits and validations, choose Validate

To display all line items that have processed successfully, choose Result .

To post a Value Complete document, choose Post

Save the settlement statement.

See Also

Creating a Prior Period Adjustment for a Settlement Statement [page 333]

Reversing a Settlement Statement [page 334]

9.5.2  Creating a Prior Period Adjustment for a Settlement 
Statement 

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Revenue Accounting 
→ Valuation → Settlement Statements → Settlement Statement

The Settlement Statement: Initial Screen appears.
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Enter data as required to indicate which records the system should retrieve. Then choose Execute .

The more data that you enter, the more specific the resulting set of records will be.

The Settlement Statement: List Viewer screen appears.

Select the settlement statement to be adjusted. Then choose Create Prior Period Adjustment .

The Settlement Statement: Create screen appears.

Maintain the settlement statement as needed by changing data, deleting lines, etc. Then complete the ppa 
reason field.

Save the adjustment(s).

See also:

Creating or Maintaining a Settlement Statement [page 332]

 

9.5.3  Reversing a Settlement Statement 

Use

You use this function for reversing a settlement statement.

Activities

1. At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Revenue 
Accounting Valuation Settlement Statements Settlement Statement  .
The Settlement Statement: Initial screen appears.

2. Enter data as required to indicate which records the system should retrieve. Choose Execute .

Note
The more data that you enter, the more specific the resulting set of records will be.

The Settlement Statement: List Viewer screen appears.
3. Select the settlement statement to be reversed.
4. Choose Create Reversal .

The Settlement Statement: Create screen appears.
5. Choose Value + Post to determine whether there are any errors and to begin processing.
6. Save the reversal.
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See Also

Creating or Maintaining a Settlement Statement [page 332]

9.6 Creating a Settlement Statement / DOI Cross 
Reference 

Use

Use this screen to create a cross reference and link a purchaser’s unique property data to SAP’s venture data.

The cross reference between these two sets of data is then used as required in the Settlement Statement 
transaction.Whenever the purchaser’s data is entered, the system then automatically defaults the 
corresponding SAP venture data.

Procedure

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Revenue 
Accounting Valuation Settlement Statements Settlement Statement / DOI Cross Reference  .

The Settlement Statement/DOI XRef: Initial Screen appears.

Choose Create .

The Create Settlement Stmnt/DOI XRef: Maintenance View screen appears.

Enter data as required.

To review details about how records already processed in Settlement Statement Valuation processing are 
affected by changes to Settlement Statement / DOI Cross Reference data, choose Log .

Save your entries.

Using a Reference to Create a Settlement Statement - DOI Cross Reference

To create a settlement statement - DOI cross reference with reference to an existing cross reference, at the 
Settlement Statement/DOI Xref: Initial Screen , enter data as required.Then choose Execute .

If more than one record matches the data you entered, the Settlement Statement/DOI XRef: List Viewer screen 
appears.In this case, select one of the records from the list.

OR

If only one record matches the data you entered, a single record is displayed.

Choose Create to create a new record with the data from the record you selected.

Changing or Displaying a Settlement Statement -DOI Cross Reference
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To change of display settlement statement - DOI cross references, at the Settlement Statement/DOI XRef: 
Initial Screen , enter data as required.Then choose Execute .

If more than one record matches the data you entered, the Settlement Statement/DOI XRef: List Viewer screen 
appears.In this case, select one of the records from the list.

OR

● If only one record matches the data you entered, a single record is displayed.

Choose Create to create a new record with the data from the record you selected.

See also:

Creating or Maintaining a Settlement Statement [page 332]

9.7 Creating or Maintaining a Purchaser-Remitter Cross 
Reference

Use

Use this transaction to establish a cross reference when the entity responsible for remitting payment is 
someone other than the purchaser. Because many different remitters may exist for a single purchaser, the 
remitter information you enter is specific to a property/DOI, product, and either a well completion or 
measurement point.

Valuation uses the information you enter to determine the remitter associated with a Valuation Cross 
Reference (VCR). (The VCR is established for a DOI, contract, product code, and either a well completion or 
measurement point.)

Along with VCR attributes, the system uses the purchaser, which is retrieved from base contract information, 
to determine the party responsible for remitting payment. Revenue Distribution then uses this remitter to 
create Accounts Receivable entries.

Procedure

1. At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting  Revenue 
Accounting  Valuation  Purchaser/Remitter Cross Reference  .

2. The Purchaser/Remitter Cross Reference (OIUH_VL10): Initial Screen appears.
3. Choose Create .
4. The Purchaser/Remitter Cross Reference (OIUH_VL10) – Create screen appears.
5. Enter data as required, including the selection of either the well completion or measurement point radio 

button.

6.
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The Purchaser ID identifies the purchaser of a product for a property/DOI while the Remitter ID identifies 
the business associate who is responsible for remitting payment on behalf of the purchaser for the sale of 
the product.

7. Save your entries.

Using a Reference to Create a Purchaser / Remitter Cross Reference

1. To create a purchaser/remitter cross reference with reference to an existing record, at the Purchaser/
Remitter Cross Reference (VL10): Initial Screen , enter data as required. Then choose Execute .

2. If more than one record matches the data you entered, a list of records appears Select one of the records 
from the list.

3. OR
If only one record matches the data that you entered, the single record is displayed.

4. Choose Create to create a new record with the data from the record you selected.

Changing or Displaying a Purchaser / Remitter Cross Reference

1. To change or display a purchaser/remitter cross reference, at the Purchaser/Remitter Cross Reference 
(VL10): Initial Screen , enter data as required. Then choose Execute .

2. If more than one record matches the data you entered, a list of records appears Select one of the records 
from the list.

3. OR
If only one record matches the data that you entered, the single record is displayed.

4. Choose Change or Display to change or display the record as required.

9.8 Network Processing

Purpose

A network is processed in the Valuation application area in order to calculate the value of the volumes for the 
network.

As each network is processed, the status of the processing is tracked in the system.

Process Flow

1. Make manual adjustments by using Current Selections, Valuation Cross Reference Prior Period Notification 
Selections, Reject Selections, or Manual Prior Period Notifications.

2. Use the Valuation Document Work List to execute the process of valuing volumes for the network.
3. The system calculates the value of the volumes by using formulas.
4. The status of the valuation of the volumes is tracked for each network.
5. Transactions that encounter errors are rejected and made available for reject processing.
6. The status of network processing can be monitored by using the Valuation Document Work List [page 

339] .

Network Processing by Batch or Via the Valuation Document Work List
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When the Auto Select indicator is selected for a delivery network, the network is then available for batch 
processing.

The Valuation Batch Process processes all delivery networks through Valuation/Revenue Distribution that have 
(1) been selected by the Selection Driver and that (2) have the Auto Select indicator selected.

The Selection Driver creates a document containing all the transactions for a given network/sales date 
combination. The Selection Driver creates documents for:

● all available delivery networks that have the Auto Select indicator selected
● all delivery networks with prior period notifications
● all rejected delivery networks

In contrast, if the Auto Select indicator is not selected, then the network can be processed only with the 
Valuation Document Work List transaction.

9.8.1  Valuation Document Work List 

Definition

The Valuation Document Work List ( Logistics → Production and Revenue Accounting → Revenue Accounting → 
Valuation → Valuation Processing → Valuation Document Work List ) centralizes the tasks involved in Valuation 
processing. It is a single transaction from which you can:

select networks for processing

value and post transactions

review reports

A valuation document represents a unique combination of:

network

sales dates

frequency code

Use

You can use this object to carry out the following procedures.

Processing Networks; Verifying and Committing Results [page 339]

Correcting or Deleting a Document [page 342]

Using the Valuation Selection Report [page 343]

Using the Valuation Work List to Create a Document Manually [page 344]
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9.8.1.1 $PRCD$ Processing Networks; Verifying and 
Committing Results 

Use

Processing Networks Part 1 of 3

1. At the SAP Easy Access menu, choose Logistics Production and Revenue Accounting  Revenue 
Accounting Valuation Valuation Processing Valuation Document Work List  .
The VL Document Work List – Initial Screen appears.

2. Enter criteria to select documents.Then choose Execute .
The VL Document Work List – Document Header screen appears.

3. Double-click on a document to verify that lines were created for it.
The VL Document Work List – Document Details screen appears.

4. To review volume, formula, and tax details, double-click on a line item within a document.
The VL Document Work List – Volume, Formula and Tax Header screen appears.

Note
If a formula has been overwritten, the system displays the details in the Formula tab.In addition, in the 
Tax tab the system displays details by position, which represents a tract.

Note
You can double-click on the lines within the tab for even more details.For example, if you double-click on 
a line within the Formula tab, you will access the VL Document Work List – Formula Tax and Marketing 
Details screen.

5. In case of NGL processing the plant thermal reduction (PTR) can be viewed under the Volume Details tab 
and the underlying journal entries will include the PTR details.

6. At the VL Document Work List – Document Header screen, review the Document stage and Processing 
status columns to determine how the system has processed a document.

Note
The system has processed the document successfully if Value Complete (which indicates that the 
system has run the document all the way through Revenue Distribution) is displayed in the Document 
stage column and Successful is displayed in the Processing status column.

7. To run a document from the Valuation mainline through Revenue Distribution, select a document and 
choose Value .
Choosing Value is equivalent to processing the data in a trial status because data is not actually committed 
to the database.You can choose Value as many times as you would like to review and verify results.

Note
Choosing Value is useful when setting up master data.It assists you in finding errors before data is 
committed to the database.
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8. Choose the following options as required to verify results.

Verifying Results - Part 2 of 3

Verifying Results with the Combined Run Report

1. To display lines that the system has processed through Revenue Distribution and verify allocation results, 
from the VL Document Work List - Document Header , select a document and choose Comb. Run RPT.
The VL Document Work List – Oil and Gas Appl Header screen appears.To access accounting, owner, 
marketing, and taxes information, double-click on a line.

Verifying Results with the new Combined Run Report 
Transaction(o3u_comb_new)

With this function, you have a flexible selection criteria which helps to analyze the bookings and reversals data 
across documents. You can access the transaction in the SAP Easy Access menu under Logistics -> Production 
and Revenue Accounting -> Revenue Accounting -> Valuation -> Valuation processing -> Reports 
(o3u_comb_new). This also has the following features:

● Have flexibility in selection criteria involving business fields like venture, well, measurement point, DNs, 
specific documents, contracts and major product code.. All the selection fields represent the PRA data 
model.

● You can view dual accounting reports via this transaction in the ALV mode.
● Highlight any owner who has undergone ownership transfer on the combined run are highlighted with an 

indicator.
● You can view natural gas liquids (NGL) bookings Report details by component although journalized entries 

are at NGL 400 level.
● Latest booking option for a delivery network/sales date will show all the latest bookings by fetching data 

across documents associated with delivery network/sales date.
● You can view marketing cost details for oil and gas
● View the accounts receivable measurement point from DOI Accounting in the Accounting section on the 

3rd Party A/R Account.
● View the Owner Name in the ownership section and well completion name in the header data section.
● View negative gross values, taxes, and marketing costs on reversals

Use the Combined Run Report to Identify the Corresponding FI Document

1. To display lines that the system has processed through Revenue Distribution and verify allocation results, 
from the VL Document Work List - Document Header screen, select a document and choose Comb. Run 
RPT.
The VL Document Work List – Oil and Gas Appl Header screen appears.
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2. Select a row.Then choose Summary .
The Summary of Combined Run Report screen appears.

3. In the Accounting section, note the batch number .

4. Open another SAP session and choose Accounting Financial Accounting General Ledger
Document Display  .
The Display Document: Initial Screen appears.

5. Choose List .
The Document List screen appears.

6. Enter the company code.Then in the Reference key field, enter the batch number that you noted from the 
Combined Run Report.
The Document List screen appears with a list of documents that correspond with the company code and 
batch number that you entered.

7. Double click on a line for the document you want to review.
The Document Overview screen appears with the accounts and corresponding amounts.

8. Double click on line items as required for more detailed information.

Verifying Results with the Application Log

1. To review details about any fatal errors that may have occurred when the system was processing a 
document, from the VL Document Work List - Document Header screen, select the document and choose 
Application Log .
The Display Logs screen appears with information about how the system processed the document, and it 
may include information about any fatal errors that occurred.

Verifying Results with the Job Overview

1. To review details about a document submitted to the system for processing, from the VL Document Work 
List - Document Header screen, select the document and choose Job Overview .
The Simple Job Selection screen appears with the job name for the document in the Job name field.

2. Choose Execute .
The Job Overview screen appears with details about how the system has processed the document. There 
may be informational messages indicating issues such as density not set.

Committing Data to the Database - Part 3 of 3

1. Once you have verified results and the system defines a document as Value complete (shown in the 
Document stage column) and Successful (shown in the Processing status column), choose Post to 
commit data to the database and send data to Journal Entry.

2. To commit a document to the database without reviewing details, choose Value + Post .
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Note
Value + Post is the function that the system uses for automatic batch processing.

Result

You can review the resulting FI documents that correspond with the Valuation documents by using the 
Combined Run Report and the FI Display Document transactions. See Reviewing FI Documents that 
Correspond with VL Documents [page 344] for more information.

9.8.1.2 Correcting or Deleting a Document 

Use

Use this function to correct a document or to delete a document.

Prerequisites

Rejected records at the selection stage are corrected. To access records rejected at the selection stage, access 
the Valuation Rejects Selection for Delete [page 345] transaction by choosing Logistics   → Revenue Accounting 
→ Valuation → Valuation Processing → Valuation Rejects Selection for Delete .

Procedure

After making a correction, from the SAP Easy Access menu, choose Logistics → Production and Revenue 
Accounting → Revenue Accounting → Valuation → Valuation Processing → Valuation Document Work List

When you choose DEL doc , the system actually deletes the document while leaving the input intact. The 
system then creates a new document based on the input.

For information about continuing the process of running a selection again, see Using the Valuation Doc. Work 
List to Create a Document Manually [page 344] ( Logistics → Revenue Accounting → Valuation → Valuation 
Processing → Valuation Rejects Selection for Delete ).

To delete a document and related prior period notifications, choose DEL doc + PPNs .
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When you choose DEL doc + PPNs , the system deletes not only the document but any related prior period 
notifications as well.

 

9.8.1.3 Using the Valuation Selection Report 

Use

Within the Valuation Document Work List, you can use the Valuation Selection Report to analyze data related to 
selection processing.

The Valuation Selection Report function provides a way to access details about:

● networks selected for initial processing on a specific sales date
● prior period notifications that need to be processed for valuation cross references
● rejected transactions that require corrections

Procedure

At the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Revenue 
Accounting Valuation Valuation Processing Valuation Document Work List  .

The VL Document Work List - Initial Screen appears.

Choose Doc. Create RPT .

The Valuation Selection Report screen appears.

Enter selection criteria and choose Execute .

The Valuation Selection Report Overview screen appears.

Double click on a line to access details about a document.

The Valuation Selection Report screen appears.

Review the details of the document, including the contents of the Selection Type column, which identifies 
whether the document is current, PPN or reject.

Also review the contents of the Rej Rsn and Rej Rsn Description columns, which provide information about 
why rejects occurred.
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9.8.1.4 Using the Valuation Doc. Work List to Create a 
Document Manually

Use

Use this procedure to create a document manually.

This procedure is necessary in order to create a new document after a document has been reselected.

Procedure

1. At the SAP Easy Access menu, choose Logistics  Production and Revenue Accounting  Revenue 
Accounting  Valuation  Valuation Processing  Valuation Document Work List  .

2. The VL Document Work List – Initial Screen appears.
3. Enter a network, sales date, and the frequency. Then choose Create .
4. The Start Time dialog box appears.
5. Either choose Immediate to begin the selection immediately, or schedule a start time. Then choose Save .

6.
The data is submitted on-line, which in turn causes the system to begin processing the batch job.

The system attempts to process the batch job through posting. The system will not, however, execute an 
out-of-balance posting. Further, the system will not commit documents with rejects to the database.

7. Choose Execute .
8. The VL Document Work List – Document Header screen appears.
9. If you create a document manually in order to replace a document that you reselected, review the Run 

Time column to find the document with the most recent time stamp.

The document with the most recent time stamp is the replacement for the document you reselected. It will 
include any previously rejected lines that you corrected successfully.

9.8.2  Reviewing FI Documents that Correspond with VL 
Documents

Use

By using the Combined Run Report and the Display Document transactions, you can review the FI documents 
that correspond with Valuation documents.
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Procedure

1. At the SAP Easy Access menu, choose Logistics  Production and Revenue Accounting  Revenue 
Accounting  Valuation  Valuation Processing  Reports  Combined Run Report  .

2. The Combined Run Report screen appears.
3. Enter selection criteria as required. Then choose Execute .
4. The Combined Run Header Information screen appears.
5. Choose Summary .
6. The Summary of Combined Run Report screen appears.
7. In the Accounting section, note the batch number .

8. Open another session and choose Accounting  Financial Accounting  General Ledger  Document 
 Display  .

9. The Display Document: Initial Screen appears.
10. Choose List .
11. The Document List screen appears.
12. Enter the company code and in the Reference key field, enter the batch number that you noted from the 

Combined Run Report followed by an asterisk. Then choose Execute .
13. The Document List screen appears with a list of documents that correspond with the company code and 

batch number that you entered.
14. Double click on a line for the document you want to review.

The Document Overview screen appears with the accounts and corresponding amounts.

1. Double click on line items as required for more detailed information.

9.8.3  Using Valuation Reject - Selection for Deletion

Use

Rejects from prior runs are automatically selected for processing. With this transaction you can review any 
rejects from prior runs, and you can delete rejected transactions as required so that they are not processed in 
future Valuation jobs.

Procedure

1. At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting  Revenue 
Accounting  Valuation  Valuation Processing  Valuation Rejects Selection for Delete .

2. The Valuation Rejects: Selection for Delete screen appears.
3. Enter data as required. To enter prior period notifications for a specific sales date, enter a date or range of 

dates.
4. Specify the scope of the list and then choose Execute .
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5. The Valuation Rejects: Selection for Delete screen appears.
6. To prevent the system from processing a reject further, select the reject and then choose the Del Ind that 

corresponds with the reject.
7. Save the valuation reject selections.

9.8.4  Using Valuation Prior Period Notification Selection 

Use

Use this transaction to select a user-generated prior period notification (PPN) for processing or delete it, as 
required.

You can also use this transaction to display PPNs resulting from the Production and Contractual Allocation 
application areas. These PPNs are automatically generated by the system and transmitted to Valuation.

Procedure

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Revenue Accounting 
→ Valuation → Valuation Processing → Valuation Prior Period Notification Selection

The Valuation Prior Period Notification Selection screen appears.

Enter data as required. To retrieve prior period notifications for a specific production date, enter a date or range 
of dates.

Specify the scope of the list for the system to retrieve by choosing the required Delete and/or Re-Process radio 
buttons as required. Then choose Execute .

The Valuation Prior Period Notification Selection screen appears.

To delete a PPN and therefore prevent further processing of it, select the Del Ind. for the PPN.

OR

To process a PPN, select the Rpr Ind for the PPN.

You can identify any PPNs that the system automatically generated by reviewing the Del Ind. and Rpr Ind 
indicators, which are grayed out and cannot be used for automatically-generated PPNs. Also, the descriptions 
of reason codes for automatically-generated PPNs include the words volume change.

Save your entries.
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9.8.5  Creating Manual Prior Period Notifications 

Use

Use this transaction to create a prior period notification (PPN) manually. A PPN can be created manually for a 
unit property or division of interest (DOI) for any reason.

This transaction could be used if, for example, you decide to create a PPN after bypassing the prompt to create 
a PPN at the Prior Period Notification dialog box.

Procedure

At the SAP Easy Access screen, chose Logistics → Production and Revenue Accounting → Revenue Accounting → 
Valuation → Valuation Processing → Valuation Manual Prior Period Notification → Create

The Create Manual Prior Period Notifications: Selection Screen appears.

Enter data as required, including either a well completion or measurement point. Then choose Enter .

The Create Manual Prior Period Notifications: Overview screen appears.

Delivery network IDs that correspond with the data you entered on the selection screen appear. To create a 
PPN, enter a reason that corresponds with the production date(s).

To remove a reason entered in error, select the row with the incorrect reason and choose Clear Sel. Records .

To review the selection criteria that produced the delivery network IDs, choose Selection Criteria .

Save the manual prior period notification(s).

 

 

 

9.9 Valuation Batch Process 

Use

The Valuation Batch Process represents the automatic processes that builds Valuation records required to 
value volumes. The Valuation Batch Process includes the following areas:

● Selection Functions – Begins building Valuation records
Optimizer – Ensures efficient and successful processing of networks
Mainline Controller – Performs functions to determine value
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Valuation batch processing can be either scheduled or executed on-demand.

Features

Selection Functions

The following Selection Functions build Valuation records and report the processing status of the data that you 
enter.

Table 67:

Selection Function Description

Current Selections Processes current period records

VCR PPN Selections Processes prior period notifications for valuation cross refer­
ences

Reject Selection Processes rejected records

The selection functions extract values and volumetric data from Production and Contractual Allocation, and 
they also calculate taxes.

Optimizer

The Optimizer takes the Valuation records begun by the Selection Functions and retrieves a unique ID number 
that is used to organize all of the records by network and sales date.

It use the Activate for Specific Client Customizing table to determine how many parallel mainline controller 
processes have been specified. If nothing is specified in the table, the system uses a default of 10 parallel 
processes.

The Optimizer starts the mainline controller jobs.

Mainline Controller

Each mainline controller job processes all of the transactions within a given network/sales-date combination.

The system first processes networks with the greatest number of transactions for a given network and sales 
date. (A Valuation transaction is a physical record containing the attributes of an oil or gas sale.) Further, the 
system launches unit properties before other networks. When the system successfully processes a network/
sales date combination, it submits a new set of network/sales date combinations to be processed.

You can monitor the progress of a cycle by network—each network shows real-time status, such as waiting, 
running, and finished. If a network abends, the system stops processing only for that particular 
network.Processing of other networks is not affected.

You can maintain a network immediately after the system processes it, even if the system is still processing 
other networks, and access its reports .

Mainline Controller
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Mainline processing drives each parallel process to ensure that the system performs the following major 
functions for Valuation:

● Edits and Validations of Valuation records
● Volume Extractions for Valuation records
● Valuation Formula Processing
● Unit to Tract , which breaks down records to the tract level for unit properties
● Tax Processing calculates tax amounts and updates tax tables for Tax and Royalty processing
● Oil and Gas Statement Updates , which update current month databases with tax information for Oil and 

Gas Statements
● Valuation Report Updates
● Valuation History Table Updates handle records that the system has processed through Valuation 

successfully, and updates network processing status and history tables
● Valuation Rejects Update deletes rejected records and prior period notifications marked for deletion
● RD Processing summarizes records and creates a file for Revenue Distribution processing, and processes 

all steps for reversal and bookings in Revenue Distribution
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9.9.1  Debugging the Valuation Batch Cycle

Use

Use the following rules when debugging the Valuation Batch Cycle in order to investigate problems in Valuation 
and Revenue Distribution.

Prerequisites

● If you are working in a productive system, confirm that debugging is absolutely necessary. Debugging is 
risky in a productive system because it can easily lead to inconsistencies. It can also result in long-lasting 
data base locks which can affect number ranges, for example.

● The debug mode is set for debugging, NOT the normal mode. To confirm that the system is in debug mode, 
go to SM50 and review the work process. Verify that the system is displaying Stopped in the Status column 
and Debug in the Reason column for that work process.

Note

You should not use the normal mode to debug because if you do, data base commits cannot be rolled back.

Features

● The system handles a debugging session in debug mode by assigning the session its own work process. 
The work process is not available until the debugging session is finished.

● It is possible to debug SELECT-ENDSELECT –loops.

● Generation of a program load issues a database commit. This occurs only in development systems; it is 
suppressed in productive systems.

9.10 Valuation Selections Process 

Use

The Valuation Selections Process builds system documents containing the prerequisite information required to 
collate data that is later posted in various accounting ledgers after the system completes Revenue Distribution 
processing.

You can maintain and view the system documents by using the Valuation Document Work List [page 339] 
transaction.
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Features

The Selections Process handles contract diversity , when more than one marketing representative sells the 
same product, as well as settlement diversity , when a royalty owner has negotiated a formula calculation that 
is different than the calculation for other owners.

Further, the Selections Process generates data for the Selections Report in order to provide information about:

● networks processed in the current month
● networks that were rejected and have been reprocessed
● prior period notification (PPN)

To prevent duplicate processing of PPNs and rejected, reprocessed networks, the system automatically clears 
the PPN and reject tables.

9.11 Valuation Reports 

Use

The Valuation Selection Report and the Combined Run Report are available for you to monitor Valuation 
processing.
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You can also monitor the status of records that the system is processing in Valuation by using the Valuation 
Document Work List [page 339] .

9.11.1  Valuation Selection Report 

Use

Use the Valuation Selection Report to display the processing status for each combination of :

delivery network

sales date

frequency code

major product code

If there has been a change that affects a valuation cross reference, the system produces a prior period 
adjustment (PPA) and displays a description of the PPA in the report under PPA columns.

Further, if the system could not process completely a particular delivery network / sales date/ frequency 
code / major product code combination, the system displays a reason describing the incomplete processing in 
the report under Reject columns.

Activities

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting   → Revenue Accounting 
→ Valuation → Valuation Processing → Reports → Valuation Selection Report

The Valuation Selection Report screen appears.

Specify data for the system to use when retrieving records.

The system will retrieve any records that contain the data you specify. The more data that you enter, the more 
restricted the resulting set of records will be.

Choose Execute .

The Valuation Selection Report Overview screen appears.

To review details about the processing of a particular delivery network / sales date / frequency code / major 
product code combination, double-click on a Report ID.

The Valuation Selection Report screen (2) appears.

Use the Valuation Selection Report screen (2) to review the details of processing, including entity and contract 
numbers and any PPA or reject description.

Exit the report.
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9.11.2  Using the Combined Run Report 

Use

Use this report to verify allocation results before posting the results.

The Combined Run Report displays records that have been processed all the way through PRA, that is, through 
Valuation and on through Revenue Distribution. The system matches transaction history record with 
associated journal entries created in the allocation process in order to generate a detailed report of allocation 
activity.

Most records are produced by the Valuation components, although Check Input and other components 
produce records as well.

Activities

Displaying the Combined Run Report

At the SAP Easy Access menu, choose Logistics →  Production and Revenue Accounting → Revenue Accounting 
→ Valuation → Valuation Processing → Reports → Combined Run Report

The Combined Run Report screen appears.

Enter selection criteria as required. Then choose Execute .

The Combined Run Header Information screen appears.

For a print preview of a record, select the record and then choose Views → Print preview

The date on the upper right corner of the report represents the actual run date.

To display details of the records, choose a record and select Details .

The Combined Run Detail Information screen appears.

The tabs on the Combined Run Detail Information screen provide the following additional information.

--The Accounting tab displays account distributions:

Batch number

Account numbers and descriptions
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Debits and credits

--The Owner tab displays information about owner detail distributions:

Owner number and type

Pay code and suspense code

Owner disbursement decimal

Owner share of volume, value, deducts and taxes

--The Marketing tab displays marketing costs and reimbursements.

--The Taxes tab displays tax percentages and amounts, including any reimbursement amounts.

Identifying the Corresponding FI Document

At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue Accounting → 
Valuation → Valuation Processing → Reports → Combined Run Report

The Combined Run Report screen appears.

Enter selection criteria as required. Then choose Execute .

The Combined Run Header Information screen appears.

Choose Summary .

The Summary of Combined Run Report screen appears.

In the Accounting section, note the batch number.

Open another session and choose Accounting   → Financial Accounting → General Ledger → Document → Display

The Display Document: Initial Screen appears.

Choose List .

The Document List screen appears.

Enter the company code. Then in the Reference key field, enter the batch number that you noted from the 
Combined Run Report.

The Document List screen appears with a list of documents that correspond with the company code and batch 
number that you entered.

Double click on a line for the document you want to review.

The Document Overview screen appears with the accounts and corresponding amounts.

Double click on line items as required for more detailed information.

 

 

9.12 Oil and Gas Run Statements 
Use
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Valuation features functions to enter oil and gas statement profiles, and to build statements from current data 
with the Valuation Document Work List [page 339] .

Further, you can use list processing to view statements, and to generate statements for a prior month, not just 
for a current run.

9.12.1  Creating or Maintaining an Oil Statement Profile

Use

Use this transaction to specify the venture/division of interest, measurement point, and contract information 
required for statements that are printed in a batch job every month. Individual statements can be accessed and 
printed ad hoc as required.

The ad hoc statements report all run ticket data for a required sales month, while monthly statements report 
the ticket data that has been valued since last month’s statements.

Procedure

1. At the SAP Easy Access screen, choose Logistics  Production and Revenue Accounting  Revenue 
Accounting  Valuation  Oil and Gas Run Statements  Oil Statement Profile  .

2. The Oil Statement Profile: Initial Screen appears.
3. Choose Create .
4. The Create Oil Statement Profile: Application Maintenance screen appears.
5. Enter data as required, including:

● In the Owner/Recipient field, enter the recipient, which could be a purchaser.

Note

It is not required to enter the owner for the Venture/DOI in this field.

● In the Number of Copies field, enter the number of copies to be printed.

1. Save the oil statement profile.

Using a Reference to Create an Oil Statement Profile

1. To create an oil statement profile with reference to an existing record, at the Oil Statement Profile: Initial 
Screen , enter data as required. Then choose Execute .

2. If more than one record matches the data you entered, the Oil Statement Profile: List Viewer screen 
appears. In this case, select one of the profiles from the list.

3. OR
If only one record matches the data you entered, a single record is displayed.

4. Choose Create to create a new record with the data from the record you selected.

Changing of Displaying an Oil Statement Profile
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1. To change or display an oil statement profile, at the Oil Statement Profile: Initial Screen , enter data as 
required. Then choose Execute .

2. If more than one record matches the data you entered, the Oil Statement Profile: List Viewer screen 
appears. In this case, select one of the profiles from the list.

3. OR
If only one record matches the data you entered, a single record is displayed.

4. Choose Change or Display to change or display the record as required.

9.12.2  Oil Statement List Processing

Use

Use this transaction to review a group of monthly oil statements with details about what data is included on a 
statement, and when a report was generated.

Procedure

1. At the SAP Easy Access screen, choose Logistics  Production and Revenue Accounting  Revenue 
Accounting  Valuation  Oil and Gas Run Statements  Oil Run Statement List Processing  .

The Oil Statement Report List Processing: List Viewer screen appears.

1. Enter data as required. Then choose Execute .

The Oil Statement Report List Processing: List Viewer screen appears.

1. Review the reports listed, and note the run date , which indicates when the statement report was 
generated.

1. Exit the list viewer.

9.12.3  Creating or Maintaining a Gas Statement Profile

Use

Use this transaction to specify the venture/division of interest, measurement point, and contract information 
required for statements that are to be printed in a batch job every month. Individual statements can be 
accessed and printed ad hoc as required.

Actual, entitled, or settlement amounts will be reported.
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Procedure

1. At the SAP Easy Access screen, choose Logistics  Production and Revenue Accounting  Revenue 
Accounting  Valuation  Oil and Gas Run Statements  Gas Statement Profile  .

2. The Gas Statement Profile: Initial Screen appears.
3. Choose Create .
4. The Create Gas Statement Profile: Application Maintenance Screen appears.
5. Enter data as required, including the number of copies to be generated.
6. Save the gas statement profile.

Result

A batch job generates gas statements based on the records entered in this transaction.

Using a Reference to Create a Gas Statement Profile

1. To create a gas statement profile with reference to an existing record, at the Create Gas Statement Profile: 
Initial Screen , enter data as required. Then choose Execute .

2. If more than one record matches the data you entered, the Gas Statement Profile: List Viewer screen 
appears. In this case, select one of the records from the list.

OR

If only one record matches the data you entered, a single record is displayed.

1. Choose Create to create a new record with the data from the record you selected.

Changing or Displaying a Gas Statement Profile

1. To change or display a gas statement profile, at the Gas Statement Profile: Initial Screen , enter data as 
required. Then choose Execute .

1. If more than one record matches the data you entered, the Gas Statement Profile: List Viewer screen 
appears. In this case, select one of the records from the list.

OR

If only one record matches the data you entered, a single record is displayed.

1. Choose Change or Display to change or display the record as required.

9.12.4  Gas Statement List Processing

Use

Use this transaction to review a group of monthly gas statements with details about what data is included on a 
statement, and when a report was generated.
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Procedure

1. At the SAP Easy Access screen, choose Logistics  Production and Revenue Accounting  Revenue 
Accounting  Valuation  Oil and Gas Run Statements  Gas Statement List Processing  .

The Gas Statement Report List Processing screen appears.

1. Enter data as required. Then choose Execute .

The Gas Statement Report List Processing: List Viewer screen appears.

1. Review the reports listed, and note the run date , which indicates when the statement report was 
generated.

1. Exit the list viewer.

9.12.5  Running the Oil and Gas Statement Reports 

Purpose

Use these steps to run the oil and gas statement reports.

You create oil and gas statement profiles by using the Oil Statement Profile [page 355] and the Gas Statement 
Profile [page 356] transactions.

SAP recommends that you execute the statement generation and print programs in the same background job, 
as described in Part 3 below. If the generation job were to be run multiple times prior to the print job, the data 
for initial generation could be overwritten with the print job showing only the most recent set of data.

Process Flow

Part 1 of 3 - Verify Entries in the OIUVL_CM_STAT Table

Verify that the following data is entered in the report print programs.

Table 68:

Field Name Oil Statement Entries Gas Statement Entries

KSCHL OI01 GA01

NACHA 1 1

358 C U S T O M E R
SAP Oil & Gas (PRA - Production and Revenue Accounting)

Valuation 



Field Name Oil Statement Entries Gas Statement Entries

PGNAM ROIUVL_OIL_RPT_STATEMENT_PRINT ROIUVL_GAS_RPT_STATE­
MENT_PRINT

RONAM PRINT_STATEMENT PRINT_STATEMENT

FONAM OIUVL_OIL_STATEM OIUVL_GAS_STATEM

In the fields LDEST and DSNAM, make your customer-specific entries.

Part 2 of 3 - Creating Variants for the Oil and Gas Statement Print Programs

From the SAP Easy Access menu, choose Tools → Development → ABAP Editor

In the Program field, enter eitherROIUVL_OIL_RPT_STATEMENT_PRINTfor the oil report 
orROIUVL_GAS_RPT_STATEMENT_PRINTfor the gas report .

Choose Goto Variants

In the Variant field, enter a name for the variant. Then choose Create .

Leave the P_LOGNUM field blank, and in the P_RUN_DT field, enter the date for which the report is needed.

Choose Back . When the system prompts you to save, choose Yes .

The ABAP: Save Attributes of Variant <name> screen appears.

Complete the Description field.

Choose Save and exit.

Part 3 of 3 - Define Background Job

Choose System Services Jobs Define jobs

Complete the Job name and Job class fields.

Choose Step .

The Create Step 0 dialog box appears.

Verify that in the Name field, eitherROIURV_OIL_RPT_STATEMENTorROIURV_GAS_RPT_STATEMENTis 
displayed.

Choose Save .

The Define Background Job screen appears.

Choose Save again. Then choose Step .

Choose Create .

The Create Step 0 dialog box appears.

Choose ABAP Program to enable the Name , Variant , and Language fields. Then enter the following data:

● In the Name field, enter 
eitherROIUVL_OIL_RPT_STATEMENT_PRINTorROIUVL_GAS_RPT_STATEMENT_PRINT

● In the Variant field, enter the name of the variant created in Part 2.
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Choose Save .

The Step List Overview screen appears.

Choose Back .

The Define Background Job screen appears.

Choose Start condition .

The Start Time dialog box appears.

Either choose Immediate to run the program immediately, or choose Date/Time to schedule a run.

Choose Save .

The Define Background Job screen appears.

Choose Save .

The system displays the status.

Choose Job overview .

The Simple Job Selection screen appears.

Choose Execute .

Select your job and choose Spool .

Either print out the report by selecting the spool and choosing Print or display the output by choosing the icon 
in the column Type .

9.13 Using the Run Ticket Inquiry

Use

Use this transaction to view information about oil run tickets for a selected property and measurement point.

Procedure

1. At the SAP Easy Access screen, choose Logistics  Production and Revenue Accounting  Revenue 
Accounting  Valuation  Oil and Gas Run Statements  Run Ticket Inquiry  .

2. The Run Ticket Inquiry screen appears.
3. Enter data as required. Then choose Execute .
4. The Run Ticket Inquiry List Processing screen appears.
5. Review the run ticket details. Then exit the function.
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9.14 List Processing

Use

Use list processing to retrieve and review data as required.

Activities

Using Multiple Selection

Often to the right of the input fields the system displays an icon with a yellow arrow. This is the Multiple 
selection icon, which allows you to enter multiple sets of data as criteria for the system to use when executing a 
report. For example, you could use the Multiple selection feature to specify more than one range of numeric IDs 
(1-50 and 60-100) and at the same time exclude a value (not ID number 75).

If more than one selection is entered, the system displays the arrow in green because the system cannot 
display all of the selection criteria on the initial screen at one time.

Multiple Selection Features
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Table 69:

Feature Description

1. Select single values Use this to enter single values to be retrieved for the report.

2. Select ranges Use this to enter a range of values to be retrieved for the re­
port.

3. Exclude single values Use this to enter single values to be excluded from the re­
port.

4. Exclude ranges Use this to enter a range of values to be excluded from the 
report.

5. Entity lookup Enables a lookup on the entity.

6. Delete entire selection Delete all values that you entered in the dialog box.

7. Delete line Deletes the value from the line in which the cursor is placed.

8. Insert line Inserts a new line above the field on which the cursor is 
placed.

9. Selection operators Retrieves a list of selection operators ( , ≥ , , , , ) that can be 
used with the input values.

Using Selection Screen Variants

Use a variant to establish a set of values that will be used on a regular basis to run a report. By setting up a 
variant, you eliminate the need to enter a set of data more than one time. When you retrieve a variant, the 
values you specified in the variant default into the corresponding fields on the screen.

Creating a Variant

1. On the List Processing screen, enter the values to be included in the set of values for the variant.

2.
Any values that you include by using Multiple Selection are included in the variant.

3. Choose Goto  Variants  Save as variant  .
4. In the Variant name field enter a name or ID for the variant. In the Description field enter a description for 

the variant.
5. Choose Save to return to the List Processing screen.

Retrieving a Variant

1. From the List Processing screen choose Goto  Variants  Get  .
2. The system displays a dialog box with a list of variants.
3. Select a variant and then choose Enter to return to the list processing screen.

The system inserts the values specified in the variant into the corresponding fields.

List Viewer Navigation Functions
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After you choose a variant and/or enter data on the initial screen and choose Execute , the system displays the 
results on a List Viewer screen. Some of the functions available on the List Viewer screen follow.

Table 70:

Viewing Details of a Record 

● To view details of a record, select the appropriate record 
and choose Details .

Viewing Data in Ascending Order 

● To sort data in ascending order, select the column by 
which you will sort in ascending order. Then choose Sort 
in ascend. order .

Viewing Data in Descending Order 

● To sort data in descending order, select the column by 
which you will sort in descending order. Then choose 
Sort in descend order .

Finding a Record 

● To find a record in the report, choose Find . Then enter 
selection criteria.

Using the Filter 

● To limit the number of records shown in the report, se­
lect the column for which you will set the filter. Then 
choose Set filter and enter criteria for the filter.

Printing the Report 

● To print the data displayed in the List Viewer, choose 
Print .

Export the Report 

● To save the data displayed in the List Viewer as a file, 
choose Export .

Changing the Format of the Report 

● To select a different format for the report, choose 
Views .
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10 Check Input 

Purpose

The Check Input application area processes payments received from third party purchaser or remitter 
remittance statements into the SAP Oil and Gas system and involves the standardization of data .

Note
The standardization involves the editing and translation of purchasers’ data into the necessary standard 
data types and formats so that it can be processed.

Payments can be processed automatically, through CDEX, or they can be entered into the system 
manually.Further, there are options to process payments for recording income, expenses, and royalty 
payments for non-material interests.

Check Input allows you to define formats that represent the remitter’s check stub layout in order to facilitate 
data entry.Further, Check Input utilizes batch data input to organize and process information.

Check Input automated processing :

● Credits accounts receivable and debits cash clearing
● Creates valuation input
● Suspends line correction – errors are automatically suspended, then automatically reprocessed upon 

completion of master data set up.A write-off process is also available to remove unwanted or non-material 
errors.

● Supports intercompany receivables with cash transfers from affiliated companies and makes the 
corresponding intercompany journal entries.

● With the Check Stub Data Exchange (CDEX) interface , Check Input receives check detail and processes 
payments from purchasers electronically

Integration

● Creates accounts receivable and cash journal entries through the Journal Entry application area
● Sends sales data into the Valuation application for further distribution to revenue allocations and journal 

entries.
● Utilizes division order accounting rules for processing determination
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10.1 Creating or Maintaining Check Layouts 

Use

Use this transaction to establish and maintain check layouts for the input of check data.Since each remitter 
uses a different check format, the system uses a layout to map a remitter’s data into standard Check Input 
fields for further processing.

Procedure

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Revenue 
Accounting Check Input Master Data Check Layout  .

Choose Create .

Enter the following data as required.

● In the Seq field, specify the order in which the associated field name will appear in the check layout.
● In the Field Name field, enter the names of the fields to be included in the check layout.
● In the Override Field Name field, enter a description of the field name that will be used in place of the 

already existing description throughout Check Input.You could use this field to rename a field in order to 
match the actual field name on the check detail.

● In the Calc Net field, specify whether the corresponding Field Name is used to calculate the net amount.
● To sum the field for all equal records in a check (that is, records with the same property number, sales from 

date, remitter product code, etc.), select the Sum indicator.

Note
The Approved indicator must be selected before the layout can be cross-referenced to a remitter in the 
Remitter / Layout Cross Reference.

● Save your entries.

See also:

Creating or Maintaining a Ck. Input – Remitter / Layout Cross Reference [page 366]

Using a Reference to Create a Check Layout

To create a check layout with reference to an existing record, enter data as required in the Check Layout: Initial 
Screen .Then choose Execute .

If more than one record matches the data you entered, select one of the records from the list.

OR

If only one record matches the data you entered, the single record is displayed.

Choose Create to create a new record with the data from the record you selected.

Changing or Displaying a Check Layout
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To change or display a check layout, enter data as required in the Check Layout: Initial Screen .Then choose 
Execute .

If more than one record matches the data you entered, select one of the records from the list.

OR

If only one record matches the data you entered, the single record is displayed.

Choose Change or Display to change or display the record as required.

10.2 Creating or Maintaining Ck. Input - Remitter / Layout 
Cross Ref. 

Use

Use this transaction to assign a specific check layout to a remitter. This assignment must be established before 
the layout can be accessed in other Check Input transactions.

Prerequisites

The check layout that you will link the remitter to is complete. To create or maintain a check layout, use the 
Check Layout [page 365] transaction ( Logistics → Production and Revenue Accounting → Revenue Accounting 
→ Master Data → Check Layout ).

Procedure

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Revenue Accounting 
→ Check Input Master Data → Remitter/Layout Cross Reference

The Check Input - Remitter / Layout Cross Ref screen appears.

Choose Create .

The Check Input - Remitter / Layout Cross Ref screen (2) appears.

Enter data as required.

Though the remitter may be tied to several different layouts, only one layout may be designated as the default.

To enter free-form text comments, choose Comments .

Save your entries.
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Using a Reference to Create a Check Input - Remitter / Layout Cross Reference

To create a check input - remitter / layout cross reference record with reference to an existing record, at the 
Check Input - Remitter / DOI Cross Ref screen, enter data as required. Then choose Execute .

If more than one record matches the data you entered, select one of the records from the list.

OR

If only one record matches the data you entered, the single record is displayed.

Choose Create to create a new record with the data from the record you selected.

Changing or Displaying a Check Input / Remitter / Layout Cross Reference

To change or display a check input - remitter / layout cross reference record with reference to an existing 
record, at the Remitter / DOI Cross Ref screen, enter data as required. Then choose Execute .

If more than one record matches the data you entered, select one of the records from the list.

OR

If only one record matches the data you entered, the single record is displayed.

Choose Change or Display to change or display the record as required.

10.3 Check Input Process Rules 

Use

Use this transaction ( Logistics → Production and Revenue Accounting → Revenue Accounting → Check 
Input → Master Data → Process Rules) to establish and maintain processing rules to be used if it is 
necessary to manipulate check field values when a remitter’s check is processed.

In order to determine the value for a specific layout field, the factor 1 and factor 2 fields (either a field value or a 
fixed, constant value) act on each other as directed by the function.

Prerequisites

A check layout exists with the fields to which the process rules will apply.

Activities

Setting Up Rules by Product

You can set up a unique rule for a remitter’s product by setting up the rule with the Default Process Rule 
indicator (see description below) deselected.
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When you set the Default Process Rule indicator, then the rules entered on this screen are the default rules for 
the remitter ID, layout ID, and product combination.

You must then do the following:

Complete the Override Process Number field to specify that the normal processing rules will not be used.

Complete the Product field in order to specify the product to which the unique rule applies.

Reference the override process number in the transaction in order to make the rules available to the system for 
processing.

The resulting value is displayed in the Result Field for the specified layout.

Example

If a remitter sends check deduction values as positive, you can use this transaction to set up rules that multiply 
the remitter’s deduction values by –1.

10.4 Creating or Maintaining Product / Property 
Translations 

Use

Use this transaction to establish and maintain translations of a remitter’s code value for a product or property 
into a recognized SAP Oil and Gas System value.

The system uses translations when remitter check detail lines contain values that do not correlate directly to 
SAP values.For example, a remitter may identify an oil product as OIL while SAP identifies the same product as 
100 .

This transaction provides a method to translate remitter values into SAP values.

Prerequisites

The check layout for which you will create the product / property translation is complete and linked to a 
remitter.For information about completing a check layout and linking it to a remitter, see Creating or 
Maintaining Ck. Input - Remitter/Layout Cross Reference [page 366] .
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Procedure

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Revenue 
Accounting Check Input Master Data Translations  .

The Product / Property Translations screen appears.

Choose Create .

The Product / Property Translations screen (2) appears.

Enter the remitter ID and the layout ID.Then continue entering data.

Save your entries.

Using a Reference to Create Product / Property Translations

To create a product / property translation record, at the Product / Property Translations screen, choose 
Execute .

If more than one record matches the data you entered, select one of the records from the list.

OR

If only one record matches the data you entered, the single record is displayed.

Choose Create to create a new record with the data from the record you selected.

Changing or Displaying Product / Property Translations

To change or display a product / property translation record, at the Product / Property Translations screen, 
choose Execute .

Select one of the records from the list.

OR

If only one record matches the data you entered, the single record is displayed.

Choose Change or Display to change or display the record as required.

Meridian Translations

Meridian frequently changes their property numbers on incoming check information while the corresponding 
PRA cross reference information remains the same.

The property numbers sent are formatted with the first five characters identifying the property number, and 
the remaining characters comprise the contract and meter numbers.The property number does not change, 
while the contract and meter numbers do change.

To handle the situation, in the Remitter Code field, you could enter the first five characters of the stable 
property number followed by the word MERIDAN .

10.5 CDEX Company Product Cross Reference 

Use
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Use this transaction ( Logistics Production and Revenue Accounting Revenue Accounting Check Input
Master Data CDEX Company Product Cross Reference  ) to create and maintain a cross reference from a 

CDEX product code (which is two characters) and a PRA product code (which is three characters).

10.6 CDEX Remitter Cross Reference 

Use

Use this transaction ( Logistics Production and Revenue Accounting Revenue Accounting Check Input
Master Data CDEX Remitter Cross Reference  ) to create and maintain a cross reference between a CDEX 

remitter number and a PRA remitter number.

10.7 Using the CDEX Workplace 

Use

Use this transaction to do the following:

Load files that have been downloaded previously from CDEX

Review and validate these files

Based on these files, create checks for the PRA Payment Posting Desktop transaction

A file is displayed on a single line in the CDEX Workplace transaction. (A single line represents one check.)

Procedure

From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Check Input → Document Entry → CDEX Workplace

To load CDEX files that have been downloaded previously from CDEX, choose Load CDEX . Then complete the 
resulting CDEX Load dialog box with one of the following options:

To copy the CDEX input file to a backup file and delete the original file, complete both the Input File name and 
the Backup File name fields.

To load the CDEX file without creating a backup file or deleting the original file, complete only the Input File 
name field.

To review the status of CDEX files, review the Status column at the CDEX Workplace – Check View screen.
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A red light indicates that there are errors; you can review information about the reason for an error in the Rej 
rsn column.

To correct master data (for example if a remitter was not set up correctly), choose Validate after the master 
data has been corrected.

To create check(s) in the Payment Posting Desktop , select the line for the check and choose Create .

Result

After the system successfully creates a check, the system deletes it from the CDEX Workplace transaction and 
it becomes available in the PRA Payment Posting Desktop [page 371] for further processing.

10.8 PRA Payment Posting Desktop 

Use

This transaction ( Logistics Production and Revenue Accounting Revenue Accounting Check Input
Document Entry PRA Payment Posting Desktop  ) processes data for purchasers’ payments and tracks the 
following:

● Property from which product was purchased
● Quantity of the product
● The month in which the product was purchased

Special Distribution

If there are multiple partners in a division of interest who are due proceeds based on to the percentage of their 
share in a property, Check Input supports the distribution of revenue from the check received among the 
partners according to the percentage of the property owned by each partner.

Features

The PRA Payment Posting Desktop transaction displays check details on the Payment Posting Desktop – 
Worklist Screen , including the following details:

● The Ctrl Check Amt column displays the user-calculated or CDEX-calculated total of a check’s line items
● The Calc Check Amount column displays the system-calculated total of a check’s line items.
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Caution
The system cannot process a check if there is a difference between the control check amount and the 
calculated check amount. If there a difference exists, it is displayed in the Amt Diff column.

● An X in the VL/RD column indicates that the amount of the corresponding line item(s) of a check must be 
distributed among the partners in the division of interest.

Note
The system displays an X in this column even if only one of the lines needs distribution. (That is, an X in 
this column does not necessarily indicate that all of the line items should be distributed among the 
partners in the division of interest.)

● The Check Status column indicates the stage of the check throughout the life cycle of the check.

Note
When a check has a status of 46 ( Posted Fully ), it cannot be processed further.

● The Dtl Recs column displays the number of line items for a check.

Activities

You can carry out the following activities with this transaction:

● Display checks [page 372]
● Copy and change check line items [page 374]
● Change a value across line items [page 374]
● Import check line items from a spreadsheet [page 374]
● Enter checks manually [page 373]
● Value checks [page 374] (that is, carry out a trial run) so that you can review and verify check details in the 

Combined Run report before posting checks
● Write off suspended lines [page 374]
● Post checks [page 374]
● Delete checks [page 374]
● Schedule checks for background processing [page 374]
● Mark checks to be processed in mass [page 374]

10.8.1  Displaying Individual Checks 

From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Check Input → Document Entry → PRA Payment Posting Desktop

Enter selection criteria to specify the set of checks that the system will retrieve and choose Execute .

The Payment Posting Desktop – Worklist Screen appears.
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Select the line that corresponds with the check you would like to display, and then choose Display .

The Payment Posting Desktop – Displaying Check screen appears.

To review details about how a check was created, choose Attributes .

Review the status of the Check Amount according to the symbol adjacent to the Check Amount field. The 
system displays one of the following symbols:

An equal sign (=) if the check amount balances with the total of the line items

A less than sign (<) if the check amount is less than the total of the line items

A greater than sign (>) if the check amount is greater than the total of the line items

Review the status of check line items by noting the symbol displayed in the Status column.

The write-off symbol is visible only if the check has the status “booked partially”.

Choose the following options as required:

To review information about the SAP documents that the system generates after a check is valued or posted, 
choose Booked Documents .

The resulting dialog box displays information about a cash batch, and if applicable, any Valuation documents 
generated to distribute revenue among partners in a division of interest.

To view line items that are relevant for Valuation/Revenue Distribution processing, choose Aggregate key fields .

The system then highlights the relevant line items.

To view line items in the order in which they were entered, choose Undo aggregation .

10.8.2  Entering Checks Manually 

1. From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Revenue 
Accounting Check Input Document Entry PRA Payment Posting Desktop  .
The Payment Posting Desktop – Selection Screen appears.

2. Choose Create .
The Payment Posting Desktop – New Check screen appears.

3. Enter data as required and save your entries.

Note
○ The Chk Layout field layout is a required field because it controls the check format.
○ The system uses the following data to determine whether you are making duplicate entries for a 

check:
○ Remitter number
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○ Remitter sequence number
○ Check number

10.8.3  Maintaining Individual Checks 

From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Check Input → Document Entry → PRA Payment Posting Desktop

Enter selection criteria to specify the set of checks that the system retrieves, and choose Execute .

The Payment Posting Desktop – Worklist Screen appears.

Select the line that corresponds with the check you would like to display, and then choose Display .

The Payment Posting Desktop – Displaying Check screen appears.

Choose the following options as required:

To change a check line item, select it and choose Toggle Display or Edit Mode .

To copy a check line item, select the line item and choose Copy <object> .

To write off a suspended line, choose Write Off Suspended Line(s) so that the amount will be posted to a write 
off account.

To change a value across multiple line items at one time, select a column and as many rows as required, 
highlighting the intersection of the column and rows. Then choose Carry Out a Mass Change . In the resulting 
Enter Replacement Value dialog box, enter a new value for the system to assign to each of the relevant rows.

To import line items from a spreadsheet, in the spreadsheet select the rows to be imported and choose the 
copy function in the spreadsheet. (By doing this you post the copied data to the clipboard.) Then, in the 
Payment Posting Desktop – Editing Check screen, choose Import to import the data from the clipboard to the 
screen.

The data to be imported from the spreadsheet must be formatted with exactly the same columns as the 
columns used in the check layout.

10.8.4  Processing Checks 

Use

Use the following options available in the Payment Posting Desktop transaction to process checks.
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Prerequisites

Checks downloaded from CDEX have been processed through the CDEX Workplace [page 370] successfully, 
thereby making the checks available for processing in the Payment Posting Desktop .

Procedure

From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Check Input → Document Entry → PRA Payment Posting Desktop

After entering selection criteria to specify the set of checks that the system retrieves, choose Execute .

The Payment Posting Desktop – Worklist Screen appears.

Select one or more checks to carry out the following options as required:

To carry out a trial run so that you can review and verify check details in the Combined Run report before 
posting a check, choose Value .

To view the Combined Run report, choose Combined Run Report .

To post checks, choose Post .

To schedule checks for background processing, choose Schedule as a Background Job .

To mark checks to be processed with the Processing Checks in Mass transaction, choose In Mass Processing.

When you choose In Mass Processing , the system does not automatically carry out mass processing for the 
checks. The system carries out mass processing of the checks only after you execute the Processing Checks in 
Mass [page 376] transaction.

To delete checks, choose Delete .

Processing a Single Check

From the Payment Posting Desktop – Worklist Screen , select a check and choose Display .

The Payment Posting Desktop – Displaying Check screen appears.

Choose Process Check.

The Payment Posting Desktop – Specify Processing Options dialog box appears.

Choose Online . Then choose Continue .
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10.9 Processing Checks in Mass 

Use

This transaction ( Logistics Production and Revenue Accounting Revenue Accounting Check Input
Periodic Processing Processing Checks in Mass  ) processes a large number of checks during off-peak 
hours.

Prerequisites

The checks to be processed in this transaction have been marked for mass processing in the PRA Payment 
Posting Desktop .

Activities

On the initial Incoming Checks – Mass Processor screen, enter selection criteria to specify the set of checks to 
be processed.

Note
You can use the Created by User field to specify the set of checks to be processed based on the user(s) who 
entered them.

10.10  Check Input Reports 

Use

The following Check Input reports are available under the menu path Logistics Production and Revenue 
Accounting Revenue Accounting Check Input Reports  .

● Incoming Check A/R and Prices Variance Report
This report provides a warning to the user that the unit price or net receivable calculated in Check Input 
processing is outside of the user-defined tolerance.
You establish the net receivable tolerance in Common Table TBLCI016, and you establish the price 
tolerance by product code in Common Table TBLCI002.
(The menu path for Common Table maintenance is Logistics Production and Revenue Accounting
Tools Common Table Maintenance  ).

● Suspended Line Items Message Report
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This report provides information about Check Input line items that cannot be posted or processed 
successfully.

10.11  Reviewing FI Documents that Result from CI or CW 
Processing

Use

By using the Job Maintenance and Display Document transactions, you can review the FI documents that result 
from Check Input (CI) or Check Write (CW) processing and verify whether Check Input or Check Write has 
executed properly.

Procedure

1. At the SAP Easy Access menu, choose Tools -> CCMS -> Jobs -> Maintenance .
2. The Simple Job Selection screen appears.
3. In the Job name field, enter either SAP_CHECKINPUT for Check Input or SAP_CHECKWRITE for Check 

Write . Then choose Execute .
4. The Job Overview screen appears.
5. Select the required job and choose Spool .
6. The Output controller: List of Spool requests screen appears.
7. Select the spool and choose Display .
8. Note the reference number .

9. End the session or open another one and choose Accounting  Financial Accounting  General Ledger 
 Document  Display  .

10. Choose List .
11. The Document List screen appears.
12. Enter the company code and in the Reference key field, enter the reference number that you noted in the 

Job Maintenance transaction. Then choose Execute .
13. The Document List screen appears with a list of documents that correspond with the company code and 

the reference number that you entered.
14. Double click on a line for the document you want to review.
15. The Document Overview screen appears with the accounts and corresponding amounts.
16. Double click on line items as required for more detailed information.
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11 Payment Processing 

Purpose

Payment Processing summarizes entries from the General Ledger and the Owners Payable subledger to the 
check stub level, and then determines whether the total amount is to be paid, and whether taxes are to be 
withheld.

The primary transaction in the Payment Processing component is the PRA Payment Processing [page 379] 
transaction ( Logistics → Production and Revenue Accounting → Payment Processing → Period Processing → PRA 
Payment Processing ). The PRA Payment Processing transaction is used to run payment processing jobs, and to 
review the status of completed jobs as well as any exception items.

There are two transactions that support the PRA Payment Processing transaction:

the Bank Details for Payment Processing [page 378] transaction ( Logistics → Production and Revenue 
Accounting → Payment Processing → Master Data → Bank Details for Payment Processing ), with which a user 
specifies the bank accounts to be used to make payments before running the PRA Payment Processing 
transaction

the Exception Reporting [page 383] transaction ( Logistics → Production and Revenue Accounting → Payment 
Processing → Reports → Exception list from payment runs ), which lists the reasons that a payment line or owner 
was not paid. This transaction is meant to be used after a user completes a payment run with the PRA Payment 
Processing transaction.

Features

Optimization

Payment Processing includes optimization features that support performance, infrastructure, and reliability.

For example, to prevent payment processing failure or rejects at latter stages of processing, a validation that 
verifies required account numbers in the Chart of Accounts is incorporated at the beginning of processing.

Also, to prevent the system from re-processing the entire set of owner records that are part of a Payment 
Processing job, the system processes one owner at a time. If processing for one owner fails, therefore, a user 
can restart processing and the system will pick up processing where it stopped for a particular owner.

11.1 Maintaining Bank Details for Payment Processing 

Use

Use this transaction to enter the bank master data required for payment processing.
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Procedure

At the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Revenue 
Accounting Payment Processing Master Data Bank Details for Payment Processing  .

The Bank Data Maintenance: Initial screen appears.

In the Company Code field, enter the company code for which you will set up bank details.Then choose Create .

The Bank Data Maintenance: Create screen appears.

Enter the following data.

● In the Bank ID field, enter the code that identifies the bank from which payment will be generated.
● In the Bank Name field, enter the bank’s name.
● In the Bank Account field, enter the bank account number from which payment will be generated.
● In the Cash Account field, enter the G/L account number to which the cash transactions are booked in 

PRA.
● In the Clearing Account field, enter the G/L account number to which electronic money transfers are 

booked in PRA.
● In the Check Lot field, enter the check lot number.
● Save your entries.

Result

The master data is ready for use in the PRA Payment Processing [page 379] transaction ( Logistics
Production and Revenue Accounting Revenue Accounting Payment Processing Periodic Processing PRA 
Payment Processing  ).

11.2 PRA Payment Processing 

Use

Use this transaction to run payment processing jobs, and to review the status of completed jobs as well as any 
exception items.

Prerequisites

In the Business Associate transaction within Ownership, the Resident Cntry and the Resident Region field on the 
General Data tab are completed for the relevant owner(s) to be processed. To access the Business Associate 
[page 15] transaction, choose Logistics → Production and Revenue Accounting → Ownership → Business 
Associate
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In addition, the following entries are made in the Business Associate record as required.

Payment Frequency

To override the minimum payment amount, set the Pay Frequency to Pay Regardless.

Print Check First (indicator)

To indicate that an owner’s check will be sorted to the top of the output files regardless of attachments or 
postage, select the Print Check First indicator.

Payment Block

To stop all royalty checks from being processed for an owner, set a payment block.

Payment Type

Use this field to designate how an owner is paid. Note that if the owner is paid by means other than a check, the 
payee will still receive a check attachment.

In order for the correct tax amounts to be withheld from owners’ checks, state withholding tax rates must be 
maintained in the Withholding Tax Rate [page 424] transaction ( Logistics → Production and Revenue 
Accounting → Revenue Accounting → Revenue Distribution → Tax Maintenance → Withholding Tax Rate ).

The minimum check amount is defined. To define the minimum check amount, use the Activation for Specific 
Companies Customizing activity by choosing Industry Solution Oil & Gas (Production and Revenue Accounting) 
Global Settings Activate functionality Activation for Specific Companies .

A check number range is defined for a check lot. To enter and maintain a check number range, use the 
Configure Check Numbers Customizing activity by choosing Industry Solution Oil & Gas (Production and 
Revenue Accounting) → Revenue Accounting → Payment Processing → Configure Check Numbers

Each company code is defined with a Federal Backup Withholding Tax Rate. You enter Federal Backup 
Withholding Tax Rates in the common table TBLRD050 for each company code (that is, the org. level 1 
number).

The menu path for the Common Table is Logistics → Production and Revenue Accounting → Tools → Common 
Table Maintenance

The ID, description, and payment methods for the check lot are defined. To enter the check lot data, use the 
Configure Check Lot Customizing activity by choosing Industry Solution Oil & Gas (Production and Revenue 
Accounting) → Revenue Accounting → Payment Processing → Configure Check Lot

Bank master data required for the Payment Processing run is set up. To set up bank master data, use the Bank 
Details for Payment Processing [page 378] transaction ( Logistics → Production and Revenue Accounting → 
Revenue Accounting → Payment Processing → Periodic Processing → PRA Payment Processing ).

The accounting period for which you will run Check Write is closed. To close an accounting period, use the 
Accounting Period Close [page 454] transactionchoose Logistics → Revenue Accounting → Journal Entry → 
Periodic Processing → Accounting Period Close

 

Procedure

At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue Accounting → 
Payment Processing → Periodic Processing → PRA Payment Processing

380 C U S T O M E R
SAP Oil & Gas (PRA - Production and Revenue Accounting)

Payment Processing 



The Parallel Payment Run dialog box may appear if more than one payment run is being processed in the 
system.

Once you proceed past this message, the PRA Payment Processing screen appears.

Enter the following data.

In the Run Date field, the current date defaults. If required, enter another date to identify the payment 
processing job. (The date does not have to be the date on which the job was run.)

In the Identification field, enter an ID for the payment processing job.

In the Check Date field, review the date. This is the date that will be printed on the checks.

In the Type of Run field, specify whether the run is primary (that is, monthly) or secondary (secondary runs are 
executed as needed).

To generate checks of any amount, select the Ignore all minimum pay amount indicator.

When the Ignore all minimum pay amount indicator is not selected, the system only generates checks that are 
above the minimum pay amount. The system determines whether there is a minimum pay amount specified 
for the owner. (An owner’s minimum payment amount is set in the Business Associate transaction’s Payment 
Data tab: Logistics → Production and Revenue Accounting → Ownership → Business Associate .)

If there is not a minimum pay amount specified for the owner, then the system uses the default minimum 
payment amount that is set in the Activation for Specific Companies Customizing activity ( Industry Solution Oil 
& Gas (Production and Revenue Accounting) → Global Settings → Activate Functionality → Activation for Specific 
Companies ).

As needed throughout processing, choose the Status tab to review the status of the payment processing job. 
Choose Refresh to update the status.

Choose the Parameters tab . Then choose one of the following options.

Table 71:

Function Option

To generate checks for all entities in a company Select Company

To correct a check or write a check for an owner that has not 
received a check

Select Owner

To write a check for a property that was under booked or 
overbooked

Select Property

 

At the Parameters tab, data that corresponds with the company, owner, or property. Then enter the following 
data.

In the Company Code field, enter the company for which the system will generate checks.

In the Bank ID field, enter the code identifying the bank from which the payment for the check(s) is generated.

In the Bank Account field, enter the account from which the payment for the check(s) is generated.
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In the Cash Account field, enter the general ledger account number to which PRA books cash transactions.

In the Clearing Account field, enter the general ledger account number to which PRA books electronic money 
transfers.

If required, choose the Server tab to specify the server on which the system runs the payment processing job.

Choose Process Payment .

You can choose Discard run data if processing stops and you do not want to restart processing at the point 
where the processing stopped. In this case, you can choose Discard run data and start the payment run again 
from the beginning.

To restart a payment processing job, choose Restart Payment Proc .

To prevent the system from re-processing an entire set of owner records that are part of a Payment Processing 
job, the system processes one owner at a time. If processing for one owner fails, therefore, you can re-start 
processing with the Restart Payment Proc. function and the system will pick up processing where it stopped for 
the particular owner.

Displaying Previous Payment Runs

To review the details of previous payment runs, on the PRA Payment Processing initial screen, enter the run 
date and identification. Then choose PRA Payment Run → Display prev. runs

To delete all of the temporary data that was created during the payment run, choose Clear Run Detail .

Result

The Master Payment Control Report is available with details about what was paid, as well as a list of the journal 
entry batches that the system posted. You can access the report and the list of batches by choosing System → 
Services → Jobs → Job Overview

The system generates the Bottomline file, which contains both detailed and summarized line for owners 
entitled to payment. This file may be sent to a third party or used by a separate software package for check 
printing and mailing.

The system stores the Bottomline file in the DIR_HOME directory; the file name is a combination of the ID and 
run date that you specified.

If any payment lines or owner was not paid, you can review details with the Exception Report [page 383] You 
can access the Exception Report from within the PRA Payment Processing transaction by choosing Environment 
→ Exception Report or by choosing Logistics → Production and Revenue Accounting → Payment Processing → 
Reports → Exception list from payment runs
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11.3 Reviewing the Exception List from the Payment Run 

Use

Use this report to review the reasons for which payment lines or owners were not paid.

Prerequisites

The payment run is completed. (For details about carrying out a payment run, see PRA Payment Processing 
[page 379] .)

Procedure

At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue Accounting → 
Payment Processing → Reports → Exception list from Payment run

The PRA Payment Processing – Exception items screen appears.

In addition to accessing the Exception Report from the SAP Easy Access menu, you can also access the report 
by choosing Environment → Exception Report .

Enter the following data.

In the RUN_ID field, enter ID for the payment processing run.

To limit the scope of the report further, enter the following data as required.

In the RUN_DATE field, enter the run date.

In the OWN_NO field, enter the owner number.

In the OWN_SEQ field, enter the owner sequence number.

Choose Execute . Then review the exception list.
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12 Check Write 

Purpose

The following Check Write transaction is available:

Outbound Bank Tape [page 384]

12.1 Outbound Bank Tape 

Use

This transaction creates a file to be sent out to the bank for reconciliation purposes.

Procedure

At the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Revenue 
Accounting Check Write Outbound Bank Tape  .

The Treasury Check screen appears.

To create the file and send it to the bank, choose Execute .

12.2 Reviewing FI Documents that Result from CI or CW 
Processing

Use

By using the Job Maintenance and Display Document transactions, you can review the FI documents that result 
from Check Input (CI) or Check Write (CW) processing and verify whether Check Input or Check Write has 
executed properly.
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Procedure

1. At the SAP Easy Access menu, choose Tools -> CCMS -> Jobs -> Maintenance .
2. The Simple Job Selection screen appears.
3. In the Job name field, enter either SAP_CHECKINPUT for Check Input or SAP_CHECKWRITE for Check 

Write . Then choose Execute .
4. The Job Overview screen appears.
5. Select the required job and choose Spool .
6. The Output controller: List of Spool requests screen appears.
7. Select the spool and choose Display .
8. Note the reference number .

9. End the session or open another one and choose Accounting  Financial Accounting  General Ledger 
 Document  Display  .

10. Choose List .
11. The Document List screen appears.
12. Enter the company code and in the Reference key field, enter the reference number that you noted in the 

Job Maintenance transaction. Then choose Execute .
13. The Document List screen appears with a list of documents that correspond with the company code and 

the reference number that you entered.
14. Double click on a line for the document you want to review.
15. The Document Overview screen appears with the accounts and corresponding amounts.
16. Double click on line items as required for more detailed information.
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13 Accounts Receivable 

Purpose

You use this function to manage accounts receivablebalances.

The accounts receivable balances are updated real time when respective Journal Entry (JE) postings take 
place.

This function allows you to view information on current and historical accounts receivable balances, create 
comments and categorize balances, transfer balances and write-off balances.

Integration

Accounts Receivable is tightly integrated with Revenue Distribution and Journal Entry.

Features

This function has the following processes:

● Update of receivable balances real-time during AR sub ledger postings
● Manage receivable balances through a user-friendly AR workplace

○ View current balances, historical balances, write-off history and transfer history
○ For current balances

○ Categorize all or portion of a balance
○ Initiate , Cancel and Approve manual write-offs
○ Mass approve manual write-offs
○ Drill down to the accounts receivable details
○ Transfer a detail check input (CI), balance (cash balance) with no limit on the transfer amount
○ Associate comments (capturing user and date) to a write-off, balance transfer or general AR 

balance key
● Maintain Responsibility IDs at AR remittance level

○ Mass reassign Responsibility IDs
○ Automatically update current balances with the new responsibility ID when it is changed

● Maintain configuration for automatic write-off for a company, account and age
○ Use amount or percent or both for write-off determination

● Age balances automatically on accounting period close
● Automatic write-off on accounting period close

386 C U S T O M E R
SAP Oil & Gas (PRA - Production and Revenue Accounting)

Accounts Receivable 



13.1 Accounts Receivable Workplace 

Use

You use this function to manage accounts receivablebalances.

The accounts receivable balances are updated real time when respective Journal Entry (JE) postings take 
place.

This function allows you to view information on current and historical accounts receivable balances, create 
comments and categorize balances, transfer balances and write-off balances.

Activities

● To display the Accounts Receivable Workplace: Initial Screen , go to the SAP Easy Access menu and choose 
Logistics → Production and Revenue Accounting → Revenue Accounting → Accounts Receivable → Real time 
AR Reconciliation → A/R Reconciliation Workplace
The following fields appear on the selection screen:

Table 72:

Field Description

Company Code The company of the person responsible for the outstand­
ing balance.

Remitter The person responsible for remitting payment on an out­
standing accounts receivable balance.

Responsibility ID The person responsible to track the payments for out­
standing balances.

Sales Month The production month/year for which the revenue trans­
action was processed.

Product (If included) The specific product.

Property/DOI/Measurement Point Radio buttons which indicate whether the accounts re­
ceivable balance was recorded at a property/division of in­
terest (DOI) level or at a measurement point level.

Current Balances Radio button to select/display current outstanding balan­
ces.

Historical Balances Radio button to select/display historical balances.

Write-off History Radio button to select/display write-off balance history.
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Field Description

Transfer History Radio button to select/display balance transfer history.

Age Allows you to limit your search to only those balances in 
which the difference between the due date and the cur­
rent date is equal to, greater than equal to or less than 
equal to the selected age.

Balance >= Allows you to limit your search to only those balances in 
which the current balance amount is greater than or equal 
to the amount entered in this field.

Status Allows you to select balances for different write-off status 
( pending write-off, auto write-off, manual write-off (pend­
ing write-off, auto write-off, manual write-off (PW, AW)) .

● Enter the relevant data for the selection that you would like to carry out.
● Choose Execute .
● The corresponding Accounts Receivable Balance screen is displayed.
● Select a balance record and carry out the desired action (Add/Display Comments, Categorize, Initiate/

Cancel/Approve Write-off).

Note
Only cash balances (check input balances) can be transferred through balance transfer. The balance 
transfer journal entries (JE) are created with batch type 29.

13.1.1  Accounts Receivable Manual Write-Off Process 

Purpose

You can write-off accounts receivable balances in RD. Writing-off means creating the offsetting entry, as well as 
a write-off record in the system.

You generally write-off amounts that you consider to be insignificant, and/or amounts that you consider to be 
too small to write to journal entries (JE) line item tables – because you do not want to fill the line item tables 
with unnecessary entries.

Example
A ssuming that for a specific property/division of interest (DOI), a remitter owes you $ 1,000, and has paid 
$ 990 of that, that $ 990 will be booked to your accounts receivable line item table on the credit side. The 
remaining $ 10 is booked to the debit side of the accounts receivable (A/R) account. If that amount – the 
$ 10 – is not significant, you can elect to write it off. The A/R write-off function allows you to do that. When 
you select a record (in this case, the $ 10) as a write-off, and write it off in the system, the system creates the 
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reconciling difference (in this case, a $10 entry on the credit side of the A/R line item table would be 
created).

Balances can be written off with the following business key: company, remitter, property/DOI or measurement 
point, sales month and product code.

Process Flow

The Accounts Receivable Reconciliation Workplace provides you with a two-step process to write-off accounts 
receivable records:

● You can Initiate Write-off for the remitter balance that you want to write-off.
On the Accounts Receivable Current Balances screen, you select a remitter balance to be written off. You 
mark the balance as Pending Write-off .

● After you have marked an AR record for write off and saved that record, a supervisor, for example, can 
then, in this step, approve it or delete it. This is done to avoid errors in the write-off process.
In the Accounts Receivable Current Balances screen, you select the remitter balance that you selected in 
Step 1 and approve the write-off record (or you delete the write-off record).

Note
A comment entry is required at every step of write-off, that is, to Initiate , Cancel and Approve .

More than one record can be selected for mass write-off approval.Same approval comment will be 
recorded for all selected records for approval.

If you agree that the specific record is to be written off, you must approve the write-off.

If you do not agree that the record is to be written off, delete the write-off.

Example
Your accountant has entered a record of $ 400 for write-off, but you feel that that amount is too high to 
write-off. You will then delete/cancel the write-off.

Result

The write-off is either deleted or approved, and a journal entry is generated to reflect that.

The approval of a write-off generates the following journal entries with batch type 36:

● The offsetting entry for the receivable balance that you are writing-off.
● An entry to the write-off account indicating that you have written something off.
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13.2 Accounts Receivable Responsibility ID Maintenance 

Use

You use this function to maintain responsibility IDs for managing account receivable (AR) balances.

The people responsible for keeping track of the receivable balances at different accounts receivable remittance 
levels (measurement point or property/division of interest (DOI)) are assigned unique responsibility IDs.

Activities

● To display the Accounts Receivable Responsibility ID: Maintenance screen, go to the SAP Easy Access 
Menu and choose Logistics Production and Revenue Accounting Revenue Accounting Accounts 
Receivable Real TimeARReconciliation Maintain A/R Responsibility ID  .

● Create/Change or Display a responsibility IDs for a remittance level and Effective From date.
● You can also use the List option to Display/Maintain a list of responsibility IDs based on the selection 

criteria. You can also mass reassign responsibility IDs.

Note

The accounts receivable balances are automatically updated with the new/changed responsibility ID for the 
remittance level and effective date. When a responsibility IDs is deleted, the responsibility IDs for AR balance 
is updated as Unidentified .

13.3 Accounts Receivable Write-off Configuration 
Maintenance 

Use

You use this to maintain the configuration for automatic write-off.

When accounts receivable balances remain outstanding for a considerable period, they are automatically 
written-off based on the configuration.

The write-off amount or write-off percent are defined for a company, account and write-off age. When the Both 
Amount and Percent Needed in Write-off Determination indicator is selected, both amount and percent are 
considered for write-off.
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Activities

● To display the Accounts Receivable Write-Off Configuration: Maintenance Screen,go to the SAP Easy Access 
menu and choose Logistics Production and Revenue Accounting Revenue Accounting Accounts 
Receivable Real Time AR Reconciliation Maintain A/R Write-Off Configuration  .

● Create, change or display the write-off configuration for a company, account and age.
● Use the List option to Display/Maintain write-off configurations from the resulting list based on the 

selection criteria.

13.4 Accounts Receivable Aging and Auto Write-off 

Use

You use this function to age the accounts receivable balances and carry out automatic write-offs during the 
accounting period close process.

During the monthly accounting period close, the following accounts receivable processes are performed:

● All outstanding old and current balances are aged by a month. The balances with future sales date are not 
aged till they become current.

● All receivable balances that satisfy the automatic write-off criteria are written-off and the corresponding 
reversal entries are posted.

Note
The automatic write-off journal entries are created with batch type 70.

Activities

● To display the PRA Accounting Period Close screen, go to the SAP Easy Access menu and choose Logistics 
→ Production and Revenue Accounting → Revenue Accounting → Journal Entry → Periodic Processing → 
Accounting Period Close .

● Select one or more companies and choose Process Close .
The accounting period job is triggered which ages receivable balances, carries out auto write-off and closes 
the current accounting period.
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14 Revenue Distribution

Purpose

Revenue Distribution allocates volume and value transactions received from the Valuation application 
component of PRA across DOI ownership, and does the following:

● Disburses funds to owners
● Generates accounting distributions
● Allocates bearer expenses to working owners
● Determines net payables for owners and records payable or income and expenses
● Processes prior period adjustments
● Maintains payment history
● Maintains 1099 (U.S. tax) information
● Allocates tax disbursements and marketing reimbursements to owners

The following is a representation of the data flow for Revenue Distribution:
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Within the Revenue Distribution module, the relevant processes are as follows:

If data within RD is found to be "out of balance", no posting will be made to the database tables. For more 
information on the concept of "out of balance", please see the documentation on the Out-Of-Balance Report 
[page 409] .

Revenue distribution uses a file that is received from Valuation, containing processed transactions as input. 
Revenue Distribution then allocates total volume, value, deducts and taxes from Valuation to all owners in the 
division of interest, generates accounting distributions, and maintains payment history and 1099 (U.S. tax) 
information.

Revenue Distribution then summarizes and creates a journal entry file for the Journal Entry [page 428] 
subsystem, to be posted to the financial ledgers of SAP FI.

Revenue Distribution generates reports for results verification – which allows you to identify errors in 
processing, and "out-of-balances" (very rare situations in which the debits and credits are not equal).

The reports that are used in conjunction with RD are:

● Allocation Error Report (see: Using the Allocation Error Report in RD [page 407] )
● Combined Run Report (see: Combined Run Report [page 353] )
● Out-of-Balance Report (see: Out-Of-Balance Report [page 409] )
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After processing has been carried out, RD creates a Journal Entry transaction file, which is a data file that is 
used to send information on to the Journal Entry module for subsequent processing.

In addition to those main functions, Revenue Distribution also supports the following:

● Allocation of bearer expenses to working owners
● Determination of net payables for owners (gross revenue, minus deducts)
● Recording of payables, income, expenses, marketing payables and facility income
● Recording of accounts receivable (A/R) amounts
● Recording of payable taxes
● Distribution of operator payments

● Handling owner-level transactions and other situations that require special accounting actions. Examples 
of those transactions are: settlement diversity of owner transactions (transactions in which a non-working 
interest owner is paid on a different basis than that upon which volumes were sold), sliding scale owners (a 
form of settlement diversity transaction in which the decimal - net revenue interest of the owner can vary 
based on volume and/or values), tax-free owners (owners who, by agreement, are not required to pay state 
production and severance taxes), and marketing-free owners (owners who are not required to pay any 
marketing deductions, or certain types of marketing deductions)).

● Functionality for inputting and allocating state ad valorem taxes to owners in a DOI (see: Creating Ad 
Valorem Tax Recovery Records [page 425] )

● Generation of accounting entries as a result of the allocations and special accounting processes performed
● Calculation of tax withholding amounts for federal, state, and non-resident alien taxes (state backup 

withholding for Colorado and Utah, etc.) (see: Maintaining Withholding Tax Rate Info [page 424] )
● Calculation of interest on suspended or paid funds
● Processing of suspense releases based on owner suspense release data
● Processing suspense allocations based on ownership transfer data
● Utilization of system-wide minimum payment amounts
● Processing override options to system-wide minimum payment amounts maintained by owners in the 

business associate file
● Clearing out minimum suspense data at specified points in time
● Processing special payment control data based on information maintained by owner in the Business 

Associates Table ("print check first", "stop payment", and "payment method")
● "Print check first" – used when the check for an owner needs to be printed at the beginning of the check 

print job, due to special handing or other requirements
● "Stop payment" – used when it is desired to stop any payments from being made to an owner. This can be 

used in lieu of placing the owner in suspense on every DOI he has an interest in
● Functionality for entering comments or messages to be printed on owner check statements (comments or 

messages can be printed for all owners, a specific owner, all owners in a property, all owners in a DOI, or all 
owners in properties in a specific state)

● Generation of checks and statements for those owners being paid by check
● Generation of statements only for owners being paid by other means (wire transfer, etc.), or for owners 

whose revenue is being offset against joint interest expenses
● Provision of the ability to reprint owner statements, if necessary
● Provision for the input of manual check data and generation of appropriate accounting entries (see: 

Entering Royalty Check Information Manually [page 420] )
● Provision for the ability to void checks either back into payables or into legal suspense
● Provision of the ability to generate replacement checks (whereby the original check is automatically 

voided)
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● Maintenance and update of a check register
● Maintenance of 1099 (U.S. tax) data, and manual adjustment of the 1099 data (the user can manually 

adjust the data) (see: Displaying Owner 1099 Information [page 423] )
● Provision for automatic write-off of accounts receivable balances that are within a user-defined amount, by 

product
● Generation of transactional data to be provided to participating owners through CDEX
● Provision of the capability to manually select accounts receivable balances to be written off, which are 

outside the automatic write-off amounts. A separate approval screen for manual write-off is provided for 
control purposes (see: )

● Provision of the ability to transfer accounts receivable amounts generated by the check input application 
across remitters, remittance levels, product codes, and sales dates. That is used in cases in which the data 
has been entered erroneously in the check input application, and has already been processed into the 
subledgers

● Processing of prior period notifications (PPNs) received from the Valuation application component by 
extracting and reversing original entries processed. The Valuation application component sends the re-
entry or corrected transactions back to Revenue Distribution

● Provision of an option for processing prior period transactions against either current ownership in the DOI, 
or against the ownership that exists as of the sales month or the prior period transaction (that is, historical 
ownership)

● Extraction and reporting of owner-payable data that is "escheatable" under state escheat laws (which vary 
from state to state)

● Provision of search functionality for all Journal entries created from a specific valuation transaction. That 
includes both DOI and owner-level information.

● Provision of search functionality for check detail, 1099 tax data, negative payables, and legal suspense data 
(see: Displaying Owner Check Details [page 419] , Displaying Owner 1099 Information [page 423] , 
Displaying Negative Payable/Suspense Browse Information [page 427] )

● Generation of various types of reports, including: accounts receivable reports, income analysis reports, 
taxes payable analyses, legal suspense reports, royalty payable reports, owner payment exception reports, 
and audit and control reports of the allocations and other processes it carried out

● Sending of information to the Combined Run Report and the Journal Entry (JE) System

Integration

Revenue Distribution receives transaction batch data (as a file) from the Valuation component (or from direct 
input in RD) in PRA, and after processing occurs in RD, the data is then sent to the Journal Entry component of 
PRA, and on to SAP Core FI (General Ledger).

14.1 Revenue Distribution Allocation 

Use

Revenue Distribution allocation allocates total volume, value, and deducts, as well as taxes from PRA Valuation 
to all payable owners in a division of interest (DOI).
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It also does the following:

It allocates tax and tax reimbursements, and marketing and marketing reimbursements to owners.

It determines net payables for owners and records payables or income and expenses.

It records marketing payable or facility income, or reduces A/R (accounts receivable) amounts

It generates the accounting distribution required

It records taxes payable or reduces A/R or pays an operator

RD allocation uses DOI information from Ownership and data from Valuation in the allocation process. RD then 
distributes the revenue to the respective owners, based on the ownership information, and the volume and 
value involved.

The data flow is as follows:
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The valuation data is processed from Valuation selections through RD and the creation of journal entries is 
done at a network/product code/sales date level.

In addition, RD allocation sends data to the combined run report.

Revenue Distribution receives its data directly from Valuation. The RD module processes the batch data 
received from Valuation, and distributes it to DOI owners. Later on, you can run reports to view details of 
specific revenue distributions. RD allocations generates reports for results verification and identification of 
errors and out-of-balances.

RD Allocation is one of the two main processes that run in RD, the other is RD Reversals [page 408]

Ownership information is retrieved using the property/DOI and product code/sales data from the Valuation 
transaction. If the VL transaction is a contract-level transaction, the entire DOI ownership is retrieved. If the VL 
transaction is a producer-level transaction, ownership information for the producer and carried and royalty 
owners born by him is retrieved (the owners are retrieved and processed in the following order for contract 
level transactions: royalty owners, in order of their BA numbers, carried owners – if any, non-affiliated working 
owners – if any, affiliated working owners – if any, working owners who are the processing company – if any. 
Owners are retrieved and processed in the following order for producer-level transactions: royalty owners borne 
by the producer – in order of their BA numbers, carried owners carried by the producer – if any, the producer 
himself.
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The “ subtraction method“ is used to allocate amounts to owners. The subtraction method formula is:

Table 73:

(Amount – amount already allocated) x an interest percentage / (total interest to be allocated – interest already allo­
cated)

Owner net payable amounts are calculated for royalty owners, and journal entries are recorded for them. 
Information from the DOI and VL transaction is used to determine the correct account number. Non-affiliated 
royalty owners receive royalties payable or legal suspense entries. Affiliated royalty owners receive income, tax 
expense, marketing expense and/or intercompany reimbursement entries.

Working and carried owners pick up any bearer amounts from their bearer group(s). Bearer amounts include 
tax, tax reimbursements, marketing, marketing reimbursements not paid by/allocated to the royalty owners, 
recoupable marketing amounts paid by the royalty owners, entitled differences and settlement differences 
from the royalty owners.

Owner net payable amounts are calculated for carried owners and statistical journal entries are recorded for 
them. Information from the DOI and VL transaction is used to determine the correct account number.

Working owners pick up their portion of amounts accumulated by the carried owners. Owner net amounts are 
calculated and journal entries are recorded. Information from the DOI and VL transaction is used to determine 
the correct account number. Non-affiliated working owners receive royalties payable or legal suspense entries. 
Affiliated working owners receive income, tax expense, marketing expense and marketing reimbursement 
entries, as well as several different expense entries for entitled and settlement differences.

Marketing amounts are posted as either marketing payable or facility income or they are used to reduce the 
accounts receivable amount, depending on who provided the marketing service. Information from the VL 
transaction is used to determine the correct account number. The marketing amounts used are based on the 
total allocated to the lease ownership.

Tax amounts are posted as either taxes payable, royalties payable to the operator, or a reduction of the 
accounts receivable amount, depending on who is responsible for remitting the tax amountss to the 
government. Information from the DOI accounting data and VL transaction is used to determine the correct 
account number.

Table 74:

How to calculate an owner’s net amount

An owner’s net amount is calculated as:

value

+ tax reimbursements

+ marketing reimbursements

- tax deductions

- marketing expenses

- bearer expenses
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Table 75:

How to calculate an affiliated owner’s income amount

An affiliated owner’s income amount is calculated as:

value

+ tax reimbursements

+ bearer tax reimbursements

Marketing costs and reimbursements are booked separately using a different account category.

Table 76:

How to calculate the offsetting debit amount

The accounts receivable/purchases/well expense etc. amount is calculated as:

allocated value

+ allocated tax and marketing reimbursements

- allocated external marketing not booked as payable nor recouped by working owners

- tax remitted by the purchaser

 

Owner pay methods

Owner pay methods are established for each owner on the DOI owner maintenance screen (see also: 
Maintaining Division of Interest Owners [page 34] ). The possible values are:

- Pay– Identifies that the owner will be paid on value. If the owner is a non-affiliated owner, the owner then 
receives payment in the form of a royalties payable credit. If the owner is an affiliated owner, he receives an 
income credit offset by tax expense, marketing expense, settlement expense, and bearer differences, if 
applicable.

- Suspense– Indicates that the owner is in legal suspense. A credit to Legal Suspense will be recorded for the 
owner (see also: Carrying Out a Legal Suspense Subledger Query [page 458] .

- Balancing factor– Indicates that the owner is “taking in kind“. Volumes and values are allocated, but the 
amounts are not reflected in the journal entries.

Revenue Process (Code)

The revenue process code indicates the source of revenue transactions to be processed against the DOI. The 
possible revenue processes are:

- System valued– The transaction is processed through PRA Production, Contractual Allocation and Valuation 
using production volumes (system valued is usually used for company-operated properties).

- Check input– A Valuation transaction is created from the data entered (by a user). The transaction originates 
from the input of check stub data in the PRA Check Input module (see Check Input [page 364] ). Taxes may be 
re-calculated. Revenue Distribution records revenues and payables and debit receivables. Check input also 
simultaneously creates a journal entry for the credit and debit entries.
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- Settlement statement– The transactions originate from the input settlement statement data in the Valuation 
module. A Valuation transaction is created from the input data, which is then sent to RD.

Other determinants of Revenue Distribution allocation processing (note: the following fields all refer to the DOI 
Accounting screen)

Table 77:

Tax amount The tax amount field when the system source code is CI. The 
default value of the field is “net of exempt owner“. RD alloca­
tions can allocate taxes to owners based on a gross tax 
amount or net tax amount. The tax amount field tells RD al­
locations what the tax amount represents so it will be cor­
rectly allocated to the owners.

Tax reimbursement The tax reimbursement field when the system source code 
is CI. The default value for this value is “net of exempt 
owner“. RD allocations can allocate tax reimbursements to 
owners based on a gross amount or net amount. The tax re­
imbursement field tells RD allocations what the tax amount 
represents, so it will be correctly allocated to the owners.

Current/historical The current/historical field is used to indicate whether the 
owners of record on the sales date or the current accounting 
period are processed by RD allocations, both for original al­
locations and PPAs. The default value for this field is “cur­
rent accounting period“. The operating company will use 
“current accounting period“ generally. An exception to this 
might be for the settlement of a lawsuit (in practice, “histori­
cal“ is almost never used).

Entitled/actual The entitled/actual checkbox interacts with the Ent/Act/Set 
payment basis entered on the Maintain DOI Owners screen 
( Maintaining Division of Interest Owners [page 34] ) to de­
termine if an owner is to be paid on the basis of entitled pro­
duction, actual sales, or settlement diversity.

Normal RTF (normal recording time frame) The normal recording time frame represents the relationship 
between the production date and the accounting period. 
Valid values are “Accounting month equals production 
month“, “Accounting month equals production month +1“, 
etc.

Summarize to DOI The summarize to DOI flag is used to sum the Sales, Paya­
ble, and Accounts Receivable entries to the property/DOI 
level from the well completion or the well completion/tract 
DOI level. The default is “summarize to DOI“ when no value 
is entered. If set, it will reduce the amount of transactions 
coming from Valuation to Revenue Distribution and result in 
a more summarized combined run report.
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Severence tax types

(this is a screen tab on the DOI Accounting screen)

Severence tax payment flags are maintained on the DOI Ac­
counting Data Maintenance screen ( Defining Tax and Reve­
nue Attributes for a DOI (DOI Accounting) [page 45] ).

The tax payment flags are not an indication of whether pay­
ment of severence taxes is required. They are not an indica­
tion of who is responsible for remitting tax payment 
amounts to the tax authorities. Severence tax amounts are 
either input or calculated in E&P modules prior to the RD al­
location process.

Remitted by The Remitted field indicates if the processing company is re­
sponsible for paying (remitting) the corresponding severe­
nce tax type. Values are: “by producer“ = the processing 
company is responsible for remitting the tax; “by pur­
chaser“ = the purchaser is responsible for remitting the tax; 
“not applicable“ = the tax type is not applicable for the prop­
erty/DOI and, therefore, should not be calculated by the sys­
tem; “to operator“ = the taxes are to be remitted to the oper­
ator rather than the taxing authority.

Reporting Indicates on which tax report the taxes are to be reported: 
“Report as producer“, “report as purchaser“, “report as 
both“, “neither“ (operating company not responsible for 
paying or reporting but taxes will be calculated) or “not ap­
plicable“ (don’t calculate tax).

Operator (taxes payable operator) This field is used to identify the operator to whom the tax re­
mittance is being made. The field is required if the remitted 
field indicates “by operator“ or if the Remit to operator 
checkbox on the Ad Valorem Recovery screen is selected. If 
entered, the BA must be a valid Business Associate and have 
a remitter business associate type.

 Example

This example is based on a typical RD situation, with a division of interest, and several owners: WI 01, WI 02, RI 
01, and RI 02 (working interest owners and royalty interest owners). The first example involves a normal 
situation in RD, and the second example includes some deducts, such as an owner who is marketing-free.

Division of Interest (DOI)

Table 78:

Owner GRI NRI BG

WI 01  
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Owner GRI NRI BG

WI 02  

RI 01  2

RI 02  1

Valuation totals:

Volume = 100 BBLs (barrels)

Value = $1000

Deducts = $ 50

Taxes = $ 150

The following is an example of allocation in RD, without any special conditions:

Table 79:

Owner Volume Value Deducts Taxes Net

WI 01 40 400 20 60 320

WI 02 30 300 15 45 240

RI 01 20 200 10 30 160

RI 02 10 100 5 15 80

Total 100 1000 50 150 800

Note: volume is barrels, value is USD.

14.1.1  RD Allocation Examples

The following are examples of RD allocation:

Example 1: Pay and suspense

DOI Information
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Table 80:

Owner NRI Pay code

RI1 0.0625 Pay

RI2 0.0625 Sus

WI1 0.4375 Pay

Company A 0.4375 Pay

Assume a contract level transaction with volume of 100 @ $ 10.00/unit = $ 1,000 to allocate.

Allocation to owners using the subtraction method (for a description of the subtraction method, see 
Revenue Distribution Allocation [page 395] ): :

Table 81:

RI1 (1000.0 – 0.00) x 0.0625 / (1-0.0000) = 62.50

RI2 (1000.0 – 62.50) x 0.0625 / (1 – 0.0625) = 62.50

WI1 (1000.0 – 125.00) x 0.4375 / (1 – 0.1250) = 437.50

Company A (1000.00 – 562.50) x 0.4375 / (1 – 0.5625) = 437.50

Accounting entries (journal entries) :

Table 82:

Company Account Owner DR CR

003 R/P RI1  62.50

003 Legal Susp. RI2  62.50

003 R/P WI1  437.50

003 Income Company A  437.50

003 A/R  1000.00  

   1000.00 1000.00

Example 2: Producer Level

DOI Information

Table 83:

Owner NRI Pay.Cd. Br.Grp.

RI1 0.0625 Pay 01

RI2 0.0625 Susp 01
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WI1 0.4375 Pay  

Company A 0.4375 Pay  

Bearer Group

Table 84:

Bearer Br Pct

WI1 0.5

Company A 0.5

  

  

Assume a producer level transaction with volume of 50 @ $ 10.00/unit = $ 500.00 to allocate. Assume WI1 is 
taking in kind under a TIK (take in kind) contract, and disbursing their own royalty.

Allocation to owners using the subtraction method :

Table 85:

RI1 (500.00 – 0.0) x 0.03125 / (0.5 – 0.000000) = 31.25

RI2 (500.00 – 31.25) x 0.03125 / (0.5 - 0.03125) = 31.25

Company A (500.00 – 62.50) x 0.4375 / (0.5 – 0.06250) = 437.50

Accounting entries :

Table 86:

Company Account Owner DR CR

003 R/P RI1  31.25

003 Legal Susp RI2  31.25

003 Income Company A  437.50

003 A/R  500.00  

   500.00 500.00

Example 3: Effect of Balancing Factor

DOI Information

Table 87:

Owner NRI Pay Code
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RI1 0.0625 Pay

RI2 0.0625 Susp

WI1 0.4375 Balancing

Company A 0.4375 Pay

Assume a contract level transaction with volume of 100 @ $ 10.00/unit = $ 1,000.00 to allocate.

Allocation to owners using the subtraction method

Table 88:

RI1 (1000.00 – 0.00) x 0.0625 / (1 – 0.0000) = 62.50

RI2 (1000.00 – 62.50) x 0.0625 / (1- 0.0625) = 62.50

WI1 No allocation

Company A (1000.00 – 562.50) x 0.4375 / (1 – 0.5625) = 437.50

Accounting entries :

Table 89:

Company Account Owner DR CR

003 R/P RI1  62.50

003 Legal Susp. RI2  62.50

003 Income Company A  437.50

003 A/R  562.50  

   562.50 562.50

Example 4: Processing Affiliated Owners

DOI Owners

Table 90:

Owner NRI Pay Code

RI1 0.0625 Pay

RI2 0.0625 Susp

Affiliate 0.4375 Pay

Company A 0.4375 Pay

Assume a contract-level transaction with volume of 100 @ $ 10.00/unit = $ 1,000.00 to allocate.
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Accouting entries:

Table 91:

Company Account Owner DR CR

003 R/P RI1  62.50

003 Legal Susp RI2  62.50

003 Inter Co A/P Affil.  437.50

003 Income Company A  437.50

003 A/R  1000  

   1000 1000

Note that the following entries, recorded on the affiliated company’s books, may be suppressed.

Table 92:

Company Account Owner DR CR

256 Income Affil  437.50

256 Inter Co A/R  437.50  

   437.50 437.50

Processing an Affiliated Purchaser

DOI Information

Table 93:

Owner NRI Pay Code

RI1 0.0625 Pay

RI2 0.0625 Susp

WI1 0.4375 Pay

Company A 0.4375 Pay

Assume a contract level transaction with volume of 100 @ $ 10.00/unit = $1,000 to allocate. Assume the 
purchaser is an affiliated company, but not the processing company, and that the contract is not a settlement 
type contract nor a direct/indirect supply type contract.

Accounting entries :

Table 94:

Company Account Owner DR CR
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003 R/P RI1  62.50

003 Legal Susp RI2  62.50

003 R/P WI1  437.50

003 Income Company A  437.50

003 Inter Co A/R  1000.00  

   1000.00 1000.00

Note that the following entries, recorded on the affiliated company’s books, may be suppressed.

Table 95:

Company Account Owner DR CR

256 Purchases  1000.00  

256 Inter Co A/P   1000.00

   1000.00 1000.00

14.1.2  Using the Allocation Error Report in RD

Use

Use this report to display transactions that were rejected during the Revenue Distribution allocation process.

This provides you with reject messages, that you can then use to apply corrections to master data set-up.

In order to use this report, you have to know the relevant file number (the relevant file number here is 
RDBQ5454).

Procedure

At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Reporting → List 
Viewer → Revenue Distribution → Revenue Distribution → Daily .
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Result

The system now displays a list of control and report transaction files that had errors.

14.1.3  RD Reversals 

Use

The main function of reversals in RD is to reverse journal entries previously recorded in the financial system.

As transactions are successfully processed through the Valuation module, reversal notifications are generated 
for all prior period transactions. The reversal notifications contain the following key information: property, DOI, 
product code, sales date, network, and optionally well/well completion or measurement point. The well/well 
completion or measurement point will be blank if the “summarize to DOI“ checkbox is selected on the DOI 
Accounting Maintenance screen.

The generation of reversal notifications occurs in the Valuation summaryprocess. At that point, all VCR 
(valuation cross-reference) established at the unit level have been allocated to the tracts. Therefore, all 
notifications are sent to RD at the tract level.

The RD reversals process searches for journal entries with key data matching the reversal notification key. The 
volume type on the selected JEs is inspected. A determination is made about whether or not chain of title is to 
be followed for the journal entry to be reversed (see also: Displaying Chain of Title Records [page 43] ). Chain of 
title will be followed only if the journal entry is an owner JE – i.e. has a BA number. When chain of title is 
followed, the numeric amounts on the journal entry are broken up by the percentage of interest transferred to 
each new owner and the sign of the journal entry is reversed. When chain of title is not followed, the original 
journal entry is simply reversed and posted.

When the new transaction from Valuation is processed through RD allocations, it will create journal entries 
which will be offset by those created by the RD reversal process. When those journal entries are netted 
together, the result is net adjustments.

RD reversals is an automatic process that:

● Uses a reversal notification file (batch) from Valuation as input
Summarizes and creates a journal entry file for the Journal Entry subsystem, to be reversed from the 
financial ledgers
Generates reports for results verification and identification of errors and out-of-balances
The Valuation reversal file contains key information on transactions successfully processed through 
Valuation and sent to Revenue Distribution
The RJE records are used to create reversal entries on a file and sent to the Journal Entry module for 
posting
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The data flow for RD reversals is as follows:

Next to allocations, reversals is the other main processing function within Revenue Distribution.

Integration

RD reversals receives its data from Valuation in PRA, and sends the data on as a file to Journal Entry.

14.1.4  Out-Of-Balance Report

Use

The Out-Of-Balance Report is a report in PRA Revenue Distribution, which runs automatically concurrent with 
the Revenue Distribution allocation process. It is used to check the balances in transactions, and to search for 
and display any transactions, in which there was an error, in which the debit and credit totals are not equal to 
each other. The report will then provide you with the keys that are required for looking into the issue further.
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The situation described above – one in which there was an error of the debit not being equal to the credit, 
should not occur on a routine basis.

Activities

The report runs automatically in RD, but can be displayed under Logistics → Production and Revenue 
Accounting → Tools → List Viewer → Revenue Distribution → Revenue Distribution → Daily .

Relevant file number = RDBQ573

14.2 RD Periodic Processing 

Purpose

RD periodic processing contains a group of reports that allow you to query RD tables, and to use the 
transactional data in those tables to carry out subsequent processes in RD.

It supports the following transactions:

● Creation of a production payment report – you can run a report that lists balances owed to a specific 
owner, as well as the amounts already paid to that owner. (see: Creating a Production Payment Report 
[page 411] ).
Carrying out of a funds transfer – you can transfer funds contained in the Legal Suspense Line Item Table 
to a pay table such as the owner payable table, for example, when the status of an owner changes (see: 
Carrying Out a Funds Transfer [page 412] ).
Check clearing – You can use this to set the check status of checks in the Check Register to “cleared”, 
when you receive a file from a bank with data on checks that have cleared the bank. (see: Running the 
Check Clearing Job [page 412] ).
Ad valorem – Ad valorem is a tax based on transactions, and is sent to you as a bill from the local 
government authority. You can run a job here that allocates all ad valorem records across a property/DOI 
and that posts the relevant journal entries for it. (see: Processing Ad Valorem Tax Records [page 413] ).
1099 Report – you can run a report that lists the history of 1099 tax payments for owners. (see: 1099 
Report [page 414] ).
Void / cleared check purge – you can use this to delete all records in the Check Register that have a status 
of “void” or “cleared”.(see: Purging Void / Cleared Check Records [page 414] ).
Escheat processing – you can use this to pay suspended payment amounts for an owner to the state, 
when the owner is in escheat (see: Escheating Payment Amounts [page 415] ).
Void / manual check – you can use this to manually void check records in the Check Register (see: 
Manually Voiding Check Records in RD [page 416] ).
Outbound CDEX processing – you can use this to run a job that picks up mass check data and check 
detail data and sends it to CDEX (Check Data Exchange Consortium) for processing (see: Using Out-Bound 
CDEX in RD [page 417] ).
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Prerequisites

The assumption here before you run RD periodic processing is that transactions have occurred in RD over a 
period of time.

Process Flow

You run these processes whenever you find the necessity of doing so.

14.2.1  Creating a Production Payment Report 

Use

Use this to run production payment processing in RD.

Production payment in Revenue Distribution is a report that displays what amount is payable against a starting 
balance that is owed to some owner. It displays the remaining balance (the outstanding balance). It also 
displays a list of records of what you have paid a partner or owner. That helps you track disbursements.

Balances are entered in Ownership in PRA. For example, there could be a starting amount of $ 100,000 entered 
in Ownership. In Revenue Distribution, you can create a production payment report, which lists the starting 
balance, and the amounts disbursed in RD against that balance, usually per month. The remaining balance is 
also listed. That is the production payment report. It allows you to track – on a monthly basis – what you have 
paid an owner with respect to a starting balance.

You can set that up in RD so that it covers more than one property / DOI.

Once the balance has been paid in full, the type of ownership interest can change in Ownership.

Procedure

● From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Revenue Distribution → Periodic Processing → Production Payment Report .

The Production Payment Report screen is displayed.

● Select Run (the Execute icon).
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14.2.2   Carrying Out a Funds Transfer 

Use

Use this to run a job that transfers funds from the Legal Suspense line item table to a pay table (such as the 
Owner Payable table).

When the owner pay code for an owner changes, it can become necessary to transfer funds that were recorded 
in the Legal Suspense line item table into a pay table such as the Owner Payable table, so that the owner can be 
paid.

For example, if there is a royalty owner who is owed money, but the payments have been recorded in the 
Suspense table for some reason, and the pay code for that owner changes, all those records for that owner in 
the Suspense table can now be transferred to a pay table.

This process triggers a job that pulls the records from the Legal Suspense table and transfers them to pay 
tables, after the pay code for the owner has changed. It also offsets the Legal Suspense table.

A check is then issued for that owner in the next Check Write cycle.

You can transfer funds within the same owner, or transfer funds from one owner to many owners.

This process can also be run in reverse – the records from the Owner Payable table can be transferred to Legal 
Suspense.

Procedure

From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Revenue Distribution → Periodic Processing → Funds Transfer.

The Funds Transfer screen is displayed.

At the Funds Transfer screen, to kick off the job, select Run .

14.2.3  Running the Check Clearing Job 

Use

Use this to run a background job that pulls in a file of checks that have “cleared” a bank, and matches those 
records with check records in the Check Register, and then sets the check status of those check records in the 
Check Register to “cleared”.

Oil companies typically write hundreds or thousands of checks per month, which are then sent to banks for 
processing. On a periodic basis, the bank creates a data file with data on the checks that have “cleared” the 
bank, and sends it as a file to the oil company.
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This job pulls in that file into RD, and matches the check records to those in the Check Register, and when 
found, sets the check status for each matched record to “cleared”.

Procedure

From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Revenue Distribution → Periodic Processing → Check Clearing.

The Check Clearing screen is displayed.

1. Select Execute .

Result

RD matches the file data with the Check Register and changesthe check status of the relevant checks to 
“cleared”.

14.2.4  Processing Ad Valorem Tax Records 

Use

Use this to run a background job that takes ad valorem records and allocates them across a property/DOI and 
creates and posts the relevant journal entries for them.

Ad valorem is a tax amount paid to a state authority, usually a local governmental authority. The state authority 
sends your company a bill for ad valorem on a periodic basis (per month, etc.), the bill contains the amount 
owed in ad valorem tax. The tax is calculated based on the value of transactions.

When you trigger this background job, the job takes the ad valorem records entered on the Ad Valorem table, 
and allocates them across the property/DOI and creates and posts the relevant journal entries for them.

Procedure

● From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Revenue Distribution → Periodic Processing → Ad Valorem .

The Ad Valorem screen is displayed.

Select Run (the Execute icon).
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Result

The system runs a background job that takes ad valorem records in the Ad Valorem Table and creates journal 
entries for them and posts those journal entries to JE.

14.2.5  1099 Report

Use

Use this to create a report that lists the history of payments made to owners and partners for 1099 tax.

The 1099 Report functionality takes records entered in the OSTA Table (the Owner Paid Cumulation Table - the 
table that contains records summarizing payments made to owners), which receives its data from Checkwrite, 
and creates a 1099 Report for a specific year.

For example, an owner might contact you, requesting the 1099 record for a specific year. You can use this 
report to print out that type of information.

Procedure

1. From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Revenue Distribution → Periodic Processing → 1099 Report .

2. The 1099 Report screen is displayed.
3. Enter the relevant data for your search.
4. Select Execute .

The system will display a report of 1099 data based on your search.

14.2.6  Purging Void / Cleared Check Records 

Use

Use this to purge (delete) check records in the Check Register.

This report reads all check records in the Check Register that have a status of “void” or “cleared” and purges 
(deletes) them. It also purges all the “child” table entries associated with them. You can manually void a check 
in RD too.

This function is used to “clean up” the RD table, when there are many records in the table that you no longer 
need.
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Procedure

1. From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Revenue 
Accounting Revenue Distribution Periodic Processing Void / Cleared Check Purge

The Void / Cleared Check Purge screen is displayed.

Enter the relevant data.

Select Execute .

14.2.7  Escheating Payment Amounts

Use

Use this to remove suspended payment amounts for a specific owner who is in escheat, and pay those 
amounts to the state.

Escheat is a legal status that means – reversion of some property to the state, when no owner can be found. 
There are situations in which an owner is to be paid in Revenue Distribution, but that owner cannot be located, 
because the owner is deceased, the owner address cannot be found, or for any other reason. Escheat also 
covers payments to owners – if the owner cannot be found to pay, the payment amounts then revert to the 
state.

The escheat status of an owner is defined in the business associate record for that owner (see: Creating a 
Business Associate [page 15] ). An owner can be flagged as being "in escheat".

If an owner is flagged as in escheat, the payments to that owner are written to the Legal Suspense Line Item 
Table. Those amounts are not paid out, rather, they accumulate and are held in that table. If the funds are in 
suspense for a specific period of time – for example, two years, they can be in escheat – meaning that they will 
be then paid to the state, when no owner can be found. If the funds have been in escheat for too long, you then 
have to pay them to the state.

The background job that runs here runs when owners have funds in suspense. This job collects the monies that 
have been in the system but not paid out for the escheatable owners. It takes the monies from suspense and 
moves them to escheat – which means that it debits Suspense and credits Escheat (the Escheat account).

The escheat job removes the records from the Legal Suspense table and writes them to Journal Entry tables 
(JE line item tables). The legal suspense is offset (balanced, an offsetting entry is made of it to another table). 
The job also writes entries to the Check Register. You thus have a history of what you just did.

You must then remit the amounts escheated to the state. For example, you can escheat all records for an owner 
that have been in suspense for at least two years, for example.

This process allows you to run a report and display a list of all records that are in escheat for an owner.
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Procedure

1. From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Revenue Distribution → Periodic Processing → Escheat Processing .

The Escheat Processing screen is displayed.

1. In the Beginning Check Number field, enter the first check number that you would like to write to the Check 
Register.

2. Select Run (the Execute icon).

The system writes the number of escheated records, beginning with the check number that you entered in the 
Beginning Check Number field, to the Check Register.

Example

For example, if you have 5 escheat check records in suspense (for example, for 5 separate owners), starting 
with Check Number 100, you enter 0000000100 in the Beginning Check Number field, and when you select 
Run , the system writes those five check records: 100, 101, 102, 103, and 104 from the suspense table to the 
Check Register.

14.2.8  Manually Voiding Check Records in RD 

Use

Use this to manually “void” check records in the Check Register.

Checks are written from Checkwrite into the Check Register table. You can flag individual checks so that they 
are “void”. That is done if you want to reissue that check, or if the check came back (as “returned”). If you have 
issued a check, and that record is in your Check Register, but the physical check comes back as never having 
‘cleared’ (it was never cashed), you then have an unnecessary record in your Check Register. You can use this 
function to remove unnecessary records of that kind. One reason that you would want to do that is to clear your 
Check Register so that it does not fill up with unrequired data.

When you run this periodic processing job, the job sees that the check status is now “void”, so it updates the 
check status to void. It then records journal entries to: debit (to cash) and credit (to Owner Payable). The 
original journal entries that were created when the original check was written are also now reversed. The 
money is put back into ‘Cash’, and the payable is put back into ‘Payable’. The original amount will now be in 
Owner Payable.

Procedure

1. From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Revenue Distribution → Periodic Processing → Void / Manual Check .
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The Void / Manual Check Batch Run screen is displayed.

1. There are two ways to proceed:

Table 96:

To… Do the following…

Have the job start from the beginning… Leave the Starting Step field blank.

Have the job will start with a specific entry… Make an entry in the Starting Step field.

1. Select Execute .

The system runs the job.

14.2.9  Using Out-Bound CDEX in RD 

Use

Use this to run a job that picks us mass check data and check detail data, and sends it to CDEX.

Large oil companies that have mass check data often use a consortium called “CDEX” (Check Data Exchange) 
to process their checks and check details. The details are given by the oil company to CDEX, with information 
on who (which company or owner) the check is to go to. CDEX then sends a file to that company. That 
company uses that file, which obviates you having to send mass quantities of data with check details to the 
company.

At the business associate level in Ownership, specific owners are flagged as being “CDEX owners”.

If there are checks on the Check Register, when the outbound CDEX job is run, it picks those up (often, it picks 
up the entries since the last time you transmitted) – along with the check details, and creates a file. The file is 
sent to CDEX.

Procedure

● From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Revenue Distribution → Periodic Processing → Outbound CDEX .

The Outbound CDEX screen is displayed.

● Select Run .
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14.3 Displaying Owner Check Information 

Use

Use this screen to view check information for an owner. You can also use it to create and maintain void check 
and replacement check transactions, and to reprint check stubs.

The manual/void check transaction job uses this information to create the appropriate Journal Entries and 
update the check register for each transaction.

Table 97:

Void check dialog box

Allows you to void a check that has already been issued to the current owner. Within this dialog box, you indicate the sub­
ledger to which the returned check amount should be applied and the reason for the voided check.

Replacement check dialog box

The void check was replaced by this check number. Here, you tell the system that, after creating a manual check.

Procedure

At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue Accounting 
→ Revenue Distribution → Owner Checks → Owner Check.

The Owners Check: Initial Screen is displayed.

On that screen, enter the relevant data for your search: the owner that it applies to, the check number, check 
status, and check date.

An explanation of the fields on the Owners Check: Initial Screen is as follows:

Table 98:

Field Description

Company The company responsible for processing the check

Owner ID The business associate who will receive the check

Check number The specific check that was paid to the owner

Check date The date on which the check was written

Check status The current disposition of the check. Valid options for 
checks that are outstanding are "normal“ or “manual“, while 
“void“ or “net out“ are other possibilities

Select Find Records.

The system produces a list of records based on your selection criteria.
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14.4 Displaying Owner Check Details 

Use

Use this to view all of the detail information that corresponds to a line on the owner’s check stub.

This screen is for display (list) purposes only, you cannot create/save, etc. from this screen.

Other Deducts dialog box – Breaks all of the other possible deductions down to an individual level so that you 
can see the deduction amount that is associated with each type of deduction. The fields and values are 
populated automatically, and all of the fields are display only.

Taxes Dialog box – Lists all of the tax types that apply to the state in which the current property /DOI is 
located, and it shows the amount of tax that is associated with each tax type. These fields and values are 
populated automatically (by the system), and all of the fields are display only.

Procedure

1. At the SAP Easy Access Menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Revenue Distribution → Owner Checks → Owner Check Detail.
The Owner Check Detail : Initial screen is displayed.

2. Enter the data that is relevant for your search.

The explanation of the fields on the Owner Check Detail: Initial Screen is as follows:

Table 99:

Fiel d Descriptio n

Compan y The company that issues the check

Owne r The business associate number for the owner in the prop­
erty, as well as the interest type and the interest sequence. 
The interest type provides the specific type of ownership in­
terest that the owner holds (royalty interest, working inter­
est, etc.) and the interest sequence indicates the occurrence 
of the interest type within the property/DOI

Check numbe r The specific check that was paid to the owner. This allows 
you to view the information from the check stub at a more 
detailed level
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Check dat e The date when the check was issued

Legen d Indicates a payment/deduction type or special payment rea­
son. This information is passed through the RD allocations 
process and put into Journal Entry for use in the check stub 
information

Accounting perio d Identifies the accounting month used when booking Journal 
Entries in the JE financial system

Property/DO I The property for which the owner interest is being paid

Sales mont h Identifies the production month for which the revenue trans­
action was processed

Product Identifies the specific product that is associated with the 
various values and costs entered on this screen

Select Find Records.

14.5 Entering Royalty Check Information Manually 

Use

Use this to manually enter new check transactions.

This is a standard report that can be used to display a list of checks that have been paid (issued) to an owner. 
You can create a manual check to reflect new checks issued to an owner after the Void / Manual check process 
has run, and a check has been voided.

The information entered here is processed by the manual/ void check transaction job, which will then generate 
the appropriate accounting entries for each manual check.

Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Revenue Distribution → Owner Checks → Manual Royalty Check.
The Manual Royalty Check: Initial Screen is displayed.

2. On the Manual Royalty Check: Initial Screen, select Create.
The Manual Royalty Check – Create screen is displayed.

420 C U S T O M E R
SAP Oil & Gas (PRA - Production and Revenue Accounting)

Revenue Distribution



An explanation of the fields on that screen is as follows:

Table 100:

Field Description

Company The company responsible for processing the check

Approved Set this flag if you want the current manual check entry to 
be ready for processing in the manual/void check transac­
tion job.

This flag allows you to enter an incomplete set of data with­
out completing the check validation process, because the 
validation process will only be carried out if approval is 
checked. The entry is validated by summing the net value 
amounts that currently exist for the check, and adding that 
total to the displayed owner net value for the current entry; 
and if the total owner net value for the entire check equals 
the entered check amount, the current entry will be ac­
cepted and marked as approved for processing.

Owner The payee of the check (the party paid). The owner ID that 
you enter here must be a valid business associate in E&P

Bank ID The bank number from which the check was issued

Bank account The bank account from which the check was issued

Check number The specific check issued to pay an owner

Check date The date on which the check is issued to an owner

Check amount The value (amount) of the check

Property/ DOI The property whose product generates the disbursement 
amount

Sales month The production date of the royalties payable information for 
the relevant manual check

Product The product

Comment sequence Represents the order in which comments have been added 
for the current company, owner, property/ DOI, sales month, 
product, and legend combination. ‘01‘ indicates the first set 
of comments that has been added for the current manual 
entry information

Legend A payment/deduction type or special payment reason. The 
default value is blank, which represents the majority of the 
records, but some of the valid reasons can be: “lawsuit set­
tlement“, “contract buyout/buy down“, and “extraction tax“
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Field Description

Override Account ID Identifies the account number that the manual/void check 
transaction job will use in place of the regular account num­
ber when it is booking royalties payable entries for the cur­
rent manual check. Note: This field cannot be used if there 
are values entered for any of the other deduction type en­
tries

Lease … gross volume The total volume that has been produced and sold for the 
well. This value must be an integer if the product is either 
gas or NGLs (natural gas liquids)

PVR (plant volume reduction) The volume of natural gas liquid that is lost when processing 
gas through a plant is called the plant volume reduction, or 
PVR

Lease … gross value Shows the total value of the sale of the product before any 
taxes and/or deductions. All applicable tax and marketing 
reimbursements must be included in this value

Lease …transportation Indicates the deduction from the lease gross value that the 
owner can take for transportation costs

Other marketing The amount that the owner can deduct from the lease gross 
value for all other marketing costs associated with the se­
lected product

Severance tax The amount of tax that will be withheld from the lease gross 
value for the current product

Owner … disbursement decimal The percentage of interest the owner holds for a specific 
contract. The values range from -1.00000000 to 
1.00000000

Owner … DOI decimal The percentage of interest the owner holds in the current 
property/ DOI. The valid values range from –1.00000000 to 
1.00000000

Owner gross value The owner’s share of the sale of the product at an individual 
owner level, before taxes and deductions. All applicable 
owner-level tax and marketing reimbursements must be in­
cluded in this value

Owner … transportation The owner’s share of the total lease-level transportation de­
duction

Owner … other marketing The owner’s share of the total lease-level marketing cost de­
duction for the selected product
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Field Description

Owner … severance tax The owner’s share of the total lease-level tax that will be 
withheld on the product

To enter additional deductions, select Other Deductions . A dialog box is displayed, from which you can select 
from a number of deduction types (such as “excess royalty reimbursement“, “legal expense“, “crude oil excise 
tax“, as well as various state taxes, such as Colorado state tax, and Utah state tax).

1. Enter your check data.
2. Save your data by choosing Save .

14.6 Displaying Owner 1099 Information 

Use

Use this to display an owner’s year-to-date 1099 tax information (for any year that you specify).

The year-to-date values are the sum of the amounts from the owner’s check detail and any adjustments that 
are entered in the adjustment column. The check write jobs (regular checkwrite, manual checks, and void 
checks) generate and/or update these values.

Procedure

At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue Accounting 
→ Revenue Distribution → Owner Checks → Owner 1099 Information.

The Owner 1099 Info: Initial Screen is displayed.

On that screen, enter the relevant data for your search.

An explanation of the fields on the Owner 1099 Info.:Initial Screen is as follows:

Table 101:

Field Description

Company Must be a valid company for the owner. If no company is se­
lected, the information displayed will be summed across 
several companies in the event that the owner’s checks were 
issued by several different internal companies

Year The tax year for which the 1099 information is required. This 
field will default to the current year if you do not enter a year
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Owner ID Identifies the business associate for whom the 1099 infor­
mation is being gathered

Interest Type Identifies the owner interest type to which the 1099 informa­
tion applies. If no interest type is selected, the displayed in­
formation will be summarized across all the interest types

State Identifies the state to which the tax adjustments and 1099 
information apply. If no state tax is selected, the displayed 
information will be summarized across all of the states 
where the owner holds properties which have interest

1. Select Find Records.
The system displays a list of records based on your search criteria.

14.7 Maintaining Withholding Tax Rate Info 

Use

Use this to establish and maintain withholding tax rate information for both state taxes and non-resident alien 
withholding taxes.

These are specific withholding tax rates. A rate may have to be withheld from a check (for example, if there is 
no proper tax ID).

Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Revenue Distribution → Tax Maintenance → Withholding Tax Rate.
The Withholding Tax Rate: Initial Screen is displayed.

2. Select Create .
The Create Withholding Tax Rate: Overview screen is displayed.

3. Select either State (U.S. state), or Foreign Owner . Based on your selection, the screen will now display 
various fields for data entry.

The following is an explanation of the fields on the Withholding Tax Rate: Initial Screen :

Table 102:

Fiel d Descriptio n
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State or Foreign owne r The state or foreign owner radio buttons allow you to indi­
cate whether the withholding tax rate that is established will 
apply to state-based taxes or to non-resident alien taxes

Stat e Identifies the state to which the tax rate will apply. In order 
for the tax to be deducted for a property/DOI, the state with­
holding tax rate must be established

Tax typ e Identifies the tax to which the withholding rate applies. Once 
you have selected a state, the field will be populated with all 
the tax types that are applicable in that state. In order for a 
tax amount to be calculated for a tax type, a state withhold­
ing tax rate must be entered for the selected tax type

Interest typ e Identifies the owner interest type to which the tax rate will 
apply. All owner interest types that are subject to the tax 
must be established on this screen

Effective from dat e The start date, when the information becomes effective

Effective to dat e The end date, after which the information is no longer valid

Save your record.

14.8 Creating Ad Valorem Tax Recovery Records 

Use

Use this to maintain ad valorem tax data at the DOI/Product/Sales month level. This allocates property tax 
across the DOI. You can also select transactions that should be processed by the allocate ad valorem tax job.

Ad valorem means “according to value“. Ad valorem tax is assessed on the value of goods or property (property 
tax), not on the weight, quantity, etc.

Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Revenue Distribution → Tax Maintenance → Ad Valorem Tax Recovery.
The Ad Valorem Tax Recovery: Initial Screen is displayed.
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2. There are two ways of proceeding:

Table 103:

On the Ad Valorem Tax Recovery: Initial Screen , Select Create .

The system displays the Create Ad Valorem Tax Recovery: Overview screen.

Enter the relevant data on the DOI/ product, and the ad valorem amount that applies; for the receivable value, select 
either estimated or actual , and then select Save .

Alternatively, you can view ad valorem tax data for a DOI/product/sales month.

To do so, on the Ad Valorem Tax Recovery: Initial Screen , enter the data for the DOI, product, and sales month, and 
then select Find Records .

The system lists ad valorem records for the DOI/product/sales month.

An explanation of the fields on the Create Ad Valorem Tax Recovery: Initial Screen (and on the Ad Valorem Tax 
Recovery: Overview screen) is as follows:

Table 104:

Fiel d Descriptio n

Property/ DO I Identifies the property to which the ad valorem taxes apply

Major produc t The product which is subject to the ad valorem taxes from 
the specified property/ DOI

Sales mont h The production month for which the transaction is proc­
essed

Ad valorem tax amoun t The amount of ad valorem tax that is being charged to the 
property/DOI for the specified major product and sales 
month. If the state bills the owner for taxes, this amount can 
be entered on this screen, and a batch process will allocate 
that amount to the owners of the property/DOI

Receivable valu e The receivable value radio buttons indicate whether the ad 
valorem tax amount is an estimated (accrued) value or an 
actual receivable value

Processe d Indicates whether the current transaction should be proc­
essed by the Allocate Ad Valorem Tax job or not. Set it to 
have that job process it.

Remit to operato r This flag indicates whether the ad valorem tax job amount 
should be remitted to the operator for the corresponding 
DOI, instead of remitted to the relevant state or federal 
agency
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Result

An ad valorem tax record is created or displayed (depending on what you selected) for the DOI/product.

14.9 Displaying Negative Payable/Suspense Browse 
Information 

Use

Use this to display a list of all negative payables and all suspended amounts that are due a given, selected 
owner.

A negative payable situation can arise, for example, when one party has paid the other party too much, and will 
then get money back from that owner. Thus, it is called a “negative payable“.

Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Revenue Distribution → Suspense → Negative Payable/Suspense.
The Negative Payable/ Suspense Browse: Initial Screen is displayed.

2. On the Negative Payable/ Suspense Browse: Initial Screen , enter the owner (Owner ID) for which you would 
like to display the list of negative payables and suspended amounts.

3. Select either All , Invoiced , or Uninvoiced .
4. Select Find Records.

Result

The system displays a list of negative payables and suspended amounts for the owner.
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15 Journal Entry 

Purpose

Journal Entry is a set of processes that takes files with records representing financial transactions in PRA, edits 
the data in the files, and posts the files to JE accounts. Journal Entry provides common journalization, posting, 
inquiry, extraction, and purging functions to all other SAP PRA application areas and PRA line item tables. The 
ultimate goal of JE is to have financial data saved in tables, representing financial transactions that have taken 
place in PRA.

Whereas Revenue Distribution reads journal entries, Journal Entry as a module only posts the journal entries. 
Processes within Journal Entry call JE to obtain the relevant account. There are over forty processes in PRA 
that call Journal Entry.

JE provides the following functionality:

● Journal entry collection
● Journal entry maintenance
● Journal entry editing
● Journal entry posting
● Journal entry queries (ABAP Reports on Journal Entry line item tables)
● Journal entry extraction
● Journal entry purging (deletion of data that is no longer required)

A journal entry in PRA, in addition to carrying the net financial debit or credit, can include other data such as 
gross and net volumes, decimals, owners, and purchasers. The specific fields that are included are dictated by 
the JE line item table field definition in the relevant module.

Every journal entry must be linked with a batch (unique batch ID). A batch is simply a collection of individual 
journal entries, to be treated as one unit for processing. Batch numbers must be assigned sequentially for each 
accounting period for each company and batch type. For purposes of the Revenue System (RD, JE, etc.), a 
batch represents a set of journal entries to be processed as a unit.

In order to be processed in JE, a batch (collection of journal entries) must be in balance (meaning: debits must 
equal credits and control totals must equal the corresponding accumulated totals).

The Journal Entry application component is used to maintain account information (accounting detail data) for 
all accounts used in automated or manual processes within PRA, thus completing the upstream business 
processes incorporated in PRA. It also supports the ability to enter and process manual journal entry batches 
(see: Manual Journal Entry [page 444] ).

Journal Entry represents the accounting and disbursement side (what accounting entries are made) of PRA, 
whereas Valuation represents the volumes and values side (what volumes are involved, and how are they 
valued). Revenue Distribution [page 392] serves as the interface between the volumes and values side, and the 
accounting and disbursement side.

The Journal Entry module supports:

● Master data requirements
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● Manual entry of journal entries (manual processes support the entry of accounting entries by an assigned 
group (batch)). Controls, edits and validations are used to check the manual entry processes in JE. JE 
allows for the manual correction or write-off of accounting detail lines that failed posting. You can also copy 
and reverse manual entries.

● Automated processing and financial integration

There are two main components of the Journal Entry module:

● The Chart of Accounts
● Accounting detail posting rules – Features of which include: distribution/ assignment at multiple levels 

for account category, division of interest, and owner), detail type designation (for example: AR, AP, RD), 
and reconciliation (purge) rules, which remove offsetting balances

All journal entries created in PRA, whether entered manually or generated in other systems/application 
components, are edited and posted into the line item tables by the Journal Entry component. The purpose of 
the line item tables is to store the journal entry data according to account type (financial transaction involved).

The following Journal Entry line item tables exist:

● Miscellaneous Line item table
● Inter-company Line item table
● Owner Payable Line item table
● Legal Suspense Line item table
● Statistical Line item table
● Income Line item table
● Expense Line item table
● Tax Payable Line item table
● Accounts Receivable Line item table
● Accounts Payable Line item table

(Note: for a full list of and description of all the line item tables in JE, see: Journal Entry Line item tables 
[page 433] )

The following represents the process flow for Journal Entry:
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Journal entry automated processing:

● Gathers all available entries
● Performs edits and validations
● Posts accounting detail to line item table detail ledgers
● Posts summarized accounting detail to SAP financial components (there is an SAP FI integration job that 

summarizes JE transactions for posting in FI). JE volumes can be sent to the SAP FI Module for all JE 
accounts.

Features

Journal Entry encompasses the following:

● Maintenance of a chart of accounts for all accounts that are used in PRA processing.
● Maintenance of identification of the keys for purging account data on either a routine or periodic basis. 

Asset and liability accounts are purged based on net account balances. Income and expense accounts are 
purged based on a defined time period.

● Maintenance of default account numbers that are used in PRA processing, when certain types of 
accounting entries are made (for example, the default account used to book royalty payables). In many 
cases, default accounts can vary based on other characteristics of the type of entry being made, such as 
product, interest type, entity type, etc.
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● Provides the ability to establish account numbers that override the default accounts. The override 
accounts are set up to be used at either a DOI or DOI/owner level. The DOIs or DOI/owners to which the 
overrides apply are maintained in the DOI accounting data application component.

● Provides the capability to enter manual batches of journal entries , with appropriate controls such as 
batch controls and journal entry edits and validations.

● Edits and validates all journal entries , whether they originate in manual journal entry batches, or have 
been generated automatically by other PRA application components.

● Provides the ability to track journal entries that have failed the edit and validation process . Rejected 
journal entries can be corrected online, and can also be written off.

● Processes journal entries that apply to future accounting periods. Other PRA application components 
cannot utilize these entries until the future accounting period becomes the current accounting period.

● Provides the ability to flag manual batches so that they will be automatically reversed in the next 
accounting period.

● Provides the ability to copy manual journal entry batches, with an option to reverse the signs of the entries, 
if desired.

● Provides a search and display function that queries the various line item tables maintained by the Journal 
Entry component.

The following table provides an overview of some of the main concepts used in Journal Entry, along with a 
description of each concept:

Table 105:

Account number Represents the account number of a group of journal en­
tries.

Account type The type of journal entry that the account represents. Exam­
ples of account types include owner payable, expense, in­
come, etc.

Company The processing company, to whose books the account will 
be posted (journalized).

Accounting Category A four-character code identifying a group of account num­
bers.

Accounting Period Identifies the accounting month in which the batch is to be 
entered. The accounting period must be open to be ac­
cepted. Three accounting periods will be open at any given 
time (to include the current month plus two).

Batch number Used to uniquely identify a group of journal entries. The sys­
tem sequentially assigns batch numbers by batch type.

Batch type A code used to classify batch information. Examples are: Re­
versal, write-off, and void checks. Batch types are desig­
nated as reversible and non-reversible, for use in the Reve­
nue Distribution automated reversal processing. All batch 
types, except type 42 are non-reversible, and will not be 
processed by the automated reversal procedure.
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Account number An account number is a ten-character reference number 
used to identify a journal entry. It is set up in account main­
tenance.

Account category An account category identifies a group of account numbers. 
For example, taxes payable is an account category. Within 
this category, several taxes payable account numbers exist 
that refer to a specific account such as taxes payable – gas 
and taxes payable – oil.

The account categories are defined in common table 
TBLRV016. This table is a static list of all account categories 
used by SAP PRA.

Account category attributes There are several attributes that are used to uniquely iden­
tify the account numbers within an account category. These 
attributes are defined on the Accounting Category transac­
tion (see:

Creating Account Category Information [page 440] ). For 
each account category defined on common table 
TBLRV016, an entry that describes the distinguishing char­
acteristics of the accounts within the category must be 
made in this transaction.

Account number determination Several areas of PRA generate journal entries. Account num­
bers are assigned to these entries using the values of the re­
quired account category attributes found on the PRA trans­
action being processed. The tie between the values of the re­
quired attributes and the specific account number is made 
on the Account Entry Control transaction (see:

Using Account Entry Control [page 442] ).

Default account number If the combination of values found on the PRA transaction 
does not exist on the Accounting Entry Control transaction, 
a default account number is used. The default account num­
bers are listed by category on common table TBLRV066.

A default account number report is generated by each PRA 
program that attempts to assign an account number to a 
journal entry but cannot, and therefore, uses a default ac­
count number.

Integration

JE contains system interfaces with the following PRA application areas:

● Division order in Ownership (used for validation)
● Revenue Distribution/Disbursement
● Check input processing
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15.1 Journal Entry Line Item Tables

Definition

PRA contains a General Ledger and ten line item tables. A line item table is a table containing journal entries 
specific to a particular function. The PRA JE posting process (see: The JE Posting Process [page 448] ) posts to 
ten separate line item tables. The determination in the system of which journal entries will be posted to which 
line item table is made based on the account type assigned to the journal entry.

It is important to note that every posting in JE always has two accounts that are posted to:

● The JE General Ledger (header information), and
● A line item table (detail information)
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The account type determines which JE line item table the journal entry will be posted to.

JE has the following line item tables (the technical name of the table is provided here if you want to view 
the table itself) :

Table 106:

Line item table name Line item table description

Miscellaneous (Table OIUH_RV_MSSL) Used by various RD reporting processes

Inter-company (Table OIUH_RV_ICSL) Used for accounting between companies. Used in automatic 
billing situations (as opposed to situations in which a check 
is sent). Used when an affiliate is an owner in a DOI to which 
the processing company is distributing revenue. The affili-
ate’s share of sales, tax expense, marketing expense, etc. is 
recorded in separate accounts on the affiliate’s ledgers, and 
a payable entry for the net amount is recorded to an account 
in the Inter-Company Payable category on the processing 
company’s ledgers. The entry represents money that must 
be distributed to the affiliated owner by the processing com­
pany.
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Owner payable (Table OIUH_RV_OPSL) Used for RD check-write, royalty reporting, RD reporting, 
Check Input, Negative invoicing, RD transfer of suspense 
balances, and Tax and Regulatory Reporting.

Legal suspense (Table OIUH_RV_LSSL) Used for RD reporting and the RD transfer of suspense bal­
ances. Legal suspense is used when recording net payable 
amounts to non-affiliated owners who are in legal suspense.

Statistical (Table OIUH_RV_STSL) Used for statistical purposes only. Most commonly used to 
record amounts that would have been paid to carried own­
ers, or to the Minerals Management Service (MMS), when 
there is a ‘take-in-kind’ situation.

Income (Table OIUH_RV_INSL) Used by the RD accrual process, used for the Income Analy­
sis Report, the Sales/Accrual Report, and the Sales History. 
Income is an affiliated owner‘s share of sales, plus tax reim­
bursements; it is recorded to accounts in the income cate­
gory.

The share of revenue distribution to an affiliated owner in the 
DOI. The net amount is recorded on the processing com­
pany on the affiliated owner’s behalf.

Expense (Table OIUH_RV_EXSL) Records an affiliated owner’s share of marketing costs or 
tax.

Tax payable (OIUH_RV_TPSL) Actual tax amounts that have been calculated in the Valua­
tion module of PRA. It represents the amount payable to 
state or local taxing authorities.

Used for RD reporting and taxes payable write-off process­
ing.

Accounts Receivable (Table OIUH_RV_ARSL) Amount to be received from the purchaser in connection 
with a sale when the purchaser on the contract is non-affili-
ated.

Accounts Payable (Table OIUH_RV_APSL) External marketing charges when the service is not provided 
by the purchaser or an affiliated company.

The JE line item table is sometimes represented by the concept of "account ID" in some JE transactions. For 
example, in the manual journal entry transaction, the account ID refers to the JE line item table that you are 
posting to.
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15.2 JE Account Master Data Creation 

Purpose

Before you can use Journal Entry for your transactional data, you will have to set up the accounts that you want 
to use – which are master data.

The purpose of setting up master data in JE is to define the relevant accounts and account ID – account 
category links, so that for a specific situation, the relevant account can be found for a specific posting situation.

There are various accounts that can be set up in Journal Entry. You first have to set up the SAP FI (Financial 
Accounting module) accounts in the FI Chart of Accounts (FI General Ledger). Then, you set up your PRA 
accounts – the accounts that you intend to use to post journal entries to. You can set up numerous accounts 
representing differing account types, and you can even set up accounts per customer and/or product (for 
example, an account based on federal entity and condensate as the product type, and a separate account 
based on state as the entity and condensate as the product).

You cannot run anything on the Revenue Accounting side of PRA unless you first set up the relevant accounts 
that you will be using.

The overall master data creation process of creating the accounts is illustrated below:
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Prerequisites

You have to first have created your accounts in SAP FI before you can begin creating accounts for JE. For more 
information on that, refer to the documentation on SAP FI General Ledger .

Process Flow

1. You create your FI Chart of Accounts in Core SAP FI (or: it is already set up for your company).
You create your PRA Chart of Accounts (see: Creating PRA Accounts as Master Data (Chart of Accounts) 
[page 437] )
You set up accounting category information in customizing (see: Creating Account Category Information 
[page 440] ).
You set up account entry control information – which ties accounts to account categories (see: Using 
Account Entry Control [page 442] ).

After your accounts have been set up as master data, you can begin to create journal entries.

The accounts that you set up in the PRA Chart of Accounts have to be valid accounts in the FI Chart of 
Accounts.

15.2.1  Creating PRA Accounts as Master Data (Chart of 
Accounts) 

Use

Use this to create the PRA Chart of Accounts for your company. The PRA Chart of Accounts are the individual 
accounts that you will be using in Journal Entry in PRA when you post journal entries.

The PRA Chart of Accounts is that part of your company’s FI General Ledger accounts, which you will use in 
Journal Entry. It represents the accounts that will be available for transactional journal entries. For example, 
you might have 50 accounts in your company’s FI General Ledger, and from that, you choose to use 20 
accounts in your PRA Chart of Accounts.

The creation of your Chart of Accounts is sequential – you create one account after another. The accounts that 
you set up have to first be in SAP FI (in the FI Chart of Accounts – the FI General Ledger).

You tie an FI account ID with an account in PRA. The “account type” represents the type of account – based on 
what type of data will be saved to the table or account.

You create a new record in PRA, which defines an account ID from FI, which is created as a specific account 
type in PRA (account type = owner payable, royalties payable, etc.). You create each individual account here, 
and you can create one after the other, until you have all your accounts created. The account type determines 
which type of journal entries will be posted to the account (for example, if you set up an account from FI as an 
owner payable account, it will only post owner payable entries during transactional JE processing).
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The graphic below illustrates this process: you define accounts that have already been set up in SAP FI as 
accounts that you intend to use in PRA Journal Entry. (Generally, only a portion of the total FI GL accounts will 
be used as PRA accounts).
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You create a new account per company code. The FI account ID will be the 
same as the PRA account ID (when you enter the account ID here, validations 
run to make sure that that account already exists in FI). The account type 
determines the type of journal entries that will be posted to the account (in 
the example below, Owner Payable), and determines the line item table in JE 
that the data will be posted to.

Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Journal Entry → Master Records → Account Maintenance.
The Account Maintenance screen is displayed.

2. Select Create .
3. On this screen, you are taking an account that already exists in FI for your company, and defining it as an 

account within PRA. In the Account ID field, enter an account that already exists in FI. Now, in the Account 
Type field, select the type of JE account that you would like the account to be. Also enter the relevant 
company code in the Company field. This will create the account for this company code.
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4. Choose Save .

It is important that if you are creating a record here, that you always set the Active flag on this screen. That 
indicates to the system that this account maintenance record is to be an active account. The only situation in 
which you would deactivate it is if you want to deactivate an already existing account – to set the account to 
‘inactive’ – in effect turning off that account for data entry.

Result

A new account is created and added to the Chart of Accounts in JE. This defines an existing FI account as a new 
JE account. The type of journal entries that this new account will receive during transactional journal entry is 
defined by the account type that you define here.

15.2.2  Creating Account Category Information 

Use

Use this to set the account category attributes for your account ID.

Journal entries use the account category to assign every line item to a JE account.

Here, you set up which account types can post with the account category. An account category can have more 
than one account type.

This area is part of customizing.

You define the category attributes that will be used on the Account Entry Control screen (as fields).

Each journal entry that is used in PRA is linked with an account category. Here, you set the account parameters 
for the accounts category. This in effect allows you to create more specific accounts in PRA, based on the same 
account ID / accounting category record.

By setting one of the category attribute flags, you indicate that the selected attribute will then be used on the 
Accounting Entry Control screen to help assign unique account numbers to a category for each value of the 
attribute. These requirements must be set up for an accounting category on this screen before the Accounting 
Entry Control screen can be used.

An account category identifies a group of account numbers. For example, Taxes Payables is an account 
category. Within that category, several Taxes Payable account numbers exist that refer to a specific account 
such as Taxes Payable – Gas and Taxes Payable – Oil.

The account categories are defined in common Table TBLRV016. That table is a static list of all account 
categories used by PRA. Updates to that table cannot be carried out without changes to the PRA programs that 
use them.
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Accounting category attributes – There are several attributes that are used to uniquely identify the account 
numbers within an account category. These attributes are defined in the Accounting Category transaction (see 
path below). For each account category defined in common table TBLRV016, an entry that describes the 
distinguishing characteristics of the accounts within the category must be made in this transaction.

For example, if separate taxes payable account numbers exist for each product code, product code would be 
marked as a required field in the above transaction ( Accounting Category ) for the taxes payable account 
category.

If taxes payable is not enough to distinguish the taxes payable account numbers, then each required attribute 
would be set to Y in that transaction.

Several areas of SAP PRA generate journal entries. Account numbers are assigned to those entries using the 
values of the required account category attributes found on the PRA transaction being processed.

The tie between the values of the required attributes and the specific account number is made on the Account 
Entry Control transaction (see: Using Account Entry Control [page 442] ).

If the combination of values found on the PRA transaction does not exist on the Account Entry Control 
transaction, a default account number will be used. The default account numbers are listed by category in 
common table TBLRV066. A default account number report is generated by each PRA program that attempts 
to assign an account number to a journal entry but cannot, and therefore, uses a default account number.

Prerequisites

You first have to have set up an account and an account category in JE, and link the accounts to a category.

Procedure

1. Within Customizing, choose SAP Reference IMG, and then: Industry Solution Oil & Gas (PRA) → Revenue 
Accounting → Journal Entry → Configure Accounting Category .
The Accounting Category: Initial Screen is displayed.

2. On the Accounting Category: Initial Screen, enter an Accounting category and an Accounting type and then 
select Create.
The Create Accounting Category screen is displayed, with all the possible category attributes as flags at the 
bottom.

3. You can now set the category attributes that you would like to use with this account ID / accounting 
category record. When you select a flag here, the corresponding field on the Account Entry Control screen 
will then require an entry (exception: completing the Affiliated Company field in the Account Entry Control 
transaction is optional).
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15.2.3  Using Account Entry Control 

Use

Use this to define account attributes and link them to a specific accounting category. This allows you to create 
more than one account per account category.

You can create a new account, differentiated by the parameters you set in account category customizing:

● State
● Entity Type
● Product
● Interest Type
● Contract Type
● Volume Type
● Severance Tax Type
● Marketing Cost Type
● Property Interest
● Affiliated Company

This transaction ties an account ID to an account category – differing by the available parameters that you 
already set up for this account category (within customizing for accounting category).

For example, it allows you to create a different account for the same account ID / account category, but based 
on such differentiators as entity type and product. The differentiators were already set up in the accounting 
category transaction in customizing.

The data that is defaulted on this screen is from Account Category Customizing (see: Creating Account 
Category Information [page 440] ).

The data on this screen will be defaulted from Account Category Customizing, and will display the account 
category attributes that were defined for the account ID / account category combination.

This transaction is to be used once (for each account) to set up the data as master data.
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Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Journal Entry → Master Records → Accounting Entry Control.
The Account Entry Control: Initial Screen is displayed.

2. On the Account Entry Control: Initial screen , enter the relevant data and select Create .
The system displays the Account Entry Control – Create screen.

3. On that screen, enter the relevant data and either Default , Property/DOI Override , or Owner Override .
4. Select Save .
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15.2.4  Creating an Account Category Override by DOI or 
Owner 

Use

Use this to override the usual account category search method, instead indicating an override account that you 
would like the system to use. This is used to override the usual account assignment for a specific owner/DOI, 
etc.

This allows you to override the usual account search in JE for a specific account category, either by property/
DOI, or owner for a specified major product and effective date.

Procedure

1. At the SAP Easy Access Menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Journal Entry → Master Records → DOI Owner Accounting Entry Code .
The DOI Owner Accounting Entry Code: Initial Screen is displayed.

2. On that screen, select Create .
The DOI Owner Accounting Entry Code – Create screen is displayed.

3. The first decision that you should make here is whether you want to override for an owner or a DOI. Select 
either Property/DOI or Owner .

4. Next, enter the account category, major product, and property/DOI. The Override Account is the account 
that you would like to use instead of the usual account. Select Enter .

You are in essence telling the system here - do not use the account that is in the Default account field, but 
rather, use the account that is in the Override account field.

The bottom of the screen – which contains fields that have account category data - is for informational 
purposes only.

15.3 Manual Journal Entry

Purpose

The usual way that journal entries are processed in JE is that they are automatically processed from the PRA 
application areas such as Valuation, Revenue Distribution, and Check Input (see: The JE Posting Process [page 
448] ).
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There are situations, however, in which you will want to manually enter journal entries. Those situations are the 
following:

● If a journal entry is required but is not automatically processed in PRA
● When timing does not allow the running of the SAP PRA process to enter or adjust the amounts
● When standard accrual or workpaper type entries are required
● When a journal entry rejects due to an error during the journal entry batch process
● As a correcting entry, or as an adjusting entry (you have posted 100 to a line item table, and should have 

posted 120, so you now manually enter a value of 20, etc.).

Process Flow

1. On the JE Batch Control screen, you create a batch with batch control data (see: Creating a Batch Control 
Record [page 445] ).

2. On the JE Detail screen, you create manual journal entry detail information for that batch (See: Entering JE 
Detail Information for Manual Journal Entry [page 446] ).

Of the two methods listed above: batch control processing and manual journal entry, both are batch 
functionality. The distinction is that batch control processing involves system-generated batches, and manual 
JE is not system-generated. When you create batch control information, the system automatically assigns a 
batch number, when you save that data. In manual journal entry, you manually enter the journal entry 
information and save your record.

15.3.1  Creating a Batch Control Record 

Use

Use this to create a batch control record for manual journal entry.

Before you create a manual journal entry, you first have to create a batch control record. Whenever you want to 
manually enter journal entries in JE, you first have to set up the batch control information, and then create the 
manual journal entry detail information for that batch. You use batch control to set up a batch for manual 
processing, to which detail information will be added in a subsequent step (see: Entering Journal Entries 
Manually [page 446] ).

You use this to approve and select journal entry batches for processing. Control totals are used to ensure that 
data has been entered correctly and that all the proper accounting procedures have been met before a batch 
can be selected for processing.

A batch may be changed or deleted only if its status is “work unapproved“.
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Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Journal Entry → Document Entry → JE Batch Control.
The Batch Control: Initial Screen is displayed.

2. On the Batch Control: Initial Screen, select Create.
The system now displays the Batch Control – Create screen.

3. Enter the relevant company (in the Company field) to which the journal entry will be posted. Enter the 
relevant accounting period (in the Accounting Period field) for the manual journal entry batch, as well as 
the total amount ($) that the manual journal entry batch will represent (you enter that in the Debit Amount 
field).In the Number of entries field at the bottom of the screen, enter the total number of detail entries you 
plan to enter on the JE Detail screen (Manual Journal Entry screen). In the Statistical Amount field, enter 
the number that you would like to enter as “statistical”. In the Type field, enter the type of batch that you 
would like to create. (The Calculated column will display the total amounts that have been entered at the JE 
Detail level in that step).

4. Choose Save .
5. The system will now assign a batch number to this batch (the system finds the next sequential batch ID 

number and uses it). The system-generated batch ID will now be displayed in the Batch ID field.

The Copy/reverse dialog box allows you to create a new journal entry batch or to reverse the current batch.

Result

The batch control data is created for manual journal entry. You can now enter the detail information for the 
batch on the JE Detail screen.

15.3.2  Entering JE Detail Information for Manual Journal 
Entry 

Use

Use this to create the JE Detail data for a manual journal entry batch. Based on the account ID, you enter detail 
information here and create the journal entry.

This is done immediately after you have created the batch control record (see: Creating a Batch Control Record 
[page 445] ). The data that you enter here is tied to the batch control record, and provides detailed information 
on the batch that you are creating for manual journal entry.

You can use this to create new journal entries manually, and to display, change, and delete existing journal 
entries.
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The information that is entered on this screen will ultimately be used for 1099 tax reporting, and since different 
fields may be required, depending on the account ID and assigned account category, you should be careful that 
all the necessary data has been entered to ensure accurate and complete reporting to the U.S. federal 
government.

Prerequisites

● You have to have the authorization to maintain manual journal entry information.
● You have batch data entry type security for the batch number being entered.

Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Journal Entry → Document Entry → JE Detail.
The Manual Journal: Initial Screen is displayed.

2. On the Manual Journal: Initial Screen , there are three ways that you can proceed, depending on what you 
want to do:

Table 107:

To… On the Manual Journal: Initial Screen…

Create a new JE record Enter the relevant data (for descriptions of the individual 
fields, see below) and select Create .

The Manual Journal – Create screen is displayed.

From there, enter the relevant data, and choose Save to 
save your new record.

Create a new JE record, with reference (you copy an exist­
ing record, which you are using as a template or reference 
for creating your new record).

Enter the relevant data ( company code , Account ID, 
Batch ID, Line number , etc.) and then select Find 
Records .

From the list that is displayed on the subsequent screen, 
choose an item (a row) and select Copy . The system will 
use the attributes of the record you chose in creating the 
new record. Now make any changes that you would like to, 
and choose Save to save your record.

Change, display, or delete existing records Enter the data for your search and then select Find 
Records . From the list on the next screen, you can select a 
record and then select Change . You now can change or 
delete the record. After that, choose Save .

The company , accounting period , and amounts will be the same on the JE Detail screen as they were on the JE 
Batch Control screen for the batch that you are creating, because you are supplying the detail information for 
the batch here.

With respect to the fields on the Manual Journal: Initial Screen :

Company – Is required for the system to know which company this applies to.
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Account ID – Must be entered to determine which fields allow data to be entered on the screen. These fields are 
determined by the account type as originated in the Account Maintenance transaction. On this screen, you are 
entering a journal entry for this account ID.

Transaction amount (net amount)- Is the total dollar amount for the journal entry that you are creating. It is a 
required entry. It will be used to determine if the batch balances with the control totals on the Batch Control 
screen.

You do not have to enter either Well completion or Measurement point . Those are optional.

1. Choose Save .
The amount that you entered in the Transaction amount field will now be defaulted into the JE Batch 
Control screen and be displayed in the Batch Control Totals screen area.
The Calculated Totals on the Batch Control Totals screen have to equal the Entered amounts for that line, 
before the batch can be selected and processed without errors.
The batch will now have a status of “ready for processing”.

15.4 The JE Posting Process

Use

The purpose of JE posting is to take a batch, validate it for consistency, and create FI documents and post 
those entries in various line item accounts needed for subsequent business processing.

JE Posting is a process that with a few exceptions runs behind the scenes (without user dialog) and is the heart 
of Journal Entry. It receives journal entry data (representing financial transactions) from the PRA modules 
(Valuation, Revenue Distribution, etc.), and summarizes them in batches and posts them to the PRA JE line 
item tables and to SAP FI. JE Posting is the link between the journal entries coming from PRA applications and 
the FI documents and JE line item table items that are created.

All application areas of PRA that create financial transactions call the Journal Entry system and use it. The 
sender (source) of the data is the various application areas of PRA (Revenue Distribution, Checkwrite, Check 
input, etc.).

The JE Posting Module is automatically called by the various PRA application areas. For example, whenever you 
create a Valuation, Revenue Distribution, Checkwrite, Check Input, Tax and Royalty, Owner Suspense, or 
Accounts Receivable document, the JE Posting Process is automatically triggered.

There is an exception to that, however – the JE stand alone Posting Mode. It is used to manually trigger JE 
Posting for ad hoc processing needs like manual journal entry and reject corrections. For more information on 
that area, see: Running JE Posting in Stand-Alone Mode (JE Posting Driver) [page 452] .
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The following is a graphical representation of the data flow for JE posting:

Whenever journal entries are posted, the data for each journal entry is posted to two separate tables: the JE 
General Ledger, and JE line item tables (one of the ten line item tables, based on what type of financial 
transaction is involved).
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Features

JE Posting can handle three kinds of batches:

Table 108:

Batch Description

Original posting Original posting is the case when JE receives a batch num­
ber (a set of two or more JE records) to be posted for the 
first time.

Reject reprocessing Reject reprocessing occurs when JE posted the original 
batches and some line item failed validation and was re­
jected. Those entries are stored in a JE table (Manual JE & 
Rejects Table) which is corrected through the Manual Jour­
nal entry screen. Once the problem has been fixed, it is sent 
again for posting through the stand-alone JE posting driver.
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Batch Description

Write-off Write-off processing happens when the user decides to dis­
card the rejected line item instead of correcting the error.

The following functions are supported:

● Validations are carried out on the journal entries (checks are carried out on the journal entries with respect 
to: master data, data integrity, and checks if the fields are filled).

● Any errors in journal entries are written to an error table (Manual JE and Rejects Table). From there, you 
can use the Running JE Posting in Stand-Alone Mode (JE Posting Driver) [page 452] to manually trigger JE 
Posting, after any corrections have been made via the Manual JE function.

● The formatting of accepted journal entries for input into the JE subledgers and SAP FI ledgers
● The updating of the A/R interface table with receivable line items

When the batch is accepted, the set of line items for the batch is summarized on a company code, accounting 
period, batch number, and account number and FI document line items are formatted and posted to FI through 
a BAPI call.

The ultimate function of the JE Post process is to post journal entries (summarized financial transactions) to 
line items accounts in JE (the line item tables) and to post to SAP FI. JE Posting helps you carry your financial 
transactions to financial statements in FI.

Each journal entry has two entries: a header and a line item. The header entry is posted to the PRA General 
Ledger, and the item is posted to a JE line item.

● The system assigns a batch number to each batch.
● Each process calls the JE post directly, thus eliminating the need for JE post batch jobs.
● Reconciliation between postings in FI and batch number in PRA exists
● JE reports (The Accepted Journal Entry Report, and the Rejected Journal Entry Report) can be executed at 

any time for any JE post run
● A new JE post process can be run even if the previous post process failed
● A BAPI is used as an interface to post to SAP FI.
● A staging table (JEINTF) is used in the JE Post Process.

If a batch run fails, the system will roll back the work so that it does not post to FI and the subledgers.

Integration

FI customizing affects JE Posting.

SAP Oil & Gas (PRA - Production and Revenue Accounting)
Journal Entry C U S T O M E R 451



15.4.1  Running JE Posting in Stand-Alone Mode (JE Posting 
Driver) 

Use

You can use this to manually trigger the JE Posting Process.

You can do that, for example, after corrections have been made to JE rejects using Manual JE. You then 
manually trigger JE Posting in order to post the batches that you have made changes to.

JE posting is usually an automatic, “behind-the-scenes” process that runs without any user interaction. In 
general, the JE Posting Process pulls data from the PRA Modules and creates PRA line items and SAP FI entries 
(see: The JE Posting Process [page 448] ).

There is an exception, however, and that is manual triggering of the JE Post Process. You use this if there is an 
error in the JE Post (for example, you might have an incorrect account number that you want to correct). That 
might occur, for example, when there is an error at a line item level – resulting in a “reject” at that line. The error 
is then sent to the Manual JE and Rejects Table in Journal Entry.

However, the corrections are not automatically processed. You have to use the JE Standalone Driver to 
retrigger the JE Posting Process.

Please see the graphic within the documentation on The JE Posting Process [page 448] . The graphic illustrates 
where in the overall JE Post Process the stand-alone posting driver function fits in.

Procedure

1. From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Revenue 
Accounting Journal Entry Periodic Processing JE Posting .

The Program ROIUH_JEPOST_DRIVER – Standalone JE Posting screen is displayed.

Enter the data that you would like to re-post: Company code, accounting period, and batch number.

Select Execute .

If you do not enter anything in the fields, and then select Execute, the system will display all the available 
batches (brand new batches, and all batches that contain rejected entries).

The system will produce a message that states, “Job started successfully. Jobname: ………..”

452 C U S T O M E R
SAP Oil & Gas (PRA - Production and Revenue Accounting)

Journal Entry 



15.5 Carrying Out a Query of Accepted Journal Entries 

Use

Use this to run a report in JE that lists all accepted journal entries.

Normally, in JE, journal entries are posted to JE line item tables, and the data remains there. You may, however, 
want to put the accepted (posted) journal entries into a form in which they can be listed and then printed 
together. “Posted” or “accepted” means – posted to SAP FI and to a line item table. This report lets you do that 
– it lets you run a report of all posted journal entries so that you can print them out.

You can post a batch and then use this to obtain a list of all the journal entries that were posted within that 
batch, which you can then print out.

Procedure

1. From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Journal Entry → Reporting → JE Posting Reports → Posted Journal Entries Reports .

The Accepted Journal Entries Report screen is displayed.

1. There are two options for proceeding:

● Just select Execute (without entering any data). The system summarizes all batches together into one list.
Enter data in the fields (batch number, etc.) for a more targeted report query. For example, if you know 
what the batch number is, you can run a report that produces a list just for that batch.

Result

A list is produced, showing all of the posted (accepted) journal entries.

15.6 Carrying Out a Query of Rejected Journal Entries 

Use

Use this to run a report on journal entries which have been rejected – not posted successfully .

It can occur that in JE, there are journal entries that are not posted, for a variety of reasons. Normally, those 
rejected entries are simply saved in reject tables in JE. You may, however, want to run a report on the tables and 
then put the rejected journal entries into list form, in order to print them out. This function allows you to do 
that.
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For example, you might run a batch through JE, posting the journal entries to JE line item tables. Then, you 
might want to run a report on that batch to list all journal entries that were not posted (rejected) for that batch.

Procedure

1. From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Journal Entry → Reporting → JE Posting Reports → Rejected Journal Entries Report .

The Rejected Journal Entries Report screen is displayed.

1. There are two options for proceeding:
○ Select Execute (without entering any data in the fields). That will produce a list of all batches, 

summarized in one list.
○ Enter data in the fields to narrow down your search. For example, you can enter the batch number. 

Select Execute . The system displays a list of non-posted journal entries based on your search.

Result

The system produces a list of rejected (non-posted) journal entries.

15.7 Carrying Out the JE Monthly Accounting Period Close 

Use

Use this to carry out a Journal Entry Monthly Accounting Period Close.

Journal Entry is based on accounting periods – journal entries are processed per accounting period. This 
process closes the current accounting period, and is usually a month-end close.

When you run this transaction, the system displays all the current open accounting periods for all the 
companies and company codes, along with a flag for each open accounting period. You can set the flag for each 
period, which means that you want to close that accounting period for journal entry, meaning – no journal 
entries will be able to be processed for that period after that (for example, if you close November, journal 
entries will only be able to be entered for December).

You will usually run this at the end of the month, when you want to close accounting periods for that month. You 
can close the accounts for a single company code for a specific month, while leaving another company code 
open for that month.
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Before you run this, it is important to realize that once you close an accounting period in JE, you cannotreopen 
it later. Please consider the effects of running this transaction before you run it. It is a good idea to only run it at 
the end of the month, and only after thinking about the effects that it has.

Procedure

From the SAP Easy Access menu, choose LogisticsProduction and Revenue AccountingRevenue 
AccountingJournal EntryPeriodic ProcessingAccounting Period Close.

The PRA Accounting Period Close screen is displayed.

That screen displays all open accounting periods for all company codes, with a flag next to each.

Select the periods that you would like to close by flagging each one.

Select Process Close .

15.8 JE Line Item Table Queries

Purpose

Journal entries are stored in Journal Entry line item tables. Those line item tables can be queried, for example, 
if you want to do an analysis of the records in the table. Or, you might want to find out, for example, how much 
you owe a specific owner for a specific period, in which case you would run a query on the Owner Payable line 
item table for a specific owner.

You can query the following JE line item tables:

● The General Ledger
● Miscellaneous
● Inter-company
● Owner Payable
● Legal Suspense
● Statistical
● Income
● Expense
● Tax Payable
● Accounts Payable
● Accounts Receivable
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15.8.1  Carrying Out a General Ledger Query 

Use

Use this to view the various records that have been entered into the Journal Entry General Ledger.

The JE General Ledger is a “parent record” that carries key information supporting a detailed line item entry to 
each JE line item record. Whenever you have an entry in JE, the entry consists of the parent and the 
“child“ (G/L and line item table). For example, when an entry is made, the header information (property, DOI, 
sales date, etc.) is posted to the G/L, and the details (gross booking, interest, etc.) are posted to the line item 
table. There is always that 1:1 relation between G/L and line item table.

The General Ledger contains the following fields:

● Company
● Batch ID
● Accounting Month
● Account ID
● Well completion or Measurement point
● Product
● Sales Month
● Property/DOI
● Network
● Purchaser

Procedure

1. At the SAP Easy Access Menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Journal Entry → Accounting Ledgers → General Ledger Query.
The General Ledger Query: Initial Screen is displayed.

2. On that screen, enter the relevant data for your search, and either Well completion , Measurement point , or 
None .

3. Now select Find Records .
The General Ledger Query screen is displayed, with a list of records that correspond to your search.

15.8.2  Carrying Out a Miscellaneous Line Item Table Query 

Use

Use this to view all of the Journal entries whose account type is “miscellaneous“.

The Miscellaneous Line Item table is Table OIUH_RV_MSSL. It is used for various RD reporting processes.
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Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Journal Entry → Reporting → Line Items (by Account Type) → Miscellaneous.
The system displays the Miscellaneous Subledger Query: Initial Screen .

2. Enter the data for your query and then select Find Records .
The system produces a list based on your search criteria.

Explanation of the subsequent dialog boxes:

Owner tax dialog box – shows the owner’s share of all taxes that apply to the current miscellaneous Journal 
entry.

Gross tax dialog box – shows the property level total tax amount for each applicable tax type for the current 
miscellaneous Journal entry.

Other Deductions Dialog – Shows the property level total deductions for each applicable deduction type for 
the current miscellaneous Journal entry.

15.8.3  Carrying Out an Inter-Company Line Item Table Query 

Use

Use this to view all of the Journal entries whose account type is “inter-company“.

The Inter-company Line Item Table is Table OIUH_RV_ICSL). The table is used for accounting between 
companies. It is used in automatic billing situations (as opposed to situations in which a check is sent). It is 
used when a affiliated company is an owner in a DOI to which the processing company is distributing revenue. 
The affiliate’s share of sales, tax expense, marketing expense, etc. is recorded in separate accounts on the 
affiliate’s ledgers, and a payable entry for the net amount is recorded to an account in the Inter-company 
payable category on the processing company’s ledgers.

The entry represents money that must be distributed to the affiliated owner by the processing company.

Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Journal Entry → Reporting → Line Items (by Account Type).
The Inter-company Subledger Query: Initial Screen is displayed.

2. Enter the relevant data for your search, and then select Find Records .

The system produces a list of records based on your search criteria.
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15.8.4  Carrying Out an Owner Payable Query 

Use

Use this to view all of the Journal Entries whose account type is “owner payable“.

Owner Payable is a line item table that is used in RD Check Write, Royalty Reporting, Check Input, Negative 
Invoicing, RD transfer of suspense balances, and Tax & Regulatory Reporting. The technical table name of the 
Owner Payable table is OIUH_RV_OPSL).

Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Journal Entry → Reporting → Line Items (by Account Type) → Owner Payable.
The Owner Payable Subledger Query: Initial Screen is displayed.

2. On the Owner Payable Subledger Query: Initial Screen , enter the relevant data for your search.
3. Select Find Records.

The system produces a list of records based on your search criteria.

15.8.5  Carrying Out a Legal Suspense Query 

Use

Use this to view all of the Journal Entries whose account type is “legal suspense“.

The Legal Suspense Line Item Table is used for RD reporting and the RD transfer of suspense balances. Legal 
suspense is used when recording net payable amounts to non-affiliated owners who are in legal suspense. The 
technical table name of the table is OIUH_RV_LSSL).

Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Journal Entry → Reporting → Line Items (by Account Type) → Legal Suspense.
The Legal Susp. Subledger: Initial Screen is displayed.

2. On the Legal Suspense Subledger: Initial Screen , enter the relevant data for your search and then select 
Find Records .

Explanation of dialog boxes:

Owner Tax dialog box – The owner tax dialog shows the owner’s share of all taxes that apply to the current 
legal suspense Journal Entry.
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Gross Tax dialog box – shows the property level total tax amount for each applicable tax type for the current 
legal suspense Journal entry.

Other Deductions dialog box – Shows the property level total deductions for each applicable deduction type 
for the current legal suspense Journal entry.

15.8.6  Carrying Out a Statistical Query 

Use

Use this to view all of the Journal Entries whose account type is “statistical“.

This is used for statistical purposes only. It is most commonly used to record amounts that would have been 
paid to carried owners, or to the Minerals Management Service (MMS), when there is a ‘take-in-kind’ situation. 
The table is OIUH_RV_STSL).

Procedure

At the SAP Easy Access menu, choose LogisticsProduction and Revenue AccountingRevenue 
AccountingJournal EntryReporting Line Items (by Account Type).

The Statistical Subledger Query: Initial Screen is displayed.

Enter the relevant data and select Find Records .

Explanation of subsequent dialog boxes:

- Owner Tax dialog box– Shows the owner’s share of all taxes that apply to the current “statistical“ journal 
entry.

- Gross Tax dialog box– Shows the property level total tax amount for each applicable tax type for the current 
“statistical“ Journal entry.

- Other Deductions dialog– Shows the property level total deductions for each applicable deduction type for 
the current “statistical“ Journal entry.

15.8.7  Carrying Out an Income Line Item Table Query 

Use

Use this to view all of the Journal entries whose account type is “income“.

Income is an affiliate’s share of sales, which are recorded to accounts in the income category. The Income line 
item table is used by the RD accrual process, and used for the Income Analysis Report, and the Sales History. 
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Income is an affiliated owner’s share of sales, plus tax reimbursements; it is recorded to the accounts in the 
income category.

The share of revenue to an affiliated owner in the DOI. The net amount is recordedon the processing company 
on the affiliated owner’s behalf.

The income table is OIUH_RV_INSL.

Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Journal Entry → Reporting → Line Items (by Account Type) → Income.
The Income Subledger Query: Initial Screen is displayed.

2. On the Income Subledger Query: Initial Screen , enter the relevant data for your search and then select Find 
Records .

Explanation of subsequent dialog boxes:

Owner Tax Dialog box – shows the owner’s share of all taxes that apply to the current income journal entry.

Gross Tax dialog box – shows the property level total tax amount for each applicable tax type for the current 
income Journal entry.

15.8.8  Carrying Out an Expense Line Item Table Query 

Use

Use this to view all Journal Entries whose account type is “expense“.

The Expense table contains records that record an affiliated owner’s share of marketing costs or tax. The table 
name is OIUH_RV_EXSL).

Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Journal Entry → Reporting → Line items (by Account Type) → Expense.
The Expense Subledger Query: Initial Screen is displayed.

2. On the Expense Subledger Query: Initial Screen , enter the relevant data for your search and then select 
Find Records .

Explanation of subsequent dialog box:

Gross Tax dialog box - Shows the property level total tax amount for each applicable tax type for the current 
expense Journal entry.
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15.8.9  Carrying Out a Tax Payable Query 

Use

Use this to view all of the Journal entries whose account type is “tax payable“.

Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Journal Entry → Reporting → Line Items (by Account Type) → Tax Payable.
The Tax Payable Subledger Query: Initial Screen is displayed.

2. On the Tax Payable Subledger Query: Initial Screen, enter the relevant data, and either Well Completion or 
Measurement Point, and then select Find Records.

The system produces a list of records based on your search criteria.

Explanation of subsequent dialog box:

Gross Tax dialog box – shows the property level total tax amount for each applicable tax type for the current 
“tax payable“ Journal entry.

15.8.10  Carrying Out an Accounts Payable Query 

Use

Use this to view all of the Journal entries whose account type is “accounts payable“.

The Accounts Payable line item table contains records that represent external marketing charges when the 
service is not provided by the purchaser or an affiliated company. The table is OIUH_RV_APSL.

Procedure

At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue Accounting 
→ Journal Entry → Reporting → Line Items (by Account Type) → Accounts Payable.

The Accounts Payable Subledger Query screen is displayed.

1. Enter the relevant data for your search, and either well completion , or measurement point .
2. Select Find Records.
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15.8.11  Carrying out an Accounts Receivable Line Item Table 
Query 

Use

Use this to view all of the Journal entries whose account type is “accounts receivable“.

The Accounts Receivable line item table contains records of amounts to be received from a purchaser in 
connection with a sale when the purchaser on the contract is non-affiliated. The table is OIUH_RV_ARSL).

Procedure

1. At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Journal Entry → Reporting → Line Items (by Account Type) → Accounts Receivable.
The Accounts Receivable Subledger Query: Initial Screen is displayed.

2. On that screen, enter the relevant data for your search and then select Find Records .

15.9 JE Line Item Purge

Purpose

The JE Purge (line item purge) is a batch process that deletes entries from the line item tables and moves them 
to the Historical Archive Table. You select one of two possible purge processes:

● Annual Purge (see: Carrying Out a JE Annual Purge [page 464] )
● Offset Purge (see: Carrying Out an Offset Purge [page 466] ).

You "purge" line items to get rid of line items that are no longer needed. There are two types of purge: the offset 
purge and the annual purge. The offset purge is used to purge offsetting entries before a specified accounting 
date close, and the annual purge is used to purge all entries for a specific time frame.

The JE annual purge and JE offset purge can be scheduled to be run as background jobs using transaction 
SM36, or started via the SAP Easy Access menu. You can use transaction SM37 to monitor it.

The following graphic illustrates the archiving process within the purge process in JE :

462 C U S T O M E R
SAP Oil & Gas (PRA - Production and Revenue Accounting)

Journal Entry 



SAP Oil & Gas (PRA - Production and Revenue Accounting)
Journal Entry C U S T O M E R 463



You can set this up in Customizing under Industry Solution Oil & Gas (PRA) → Global Settings → Activate 
configurable edits .

15.9.1  Carrying Out a JE Annual Purge 

Use

Use this to carry out annual purges of JE line item tables.

The JE Purge is a batch process that deletes entries from the JE line item tables for the date range that you 
specify (everything earlier than the accounting period date), and either deletes them with no archiving, or 
moves them to the Historical Archive Table.

The purge selects entries from General Ledger and JE line item tables joined on the system number, and 
deletes all entries before the accounting period date that you enter.

You can select the annual purge, which in general is used to purge all line items in a JE line item table at the end 
of the year. The purpose is to clear out the line item tables so that new data can be entered into them.

However, the term “annual” does not mean that you can only run it once or at the end of the year. You can run 
this purge more than once per year, as you see fit.
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The purge process removes all the entries before the cut-off date that you enter (usually the end of the year, 
but it does not have to be). The cut-off date is the accounting period date.

The annual purge can be used for the following JE line item tables:

Accounts Payable

Expense

Income

Intercompany

Miscellaneous

Statistical

You can also decide what is to happen to the deleted entries. There are two options:

The deleted line item is deleted permanently, without being saved anywhere

The deleted line item is automatically saved to an archive table (the Historical Archive Table)

You define in Customizing which of those two options will pertain to your system. If you do not set it in 
Customizing, the first option will apply – that is, the line items will be deleted without being saved to a historical 
archive table. That is the default set-up. If you want the deleted entries to be archived, you have to set that in 
customizing.

Prerequisites

The only real prerequisite is that your JE line item tables have reached a point that you would like to clean them 
out by deleting line items.

Procedure

From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Revenue Accounting 
Journal Entry Utilities JE Annual Purge

The JE Annual Purge Process screen is displayed.

In the Accounting Period Cutoff Date field, enter the date that you would like to use as a cut-off. The system will 
use that date and delete all JE line items that were posted before that date.

To trigger the purge, select Execute .
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Result

The JE annual purge process is kicked off, and all JE line items before the accounting period cut-off date are 
deleted.

Example

For example, you could choose:

- As the accounting period: 01/01/2001,

- And delete all entries for the Accounts Payable line item table.

Here, the system would select all entries based on your search, and copies the entries into an archiving table (if 
you customized it that way). Then, the system deletes those same entries from the Accounts Payable line item 
table.

 

15.9.2  Carrying Out an Offset Purge 

Use

Use this to purge offset entries to line item tables in Journal Entry.

The offset purge clears (deletes) royalty/owner payable, accounts receivable, legal suspense, and taxes payable 
line items, where the line items have been offset with the appropriate clearing entries. JE line item table entries 
can be first copied to the relevant Historical Archive Table before they are then deleted from the line item table.

Parameters set in customizing (one per line item table) are used to determine whether data should be archived 
before it is deleted from the line item table.

At the end of the day when all entries are ‘posted’, the net open amount for a defined purge key should 
summarize to a zero balance and the detail contained in the zero balance has to be moved off the JE line item 
table to the Historical Archive Table (each line item table has its own historical archive table, and there is a 
General Ledger archive table). The purge key is a pre-defined combination of columns in GL and line item table.

JE offset purge can be run on demand for different line item tables and company codes.

Offset purge applies only to the following JE line item types:

● Accounts receivable
● Legal suspense
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● Owner payable
● Taxes payable

Procedure

1. From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Journal Entry → Utilities → JE Offset Purge .

The JE Offset Purge Process screen is displayed.

1. On that screen, there are several flags that you can set: accounts receivable , owner payable, legal 
suspense , and taxes payable . You can run the purge process by company code for one or more of those JE 
tables. Select your criteria for what you would like to purge.

2. To trigger the offset purge process for that criteria, select Execute .

15.10  Loading External Data into JE 

Use

Use this to load JE batches that originate outside of the PRA system into the PRA system.

The batch is in external file form. All entries in the input file will be assigned a single batch number and will take 
values for company code, accounting period, and batch type from the user input when the program is 
executed.

Prerequisites

The following requirements have to be met to load external data into JE:

● The batch types must be types: 04, 40 (“company batch load”), or 41 (“company batch load – non-
reversible”). Those batch types will be automatically selected and approved if no errors are detected.
An external file must be used
The external file should be created as a binary file and adhere to the layout defined in Include program 
ROIUH_JEBD0014.
The file has to reside on an application server and its complete name including path should be given as 
input.

Procedure

1. From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Revenue 
Accounting → Journal Entry → Utilities → Load JEINTF rec for Batch Type 40 & 41.
The Program ROIUH_LOAD_JEINTF – To Load JE Interface Batch Types 04, 40 & 41 screen is displayed.

2. Enter the Input file name (and other relevant data) in the fields.
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3. Select Execute .

Result

The batch number assigned by the PRA system, and whether the batch is balanced or not .
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16 Contracts and Pricing 

Purpose

The Contracts and Pricing application area in Production Revenue Accounting (PRA) supports the 
maintenance of contracts and related marketing costs, pricing terms, and prices for the sale of products 
including crude oil, condensate, and natural gas.

Contracts

Contracts are used by the Product Control, Contractual Allocation, and Valuation application areas.There are 
different contract types, and for each one there is a unique template that is used to enter contract data into the 
system.The contract contains header and item-level data, and the item-level data includes pricing at a 
measurement point or well completion level.

Pricing

Pricing functions capture the pricing data required to value oil and gas sales, and are also used to set up 
formulas, oil price postings, and gravity pricing adjustment tables.Pricing functions can be used for fixed as 
well as formula-based pricing.Key features of the pricing functions include:

● Complex formulas, including highest, average, and lowest multiple price indices or bulletins
● Surcharges and bonuses
● Equal Daily Quantity (EDQ) pricing
● COPAS or daily pricing
● Multiple currencies
● Multiple units of measure
● Pricing at various levels: contract material, contract/material/measurement point, or contract/material/

well completion
● Effective-dated pricing

Integration

Contracts and Pricing is integrated with the following application areas.

Table 109:

Integrated with Application Area : Description of Integration

Production Plant processing in Production requires a processing agree­
ment from Contracts & Pricing.

Contract Allocation Contractual Allocation (CA) references contract numbers 
and marketing representatives during processing.

SAP Oil & Gas (PRA - Production and Revenue Accounting)
Contracts and Pricing C U S T O M E R 469



Product Control Product Control uses marketing representatives specified in 
sales contracts.

Valuation Valuation requires a contract record in order to create a valu­
ation cross reference.Also, Valuation uses pricing master 
data to calculate the gross price for marketing charges.

16.1 Creating a Contract

Use

Contracts are used by the PRA Production, Product Control, Contractual Allocation and Valuation application 
areas. There are different contract types, and for each one there is a unique template that is used to enter 
contract data.

Prerequisites

A valid customer master record exists for the customer to be referenced in the contract.

Procedure

1. At the SAP Easy Access screen, choose Logistics  Production and Revenue Accounting  Contracts 
and Pricing  Contracts  Create Contract  .

2. The Create Contract: Initial Screen appears.
3. Enter the contract type and choose Enter .

4.
The contract type determines which fields in the transaction are required. To review a list of contract type 
descriptions, see Contract Types [page 471] .

5. If you do not want the system to assign a number automatically for the contract, enter an alphanumeric 
code for the contract in the Contract field.

6. At the General , Contamination , Dates , and/or Service tabs, enter data as required. At the Service tab, 
enter data as required for conditions related to transportation or services, such as separating a gas 
product.

7. Save the contract.
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16.2 Contract Types

Table 110:

Contract Type Description

Affiliate Gas Purchase Compliment to Gas Sales to Affiliate - Transported contract 
type.

Casinghead - Purchase Utilized for plants that will be allocated through plant net­
works. Utilized to indicate a purchase for the lease (well). 
Settlement is made to the lease and is offset to the plant.

Company Operated Gathering Agreement Utilized for company-operated gathering agreements.

Gas Purchase Utilized for wet gas purchase behind a plant.

Gas Sales Type of contract most commonly used for conventional gas 
sales. The transaction is processed through Revenue Distri­
bution.

Gas Sales To Affiliate - Transported "Settlement Contract" utilized by companies with sales to 
affiliates. It allows them to pass volumes and values between 
the Revenue and Marketing systems. It utilizes the netback 
price provided by the Marketing system.

Gas Sales to Affiliate -Non-Transported "Settlement Contract" utilized by companies with sales to 
affiliates. It allows them to pass volumes and values between 
the Revenue and Marketing systems. It utilizes the netback 
price provided by the Marketing system.

Gathering Agreement Utilized for outside-operated gathering systems and is avail­
able for Valuation reserve word processing.

Long-Term Off Lease Sales Utilized by marketing for off-lease sales.

Miscellaneous Gas Sales Utilized for sales to company facilities that will not be con­
tractually allocated (e.g., irrigation gas). May be used by 
Marketing, Revenue, or Plants.

NGL Purchase Utilized for products purchased for resale.

NGL Sales Utilized for NGL sales at the tailgate of the plant (cross refer­
ence at the gas plant measurement point) or for NGL sales 
at the well/lease (cross reference valuation point).

NGL TIK Utilized for TIK NGL sales contracts. Transactions are not be 
processed through Revenue Distribution.
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NGL TIK - Valued Utilized for TIK NGL sales contracts. Transactions are proc­
essed through Revenue Distribution in order to value mar­
keting costs.

Non-Interest Gas Sales Utilized for the gas sales of other working interest owners 
when the operating company is making settlement on their 
behalf.

Oil Buy/Sell Contract which includes both a purchase and a sales trans­
action. May be used in conjunction with the Oil/Condensate 
Lease Indirect Supply contract type for leases, or it may be 
used alone when no lease transactions are involved.

Oil Exchange Utilized for contracts where similar products are exchanged 
and no money changes hands except for an agreed-to differ-
ential.

Oil Futures - Purchase Includes purchase contracts from NYMERC Market. Proc­
essed in the same manner as the Oil Purchase contract type.

Oil Futures Sale Includes sales contracts from NYMERC Market. Processed 
in the same manner as the Oil Sale contract type.

Oil Purchase Utilized for the outright purchase of crude/condensate from 
lease and non-lease locations.

Oil Sale Utilized for the outright sale of crude/condensate from non-
lease locations.

Oil/Cond - TIK Utilized for owners who have TIK oil contracts. These trans­
actions are processed through Revenue Distribution.

Oil/Cond Lease Direct Supply Utilized for purchases when the operating company takes 
delivery of the crude oil at the lease location and retains 
ownership.

Oil/Cond Lease Indirect Supply Utilized for the purchase of crude oil when the operating 
company purchases at the lease and resells to a third party 
at the lease for transportation. Must be used with the Oil 
Buy/Sell contract type.

Oil/Cond Outright Sale Utilized when the operating company sells proprietary, 
and/or third-party, oil/condensate from the lease to a third 
party.

Other Owner Spot Sales/TIK Utilized for owners who have TIK spot sales contracts. These 
transactions are not processed through Revenue Distribu­
tion.
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Other Owner Spot Sales/TIK -

Valued

Utilized for other working interest owners TIK spot sales 
contracts when the other owner is responsible for marketing 
costs. These transactions are processed through Revenue 
Distribution in order to value the marketing costs.

Other Owner/TIK - Non-Valued Utilized for conventional TIK gas sales contracts entered into 
by other working interest owners in company-operated 
properties. These transactions are not processed through 
Revenue Distribution.

Other Owner/TIK - Valued Utilized for conventional TIK gas sales contracts entered into 
by other working interest owners in company-operated 
properties. These transactions are processed through Reve­
nue Distribution for the purpose of valuing marketing costs.

Percent Proceeds - Gas Sale Utilized for leases passing through non-interest or non-oper­
ated plants which do not go through the plant allocation. 
Also utilized for unprocessed gas sold at the lease where the 
operating company receives a percent of the proceeds.

Processing Agreement with TIK Rights Utilized for processing agreements when the lease has TIK 
rights on NGLs. Plant residue and NGLs to be marketed by 
the lease owners under related sales contracts.

Processing Agreement without TIK Rights Utilized for processing agreements when the lease does 
NOT have TIK rights on NGLs. Residue is marketed by the 
lease owners under related sales contracts. NGLs are mar­
keted by the plant under separate sales contracts.

PVR Sales Utilized by Marketing for PVR make-up gas from a straddle 
plant.

Residue Purchase Utilized by plants for residue purchases.

Selling under JOA Utilized when not selling under the operating company’s 
own contract.

Service Provided Utilized when service is provided. Similar to the Service Re­
ceived contract type.

Service Received Utilized when service is received. Terms used by revenue to 
deduct costs from the lease and create a payable to the con­
tract party on the service agreement.

Spot Purchase Generally utilized by the marketing group for third party gas 
purchases.

Spot Sales Utilized for gas spot sales by revenue, plants, and/or market­
ing.
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Storage Agreement Utilized to define cost terms for gas in storage. Accessed by 
the reserve words.

Straddle/3 rd Party Agreement Utilized for the agreement between the pipeline and the 
plant for third party processing.

Third Party Keep Whole Gas Purchase Utilized for wet gas purchase agreements at a plant.

Transfer Utilized by Marketing to transfer the Netback Price calcu­
lated at a market center during one pricing cycle over to the 
next pricing cycle as the Weighted Average Sales Price for 
the same market center. These transactions are never val­
ued or journalized.

16.3 Approving Contracts or Reviewing a List of Contracts

Use

Use this transaction to:

● retrieve a list of contracts and review the associated details
● approve contracts

Procedure

1. At the SAP Easy Access screen, choose Logistics  Production and Revenue Accounting  Contracts 
and Pricing  Contracts  List Contract  .

2. The Contract List Processing screen appears.
3. Enter data as required and choose Execute .
4. The Contract List Processing screen appears with a list of contracts that matches the criteria you entered 

on the first screen.
5. Review the details of the list.
6. To approve a contract, click a row to select the contract in the row, and then choose Approve .

16.4 Setting the Currency for Valuation Calculations 

Use

Use this transaction to make certain settings so that the system uses a condition type currency (for example, 
US$ which is for US dollars, 6 decimals) when processing volumes through Valuation, while the system uses 
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the company/contract currency (for example USD, which is for US dollars, 2 decimals) for document and 
reporting purposes.

By making the settings described in this procedure, the system uses the condition type currency for calculating 
the value before any rounding is done using the company/contract currency .

Procedure

Enter transaction code VOK0.

The Maintain Pricing screen appears.

Choose Condition type Condition types Definition

The Change View Conditions: Condition Types Overview screen appears.

Select the condition type to be maintained. Then choose Details .

The Change View Conditions: Condition Types Details screen appears.

The currency that corresponds to the condition type that you select is the currency that will be used for 
calculating the value. The systems then calculates the value using the currency of this condition type before 
using the company/contract currency (for example, USD) for document and reporting purposes.

In the Control data 2 section, verify that the Currency conv. and Qty conversion indicators are selected.

If they are not selected, select them as required and then choose Save .

 

 

16.5 Pricing Functions 

Use

Use the following procedures as required in order to enter data that is necessary for the system to calculate 
pricing.

Entering a Fixed Price Condition [page 476]

Entering Pricing for EDQ, COPAS, Metered Sales Oil, Natural Gas [page 476]

Entering Multiple Bulletins Pricing [page 478]
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16.5.1  Entering a Fixed Price Condition 

Procedure

From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Contracts and 
Pricing Contracts Pricing Terms Create Condition  .

The Create Condition Records screen appears.

Enter EP01 to enter fixed pricing data. Then choose Enter .

The Key Combination dialog box appears.

1. Select the level to which the condition record will apply (either measurement point or well completion, if 
applicable), and choose Enter .
The Create Fixed Price Condition (EP01): Fast Entry screen appears.

2. Enter data as required.

Note
○ In the Rate field, enter the price.
○ In the Unit field, enter the currency.
○ In the Valid on field, enter the date that the condition becomes effective.
○ In the Valid to field, enter the date through which the condition is effective.

3. Save your entries.

16.5.2  Entering Pricing for EDQ, COPAS, Metered Sales Oil, 
Natural Gas 

Prerequisites

For gas and oil formula-based conditions, pricing configuration is complete for the following:

The posting company in the Define Posting Co., Gravity ID, & Scale Definition and Default Codes Customizing 
node

Quotation data in the Define Quotation Data (Link to Downstream Functions) Customizing node

For oil formula-based conditions in which you specify values, pricing configuration must be complete for:

The gravity ID, the scale definition, and default codes at the Define Posting Co., Gravity ID, & Scale Definition 
and Default Codes Customizing node

Procedure

From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting Contracts and Pricing 
Contracts → Pricing Terms → Create Condition
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The Create Condition Records screen appears.

EnterEP00to enter a formula-based condition. Then choose Enter .

The Key Combination dialog box appears.

Select the level to which the condition record will apply (either measurement point or well completion, if 
applicable), and choose Enter .

When Valuation processes the pricing information, it attempts to retrieve a price first at the contract/well 
completion level, then at the contract/measurement point level, and finally at the contract level.

The Create Formula Price Condition (EP00): Fast Entry screen appears.

Enter data as required.

In the Valid on field, enter the date on which the condition becomes effective.

In the Valid to field, enter the date through which the condition is effective.

Select a material number and choose Details .

The Create Formula Price Condition: Details screen appears.

Enter the floor and ceiling gravity and/or rates. Then go back.

The Create Formula Price Condition (EP00): Fast Entry screen appears.

Choose Maintain formula .

The Conditions Create: Formula Terms screen appears.

By choosing Repository Proposal , you can select an existing formula and use it again.

Enter a formula description and complete the A v B rule field.

In the Industry Terms field, select an industry term. To verify and/or overwrite the industry term values, choose 
Calc Rules .

The Maintain Conditions Create calculation rules screen appears.

The industry term values that appear are maintained in Customizing under Industry Solution Oil & Gas 
(Production and Revenue Accounting) → Contracts and Pricing → Industry Terminology to Calculation Rule 
Mapping

In the A Term section of the screen, enter data as required.
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In the Quotation no. field, enter a quotation number, which represents a posted price on which you can base 
contracts. (After you choose a quotation number, the system completes the QtSrc and Typ fields.)

In the Rule field, enter a rule, which determines the use of the calculation factors in the Factor 1 and Fact 2 
fields, as well as any surcharge specified in the Surcharge field.

In the Fact 1 and Fact 2 fields, it is possible to enter negative values in order to calculate differentials. It is also 
possible to enter a negative value in the Surcharge field.

Save your entries.

16.5.3  Entering Multiple Bulletins Pricing 

Prerequisites

For gas and oil formula-based conditions, pricing configuration must be complete for:

The posting company at the Define Posting Co., Gravity ID, & Scale Definition and Default Codes Customizing 
node

Quotation data at the Define Quotation Data (Link to Downstream Functions) Customizing node

For oil formula-based conditions in which you specify values, pricing configuration must be complete for:

The gravity ID, the scale definition, and default codes at the Define Posting Co., Gravity ID, & Scale Definition 
and Default Codes Customizing node

Procedure

From the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting Contracts and 
Pricing Contracts → Pricing Terms → Create Condition

The Create Condition Records screen appears.

EnterEP00 to enter a formula-based condition. Then choose Enter .

The Key Combination dialog box appears.

Select the level to which the condition record will apply (either measurement point or well completion, if 
applicable), and choose Enter .

When Valuation processes the pricing information, the system attempts to retrieve a price first at the contract/
well completion level, then at the contract/measurement point level, and finally at the contract level.

The Create Formula Price Condition (EP00): Fast Entry screen appears.

Enter data as required. Then select a material number and choose Details .

The Create Formula Price Condition: Details screen appears.
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Enter the floor and ceiling gravity and/or rates. Then go back.

The Create Formula Price Condition (EP00): Fast Entry screen appears.

Choose Maintain formula .

The Conditions Create: Formula Terms screen appears.

By choosing Repository Proposal , you can select an existing formula and use it again.

Enter a formula description and complete the A v B rule field.

Enter the item number and quotation group. Then enter the quotations (which represent the bulletins) to be 
used.

Enter the item number and quotation group.

Then enter the quotations (which represent the bulletins) to be used.

Choose Accept and save your entries.

16.6 Execute a Pricing Report 

Use

Use this report to review conditions associated with a condition type or a range of condition types.

Procedure

1. At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting  Contracts and 
Pricing  Pricing Terms  Execute pricing report.
TheExecute Pricing Report screen appears.

2. Enter EP in thePricing Report field and chooseExecute .
ThePricing Report screen (2) appears.

3. Enter selection criteria for the report as required, such as the contract number(s) and the condition 
type(s).Then chooseExecute .
ThePricing Report screen (3) appears.

4. Review the details of the conditions records.
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16.7 Creating and Maintaining a CO2 Removal Fee Record 

Use

Use this transaction to create or maintain CO2 removal fees that are incurred when a gas plant has to remove 
CO2 from a gas product that is being processed through the plant. Normally, the originating property injects 
CO2 into the well in order to produce more products from the well, but since CO2 dilutes the product quality, it 
must then be removed from the gas.

In exchange for removing the CO2, the gas plant retains a certain amount of the resulting product based on the 
flat rate established in this transaction.

Procedure

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Contracts and Pricing 
→ Contracts → Other Terms → CO2 Removal Fee Processing

The CO2 Removal Fee Processing: Initial Screen appears.

Choose Create .

The Create CO2 Removal Fee Processing: Maintenance View screen appears.

Enter data as required, including rate per unit of measurement that determines the removal fee in the Rate per 
Unit field.

If applicable, enter the portion of the fee that is tax deductible in the % Fee Deduct field.

To base product volumes on a measurement point, enter the data as required for a measurement point.

If measurement points are not entered, product volumes are based on all volumes from the company / 
venture / division of interest.

Further, the measurement that you specify here identifies the measurement point against which the total fee 
for removing the product will be assessed and is tied to the property/DOI from which the product originated.

Save your entries.

Using a Reference to Create a CO2 Removal Fee Processing Record

To create a CO2 Removal Fee Processing record with reference to an existing record, at the CO2 Removal Fee 
Processing: Initial Screen , enter data as required. Then choose Execute .

If more than one record matches the data you entered, select one of the records from the list.

OR

If only one record matches the data you entered, the single record is displayed.

Choose Create to create a new record with the data from the record you selected.

Changing or Displaying a CO2 Removal Fee Processing Record
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To change or display a CO2 Removal Fee Processing record, at the CO2 Removal Fee Processing: Initial Screen , 
enter data as required. Then choose Execute

If more than one record matches the data you entered, select one of the records from the list.

OR

If only one record matches the data you entered, the single record is displayed.

Choose Change or Display to change or display the record as required.

 

 

16.8 Creating and Maintaining Contract Marketing Costs 

Use

Use this transaction to create and maintain marketing costs at the contract, contract / measurement point, or 
contract / well completion level. Marketing costs are the costs involved in taking a product to market.

This transaction can be used to capture marketing costs for multiple materials.

Prerequisites

The relevant contract includes the following required base contract information:

venture

an approved division of interest

either a well and well completion or a measurement point, if applicable

Procedure

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Contracts and Pricing 
→ Contracts → Other Terms → Contract Marketing Costs

The Contract Marketing Costs: Initial Screen appears.

Choose Create .

The Create Contract Marketing Costs: Maintenance View screen appears.

Choose one of the following.

Options for Entering Marketing Costs
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Table 111:

Action Follow on function

To enter data for a contract Choose Contract

To enter data for a contract and well completion combina­
tion

Choose Contract / WC

To enter data for a contract and measurement point combi­
nation

Choose Contract / MP

To enter data for a contract, well completion, and measure­
ment point combination

Choose Contract / WC /MP

 

Enter the contract number and the material number.

To establish a deduction or reimbursement amount, complete the following:

select either deduction or reimbursement for the Deduction Reim field

enter an amount per measurement unit in the D/R Rt and the corresponding basis for measurement in the 
Basis field.

The rate is a rate per volume. It specifies the amount per measurement unit that the system multiplies by the 
volume in order to obtain either the deduction or reimbursement amount in Valuation.

The rate must be used in a marketing reserve word before it can be used in Valuation.

a deduction or reimbursement percentage in the D/R Pct field

The percentage specifies the actual deduction or reimbursement amount that the system will use.

The percentage must be used in a marketing reserve word before it can be used in Valuation.

a fixed amount in the D/R Fixed Amt field

Enter other data as required, including the venture and division of interest data representing the plant that will 
be credited with the associated marketing cost.

Save your entries.
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Result

After the required marketing cost reserve word(s) are entered in the valuation formula(s), the Valuation batch 
process performs the actual deduction or reimbursement in order to carry out the marketing cost calculation.

 

 

16.9 Creating and Maintaining Tax and Royalty 
Reimbursement 

Use

Use this transaction to create and maintain both contract tax reimbursement terms and exceptions related to 
the settlement of certain government royalties and taxes between the seller and the purchaser.

Prerequisites

The relevant contract includes the required base contract information.

Procedure

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Contracts and 
Pricing Contracts Other Terms Tax and Royalty Reimbursement  .

● The Tax and Royalty: Selection Screen appears.

Choose Create .

● The Tax and Royalty: Create screen appears.

Choose one of the following.

Options for Entering Tax and Royalty Reimbursements

Table 112:

Action Follow-on function

To enter data for a contract Choose Contract
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Action Follow-on function

To enter data for a contract and well completion combina­
tion

Choose Contract / WC

To enter data for a contract and measurement point combi­
nation

Choose Contract / MP

To enter data for a contract, well completion, and measure­
ment point combination

Choose Contract / WC /MP

Enter the following data as required.

● In the Major Product field, enter the product code.
● In the Effective from field, enter the date on which the data becomes effective.
● In the Excess ryl prc field, enter the percentage (based on price per measurement unit) that the purchaser 

reimburses the seller for any excess royalty that the seller is obligated to pay.
● If the contract is to be viewed for excess royalty provisions, choose Excess Royalty .
● In the Country field, enter the country code.
● In the Primary geo loc , enter the state.
● Enter the name / type of severance tax.
● In the Total Reimb Cd field, specify whether the contract reimbursement code is total or incremental.
● In the Tax Rate Dt field, specify when a new tax becomes valid in relation to a contract.
● In the Tax % field, specify the percentage of the tax based to be reimbursed by the purchaser.It is the value 

that Valuation uses to calculate the reimbursement.(This applies when the tax is based on a percentage of 
the price per measurement unit.)

● Save your entries.

Result

The tax and royalty reimbursement data is available for the Valuation batch process, which performs the tax 
and royalty reimbursements.

Using a Reference to Create a Tax and Royalty Reimbursement Record

To create a tax and royalty reimbursement record, at the Tax and Royalty: Selection Screen , enter data as 
required.Then choose Execute .

If more than one record matches the data you entered, select one of the records from the list.

OR

If only one record matches the data you entered, the single record is displayed.

Choose Create to create a new record with the data from the record you selected.

Changing or Displaying a Tax and Royalty Reimbursement Record

To change or display a tax and royalty reimbursement record, at the Tax and Royalty: Selection Screen , enter 
data as required.Then choose Execute .
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If more than one record matches the data you entered, select one of the records from the list.

OR

If only one record matches the data you entered, the single record is displayed.

Choose Change or Display to change or display the record as required.

16.10  Creating Formulas 

Use

Use this transaction to create formulas to be used when creating pricing conditions.

Procedure

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Contracts and 
Pricing Pricing Formula Repository Create  .

The Create Formula screen appears.

Enter an ID for the formula, and other data as required.Then choose Enter .

The Formula Create: Formula Terms screen appears.

Enter a description of the formula in the Formula Description field.Then enter data as required in the A B rule 
field, which determines how the A and B terms are individually used or combined to calculate the overall 
formula value.

Complete the A Term and B Term sections of the screen, which contain the formula terms that are used 
according to the A B rule.

Use the following fields to define the A and B terms.

Note
To copy details from an existing formula, choose Repository proposal .

Table 113:

Field Purpose

Item number To copy data for an existing line item to a new line, replace an 
existing item number with a new number.Data for the exist­
ing line item is then copied to the line with the new num­
ber.In this process, data for the existing line item remains 
unchanged.
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Field Purpose

Quotation group Used to group quotations for complex pricing schemes, in­
cluding average, highest, or lowest.

QtSrc Determines the source of the quotation, such as Platt's or 
Reuters.

Typ (quotation type) Classifies the type of quotation used, such as high, low, or 
average. For example, if a market data provider externally 
calculates the EDQ price for oil on a specific day, the quota­
tion type is EDQ.

Quotation no. (quotation number) Identifies the quotation number.

Quotation description (Text) Description of the quotation.

Rule (item calculation rule) This field controls how the Factor 1, Fact2, Surcharge, and 
quotation value are combined to calculate the value of that 
line.

Factor 1 (Calculation factor 1) The value entered in this field is used together with the value 
in the Fact2 field to calculate the line item value according to 
the rule you have defined.

Fact 2 (Calculation factor 2) The value entered in this field is used together with the value 
in the Fact1 field to calculate the line item value according to 
the rule you have defined.

Surcharge Applied surcharge/discount

Curr. (Surcharge currency) Currency of the surcharge, which may be different than the 
currency of the price quotations.

PerUn (Surcharge per unit) Measurement unit which is used for the surcharge. For ex­
ample, a surcharge can be applied to every 10 US Gallons.

UoM (Surcharge unit of measure) Unit of measure used for the surcharge. For example, Kg, 
BBL.

ExTy (Exchange rate type) It is possible to define various exchange rate types, which 
determines what kind of exchange rate is used.

Continue entering terms as needed for each line item.

Save the formula terms.
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16.11  Maintaining Price Postings 

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Contracts and Pricing 
→ Pricing → Prices → Maintain

The Determine Work Area: Entry screen appears.

Enter data as required to select one quotation. Then choose Enter .

The Change View Price Posting Maintenance: Overview screen appears.

To add a new entry, choose New entries .

The New Entries: Overview of Added Entries screen appears.

Enter the quote date, bulletin number, and price.

The gravity scale does not need to be entered, because it defaults based on the pricing configuration.

Save the price posting.

 

 

16.12  Maintaining Gravity Scales 

Use

Use this transaction to add gravity scales for crude oil postings.

Procedure

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Contracts and Pricing 
→ Pricing → Gravity Scales → Maintain Gravity Scales

The Change View Gravity scales: Overview screen appears.

Choose New entries and enter the following data as required.

In the Src. field, enter the posting company.

In the Grv field, enter the gravity scale code, which is the posting company ID of the gravity scale.

In the From column, enter the effective from date. In the To column, enter the effective to date and in the Base 
column enter the base gravity. Then enter the density type.

Save the gravity scale.
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Select the gravity scale and choose Gravity scale items . Then choose New entries and enter the following data.

See the example below for an overview illustrating how multiple gravity scale values could be entered.

In the Type column, indicate whether the gravity scale value is above or below a certain amount.

To indicate a range of values, enter from in the Type field and then complete the From and To fields.

If applicable, enter a flat rate in the Flat Rate column.

In the Incr. Rate column, enter the dollar incremental rate.

In the Grv. Incr. column, enter the gravity increment.

Save the entries.

Review the Change View Gravity scales: Overview screen to determine the status of the gravity scale.

A green light indicates a complete gravity scale record.

Example

Sample Gravity Scale Values at the Change View Gravity scale items: Overview screen

Table 114:

sclpos Type From To Flat Rate Incr. Rate Curr. Per. UoM Grv. incr.

1 above 45  0.000 0.050 US3 1 BB6 0.1

2 from 40 45   US3 1 BB6  

3 below  40 0.000 0.150- US3 1 BB6 0.1
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17 Regulatory Reporting 

Purpose

The Regulatory Reporting application area is used to produce volumetric reports based on production 
data.These reports are used to meet the requirements of many state and federal agencies.

Some reporting features are listed below.

Trial Reports

If you need to run a trial report, you can run a report as often as required in order to extract data from the 
system again. You can execute both current and amended reports on a trial basis.

Prior Period Adjustments

The system includes any relevant prior period adjustments (PPAs) when calculating amounts that are due. You 
can produce an amended report when PPAs result from (a) volumes or values that were reported incorrectly, or 
(b) incorrect master data assignments, such as when a property is assigned to the wrong lease.

The List Viewer

After processing a report, the system generates reports in the form of flat files in the List Viewer as well as 
journal entries.

You can print some reports, or flat files, directly from the List Viewer. For other reports you must download data 
from the List Viewer as a .txt file and then merge the data with the appropriate Microsoft Word template to 
create the report.

See also:

Downloading and Printing Oil & Gas Reports in MS-Word

The [page 489] Production Regulatory Reporting Framework

17.1 The Production Regulatory Reporting Framework

Purpose

The Production Regulatory Reporting Framework tool is the central reporting tool for reporting production 
volume data to U.S. federal and state agencies.

Federal and state agencies collect the reports for statistical, tax, regulatory, and environmental reasons. 
Production regulatory reporting is based on well completions volumes, or on measurement point volumes.

You can do the following with the Framework:

Create the required master data for reporting – This entails creating a Regulatory ID for each well completion 
(or measurement point) that you are reporting on (see Creating Master Data for Regulatory Reporting [page 
493] ).
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Generate production regulatory reporting – this involves pulling the relevant production volumes together from 
PRA-Production (see Generating Reporting Data for Regulatory Reporting [page 495] ).

View report history – You can view reports and report data that have already been created (see Displaying 
Reporting Data [page 497] ).

View changed well completion records – View records that were changed as a result of a prior period 
adjustment (see Displaying Reporting Data [page 497] ).

A distinction should be made between generating the reports in the ERP system and actually submitting the 
reports to the relevant federal or state agency.

● "Generating the report" in the SAP system means: pulling together all the relevant production reporting 
data within the SAP system, and creating reports that are then stored on the database as production 
records, which can then be used to submit the physical (or electronic) report to the state agency.

● "Submitting the report" means, you use the ERP data and send an electronic or paper report to the agency, 
based on the ERP report data that you have generated.

Note
SAP provides software for generating the report, but report submission occurs outside the SAP system. The 
actual filing of the report can be done either electronically, or by paper, depending on the specific state 
agency requirement. Most states now expect filing to be done electronically, however.

Most entity data that you need (wells, well completions) will already exist in PRA-Production.

State reporting:

Table 115:

Report name Documentation link

TexasH-10 Texas Form H-10 [page 502] , Creating Master Data for the 
Texas H-10 Report [page 505] , Generating Reports for Texas 
H-10 Reporting [page 507]

ArkansasForm 7 Using The Arkansas Form 7 Report [page 511]

Oklahoma Form 1004 Using Oklahoma Form 1004 [page 524]

Wyoming

North Dakota Reports Using the North Dakota Reports [page 520]

Louisiana OPG/R5D and WR1 Reports Using the Louisiana OGP/R5D Report (New) [page 517]

Using the Louisiana WR1 Report [page 518]

California Report OG110 Using California Report OG110 [page 514]
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Federal reporting:

Note
MMS reporting (Minerals Management Service): For a complete description of MMS reporting and all the 
requirements associated with it, please refer to the MMS Production Reporting Handbook(an MMS 
publication).

The MMS also has extensive information on its web site that you can access for more information on filing 
MMS reports.

- Wells previously reported on MMS 3160 are now on the OGOR reports. On the master data records, there is 
now a well / MMS operator number assignment, a well / (agency or MMS) lease assignment, a disposition / 
metering point assignment, and a volume type and product to disposition code or adjustment code 
assignment.

Federal reports that you can run with the Framework:

MMS-PASR (Production Allocation Schedule Report) – for federal offshore production regulatory reporting.

Using the MMS-PASR Report [page 526]

Prerequisites

You will first have to make the relevant customizing settings in the IMG for production regulatory reporting.

You can make those settings in customizing under: SAP Reference IMG   Industry Solution Oil & Gas (PRA)
   Production Tax and Regulatory Reporting   Regulatory / Production Reporting . There are four IMG 

activities, which are used to do the following:

● Set up which regulatory agencies and reports will apply
● Set up which customizable fields you want to use,and what values those fields will have on the Report 

master data set-up screen, and the attributes of those fields.
● The reporting levelthat you are going to use (company code, or company code plus organizational levels)
● The output options– how you want the report data to be output.

For a complete description of how to customize this area, please refer to the IMG documentation for each IMG 
activity listed above.

17.1.1  Maintaining Operator and Contact Information 

Use

Use this to create operator and contact master data, which is required for production regulatory reporting.

Before you can submit production regulatory reports to state agencies (or federal agencies), you will have to 
first maintain the operator and contact information. This master record is set up per report, state, and 
reporting unit of your company. You create one record per agency and report, and the record identifies the 
relevant operator of the lease, and internal contact person in your company, who will serve as a contact with 
respect to the state agency.
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Procedure

1. From the SAP Easy Access menu, choose Logistics à Production and Revenue Accounting à Production, Tax 
and Royalty Reporting à Production Regulatory Reporting à New Regulatory Reporting à Maintain Operator 
and Contact Information

The Display View “Regulatory Reporting Operator and Contact Xref”: Details screen is displayed.

On that screen, select change/display , and then New Entries . In the Rep.Agency field, enter the relevant 
agency that you will be reporting to.

In the RegReport field, enter the relevant report that you will be submitting (the report and state for which you 
are creating the operator and contact information).

In the Company (ORG1) field and Reg.Level fields (2,3,4), enter the reporting level that is relevant for the 
reporting operator and contact.

Note that the relevant reporting level will already have been set up for your company in customizing (in the IMG 
under: Industry Solution Oil & Gas (PRA) à Global Settings à Maintain Organizational Levels ). For example, if, in 
customizing, you have defined that reporting will be at org.level 3, on the operator and contact screen, you 
would enter the relevant company code, the relevant org.level 2 number, and the relevant org.level 3 number.

In the Regulatory Reporting Operator and Contact Xref screen area, you enter the relevant operator and contact 
information for the specific report:

Table 116:

Operator Code Enter the code that the agency sent you, which represents 
your organization; the organization that is submitting the re­
port. It is the code that the agency uses to identify your 
company or organizational unit.

Operator Name Enter the name of your company.

Customer Here, you enter a “customer” number, which will represent 
the internal person in your company, who will be responsible 
for the report. This person will serve as the contact for the 
state agency, for reporting issues. The internal contact is re­
ferred to as a “customer” to reflect the term that oil and gas 
companies use.

Save your record.

Result

The operator and contact are now saved as master data in the system for the specific report and agency that 
you chose.
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17.1.2  Creating Master Data for Regulatory Reporting 

Use

Use this to create the required master data for Production Regulatory Reporting.

The first step in generating the production regulatory reports is to create the relevant master data. Master data 
creation is used to do two things:

- Set up the relevant Regulatory IDs for reporting

- Linking SAP Production entity IDs with state agency IDs

The reason that this is necessary is that the state agency will often have a different ID for production entities 
(well completions and measurement points) than the ID used in your SAP system. You will thus need to create 
IDs that you can then send to the state agency, and/or link SAP IDs with state agency IDs, so that the agency 
IDs can be identified in the SAP system (cross-reference is made and saved in tables in SAP). This maps the 
SAP ID to the state agency ID, for identification purposes.

On the Report Master Data Set-Up screen within the Production Regulatory Reporting Framework (see: The 
Production Regulatory Reporting Framework [page 489] ), the Data and WC Reg. ID screen tabs are used to 
create master data.

Table 117:

Data screen tab This is the “value list setup screen”. This screen tab is used 
to set up the values for the drop-down list boxes for specific 
fields on the WC Reg.ID screen tab.

WC Reg. ID screen tab This screen tab is used to create a Regulatory ID for each 
SAP Production entity that you will be reporting on.

Procedure

1. From the SAP Easy Access Menu, choose Logistics → Production and Revenue Accounting → Production, Tax 
and Royalty Reporting → Production Regulatory Reporting → New Regulatory Reporting → Master Setup and 
Report Submission .

The Report Master Data Setup for <Report> - Select screen is displayed.

1. In the Rep.Agency field at the top of the screen, enter the relevant regulatory reporting agency (the agency 
that you will be reporting to) from the drop-down list.

1. In the RegReport field, enter the relevant report.

The regulatory report and state that you choose here will dynamically determine which screen tabs appear on 
this screen, and which fields will appear on those screen tabs.

1. Select Create .

1. Select the Data screen tab. Entries that you make on this screen tab become the fixed values in the drop 
down list boxes for the corresponding fields on the WC Reg. ID screen tab. For example, if you choose lease 
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number for the Field Name field, the values that you enter will then appear in the drop-down list boxes of 
the lease field on the WC Reg. ID screen tab as fixed values that can then be chosen during master data 
creation.

On the Data screen tab, you would – as an example - select Lease Number in the field name field, then choose 
Display / Change , add a Value and a Description in the columns, and Save . That record would then appear in 
the WC Reg. ID screen tab in the list box in the Lease Number field. This screen tab is also used to enter state-
assigned values for each field in the Field Name field. The Data screen tab can also supply the values for the 
fields on the PRA – Agency Xref screen tab.

1. Select the WC Reg. ID screen tab.

1. Now enter the relevant master data on the WC Reg. ID screen tab. This screen tab is used to create the 
regulatory IDs for each well completion that you are reporting to the state. For example, if you are going to 
be reporting on well completions, you will have to create a WC Reg. ID for each well completion that you are 
going to be reporting on. You would thus enter the well completion, the reporting month, and any other 
reporting master data required by the specific state agency.

1. Choose Save .

There are several screen tabs that appear on the Report Master Data Set-Up screen, depending on the agency 
and report that you choose. In addition to saving data on the Data and WC Reg.ID screen tabs, it might also be 
necessary to enter data within the following screen tabs:

Table 118:

BAs Business Associates screen tab. This screen tab takes you to 
the Reg Reporting BA Maintenance: screen. You enter the re­
port type and select Execute , and the Display Reg. Reporting 
BA Maintenance: Application Maintenance screen is dis­
played. It shows the link between BAs and agency (MMS) 
leases.
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MP XRef This screen tab is used to link an SAP-assigned measure­
ment point ID to the ID used by the state agency.

The MP Xref is used if you are processing OGOR B or OGOR 
C (not OGOR A). It is also used in conjunction with the MMS-
PASR and New Mexico reports.

On this screen tab, you enter the relevant well completion. 
The system displays all the measurement points linked with 
it. You can assign measurement point numbers.

This screen tab is displayed for those reports in which the 
MP cross reference flag is set in Customizing. The measure­
ment point cross reference can be maintained for measure­
ment points, which are found based on the following condi­
tions:

● The agency / report name / major product code / vol­
ume type / product code combinations defined in the 
cross reference setting.

● The measurement points which have measurement 
point allocation profiles defined for the combinations of 
major product code / volume type / product code as 
described above, and which are linked to the selected 
well completion at the selected effective date.

PRA Agency Xref On this screen tab, you can create a link between your SAP-
assigned ID and the agency-assigned ID for specific Produc­
tion entities (such as transporter ID).

17.1.3  Generating Reporting Data for Regulatory Reporting 

Use

After you are finished setting up your master data for production regulatory reporting (see Creating Master 
Data for Regulatory Reporting [page 493] ), you can generate the reports in the ERP system.

On the Report Master Data Set-Up screen, within the Monthly Processing screen tab, you process all the wells 
that you previously created master data for on the WC Reg. ID screen tab. You can report on either a current or 
amended (changed) basis.

There are three screen tabs within the Monthly Processing screen tab:

Table 119:

Submit Reports You use this screen tab to generate the reports. You enter 
the organizational data, month and year, and current or 
amended status.
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Reporting History You can use this screen tab to view report data that has al­
ready been created.

Changed Well Completions You can use this screen tab to view/maintain changes to well 
completion records based on prior period notifications 
(PPNs). You can also use this screen to exclude specific set 
of well completions from amended (or replacement) reports.

Reporting format options

The reports are generally based on monthly reporting of volumes. You can run a current or amended report and 
send it to the relevant agency electronically using a CSV file (a comma-separated output file) or an ASCII file. 
You can only send one finalized report per month to the agency, but reports can be regenerated in the system 
as many times as you need until they are finalized. You can only carry out one final run per report period 
(month). Finalization of reports after the fact can be carried out, for example, report results can be checked 
and those results can be finalized. The CSV output file or ASCII file can be created in a separate step. The 
generated data is stored as a report in the ERP system in the database.

Replacement reports - If you change data and reprocess it, the report is then viewed as a Replacement Report . 
You can send as many replacement reports as necessary. For any particular reporting month, you can generate 
multiple versions of amended reports. But a new version of amended report can only be created after the 
previous version is finalized.

Prerequisites

The relevant master data for the production entities that you will be reporting on has to have already been 
created.

Procedure

1. From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Production, 
Tax and Royalty Reporting Production Regulatory Reporting New Regulatory Reporting Master Setup 
and Report Submission  .The Master Data Set-Up screen is displayed.On that screen, select the Monthly 
Processing screen tab.

2. From Monthly Processing , select Submit Reports .
3. Enter the relevant data (company, date range, etc.).
4. Choose Select (the Execute icon).
5. In the ALV area at the bottom of the screen, the system provides a list of records that correspond to your 

search criteria. This gives you options on what to run.
6. Select one of the records and then select Create . That triggers the batch job in the system.

For each record that is displayed in the ALV screen area, there are icons, which are used for the following:
○ View Report icon - To view the report that was submitted, select this icon. The Choose Report Type 

dialog box is then displayed. This dialog box gives you two options on how you would like the report 
data to be output. If you would like to create a paper copy of the report, select Hardcopy (Smartform ) 
and then select Continue . If you would like to have the report in the agency format, select File and then 
select Continue .
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○ Finalize Report icon - To finalize the report (indicate to the system that the report run is final), select 
the FinalizeReport icon. If you have not yet finalized the report, you can run the report again, and you 
can finalize it, after which you cannot then rerun it. However, you can re-run a replacement.

○ Regenerate Report – You can use this to regenerate – rerun – the report. You can regenerate reports 
as many times as you need to, until they are finalized.

○ Replacement Report – Select this to create replacement reports or amended reports.
○ Logs – Select this icon if you would like to view the error log for the job. On the dialog box that is then 

displayed, you can choose either Report Generation or Report Finalization . You can view the log to see 
exactly at what step the report generation failed.

○ Cancel processing – You can reset the status to Failed . You can do that when the job that you would 
like to cancel has a status of Finalization Running , Generation Running , or Scheduled/Rescheduled . If 
the job is scheduled only, this deletes it; if the job is already running for any reason, selecting this 
resets the status to Failed .

17.1.4  Displaying Reporting Data 
Use

You can query records of what you reported for a specific month for a specific reporting agency within the 
Production Regulatory Reporting framework.

For example, you can see what was reported to a specific state agency for March, 2001 for company code 101.

Procedure

1. From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Production, Tax and 
Royalty Reporting Production Regulatory Reporting New Regulatory Reporting Master Setup and Report 
Submission .The Report Master Data Setup for <Report> - Selectscreen is displayed.

2. Select the Monthly Processing tab, and then choose the Reporting Historyscreen tab.
3. On the Reporting History screen tab, enter the relevant data for your search: the company, the organization 

levels, the relevant report type, the run status (finalized report, etc.), and the production or reporting 
month. The Sub.Repor " is the reg.report that you would like to query.

Note
Usually, the production month and the reporting month are the same. However, for an amended report, the 
production month is not always the same as the reporting month, because amended reports are reports 
that are sent in after the report is submitted.

1. Choose Select (the Execute button). When you select Execute ( Select ), the screen displays two ALV list 
screen areas at the bottom of the screen. The top ALV area is for the header data for the records that you 
queried; the bottom ALV is for the detail data.

2. You can now select Print Report . That allows you to view a copy of the report that will be submitted on 
paper to the regulatory agency, with all the relevant data from your search added to it. You can choose Print 
Preview if you just want to view it, or you can print immediately.

Viewing Changed Well Completions

If you have already sent a regulatory report to an agency, it can occur that the relevant volumes change due to 
prior period adjustments (PPAs) and reallocated volumes, after the report was submitted to the agency. If that 
happens, you then have to re-report using an amended report.
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You can use the Changed Well Completions screen tab on the Monthly Processing tab to view a list of well 
completions that have been reported, and create or delete entries from the list of well completions that have to 
be re-reported.

1. On the Changed Well Completions screen tab, enter the Production month and year, and the company code 
and org. level.

2. Choose Select (the Execute icon).

In the Reallocated Well Completions screen area at the bottom of the screen (ALV), the system displays all the 
records that match your search criteria. The ALV displays a worklist of amended reports, showing the wells that 
changed since the last report finalization, and those well completions that will be re-reported and deleted in the 
next amended report run.

You can also create records from the Changed Well Completions screen tab. To do that:

1. Select Create .
2. Enter the well completion and production month and year.
3. Choose Save .

The record that you created will now appear in the ALV screen area at the bottom of the screen.

You can also delete records from the ALV list of queried records on the Changed Well Completions tab. To do 
that, from the ALV, select a record and then select Delete Line .

To exclude records from amended report

You can exclude particular set of records from next generation of amended report.From the Re-allocated Well 
Completion Screen :

1. Choose a particular row or multiple rows and select Exclude . A pop up requesting you to confirm the 
exclusion appears.

2. Choose Yes .

An X mark appears in the ALV column Exclude RWC. Related well completions belonging to the same lease (like 
for MMS PASR reports) or pool code (like NM C115) are also excluded.

Excluded records do not appear in the amended report.

When amended report is finalized, all re-allocated well completion records are deleted except for the well 
completions that were explicitly marked as excluded (by choosing X in the Exclude RWC ).

To include records in amended report

By default all re-allocated well completions appearing in the ALV grid are included in the next amended report 
generation except for records with X mark. These excluded records can again be included in the amended 
report. From the Re-allocated Well Completion Screen :

1. Select a particular row or multiple rows and select Include .A pop up requesting you to confirm the 
inclusion appears.

2. Choose Yes .

498 C U S T O M E R
SAP Oil & Gas (PRA - Production and Revenue Accounting)

Regulatory Reporting 



3. All selected records and related re-allocated well completion (like under the same lease or pool code) are 
included and the Exclude RWC column is blank for these re-allocated well completions.

The Regulatory Reporting Monthly Exception Report

An Exception Report exists in the system. You can use it to view well completions that are not assigned to a 
state or federal Regulatory ID. For more information on the Exception Report, see Using the Reg.Reporting 
Monthly Exception Report [page 499] .

17.1.5  Using the Reg. Reporting Monthly Exception Report 

Use

Use this to run monthly exception reports for Production Regulatory Reporting.

The Exception Report displays all well completions that are not assigned to a state or federal regulatory ID, 
based on the selection criteria that you choose. This allows you to identify and reprocess those well 
completions, if you want. You can create regulatory IDs for them as master data using the Production 
Regulatory Reporting ‘framework’ (see Creating Master Data for Regulatory Reporting [page 493] ).

The data that the system retrieves from the database is based on the existence of a well completion dated 
record for a given month and year. The system retrieves data from the well, well completion, and well 
completion dated records. All those records that do not have a regulatory ID will be listed.

Procedure

At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production, Tax and 
Royalty Reporting → Production Regulatory Reporting → New Regulatory Reporting → Master Setup and Report 
Submission .

The Report Master Data Setup screen is displayed.

Choose Goto → Exception Report .

The Regulatory Reporting – Monthly Exception Report screen is displayed.

If you are already starting from the Production Regulatory Reporting Framework screen ( Report Master Data 
Setup screen), choose Goto → Exception Report .

● On the Regulatory Reporting Monthly Exception Report screen, enter the relevant search criteria that you 
would like to use.

Field explanation :

Table 120:

Country key The country in which the well is located, as defined in the 
well completion records.
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Primary geographic location The state in which the well is located, as defined in the well 
completion records.

MMS flag If you set this flag, the report, when run, will search for fed­
eral (MMS) Reg.IDs. If it is not set, the search will look for 
state Reg. IDs.

Company The company code.

Organizational levels (1, 2, 3, 4) These organizational levels are subdivisions of a typical up­
stream oil company. They could be set up for example as: 1 = 
Company, 2 = Regional level entity, 3 = Division-level entity, 
4 = District-level entity.

Producing method The type of producing method at the well. For example, gas 
lift, hydraulic pump.

Well class The type of well. For example, air injection, gas well, oil well, 
water disposal, water injection.

Status The current status of the well: producing, shut-in, injecting.

MMS ownership flag Indicates whether the well is on state, federal, or Indian land.

Company operated Indicates whether the well is company-operated, or third-
party operated. Usually, this is set, as most Reg.IDs are set 
up for company-owned wells.

● Enter your search criteria and then select Execute .

Result

The Regulatory Reporting – Monthly Exception Report ALV screen is now displayed, which lists the well 
completions not assigned a regulatory ID.

17.1.6  Using the Regulatory Reporting Monthly Adjustment 
Report 

Use

The PRA Regulatory reporting framework provides a mechanism to edit the Minerals Management services 
reports ( Oil and Gas Operations Report (OGOR) A, B, C, and Production Allocation Schedule Report (PASR)) 
and store the reports that have been adjusted according to the Federal Agency requirements.
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Prerequisites

You must have done the following:

● To enable Production Regulatory Reporting Enhancements:

○ In Customizing, choose Industry Solution Oil & Gas (PRA) Global Settings Activate Configurable 
Edits

○ Execute
○ Choose Edit#30 - MMS Override Groups and Edits

● Generated Minerals Management Service ( MMS), OGOR and PASR reports using the Production 
Regulatory reporting framework.

● Completed the report generation successfully with the status-12 ( Report Generation Completed ).

Activities

● To go to the Adjust MMS Reports , from the SAP Easy Access menu, choose Logistics Production and 
Revenue Accounting Production  , Tax and Royalty Reporting Production Regulatory Reporting
New Regulatory Reporting Adjust MMS Reports  .

● The adjustment screen is displayed which is split into three sections:
○ Filter Criteria – Selection criteria
○ Header Information
○ Detail Information

● Choose the relevant MMS report from the options OGOR A, B, C or PASR.
● Enter the company code, reporting month and year (MMYYYY), Amended/Current ( A/C ) indicator and 

other relevant data for your search for OGOR A, B and C.
● Enter the company code, reporting month and year (MMYYYY), Amended/Current ( A/C ) indicator, Facility 

Number , Output Facility and Sales Facility for PASR.
● Choose Execute ( Select ).

In the ALV grid the system displays the H eader information in the top ALV; in the bottom ALV, it displays 
the Item ( Detail ) information on double clicking on any row of the Header information.
On the screen, the application toolbar also provides the following buttons:
○ Execute – Select
○ Log – Any errors while processing would be recorded in this file.
○ Check ABC Relationships – This button would provide a quick check on the comparison of the A/B/C 

report volumes and check if they are fine. If not then the log file reports the error.
○ Edit – The option to modify only the records that are relevant for modification in the header and detail 

information for each of the reports.
● Select the Edit button to modify the report and only the relevant columns in the ALV grid detail information 

are ready for modification.
● Save the changes that you have modified by choosing Save . On change of the existing data in the status of 

the regulatory report generated is changed to a new status Report Adjusted ; Status code – 25 .
New version of the detail records are created each time a Save is done with the current user Id and 
timestamp.

● Adjust the Current/Amended reports before finalization.
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See Also

For more information, see:

● Using the MMS-OGOR Report [page 530]
● Using the MMS-PASR Report [page 526]

17.2 Reporting with the Regulatory Reporting Framework 

Purpose

The Production Regulatory Reporting Framework is the central tool used for reporting production volumes to 
U.S. federal and state agencies.

The following state reports can be processed using the Framework:

Table 121:

Report See:

Arkansas Form 7 Using The Arkansas Form 7 Report [page 511]

California OG110 Using California Report OG110 [page 514]

Colorado Form 7 Using the Colorado Form 7 Report [page 516]

Louisiana OGP/R5D and WR1 Using the Louisiana OGP/R5D Report [page 517]

Using the Louisiana WR1 Report [page 518]

New Mexico C115 Using New Mexico Report C115 [page 519]

North Dakota Reports Using the North Dakota Reports [page 520]

Oklahoma Form 1004 Using Oklahoma Form 1004 [page 524]

Texas H-10 Texas Form H-10 [page 502]

Texas P1B Using the Texas P1B Report [page 509]

Wyoming Form 2

MMS-PASR Using the MMS-PASR Report [page 526]

MMS-OGOR Using the MMS-OGOR Report [page 530]

17.2.1   Texas Form H-10 

Definition

502 C U S T O M E R
SAP Oil & Gas (PRA - Production and Revenue Accounting)

Regulatory Reporting 



The Texas Form H-10 report is aTexasstate report used to annually report well injection and disposal volumes. 
The report is submitted to the Texas Railroad Commission (Texas RRC).

The Texas H-10 Report is a standardized report based on a specific state agency (Texas RRC) requirement, and 
is based on injection wells. Reporting is at the company code/ organization level.

The report:

Is submitted per injection/disposal well in the field

Reports the total volume of liquid and/or gas injected for each month

Reports all fluid types injected or disposed during the reporting cycle

Reports pressures and volumes for the period since the last annual monitoring report was filed

Reports the minimum and maximum annulus pressure (between tubing and casing)

The report is mailed to you by the Texas Railroad Commission. You fill it out and send it back to the Texas RRC.

Unlike most production regulatory reports, it is not a monthly report, but a yearly report. The purpose is to 
report all injectant volumes used in a well/well completion for a specific lease. Well operators who produce oil 
and gas inTexashave to file the Texas H-10 Report. The report – when fully complete – has to meet the 
reporting requirements as developed by the Texas Railroad Commission (Texas RRC).

In the field, liquid or gas is injected into a well to increase the pressure in the reservoir, when there is not 
enough pressure from within the reservoir to get material to the surface at the required rate for production.

One of the reasons for reporting is so that the state can maintain environmental data on well production. 
Injection and production information (pressures and volumes) have to be reported per well. The transactional 
data (production data) for this can be retrieved from the Production area of PRA.

For more information on Texas H-10 reporting, please refer to the following Texas Railroad Commission (RRC) 
websites:

Railroad Commission ofTexasRules: www.rrc.state.tx.us/tac/rule.html

Railroad Commission ofTexasForms – guidelines for computer-generated hardcopy forms: 
www.rrc.state.tx.us/divisions/og/computer-forms/ogicf.html

Hardcopy format (you can view the Texas Form H-10 here): www.rrc.state.tx.us/divisions/og/form-library/
h10.pdf

File format (Electronic Public Information – Electronic Data Interchange H-10 record): www.rrc.state.tx.us/edi/
eia001h0.html

There are two steps that are required when you report using the SAP system for the Texas H-10 Report:

Setting up the required master data, and

Generating the report in SAP

A third step – outside of the SAP system - is to use that generated data to actually submit by sending it to the 
Texas Railroad Commission.

The file format for the report is mandated by the Texas RRC.
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Master datafor the Texas H-10 Report is created within the Production Regulatory Reporting “framework 
transaction” (O3UREP_MASTER, menu path: Logistics à Production and Revenue Accounting à Production Tax 
and Royalty Reporting à Production Regulatory Reporting à New Regulatory Reporting à Master Data Setup and 
Report Submission ).

The data required for reporting can be retrieved from data stored in the PRA Production module in the ERP 
system, but you will also need to create additional master data for the H-10 Report (district codes, gas wells, 
etc.).

See: Creating Master Data for the Texas H-10 Report [page 505]

Report generation– The Production Regulatory Reporting framework (O3UREP_MASTER) is used to generate 
the report (the reporting framework is the central tool in PRA used to submit production regulatory reports).

See: Generating Reports for Texas H-10 Reporting [page 507]

When we say “generate the report”, we do not mean submit the report. To generate the report means to “pull 
together” all the required data for report submission in the ERP system. To “submit the report” means to send 
the report to the Texas Railroad Commission.

The following data is output when the report is finalized:

Header information:

Operator

Report type

District

Record type

City

State

Zip code

Detail information

Operator

Report type

District

Record type

UIC control number

Cycle month

Average injection PSIG (pounds per square inch)

Maximum injection PSIG
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Volume

Lease number

Volume injection bbls (barrels)

Volume injection MCF

Well number

Field number

SW inj. (salt water injected)

FW inj. (fresh water injected)

BW inj. (brackish water)

Air injected

Gas injected

CO2 injected

Other injected

17.2.1.1  Creating Master Data for the Texas H-10 Report 

Use

Use this to create the master data that you will need for Texas H-10 reporting.

Most of the master data – representing PRA entities - that you will need to generate Texas H-10 reports will 
already exist in PRA Production, but there is additional master data that you will need to set up for reporting 
(for example, the Texas RRC district code). You can do that here.

Proceed as follows:

1. At the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Production, Tax, and 
Royalty Reporting Production Regulatory Reporting New Regulatory Reporting Master Setup and Report 
Submission .

The Report Master Data Set-Up … screen is displayed.

Enter the relevant reporting agency and the relevant report

1. In the Rep. Agency field at the top of the screen, select Texas Railroad Comm. from the drop-down list box 
for that field.

2. In the RegReport field, select Form H-10 .

Screen set-up: maintain fixed values for relevant input fields on the WC Reg ID screen tab

Select the Data screen tab. Data that you enter on this screen tab is used to maintain fixed values for input 
fields on the next screen tab - the WC Reg.ID screen tab.
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For example, if you select Texas Field Number and enter values for it and then save those values, the values will 
then appear in the drop-down list for the Field No . on the WC Reg. ID screen tab.

The drop-down list box for the Field Name field contains all the fields that can be maintained for the report, 
based on your customizing settings. To view them, select the search help directly at the right of the Field Name 
field.

 

From the search help for Field Name , default the first relevant field into the Field Name field by double-clicking 
on it.

Now select Display/change . This sets up the screen for data entry.

Next, in the ALV list area below the Field Name field, maintain values for that field - in the Value and Description 
fields. The values that you maintain here for the field will be used as the drop-down fixed values for that field on 
the WC Reg. ID screen tab screen. After you have finished the first field, select the next field from the search ID 
for the Field Name field, and continue on until you are finished with all the fields in the Field Name drop-down 
list. When you have entered values for all of the fields that you intend to use on the WC Reg. ID screen tab, 
choose Save .

The relevant fixed input field values are now saved and can be used.

Enter the relevant reporting well and lease master data

Select the WC Reg. ID screen tab. This screen tab is used to maintain the well master data for Texas H-10 
reporting, specifically, well completions, effective date ranges, lease numbers, districts, etc. The well 
completion is the basis for injection reporting.

Enter:

- A relevant well and well completion (the well completion consists of two fields: well number, and well 
completion number)

- The effective month (Texas H-10 is an annual report, but month is still valid, because you select a start month, 
which does not have to be January. You may report from February of one year to the end of January of the next, 
for example). The month here corresponds to the “reporting cycle” start month in Texas Form H-10.

- District (this is the district number from the Texas RRC point of view)

Enter data for either:

- a) Lease No. (the RRC oil lease number - if an oil lease is involved), OR

- b) Gas Well No . (if the lease is a gas well lease)

- The Com.PermitNo (commingled permit number)

- The Field No. (the oil field ID for the field that you are reporting on)

- Injection Source (an example is: “fresh water”). The specific injectant that was used.

Comments on data entry:

Please note that you create one well completion record after another on the WC Reg.ID screen tab until you 
have entered all the relevant well completions. When you save each record, it will then be dynamically listed in 
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the ALV list area at the bottom of the screen. You can either enter each record and save one after the other, or 
enter all the records and then save.

Create with reference - You can create one record, and then use Shift + F7 to default the field entries for that 
record into the screen, where you can use them when creating the next record. This allows you to maintain 
many similar records in a fast manner.

Repeat this for each well that you are going to report on. Select Save .

Maintain the relevant lease operator and contact cross reference for the lease that you will be reporting on

From the Report Master Data Set-Up… screen, in the menu, choose Goto Reg. Operator (or, from the SAP Start 
menu, choose Logistics Production and Revenue Accounting Production, Tax, and Royalty Reporting Production 
Regulatory Reporting New Reg. Reporting Maintain Operator and Contact Information)

The “ Display View Regulatory Reporting Operator and Contact Xref: Overview ” screen is displayed. On that 
screen, select Display/change and then New Entries .

The New Entries: Details of Added Entries screen is displayed

On that screen: in the Rep.Agency field, enter TXR (Texas RR Commission). In the Reg. Report field, enter H_10 
(Texas H-10 Report). Enter the company code and organizational levels that apply (for the H-10 Report, you 
report at a company code level, thus enter the org. level that you will be reporting under). Enter the operator 
code for the operator, and the operator name, and customer name (the “customer name” is just another name 
for “operator”).

Save

 

When you are done creating your master data, you can move on to:

Generating Reports for Texas H-10 Reporting [page 507]

17.2.1.2  Generating Reports for Texas H-10 Reporting 

Use

Use this to generate ABAP reports for Texas H-10 reporting.

There are various ABAP reports that you can run from within the Production Regulatory Reporting framework. 
You use the Monthly Processing screen tab on that screen to generate the reports.

You can do the following things from within the Monthly Processing screen tab:

Submit reports – generate ABAP reports that pull together the relevant production data for Texas H-10 
reporting.

Reporting history – you can use this to view reports that were already created.

Changed well completions – allows you to view/maintain/exclude (from amended reports) wells changed due 
to prior period notifications (PPNs).

Prerequisites
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Master data for Texas H-10 reporting has to have been set up. See: Creating Master Data for the Texas H-10 
Report [page 505]

Procedure

Generating reports

From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Production, Tax and 
Royalty Reporting Production Regulatory Reporting New Regulatory Reporting Master Setup and Report 
Submission . The Report Master Data Set-Up screen is displayed.

Select Monthly Processing (screen tab). The Report Generation of Texas Railroad Comm. – Form H-10 screen is 
displayed.

Select Submit Reports .

On the Submit Reports screen tab, select Create .

Enter the relevant reporting company code (and org.level, if relevant), as well as the relevant reporting month 
and year (the month is the start month for that reporting cycle). Enter eitherCfor current report, orAfor 
amended report (if the report is the initial report, enterC, if you are amending an already-created report, 
selectA. A new version of amended report is created after finalization of the previous version).

Choose Save . The report is generated.

In the ALV list area at the bottom of the screen, the system will dynamically list the reports that you generate. 
The execution status shows the status of the report, as: failed, completed, etc. The four icons for each record 
are:

Logs – If you select this, the system displays a dialog box, from which you can display technical information on 
the status of the job runs.

Regenerate report – You can rerun the report.

View report – If you select this, the system then displays a dialog box with options on how you want to display 
the report: to display a list that you can print out, select hardcopy . To produce a list that can be sent 
electronically, select File .

Finalize report – To finalize the report, select this.

To display a list of reports that have already been generated

On the Monthly Processing screen tab, under Submit reports , enter the relevant company code and 
organizational level, as well as the month (start month) and year. In the A/C Indicator field, enter C if the report 
is an initial report (C for “current”), and A if the report is an amended, non-initial report.

Select Execute to run the ABAP report. In the ALV display at the bottom of the screen, the system displays a list 
of records based on your search criteria. From that list, you can choose one record and then choose one of the 
four icons for that record. The execution status shows the status of the report, as: failed, completed, etc. The 
four icons are:
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Logs – If you select this, the system displays a dialog box, from which you can display technical information on 
the status of the job runs.

Regenerate report – You can use this to regenerate the report.

View report – If you select this, the system then displays a dialog box with options on how you want to display 
the report: if you choose hardcopy, the system produces a list that you can print out. If you select File, the 
system produces a list that can be sent electronically.

Finalize report – You can use this to finalize the report.

Reporting History

You can use this to display reports that have already been generated.

From the Monthly Processing screen tab, select the Reporting History screen tab.

Enter the company code, month and year, and other relevant data for your search.

Select Execute ( Select ).

In the ALV list at the bottom of the screen, the system displays the header information in the top ALV; in the 
bottom ALV, it displays the item information.

Changed Well Completions

You use this screen tab to display well completions that have been changed due to prior period notifications 
(PPNs).

From the Monthly Processing screen tab, select the Changed Well Completions screen tab.

Enter the company code and org.level(s), and the relevant month (start month for that reporting cycle) and 
year.

Select Execute ( Select ). The system displays a list of records for well completions that have changed due to 
PPNs ( Reallocated Well Completions ). For more information on PPNs, see: Prior Period Notification [page 196]

17.2.2  Using the Texas P1B Report 

Use

Use the Texas P1B report to report oil and gas production volumes to the 
Texas Railroad Commission (Texas RRC).

The P1B report is used to report oil lease volume dispositions, as well as gas dispositions, including beginning 
and ending inventories. You can designate the P1-B report as partially unitized. An oil lease number is needed 

SAP Oil & Gas (PRA - Production and Revenue Accounting)
Regulatory Reporting C U S T O M E R 509



for the Texas P1B report. You can also designate a "special project" that the well completion belongs to for the 
P1B Report.

Particularities of the Texas P1B Report:

● The reporting period is the reporting month
● The well completion is the reporting unit
● The district is the reporting geographical unit.

You can run the report in current or amended mode.

Procedure

Follow the procedures outlined in the documentation: The Production Regulatory Reporting Framework [page 
489] .

When setting up the Texas P1B report, and processing it, use the following: P1B: Mn Suppl. Rpt (P1B Report).

17.2.3  Using the Texas PR Report 

Use

Use this to carry out regulatory reporting for the Texas PR Report (Texas Production Report).

Features of theTexasPR Report:

● Electronic filing (e-filing) is supported. Smartforms are supported for online e-filing of report data. The 
Smartforms replace the old hardcopy filing contained in the Texas P1 and Texas P2 reports). The Texas PR 
report also supports EDI filing.

● Amended and current reports can be processed.

Tip
The Texas PR Report was introduced, replacing the Texas P1 and P2 Reports, in order to meet new Texas 
Railroad Commission (Texas RRC) reporting requirements. One major part of that was to enable electronic 
filing of reports. The Texas PR Report consolidates reporting functionality that was previously in the the 
following reports, into a single report: Texas P1 Report and Texas P2 Report (the Texas P1B Report, however, 
is still reported separately, see: Using the Texas P1B Report [page 509] ).

Procedure

1. From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Production, 
Tax and Royalty Reporting Production Regulatory Reporting New Regulatory Reporting Master Setup 
and Report Submission
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2. From here, follow the procedures as outlined in the documentation: The Production Regulatory Reporting 
Framework [page 489], for setting up the required master data for reporting, and generating/submitting 
the report.

17.2.4  Using The Arkansas Form 7 Report 

Use

Use the Arkansas Form 7 Report to report volumes of gas produced by well ID (well completions), per field, for 
wells producing in the state of Arkansas, USA.

You can also use the report to report volumes sold by the purchasers/transporters of the well ID. The Arkansas 
Form 7 Report is a monthly gas report. The report is sent to the Arkansas Oil & Gas Commission (AOGC).

Please refer to the official AOGC website for more information on the commission and the report: http://
www.aogc.state.ar.us. That site also contains a copy of the Form 7 Report.

You process this report in the ERP system using the centralized PRA Production Regulatory Reporting 
‘framework’ transaction. The framework is used as a central tool for collecting and reporting production 
volumes to various states in the United States, as well as to the U.S. Federal Government.

The path to the PRA framework is: Logistics à Production and Revenue Accounting à Production, Tax and 
Royalty Reporting à Production Regulatory Reporting à New Regulatory Reporting à Master Set-up and Report 
Submission

Please first familiarize yourself with the functionality of the report by reviewing the documentation on the 
framework: The Production Regulatory Reporting Framework [page 489] .

Features of the Arkansas Form 7 Report

All volumes are reported, or standardized to MCF (thousand cubic feet) at 14.65 lbs/inch 2

Production volumes are obtained from the PRA-Production module

Volumes sold by purchasers/transporters are extracted from CA (Contractual Allocation)

The particular feature unique to Arkansas Form 7 – vis-à-vis the other state reports - is the accumulated 
balance – which is an entry in the report that is mandated by the state of Arkansas. The accumulated balance 
is the total over/under production of a well completion from the time it started producing to the current date. 
The accumulated balance is created for each month. The over/under is calculated for it – which is the 
difference between the monthly allowable and the total gas produced for that month. That over/under is then 
added to the last month’s accumulated balance, which then becomes the accumulated balance for the current 
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month. The accumulated balance for a starting month always mirrors the accumulated balance from the 
previous month.

The concept of daily allowable is used, which is the maximum production per well completion per day in the 
state of Arkansas. You receive this figure from the AOGC, and enter it in the system as part of master data set-
up.

The report also uses the concept of an accumulated allowable – which is the starting accumulated volume 
balance from the previous month. That value helps determine the over/under cumulative balance, when setting 
up master data.

The monthly allowable is calculated by multiplying the daily allowable by the number of days in the reporting 
month. The state of Arkansas defines that figure and sends it to you, and you enter that value in the system.

The Arkansas report uses an assessment in calculating the relevant volume for reporting. The assessment is a 
factor that is multiplied by the total volume produced for a field. The assessment is a factor of 0.005, and is 
multiplied by the total production volume, to obtain an adjusted volume.

You can use smartforms to display a hardcopy of the report.

Amended reportshave to be run when the starting accumulated balance for a well completion is changed for a 
month and a report has already been run for that month. Amended reports are created per well completion, by 
entering different starting accumulated balances, which then serve as a replacement for the current report.

Prerequisites

A prerequisite for reporting on Arkansas Form 7 is that PRA-Production and PRA-CA have successfully run (if 
CA has not successfully run, the purchasers/transporters volume sold will not be reported). MP volumes 
should also have been entered for a reporting month.

You will need to customize the report. The steps involved in customizing the report, before you begin with 
transactional data processing, are as follows:

Maintain the unit of measure(UoM) for oil and natural gas. To do that, in the IMG, choose Industry Solution Oil & 
Gas (PRA) à Production, Tax and Royalty Reporting à Regulatory/Production Reporting à Regulatory Reporting 
Customizing

For natural gas, UoM should be maintained for the dimension field = VOLUME and dimension field = HVALUE 
(heating value).

The production month should also be entered in the format MM/YYYY.

Maintain the volume type for the major product

To do that enter transaction code SM30.

In the Table/View field, enter V_OIUREP_COD_ARK.

Select Maintain .

The Determine Work Area: Entry dialog box is displayed.

Within that dialog box, in the Report Agency field, enter ARK, and in the Regul.Report field, enter FORM7.
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Select Continue .

The Change View “Regulatory Reporting Arkansas Form 7 Majpd/VT Cross-Ref.” screen is displayed. On that 
screen, select New Entries .

The New Entries: Details of Added Entries screen is displayed.

There, assign a volume type for a major product (for example: major product = Natural gas, and volume type = 
01 – Measured production).

Save your data.

Set the output options for the report (smartforms).

To do that, in the IMG, choose SAP Reference IMG à Industry Solution Oil & Gas (PRA) à Production, Tax and 
Royalty Reporting à Regulatory/Production Reporting à Regulatory Reporting Master Data Setup

Now select the IMG activity.

At the left of the screen that is displayed ( Display View: Reporting Agencies: Overview ), select Reporting 
Agencies , and in the right screen frame, select Arkansas AOGC .

Now, at the left screen area, double click on Output Options .

On the Change View “Output Options: Overview ” screen, select New Entries .

On the screen that is now displayed, enter a month and relevant year (see the recommendation directly below), 
and in the Name field, enter the following smartform name: ROIU_REP_ARK_FORM7.

In the Output Options IMG activity, it is better to enter a slightly earlier production month and year.

In addition, within customizing ( Industry Solution Oil & Gas (PRA) à Production Tax and Royalty Reporting à 
Regulatory/Production Reporting à Regulatory Reporting Master Data Setup ), you can also:

View the relevant structures that are used in conjunction with the Arkansas report. To do that, at the left of the 
screen, double click on Rep.Agency , and then select ARK at the right. Then, at left again, double click on 
Assigned Structures .

Within the structures, view the relevant fields. To do that, from Assigned Structures (described directly above), 
select a structure and double-click Maintainable Fields .

Set the reporting level, which is a further breakdown of your company code into organizational levels (you can 
set up org.levels 1-4), reflecting the organizational breakdowns typical in many upstream oil and gas 
companies. From Regulatory Reporting Master Data Setup , at left, select Reporting Agencies . Then, at right, 
select ARK , at left again, double-click Reporting Level . Enter the relevant organizational data for your 
organization.
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Procedure

Follow the procedures outlined in the documentation with the title The Production Regulatory Reporting 
Framework [page 489] .

Master data set-up for the Arkansas report is the same as for the other reports that use the central framework 
tool (thus, please see the documentation on the framework for instructions on how to finish setting up the 
master data). There are some Arkansas-specific master data fields, which the following table explains:

On the Data screen tab, you can create drop-down list box fixed value entries for the following fields on the WC 
Reg. ID screen tab: Arkansas Field number, Arkansas lease number , and Purchaser_transporter.

On the WC Reg. ID screen tab, you create Reg.IDs for well IDs; the meaning of the fields is as follows:

Table 122:

Well I D The AOGC-assigned ID for a well completion. You input it on 
the WC Reg. ID screen, after you receive the specific ID from 
the AOGC.

Daily allowable The maximum volume that a well completion can produce 
per day.Arkansasuses the concept of monthly allowables for 
specific well completions. The monthly allowable (is state-
assigned) and is the daily allowable multiplied by the num­
ber of days in the production month.

Lease number The AOGC-assigned lease ID. The agency sends you this, 
and you input it as part of master data set-up.

Field number The default field is the field already set up for the well com­
pletion as master data.

Beginning over/under cumulative allowable The over/under is the monthly allowable minus the total gas 
produced for the month. It is added to the previous month’s 
accumulated balance, to arrive at the accumulated balance 
for the current month.

This is the starting over or under for this well record. It is de­
rived from the previous month’s accumulated allowable.

17.2.5  Using California Report OG110 

Use

Use this to carry out the necessary reporting for California Form OG110.
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The report is the California OG110 – State of California Department of Conservation Division of Oil, Gas, and 
Geothermal Resources, Forms OG110 and OG110B.

The OG110 report is used to report on well completion volumes producing in the state of California. The report 
is a monthly report.

In the PRA, you use the central production regulatory reporting framework tool (see: The Production 
Regulatory Reporting Framework [page 489] ). You can use the framework to do the following:

● Create the required master data for reporting, for each Production entity that you are reporting on. You 
create well completion Reg. IDs for each well completion that should be reported to the state of California.

● Generate the report – which involves pulling together the relevant data from PRA-Production.

You can then output the data to an ASCII file or print a hardcopy, which can print as a smartform. The report 
output is the ASCII file format specified by the state of California. The state’s specified output file consists of 
three sub-reports:

● A Production report (for production volume data)
● An injection report (for injection data)
● An oil and gas disposition report (for disposition data)

Particularities of the California report (as compared with the Framework):

Table 123:

PRA / Agency Xref screen tab Allows you to cross-reference a California state-assigned ID 
to the equivalent SAP ID for the Production entity.

Pool code California-assigned ID for the pool of oil or gas, from which 
the well is pumping.

H20 source code California-assigned code that indicates the source of in­
jected water.

H20 disposition code California-assigned code that indicates the method used to 
dispose of produced water from the well.

Prerequisites

PRA-Production has to have run successfully.

Procedure

1. From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production, Tax 
and Royalty Reporting → Production Regulatory Reporting → New Regulatory Reporting → Master Setup and 
Report Submission .

1. From here, please follow the procedures as outlined in the documentation: The Production Regulatory 
Reporting Framework [page 489] , for setting up the required master data for reporting, and generating the 
report.

SAP Oil & Gas (PRA - Production and Revenue Accounting)
Regulatory Reporting C U S T O M E R 515



Result

The relevant master data is set up for Production entities that you will be reporting on, and report generation 
has been carried out. You can now submit the report to the relevant state agency.

17.2.6  Using the Colorado Form 7 Report 

Use

Use this to carry out the necessary reporting for Colorado Form 7.

The report is the Colorado Form 7 – Colorado Oil and Gas Conservation Commission Monthly Report of 
Operations. The Colorado Form 7 is required each month for all producing and injecting oil and gas wells in 
Colorado.

In PRA, you use the central production regulatory reporting framework tool (see: The Production Regulatory 
Reporting Framework [page 489] ). You use the Framework to create regulatory IDs for each well completion 
that you are reporting, and to run the monthly report, which gathers and creates the data for the Form 7 
Report. You can output the data to a CSV file or print a hardcopy, which can print as a customized Smartform. 
The report is output to a CSV (comma-delimited) file that can be sent to the state of Colorado and is the format 
required by the Colorado Oil and Gas Conservation Commission.

MP Xref screen tab – on the Framework screen, within master data setup, there is an MP Xref screen tab. You 
use that to cross-reference the SAP-assigned measurement point to the state-assigned measurement point ID.

You can view the Colorado Oil and Gas Conservation Commission website at http://oil-gas.state.co.us/

Prerequisites

PRA-Production has to have run successfully.

Procedure

1. From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production, Tax 
and Royalty Reporting → Production Regulatory Reporting → New Regulatory Reporting → Master Setup and 
Report Submission .

1. From here, please follow the procedures as outlined in the documentation: The Production Regulatory 
Reporting Framework [page 489] .
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17.2.7  Using the Louisiana OGP/R5D Report 

Use

Use this to set up master data and generate the report data for the Louisiana OGP and R5D reports.

You can use this to set up the required master data (WC and MP Reg. ID), and generate the reports that report 
on well completion volumes per operator in the state of Louisiana. You can also view the report history 
(previously-created records). When you produce hydrocarbon products in the state of Louisiana, you have to 
file production reports with the Louisiana Office of Conservation.

The OGP report is the Operator’s Monthly Oil and Gas Report

The R5D report is the Operator’s Monthly Gas Disposition Report, and is used for gas acquisition and 
disposition volumes

Administration of the report is part of the production regulatory reporting ‘Framework’ transaction.

- Note that the regulatory well completion IDs that you create for the OGP report will also be used by the R5D 
report.

- A hard copy (smartform) is not required by the state of Louisiana.

For more information on how to use the ‘Framework’ transaction, please see: The Production Regulatory 
Reporting Framework [page 489] ).

For more information on the Louisiana Office of Conservation, please visit their website at: http://
www.dnr.state.la.us/CONS/Conserv.ssi

Procedure

From the SAP Easy Access menu, choose Logistics àProduction and Revenue Accounting àProduction, Tax, and 
Royalty Reporting àProduction Regulatory Reporting àNew Regulatory Reporting àMaster Setup and Report 
Submission

The Report Master Data Setup screen is displayed.

Follow the procedures detailed in The Production Regulatory Reporting Framework [page 489] .

Particularities for Louisiana reporting(with respect to using the Reg. Reporting ’Framework’):
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PRA-Agency X-Ref screen tab – This screen tab is used to link an internal (SAP) transporter ID with an external 
state agency company code. The reason is that only the state agency company code appears on the Louisiana 
R5D Report that is submitted, and you have to have a way to tie that state agency company code with the 
transporter in the SAP system.

For the Louisiana OPG/R5D reports, you create not just well completion Reg. IDs, but also measurement point 
(MP) Reg. IDs (which are used to represent “drip points” in the state of Louisiana). Parish percentages are also 
used.

Instead of counties or other geographic administrative units, the state of Louisiana is subdivided into parishes. 
Louisiana also uses conservation districts.

For the R5D report, natural gas, and gas injected into the reservoir can be entered. R5D records can be set up 
as original (O) or as corrections (C).

For the OGP report, additional transporter data can be entered, which represents transporters who move 
product from the relevant wells.

17.2.8  Using the Louisiana WR1 Report 

Use

Use this to report WR1 report data to the state of Louisiana.

This report does not report on production volumes. Rather, the WR1 report is the “Inactive Well Report” for the 
state of Louisiana, and reports to the state on the status of inactive wells. The report is a bi-yearly report, which 
you report twice per year (the current reporting dates given by the state of Louisiana are May 1 and November 
1). The purpose of the report is so that the state is informed of the current status of inactive wells, every six 
months.

You can use this transaction to:

● Create master data
● Generate the state report
● View historical records (history)
● View amended report PPNs

- A hardcopy is required by the state agency. The state does not accept electronic filing, so filing has to be sent 
in in paper form.
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Procedure

● From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production, Tax 
and Royalty Reporting → Production Regulatory Reporting → New Regulatory Reporting → Master Setup and 
Report Submission .

The Master Setup and Report Submission screen is displayed.

Follow the procedures detailed in: The Production Regulatory Reporting Framework [page 489] .

Particularities of the WR1 Report:

● Conservation districts are used as the geographic reporting area
● Utility status codes are used

17.2.9  Using New Mexico Report C115 

Use

Use this to carry out the necessary reporting for New Mexico Report C115.

The report is the New Mexico Form C115 – State of New Mexico Energy Minerals and Natural Resources 
Opertor’s Monthly Report. The report is used to report well completion production in the state of New Mexico, 
USA. The report is a monthly report.

You can output the data to an ASCII file, or print a hardcopy, which can print as a customized smartform.

In PRA, you use the central production regulatory reporting framework tool (see: The Production Regulatory 
Reporting Framework [page 489] ). You use the Framework to create regulatory IDs for each well completion 
that you are reporting, and to run the monthly report, which gathers and creates the data for the Form C115.

Master data fields unique to the New Mexico reports are:

Table 124:

Point of Disposition (POD) A New Mexico state-assigned ID number that is equivalent 
to a sales measurement point in the SAP system.

Transporter OGRID A New Mexico state-assigned ID number that is the equiva­
lent to a transporter number in the SAP system.

Operator OGRID A New Mexico state-assigned ID given to the operator, or the 
company filing the report.

Pool Code A New Mexico state-assigned ID for the pool of oil or gas 
from which the well completion is pumping.
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PRA – Agency Xref tab – This screen tab allows you to cross reference a New Mexico state-assigned ID to the 
equivalent SAP-assigned ID.

MP Xref screen tab –This screen tab allows you to cross-reference the SAP-assigned measurement point to 
the state-assigned measurement point ID. For the New Mexico report, PODs for oil and gas are assigned using 
the MP Xref tab.

You can view the New Mexico Energy Minerals and Natural Resources website at: http://
www.emnrd.state.nm.us/

Prerequisites

PRA-Production has to have run successfully.

Procedure

1. From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production, Tax 
and Royalty Reporting → Production Regulatory Reporting → New Regulatory Reporting → Master Setup and 
Report Submission .

1. From here, please follow the procedures as outlined in the documentation: The Production Regulatory 
Reporting Framework [page 489] .

17.2.10  Using the North Dakota Reports 

Use

Use this to report volumes of produced oil and gas in the state ofNorth DakotaUSA

The reports are filed with the Industrial Commission of North Dakota.

For more information on the Industrial Commission of North Dakota, please refer to their website: 
explorer.ndic.state.nd.us.
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There are variousNorth Dakotareports available. The following is a list of the reports that you can process in the 
system:

Table 125:

Form 5 North Dakota Oil Production Report A monthly report that reports on wells 
in a CTB (tank battery). The report con­
tains base sediment and water (BS&W) 
drawn and lease use volume sections. 
(unique fields: meter reading at start of 
month, clean oil produced, BS&W 
drawn, lease use, Meter end of month 
reading, water produced, purchaser, 
transporter).

Form 5A North Dakota Oil Production Report A continuation of Form 5. A separate re­
port is required for each different field, 
pool, county, and operator.

Form 5B North Dakota Gas Production Report Used to report volumes of gas pro­
duced (unique fields: gas produced, gas 
used on lease, gas flared, gas pur­
chaser).

Form 10 North Dakota Purchasers Monthly Re­
port

This report is filed by the “first pur­
chaser”. All volumes of crude oil or 
other liquid hydrocarbon should be 
listed, separately, on this report.

Form 10A North Dakota Oil Transporters Monthly 
Report

This report is filed by the transporter. 
All volumes of crude oil or other liquid 
hydrocarbons transported from each 
well or central tank battery is reported.
(unique fields: NDIC CTB number, 
name of purchaser).

Form 16 Saltwater Disposal Report Well operators who use saltwater for in­
jection in North Dakota, USA, have to 
file the North Dakota Report Form 16, 
that shows, for each injection well, the 
source wells of disposal water, and 
method of transportation. (unique 
fields: oil skimmed from water, begin­
ning and end of month meter reading, 
UIC number, township, monthly barrels 
transported, pipeline or truck indica­
tor).

Form 16A Saltwater Disposal Report Continuation A continuation of Form 16.
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Form 17 Enhanced Recovery Report A regular monthly report, regardless of 
the status of the operations. All active, 
shut-in, or temporarily abandoned in­
jection wells are included on this report. 
This report is also accompanied by 
Form 17A (unique fields: injection zone, 
UIC number, average injection pres­
sure, water treated indicator).

Form 17A Enhanced Recovery Source Report This report should accompany the En­
hanced Recovery Report – Form 17, if 
there were any injections during the re­
porting month (unique fields: injection 
zone, quarter, range number).

You process the reports in the ERP system using the centralized PRA Production Regulatory Reporting 
‘Framework’ transaction (see: The Production Regulatory Reporting Framework [page 489] ). Please familiarize 
yourself with the framework transaction before processing the North Dakota Reports.

You can do the following with the framework:

Master data setup (create a Regulatory ID for wells you are reporting on)

Report generation

Report submission

Report history display, and display of well records changed due to prior period notifications

Prerequisites

Customizing

Follow the instructions on how to set up customizing table entries for North Dakota reporting, which are 
contained in the Framework documentation: The Production Regulatory Reporting Framework [page 489] ). 
The relevant IMG path is: Industry Solution Oil & Gas (PRA) à Production, Tax and Royalty Reporting à 
Regulatory/Production Reporting à Regulatory Reporting Master Data Setup

Master data has to already exist (well, well completion)

PRA-Production and Contractual Allocation have to have been run successfully.

Procedure

Use the central production regulatory reporting ‘Framework’ tool to set up Reg.IDs, generate the report, and 
view records that have already been created. The relevant path to the Framework tool is Logistics à Production 
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and Revenue Accounting à Production, Tax and Royalty Reporting à Production Regulatory Reporting à New 
Regulatory Reporting à Master Setup and Report Submission

This documentation only outlines the special data entities and particularities unique to North Dakota reporting. 
Please use the hyperlink above to link to the documentation that describes the full description of how to use 
the Framework tool to process the report.

Master data setup

Table 126:

On the Report Master Data Setup screen, in the Rep.Agency field, chooseNorth Dakota

The system will now defaultNorth Dakota Reportsinto the RegReport field.

On the Data screen tab, you can customize the following fields (after which, the values that you choose will appear as fixed 
drop-down options on the WC Reg.ID screen tab, for the relevant fields).

UIC number

Well name

Well number

Pool

Unit / field

The following data entities (fields) unique to the North Dakota Reports:

Table 127:

ND Well Name NDIC well name – the well from the North Dakota Industrial 
Commission (NDIC) point of view.

ND Well Number NDIC well number – the well number from the North Dakota 
Industrial Commission point of view.

Well File Number The well file number assigned by the NDIC.

Pool The pool number, for the pool that the well is part of.

Lease Number The relevant lease number.

UIC Number Underground injection control number.

One particularity ofNorth Dakotareporting, is that you can report on purchaser amounts (first purchaser). 
Relevant amounts come from PRA-Contractual Allocation.

Smartforms are utilized to print out report data as a hardcopy.

All liquid volumes have to be reported as barrels (42 gallons), and rounded to the nearest full barrel. All gas 
volumes are reported as MCF, corrected to 14.73 psi and 60 degrees F.
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The following data is output when the report is generated: report month and year, revised/amended report 
indicator, field, pool, county, operator, phone, address, city, zip code, date, printed name, and title. The fields 
that are actually output depend on the specific report that you are running.

17.2.11  Using Oklahoma Form 1004 

Use

Use the Oklahoma Form 1004 to report volumes of gas produced by wells, for wells producing in the state of 
Oklahoma, USA.

The Form 1004 is the “Monthly Natural Gas Production of Well Site Meter Operator” report. You submit the 
report – after you have generated it in the system – to the Oklahoma Corporation Commission (OCC).

For more information on the Oklahoma Corporation Commission (OCC) and Form 1004, please refer to the 
OCC website at: www.occ.state.ok.us/ . That site also contains a copy of the Form 1004.

You process this report in the ERP system using the centralized PRA Production Regulatory Reporting 
‘framework’ transaction (see: The Production Regulatory Reporting Framework [page 489] ), which involves:

Master data setup (creating a Reg.ID to reflect wells you are reporting on)

Report generation

Report submission

Report history display, and display of well records changed due to prior period notifications

With respect to the Oklahoma report:

All volumes are reported in, or standardized to, MCF (thousand cubic feet) at 14.65 lbs/inch 2.

Relevant production volumes are obtained from the PRA-Production module.

Prerequisites

There are two prerequisites for using this report:

Master data has to already exist (well, well completion, etc.)

PRA Production has to have run successfully
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Customizing

Follow the instructions on how to set up customizing table entries for theOklahomareport, which are contained 
in the framework documentation.

Procedure

Use the central production regulatory reporting “framework” tool to set up Reg. IDs, generate the report, and 
view records (see: The Production Regulatory Reporting Framework [page 489] ). The relevant path is Logistics 
à Production and Revenue Accounting à Production, Tax and Royalty Reporting à Production Regulatory 
Reporting à New Regulatory Reporting à Master Setup and Report Submission ).

This documentation only outlines the special data entities and particularities unique to the Oklahoma Report. 
Please use the hyperlink above to link to the documentation that describes the full description of how to use 
the framework tool to process the report.

Some information on data entities specific toOklahomareporting:

Table 128:

Master data setup

- On the Report Master Data Setup screen, in the Rep. Agency field, choose: OCC (for Oklahoma Corporation Commission);

The system will then default Oklahoma Form 1004 into the Reg.Report field.

On the Data screen tab, you can customize the following fields: OCC pool code, OCC allowable number, OCC prefix, and 
OCC operator lease number. Customizing those fields involves choosing a field, and selecting what values will appear for 
that field in the drop-down list box on the WC Reg.ID screen tab.

The following are data entities (fields) unique to theOklahomaReport

Table 129:

OCC county number The relevant county in Oklahoma.

OCC allowance number The OCC sends you this number. It has a prefix and a suffix 
as well. The suffix is generally only used for Guymon-Hugo­
ton gas.

API well number + suffix Each well number is assigned to wells at the time of the in­
tent to drill. Each well has a suffix, which is assigned by the 
OCC for administrative purposes.

Operator and suffix The person or company that operates the well. This number 
and suffix are assigned by the OCC.
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Output indicator: e-mail and hard copy How output is to be handled.

Allowance class The following values can apply here: allocated gas, special 
allocated gas, unallocated gas, Guymon Hugoton gas, allo­
cated oil, unallocated oil, and enhanced recovery.

Pool number Assigned by the OCC to identify the relevant pool.

17.2.12  Using the MMS-PASR Report 

Use

Use this to report on production volumes, for MMS-PASR reporting.

The MMS-PASR is MMS Form 4058 – The Production Allocation Schedule Report (PASR). The report provides 
allocation information for Federal offshore production volumes that are commingled prior to measurement, for 
reporting (commingled means that the volumes come from differing leases).

The MMS-PASR report is a U.S. federal report that OCS (outer continental shelf) lease operators file with the 
MMS (Minerals Management Service). Reporting is at the measurement point level (well completion volumes 
are summed and reported at measurement point level). Measurement points are set up in master data creation 
as facility measurement points (FMPs), which are measurement points that are tied to the government’s 
assigned facility number identifier for that storage tank.
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The graphic below illustrates the reporting level for MMS-PASR reporting – viewing the measurement points in 
a hierarchy, from the MMS’s point of view. In MMS-PASR reporting, the measurement point (facility) is the 
basic reporting level:

Volumes for PASR reporting are summed under either:

Table 130:

Sales volumes The normal situation; you report on volumes that are being 
sold.

“Other volumes” Volumes from sources other than pure sales. This is often 
used in commingling situations.

The MMS-PASR report is due the first month that production is commingled, or the month that commingling 
approval is granted by the MMS, and it is due monthly thereafter until the FMP (facility measurement point) is 
terminated or made inactive. The report is due even if there is no production for a month. In addition to 
reporting, the report is also used to corroborate data on the operations submitted by OCS lease operators.

For more information on the Minerals Management Service in general, access the MMS website at 
www.mms.gov. For information on the MMS-PASR report, and to download a PDF document entitled “How to 
Complete the PASR”, access: www.mrm.mms.gov/Reporting Services/PDFDocs/ProductionHB.pdf
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In the ERP system, you generate the report using the central production regulatory reporting ‘framework’ 
transaction (see: The Production Regulatory Reporting Framework [page 489] ).

Specific features of the PASR report :

● The operator of a tank battery must complete a PASR because the tank battery is the point where sales 
occur for each federal lease.

● Production is measured for allocation before commingling.
● Leases can be operated by different operators.
● Master data is maintained for facility measurement points (FMCs) and operator codes (the operator code 

is a code assigned to identify an operator). A facility is a storage facility.
● The report obtains lease-level master data from the MMS-OGOR master data set-up.
● An external (government-assigned) measurement point ID (metering point) is used to identify the 

measurement point.
● The MMS-PASR report reports volumes sold at measurement point level, not at well completion level, as is 

the case with other production regulatory reports.
● MP Reg. IDs are created as master data, instead of well completion Reg. IDs. The system, when generating 

the report, obtains well completion volumes for the specific measurement point, for the reporting month.
● Smartforms are not provided as standard output by SAP, but you can customize your own.

Prerequisites

First activate the MMS-PASR report in your system, if you have not already done so. You can do that in 
customizing. The IMG path is Industry Solution Oil & Gas (PRA) → Production, Tax and Royalty Reporting → 
Activate Production / Tax and Royalty Reports.

The following can be customized for the report:

Table 131:

Comments for the external MP ID and the Facility ID.

This allows you to set up specific fields on the Data screen 
tab of the Framework as having comments (fields that you 
can add free-form comment text to).

In the IMG, choose: Industry Solution Oil & Gas (PRA) → 
Production, Tax and Royalty Reporting → Regulatory/
Production Reporting → Reg.Reporting Master Data Setup. 
Select Comm . to activate comments for the relevant field.

Fields on the Data screen tab of the ‘Framework’ screen. For the fields: Facility code, facility operator code, and MMS 
sales facility.
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Major product code / volume type mapping.

This determines whether a specific product / volume type is 
going to be handled as a sales volume or as an “other vol­
ume” in the report.

In the IMG: → Regulatory Reporting Major Pd Code / Volume 
Type Mapping .

Here, you link a major product code (“oil”) to a volume type, 
and override group (internal handling group). The entry that 
you make in the Report Column field for each volume type / 
product code combination will determine if that major prod­
uct code / volume type is handled as a sales volume or as an 
“other volume”. Each volume will either be reported under 
sales volume or under other volume in the PASR report itself. 
If you leave it blank, the volume / major product code will be 
reported under both the volume fields – sales and other, but 
that determination is based on the origin of the volume, i.e if 
the volume is from a non-MMS well, it will be reported under 
“other volumes”, if it is from an MMS-well, it will be reported 
under “sales volumes”.

A prerequisite for MMS-PASR report generation is that PRA-Production has run successfully in the system.

Procedure

Use the central production regulatory reporting ‘framework’ tool to set up Reg.IDs as master data, generate the 
report, and view records (see: The Production Regulatory Reporting Framework [page 489] ). Follow the 
Framework documentation for:

● Creating the relevant master data (MP Reg.ID)
● Generating the report data
● Viewing historical records

The relevant path for both master data setup and report generation is Logistics → Production and Revenue 
Accounting → Production, Tax, and Royalty Reporting → Production Regulatory Reporting → New Regulatory 
Reporting → Master Data Setup and Report Submission .

On the ‘Framework’ screen:

Table 132:

Data screen tab Here, there are three customizable fields available: Facility 
code, Facility operator code , and MMS sales facility . You can 
enter your own values for those fields, which are then used 
on the MP Reg.ID screen tab as the fixed drop-down values 
for the relevant fields on that screen tab. The operator code 
is the ID assigned to an operator.
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MP Reg. ID screen tab You use this screen tab to set up your master data – meas­
urement point Reg.IDs -for reporting. You only use this if you 
are setting up sales FMPs.

You create a record that ties your own measurement point to 
an MMS-assigned sales facility number (external number), 
for a specific date range. Measurement point is the basic re­
porting entity for the MMS-PASR report. The sales facility 
number is the government’s assigned ID for a physical stor­
age tank, which you represent in your system as a measure­
ment point.

MP Xref screen tab You can use this screen tab to display related measurement 
points. The metering point is simply the MMS name for an 
MP. On this screen tab, you enter the metering point that you 
received from the MMS, as well as an operator code (the 
metering point is only maintained for commingled metering 
points).

On this screen tab, you assign a facility number for a meas­
urement point. For MPs that you are setting up, you can list 
all the measurement points linked to that upstream MP. For 
each measurement point, you can enter a facility number. 
This is mostly used not for internal configuration purposes, 
but rather, as a cross-reference between your data (MP) and 
the government’s data (facility ID).

DN Xref . screen tab You can use this screen tab to display all the networks at­
tached to a well. You can also assign a network to an override 
group. This is used in internal configuration. For example, 
you could define a group of well – networks for one type of 
processing (“offshore”), and another group of well – net­
works for onshore processing. It allows you to handle deliv­
ery networks in different ways.

17.2.13  Using the MMS - OGOR Report 

Use

The Minerals Management Service (MMS) - Oil and Gas Operations Report (OGOR) is MMS Form 4054, which 
is a summary of all operations conducted on a lease/agreement during a specific production month.
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Prerequisites

You must have done the following:

● To activate the MMS-OGOR A, B and C reports go to Customizing and choose Industry Solution Oil & Gas 
(PRA) Production  , Tax and Royalty Reporting Activate Production/Tax and Royalty Reports.

● To bring in the Customizable fields on the Data Screen tab, go to Customizing and choose Industry 
Solution Oil & Gas (PRA) Regulatory/Production Reporting Regulatory Reporting Master Data Setup

● The following must be Customized for the report:
○ Fields ( Lease Number , Agency Lease Number , Operator lease Number , Operator Well Number , API 

Well Group , Action Code ) on the Data screen tab of the Framework screen.
In Customizing, choose Regulatory Reporting Major Product Code/Volume Type Mapping . Here, you 
link a major product code (Oil) to a volume type, and override group (internal handling group).

○ Major product code/volume type mapping
○ This determines whether a specific product/volume type is going to be handled as a Production 

Volume or as an Injection Volume on the OGOR A report.
○ This determines whether a specific product/volume type is going to be handled as a Disposition 

Volume on the OGOR B report.
○ This determines whether a specific product/volume type is going to be handled as a Sales Volume 

or Production volume or Beginning Inventory or Ending Inventory on the OGOR C report.

Features

The OGOR is required to be reported monthly (unless a different frequency is previously approved by Bureau of 
Land Management ( BLM ) or Bureau of Indian Affairs ( BIA) for all designated operators of a Federal or Indian 
lease, unit, or communitization agreement that contains wells not permanently plugged and abandoned or that 
has ending inventory and is not terminated.

The OGOR consists of three parts:

● The OGOR-A accounts for all production and injection data on a lease/agreement by well and producing 
interval, in addition to drilling, temporarily abandoned, work over, or abandonment activity. The OGOR-A 
identifies the status and volumes for each well on a lease for which you are responsible.
OGOR Adescribes the activities of all wells by producing interval for the report entity. Operators must 
report all wells no longer in active drilling status until the wells are permanently plugged and abandoned, or 
the lease is terminated. For onshore, report only until abandoned or squeezed. If you have test production 
while the well status is drilling, you must report the well.

● The OGOR-B accounts for the total disposition of lease/agreement production for each product. 
Disposition may include direct sales, transfers, and lease/agreement use.
OGOR Bdescribes the disposition activity for all production/products for the report entity.

● The OGOR-C accounts for the production and sales attributable to a lease/agreement but put into 
inventory before the production is sold from a storage facility. It also identifies beginning inventories, 
ending inventories, production, sales, and adjustments.
OGOR C describes the inventory activity for all oil/condensate and CO2 production for the report entity.
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Activities

To set up Regulatory Identifiers (Reg. IDs) as master data, generate the report, and view records, use the 
central production regulatory reporting framework tool (see: The Production Regulatory Reporting Framework 
[page 489] ).

To setup the master data and for report generation go to the SAP Easy Access menu and choose Logistics
Production and Revenue Accounting Production, Tax, and Royalty Reporting Production Regulatory 
Reporting New Regulatory Reporting Master Data Setup and Report Submission  .

On the Framework screen, you view the following:

● Data screen tab
Here, there are three Customizable fields available: Facility Code , Facility Operator Code , and MMS Sales 
Facility . You can enter your own values for those fields, which are then used on the MP Reg.ID screen tab as 
the fixed drop-down values for the relevant fields on that screen tab. The operator code is the ID assigned 
to an operator.

● Measurement Point Regulatory Identifier (MP Reg. ID) screen tab
You use this screen tab to set up your master data – measurement point Reg.IDs -for reporting. You only 
use this if you are setting up sales facility/measurement points (FMPs).
You create a record that ties your own measurement point to an MMS-assigned sales facility number 
(external number), for a specific date range.

● Measurement Point (MP) Cross Reference (Xref) screen tab
You can use this screen tab to display related measurement points. The metering point is simply the MMS 
name for an MP. On this screen tab, you enter the metering point that you received from the MMS, as well 
as an operator code (the metering point is only maintained for commingled metering points).
On this screen tab, you assign a facility number for a measurement point. For MPs that you are setting up, 
you can list all the measurement points linked to that upstream MP. For each measurement point, you can 
enter a facility number. This is mostly used not for internal configuration purposes, but rather, as a cross-
reference between your data (MP) and the government’s data (facility ID).

● Delivery Network (DN) Cross Reference (Xref.) screen tab
You can use this screen tab to display all the networks attached to a well. You can also assign a network to 
an override group. This is used in internal configuration. For example, you could define a group of well – 
networks for one type of processing (offshore), and another group of well – networks for onshore 
processing. It allows you to handle delivery networks in different ways.

See Also

For more information see:

● Using the Regulatory Reporting Monthly Adjustment Report [page 500]
● Creating Master Data for Regulatory Reporting [page 493]
● Creating Well Level Override Group for MMS OGOR Report [page 533]
● Generating Reporting Data for Regulatory Reporting [page 495]
● Viewing historical records [page 497]
● Minerals Management Service in general, access the MMS website at www.mms.gov.
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17.2.13.1  Creating Well Level Override Group on MMS OGOR 
Report 

Use

You use this function to split the volumes between two different overrride groups based on the percentages.

The override group is set up on the Well Completion Regulatory Identifier cross-reference (WCREGID Xref) 
screen tab on the Production Regulatory Reporting Framewor k screen.

Override group for onshore and offshore purposes tells the system how to handle a particular volume at the 
well level.

Example
Royalty-bearing fuel and/or flare volumes ( Section 6) and Deep Gas Relief are two examples than can 
require splitting a volume between different disposition codes on OGOR B report.When the split is 100 
percent, a user can use an override group for the well or DN (and no change is necessary).When the split is 
less than 100 percent, this function splits the volume with the respective percentages.

Features

This function has the following features:

● Override group percent split table replaces Override Group field in the Well Completion Regulatory Identifier 
(WC REGID) tab.

● Allows users to associate a percentage of the well to an override group.
● Percent split table adds up to 100 percent.
● Default percentage is 100. This means that there is no override group (non override group with default 

override group DEF ).

Example
Oil sales of 100 barrel (BBL) at well completion (WC) 100-1.

User sets up a percentage split on the Well Completion Regulatory Identifier (WC Reg ID) to say that 65 
percent must use the DEEPG override group. The remaining 35 percent uses the non override group 
case and will automatically calculate the 35 percent and assign it to DEF override group.

Activities

● To Customize the override group, choose Logistics Production and Revenue Accounting  Production, 
Tax and Royalty Reporting Production Regulatory Reporting New Regulatory Reporting Master Setup 
and Report Submission  .
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● Go to the Well Completion Regulatory Identifier ( WC REG ID ) tab and choose Execute .
● Double click to select the Well Completion from the ALV grid.

For creating new records, an empty table is displayed with Override Group and Percent for editing.
● Select the override group DEF from the table field and enter the Percentage - 20 .
● Select the override group SEC 6 and enter the Percentage - 80 .
● Choose Enter and Save .

See Also

For more information, see Using the MMS - OGOR Report [page 530] .

17.3 Using the Report Driver for PRA Reporting 

Use

Use the Report Driver to submit tax, royalty, and regulatory (production) reports in Production & Revenue 
Accounting.

The Report Driver is a centralized, standardized tool that is used for most of the tax, royalty, and production 
reports in Production & Revenue Accounting. With a few exceptions (such as OK Royalty and MMS Production), 
almost all of the tax, royalty, and production reports used in PRA use it. Due to the fact that the Report Driver is 
a centralized tool, it means that you do not have to use many different individual report transactions to create 
reports in the ERP system.

The core of the Report Driver is a report generation tool, which pulls data together from various tables into a 
single report.

The following lists which reports the Report Driver is used for, and which reports it is not used for, by reporting 
area:

Table 133:

Reporting area in PRA: The Report Driver is used for: The Report Driver is not used for:

Tax reporting All states, all reports. ---

Royalty reporting The Generalized State Report, Texas re­
ports, New Mexico reports. All state re­
ports except those listed at right.

MMS, Oklahoma, Wyoming.

Regulatory (production) reporting Texas reports (Texas P1, P2, P1B). MMS, New Mexico, Louisiana reports, 
Wyoming.
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If you want to see a full list of all the reports that the Report Driver can be used with, you can look at the drop-
down list box for the Reg.Report field on the Report Execution (Report Driver) screen. The drop-down list box 
contains all the reports.

Each time you run the Report Driver, the following are produced:

A main report, and

An error report.

The main report is stored in the database, and temporarily-required information like the error reports is stored 
in the file system. You can view each individual dataset, and print it out, or download it and send it to the 
relevant governmental reporting authority.

Procedure

From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Production, Tax and 
Royalty Reporting …

Table 134:

For Tax reporting: (follow the path listed directly above and then choose)… Tax 
Reporting Old Tax Reporting Submit Tax Reports .

For Royalty reporting: … Royalty Reporting Old Royalty Reporting Submit Royalty 
Reports

For Regulatory (production) reporting: … Production Regulatory Reporting Old Regulatory Reporting 
Submit Production Regulatory Reports

The transaction code for the Report Driver is O3UH_REPEX. If you want to centrally access the Report Driver, 
you can use that transaction to do so.

The Report Execution screen is displayed.

The first field on that screen – the Reg.Report field – contains the names of reports that you can choose from. 
Select the report that you would like to submit. The input fields on the Report Execution screen will change 
dynamically, based on what report you select.

The reports that are displayed in the matchcode ID dropdown box for the Reg . Report field are based on the 
user-assigned authorizations, which can be given using authorization object O_OIUH_REP based on the 
reporting type (tax, royalty or production), state, company code (org.level) or individual report (JIL).

Enter the reporting month and year for the report, as well as any other relevant parameters (company code, 
etc.). Also enter whether you want the report run to be a trial run or a final run (a trial run is like creating the 
report as a draft version).

Select New Report Execution (the Create icon).
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A pre-execution screen is now displayed.

On that screen, select Execute Report . Selecting Execute generates the report for the data you entered, and 
generates the report files – it pulls all the relevant data together (from the relevant tables) for the report that 
you chose. You can now view that data in the Report Executions ALV screen area at the bottom of the screen.

The status of the report execution is displayed in the status field of the list at the bottom of the screen.

The following statuses exist:

Table 135:

10 Report generation scheduled

11 Report generation running

12 Report generation completed

13 Report generation failed

14 Report generation rescheduled

15 Report generation outdated (reallocation)

20 Report finalization scheduled

21 Report finalization running

22 Report finalization completed

23 Report finalization failed

24 Report finalization rescheduled

You can update the list of report runs and also the current status. To do that, select the List button.

From the list of report files in the ALV list at the bottom of the screen, you can double click on one item in the 
line.

To display the job log, double click on a job name or number.

To access the Report Results screen, double click on any field other than the job name or number. The Report 
Results screen displays all of the files for the report.

To view the Detail Report, double click an individual line entry. The Detail Report is the information that you will 
be supplying to the government agency, or a supplemental report.

If the file name column is empty, it means that that dataset is saved in the database. Not all of the files that 
appear in the file name column will be files that will be reported to the government. All intermediate or empty 
files created by each run are automatically deleted by the system at the end of the run.
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Regeneration:

If a specific report has already been generated, and you want to generate it again, you can regenerate it. To do 
that, on the Report Execution screen, select Regenerate Report .

Report finalization:

You can only finalize a report once. After you have finalized a report, it is not possible to carry out another 
finalization for the same report month/year/company and amended/current. You can, however, amend reports.

17.4 Regulatory Reporting Status Inquiry 

This function lists the reporting ID’s, names, and their associated governmental entities (state or federal) that 
have been created for agency filing.Only original, as opposed to amended, reports are reflected in this function. 
Reports are listed by reporting period.Optional fields include report name and state or federal agency.

Procedure

1. At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Production, 
Tax and Royalty Reporting  Production Regulatory Reporting Old Regulatory Reporting Master 
Maintenance Maintenance / Tracking Regulatory Reporting Status Inquiry  .
The Regulatory Reporting Tracking Browse: Initial Screen appears.

2. Enter data as as required.
3. Choose Execute .

17.5 Creating or Maintaining a Louisiana Regulatory 
Reporting Record 

Use

Use this transaction to maintain well completion regulatory data for Louisiana reporting.

Procedure

1. At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Production, 
Tax and Royalty Reporting Production Regulatory Reporting Old Regulatory Reporting Louisiana 
Louisian Regulatory ID.

2. The Louisiana Reg. ID: Initial Screen appears.
3. Choose Create .

The Louisiana Reg. ID - Create screen appears.
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1. Enter data as required:
2. Save your entries.

Using a Reference to Create a Louisiana Regulatory ID Record

1. To create a Louisiana Regulatory ID record with reference to an existing record, at the Louisiana Reg. ID: 
Initial Screen , enter data as required.Then choose Execute .

2. If more than one record matches the data you entered, select one of the records from the list.
OR
If only one record matches the data you entered, the single record is displayed.
Choose Create to create a new record with the data from the record you selected.

Changing or Displaying a Louisiana Regulatory ID Record

1. To change or display a Louisiana Regulatory ID record, at the Louisiana Reg. ID: Initial Screen , enter data as 
required.Then choose Execute .

2. If more than one record matches the data you entered, select one of the records from the list.
OR
If only one record matches the data you entered, the single record is displayed.

3. Choose Change or Display to change or display the record as required.

17.6 Creating or Maintaining a Louisiana R-5-D Record 

Use

Use this transaction to maintain well completion regulatory data for Louisiana reporting.

Procedure

1. At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Production, Tax 
and Royalty ReportingàProduction Regulatory ReportingàOld Regulatory ReportingàMaster 
MaintenanceàLouisianaàLouisiana R5D  .

The Louisiana R-5-D: Initial Screen appears.

1. Choose Create .
The Louisiana Reg. ID - Create screen appears.

2. Enter data as required.
3. Save your entries.

Using a Reference to Create Louisiana R-5-D Record

1. To create a Louisiana R-5-D record with reference to an existing record, at the Louisiana R-5-D: Initial 
Screen , enter data as required.Then choose Execute .
The Create Louisiana R-5-D: Overview screen.
If more than one record matches the data you entered, select one of the records from the list.
OR
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If only one record matches the data you entered, the single record is displayed.
2. Choose Create to create a new record with the data from the record you selected.

Changing or Displaying a Louisiana R-5-D Record

1. To change or display a Louisiana R-5-D record, at the Louisiana R-5-D: Initial Screen , enter data as 
required.Then choose Execute .
The Create Louisiana R-5-D: Overview screen.
If more than one record matches the data you entered, select one of the records from the list.
OR
If only one record matches the data you entered, the single record is displayed.

2. Choose Change or Display to change or display the record as required.

17.7 Creating or Maintaining a Generalized Regulatory ID 

Use

Use this transaction to maintain regulatory reporting information for a well completion in a state that you 
specify.

Procedure

1. At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Production, 
Tax and Royalty Reporting Production Regulatory Reporting Old Regulatory Reporting Master 
Maintenance Generalized Generalized Reg. ID  .

2. The Gen. Reg ID: Initial Screen appears.
3. Choose Create .

The Create Gen. Reg ID: Overview screen appears.
4. Enter data as required:
5. Save your entries.

Using a Reference to Create a Miscellaneous Regulatory ID Record

1. To create a miscellaneous regulatory ID record with reference to an existing record, at the Gen. Reg ID: 
Initial Screen , enter data as required.Then choose Execute .

2. If more than one record matches the data you entered, select one of the records from the list.
OR
If only one record matches the data you entered, the single record is displayed.

3. Choose Create to create a new record with data from the record you selected.

Changing or Displaying a Miscellaneous Regulatory ID Record

1. To change or display a miscellaneous regulatory ID record, at the Misc Reg ID: Initial Screen , enter data as 
required.Then choose Execute .

2. If more than one record matches the data you entered, select one of the records from the list.

SAP Oil & Gas (PRA - Production and Revenue Accounting)
Regulatory Reporting C U S T O M E R 539



OR
If only one record matches the data you entered, the single record is displayed.

3. Choose Change or Display to change or display the record as required.

17.8 Creating or Maintaining a Texas Regulatory ID Record 

Use

Use this transaction to maintain well completion regulatory data for Texas reporting.

Procedure

1.        1.      From the SAP Easy Access menu, chooseLogistics Production and Revenue Accounting 
Production, Tax and Royalty Reporting Production Regulatory Reporting Old Regulatory Reporting 
Master Maintenance Texas Texas Reg.ID.
The Texas Reg ID: Initial Screen appears.

2. Choose Create .
The Create Texas Reg ID: Overview screen appears.

3. Enter data as required.
4. Save your entries.

Using a Reference to Create a Texas Regulatory ID Record

1. To create a Texas Regulatory ID record with reference to an existing record, at the Texas Reg ID: Initial 
Screen , enter data as required.Then choose Execute .

2. If more than one record matches the data you entered, select one of the records from the list.
OR
If only one record matches the data you entered, the single record is displayed.

3. Choose Create to create a new record with the data from the record you selected.

Changing or Displaying a Texas Regulatory ID Record

1. To change or display a Texas Regulatory ID record with reference to an existing record, at the Texas Reg ID: 
Initial Screen , enter data as required.Then choose Execute .

2. If more than one record matches the data you entered, select one of the records from the list.
OR
If only one record matches the data you entered, the single record is displayed.

3. Choose Change or Display to change or display the record as required.
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17.9 Creating or Maintaining a Wyoming Regulatory ID 
Record 

Use

Use this transaction to create and maintain data for a Wyoming Regulatory ID record.

Procedure

1. At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting
Production, Tax and Royalty Reporting Production Regulatory Reporting Old Regulatory Reporting 

Master Maintenance Wyoming Wyoming Reg.ID  .
The Wyoming Regulatory ID: Initial Screen appears.

2. Choose Create .
The Wyoming Regulatory ID Create: Overview screen appears.

3. Enter data as required.
4. Save your entries.

Using a Reference to Create a Wyoming Regulatory ID Record

1. To create a Wyoming Regulatory ID Record with reference to an existing record, at the Wyoming Regulatory 
ID: Initial Screen , enter data as required.Then choose Execute .

2. If more than one record matches the data you entered, select one of the records from the list.
OR
If only one record matches the data you entered, the single record is displayed.

3. Choose Create to create a new record with the data from the record you selected.

Changing or Displaying a Wyoming Regulatory ID Record

1. To change or display a Wyoming Regulatory ID Record, Wyoming Regulatory ID: Initial Screen , enter data as 
required.Then choose Execute .

2. If more than one record matches the data you entered, select one of the records from the list.
OR
If only one record matches the data you entered, the single record is displayed.

3. Choose Change or Display to change or display the record as required.
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17.10  Viewing Reallocated Well Completion Records 

Use

If you have already sent a regulatory report to an agency, it can later occur that the relevant volumes change 
due to prior period adjustments (PPAs) and/or reallocated volumes, after the report was sent in. If that 
happens, you then have to re-report in an amended report.

You can use this screen to view a list of well completions that have been reported, and create or delete entries 
from the list of well completions that have to be re-reported.

You can also exclude a subset of well completions from being included in the amended report.

Once the amended report is finalized, only the wells not marked to be excluded are deleted from the list of re-
allocated well completions.

If a single well completion is selected to be excluded, the related well completions belonging to the same lease 
(or pool code or other business key associated with the type of agency and report) are also excluded.

Procedure

1. To display the Master Setup and Report Submission: Initial Screen, in the SAP Easy Access menu, choose 
Logistics → Production and Revenue Accounting → Production, Tax and Royalty Reporting → Production 
Regulatory Reporting → New Regulatory Reporting → Master Setup and Report Submission .

2. Select the relevant data for your search (Rep Agency and Reg Report).
3. Choose Monthly Processing tab.
4. Enter Company (ORG1) level information.
5. Choose Changed Well Completions tab
6. Either enter the required data (like Org1 , Prod Year , Well Completion , etc.) or leave all fields blank and then 

choose Select ( Execute ). The system displays all the records that match your search criteria.

The ALV displaysa list of re-allocated or changed well completions that has either its master data or production 
volumes changed since the last time this particular report (current or amended) was finalized for the specific 
production date.

To create new records

1. Go to the Re-allocated Well Completion screen.
2. Choose Create .
3. Enter the well completion and production date.
4. Choose Save . The record that you created will now appear in the ALV screen area at the bottom of the 

screen.

To delete records

You can also delete records from the ALV list of queried records.

1. Go to the Re-allocated Well Completion screen.
2. Select a particular row or multiple rows and select Delete Line . A pop up box requesting you to confirm the 

deletion appears.
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3. Choose Yes . The record is deleted from the list.

To exclude records from amended report

You can exclude particular set of records from next generation of amended report.

1. Go to the Re-allocated Well Completion screen.
2. Select a particular row or multiple rows and select Exclude . A pop up box requesting you to confirm the 

exclusion appears.
3. Choose Yes .

An X mark appears in the ALV column Exclude RWC . Related well completions belonging to the same lease 
(like for MMS PASR reports) or pool code (like NM C115) are also excluded.

Excluded records do not appear in the amended report.

When amended report is finalized, all re-allocated well completion records are deleted except for the well 
completions that were explicitly marked as excluded (with an X mark in the Exclude RWC ).

To include records in amended report

By default all re-allocated well completions appearing in the ALV grid are included in the next amended report 
generation except for records with X mark. These excluded records can again be included in the amended 
report. From the Re-allocated Well Completion screen:

1. Select a particular row or multiple rows and select Include .
2. A pop up box requesting you to confirm the inclusion appears.
3. Choose Yes .

All selected records and related re-allocated well completion (like under the same lease or pool code) are 
included and the Exclude RWC column is blank for these re-allocated well completions.
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18 Royalty Reporting 

Purpose

In Production and Revenue Accounting, Royalty Reporting generates reports required for various reporting 
agencies.

Features

Royalty Reporting uses two sets of master data: one set established in Customizing [Production, Tax and 
Royalty Reporting   Royalty Reporting Royalty Reporting] as well as a set that is adjusted as required in the 
Maintaining Master Data for Royalty Reporting [page 546] transaction ( Logistics → Production and Revenue 
Accounting → Production, Tax and Royalty Reporting → Royalty Reporting   → New Royalty Reporting Framework 
→ Master Maintenance ).

Once you arrange the master data as required, you then use the Processing of Royalty Reports [page 548] 
transaction ( Logistics → Production and Revenue Accounting → Production, Tax and Royalty Reporting → Royalty 
Reporting → New Royalty Reporting Framework → Extraction and Reporting ), which makes data available for the 
system to extract royalty amounts, summarize data, and process the reports.

Disclaimer

In order to use Royalty Reporting, you first have to activate the required reporting routines. By activating them, 
you agree to the following statement:

      The SAP reporting routines for Royalty Reporting are provided "as is" and are provided without any 
warranty, escrow, training, maintenance, or service obligations whatsoever on the part of SAP. SAP makes no 
express or implied warranties of any type whatsoever including that any results derived from their use will 
comply with any tax and regulatory rules and reporting requirements or for the fitness of any other particular 
purpose. Licensee assumes all risks associated with its use of these routines or other portions of the Software 
and the Documentation, including without limitation risks relating to quality, performance, data loss, or 
reporting, formatting or data errors. In no event shall SAP be liable to Licensee or to any third party for any 
damages, costs or penalties arising in connection with Licensee’s use of or inability to use the Software or the 
Documentation, in connection with SAP’s provision of or failure to provide services pertaining to the Software 
or the Documentation, or as a result of any defect in the Software or the Documentation. This disclaimer of 
liability shall apply regardless of the form of action that may be brought against SAP, whether for in contract or 
tort, including without limitation any action for negligence.
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18.1 Creating or Maintaining a Tax & Royalty Profile 

Use

Use this transaction to specify the following information for tax and royalty reports:

● reporting entity identification numbers
● contact information for the individual representing the reporting company
● royalty owner information

Procedure

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Production, Tax 
and Royalty Reporting

Table 136:

Follow-on Menu Path Function

Tax Reporting Old Tax Reporting Master Maintenance

Tax and Royalty Profile

Tax Reporting

Royalty Reporting Old Royalty Reporting Master 

Maintenance Tax and Royalty Profile

Royalty Reporting

The Tax and Royalty Profile: Initial Screen appears.

Specify a report and its corresponding effective dates and contact information.Also enter the royalty owner 
information for the report.

Save the profile.

Using a Reference to Create a Tax & Royalty Profile

To create a tax and royalty profile with reference to an existing record, at the Tax and Royalty Profile: Initial 
Screen , enter data as required.Then choose Execute .

If more than one record matches the data you entered, select one of the records from the list.

OR

If only one record matches the data you entered, the single record is displayed.

Choose Create to create a new record with the data from the record you selected.

Changing or Displaying a Tax & Royalty Profile

To change or display a tax and royalty profile, at the Tax and Royalty Profile: Initial Screen , enter data as 
required.Then choose Execute .

If more than one record matches the data you entered, select one of the records from the list.
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OR

If only one record matches the data you entered, the single record is displayed.

Choose Change or Display to change or display the record as required.

18.2 Maintaining Master Data for Royalty Reporting 

Use

Use this transaction to enter the data needed to create reports for a particular reporting agency within a 
specific month and year. With this transaction, you establish the data that the system will use to generate the 
reports. After you establish the data within this transaction, you use the Processing of Royalty Reports [page 
548] transaction to generate the reports.

You can enter the following data in this transaction:

Table 137:

Property/DOI numbers Owners

Lease numbers Well / well completion numbers

Lease allocation factors Reporting profile ID

Payor fractions  

Procedure

From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production, Tax and 
Royalty Reporting → Royalty Reporting → New Royalty Reporting Framework → Master Maintenance .

The Master Maintenance for Royalty Reporting screen appears.

To review or retrieve lease master data, or to enter a new lease number and text for a reporting agency, choose 
the Lease tab.

Then do one of the following:

To review or retrieve data, enter selection criteria and choose Execute .

To enter a new lease number and text for a reporting agency, choose Create .

In the Reporting Parameters section, enter the reporting year and reporting month that corresponds with the 
existing data that you wish to retrieve. Then in the Effective From section, enter the year and month for which 
you will add or adjust existing data.
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To review or retrieve owner data, or to enter new owner data, choose the Owners tab, and specify the reporting 
parameters and the effective from year and month.

Then do one of the following:

To review or retrieve data, enter selection criteria and choose Execute .

To enter new owner data for the reporting parameters that you specified, choose Create .

To review or retrieve entity data, or to enter new entity data, choose the Entities tab.

If you have not already done so, specify the reporting parameters and the effective from year and month.

Then do one of the following:

To review or retrieve data, enter selection criteria and choose Execute .

To enter new entity data for the reporting parameters that you specified, choose Create .

To review or retrieve profile data, or to enter new profile data, choose the Profile tab.

If you have not already done so, specify the reporting parameters and the effective from year and month.

Then do one of the following:

To review or retrieve data, enter selection criteria and choose Execute .

To enter new profile data for the reporting parameters that you specified, choose Create .

The reporting profile specifies each field that is to be printed on a report and the value for each field.

Result

The data needed to create reports for a particular reporting agency, within a specific month and year, is 
specified in the system.

To execute data processing and generate reports, use the Processing of Royalty Reports [page 548] 
transaction.

18.3 Agency Product Code to PRA Material Cross Reference 

Use

This cross reference links a reporting agency’s product code to a PRA material code.

The system uses the cross reference to summarize the royalties and taxes of multiple PRA material codes to 
the reporting agency product code. (Usually, multiple PRA material codes are cross referenced to a reporting 
agency product code.)
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Activities

From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Production, Tax 
and Royalty Reporting  . Then choose one of the following:

Table 138:

Follow-on Menu Path Function

Royalty Reporting New Royalty Reporting Framework

Setup Agency Product Code and PRA Material X-ref

Royalty Reporting

Tax Reporting New Tax Reporting State Agency & 

PRA Material Xref

Tax Reporting

Note
In the Agency Prod Cd field, specify the agency product code, and in the Material field, specify the PRA 
material to be cross referenced to the agency product code.

18.4 Processing of Royalty Reports 

Purpose

Use this process to extract data previously posted in Journal Entry that determines the values to be reported. 
By using this process you can generate, download, and finalize reports as required.

This process includes the following steps:

Table 139:

Step Description

Master Change The system uses master data (established in the Master 
Maintenance transaction) effective for a particular month 
and year for a reporting agency.

Royalty Extraction The system extracts records from Journal Entry with royalty 
amounts that need to be reported to an agency for certain 
owners.
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Step Description

Master Change The system uses master data (established in the Master 
Maintenance transaction) effective for a particular month 
and year for a reporting agency.

Validation The system compares the extracted royalty data with the 
master data month by month.If the master data does not 
match the extracted data, then the master data set up is in­
complete.

Volume Extraction The system extracts the different kinds of volumes to be re­
ported (such as sales volume and gross production vol­
umes) from the Production application component.

Report Processing Because the system extracts everything at the well/well 
completion-level , the system must then summarize the 
data at the lease-level in order to meet the agency’s require­
ments.

Report Finalization The system completes the processing of the reporting pa­
rameters for the month and also creates journal entries.

Prerequisites

The master data required for extraction and reporting is set up in the Master Maintenance [page 546] 
transaction.

Process Flow

1. From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Production, 
Tax and Royalty Reporting Royalty Reporting New Royalty Reporting Extraction and Reporting  .
The Royalty Reporting screen appears.

2. Enter the reporting parameters and choose Display Status .
3. Review the numbers displayed in the columns.

Note
The number in each column indicates the sequence in which the steps were executed.

Caution
It is important that the Validation step displays a number greater than the number displayed for the 
Master Change or Royalty Extraction steps. You must execute the Validation step any time after you 
change master data or extract royalty data.
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4. To display the status of execution for a combination of reporting parameters, choose Display Status .
5. To display results at the lease-level after system processing so that you can review data before finalizing it, 

choose Display Results .
6. To display a collection of reports for a particular combination of company code, reporting agency, and 

product, choose List Reports .

Note
The same report could be listed more than once if a PPA affects the data, thereby requiring an amended 
report.

Note
To download a report, select the report and choose Download . Or to print a report, select the report and 
choose Print .

7. To extract royalty data, choose Royalty Extraction .
8. To execute validation, choose Validate data .
9. To display rows that were rejected during validation, choose Display Rejected Rows .

Note
Rows can reject if a lease is not set up properly.

10. To extract volumes, choose Volume extraction .
11. To process the report(s), choose Process Reports .

Note
The following values are possible in the Reporting Processing column:

-- P , indicating that processing is in progress

-- F , indicating that the processing failed

-- a number, which represents the step completed

Note
You can change relevant master data and execute Royalty Extraction, Validation, Volume Extraction, and 
Reporting Processing as often as needed to achieve the results required before the Report Finalization.

12. Verify that reporting results are ready for Report Finalization.

Caution
Before you choose Make reports final , download or print reports as required by choosing List Reports .

Caution
You can execute Report Finalization by choosing Make reports final only once for a particular 
combination of Reporting Parameters.
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When you choose Make reports final , the system considers the month of reporting complete and you 
can no longer extract or maintain master data for the parameters.

13. After verifying that reporting results are ready for Report Finalization, choose Make reports final .
14. To review the progress of a job, choose Display Log .
15. To review the report(s) that a job has generated, choose Display Spool .

18.5 Setting Up Agency Codes 

Use

For Tax Reporting, you use this transaction to set up override affiliation codes for New Mexico .

For Royalty Reporting, you can use this transaction to set up the following types of cross references:

● Field code and field name cross references for Louisiana reports – This cross reference allows a field name 
to be displayed in the report that is different from the field name maintained in the Production application 
component.

Note
The field names entered in this cross-reference override the field names entered at the Production 
application component.

● Purchaser tax ID and purchaser number cross references for Texas reports – This cross reference links a 
purchaser tax ID to a purchaser number; Texas requires that both the ID and the purchaser number be 
shown in the report.

Note
After you enter this type of cross reference, you must execute the Extraction and Reporting transaction 
in order for the royalty report processing to be successful.

● Purchaser tax ID and contract number – This cross reference is needed for Texas reports.

Activities

From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Production, Tax 
and Royalty Reporting  . Then choose one of the following options.
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Table 140:

Follow-on menu path Function

Tax Reporting New Tax Reporting Set Up Agency 

Specific Cross References

Tax Reporting

Royalty Reporting New Royalty Reporting Framework

Set Up Agency Category Code and Code Values

Royalty Reporting

18.6 Set Up Code and Generic Values Dated 

Use

You can use this transaction to do one of the following:

● Maintain cross references between an agency lease number and RRC lease data.

Note
Maintaining this type of cross reference is necessary for processing non-operated properties in order to 
meet GLO reporting requirements which specify that multiple RRC numbers be displayed in a report for 
an agency lease.

RRC numbers are captured in the Production application component for wells, but the PRA system 
processes this data separately from the data for non-operated properties.

● Maintain report-specific data to become effective in the system on a particular date

Procedure

1. From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Production, 
Tax and Royalty Reporting Royalty Reporting New Royalty Reporting Framework Setup Code and 
Generic Values Dated  .

2. Enter data as required. Then choose Create .

Note
In order to maintain multiple sets of RRC data for a single agency lease, you assign a different sequence 
number to each set of RRC data.

3. In the Description field, enter the RRC data. Then complete the Effective To field.
Use commas to separate the district code, the oil RRC, the gas RRC, and the field name data that you enter 
in the Description field. An example entry is: 01,456777,57778,FIELDNAME .
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4. Save your entries.

18.7 Migrate Royalty Master Data 

Use

Use this transaction to migrate royalty master data (including lease, lease allocation factor, and related 
property/division of interest/well/well completion data) from the old reporting framework to the new reporting 
framework.

Procedure

From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production, Tax and 
Royalty Reporting → Royalty Reporting → New Royalty Reporting Framework → Migration → Migrate Royalty 
Master Data

The Master table migration from old to generic royalty reporting tables screen appears.

Enter data as required.

When the DEL_LSE indicator is set, the system deletes contents of the lease table before populating with the 
migrated data. When this indicator is not set, the data for the lease is updated, or added if the lease is new.

Choose Execute .

Result

The data is migrated from the old royalty reporting framework to the new royalty reporting framework.

To review and adjust the migrated data as required, use the Master Maintenance [page 546] transaction.

18.8 Migrate Royalty Transaction Data 

Use

Use this transaction to migrate royalty transaction data (including gross volume, gross value, royalty division 
order, and exemption data) from the old reporting framework to the new reporting framework.
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Procedure

From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production, Tax and 
Royalty Reporting → Royalty Reporting → New Royalty Reporting Framework → Migration → Migrate Royalty 
Transaction Data

The History table migration from old to generic royalty reporting tables screen appears.

Enter data as required.

To upload data from an external flat file, complete the following fields as required:

In the Royalty file field, enter the name of the external flat file with royalty data.

In the Volume field, enter the name of the external flat file with production data.

Choose Execute .

Result

The data is migrated from the old royalty reporting framework to the new royalty reporting framework.

To review and adjust the migrated data as required, use the Master Migration [page 546] transaction.

18.9 Using the Report Driver for PRA Reporting 

Use

Use the Report Driver to submit tax, royalty, and regulatory (production) reports in Production & Revenue 
Accounting.

The Report Driver is a centralized, standardized tool that is used for most of the tax, royalty, and production 
reports in Production & Revenue Accounting. With a few exceptions (such as OK Royalty and MMS Production), 
almost all of the tax, royalty, and production reports used in PRA use it. Due to the fact that the Report Driver is 
a centralized tool, it means that you do not have to use many different individual report transactions to create 
reports in the ERP system.

The core of the Report Driver is a report generation tool, which pulls data together from various tables into a 
single report.
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The following lists which reports the Report Driver is used for, and which reports it is not used for, by reporting 
area:

Table 141:

Reporting area in PRA: The Report Driver is used for: The Report Driver is not used for:

Tax reporting All states, all reports. ---

Royalty reporting The Generalized State Report, Texas re­
ports, New Mexico reports. All state re­
ports except those listed at right.

MMS, Oklahoma, Wyoming.

Regulatory (production) reporting Texas reports (Texas P1, P2, P1B). MMS, New Mexico, Louisiana reports, 
Wyoming.

If you want to see a full list of all the reports that the Report Driver can be used with, you can look at the drop-
down list box for the Reg.Report field on the Report Execution (Report Driver) screen. The drop-down list box 
contains all the reports.

Each time you run the Report Driver, the following are produced:

A main report, and

An error report.

The main report is stored in the database, and temporarily-required information like the error reports is stored 
in the file system. You can view each individual dataset, and print it out, or download it and send it to the 
relevant governmental reporting authority.

Procedure

From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Production, Tax and 
Royalty Reporting …

Table 142:

For Tax reporting: (follow the path listed directly above and then choose)… Tax 
Reporting Old Tax Reporting Submit Tax Reports .

For Royalty reporting: … Royalty Reporting Old Royalty Reporting Submit Royalty 
Reports

For Regulatory (production) reporting: … Production Regulatory Reporting Old Regulatory Reporting 
Submit Production Regulatory Reports

The transaction code for the Report Driver is O3UH_REPEX. If you want to centrally access the Report Driver, 
you can use that transaction to do so.

The Report Execution screen is displayed.
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The first field on that screen – the Reg.Report field – contains the names of reports that you can choose from. 
Select the report that you would like to submit. The input fields on the Report Execution screen will change 
dynamically, based on what report you select.

The reports that are displayed in the matchcode ID dropdown box for the Reg . Report field are based on the 
user-assigned authorizations, which can be given using authorization object O_OIUH_REP based on the 
reporting type (tax, royalty or production), state, company code (org.level) or individual report (JIL).

Enter the reporting month and year for the report, as well as any other relevant parameters (company code, 
etc.). Also enter whether you want the report run to be a trial run or a final run (a trial run is like creating the 
report as a draft version).

Select New Report Execution (the Create icon).

A pre-execution screen is now displayed.

On that screen, select Execute Report . Selecting Execute generates the report for the data you entered, and 
generates the report files – it pulls all the relevant data together (from the relevant tables) for the report that 
you chose. You can now view that data in the Report Executions ALV screen area at the bottom of the screen.

The status of the report execution is displayed in the status field of the list at the bottom of the screen.

The following statuses exist:

Table 143:

10 Report generation scheduled

11 Report generation running

12 Report generation completed

13 Report generation failed

14 Report generation rescheduled

15 Report generation outdated (reallocation)

20 Report finalization scheduled

21 Report finalization running

22 Report finalization completed

23 Report finalization failed

24 Report finalization rescheduled

You can update the list of report runs and also the current status. To do that, select the List button.

From the list of report files in the ALV list at the bottom of the screen, you can double click on one item in the 
line.
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To display the job log, double click on a job name or number.

To access the Report Results screen, double click on any field other than the job name or number. The Report 
Results screen displays all of the files for the report.

To view the Detail Report, double click an individual line entry. The Detail Report is the information that you will 
be supplying to the government agency, or a supplemental report.

If the file name column is empty, it means that that dataset is saved in the database. Not all of the files that 
appear in the file name column will be files that will be reported to the government. All intermediate or empty 
files created by each run are automatically deleted by the system at the end of the run.

Regeneration:

If a specific report has already been generated, and you want to generate it again, you can regenerate it. To do 
that, on the Report Execution screen, select Regenerate Report .

Report finalization:

You can only finalize a report once. After you have finalized a report, it is not possible to carry out another 
finalization for the same report month/year/company and amended/current. You can, however, amend reports.

18.10  Form MMS-2014 

Definition

Form MMS-2014 is the “Report of Sales and Royalty Remittance” and is used to report and document royalties 
(revenues) and other obligations due on Federal and Indian oil and gas leases, as well as on geothermal leases.

It is also used to document the details of royalty payments and sales of minerals from leases on Federal and 
Indian lands. The report is filled out by the “payor” (the oil and gas company that operates the lease) and sent 
to the Minerals Management Service (MMS) – Minerals Revenue Management program of the U.S. Department 
of the Interior. The Minerals Revenue Management program (MRM) receives and processes the payments 
through a financial accounting system of the MRM, using information reported on Form MMS-2014 by the 
payor.

The MMS is responsible for collecting, accounting for, and disbursing revenues on minerals produced from 
Federal and Indian lands. The Minerals Revenue Management (MRM) program – a program within MMS – 
receives and processes those payments through a financial accounting system, using the information reported 
on the MMS 2014 form. Proper reporting allows the MMS to disburse revenues in a timely manner and allows 
businesses to reduce costly follow-up efforts and the possibility of assessment actions.

The data and process flow for MMS-2014 within the ERP system

SAP Oil & Gas (PRA - Production and Revenue Accounting)
Royalty Reporting C U S T O M E R 557



Table 144:

Source data - extraction

tables

Report generation Report finalization

PRA General Ledger

Owner Payable Subledger

Statistical Subledger

Tax tables

Report generation with MMS-2014 
(transforms the extraction data into an 
MMS-level report)

MMS-2014 ASCII file creation

JE interface file creation

The main source of information and instructions on how to fill out and use the MMS-2014 is the Minerals 
Revenue Handbook. The Handbook is published by the MMS. You can either obtain a paper copy, or access it 
on the MMS website.

The MMS also has a CD version of the Handbook, which you can obtain. The Minerals Revenue Handbook 
contains the most up-to-date information on MMS reporting, as well as examples on how to complete Form 
MMS-2014.

As the payor (owner, operator), you have to pay royalties to the U.S. federal government for product sold or 
removed from a lease on federal, Indian, or offshore leases.

For onshore leases, the royalty rate normally ranges from 12 % - 33 %.

For offshore leases, the royalty rate normally ranges from 16 % to 65 %.

In general, the MMS-2014 royalty calculation is as follows:

Table 145:

Sales volume x price x royalty rate = royalty value

Note
In some circumstances, a sliding scale exists, meaning that the royalty rate that you have to pay fluctuates 
with the volume produced. Refer to the Minerals Revenue Handbook for more information on that.

Master data for the Form MMS-2014 is critical for the accuracy of data transmitted to the MMS. The MMS-2014 
royalty payment calculation relies on the precision and integrity of the master data. Therefore, it is important to 
understand the potential consequences of maintaining inaccurate master data. Changes to master data could 
reflect adjustments or corrections to previously reported MMS-2014 data. The concept of date effective 
records drives the master data record dependency and controls the generation of prior period adjustments 
(PPAs). Depending on the method used to change or update MMS-2014 master data record changes will 
control the creation of PPA reversal and rebooking records.

What you report to the MMS on

Lease production – it is a requirement of the MMS that you report all production produced, removed from, or 
allocated to lease premises. You have to pay on 100% of lease production.

When the Form MMS-2014 is required
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You will have to submit a Form MMS-2014 if you assume responsibility for reporting and paying (one or more 
of) the following:

Royalties on production from Federal or Indian leases and agreements

● Rent or minimum royalty
● Royalties on the sale or test production from the initial lease well before the lease is classified as capable of 

producing
● Fees on a gas storage agreement
● Royalties on compensatory royalty agreements or assessments against Federal or Indian lands.
● Well fees, if stated in the lease terms
● All other situations, as listed in the Minerals Revenue Handbook.

Leases that are reported and paid to MMS

Table 146:

Federal leases

Royalty Royalty is any part of oil, gas, and geothermal resources or 
their cash value paid by a lessee to a lessor and/or parties 
acquiring possession of royalty rights based on a certain 
percentage of production from the property.

Are based on 100 % of production. Can be either actual or 
allocated production.Can be unit participating areas or com­
munitization agreements.

Minimum royalty An amount per acre. Royalties count toward fulfilling an obli­
gation; it is due on of before the last day of the lease year.

Rent An amount per acre. It is usually recoupable on Indian 
leases. It is due on the anniversary of the lease.

Indian leases

Producing (royalty/advance rental)

Non-producing committed to producing agreements (rent)

Indian leases not reported to MMS: See the Minerals Revenue Reporter Handbook for a full list of Indian leases 
that do not have to be reported to the MMS.

Table 147:

“What is a lease-level transaction ? “

A lease-level transaction is, according to the MMS, “An obligation that is reported against the lease rather than against a 
specific product or sales type”.

In the PRA system, within MMS-2014 reporting, you can either report based on lease, or based on well completion, or prod­
uct or sales type.
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Note
Form MMS-2014 has been streamlined by the MMS as ofOctober 1, 2001

Reporting levels

You can carry out Form MMS-2014 reporting at one of three levels:

● Venture level – reporting is for the entire venture/lease
● Well completion level – reporting is based on the production of specific well completions
● Both venture and well completion level – reporting is based on both venture and well completion level

Before you actually carry out the reporting in the SAP system, you have to first decide what reporting level you 
are going to use.

When to file

Forms MMS-2014 and related payments are due at the MMS by 4 p.m. mountain time (the MMS is located in 
Denver) on or before the last day of the month following the month the product was sold or removed from the 
lease, unless lease terms state that royalties are due otherwise. In other words, if the production takes place in 
July 2001, the Form MMS-2014 for that production month is due on or beforeAugust 31, 2001. Royalty 
payments are due the next business day following a weekend or Federal holiday. Minimum royalty is due the 
last day of the lease year. (Please always refer to the Minerals Revenue Reporter Handbook for complete details 
on when to file).

Reporting format

The MMS now prefers that reporters (payors) report Form MMS-2014 electronically (See the latest version of 
the Minerals Revenue Reporter Handbook) . If you are not required to report electronically – which is a rare 
exception, you can print copies of Form MMS-2014 from the MMS website (www.mrm.mms.gov/
reportingservices/forms/forms.htm), fill them out, and send them to the MMS (see below for the address to 
send the Report to). The MMS requires that paper copies conform to the format: 8.5 inches long by 14 inches 
wide.

In some circumstances, you can combine multiple electronic reports as one document. However, the MMS 
does not allow paper and electronic documents to be combined as one document. (See the Minerals Revenue 
Reporter Handbook for more details on that).

Payment methods

Payment methods are summarized on the Form MMS-2014 in the Report Control Block at the bottom of the 
Form.

The following payment types exist

Table 148:

Check to MMS Checks and payments must include a payor code and PAD 
number (payor-assigned document number). The payor 
code and the PAD number that appear on the actual pay­
ment (check) must be the same as the payor code and PAD 
that are in the SAP system for that transaction.
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Indian direct pay Direct payment to an Indian tribe by the payor.

EFT payments Electronic funds transfer

Royalty-in-Kind An arrangement in which the lessor (government, MMS) re­
ceives royalties in the form of production (oil or gas) instead 
of dollars.

Checks to MMS for BIA (BIA = Bureau of Indian Affairs)

Other

Indian lockbox Payments directly to the bank account of an Indian tribe.

Paper filing:

● MMS now prefers electronic filing and discourages paper filing. However, if you want to file the MMS-2014 
as a paper copy to the MMS, you have to first obtain express permission from the MMS (by phone) before 
you file. After obtaining permission, send the paper copy of the form to:

Minerals Management Service

Royalty Management Program

P.O. Box5810

Denver, Colorado 80217-5810

Electronic filing:

Electronic reporting options

Refer to the Minerals Revenue Reporter Handbook for the full details on how to electronically report.

The options are as follows:

1. Internet filing (Web form) – You complete Form MMS-2014 residing on the Internet and submit reports 
directly to Peregrine’s secure Web site

2. “Pro client” – You use software provided by e-commerce provider Peregrine Systems – Peregrine provides 
a software package to reporters who then import ASCII or CSV file formats into the software and, upon 
completion, access the Internet and send the file(s) directly to Peregrine.

3. EDI – You send an X12 EDI file to Peregrine – Reporters submit monthly Form MMS-2014 to the MMS using 
a value-added network (VAN)

The company that submits the payment must also submit a Form MMS-2014.

The Form MMS-2014 must have a matching payment. The payment total and the form MMS-2014 total must 
match.

Takes and entitlements

There are two methods used for reporting sales for Federal and Indian leases – “takes”, and “entitlements”.

● Takes– You report and pay royalties based on the actual volume of production sold or removed from the 
lease or from the lease-agreement combination.
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To calculate the sales volume, multiply the total production sold or removed from the lease by the Federal 
and/or Indian mineral ownership interest in the lease.

Total production volume x Fed./Indian mineral ownership = sales volume

Interest

● Entitlements– You report and pay royalties based on the volume of production sold or removed from the 
agreement allocated to your lease under the approved allocation schedule. To calculate the sales volume, 
multiply the total agreement production sold or removed from the lease by:

The tract percentage of the lease

The federal and/or Indian mineral ownership interest in the lease, and

Your company’s working interest percentage in the lease

Total agreement x tract percent x Fed./Indian mineral x company = sales volume

production volume ownership interest working int.

● For full and complete information on how to complete and submit the form, please refer to The Oil and Gas 
Payor Handbook (the handbook is revised often !).

Deductions

Before a payment is made to the MMS, deductions from the royalty due amount can be taken out of the royalty 
due amount, in order to reflect costs that the payor incurs related to the transaction. There are two types of 
deductions available for MMS-2014: transportation deductions, and processing deductions.

Transportation allowance deduction= A deduction from royalty due for the reasonable, actual costs of 
transporting production amounts from the lease to a sales point or point of value determination off the lease 
(MMS encourages you to report your transportation allowance as part of your royalty due transaction, rather 
than a separate line of reporting).

Processing allowance deduction= A deduction from royalty due for the reasonable, actual costs of extracting 
and recovering gas plant products from a gas stream (MMS encourages you to report your processing 
allowance as part of your royalty due transaction, rather than a separate line of reporting).

Royalty Value Less Allowances = The royalty value after you deduct transportation and/or processing 
allowances.

Note:

It is now an MMS requirement that you report transportation and processing allowances.

“Net royalty” is royalty minus the deductions (such as allowances).

Form MMS-2014 Confirmation Report

This report is available to payors once all Form MMS-2014 rejected lines are corrected. MMS provides the 
confirmation report through the MMS website. The report displays lines as reported by the payor and as 
corrected by MMS. You can use the confirmation report to make adjustments on future reports.

Recoupment–

Recoupment is needed if, for example, you have reported too much to the MMS, and would like to get that 
amount back (recoup that amount). A recoupment is an adjustment on Form MMS-2014 that results in a net 
negative total for the transaction. The credit is recovered from the balance of the document. It is the fastest 
and most cost-effective way to correct an overpayment.

562 C U S T O M E R
SAP Oil & Gas (PRA - Production and Revenue Accounting)

Royalty Reporting 



Refund–

A refund is a payment made by MMS to a payor. MMS prefers overpayments to be recouped against revenue on 
Form MMS-2014. Otherwise, notify MMS by telephone, fax, or in writing of a refund request. Include the 
following:

An explanation of how the overpayment occurred

Request for a specific amount

Taxpayer identification or social security number

Correcting Form MMS-2014 or copy of check

In most cases, MMS will send your refund electronically. Include the following:

Payor name

Bank name, city, and state

Nine-digit American Banking Association (ABA) number

Bank account number and account type ( c – checking, or s – savings)

Taxpayer identification or social security number

Integration

MMS-2014 has specific customizing activities within the IMG. Within each activity, specific table entries have to 
exist to maintain MMS-2014 master data and to generate the MMS-2014 report.

To access this area, in the IMG, choose SAP Reference IMG Industry Solution Oil & Gas (PRA) Production, Tax 
and Regulatory Reporting Royalty Reporting MMS-2014 , and then choose the activities under that:

Table 149:

IMG activity: Description of what to do in this activity:

Maintain Indian Tribes In this activity, you set up the Indian tribes that will be used 
in MMS-2014 Reporting. Specifically, you enter the code for 
each tribe, along with a text description of the Indian tribe.

PRA Material and MMS Product Code Cross-Reference In this activity, you enter materials which are already defined 
in your system (in Materials Management), and which are 
relevant for MMS Reporting.

This table represents a cross-reference between the PRA 
material and the MMS product code, and is maintained after 
all PRA materials have been defined. This is only used for 
validity checks. There are scenarios in which one material 
can be mapped to multiple product codes and vice versa.
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Maintain System Number Range Intervals for MMS-2014 
Processing

In this activity, you can set up the system number range in­
tervals. You maintain the number range objects for the fol­
lowing: lease PPA record number, payor property cross-ref­
erence PPA record number, payor well completion cross ref­
erence PPA record number, Lease record number, payor 
property cross-reference record number, payor well comple­
tion cross-reference record number.

Maintain Supplemental Reports In this step, you enter a custom or SAP-delivered report pro­
gram and a variant, by MMS-2014 component step. The en­
tries in this table will be defaulted in the supplemental re­
ports dialog box, when the respective component step is 
executed. Even with the dialog box, you can override the var­
iant field or leave it blank. The dialog box that appears when 
executing each component step also allows you to enter 
custom or SAP-delivered report programs with variants.

Transport Supplemental Report Variants In this activity, you create a transport request for report pro­
gram variants. This is necessary, because the previous IMG 
activity ‘Maintain Supplemental Report’ could contain a var­
iant that you want the report program (custom or SAP-deliv­
ered) to execute with, must be maintained in your SAP de­
velopment environment to be transported to your SAP pro­
duction environment. This allows you to create the variant in 
your SAP development environment, for testing, then main­
tain the IMG activity, Main Supplemental Reports, with your 
new variant, then transport the IMG table entries and your 
new variant to your production system.

Example

Example A:

MMS lease number = 054 007777-0

Sales month = October, 2001

Product = Oil

Product code = 01

Product amount sold = 999 bbl of oil

Price = $ 22/bbl.

Royalty rate = 12.5 %

Payment method = Check to MMS
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Royalty value calculation:

18.10.1  Using Form MMS-2014 

Use

Use this to carry out Form MMS-2014 reporting.

You can use this transaction to do the following:

Set up master data for MMS-2014 reporting

Create the MMS-2014 report

Query MMS-2014 reports that have already been created

For more information on Form MMS-2014, see Form MMS-2014 [page 557]

Before you create the MMS-2014, it is necessary to set up the master data for it.

Procedure

1. From the SAP Easy Access Menu, choose Logistics Production and Revenue Accounting Production, Tax and 
Royalty Reporting Royalty Reporting MMS MMS-2014 Workplace.

The MMS-2014 Workplace screen appears.

Setting up master data for MMS-2014 Reporting

First decide whether you will be reporting your MMS-2014 data at venture or at well completion level, and 
based on that, proceed by following the relevant option below.

Master Data / Well Completion screen tab

Use this if you are reporting MMS-2014 data at the well/well completion level.

From the SAP Easy Access Menu, choose Logistics Production and Revenue Accounting Production , Tax and 
Royalty Reporting Royalty Reporting MMS MMS-2014 Workplace .

Select the Master Data/ Well Completion screen tab. This is where you choose what tables you will be saving 
master data to for MMS-2014 reporting. Select Setup . In the Data Type field, select what type of master data 
record you would like to set up (for a description of each one, see the table above).
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Select the Payor/Well completion screen tab. This sets up a cross-reference between payor and well 
completion. Enter the relevant data, and then select Create . You can now enter the data for your record. You 
have to enter a payor and a record type. Choose Save .

Alternately, you can maintain (change, delete) payor/well completion records that already exist in the database. 
To do that, on the Payor/well completion screen tab, enter a well and well completion, and then select Execute . 
The system will display a list of records corresponding to your query. From there, you can use change mode to 
change the record.

Select the Lease/Well Completion screen tab. The table behind this functionality stores lease detail data 
specific to a lease and/or agreement. Each lease record must be associated with at least one payor / well 
completion record. Either create a record or use the query function to display a list of records, which you can 
then modify (as described above).

Set up the sales types for the well completions. The sales type defines what type of product transaction is 
being reported.

The table behind this functionality stores the sales type detail data for specific PRA / MMS products for a 
contract involved in a lease. Note: the same key sales type records cannot overlap effective date ranges.

To create records of this type, select the Sales Type/Well Completion screen tab. Enter the relevant data (as 
with the processes above, you can either directly create a record, or you can display a list of records and then 
modify records from the list).

18.10.2  Using the MMS-2014 Extraction Rejects Report 

Use

Use this after you have extracted data as part of the MMS-2014 reporting process to view a list of rejected 
extraction data, based on selection criteria that you enter.

The table that this report queries will only return a list if rejects occurred. When rejects occur, a table is 
populated with the reject data, and you can use this transaction to query that table. The report allows you to 
define a number of selection criteria for your query.

Procedure

1. From the SAP Easy Access Menu, choose Logistics → Production and Revenue Accounting → Production, Tax 
and Royalty Reporting → Royalty Reporting → MMS → Reports → MMS Extraction Rejects Report .

The MMS 2014 Reports – Extraction Reject Report screen appears.
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1. Enter the relevant data for your search.
Select Execute .

Result

The system produces a list of rejected extraction records.

18.10.3  Using the MMS-2014 Historic Extract Transaction 
Report

Use

Use this to run a report that displays the historic data that was extracted at a PRA Revenue accounting level as 
part of the MMS-2014 reporting process.

Procedure

● From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production, 
Tax, and Royalty Reporting → Royalty Reporting → MMS → Reports → MMS Historic Extract Trans Report .

The MMS–2014 Reports – Royalty Historic Transactions screen is displayed.

1. Enter the relevant criteria for your search.
2. Select Execute .

A list of historic data is displayed for the MMS-2014 report.

18.10.4  Using the MMS-2014 Indian Recoupment Report 

Use

Use this to query a table that contains the balances that Indian tribes owe your company, as part of MMS-2014 
reporting.

An overpayment situation might arise, for example, if you had overpaid an Indian tribe as part of MMS-2014 
reporting. During report finalization in MMS-2014 processing, the system updates Indian recoupable balances, 
which is the table that is queried here.
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Procedure

1. From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production, Tax 
and Royalty Reporting → Royalty Reporting → MMS → Reports → MMS Indian Recoupments Report .

2. Enter the relevant data for your search.
3. Select Execute .

The report runs and produces a list of Indian recoupables.

18.10.5  Using the MMS-Level Pending Royalty Trans. Report 

Use

Use this to run a query of the data that was in the report generation process, which is the second step in MMS-
report processing:

Data Extraction

Report Generation

Report Finalization

“Pending” means that the data is not yet finalized.

Procedure

From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Production, Tax and 
Royalty Reporting Royalty Reporting MMS Reports MMS Level Pending Royalty Trans Report

The MMS-2014 Reports – Pending MMS Transactions screen is displayed.

Enter the relevant search criteria for your search.

Select Execute .

A list is displayed of the data in the Report Generation step.
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18.10.6  Using the MMS-Level Historic Royalty Transactions 
Report 

Use

Use this to run a query on the data that is in finalized (“historic”) form – as opposed to “pending” form - within 
the MMS-2014 report process.

That is the data in the third step of MMS-2014 reporting:

Data extraction

Report generation

Report finalization

Procedure

From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Production, Tax and 
Royalty Reporting Royalty Reporting MMS Reports MMS Level Historic Trans Report

The MMS-2014 Reports – MMS Historic Transactions screen is displayed.

Enter the relevant search criteria.

Select Execute .

A list of the finalized – historic data is displayed for the report.

18.10.7  Creating a Printable MMS-2014 Form Upon 
Finalization 

Use

Use this to create a printed paper MMS-2014 Form after data finalization is complete.

This is usually carried out as the last step in MMS-2014 processing, and only after the report has been finalized. 
You can use this to print out the data as a SMART form.

The MMS agency does not generally accept printed paper MMS-2014 Reports anymore, but expects the 
reports to be sent in electronically. However, there are situations in which you would want to create a paper 
form, for example, if you are requested to send a paper form to an Indian owner.
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Procedure

From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Production, Tax and 
Royalty Reporting Royalty Reporting MMS Reports MMS Printable 2014 Form – Upon Final .

The Printable 2014 Form – Upon Finalization screen is displayed.

Enter the company code and the reporting sales year and month.

Select Execute .

The system displays the report data based on your search. You can create a SMART form and a paper form 
based on that.
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19 Tax Reporting 

Purpose

Based on a variety of data, such as company code and month, that a user specifies in a tax or royalty report 
transaction, the system determines the amounts of royalty and/or tax payments due for particular properties.

The company code and the month are essential for the system to determine the amounts of payments because 
the company code specifies particular properties while the month specifies for which period the payments are 
due for those properties.

Integration

The Tax Reporting application component utilizes the following integration.

● Take-in-kind data from Contractual Allocation
● Taxes payable subledger generated by Revenue Distribution
● Production data

Features

Reporting features include the following:

Trial Reports

If you need to execute a trial report, you can execute a report as often as required in order to extract data from 
the system again.You can execute both current and amended reports on a trial basis.

Prior Period Adjustments

The system includes any relevant prior period adjustments (PPA) when calculating amounts that are due.You 
can produce an amended report when PPAs result from (1) volumes or values that were reported incorrectly, or 
(2) incorrect master data assignments, such as when a property is assigned to the wrong lease.

See also:
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19.1 Using the Report Driver for PRA Reporting 

Use

Use the Report Driver to submit tax, royalty, and regulatory (production) reports in Production & Revenue 
Accounting.

The Report Driver is a centralized, standardized tool that is used for most of the tax, royalty, and production 
reports in Production & Revenue Accounting. With a few exceptions (such as OK Royalty and MMS Production), 
almost all of the tax, royalty, and production reports used in PRA use it. Due to the fact that the Report Driver is 
a centralized tool, it means that you do not have to use many different individual report transactions to create 
reports in the ERP system.

The core of the Report Driver is a report generation tool, which pulls data together from various tables into a 
single report.

The following lists which reports the Report Driver is used for, and which reports it is not used for, by reporting 
area:

Table 150:

Reporting area in PRA: The Report Driver is used for: The Report Driver is not used for:

Tax reporting All states, all reports. ---

Royalty reporting The Generalized State Report, Texas re­
ports, New Mexico reports. All state re­
ports except those listed at right.

MMS, Oklahoma, Wyoming.

Regulatory (production) reporting Texas reports (Texas P1, P2, P1B). MMS, New Mexico, Louisiana reports, 
Wyoming.

If you want to see a full list of all the reports that the Report Driver can be used with, you can look at the drop-
down list box for the Reg.Report field on the Report Execution (Report Driver) screen. The drop-down list box 
contains all the reports.

Each time you run the Report Driver, the following are produced:

A main report, and

An error report.

The main report is stored in the database, and temporarily-required information like the error reports is stored 
in the file system. You can view each individual dataset, and print it out, or download it and send it to the 
relevant governmental reporting authority.
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Procedure

From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Production, Tax and 
Royalty Reporting …

Table 151:

For Tax reporting: (follow the path listed directly above and then choose)… Tax 
Reporting Old Tax Reporting Submit Tax Reports .

For Royalty reporting: … Royalty Reporting Old Royalty Reporting Submit Royalty 
Reports

For Regulatory (production) reporting: … Production Regulatory Reporting Old Regulatory Reporting 
Submit Production Regulatory Reports

The transaction code for the Report Driver is O3UH_REPEX. If you want to centrally access the Report Driver, 
you can use that transaction to do so.

The Report Execution screen is displayed.

The first field on that screen – the Reg.Report field – contains the names of reports that you can choose from. 
Select the report that you would like to submit. The input fields on the Report Execution screen will change 
dynamically, based on what report you select.

The reports that are displayed in the matchcode ID dropdown box for the Reg . Report field are based on the 
user-assigned authorizations, which can be given using authorization object O_OIUH_REP based on the 
reporting type (tax, royalty or production), state, company code (org.level) or individual report (JIL).

Enter the reporting month and year for the report, as well as any other relevant parameters (company code, 
etc.). Also enter whether you want the report run to be a trial run or a final run (a trial run is like creating the 
report as a draft version).

Select New Report Execution (the Create icon).

A pre-execution screen is now displayed.

On that screen, select Execute Report . Selecting Execute generates the report for the data you entered, and 
generates the report files – it pulls all the relevant data together (from the relevant tables) for the report that 
you chose. You can now view that data in the Report Executions ALV screen area at the bottom of the screen.

The status of the report execution is displayed in the status field of the list at the bottom of the screen.

The following statuses exist:

Table 152:

10 Report generation scheduled

11 Report generation running
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12 Report generation completed

13 Report generation failed

14 Report generation rescheduled

15 Report generation outdated (reallocation)

20 Report finalization scheduled

21 Report finalization running

22 Report finalization completed

23 Report finalization failed

24 Report finalization rescheduled

You can update the list of report runs and also the current status. To do that, select the List button.

From the list of report files in the ALV list at the bottom of the screen, you can double click on one item in the 
line.

To display the job log, double click on a job name or number.

To access the Report Results screen, double click on any field other than the job name or number. The Report 
Results screen displays all of the files for the report.

To view the Detail Report, double click an individual line entry. The Detail Report is the information that you will 
be supplying to the government agency, or a supplemental report.

If the file name column is empty, it means that that dataset is saved in the database. Not all of the files that 
appear in the file name column will be files that will be reported to the government. All intermediate or empty 
files created by each run are automatically deleted by the system at the end of the run.

Regeneration:

If a specific report has already been generated, and you want to generate it again, you can regenerate it. To do 
that, on the Report Execution screen, select Regenerate Report .

Report finalization:

You can only finalize a report once. After you have finalized a report, it is not possible to carry out another 
finalization for the same report month/year/company and amended/current. You can, however, amend reports.
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19.2 Creating or Maintaining a Tax & Royalty Profile 

Use

Use this transaction to specify the following information for tax and royalty reports:

● reporting entity identification numbers
● contact information for the individual representing the reporting company
● royalty owner information

Procedure

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Production, Tax 
and Royalty Reporting

Table 153:

Follow-on Menu Path Function

Tax Reporting Old Tax Reporting Master Maintenance

Tax and Royalty Profile

Tax Reporting

Royalty Reporting Old Royalty Reporting Master 

Maintenance Tax and Royalty Profile

Royalty Reporting

The Tax and Royalty Profile: Initial Screen appears.

Specify a report and its corresponding effective dates and contact information.Also enter the royalty owner 
information for the report.

Save the profile.

Using a Reference to Create a Tax & Royalty Profile

To create a tax and royalty profile with reference to an existing record, at the Tax and Royalty Profile: Initial 
Screen , enter data as required.Then choose Execute .

If more than one record matches the data you entered, select one of the records from the list.

OR

If only one record matches the data you entered, the single record is displayed.

Choose Create to create a new record with the data from the record you selected.

Changing or Displaying a Tax & Royalty Profile

To change or display a tax and royalty profile, at the Tax and Royalty Profile: Initial Screen , enter data as 
required.Then choose Execute .

If more than one record matches the data you entered, select one of the records from the list.
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OR

If only one record matches the data you entered, the single record is displayed.

Choose Change or Display to change or display the record as required.

19.3 Severance Tax Master File 

Definition

A record that enables state-assigned information to be linked with tax transaction data.

Use

Use the Severance Tax Master File transaction ( Logistics Production and Revenue Accounting
Production,Tax and Royalty Reporting Tax Reporting Old Tax Reporting Master Maintenance Severance 
Tax Master File  ) to create or maintain master data required for state tax reporting.

With the application you can establish master data for the following states:

● Kansas
● Louisiana
● New Mexico
● North Dakota
● Oklahoma
● Texas
● Wyoming

The system identifies transactions that do not have a corresponding tax master record and generates a report 
listing the transactions. The report is useful in identifying properties that have been added prior to the Tax and 
Royalty Reporting process.

Note
When retrieving lease master data in the Severance Tax Master File transaction, it is important to enter both 
the state and lease number to retrieve a full list of master data for a lease.
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19.4 Creating or Maintaining a Severance Tax Transaction 

Use

Use this transaction to create and maintain state tax information which will ultimately appear on state tax 
reports.The severance tax transactions are created in the Valuation application area based on raw volume data 
retrieved from the Production application.

Modifications made to this data will not change any of the source data, but changes are allowed here to 
facilitate printing accurate data on the tax reports.

Procedure

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Production, Tax 
and Royalty Reporting Tax Reporting Old Tax Reporting Master Maintenance Tax Transaction  .

The Severance Tax Transaction: Initial Screen appears.

Choose Create .

The Severance Tax Transaction - Create screen appears.

Enter data as required.

Save your entries.

Using a Reference to Create a Severance Tax Transaction

To create a severance tax transaction with reference to an existing record, at the Severance Tax Transaction: 
Initial Screen , enter data as required.Then choose Execute .

If more than one record matches the data you entered, select one of the records from the list.

● OR

● If only record matches the data you entered, the single record is displayed.

Choose Create to create a new record with the data from the record you selected.

Changing or Displaying a Severance Tax Transaction

To change or display a severance tax transaction, at the Severance Tax Transaction: Initial Screen , enter data as 
required.Then choose Execute.

If more than one record matches the data you entered, select one of the records from the list.

OR

If only one record matches the data you entered, the single record is displayed.

Choose Change or Display to change or display the record as required.
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19.5 Creating or Maintaining a Colorado Ad Valorem Record 

Use

Use this transaction to establish and maintain information for Colorado ad valorem tax reports.

Procedure

At the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Production, Tax 
and Royalty Reporting Tax Reporting Old Tax Reporting Master Maintenance Colorado Ad Valorem  .

The Colorado Ad Valorem: Initial Screen appears.

Choose Create .

The Colorado Ad Valorem - Create screen appears.

Enter data as required.

Save your entries.

Using a Reference to Create a Colorado Ad Valorem Record

To create a Colorado Ad Valorem record with reference to an existing record, at the Colorado Ad Valorem: Initial 
Screen , enter data as required.Then choose Execute .

If more than one record matches the data you entered, select one of the Colorado Ad Valorem records from the 
list.

OR

If only one record matches the data you entered, the single record is displayed.

Choose Create to create a new record with the data from the record you selected.

Changing or Displaying a Colorado Ad Valorem Record

To change or display a Colorado Ad Valorem record, at the Colorado Ad Valorem: Initial Screen , enter data as 
required.Then choose Execute .

If more than one record matches the data you entered, select one of the Colorado Ad Valorem records from the 
list.

OR

If only one record matches the data you entered, the single record is displayed.

Choose Change or Display to change or display the record as required.
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19.6 Agency Product Code to PRA Material Cross Reference 

Use

This cross reference links a reporting agency’s product code to a PRA material code.

The system uses the cross reference to summarize the royalties and taxes of multiple PRA material codes to 
the reporting agency product code. (Usually, multiple PRA material codes are cross referenced to a reporting 
agency product code.)

Activities

From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Production, Tax 
and Royalty Reporting  . Then choose one of the following:

Table 154:

Follow-on Menu Path Function

Royalty Reporting New Royalty Reporting Framework

Setup Agency Product Code and PRA Material X-ref

Royalty Reporting

Tax Reporting New Tax Reporting State Agency & 

PRA Material Xref

Tax Reporting

Note
In the Agency Prod Cd field, specify the agency product code, and in the Material field, specify the PRA 
material to be cross referenced to the agency product code.

19.7 Tax Reporting Master Maintenance 

Use

The Tax Reporting Master Maintenance transaction ( Logistics Production and Revenue Accounting
Production, Tax and Royalty Reporting Tax Reporting New Tax Reporting Tax reporting master 
maintenance  ) is a single transaction in which you can maintain the following master data for tax reporting:

● Production units (that is, leases)
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● Cross-references between production units and properties
● Federal, agency, and operator IDs
● A Smart Form to be used for a particular tax report

Note
When entering master data for tax reporting, you also enter the month and year on which the master 
data that you enter is to become effective.

Functions

The Tax Reporting Master Maintenance transaction comprises the following functions.

● Maintaining Production Units (Leases) for an Agency [page 580] – Used to create and maintain a list of 
production units (that is, leases) that are valid for a particular agency.

● Maintaining Production Unit (Lease) Data [page 581] – Used to maintain changes to lease attributes, 
such as the operator.

● Maintaining Links from Property Data to a Production Unit [page 582] - Used to link property data to the 
production unit.

● Maintaining Joint Venture/Well Data [page 583] - Used to enter data that corresponds with a particular 
joint venture/well combination, such as operator data or reference numbers.

● Maintaining Company-Dependent Attributes [page 584] – Used to maintain attributes (such as federal 
and agency IDs) for a particular company code.

● Maintaining Assignments of Smart Forms to Reports [page 585] – Used to assign a particular Smart 
Form to a tax report.

19.7.1  Maintaining Production Units (Leases) for an Agency 

Use

Use this function to define valid production units (that is, leases) for an agency.

Activities

Linking Production Unit IDs to an Agency

At the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Production, Tax and 
Royalty Reporting Tax Reporting New Tax Reporting Tax reporting master maintenance  .

The TAX REPORTING MASTER MAINTENANCE screen appears.

Choose the Prod. Unit – Master tab.
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In the Agency field, enter the agency for which you will create or maintain a list of valid production units.Then 
from the header area of the screen, choose Create .

From within the Prod. Unit – Master tab, choose Append row .

Enter the following data.

● In the Production Unit ID field, enter the ID of the production unit/lease that is valid for the agency you 
specified.

● In the description field, enter a description for the production unit/lease.
● Complete other fields as required.Then save your entries.

Displaying Production Units for an Agency

At the Prod. Unit – Master tab, enter the agency ID in the Agency field.

To display the production unit(s) for the agency, choose Execute .

19.7.2  Maintaining Production Unit (Lease) Data 

Use

Use this function to maintain and display changes to lease attributes, such as the operator.

Activities

Changing Lease Attributes

At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production, Tax and 
Royalty Reporting → Tax Reporting → New Tax Reporting → Tax reporting master maintenance

The TAX REPORTING MASTER MAINTENANCE screen appears.

At the Prod. Unit – Master tab, in the Agency field, enter the agency ID for which you will maintain lease 
attribute data.

Choose the Prod. Unit – Changes tab.

In the Reporting Parameters section of the screen, enter the reporting parameters, including the reporting year 
and the reporting month, which are the year and the month last used to generate a report for the parameters.

In the Effective from section of the screen, enter the year and the month in which the new data for the lease 
attribute(s) will become effective. Then from the header area of the screen, choose Create .

From within the Prod. Unit – Changes tab, choose Append row .

In the Production Unit ID field, enter the production unit ID that identifies the lease for which you will change the 
attribute(s). Then enter new data for the attribute(s) as required.
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To add a different set of product unit/lease attribute data, choose Append row . Continue to choose Append 
row as many times as required.

Save your entries.

Displaying Lease Attributes

Select the Prod. Unit – Changes tab. Then enter the reporting parameters, the effective from year, and the 
effective from month for which you want to review records.

To display any records that match the criteria that you entered, choose Execute .

19.7.3  Maintaining Links from Property Data to a Production 
Unit 

Use

Use this function to link property data to the production unit and to display the linked data.

Activities

Linking Property Data to a Production Unit

From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production, Tax and 
Royalty Reporting → Tax Reporting → New Tax Reporting → Tax reporting master maintenance

The TAX REPORTING MASTER MAINTENANCE screen appears.

At the Prod. Unit – Master tab, in the Agency field, enter the agency ID for which you will maintain the link from 
the property data to the production unit.

Choose the PUID Xref – Changes tab.

In the Reporting Parameters section of the screen, enter the reporting parameters, including the reporting year 
and month, which are the year and the month last used to generate a report for the parameters.

In the Effective from section of the screen, enter the year and month in which the property data will become 
effective for the production unit. Then from the header area of the screen, choose Create .

From within the PUID Xref – Changes tab, choose Append row .

An editable blank row appears in the tab.

Enter the property data (company, venture, division of interest, well, well completion) and the production unit 
ID to which the property data will be linked. Enter other data as required.

When entering the venture, division of interest, well, and well completion, include the leading zeroes so that the 
system retrieves the entities properly. (Entering leading zeroes is necessary because the system stores the 
leading zeroes for these entities in the database.)
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To link another set of property data to the production unit ID, choose Append row . Continue to choose Append 
row as many times as required.

Save your entries.

Displaying Property Data for a Production Unit

Select the PUID Xref – Changes tab. Then enter the reporting parameters, the effective from year, and the 
effective from month for which you want to review records.

To display any records that match the criteria that you entered, choose Execute .

19.7.4  Maintaining Joint Venture/Well Data 

Use

Use this function to enter and display data that corresponds with a particular joint venture/well combination, 
such as operator data or reference numbers.

Activities

Changing Joint Venture/Well Data

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Production, Tax and 
Royalty Reporting → Tax Reporting → New Tax Reporting → Tax reporting master maintenance.

The TAX REPORTING MASTER MAINTENANCE screen appears.

At the Prod. Unit – Master tab, in the Agency field, enter the agency ID for which you will maintain data for the 
joint venture and well.

Choose the JV/Well - Changes tab.

In the Reporting Parameters section of the screen, enter the reporting parameters, including the reporting year 
and month, which are the year and month last used to generate a report for the parameters.

In the Effective from section of the screen, enter the year and the month in which the data will become effective 
for the joint venture/well combination. Then from the header area of the screen, choose Create .

From within the JV/Well – Changes tab, choose Append row .

An editable blank row appears in the tab.

Enter the company code, venture, division of interest, and well data. Then enter the operator and reference 
numbers, or other applicable data, in order to link it to the venture/well combination.
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To link another set of data to the venture/well combination, choose Append row . Continue to choose Append 
row as many times as required.

Save your entries.

Displaying Joint Venture/Well Data

Select the JV/Well – Changes tab. Then enter the reporting parameters, the effective from year, and the 
effective from month for which you want to review records.

To display any records that match the criteria that you entered, choose Execute .

19.7.5  Maintaining Company-Dependent Attributes 

Use

Use this function to maintain attributes such as federal and agency IDs for a particular company code.

Federal and agency IDs may need to be maintained, for example, when companies merge.

Activities

Entering Attributes

At the SAP Easy Access screen, choose Logistics → Production and Revenue Accounting → Production, Tax and 
Royalty Reporting → Tax Reporting → New Tax Reporting → Tax reporting master maintenance.

The TAX REPORTING MASTER MAINTENANCE screen appears.

At the Prod. Unit – Master tab, in the Agency field, enter the relevant agency ID.

Choose the RSG – Changes tab.

In the Reporting Parameters section of the screen, enter the reporting parameters, including the reporting year 
and the reporting month, which are the year and month last used to generate a report for the parameters.

In the Effective from section of the screen, enter the year and the month in which the data will become effective 
for the agency ID changes. Then from the header area of the screen, choose Create .

From within the RSG – Changes tab, choose Append row .

An editable blank row appears in the tab.

Enter the company and attributes such as the federal and/or agency ID data as required.

To enter another set of data, choose Append row . Continue to choose Append row as many times as required.

Save your entries.

Displaying Federal and Agency IDs
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Select the RSG – Changes tab. Then enter the reporting parameters, the effective from year, and the effective 
from month for which you want to review records for federal and agency IDs.

To display any records that match the criteria that you entered, choose Execute .

 

19.7.6  Maintaining Assignments of SmartForms to Reports 

Use

Use this function to assign a particular SmartForm to a tax report and to display the assignments. The system 
determines which SmartForm to use when generating the report based on the assignment.

Activities

Assigning a SmartForm to a Report

At the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production, Tax and 
Royalty Reporting → Tax Reporting → New Tax Reporting → Tax reporting master maintenance

The TAX REPORTING MASTER MAINTENANCE screen appears.

At the Prod. Unit – Master tab, in the Agency field, enter the agency ID for which you will assign a SmartForm to 
a report.

Choose the Lgl. Rpts – Changes tab.

In the Reporting Parameters section of the screen, enter the reporting parameters, including the reporting year 
and month, which are the year and month last used to generate a report for the parameters.

In the Effective From section of the screen, enter the year and the month in which the SmartForm assignment 
will become effective.

From within the Lgl. Rpt – Changes tab, choose Append row .

Enter the report ID and the corresponding SmartForm assignment, in addition to other required data.

To enter another SmartForm assignment, choose Append row . Continue to choose Append row as many times 
as required.

Save your entries.

Displaying SmartForm Assignments to Reports

Select the Lgl. Rpt – Changes tab. Then enter the reporting parameters, the effective from year, and the 
effective from month for which you want to review SmartForm assignments.

To display any records that match the criteria that you entered, choose Execute .
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19.8 Setting Up Agency Codes 

Use

For Tax Reporting, you use this transaction to set up override affiliation codes for New Mexico .

For Royalty Reporting, you can use this transaction to set up the following types of cross references:

● Field code and field name cross references for Louisiana reports – This cross reference allows a field name 
to be displayed in the report that is different from the field name maintained in the Production application 
component.

Note
The field names entered in this cross-reference override the field names entered at the Production 
application component.

● Purchaser tax ID and purchaser number cross references for Texas reports – This cross reference links a 
purchaser tax ID to a purchaser number; Texas requires that both the ID and the purchaser number be 
shown in the report.

Note
After you enter this type of cross reference, you must execute the Extraction and Reporting transaction 
in order for the royalty report processing to be successful.

● Purchaser tax ID and contract number – This cross reference is needed for Texas reports.

Activities

From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Production, Tax 
and Royalty Reporting  . Then choose one of the following options.

Table 155:

Follow-on menu path Function

Tax Reporting New Tax Reporting Set Up Agency 

Specific Cross References

Tax Reporting

Royalty Reporting New Royalty Reporting Framework

Set Up Agency Category Code and Code Values

Royalty Reporting
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19.9 Tax Reporting Adjustments 

Use

The Tax Reporting Adjustments transaction ( Logistics Production and Revenue Accounting Production, 
Tax and Royalty Reporting Tax Reporting New Tax Reporting Maintain Tax Reporting Adjustments  ) is a 
single transaction with which you can:

● Create manual adjustments to modify values from Valuation transactions, in order to make estimated 
payments to an agency

● Upload multiple adjustments
● Upload key values that the system can use as a basis to perform suspensions
● Remove a record from suspension

The Tax Reporting Adjustments transaction comprises the following functions.

● Creating Manual Tax Reporting Adjustments [page 587]
● Suspending a Tax Adjustment or Removing a Suspension [page 589]
● Uploading Key Values from a Local Drive for Suspension Purposes [page 590]
● Uploading Tax Adjustment Records from a Flat File [page 591]
● Processing Uploaded Records for Suspension [page 591]

19.9.1  Creating Manual Tax Reporting Adjustments 

Use

Use this transaction to modify values from Valuation transactions for reporting purposes in order to make 
estimated payments to an agency.

Whatever you enter here is posted in the system as an offsetting entry, in addition to the transactions posted 
by Valuation and Revenue Distribution.

Procedure

From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production, Tax and 
Royalty Reporting → Tax Reporting → New Tax Reporting → Maintain Tax Reporting Adjustments.

The Maintain Tax Reporting Adjustments screen appears.

Enter data as required.

In the RSG field, enter the company for which tax adjustments will be made.
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To limit the set of records that the system will retrieve, in the Adjustments selection criteria section, enter 
additional selection criteria.

To retrieve incremental values (that is, the difference between what was reported previously and the current 
values), select Net change only .

To retrieve suspended transactions, select Suspended only .

Choose Create .

The Tax Adjustments: Adjustments screen appears.

Enter data as required.

In the Sales Year/Month field, enter the sales month for which the adjustment is relevant.

In the Adj. type field, specify whether the adjustment is absolute, (which means that the existing transaction 
has not been reported) or a net change (which means that the transaction already has been reported).

In the Pur/Pro Ind field, specify whether you are reporting as a purchaser or as a producer.

If relevant for the transaction, enter the tax class/tier indicator and school district.

In the Aff Company Code field, specify the company affiliated to the operating company.

In the Adjustment details section, enter data as required.

In the Act st tx amt field, enter the amount to be paid to the state.

In the Act st tx reimb field, enter the amount to be reimbursed by the state.

To create a new adjustment by using an existing adjustment, select the row with the tax adjustment data to be 
copied. Then choose Create a record with reference to the selected record .

Save your entries.

See also:

Uploading Tax Adjustments Records from a Flat File [page 591]
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19.9.2  Suspending a Tax Adjustment or Removing a 
Suspension 

Use

Use this transaction either to suspend records or to remove records from suspension.

Procedure

From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production, Tax and 
Royalty Reporting → Tax Reporting → New Tax Reporting → Maintain Tax Reporting Adjustments

The Tax adjustments: Selection criteria screen appears.

Enter data as required.

In the RSG field, enter the company.

To limit the set of records that the system will retrieve, in the Adjustments selection criteria section, enter 
additional selection criteria.

To retrieve incremental values (that is, the difference between what was reported previously and the current 
values), select Net change only .

To retrieve suspended transactions, select Suspended only .

Choose Execute .

The Tax adjustments: Detail adjustments screen appears.

Do one of the following:

To suspend the record(s), select the row(s) with the required tax adjustment record(s) and then choose 
Suspend tax records .

To remove records from suspense, select the row(s) with the required tax adjustment record(s) and then 
choose Unsuspend tax records.
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19.9.3  Uploading Key Values from a Local Drive for 
Suspension Purposes 

Use

Use this function to upload key values (such as property, division of interest, sales month, and material) into a 
tax table. The system then uses the key values in the tax table as the basis for monthly suspension of records 
that match the key values.

Procedure

From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production, Tax and 
Royalty Reporting → Tax Reporting → New Tax Reporting → Maintain Tax Reporting Adjustments

The Tax Adjustments: Selection criteria screen appears.

Enter data as required.

In the RSG field, enter the company for which you will upload tax adjustment records.

To limit the data that the system will retrieve, in the Adjustments selection criteria section, enter additional 
selection criteria.

To retrieve incremental values (that is, the difference between what was reported previously and the current 
values), select Net change only .

To retrieve suspended transactions, select Suspended only .

Choose Mass upload records for suspension .

The Enter destination (Full pathname) screen appears.

Select the data to be uploaded.

Result

The key values are uploaded and available for suspension.

To suspend records, you must choose the Process suspense tab . For more information, see Processing 
Uploaded Records for Suspension [page 591] .
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19.9.4  Uploading Tax Adjustment Records from a Flat File 

Use

Use this function to upload tax adjustment records from a flat file on your local drive.

Procedure

From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production, Tax and 
Royalty Reporting → Tax Reporting → New Tax Reporting → Maintain Tax Reporting Adjustments

The Tax Adjustments: Selection criteria screen appears.

Enter data as required.

In the RSG field, enter the company for which you will upload tax adjustment records.

Choose Upload adjustments data .

19.9.5  Processing Uploaded Records for Suspension 

Use

Use this transaction to process records that have been uploaded for suspension.

Prerequisite

The records to be suspended have been uploaded with the Uploading Key Values from Local Drive for 
Suspension Purposes [page 590] transaction.

Procedure

From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production, Tax and 
Royalty Reporting → Tax Reporting → New Tax Reporting → Maintain Tax Reporting Adjustments

Enter data as required.
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In the RSG field, enter the company for which you uploaded the tax adjustment records to be suspended.

Choose Process suspense tab .

Result

The records that were uploaded for suspension with Uploading Key Values from Local Drive for Suspension 
Purposes transaction are suspended.

19.10  Exception Report for GL/TPSL Entries 

Use

Use this report to review any discrepancies that may have occurred between original Valuation transactions 
and offsetting journal entries.

To access the report, choose Logistics Production and Revenue Accounting Production, Tax and Royalty 
Reporting Tax Reporting New Tax Reporting Exception report for GL/TPSL entries.

19.11  Tax Reporting Processing 

Use

The Tax Reporting Main transaction is a single transaction in which you can:

● Review whether master data or adjustment data changes were made before beginning tax reporting 
processing

● Verify that lease data is set up properly for tax reporting processing
● Extract taxes and, as required, non-sales volumes
● Generate reports and create offsetting journal entries for a particular combination of reporting parameters

Activities

The primary activity that you carry out with the Tax Reporting Main transaction is the execution of the various 
steps required for tax reporting processing. The transaction allows you to review the status of the steps, and 
indicates what the next required step is. For more information, see Executing the Steps for Tax Reporting 
Processing [page 593] .
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Other activities include the following:

● Displaying Results [page 594] – Used to review processing results for tax reports.
● Displaying and Downloading Tax Reports [page 595] – Used to display and download reports.
● Displaying Log Details [page 596] - Used to review the results of a tax report processing step.
● Removing the Valuation Posting Lock [page 596] – Used to remove the lock on Valuation posting when a 

user does not want to complete all tax reporting steps at one time.
● Clean Up Tax Tables [page 597] – Used to remove unwanted tax records from tax tables in order to 

improve performance.

19.11.1  Executing the Steps for Tax Reporting Processing 

Use

Use this transaction to review how many tax report processing steps the system has completed and see what 
the next required step is.

The possible steps are:

Master change– Indicates whether a change to the master data was carried out. (Changes are entered with the 
Tax Reporting Master Maintenance [page 579] transaction.)

Adjustment– Indicates whether an adjustment to a Valuation transaction was carried out in order to make an 
estimated payment to an agency. (Adjustments are entered with the Tax Reporting Adjustments [page 587] 
transaction.)

Validation– The system verifies that there is a lease that is completely set up for the master data associated 
with the execution parameters that you specified.

Tax extract– The system retrieves tax data and sales volumes.

Volume extraction– If a state requires it, the system retrieves non-sales volumes (such as gross production 
volume, beginning stock, and lease fuel).

Report process– The system aggregates and distributes detail-level history data for volume and taxes.

Report finalization– The system completes the processing of the reporting parameters for the month and year 
that you specified and also creates offsetting journal entries.

Procedure

From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production, Tax and 
Royalty Reporting → Tax Reporting → New Tax Reporting → Tax Reporting Main

The Tax Processing and Reporting screen appears.

Enter data as required.
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In the RSG field, enter the company for the tax report.

Choose Display Status .

The system displays numbers in each column. The numbers represent the sequence in which the steps were 
executed.

An arrow displayed in the Next Action column indicates that additional steps need to be carried out to complete 
processing. For information about each step/column, see the descriptions in the above Use section.

If additional steps need to be carried out, select the arrow in the Next Action column to execute the step(s) 
through to Report Process .

After completing the Report Process step, verify that reporting results are ready for the final step ( Report 
Finalization ).

Before you execute the Report Finalization step, download or print reports as required by choosing List 
Reports .

You can execute report finalization only once for a particular combination of reporting parameters. Once you 
choose Report Finalization , the system considers the month of reporting complete and you can no longer 
extract or maintain master data for the parameters.

After you have verified that reporting results are ready for report finalization, execute the Report Finalization 
step.

19.11.2  Tax Reporting Processing Results 

Use

Use the Tax Reporting Main transaction ( Logistics Production and Revenue Accounting Production, Tax 
and Royalty Reporting Tax Reporting New Tax Reporting Tax Reporting Main  ) to review processing 
results for tax reports.

Activities

Choose Display Results .

Note
● In the RSG field, you enter the company for the tax report.
● To limit the number of records that the system retrieves, complete the Selection for Analysis and 

Reporting section.
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19.11.3  Displaying and Downloading Tax Reports 

Use

Use the Tax Reporting Main transaction ( Logistics Production and Revenue Accounting Production, Tax 
and Royalty Reporting Tax Reporting New Tax Reporting Tax Reporting Main  ) to display reports and 
download reports as required for a combination of execution parameters (including reporting year and month, 
company code, agency, and oil or gas report).

Activities

● Enter data as required and then choose List Reports to review the resulting list of reports that the system 
has generated.

Note
In the RSG field, enter the company for the tax report.

● To determine whether a report is current (C) or amended (A), review the C/A ind. column.

Note
The same report could be listed more than once if a prior period adjustment (PPA) affects the data, 
thereby requiring an amended report.

● To display a preview of the report, select the report that you would like to review and then choose Display . 
The report then appears in the Smart Form assigned to the report.

Note
When you choose Display , the system displays the report data in the Smart Form assigned to the 
report.

Note
SAP delivers each report with a default Smart Form assignment.

To change the default Smart Form assignment, use the Tax Reporting Master Maintenance transaction 
( Logistics Production and Revenue Accounting Production, Tax and Royalty Reporting Tax 
Reporting New Tax Reporting Tax reporting master maintenance)  . For details, see Maintaining 
Assignments of Smart Forms to Reports [page 585] .

● To download data into a file, select the report and choose Download .
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19.11.4  Displaying Log Details 

Use

Use this function, available within the Tax Reporting Main transaction ( Logistics Production and Revenue 
Accounting Production, Tax and Royalty Reporting Tax Reporting New Tax Reporting Tax Reporting 
Main  ), to review processing results of a tax reporting processing step.

Activities

After entering data as required and choosing Display Log , select the tax reporting processing step for which 
you would like to review results. Then choose Enter to review the messages and/or details of processing for the 
step.

19.11.5  Removing the Valuation Posting Lock 

Use

Use this function, available from the Tax Reporting Main transaction ( Logistics → Production and Revenue 
Accounting → Production, Tax and Royalty Reporting → Tax Reporting → New Tax Reporting → Tax Reporting 
Main ), to remove the report lock on Valuation posting.

(The lock automatically goes into effect when the tax reporting Validation step begins, and it prevents Valuation 
from posting until the tax reporting processing steps are complete. The system automatically releases the lock 
when tax reporting Finalization step is complete.)

Use this transaction only when you do not want to complete all tax reporting processing steps at one time.

Activities

After entering data as required, choose Processing → Delete Rpt Lock
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19.11.6  Clean Up Tax Tables 

Use

Use this function, available from the Tax Reporting Main transaction ( Logistics Production and Revenue 
Accounting Production, Tax and Royalty Reporting Tax Reporting New Tax Reporting Tax 
ReportingMain  ), to remove unwanted tax records from tax tables in order to improve performance.

Activities

After entering data as required, choose Processing Clean up tax tables  .

19.12  Migrate Tax Leases 

Use

Use this transaction to migrate lease data from the old tax reporting framework to the new tax reporting 
framework.

Prerequisites

The year and month for which the system will begin to retrieve data from the old tax reporting framework is 
specified in the SalesYYYYMMMM field within the Maintain Execution Parameters Customizing activity.

To access this activity, in Customizing, choose Industry Solution Oil & Gas (Production and Revenue 
Accounting) Production, Tax and Royalty Reporting Tax Reporting New Tax Reporting Framework
Maintain Execution Parameters  .

Procedure

At the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Production, Tax and 
Royalty Reporting Tax Reporting New Tax Reporting Migration Migrate Tax Leases  .

The Program ROIUX1_TAX_PUID_MIGR screen appears.

In the AGENCY field, enter the agency ID for which you will migrate tax lease data.
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Choose Execute .

Results

The data is migrated from the old reporting framework to the new tax reporting framework.

To review and adjust the migrated data as required, use the Tax Reporting Master Maintenance [page 579] 
transaction ( Logistics Production and Revenue Accounting Production, Tax and Royalty Reporting Tax 
Reporting New Tax Reporting Tax reporting master maintenance  ).

19.13  Migrate Tax Master Data 

Use

Use this transaction to migrate tax master data from the old tax reporting framework to the new tax reporting 
framework.Specifically, this transaction facilitates the migration of the cross-references between leases and 
properties.

Prerequisites

The year and month for which the system will begin to retrieve data from the old tax reporting framework is 
specified in the SalesYYYYMMMM field within the Maintain Execution Parameters Customizing activity.

To access this activity, in Customizing, choose Industry Solution Oil & Gas (Production and Revenue 
Accounting) Production, Tax and Royalty Reporting Tax Reporting New Tax Reporting Framework
Maintain Execution Parameters  .

Procedure

At the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Production, Tax and 
Royalty Reporting Tax Reporting New Tax Reporting Migration Migrate Tax Master Data  .

The Migrate tax master data screen appears.

Enter the following data.

● In the RSG field, enter the company for which you will migrate tax master data.
● In the AGENCY field, enter the agency ID for which you will migrate tax master data.
● In the OGIND field, specify whether the master data that you will migrate is for oil or gas.

598 C U S T O M E R
SAP Oil & Gas (PRA - Production and Revenue Accounting)

Tax Reporting 



● Choose Execute .

Result

The data is migrated from the old reporting framework to the new tax reporting framework.

To review and adjust the migrated data as required, use the Tax Reporting Master Maintenance [page 579] 
transaction ( Logistics Production and Revenue Accounting Production, Tax and Royalty Reporting Tax 
Reporting New Tax Reporting Tax reporting master maintenance  ).

19.14  Migrate Tax Transaction Data 

Use

Use this transaction to migrate tax transaction data from the old tax reporting framework to the new tax 
reporting framework.

Prerequisites

The year and month for which the system will begin to retrieve data from the old tax reporting framework is 
specified in the Sales YYYYMMMM field within the Maintain Execution Parameters Customizing activity.

To access this activity, in Customizing, choose Industry Solution Oil & Gas (Production and Revenue 
Accounting) Production, Tax and Royalty Reporting Tax Reporting New Tax Reporting Framework
Maintain Execution Parameters.

Procedure

At the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Production, Tax and 
Royalty Reporting Tax Reporting New Tax Reporting Migration Migrate Tax Transaction Data  .

The Migration prog for sev tax data to RPT tables in new tax reporting screen appears.

Enter the following data.

● In the RSG field, enter the company for which you will migrate tax transaction data.
● In the AGENCY field, enter the agency ID for which you will migrate tax transaction data.
● In the OGIND field, specify whether the tax transaction data that you will migrate is for oil or gas.
● Choose Execute .
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Result

The data is migrated from the old reporting framework to the new tax reporting framework.

To review and adjust the migrated data as required, use the Tax Reporting Master Maintenance [page 579] 
transaction ( Logistics Production and Revenue Accounting Production, Tax and Royalty Reporting Tax 
Reporting New Tax Reporting Tax reporting master maintenance  ).

19.15  Finalize Tax Migration 

Use

When executed, the Finalize Tax Migration transaction ( Logistics Production and Revenue Accounting
Production, Tax and Royalty Reporting Tax Reporting New Tax Reporting  )prevents the creation of 
offsetting journal entries for migrated data processed in the new Tax Reporting framework.

19.16  Converting Data from the Log Table(s) 

Use

Use this to move master data from the old log table(s) to the new log table(s).

Note that you can only carry out data conversion once. Once you do the data transfer, you cannot undo it, or do 
it a second time. Thus, it is advisable to consider this well, before doing it, to ensure that it is done correctly.

Procedure

1. From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Production, Tax, 
and Royalty Reporting New Tax Reporting Update Convert data in the log table.

2. The Convert Data in the Log Table screen appears. Enter data in the relevant fields and then select Execute .

Result

Data is moved on a one-time basis, from the old log file tables, to the new log file tables.
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19.17  Running a History Cleanup Job 

Use

Use this to remove duplicate data from tax reporting history tables.

Procedure

● From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Production, 
Tax and Royalty Reporting New Tax Reporting Update Background job for history cleanup.

● The Background Job for History Cleanup screen is displayed.
● Enter data in the relevant fields (company, agency, and oil or gas indicator).
● Select Execute .

19.18  Tax Reporting with the Tax 2.0 Portal

Use

You use this process to report crude oil and natural gas taxes with the new Tax 2.0 reporting model through the 
Tax 2.0 Portal.

The Tax 2.0 reporting model provides for more flexible tax reporting and is designed to accommodate the 
current and future legal requirements of different states. It also addresses system limitations with both the old 
and new reporting frameworks and provides additional functions, such as the ability to define statute-of-
limitations criteria and adjust reported history.

To access the Tax 2.0 Portal, on the SAP Easy Access screen, choose Logistics Production and Revenue 
Accounting  Production, Tax, and Royalty Reporting Report 2.0 Tax 2.0 Portal .

Prerequisites

● You have migrated old tax transaction data and master data into the new master data set-ups and history 
tables using the Migration Workbench. You do this after you have finalized your last tax reports for a given 
reporting month and before valuation data has been posted for the next month and any prior-period 
adjustments have been initiated.
You access the Migration Workbench with transaction O3UX3_MIGRATION.
The migration process is configured in Customizing for Industry Solution Oil & Gas (PRA) under 

Production, Tax, and Royalty Reporting Report 2.0  Enhancements .
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● General and state-specific settings have been made in Customizing for Industry Solution Oil & Gas (PRA) 
under Production, Tax, and Royalty Reporting Report 2.0 Tax 2.0 State Specific Configuration. .

● All the revenue data required to calculate and allocate taxes exists, including DOI accounting severance tax 
setup, tax calculation data, state tax rates, tax class information, and tier tax setup.

● Revenue documents have been posted with the correct tax calculations. This requires that the tax tables 
are loaded using the Tax 2.0 reporting model during valuation postings for the relevant tax report. Given 
that tax reports are state-specific, this is a state-specific setting. For example, for Texas you make the 
settings in Customizing for Industry Solution Oil & Gas (PRA) by choosing:

○ Production, Tax, and Royalty Reporting Report 2.0 General Configuration 

○ Production, Tax, and Royalty Reporting Report 2.0 Tax 2.0 State Specific Configuration 
Texas  Maintain Report Specific Configuration 

Note
It is possible to adjust tax figures manually during the tax reporting process. For more information, 
see Running a Tax Report in the Tax 2.0 Workplace [page 611].

Process

● You review and maintain the required general and state-specific master data. Most of the data will have 
been migrated from the previous tax frameworks. For more information, see Maintenance of Master Data 
in the Tax 2.0 Portal [page 602].

● You run the required tax report in the Tax Reporting Workplace by executing the individual tax reporting 
steps. You can view, adjust, suspend, and extract the tax transactions to be reported at various levels of 
detail from the workplace. For more information, see Running a Tax Report in the Tax 2.0 Workplace [page 
611].

● You can analyze reported tax transactions in a number of reports. For more information, see Tax 
Transaction Reporting [page 614].

19.18.1  Maintenance of Master Data in the Tax 2.0 Portal

Use

You use this process to review and maintain the master data required for tax reporting, which includes the 
reporting profiles required for each tax report, as well as the master data required for state-specifc tax 
reporting.

Features

Reporting Profiles
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You create reporting profiles by tax report ID and reporting company. The reporting attributes to be maintained 
include the taxpayer name, number, and address. Specify when the profile should be effective.

● State-Specific Master Data: Texas [page 603]
● State-Specific Master Data: Oklahoma [page 605]
● State-Specific Master Data: New Mexico [page 606]
● State-Specific Master Data: Wyoming [page 609]

Once you have reviewed and maintained all the required master data, you can run tax reports in the Tax 
Reporting Workplace.

For more information, see Running a Tax Report in the Tax 2.0 Workplace [page 611].

Activities

To access the state-specific master data maintenance, on the SAP Easy Access screen, choose Logistics
Production and Revenue Accounting Production, Tax, and Royalty Reporting Report 2.0 Tax 2.0 Portal
<State Name>

19.18.1.1  State-Specific Master Data: Texas

Use

You use this function to review and maintain the master data for the state of Texas.

Features

The following master data is relevant for Texas:

Texas master data

You use transaction O3UX3_TX_MASTER to link PRA entities (well/well completion, measurement point, 
venture/division of interest) to state-specific reporting attributes:

● The API well number
● The Texas Comptroller’s county identifier
● The state-assigned lease number
● Whether sales are delivered on or off the lease
● Overrides for on-lease/off-lease in the case of multiple on-lease/off-lease scenarios

Auto-suspension criteria

You use transaction O3UX3_TX_ASU specify auto-suspension criteria for the Texas tax reports. This allows you 
to specify tax records that you do not want to be processed during tax reporting.
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You can create suspension criteria by:

● Sales date, if you want to suspend all reporting activity prior to a specific sales date or across a range of 
sales dates

● PRA entity, if you want to suspend all reporting activity for a specific PRA entity (for example, well 
completion) prior to a specific sales date or across a range of sales date, for example

● State entity, if you want to suspend all reporting activity for a specific state lease number prior to a specific 
sales date or across a range of sales dates

Cross-reference between business associate and taxpayer number

You use transaction O3UX3_TX_BATXID to create a cross-reference between PRA business associate number 
and taxpayer number. This is necessary because Texas producer reports need to indicate the purchaser’s 
taxpayer number.

Out-of-statute criteria

You use transaction O3UX3_TX_SOL to specify statute-of-limitations criteria for the Texas tax reports. This 
allows you to specify tax records that you do not want to be processed during tax reporting because they are 
out of statute.

You can create statute-of-limitations criteria by:

● Sales date, if you want to indicate that all reporting activity prior to a specific sales date is out of statute 
and is not to be reported

● Filing period, if you want to indicate that all reporting activity for specific number of months before the 
current month is out of statute and is not to be reported

Transactions that meet the specified criteria are not reported to the state, but the financial impact of these 
adjustments is journalized. After you have run a report, you can view out-of-statute transactions and write 
them off in the Out-of-Statute Write-Off Maintenance report.

For more information, see Tax Transaction Reporting [page 614].

Statute-of-limitations exceptions

You use transaction O3UX3_TX_SOLE to specify exceptions to the above statute-of-limitations criteria at lease 
level for a specific sales date or range of sales dates. This allows you to specify the state lease and sales dates 
for which the statute-of-limitations criteria should be overridden. All tax data that meets these criteria is 
reported on the appropriate report.

Note
You suspended a tax transaction for a specific lease pending the outcome of a litigation process. However, 
during this time, the data to be reported aged to the point that it became out of statute. Now, you create an 
exception so that you can report the tax data even though it is out of statute.

Lease master data

You use transaction O3UX3_TX_LEASE to identify a lease as an oil or a gas lease. You can indicate whether a 
drilling permit number is being reported in place of a lease number. This is a new field on Texas tax reports.
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19.18.1.2  State-Specific Master Data: Oklahoma

Use

You use this function to review and maintain the master data for the State of Oklahoma.

Features

The following master data are relevant for Oklahoma:

Cross-reference between business associate and taxpayer number

You use transaction O3UX5_OK_BATXID to create a cross-reference between PRA business associate number 
and taxpayer number. This is necessary because the Oklahoma gross production reports must indicate the 
producer or purchaser taxpayer number.

Oklahoma master data

You use transaction O3UX5_OK_MASTER to link PRA entities (well/well completion, measurement point, 
venture/division of interest) to state-specific reporting attributes:

● Production unit number
● Gas code
● Oil class
● County of production

Auto-suspension criteria

You use transaction O3UX5_OK_ASU to specify auto-suspension criteria for the Oklahoma tax reports. This 
allows you to specify tax records that you do not want to be processed during tax reporting.

You can create suspension criteria by:

● Sales date, if you want to suspend all reporting activity prior to a specific sales date or across a range of 
sales dates

● PRA entity, if you want to suspend all reporting activity for a specific PRA entity (for example, well 
completion) prior to a specific sales date or across a range of sales date, for example

● State entity, if you want to suspend all reporting activity for a specific state lease number prior to a specific 
sales date or across a range of sales dates

Out-of-statute criteria

You use transaction O3UX5_OK_SOL to specify statute-of-limitations criteria for the Oklahoma tax reports. This 
allows you to specify tax records that you do not want to be processed during tax reporting because they are 
out of statute.

You can create statute-of-limitations criteria by:

● Sales date, if you want to indicate that all reporting activities prior to a specific sales date is out of statute 
and is not to be reported

● Filing period, if you want to indicate that all reporting activities for specific number of months before the 
current month is out of statute and is not to be reported
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Transactions that meet the specified criteria are not reported to the state, but the financial impact of these 
adjustments is journalized. After you have run a report, you can view out-of-statute transactions and write 
them off in the Out-of-Statute Write-Off Maintenance report (transaction O3UX5_UPD_OK_OOS_WO).

For more information, see Tax Transaction Reporting [page 614].

Statute-of-limitations exceptions

You use transaction O3UX5_OK_SOLE to specify exceptions to the above statute-of-limitations criteria at lease 
level for a specific sales date or range of sales dates. This allows you to specify the state lease and sales dates 
for which the statute-of-limitations criteria should be overridden. All tax data that meets these criteria is 
reported on the appropriate report.

You suspended tax data for a specific lease pending the outcome of a litigation process. However, during this 
time, the data to be reported aged to the point that it became out of statute. Now, you create an exception so 
that you can report the tax data even though it is out of statute.

Zero Volume Reporting Master

Since Oklahoma requires zero-volume reporting for all applicable production unit numbers, transaction 
O3UX5_OK_ZVOL allows you to set up the appropriate keys, which should be reported if no sales volume exists 
for a production month.

Oklahoma tax rate

You use transaction O3UX5_OK_TAX_RT to specify tax rates for different tax types, such as PR, EX, MP, RF, and 
the tax class and product code combination. The tax rates are used to recalculate the tax amount to confirm 
the footing differences if applicable. This transaction is used in the correct-all process for a report run. The 
rounding differences are valued using the tax rates you specify here.

19.18.1.3  State-Specific Master Data: New Mexico

Use

You use this function to review and maintain the master data for the state of New Mexico.

Features

The following master data is relevant for New Mexico.

Reporting Profile Maintenance

You use transaction O3UX3_RPT_PROF to create a profile for sending information to the state. The profile is set 
up by Report ID and is effective dated. The reporting attributes that you must specify include the taxpayer 
name, taxpayer number, and taxpayer address. Each report ID profile has an effective date, contact name, 
contact number, contact extension, and a contact e-mail address.

New Mexico master data
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You use transaction O3UX8_NM_MASTER to link PRA entities (well/well completion, measurement point, 
venture/division of interest) to the state-specific reporting attribute PUN (production unit number).

Auto-suspension criteria

You use transaction O3UX8_NM_ASU to specify auto-suspension criteria for the New Mexico tax reports. This 
allows you to specify tax records that you do not want to be processed during tax reporting.

You can create suspension criteria by:

● Sales date, if you want to suspend all reporting activity prior to a specific sales date or across a range of 
sales dates

● PRA entity, if you want to suspend all reporting activity for a specific PRA entity (for example, well 
completion) prior to a specific sales date or across a range of sales date, for example

● State entity, if you want to suspend all reporting activity for a specific state lease number prior to a specific 
sales date or across a range of sales dates

Out-of-statute criteria

You use transaction O3UX8_NM_SOL to specify statute-of-limitations criteria for the New Mexico tax reports. 
This allows you to specify tax records that you do not want to be processed during tax reporting because they 
are out of statute.

You can create statute-of-limitations criteria by:

● Sales date, if you want to indicate that all reporting activities prior to a specific sales date is out of statute 
and is not to be reported

● Filing period, if you want to indicate that all reporting activity for specific number of months before the 
current month is out of statute and is not to be reported

Transactions that meet the specified criteria are not reported to the state, but the financial impacts of these 
adjustments are journalized. After you have run a report, you can view out-of-statute transactions and write 
them off in the Out-of-Statute Write-Off Maintenance (transaction O3UX8_UPD_NM_OOS_WO) report.

For more information, see Tax Transaction Reporting [page 614].

Auto suspension exception

You use transaction 03UX8_NM_ASUE to define any exceptions to the statute of limitations criteria established 
through the statute-of-limitations maintenance transaction for the New Mexico tax reports. An example of the 
need for this functionality is the situation where tax data may be suspended by the user for litigation, audit, or 
other validation purposes and during this time frame, the data to be reported ages to the point that it becomes 
out of statute. With this exception functionality, those cases can be reported even if the tax data is out of 
statute. The criteria are defined by a system generated criteria number and a user defined criteria description. 
For a specific report ID, you can establish exceptions to the statute of limitations criteria at the state lease level 
for a specific sales date or range of sales dates. In establishing these criteria, you define the state lease and 
sales dates for which the statute of limitations criteria should be overridden. All tax data that meets these 
criteria are reported on the appropriate report.

Statute-of-limitations exceptions

You use transaction O3UX8_NM_SOLE to specify exceptions to the above statute-of-limitations criteria at the 
lease level for a specific sales date or range of sales dates. This allows you to specify the state lease and sales 
dates for which the statute-of-limitations criteria should be overridden. All tax data that meets these criteria is 
reported on the appropriate report.
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Note
You suspended tax data for a specific lease pending the outcome of a litigation process. However, during this 
time, the data to be reported aged to the point that it became out of statute. Now, you create an exception 
so that you can report the tax data even though it is out of statute.

Jicarilla credit

You use transaction 03UX8_NM_JC_MST to maintain the New Mexico Jicarilla Credit, which indicates an entry 
taking a tax credit as a result of a qualifying well with respect to oil and gas production from Jicarilla Apache 
tribal land. It is an offset to the tax imposed by the Jicarilla Apache Nation, and identified as the Jicarilla Apache 
Tribal Capital Improvements Tax. The volume, value, deductions, royalty should be left blank. Use parenthesis in 
the Tax Due Column for the tax credit amount.

Affiliated Code override

You use transaction 03UX8_NM_AFFOVR Use 01 to indicate that the line entry being reported was 
transported, processed or sold through an affiliated or non-arms length transaction. If the line entry being 
reported was transported, processed or sold through an arm’s length transaction, use 00.

Other exempted owners

You use transaction O3UX8_NM_OTH_OWN to specify the owners who are exempted and exist as entity type 
code 04 (State) even though they are not actually royalty owners in the system. These owners have the owner 
interest type code RT and interest category code W. You use this transaction for the reporting of specific 
business scenarios.

Upload of suffix tax rates

You use transaction O3UX8_LOAD_SUFF_RATE to upload the tax rates that are published every year by the 
state of New Mexico. Instead of maintaining the tax rates manually for every suffix using the 
O3UX8_NM_SUFFXRF transaction, this transaction can use the Excel sheet published by the state of New 
Mexico as input and upload the data.

Suffix cross-reference

You use transaction O3UX8_NM_SUFFXRF to specify the tax rates for the for tax types (AV, CN, ES & SV) for a 
suffix and major product code combination. This transaction allows you to maintain a secondary geographical 
location, municipality, and school district code for a record.

Suffix decimal

You use transaction O3UX8_NM_SUFFDEC to specify a PRA entity (venture/MP/well), and a major product code 
for a royalty entity code (Federal, Indian, Others, Private, and State) with the suffix and royalty entity/owner’s 
share (suffix decimal) in that suffix.

This decimal and the tax rates, which are specified in transaction O3UX8_NM_SUFFXRF, are used by the 
valuation process to re-value a property for suffix and royalty entity combination.

If the royalty entity code is Others, you must also enter the related entity type.

If multiple suffixes are specified, the sum of the suffix decimals cannot be less than and more than 1.
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19.18.1.4  State-Specific Master Data: Wyoming

Use

You use this function to review and maintain the master data for the state of Wyoming. The reporting attributes 
you must maintain include taxpayer name, taxpayer number, and taxpayer address. For Wyoming the tax report 
IDs are WYS (Wyoming Severance) and WYC (Wyoming Conservation). Each report ID profile has an effective 
date, contact name, contact number, contact extension, and contact e-mail address.

Features

The following master data is relevant for Wyoming.

Reporting Profile Maintenance

You use transaction O3UX3_RPT_PROF to create a profile for sending information to the state. The profile is set 
up by report ID and is effective dated. The reporting attributes that you must specify include the taxpayer 
name, taxpayer number, and taxpayer address. Each report ID profile has an effective date, contact name, 
contact number, contact extension, and a contact e-mail address.

Business associate operator ID

You use transaction O3UX6_WY_BAOPID to create a cross-reference between PRA business associate number 
and taxpayer number. This is necessary because Wyoming Severance and Conservation must indicate the 
producer’s taxpayer number.

Zero reporting master

A zero return is required on a group that had no production/sales for a given month, but it is still an active 
property. Any active property that is not reported results in a severance unreported properties letter being 
issued. Do not report zeros for shut in/plugged wells.

You would report a group for the first time based upon the well registration information that is provided to 
Wyoming. If a well becomes active in a certain month, but has no sales/production, Wyoming would have the 
well as active for that month and would issue the unreported letter if no return was filed with that group.

For zero reporting, a zero report master is created if you enter values in the Oil/Gas Indicator, Operator ID, 
Report Group Number, and Rate Code fields. To do so, you use transaction O3UX6_WY_ZVOL.

Wyoming master data

You use transaction O3UX6_WY_MASTER to link PRA entities (well/well completion, measurement point, 
venture/division of interest) to state-specific reporting attributes:

● State of Wyoming’s county identifier for reporting purposes
● Reporting group number assigned by the state
● API number for the producing entity
● Field number and name for reporting on the Wyoming reports
● Unit/lease number and name for reporting on the Wyoming reports
● Tax district the well is associated with
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For audit purposes, this transaction also contains administration information including the user who last 
changed a PRA entity, and the date and time of the last change.

Auto-suspension criteria

You use transaction O3UX6_WY_ASU to specify auto-suspension criteria for the Wyoming tax reports. This 
allows you to specify tax records that you do not want to be processed during tax reporting.

You can create suspension criteria by:

● Sales date, if you want to suspend all reporting activity prior to a specific sales date or across a range of 
sales dates

● PRA entity, if you want to suspend all reporting activities for a specific PRA entity (for example, well 
completion) prior to a specific sales date or across a range of sales date, for example

● State entity, if you want to suspend all reporting activity for a specific state lease number prior to a specific 
sales date or across a range of sales dates

Out-of-statute criteria

You use transaction O3UX6_WY_SOL to specify statute-of-limitations criteria for the Wyoming tax reports. This 
allows you to specify tax records that you do not want to be processed during tax reporting because they are 
out of statute.

You can create statute-of-limitations criteria by:

● Sales date, if you want to indicate that all reporting activity prior to a specific sales date is out of statute 
and is not to be reported

● Filing period, if you want to indicate that all reporting activity for specific number of months before the 
current month is out of statute and is not to be reported

Transactions that meet the specified criteria are not reported to the state, but the financial impacts of these 
adjustments are journalized. After you have run a report, you can view out-of-statute transactions and write 
them off in the Out-of-Statute Write-Off Maintenance (transaction O3UX6_DISP_OOSWO) report.

For more information, see Tax Transaction Reporting [page 614].

Statute-of-limitations exceptions

You use transaction O3UX6_WY_SOLE to specify exceptions to the above statute-of-limitations criteria at the 
lease level for a specific sales date or range of sales dates. This allows you to specify the state lease and sales 
dates for which the statute-of-limitations criteria should be overridden. All tax data that meets these criteria is 
reported on the appropriate report.

Note
You suspended tax data for a specific lease pending the outcome of a litigation process. However, during this 
time, the data to be reported aged to the point that it became out of statute. Now, you create an exception 
so that you can report the tax data even though it is out of statute.

Wyoming LCD (Lease condensate Override) override

You use transaction O3UX6_WY_LCDOVR to indicate whether condensate volumes from the state of Wyoming 
must be reported as if processed through a gas plant. This master file is set up for a well/wc and effective date.

Severance tax rate
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You use transaction O3UX6_WY_STAX_RT to specify the severance tax rate for different rate codes, and the 
oil/gas and incentive type combination. This is used during the correct-all process for a report run. The 
rounding difference is valued using the tax rates you specify here.

Conservation tax rate

You use transaction O3UX6_WY_CTAX_RT to specify the conservation tax rate for a period. This transaction is 
used during the correct-all process for a report run. The rounding difference is valued using the tax rates you 
specify here.

19.18.2  Running a Tax Report in the Tax 2.0 Workplace

Prerequisites

You have maintained the necessary master data in the Tax 2.0 Portal.

For more information, see Maintenance of Master Data in the Tax 2.0 Portal [page 602].

Context

You use this procedure to run a tax report for crude oil or natural gas in the Tax 2.0 Portal. You can later display, 
adjust, suspend, and download reportable tax data.

Procedure

1. On the Tax Reporting Portal screen, choose Periodic/Ad Hoc Processing Tax 2.0 Portal Workplace .

The initial screen of the Tax 2.0 Workplace appears.
2. To create a new run of the required tax report for the required reporting company, choose New.

You create either a current report or an amended report.

A current report reports tax for the latest sales date. An amended report amends previously reported 
volumes and values.

3. On the Admin/Execution tab, select the reporting steps that you want to execute.

In the standard, the following reporting steps are predefined in Customizing for execution in the following 
order:

1. Populate
2. Validate
3. Extract
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4. Process
5. Journalize
6. Finalize

4. To execute the selected reporting steps, choose Schedule Selected Step.

You can choose to execute the steps immediately or at a later time.

In the standard, the reporting steps are configured so that you can execute the steps Populate through to 
Journalize either one by one or all at once. You can also execute them as many times as necessary. This is 
in contrast to the Finalize step: You must execute this step on its own and you can execute it only once (see 
step 6) so that you do not post any data irreversibly before you have had a chance to review and adjust it if 
necessary.

The following table explains what the system does when you execute each of the reporting steps.

Table 156:

Reporting Step What the System Does

Populate The system loads the relevant data from the Valuation ap­
plication to a tax transaction data table.

Validate The system uses the tax transaction data and checks 
whether:

○ Valid master data exists for reporting
If no valid master data file exists for a particular re­
cord, it is flagged as Rejected.

○ All the cross-references required for reporting have 
been created
If not all of the required cross-references exist for a 
particular record, it is flagged as Rejected.

○ Suspension criteria have been created
If a record meets the suspension criteria, the specific 
PRA or state entity is not to be reported. The record 
in question is flagged as Suspended.

Extract The system reads the tax data to be reported into a pend­
ing transactions table.

Process The system reads the pending transactions data and cal­
culates the reporting information at detail (PRA) and sum­
mary (state entity) level. It applies statute-of-limiatations 
criteria to the summary reporting information so that out-
of-statute records do not appear on the state report. You 
can later write off these records. For more information, 
see Tax Transaction Reporting [page 614].
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Reporting Step What the System Does

Journalize The system reads all the pending transactions and creates 
trial journal entries for reconciliation reporting. For trans­
actions that are out of statute and therefore not reporta­
ble, the systems creates trial suspended journal entries 
that require further action (write-off approval and proc­
essing).

Finalize The system posts the trial journal entries. Trial suspended 
entries are posted as pending write-offs.

An application log is available for each of the steps on completion. For example, the application log for the 
Validate step shows all rejected tax records with the reason for rejection.

5. On the other tabs in the Tax Reporting Workplace, review the tax records of the current run.

The following tabs are available:

○ PRA Details
You can display reportable transactions at detailed PRA level. You can also adjust, suspend, and 
download them if necessary.

Note
It is only possible to adjust and suspend data when it is in Trial status. This means that you have not 
executed the Finalize step yet.

○ Report Details
You can display reportable transactions at the summarized state level. You can also adjust transactions 
if necessary.

Note
It is only possible to adjust and suspend data when it is in Trial status. This means that you have not 
executed the Finalize step yet.

○ Journal Entries
You can analyze the trial journal entries resulting from tax reporting.

○ Out of Statute
You can display transactions that meet statute-of-limitations criteria and do not need to be reported.

6. When you are ready to finalize the report, run the Finalize step.

The system completes the processing of the reporting parameters for the month and year that you 
specified and creates offsetting journal entries.

Results

You can create an EDI file to submit the tax report to the state.
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19.18.3  Tax Transaction Reporting

Use

The Tax 2.0 Portal includes several reports that allow you to list the tax transactions from current and finalized 
tax report runs for analysis purposes. In some reports, you can also modify the data.

You can access these reports through the Tax 2.0 Portal by choosing Periodic/Ad Hoc Processing <State 
Name> .

Features

Reports for Texas

The following table explains the reports that are available for tax transactions reported on the Texas oil and gas 
tax reports.

Table 157:

Report Use

Out-of-Statute Write-Off (transaction O3UX3_TX_OOS_WO) You use this report to list out-of-statute transactions and 
then write them off.

Tax Transactions (transaction O3UX3_TX_TAXTXN) You use this report to list the pending, rejected, or sus­
pended tax transactions of a trial tax report run.

Up-to-Date Reported Trans (transaction 
O3UX3_TX_TAXHST)

You use this report to list the tax transactions from a specific 
sales month that have already been reported to the state.

Out-of-Statute Write-Off (transaction 
O3UX3_DISP_TX_OOSWO)

You use this report to list the write-off records for out-of-
statute transactions that have been written off.

Tax Variance History (transaction O3UX3_DISP_TX_RPVAR) You use this report to show the difference between the tax 
amounts reported for two reporting months.

Tax History (transaction O3UX3_UPD_TX_TAXHST) You use this report to list the tax transactions from a specific 
period that have already been reported to the state.

Here, you can also adjust reported values. This is useful if 
discrepancies develop between your reported tax history in 
your system and the state’s official reported history for you.

Reports for Oklahoma

The following table explains the reports that are available for tax transactions reported on the Oklahoma gross 
production tax report.
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Table 158:

Report Use

Tax Transactions (transaction O3UX5_DISP_OK_TAXTXN) You use this report to list the pending, rejected or suspended 
tax transactions of a trial tax report run.

Up-to-Date Reported Transactions (transaction 
O3UX5_DISP_OK_TAXHST)

You use this report to list the tax transactions from a specific 
sales month that have already been reported to the state.

Tax Variance History (transaction O3UX5_DISP_OK_RPVAR) You use this report to show the difference between the tax 
amounts reported for two reporting months.

List of Out-of-Statute Write-Offs (transaction 
O3UX5_DISP_OOSWO)

You use this report to list the write-off records for out-of-
statute transactions that have been written off.

Tax History (transaction O3UX5_UPD_OK_TAXHST) You use this report to list the tax transactions from a specific 
period that have already been reported to the state.

Here, you can also adjust reported values. This is useful if 
discrepancies develop between your reported tax history in 
your system and the state’s official reported history for you.

Out-of-Statute Write-Off (transaction 
O3UX5_UPD_OK_OOS_WO)

You use this report to list out-of-statute transactions and 
then write them off.

User Tax Transactions (transaction 
O3UX5_UPD_OK_TAXTXN)

This transaction provides enables you to add an ‘off-system’ 
tax transaction to be processed through the tax system.

Reports for Wyoming

The following table explains the reports that are available for tax transactions reported on the Wyoming tax 
reports.

Table 159:

Report Use

Severance Tax Transactions (transaction 
O3UX6_DISP_WYSTAXTXN)

You use this report to list the pending, rejected, or sus­
pended tax transactions of a trial tax report run.

Up-to-Date Reported Severance Transaction (transaction 
O3UX6_DISP_WYSTAHST)

You use this report to list the tax transactions from a specific 
sales month that have already been reported to the state.

Severance Tax Variance (transaction 
O3UX6_DISP_WYS_RPVAR)

You use this report to show the difference between the tax 
amounts reported for two reporting months.

Severance Tax History (transaction 
O3UX6_UPD_WY_STAXHST)

You use this report to list the tax transactions from a specific 
period that have already been reported to the state.

Here, you can also adjust reported values. This is useful if 
discrepancies develop between your reported tax history in 
your system and the state’s official reported history for you.
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Report Use

Severance User Tax Transaction (transaction 
O3UX6_UPD_WY_STAXTXN)

You use this to add a severance tax transaction. This is an 
exception based transaction. Consider the ramifications of 
the impact of adding in this window.

Conservation Tax Transaction (transaction 
O3UX6_DISP_WYCTAXTXN)

You use this report to list the pending, rejected, or sus­
pended tax transactions of a trial tax report run.

Up-to-Date Reported Conserv Trans (transaction 
O3UX6_DISP_WYCTAXTXN)

You use this to query to view report group level history. True 
numbers that you have reported to the state.

Conservation Tax Variance (transaction 
O3UX6_DISP_WYC_RPVAR)

You use this report to show the difference between the tax 
amounts reported for two reporting months.

Wyoming Conservation Tax History (transaction 
O3UX6_UPD_WY_CTAXHST)

You use this report to list the tax transactions from a specific 
period that have already been reported to the state.

Here, you can also adjust reported values. This is useful if 
discrepancies develop between your reported tax history in 
your system and the state’s official reported history for you.

Conservation User Tax Transaction (transaction 
O3UX6_UPD_WY_CTAXTXN)

You use this to add a conservation tax transaction. This is an 
exception based transaction. Consider the ramifications of 
the impact of adding in this window.

List of Out-of-Statute Write-Offs (transaction 
O3UX6_DISP_OOSWO)

You use this report to list the write-off records for out-of-
statute transactions that have been written off.

Severance Out-of-Statute Write-Off (transaction 
O3UX6_UPD_WYS_OOS_WO)

You use this report to list out-of-statute transactions and 
then write them off.

Conservation Out-of-Statute Write-Off (transaction 
O3UX6_UPD_WYC_OOS_WO)

You use this report to list out-of-statute transactions and 
then write them off.

Reports for New Mexico

The following table explains the reports that are available for tax transactions reported on the New Mexico tax 
reports.

Table 160:

Report Use

Tax Transactions (transaction O3UX8_DISP_NM_TAXTXN) You use this report to view pending, rejected, suspended, or 
all tax transactional entries for the New Mexico tax report.

Up-to-Date Reported New Mexico Transaction (transaction 
O3UX8_DISP_NM_TAXHST)

You use this report to display historically reported data at 
both the PRA and reporting detail levels.

Tax Variance (transaction O3UX8_DISP_NM_RPTVAR) You use this report to view reporting variances across re­
porting periods.
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Report Use

List of Out-of-Statue Write-Offs (transaction 
O3UX8_DISP_NM_OOSWO)

You use this report to view the historical information related 
to the tax transactions, which have been written-off for the 
state of New Mexico tax report. Information includes write-
off comments as well as the batches created to write off the 
financial impact of the transactions.

User Tax Transaction (transaction O3UX8_UPD_NM_TAXTXN) You use this report to update or add tax transactional data 
prior to processing the New Mexico tax report.

Out-of-Statute Write-Off (transaction O3UX8_UPD_OOS_WO) You use this report to manage the out-of-statute transac­
tional data, which is fed to the Tax 2.0 Portal for New Mexico 
tax reporting. You can view and select tax transactional en­
tries for write-off.

Tax History (transaction O3UX8_UPD_NM_TAXHST) You use this report to update historically reported tax trans­
action. It allows you to decide whether or not to report those 
history changes.

Tax Trans Decimal (transaction O3UX8_DISP_NM_TAXDTL) You use this report to display the allocation decimal for the 
current and amended reporting detail transactions for a 
given month. You can also view the details at either the tax 
transaction level or the PRA details level.

You provide the allocation decimal for the PRA level tax 
transactions, which are the source level transactions for the 
New Mexico tax report. This decimal is calculated based on 
the associated venture/DOI’s royalty interest NRI and bur­
den groups in the division order.

19.18.4  Tax Reporting for Wyoming Gross Production Tax 2.0

Use

You use this process to report crude oil and natural gas taxes with the new Wyoming Gross Production Tax 2.0 
Reporting Model.

The Wyoming Gross Production Tax 2.0 Reporting Model provides new functions for Wyoming reporting and is 
designed to accommodate the current and future legal requirements for Wyoming.

Prerequisites

1. You have finalized the Wyoming severance tax reports.
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2. General and state-specific settings have been made in Customizing for Industry Solution Oil & Gas (PRA) 
by choosing:

○ Production, Tax, and Royalty Reporting Report 2.0 General Configuration

○ Production, Tax, and Royalty Reporting Report 2.0 Tax 2.0 State Specific Configuration
Wyoming Gross Production

3. You have set up any master data for overriding marketing and tax district allocations.

Process

1. On the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Production, 
Tax, and Royalty Reporting Tax Reporting Wyoming Gross Production WYGP Workplace  or use 
transaction O3UX7_WORKPLACE - Tax 2.0.

2. Create a WYGP reporting profile.
3. You finalize the Wyoming severance tax reports for the required tax months in the Tax Reporting Workplace 

that you expect to report for the Wyoming gross production report.

Note
This report is solely dependent on the Wyoming severance tax report and the master data set-ups 
relative to Wyoming tax reporting.

19.18.4.1  Maintenance of Master Data in Gross Production 
Tax 2.0

Use

You use this function to review and maintain the master data required for tax reporting. This includes the 
reporting profiles required for each tax report, as well as the master data required for state-specifc tax 
reporting.

Features

Reporting Profiles

You use transaction O3UX3_RPT_PROF to create reporting profiles by tax report ID and reporting company. The 
reporting attributes that you must specify include the taxpayer name, taxpayer number, and taxpayer address. 
For Wyoming, the tax report IDs are WYS (Wyoming Severance), WYC (Wyoming Conservation), and WYPG 
(Wyoming Gross Production Reporting). Each report ID profile has an effective date, contact name, contact 
number, contact extension, and a contact e-mail address.

State-Specific Master Data: Wyoming Gross Production
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You use transaction O3UX7_WY_MKTOVR when there is a specific marketing type that you need to override to 
the gross production marketing buckets. The default for the marketing buckets is at the company level. This 
transaction allows you to override at well level.

The O3UX7_WY_MPALLOC transaction allows for measurement points a percentage override allocation for the 
tax districts.

Activities

To access the master data maintenance, on the SAP Easy Access screen, choose Logistics Production and 
Revenue Accounting Production, Tax and Royalty Reporting Report 2.0 Tax 2.0 Portal Master Data .

19.18.4.2  Running the Wyoming Gross Production Tax Report

Prerequisites

You have finalized the Wyoming severance tax report.

Context

You use this procedure to run the gross production report for a reporting year. This report pulls in both crude oil 
and natural gas into the Tax 2.0 WYGP Workplace. You can later display, adjust, and download reportable tax 
data.

Procedure

1. On the SAP Easy Access screen, choose Logistics Production and Revenue Accounting Production, 
Tax, and Royalty Reporting Tax Reporting Wyoming Gross Production WYGP Workplace .

2. To create a new run of the required tax report for the required reporting company, choose New.

You create either a current report or an amended report.

A current report reports tax for the year (this is an annual report). An amended report amends previously 
reported volumes and values for a given year.

3. On the Admin/Execution tab page, select the reporting steps that you want to execute.
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In the standard, the following reporting steps are predefined in Customizing for execution in the following 
order:

1. Pre-Validate
2. Populate
3. Validate
4. Extract
5. Process
6. Post Validate
7. Finalize

4. To execute the selected reporting steps, choose Schedule Selected Step.

You can choose to execute the steps immediately or at a later time. To insure that all information is correct 
always run the pre-validate first and before you run the next steps.

In the standard, the reporting steps are configured so that you can execute the steps Populate through to 
Post Validate either one by one or all at once. You can also execute them as many times as necessary. This 
is in contrast to the Finalize step: You must execute this step on its own and you can execute it only once so 
that you do not post any data irreversibly before you have had a chance to review and adjust it if necessary.

The following table explains what the system does when you execute each of the reporting steps:

Table 161:

Reporting Step What the System Does?

Pre-Validate This step uses the gross production tax staging data (the 
Wyoming severance tax finalized transactional data) and 
populates the delivery network (DN) consistency table.

Populate This step uses the data from gross production tax staging 
and moves it to gross production tax transaction tables. 
This data is held as the population of data for reporting 
the gross production data. This step also goes to the pro­
duction tables and pulls in the well volumes to the (Gvol) 
tables in gross production and also pulls in the contract al­
location volumes to the gross (GSAL) sales data.

Validate This step uses the tax transaction data and checks 
whether:

○ Valid master data exists for reporting
If no valid master data file exists for a particular re­
cord, it is flagged as Rejected.

○ All the cross-references required for reporting have 
been created
If not all of the required cross-references exist for a 
particular record, it is flagged as Rejected.

Extract This step uses all non-rejected records and moves them 
into the PRA details transaction.
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Reporting Step What the System Does?

Process This step uses the PRA details and formats and summa­
rizes the data into the proper forms for viewing the 4101 
and 4201 transactions.

Post-Validate This step does a footing checking to make sure that the 
data is totaling correctly based on the report rules.

Finalize This steps moves the data to the gross production history 
tables.

An application log is available for each of the steps on completion. For example, the application log for the 
Validate step shows all rejected tax records with the reason for rejection.

5. On the other tabs in the Wyoming Gross Production Workplace, review the tax records of the current run. 
The following tabs are available:
○ DN Consistency

You can display the dates and timestamps for each network that is processing in the Wyoming Gross 
Production Workplace. This tells the analyst whether the data and processes are consistent. For 
example, production should always be run first, CA run second and VL/RD run third for data 
consistency.
To override inconsistent delivery networks, choose Override Inconsistencies. These inconsistent 
networks are not processed unless PPA’ed or overridden.
To undo the previous override, choose Undo Override.

○ PRA Details
You can display reportable transactions at detailed PRA level.

○ 4101 Details (Annual Gross Products for Oil) and 4201 Details (Annual Gross Products for Gas)
You can display reportable transactions at the summarized reporting attributes level. You can also 
adjust transactions if necessary. This view of information has drill-down capability to access take-in-
kind (TIK) information, school district information, and plant products detail information.

Note
This can be adjusted only when it is in Trial status. This means that you have not executed the 
Finalize step yet.

○ To display PRA details, choose Show PRA Details.
○ To display the 4101 or 4201 details, choose Show 4101 Details or Show 4201 Details.
○ To exclude the record from the ASCII file creation and finalize the record for the history tables 

with a flag reflecting that it was rolled to history and not reported, choose Toggle Report Status.
○ To navigate to the finalized history and copy the previous adjustments into the transactional 

data for PPAs (amended reporting), choose Copy Previous Adjustments. The history records 
have a audit trail for determining the original records from the adjusted records. When you 
choose this push-button, the system retrieves the adjusted record for PPAs and pulls it into the 
report so that the analyst does not have to make the same adjustments more than once.

○ To remove all adjustments from the detail 4101 and 4201 that have been manually done, choose 
Remove Adjustments.

6. When you are ready to finalize the report, run the Finalize step.
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The system completes the processing of the reporting parameters for the year and moves the data to the 
history table for gross production.

Results

You can create an EDI file to submit the tax report to the state.

19.19  Royalty Reporting with the Report 2.0 Portal

Use

You use this process to report crude oil and natural gas royalties with the new Royalty 2.0 Reporting Model 
through the Report 2.0 Portal.

The Royalty 2.0 Reporting Model provides compliant reporting for the state of Wyoming and Texas is designed 
to accommodate the current and future legal requirements for Wyoming and Texas royalty reporting. It also 
addresses system limitations with both the old and new reporting frameworks and provides additional 
functions, such as the ability to define statute-of-limitations, auto-suspension functionality criteria and allows 
adjustments to reported history.

To access the Royalty 2.0 Portal, on the SAP Easy Access screen, choose Logistics Production and Revenue 
Accounting Report 2.0 Royalty 2.0 Portal

Prerequisites

● You have migrated royalty transaction data and master data into the new master data set-ups and history 
tables using the Migration Workbench. You do this after you have finalized your last royalty reports for a 
given reporting month and before valuation data has been posted for the next month and any prior-period 
adjustments have been initiated.
To access the Migration Workbench, you can use the transaction O3UX3_MIGRATION. From this 
transaction, you can select the respective tax/royalty migration transactions for the specific report.

● You have configured the migration process in Customizing for Industry Solution Oil & Gas (PRA) by 
choosing Production, Tax, and Royalty Reporting Report 2.0 Enhancements .

● General configuration settings have been made in Customizing for Production, Tax, and Royalty 
Reporting Report 2.0 General Configuration

● State-specific settings have been made in Customizing for Industry Solution Oil & Gas (PRA) by choosing 
Production, Tax, and Royalty Reporting Report 2.0 Royalty 2.0 State Specific Configuration .

● Revenue documents have been posted with the correct royalty calculations.
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Process

1. You review and maintain the required general and state-specific master data.
Most of the data will have been migrated from the previous royalty frameworks. For more information, see 
Maintenance of Master Data in the Royalty 2.0 Portal [page 623].

2. You run the required royalty report in the Royalty Reporting Workplace on the SAP Easy Access screen by 
choosing Logistics Production and Revenue Accounting Report 2.0 Royalty 2.0 Portal
Periodic /Ad Hoc Processing  by executing the individual royalty reporting steps. You can view, adjust, 
suspend, and extract the royalty transactions to be reported at various levels of detail from the workplace.

3. You can analyze reported tax transactions in a number of reports.

19.19.1  Maintenance of Master Data in the Royalty 2.0 Portal

Use

You use this function to review and maintain the master data required for royalty reporting. This includes the 
reporting profiles required for each royalty report, as well as the master data required for state-specifc royalty 
reporting.

Features

Reporting Profiles

You create reporting profiles by royalty report ID and reporting company. The reporting attributes to be 
maintained include taxpayer name, taxpayer number, and Taxpayer address.

● For Wyoming the royalty report IDs are WYRG (Wyoming Royalty Gas) and WYRO (Wyoming Royalty Oil). 
Each report ID profile has an effective date, contact name, contact number, contact extension, and a 
contact e-mail address.

● For Texas GLO, the royalty report IDs are GL01 (GLO Royalty Oil) and GLO2 (GLO Royalty Gas). Each report 
ID profile has an effective date, contact name, contact number, contact extension, and a contact e-mail 
address.

Once you have reviewed and maintained all the required master data, you can run the royalty report in the 
Royalty Reporting Workplace.

Activities

To access the master data maintenance, on the SAP Easy Access screen choose Logistics Production and 
Revenue Accounting Production, Tax, and Royalty Reporting Report 2.0 Royalty 2.0 Portal Master Data
<State Name>
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19.19.2  State-Specific Master Data: Wyoming

Use

You use this function to review and maintain the master data for the state of Wyoming.

Features

The following master data is relevant for Wyoming:

Reporting Profile Maintenance

You use transaction O3UX3_RPT_PROF to create the cross-reference record that should exist between a PRA 
business associate number and taxpayer number. This is necessary because the state of Wyoming has its own 
internal number representing the producer.

Wyoming lease

You use transaction O3UY6_WY_LEASE to define the Wyoming lease, which is the relationship between a state 
lease number, PSA number, tract allocation percentage, and royalty rate.

Wyoming master data

You use transaction O3UY6_WY_MASTER to link PRA entities (well/well completion, measurement point, 
venture/division of interest) to state-specific reporting attributes:

● Report ID
● PRA entity (Well completion, MP or Venture/DOI)
● Effective from-date and to-date
● Report only flag (report only and do not pay)
● Override flag –Derives the properties operator status or allows you to override as operated or non-

operated
● State lease number, PSA, tract allocation lease factor, and royalty rate accessed from the lease master 

data
● Lease text (add the lease name)
● Reference field (add a free form text)
● Legacy lease number (add the old cross-reference number)

For audit purposes, this transaction also contains administration information including the user who last 
changed a PRA entity, and the date and time of the last change.

Reporting price

You use transaction O3UY6_WY_PRICE to maintain the reporting price at the state lease number/ PSA, 
Wyoming product code, effective-from and to-dates. This transaction allows you to value the transactional data 
for reporting to the state.

Coal bed methane override

You use transaction O3UY6_WY_CBMOVR to define at PRA entity level the scenarios, in which wet gas should be 
reported to the state as coal bed methane.
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Auto-suspension criteria

You use transaction O3UY6_WY_ASU to specify auto-suspension criteria for the Wyoming tax reports. This 
allows you to specify tax records that you do not want to be processed during tax reporting.

You can create suspension criteria by:

● Sales date, if you want to suspend all reporting activity prior to a specific sales date or across a range of 
sales dates

● PRA entity, if you want to suspend all reporting activity for a specific PRA entity (for example, well 
completion) prior to a specific sales date or across a range of sales date, for example

● State entity, if you want to suspend all reporting activity for a specific state lease number prior to a specific 
sales date or across a range of sales dates

Statute-of-limitations criteria

You use transaction O3UY6_WY_SOL to specify statute-of-limitations criteria for the Wyoming tax reports. This 
allows you to specify tax records that you do not want to be processed during tax reporting because they are 
out of statute.

You can create statute-of-limitations criteria by:

● Sales date, if you want to indicate that all reporting activity prior to a specific sales date is out of statute 
and is not to be reported

● Filing period, if you want to indicate that all reporting activity for specific number of months before the 
current month is out of statute and is not to be reported

Transactions that meet the specified criteria are not reported to the state, but the financial impacts of these 
adjustments are journalized. After you have run a report, you can view out-of-statute transactions and write 
them off in the Out-of-Statute Write-Off Maintenance report.

For more information, see Royalty Transaction Reporting [page 632].

Statute-of-limitations exceptions

You use transaction O3UY6_WY_SOLE to specify exceptions to the above statute-of-limitations criteria at the 
lease level for a specific sales date or range of sales dates. This allows you to specify the state lease and sales 
dates for which the statute-of-limitations criteria should be overridden. All tax data that meets these criteria is 
reported on the appropriate report.

Note
You can suspend royalty data for a specific lease pending SOL regulations for a state. Howeve, due to 
litigation the state may require that it is reported, and you can use this transaction to override and report by 
property, lease or well.

Royalty zero volume master

A zero return is required on a group that had no production/sales for a given month, but it is still an active 
property. Any active property that is not reported results in a severance unreported properties letter being 
issued. Do not report zeros for shut in/plugged wells.

You would report a group for the first time based upon the well registration information that is provided to 
Wyoming. If a well becomes active in a certain month, but has no sales/production, Wyoming would have the 
well as active for that month and would issue the unreported letter if no return was filed with that group.
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For zero reporting, a zero report master is created for a report ID, reporting company, payer code, state lease 
number, PSA, and Wyoming product code. To specify a zero-volume master, you use transaction 
O3UY6_WY_ZVOL.

Communication agreement percent override

There are scenarios where wells in units overlap the communization agreement. When the communication 
agreement overlaps into the unit, the production for that portion of the communication agreement is included 
in the gross production of the unit. The only part that is reported and paid on is the part of the communication 
agreement in the unit.

Example
If 75% of the communication agreement overlaps into the unit, 75% of the production and sales are 
attributed to the unit. The remaining 25% of the communication agreement production and sales are 
attributed to the communication. However, there is no mechanism to calculate a percentage of the gross 
production and gross sales for a well, which is only partially included in the unit.

You use transaction 03UY6_WY_CAPOVR to add the percentage that should be applied to the unit.

19.19.3  State-Specific Master Data: Texas GLO (General Land 
Office)

Use

You use this function to review and maintain the master data for the state of Texas.

Features

The following master data is relevant for Texas GLO:

Reporting Profile Maintenance

You use transaction O3UX3_RPT_PROF to create the cross-reference record that should exist between a PRA 
business associate number and taxpayer ID number. This is necessary because the state of Texas has its own 
internal number representing the producer.

Business associate and report ID cross-reference

You use transaction O3UYC_BA_RPTID to create business associate (BA) parameters for each distinct report 
ID. The BA is used to tie the general land office owner number to the GLO1 and GLO2 reports.

Lease master

You use transaction O3UY3_TX_LEASE to define the Texas/GLO/TAMU lease master. This master is the 
relationship between a state lease number and royalty rate.
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Note
Only use this transaction when new leases are set up.

Unit master

You use transaction O3UY3_TX_UNIT to tie a lease to a participation factor and determine the lowest lease in 
the unit. The lowest lease indicator is used to report the production volumes on the reports when multiple 
leases are tied to a unit.

Texas GLO/TAMU RRC master

You use transaction O3UY3_TX_RRC to link PRA entities (well/well completion, measurement point, venture/
division of interest) to state-specific reporting attributes:

● Report ID
● PRA entity (Well completion, MP, or Venture/DOI)
● Effective from-date and to-date
● District number
● Reference field (add a free form text for the name)
● Lease identifier

○ Oil lease
○ Gas lease
○ Drill permit

● Field name (RRC assigned)
● Lease name (RRC assigned)
● Property alias number (add a user description of the lease or tract being reported)
● Operator number (add the operator of the property or the PRA operator ID number)
● Prod disp report indicator (This places the production dispositions on the GLO1(oil) or GLO2 (gas). This is 

used to identify the non-operated for reporting purposes)

For audit purposes, this transaction also contains administration information including the user who last 
changed a PRA entity, and the date and time of the last changed.

Business associate cross-reference

You use transaction O3UY3_TX_BAXRF to assign the internal business associate to an external customer 
number for purchases of oil and gas. PRA BA to the state assigned customer ID. In this transaction, you enter 
the following values:

● Internal BA number
● Effective-from and effective-to
● External customer number

Texas GLO/TAMU master data

You use transaction O3UY3_TX_MASTER to define the master that ties the well to the lease, unit, tract factors, 
and an allocation factor. This ties the PRA entities to the external GLO1 (oil) and GLO2 (gas) lease numbers.

Reporting control master

You use transaction O3UY3_TX_CTRL to create a master including a report ID, reporting company, GLO lease, 
district, gas, or oil lease indicator to determine the number of expected reports for reporting. This master is 
also used to manage GLO TIK.
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● You use this transaction to create a comprehensive list of each lease/RRC that must be submitted to the 
state in a given month. This transaction drives zero- report processing. When you enter information on the 
selection screen, the system creates a zero-report record based on a current month report if no revenue 
recordings exist for that month.

● If a lease/RRC should be reported to the state, you must create a record created using this transaction.
● Usually, you only create a record for a go-live or in case of a new or discontinued lease/RRC combination.

Auto-suspension master

You use transaction O3UY3_TX_ASU to specify auto-suspension criteria for the GLO royalty reports. This allows 
you to specify royalty records that you do not want to be processed during the current royalty report.

You can create suspension criteria by:

● Sales date if you want to suspend all reporting activities prior to a specific sales date or across a range of 
sales dates.

● PRA entity if you want to suspend all reporting activities for a specific PRA entity, for example, a well 
completion, prior to a specific sales date or across a range of sales dates.

● State entity if you want to suspend all reporting activities for a specific state lease number prior to a 
specific sales date or across a range of sales dates.

Statute-of-limitations criteria

You use transaction O3UY3_TX_SOL to specify statute-of-limitations criteria for the Texas GLO reports. This 
allows you to specify royalty records that you do not want to be processed during royalty reporting because 
they are out of statute.

You can create statute-of-limitations criteria by:

● Sales date if you want to indicate that all reporting activities prior to a specific sales date is out of statute 
and is not to be reported.

● Filing period if you want to indicate that all reporting activities for specific number of months before the 
current month is out of statute and is not to be reported.

Transactions that meet the specified criteria are not reported to the state, but the financial impacts of these 
adjustments are journalized. After you have run a report, you can view out-of-statute transactions and write 
them off in the out-of-statute write-off maintenance report, which you access using transaction 
O3UY3_UPD_TX_OOS_WO.

Statute-of-limitations exception

You use transaction O3UY3_TX_SOLE to specify exceptions to the above-mentioned statute-of-limitations 
criteria at lease level for a specific sales date or range of sales dates. This allows you to specify the state lease 
and sales dates, for which the statute-of-limitations criteria should be overridden. All royalty data that meets 
these criteria is reported based on the appropriate report.

Example
You suspended the royalty data for a specific lease pending the outcome of a litigation process. However, 
during this time, the data to be reported aged to the point that it became out of statute. Now, you create an 
exception so that you can report the royalty data even though it is out of statute.

Production disposition cross-reference
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You use transaction O3UY3_TX_PDCXRF to create the association between the PRA volume types and the 
disposition codes used on the GLO1 (oil) and GLO2 (gas) reports to define in which column the production 
volumes belong.

This is done for both report IDs and is used to map to the reports. This master is critical for correct reporting. It 
is used to identify formation production and non-formation production volumes. In this transaction, enter the 
following values:

● Report ID
● Well/well completion: This is used as an exception. Most records are set up without a well/well completion 

and should default for all scenarios at the higher level.
● Transportation method
● Volume type code
● Material
● Oil disposition code
● Gas disposition code
● Subtract
● Gas production code

Royalty disposition cross-reference

You use transaction O3UY3_TX_RDCXRF to create the association between the PRA volume types used for GLO 
and the royalty disposition codes used on GLO2 ONLY in the valuation section of the reports. This tells the 
royalty report which column to put the values.

Business associate tax IDs

You use transaction O3UX3_TX_BATXID to create the master, which allows you to tie a purchaser to their 
taxpayer IDs.

Owner level override

You use transaction O3UY3_TX_OWNOVR to override the state of Texas owner to either pay but do not report or 
to not pay but report on the GLO1 (oil) and GLO2 (gas) reports. In addition, you can use this transaction to 
override a lease number for a given venture/DOI.

19.19.4  Running a Royalty Report in the Report 2.0 Workplace

Prerequisites

You have maintained the necessary master data in the Report 2.0 Portal.

For more information, see Maintenance of Master Data in the Royalty 2.0 Portal [page 623].
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Context

You use this procedure to run a royalty report for crude oil or natural gas in the Report 2.0 Portal. You can later 
display, adjust, suspend, and download reportable royalty data.

Procedure

1. On the Royalty 2.0 Portal screen, choose Periodic/Ad Hoc Processing Report 2.0 Workplace .

The initial screen of the Report 2.0 Workplace appears.
2. Create a new run of the required Royalty report for the required reporting company by choosing New.

You can create either a current report or an amended report. A current report reports Royalty for the latest 
sales date. An amended report amends previously reported volumes and values.

3. On the Admin/Execution tab page, select the reporting steps that you want to execute. In the standard, the 
following reporting steps are predefined in Customizing for execution in the following order:
1. Populate
2. Validate
3. Extract
4. Process
5. Journalize
6. Finalize

4. Execute the selected reporting steps by choosing Schedule Selected Step.
5. You can choose to execute the steps immediately or at a later time.

In the standard, the reporting steps are configured so that you can execute the steps Populate through to 
Journalize either one by one or all at once. You can also execute them as many times as necessary. This is 
in contrast to the Finalize step, which you must execute on its own and which you can execute only once 
(see step 6). As a result, you do not post any data irreversibly before you have had a chance to review and 
adjust it if necessary (see step 5).

The following table explains what the system does when you execute each of the reporting steps.

Table 162:

Reporting Step What the System Does?

Populate The system loads the relevant data from the Valuation ap­
plication to a royalty transaction data table.
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Reporting Step What the System Does?

Validate The system takes the royalty transaction data and checks 
whether:

○ Valid master data exists for reporting
If no valid master data file exists for a particular re­
cord, it is flagged as Rejected.

○ All the cross-references required for reporting have 
been created
If not all of the required cross-references exist for a 
particular record, it is flagged as Rejected.

○ Suspension criteria have been created
If a record meets the suspension criteria, this indi­
cates to the system that the specific PRA or state en­
tity is not to be reported. The record in question is 
flagged as Suspended.

Extract The system reads the royalty data to be reported into a 
pending transactions table.

Process The system reads the pending transactions data and cal­
culates the reporting information at detail (PRA) and sum­
mary (state entity) level. It applies statute-of-limiatations 
criteria to the summary reporting information so that out-
of-statute records do not appear on the state report. You 
can later write off these records (see Tax Transaction Re­
porting).

Journalize The system reads all the pending transactions and creates 
trial journal entries for reconciliation reporting. For trans­
actions that are out of statute and therefore not reporta­
ble, the systems creates trial suspended journal entries 
that require further action (write-off approval and proc­
essing).

Finalize The system posts the trial journal entries. Trial suspended 
entries are posted as pending write-offs.

An application log is available for each of the steps on completion. For example, the application log for the 
Validate step shows all rejected royalty records with the reason for rejection.

6. On the other tab pages in the Report 2.0 Workplace, review the royalty records of the current run.

The following tabs are available:

○ PRA Details
Here you can view reportable transactions at detailed PRA level. You can also adjust, suspend, and 
download them if necessary.
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Note
It is only possible to adjust and suspend data when it is in Trial status. This means that you have not 
executed the Finalize step yet.

○ Report Details
Here you can view reportable transactions at the summarized state royalty level. You can also adjust 
transactions if necessary.

Note
It is only possible to adjust and suspend data when it is in Trial status. This means that you have not 
executed the Finalize step yet.

○ Journal Entries
Here you can analyze the trial journal entries resulting from royalty reporting.

○ Out of Statute
Here you can view transactions that meet statute-of-limitations criteria and do not need to be 
reported.

7. When you are ready to finalize the report, run the Finalize step.

The system completes the processing of the reporting parameters for the month and year that you 
specified and creates offsetting journal entries.

Results

You can create an EDI file to submit the royalty report to the state.

19.19.5  Royalty Transaction Reporting

Use

The Report 2.0 Portal includes several reports that allow you to list the royalty transactions from current and 
finalized royalty report runs for analysis purposes. In some reports, you can also modify the data. You can 
access these reports through the Report 2.0 Portal by choosing Periodic/Ad Hoc Processing <State>

Features

Reports for Wyoming

The following table explains the reports that are available for tax transactions reported on the Wyoming oil and 
gas reports tax reports.

632 C U S T O M E R
SAP Oil & Gas (PRA - Production and Revenue Accounting)

Tax Reporting 



Table 163:

Report Use

Royalty Transactions (transaction 
O3UY6_DISP_WY_ROYTXN)

You use this report to list the pending, rejected, or sus­
pended tax transactions of a trial royalty report run.

Up-to-Date Reported Wyoming Transaction (transaction 
O3UY6_DISP_WY_ROHST)

You use this report to list the royalty transactions from a 
specific sales month that have already been reported to the 
state.

Royalty Variance (transaction O3UY6_DISP_WY_RPTVAR) You use this report to show the difference between the roy­
alty amounts reported for two reporting months.

List of Out-of-Statute Write-Offs (transaction 
O3UY6_DISP_WY_OOSWO)

You use this report to list the write-off records for out-of-
statute transactions that have been written off.

Royalty Balancing Report (transaction 
O3UY6_DISP_BAL_RPT)

You use this report to display the current and amended re­
porting summary and detail transactions for a given report 
run ID. You can use this report to display a particular lease 
for a particular report run, or you can display it for all leases 
on a report run.

This report provides you with a summary transaction 
amount record for a given sales month, lease, PSA, and 
product code. The PRA details for the key are displayed. In 
addition to the information provided on the summary report, 
it also provides the ventures, DOIs, and company code. If 
there is a difference between the transaction amount from 
the summary record and the sum of the detail records, the 
difference is displayed as well.

OPSL Balancing Report (transaction 
O3UY6_DISP_PAY_RECON)

You use this report to reconcile transaction amounts be­
tween the owner’s payable (OPSL) subledger, the VL docu­
ments or journal entries that are the source for the Wyoming 
royalty report, and the amount the Wyoming royalty report 
shows will be paid to the state.

This report provides you with a detailed reconciliation for a 
given venture, DOI, owner, sales month, and product code. 
For the key data, it displays the OPSL transaction amount, 
the extracted amount (which is the amount from the VL 
document or other posted journal entry), any suspended 
amount, any out of statute amount, and any rejected 
amounts.

User Royalty Transaction (transaction 
O3UY6_UPD_WY_ROYTXN)

You use this report to add a royalty transaction. This is an ex­
ception-based transaction. Consider the ramifications of the 
impact of adding in this window.

Out-of-Statute Write-Off (transaction 
O3UY6_UPD_WY_OOS_WO)

You use this report to list out-of-statute transactions and 
then write them off.
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Report Use

Royalty History (transaction O3UY6_UPD_WY_ROYHST) You use this report to list the royalty transactions from a 
specific period that have already been reported to the state.

Here, you can also adjust reported values. This is useful if 
discrepancies develop between your reported royalty history 
in your system and the state’s official reported history for 
you.

Reports for Texas GLO/TAMU

The following table explains the reports that are available for tax transactions reported on the Texas GLO/
TAMU reports tax reports.

Table 164:

Report Use

Texas GLO/TAMU Royalty Transaction (transaction 
O3UY6_DISP_TX_ROYTXN)

You use this report to list the pending, rejected, or sus­
pended tax transactions of a trial royalty report run.

Up-to-Date Reported Texas GLO Transaction (transaction 
O3UY6_DISP_TX_ROYHST)

You use this report to list the royalty transactions from a 
specific sales month that have already been reported to the 
state.

Texas GLO/TAMU Royalty Variance (transaction 
O3UY6_DISP_TX_RPTVAR)

You use this report to show the difference between the roy­
alty amounts reported for two reporting months.

List of Texas GLO OOS Write-Offs (transaction 
O3UY6_DISP_TX_OOSWO)

You use this report to list the write-off records for out-of-
statute transactions that have been written off.

Texas GLO/TAMU Balancing (transaction 
O3UY6_DISP_BAL_RPT)

You use this transaction to display the current and amended 
reporting summary and detail transactions for a given report 
run ID.

This transaction can be used to view a particular lease for a 
particular report run, or you can view it for all leases on a re­
port run. This report provides you with a summary transac­
tion amount record for a given sales month, GLO lease, dis­
trict no., RRC ID, and purchaser ID. In addition, the PRA de­
tails for that key are displayed. In addition to the information 
provided on the summary report, it also provides the ven­
tures, DOIs, and company code. If there is a difference be­
tween the transaction amount from the summary record 
and the sum of the detail records, the difference is also dis­
played in the right screen area of the report.
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Report Use

Texas GLO/TAMU Payables Reconciliation (transaction 
O3UY6_DISP_PAY_RECON)

You use this report to reconcile transaction amounts be­
tween the owner’s payable (OPSL) subledger, the VL docu­
ments or journal entries that are the source for the Texas 
GLO royalty report, and the amount the Texas GLO royalty 
report shows is paid to the state.

This report provides you with a detailed reconciliation for a 
given venture, DOI, owner, sales month, and product code. 
For the key data, it displays the OPSL transaction amount, 
the extracted amount (which is the amount from the VL 
document or other posted journal entry), any suspended 
amount, any out of statute amount, and any rejected 
amounts.

Texas GLO User Royalty Transaction (transaction 
O3UY6_UPD_TX_ROYTXN)

You use this report to add a royalty transaction. This is an ex­
ception-based transaction. Consider the ramifications when 
you add information in this transaction.

Texas GLO/TAMU Out-of-Statute Write-Off (transaction 
O3UY6_UPD_TX_OOS_WO)

You use this report to list and write off records for out-of-
statute transactions that must be written off.

Texas GLO/TAMU Royalty History (transaction 
O3UY6_UPD_TX_ROYHST)

You use this report to list the royalty transactions from a 
specific period that have already been reported to the state.

You can also adjust reported values, which is useful if dis­
crepancies develop between your reported royalty history in 
your system and the state’s official reported history for you.

19.20  Escheat Process

Prerequisites

● You have configured the system using the following Customizing activities in Customizing for Industry 
Solution Oil & Gas (PRA) under Process 2.0 Enhancements :

Note
For these Customizing activities, predefined entries are delivered by SAP. Do not modify these entries.

○ Maintain Process Types
This Customizing activity controls the workplace for each process type, which means Escheat, 
Wyoming Escrow.
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○ Maintain Process Type Tabs
This Customizing activity controls the tabs that appear in the Process Workplace for a given process 
type.

○ Maintain Processes
This Customizing activity contains technical attributes for the particular process within the Process 
Workplace. Examples include the class, process type and so on.

○ Maintain Process Steps
This Customizing activity defines the steps that comprise each process.

○ Maintain Prerequisite Step Status
This Customizing activity contains the control table that defines prerequisites for each process step.

● You have configured the system using the following Customizing activities in Customizing for Industry 
Solution Oil & Gas (PRA) under Process 2.0 Specific Configuration Escheat :

Note
You can configure these Customizing activities according to your requirements.

○ Maintain Process Group
This Customizing activity enables you to group several states to run as one process or setup 
individually to run at the individual state level.

○ Maintain Minimum Age
This Customizing activity enables you to set up escheat criteria for different states. Criteria include 
dormancy period (in months) and the Pay to Current checkbox.

○ Maintain Process Group / State XRef
This Customizing activity enables you to tie states to process group, which allows you to tie multiple 
states with the same reporting dates to one process group if desired.

○ Maintain State Smartform Configuration
This Customizing activity enables you to tie states to specific smartforms.

○ Maintain Excluded Suspense Reason Codes
This Customizing activity allows you to specify suspense reason codes to be EXCLUDED from the 
population of data to be considered for escheat.

Context

Escheat rules apply to the 50 states and the District of Columbia to report unclaimed funds [escheat. The basis 
for Escheat is PRA legal suspense and is based on the state of residency. You use this procedure to manage the 
process tracking and submitting payments for escheatable revenues to various states.

You use PRA Escheat for the following activities:

● Determine which suspended funds are eligible for escheat
● Filter PRA legal suspense subledger that is used during processing
● Create state reporting data
● Create escheat report
● Post offsetting journal entries

The escheat process is executed twice a year, once beginning in January for states that require reporting during 
the spring of the year, and once beginning in July for states that require reporting during the fall of the year.
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Procedure

1. Use transaction O3UE2_SFI for the suspended funds inquiry.

The detail and summary view of the owner suspense with filter criteria based on:

○ State level inquiry
○ Aging capability
○ Suspense reason codes
○ Debit balance inquiry
○ Minimum balance

This transaction allows you to directly display information and determine the owners who will become 
escheatable. In addition, it enables you to monitor real-time suspense balances potentially subject to 
escheat, which serves the following purposes:

○ Legal suspense inquiry
○ Legal suspense inquiry leading up to escheat analysis

2. Access the Process 2.0 Portal on the SAP Easy Access screen under Logistics Production and Revenue 
Accounting Process 2.0 Portal , or use transaction O3UE2_PORTAL_004.

3. Create escheat master data:
1. If you need to generate due-diligence letters for any owners:

On the Process 2.0 Portal screen, choose Master Data Escheat Escheat Due Diligence Address 
Maint  (transaction O3UE2_ESCHEAT_ADDR).
The Escheat Due Diligence Address Info dialog box appears. Enter the necessary address information.
Transaction 03UE2_ESCHEAT_ADDR allows you to enter the company address and contact info used in 
the due diligence letter.

2. On the Process 2.0 Portal screen, choose Master Data Escheat Escheat Holder Record 
Maintenance  (transaction O3UE2_ESCHEAT_HOLDER).
Transaction O3UE2_ESCHEAT_HOLDER allows you to enter holder information for the NAUPA file 
reporting requirements.

3. To ensure that the data you have for business associates complies with state rules and regulations 
regarding escheatable funds, you will need to maintain information for business associates.
To do so, on the Process 2.0 Portal screen, choose Master Data Escheat Escheat BA Info 
Maintenance  (transaction O3UE2_ESC_BA). You can modify existing data and add information, such 
as date of birth, that is not normally included in business associate records but is required for escheat 
processing.

4. View escheat process data and schedule process run steps. To do so, on the Process 2.0 Portal screen, 
choose Periodic/Ad Hoc Processing Escheat Escheat Workplace  (transaction 
O3UE2_WORKPLACE_002).

1. Enter a state or a group of states.
2. Enter values on the selection screen.
3. On the Admin/Execution tab, select the process group and process date. The Process Run Steps 

screen area displays the process run steps along with the status. The Process Workplace is broken 
down by a process of 5 steps:
1. Extract
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The state rules you have configured in Customizing are used to determine what is extracted. 
Dormancy period and pay-to-current are defined by state. The suspense reason code you have 
configured in Customizing for a company is used to determine the criteria for extraction.

2. Due Diligence Letters
This step creates the due diligence letters.

3. Process
This step marks the owners as escheated and creates the NAUPA format.

4. Journal Entry
This step creates the journal entries offsetting the entry to the escheat summary account.

5. Finalization
This step posts journal entries and creates escheat history for subsequent user inquiry of 
escheated balances.

From here, you can schedule process run steps or cancel steps that have been scheduled but not yet 
run.

4. On the Owner Summary tab, review the owner summary. Use the fields in upper screen area to filter 
the owners that are displayed under the Owner Summary screen area.
Owners data can be maintained and modified here. For instance, you can select the Do Not Escheat 
checkbox if you want to exclude an owner from the Escheat processing.
If you want to enter a comment to an owner, choose the link in the CM (Comment) column next to the 
relevant owner. You can review due diligence letters for an owner by choosing the link in the DD column 
next to the relevant owner. The Esch Hist checkbox indicates whether the owner has been involved in 
the escheat process in the past.

5. On the Owner Details tab, you can review further details of an owner.
6. The Report Details tab includes three subtabs:

○ On the Holder subtab, you can display the data you have created for the holder. (See step 2b, 
above.)

○ On the Property subtab, enter a state code in the Resident State Code field and execute it to 
display a data list concerning all escheatable properties for that state.

○ On the Summary subtab, you can display the high-level data concerning what you have escheated 
to the state.

7. On the Journal Entries tab, review the accounting history for of the funds for finalized escheats. Use the 
fields in the upper screen area to filter the journal entries that are displayed under the Journal Entries 
screen area.

5. Use the suspended funds inquiry to review balances for all suspended funds in the system.

1. To do so, on the Process 2.0 Portal screen, choose Periodic/Ad Hoc Processing Escheat
Suspended Funds Inquiry  (transaction O3UE2_SFI).

2. Enter the parameters for funds you want to review.
3. In the Output Option screen area, either select the Summary (with drill down) radio button, if you want 

a report that allows you to review the suspended funds summed by owner and drill-down to the details 
per owner, or select the Detail (no drill down) radio button for a list of all records.

4. A list of records that corresponds to your selected parameters is displayed indicating the total 
escheatable balances.

6. To view a full history, maintained for audit-trail purposes, for all escheat data, on the Process 2.0 Portal 
screen, choose Periodic/Ad Hoc Processing Escheat Display Owner Escheat History  (transaction 
O3UE2_ESCH_DISP_HIST). Transaction O3UE2_ESCH_DISP_HIST allows you to to display escheated 
history and print out escheated detail for specific escheated BA.
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19.21  Wyoming Escrow Process

Prerequisites

● You have configured the system using the following Customizing activities in Customizing for Industry 
Solution Oil & Gas (PRA) under Process 2.0 Enhancements :

Note
For these Customizing activities, predefined entries are delivered by SAP. Do not modify these entries.

○ Maintain Process Types
This Customizing activity controls the workplace for each process type, which means Escheat, 
Wyoming Escrow.

○ Maintain Process Type Tabs
This Customizing activity controls the tabs that appear in the Process Workplace for a given process 
type.

○ Maintain Processes
This Customizing activity contains technical attributes for the particular process within the Process 
Workplace. Examples include the class, process type and so on.

○ Maintain Process Steps
This Customizing activity defines the steps that comprise each process.

○ Maintain Prerequisite Step Status
This Customizing activity contains the control table that defines prerequisites for each process step.

● You have configured the system using the following Customizing activities in Customizing for Industry 
Solution Oil & Gas (PRA) under Process 2.0 Process Specific Configuration Wyoming Escrow :

Note
You can configure these Customizing activities according to your requirements.

○ Maintain Process Groups
This Customizing activity allows you to group several companies to run as one process or setup 
individually to run at the individual company level.

Note
For group companies, only install company should be grouped with appropriate sub-companies 
(MUST match checkwrite configuration). All other companies must run individually (just as with 
checkwrite run requirements).

○ Maintain Excluded Suspense Reason Codes
This Customizing activity allows you to specify suspense reason codes to be EXCLUDED from the 
population of data to be considered for Wyoming escrow.
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Context

The Wyoming Escrow process is executed once a month and is executed for the state of Wyoming legal 
suspense for the state of production. You use this procedure to handle the process submitting payments for 
escheatable revenues to various states.

The Wyoming Escrow process is executed once a month and is submitted from the payment processing 
workplace through a checkwrite.

Procedure

1. Use the suspended funds inquiry to review balances for all suspended funds in the system.

To do so, on the Process 2.0 Portal screen, choose Periodic/Ad Hoc Processing Wyoming Escrow
Suspended Funds Inquiry  (transaction O3UE2_SFI).

1. Enter the parameters for funds you want to review.
2. Detail and summary view of owner suspense with filter criteria based on the property interest in the 

state of Wyoming. The user can determine if this is the first time the owner is in suspense and/or the 
owner has been previously escrowed.

3. In the Output Option screen area, either select the Summary (with drill down) radio button if you want a 
report that allows you to review the suspended funds summed by owner and drill-down to the details 
per owner, or select the Detail (no drill down) radio button for a list of all records.
A list of records that correspond to your selected parameters is displayed indicating the total escrowed 
balances. The inquiry view for analysis prior to running the Wyoming Escrow process allows you to 
monitor real-time suspense balances potentially subject to Wyoming Escrow. Access the Process 2.0 
Portal on the SAP Easy Access screen under Logistics Production and Revenue Accounting
Process 2.0 Portal , or use transaction O3UE2_PORTAL_004.

2. Create vendor record address data to ensure that it complies with Wyoming’s escrow requirements 
regarding formatting, order, and content.

3. On the Process 2.0 Portal screen, choose Periodic/Ad Hoc Processing Wyoming Escrow Address 
Maintenance  (transaction O3UE2_WY_ESCROW_ADDR). The transaction 3UE2_WY_ESCROW_ADDR allows 
you to create the override bank address for BA’s paid through the Wyoming Escrow process.

4. Display Wyoming escrow process data and schedule process run steps. On the Process 2.0 Portal screen, 
choose Periodic/Ad Hoc Processing Wyoming Escrow Wyoming Escrow Workplace  (transaction 
O3UE2_WORKPLACE_001).

1. On the Admin/Execution tab, select the process group and process date.
The Process Run Steps screen area displays the process run steps along with status. The following 
Escheat process run steps are available: For a new run, enter parameters for the desired company and 
process date.
The Process 2.0 Workplace is broken down by a process of 5 steps:
1. Extract

The user extract is based on dormancy period of 60 days post sales date and/or the owner has 
been previously escrowed. The suspense reason code you have configured in Customizing for a 
company is used to determine the criteria for extraction. After the extract is done, the owner 
summary and owner detail information is available for analysis. You can drill-down from the owner 
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summary information to details. In addition, at owner detail level, you can select the Do Not Escrow 
checkbox for individual entries.

2. Journalize
This step creates the journal entries offsetting the entries from legal suspense to owners payable. 
When the Wyoming Escrow journalization is completed, you can display the trial journal entries 
created through the process.

3. Post
This step posts the journal entries. After the post step is run, you can display the journal entries 
created to move the suspended entries to the payable subledger. These journal entries are the 
source transactions to be paid in Wyoming Escrow process.

4. Check Run
This step reads in only the owners payable posted in the post step and creates a check print file. 
Journal entries offsetting owner’s payable, and the entry to summary clearing. The check run 
process submits an owner level checkwrite and then collects the results of the run once complete. 
The tabs available after the check run create tabs with the following information:
○ the original run parameter
○ the check register information generated by the run
○ the check detail information generated by the run
○ rejections encountered during the check run

5. Finalization
This step updates the status to final and creates escrow history for subsequent user inquiry and 
use in processing.

From here, you can schedule process run steps or cancel steps that have been scheduled but not yet 
run.

2. The Check Run tab includes four subtabs: Use the Parameters, Check Register, Check Details, and 
Check Rejects subtab to view details for the check run.

3. On the Owner Summary tab, review the owner summary. Use the fields in the upper screen area to 
filter the owners that appear under the Owner Summary screen area. Owners data can be maintained 
and modified here. For instance, you can select the Do Not Escrow checkbox if you want to exclude an 
owner from Wyoming escrow processing. If you want to enter a comment to an owner, choose the link 
in the CM (Comment) column next to the relevant owner.

4. On the Owner Details tab, you can review further details of an owner. Also, at the owner detail level, 
individual entries can be flagged as ‘do not escrow’.

5. On the Journal Entries tab, review the accounting history for of the funds for finalized Wyoming escrow. 
Use the fields in the upper screen area to filter the journal entries that appear in the Journal Entries 
screen area.

5. To display a complete history, maintained for audit-trail purposes, for all escheat data, on the Process 2.0 
Portal screen, choose Periodic/Ad Hoc Processing Wyoming Escrow Wyoming Escrow Owner 
History  (transaction O3UE2_ESCROW_HISTORY).
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19.22  Taxes Payable Reconciliation

Purpose

You use this process to manage and reconcile taxes payable (TP) balances in the Taxes Payable Reconciliation 
Portal , which you access from the SAP Easy Access screen by choosing Logistics Production and Revenue 
Accounting Tax Reporting Taxes Payable Reconciliation Portal  .

TP balances arise when there are discrepancies between the taxes payable that are recorded in the taxes 
payable subledger (TPSL) and the offsetting journal entries that are created from tax reporting. In this process, 
you summarize TP balances from the TPSL to a TP summary table. You can subsequently manage and 
reconcile balances at a higher level than the detailed batch level of the TPSL. The summery tables also allows 
you to retrieve balances more quickly than in the TPSL due to the smaller amount of information.

Prerequisites

You have made the settings for taxes payable reconciliation in Customizing for Industry Solution Oil & Gas 
(Production and Revenue Accounting) by choosing Production, Tax, and Royalty Reporting Tax Reporting
Tax 2.0 General Configuration  and Production, Tax, and Royalty Reporting Tax Reporting Taxes 
Payable Reconciliation  .

Process Flow

1. You configure write-off accounts under account category 19 Taxes Payable Write-Off .
For more information about setting up accounts, see JE Account Master Data Creation [page 436] .

You must set up a write-off account for every company, even if you are not reconciling taxes payable balances 
for all companies. Otherwise, an error occurs during the JE accounting period close.

1. You convert the TP balances from the TPSL to the summary balance table according to company code , 
venture number, DOI number, product, sales month, state code, and tax code .
You do this in the Taxes Payable Reconciliation Portal by choosing Periodic/Ad HocProcessing Taxes 
Payable Workplace  .

Note
You can convert either current balances or historical balances. However, converting current balances will 
result in a lot of out-of-balance records.

2. You configure automatic write-off so that the system can automatically write off TP balances from a 
specific company code that are under both a certain age and a certain amount. The system writes off 
balances that meet the criteria during the JE accounting period close.
You configure automatic write-off in the Taxes Payable Reconciliation Portal by choosing Periodic/Ad Hoc 
Processing Set Up Taxes Payable Write-Off  .
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For more information about the accounting period close, see Carrying Out the JE Monthly Accounting 
Period Close [page 454] .

3. You purge the relevant taxes payable account. This moves TP balances that equal zero from the summary 
balance table to a summary balance history table and the related TPSL record to the TPSL history table.
Yourun the purge processby choosing Logistics Production and Revenue Accounting Revenue 
Accounting Journal Entry Utilities JE Offset Purge  .
For more information, see Carrying Out an Offset Purge [page 466] .

4. You create responsibity IDs and assign to them to users. You use these responsibility IDs later to assign 
summary balances to users.
You manage responsibity IDsin the Taxes Payable Reconciliation Portal by choosing Periodic/Ad Hoc 
Processing Maintain Taxes Payable Resp. ID  .

Result

You can now open the summary balance table and manage TP balances as required. Summary balances are 
updated as the TPSL is updated in the JE posting process. In addition to inserting and updating summary 
balances, the JE post also automatically purges balances that equal zero. During JE accounting period close, 
the system automatically writes off balances that fulfil the automatic write-off criteria.

You access the summary table through the Taxes Payable Reconciliation Portal by choosing Periodic/Ad 
HocProcessing Taxes Payable Workplace  .For more information about the available features, see The Taxes 
Payable Workplace [page 643] .

19.22.1  The Taxes Payable Workplace 

Use

You use this function to manage taxes payable (TP) balances.

Prerequisites

For more information, see Taxes Payable Reconciliation [page 642] .

Features

In the Taxes Payable Workplace , you can:

● View current and historical TP balances
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● Create and update balance comments
● Categorize a balance with configurable category codes
● Perform mass categorization of balances
● Apply a target date for mass reconiciliation of balances
● Initiate, cancel, and approve the write-off of individual balances
● Drill down from a summary balance to the detailed TPSL entries
● View balances by age, responsibility ID, and write-off history
● View write-off history
● Use the standard SAP List Viewer (ALV) to sort, filter, total, sub-total, hide, or change the order of report 

columns

644 C U S T O M E R
SAP Oil & Gas (PRA - Production and Revenue Accounting)

Tax Reporting 



20 PRA Tools 

Purpose

PRA provides the following tools:

Table 165:

PRA Tool Description

Bitmap / Flashform Maintenance Flashforms are templates that you can download, which you 
use to send reporting data to reporting agencies, in hard­
copy (paper) form.

Bitmaps are templates that you can use to graphically por­
tray a network.

● The PRA Common Table A central PRA table used in a wide variety of PRA applica­
tions.

The PRA Report Driver The Report Driver is a centralized, standardized tool that is 
used to submit most of the tax, royalty, and production re­
ports in Production & Revenue Accounting.

List Processing Used to retrieve, sort, and review data.

Reviewing Changes to PRA Data Tools for reviewing changes to PRA data.

20.1 Bitmap/Flashform Maintenance 

Purpose

PRA provides tools for displaying transactional data in graphical form and for creating hardcopies (paper 
copies) of reporting data. Flashforms and bitmaps are templates stored in the ERP system, which you can 
download and use for those purposes.
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Table 166:

Tool Description

Flashforms Flashforms are pre-configured templates that allow you 
to put PRA reports into a format that allows you to print 
them and send them to regulatory agencies as a hardcopy 
(on paper).

Flashforms are reporting templates stored in the ERP sys­
tem, which are used to put specific report data into the 
proper form for printing. There is a flashform for each 
PRA report.

Bitmaps Templates that you can use to graphically depict a network.

You have to first download the flashforms from the ERP sytem to your local PC (this is a one-time activity), and 
then download the specific report data (a data file) from the ERP system to your PC.Then, you can print the 
report and send it to the relevant agency.

Prerequisites

Transactional data for the reports (production regulatory reports, tax reports, royalty reports) has to already 
have been created in the ERP system.

See also:

Downloading Reporting Flashforms [page 646]

Uploading Reporting Flashforms [page 647]

Deleting Reporting Flashforms [page 648]

Using Flashforms in MS-Word [page 649]

Printing and Submitting Reports [page 651]

20.1.1  Downloading Reporting Flashforms 

Use

Use this to download and install reporting flashforms to a local drive (to your PC). In order to use flashforms, 
you have to first have them available locally. You download the flashforms from a table in the ERP system.

The folder that you download the templates to should be the same target folder on your PC that you are going 
to use to put the report data into your Word document in order to print it. The target folder should thus be the 
same as the target folder that you choose in Using Flashforms in MS-Word [page 649] .
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Procedure

1. From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production, Tax 
and Royalty Reporting → Flashforms Maintenance → Download Reporting Flashforms .

The Download Flashforms screen appears.

1. Select Execute .

The Browse for Folder dialog box appears.

1. Using this dialog box, select the location on your PC (locally) that you want to download the flashforms to, 
and then select OK .

The Download Bitmaps/Flashforms screen is displayed. The screen lists all the flashforms that are available for 
downloading.

1. From the list, select the flashform(s) that you would like to download (to select them all, choose Select All 
Entries ).

2. Select Download Selected Entries .

Result

The flashforms are downloaded to your PC to the folder you chose. You can now use them to create hardcopies 
for submitting reports (see: Using Flashforms in MS-Word [page 649] ).

20.1.2  Uploading Reporting Flashforms 

Use

Use this to upload flashforms from a local file. Flashforms have to be uploaded to the ERP system before other 
users can download them from the ERP system, and use them.

SAP delivers standard reporting flashforms, which are stored in the ERP system. It is possible to create your 
own flashforms and upload them to the ERP system, using this transaction. The flashforms created in that way 
are, however, not considered part of the SAP standard flashforms.

Procedure

1. From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production, Tax 
and Royalty Reporting → Flashforms Maintenance → Upload Reporting Flashforms .

The Upload Flashforms screen appears.
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1. Select Execute .

The Select Flashforms to upload dialog box appears.

1. From the dialog box, select the file that you would like to upload, and then select Open .

The Bitmap/Flashform Maintenance screen appears. On the screen, you will see the list of flashforms that you 
uploaded, as well as the status (“uploaded successfully”).

Result

The flashforms are uploaded and can now be downloaded to individual users’ PCs.

20.1.3  Deleting Bitmaps and Flashforms 

Use

For information about deleting bitmaps or flashforms, choose one of the following:

● Deleting Upstream Graphics Bitmaps [page 83]
● Deleting Reporting Flashforms [page 648]

20.1.3.1  Deleting Reporting Flashforms 

Use

Use this to delete flashform files that have been uploaded.

You might want to delete files that have already been uploaded, for example, if the version of the file has 
become outdated.

Deleting flashforms files makes them not only unavailable to you, but also unavailable to other users. SAP 
recommends that you first consider this before deleting any files, and ensure that the file is indeed outdated 
and that no other users will need to use them in future, before you delete any of them.

Procedure

1. From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Production, Tax 
and Regulatory Reporting → Flashforms Maintenance → Maintain Reporting Flashform s.

The Bitmap/Flashform Maintenance screen is displayed.
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1. Select Execute .

The Bitmap/Flashform Maintenance screen is displayed, with the list of flashforms.

1. Select the files that you would like to delete.
2. Select Delete .

20.1.4  Using Flashforms in MS-Word 

Use

Use this to format MS-Word for specific reporting flashforms.

In order to be able to print reports as hardcopy, you first need to format Word for flashforms, both generally, 
and also for each specific report that you want to print and submit. Formatting Word means:

Adding a macro to Word, which adds a PRA Reports menu option on your Word interface, and

Adding a drop-down menu option under that menu option for each report that you would like to print and send 
to the relevant regulatory agency.

Prerequisite

You have to have already downloaded flashforms for the reports that you would like to format here from the 
ERP system to your PC. You have to have the reports saved locally so that you can put them into Word format. 
The target folder that you access here has to be the same as the one you saved the flashforms to in 
Downloading Reporting Flashforms [page 646] .

Formatting MS-Word so that you can put your report data into Word documents consists of the following 
procedures (to be carried out in the order listed here)
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Table 167:

I. Formatting report templates into your MS-Word document:

Open MS-Word.

Chose File à New

Select General à Templates (this is the target folder that you saved your templates to).

Select the report template that you would like to format into your Word document.

Under the Create New screen area, select the Document radiobutton.

Select OK .

The report is formatted into your Word document.

II. Installing a PRA Reports menu option on your MS-Word interface (one-time activity). This procedure runs a macro, which 
inserts a PRA Reports menu option into your MS-Word interface.

Proceed as follows:

1. From the Microsoft Word menu bar, choose Tools → Macro → Macros .

The Macros dialogbox appears.

1. From the Macros list that is displayed, select the ’SetUp*****.MAIN’ macro for the flashform that you would like to use 
(where ***** is the name of the specific report), and then select Run (this runs the macro).

2. In the Word menu, verify that the installation worked – if there is a PRA Reports pushbutton on the menu now, installa­
tion is complete.

III. Using the PRA Reports menu item to display reporting data in Word

This puts the actual reporting transactional data (volumes, etc.) into your prepared report in Word:

1. Open MS-WORD
2. In Word, choose PRA Reports , and under it, the report that you would like to display.

A new document is created.

1. The Insert File dialog box appears, prompting you to choose the file on your local drive, where you saved the relevant 
report data.

2. In the dialog box, select the file. When you select it (which highlights that file in the dialog box), the Insert pushbutton is 
now visible and active in the dialog box.

3. Select Insert .

The reporting data that you chose is now placed into your Word document.

Result

You can now print and submit reports (see: Printing and Submitting Reports [page 651] ).
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20.1.5  Printing and Submitting Reports 

Use

Use this to print out reports, in order to be able to send the paper copy of them to the relevant reporting 
agency.

Prerequisites

● You have to have first downloaded the flashform file for the report to your PC (see: Downloading Reporting 
Flashforms [page 646] ).

● You have to have formatted your Word interface for your reports, so that a PRA Reports menu option 
appears on your Word interface (see: Using Flashforms in MS-Word [page 649] ). This allows you to print 
the report data for each report.

Procedure

1. Open MS-Word.
2. In the Word menu, under the PRA Reports menu option, choose the report that you would like to submit.

The Insert File dialog box appears.

1. From the dialog box, select the relevant flashform file (from the list of files you downloaded). This inserts 
the reporting data for that report into your open Word document, formatted for printing.

2. Review the data in the Word document to ensure that it is formatted properly, and that the data is correct.
3. Print out a hardcopy of the report (paper copy).
4. Verify the copy and sign it.

Result

You can now send the copy to the regulatory agency.

20.2 The PRA Common Table 

Definition

Within many PRA dialog screen fields, the dropdown list boxes (alternately referred to as "combo boxes") for 
fields such as 'Account Category', 'Major Product', etc., receive their values - their texts - from a single 
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"common table" (Table OIUH_CM_TT). The purpose of the Common Table is for validation of input field entries, 
and the Common Table is made up of a number of individual PRA tables. In effect, it functions as a central 
master table for PRA.

The various drop-down box texts are accessed based on the value of the TT_TT_NO column in that table, which 
identifies the dropdown table ID (the table against which validation is taking place).

Example

In transaction OIUH_DO08 ("DOI Owner Accounting Entry Code: Initial Screen"), the field 'major product' is 
linked to a pre-filled combo box. The contents of that dropdown box are extracted from the OIUH_CM_TT table 
using Table ID TBLCM03. Similarly, the contents of the 'Account Category' dropdown box are filled using table 
ID TBLRV016.

You can add a new text option in the dropdown box for a field. To do that, a new entry needs to be added in the 
Common Table. Each entry in that table has a Table ID (field TT_TT_NO), a description (field TT_ELEM_DE), 
and an internal code (field TT_ELEM_NO), unique within the Table ID.

When an end-user selects from the dropdown box, the dialog code receives the internal code associated with 
the text line in the dropdown box.

You can view the PRA Common Table and its contents (all the possible texts for the combo boxes). To do so, 
use the Data Browser (transaction code SE 16 and then enter the name of the table - OIUH_CM_TT).

20.2.1  Using the PRA Common Table

Use

This report is used to run a database search on the " PRA Common Table [page 651] " in PRA (Table 
OIUH_CM_TT). You can base your search on table group (PRA application) and/or table name.

From the Common Table maintenance screen, when you run a selection (by selecting Execute), you are taken 
to the Table Group List. The Table Group List is a list of all the relevant tabels for your search (all the tables for 
that PRA application or that table name).

On the Table Group List, when you select a table (the tables names are underlined in the list, and to select one, 
just put your cursor on the underlined table name), you are taken to the "Type Detail" screen, which is a list of 
individual records for that table. Also on that screen, you can often access documentation explaining the 
specific table. To access it, from the "Type Detail" screen, select the blue and white "I" (information) icon.

You can also search based on table name. For example, if you are interested in revenue-related tables, enter 
"revenue" in the Table Name field and execute your search.

On the initial screen, you can choose from the following table groups (PRA applications):

01 = Common Table

02 = Production

PR = Production
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03 = Check Input

04 = Regulatory Reporting

CI = Check Input

CM = Common

CS = Contracts

RD = Revenue Distribution

RR = Regulatory Reporting

TR = Tax and Revenue

Procedure

1. From the SAP Easy Access menu, choose Logistics → Production and Revenue Accounting → Tools → 
Common Table Maintenance → Common Table Maintenance .

20.3 List Processing

Use

Use list processing to retrieve and review data as required.

Activities

Using Multiple Selection

Often to the right of the input fields the system displays an icon with a yellow arrow. This is the Multiple 
selection icon, which allows you to enter multiple sets of data as criteria for the system to use when executing a 
report. For example, you could use the Multiple selection feature to specify more than one range of numeric IDs 
(1-50 and 60-100) and at the same time exclude a value (not ID number 75).

If more than one selection is entered, the system displays the arrow in green because the system cannot 
display all of the selection criteria on the initial screen at one time.
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Multiple Selection Features

Table 168:

Feature Description

1. Select single values Use this to enter single values to be retrieved for the report.

2. Select ranges Use this to enter a range of values to be retrieved for the re­
port.

3. Exclude single values Use this to enter single values to be excluded from the re­
port.

4. Exclude ranges Use this to enter a range of values to be excluded from the 
report.

5. Entity lookup Enables a lookup on the entity.

6. Delete entire selection Delete all values that you entered in the dialog box.

7. Delete line Deletes the value from the line in which the cursor is placed.
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8. Insert line Inserts a new line above the field on which the cursor is 
placed.

9. Selection operators Retrieves a list of selection operators ( , ≥ , , , , ) that can be 
used with the input values.

Using Selection Screen Variants

Use a variant to establish a set of values that will be used on a regular basis to run a report. By setting up a 
variant, you eliminate the need to enter a set of data more than one time. When you retrieve a variant, the 
values you specified in the variant default into the corresponding fields on the screen.

Creating a Variant

1. On the List Processing screen, enter the values to be included in the set of values for the variant.

2.
Any values that you include by using Multiple Selection are included in the variant.

3. Choose Goto  Variants  Save as variant  .
4. In the Variant name field enter a name or ID for the variant. In the Description field enter a description for 

the variant.
5. Choose Save to return to the List Processing screen.

Retrieving a Variant

1. From the List Processing screen choose Goto  Variants  Get  .
2. The system displays a dialog box with a list of variants.
3. Select a variant and then choose Enter to return to the list processing screen.

The system inserts the values specified in the variant into the corresponding fields.

List Viewer Navigation Functions

After you choose a variant and/or enter data on the initial screen and choose Execute , the system displays the 
results on a List Viewer screen. Some of the functions available on the List Viewer screen follow.

Table 169:

Viewing Details of a Record 

● To view details of a record, select the appropriate record 
and choose Details .

Viewing Data in Ascending Order 

● To sort data in ascending order, select the column by 
which you will sort in ascending order. Then choose Sort 
in ascend. order .

Viewing Data in Descending Order 
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● To sort data in descending order, select the column by 
which you will sort in descending order. Then choose 
Sort in descend order .

Finding a Record 

● To find a record in the report, choose Find . Then enter 
selection criteria.

Using the Filter 

● To limit the number of records shown in the report, se­
lect the column for which you will set the filter. Then 
choose Set filter and enter criteria for the filter.

Printing the Report 

● To print the data displayed in the List Viewer, choose 
Print .

Export the Report 

● To save the data displayed in the List Viewer as a file, 
choose Export .

Changing the Format of the Report 

● To select a different format for the report, choose 
Views .

20.4 Reviewing Changes to PRA Data

Use

Use these transactions to identify changes to PRA data as well as related information about who made a 
change, when it was made, the name of the field containing the change, the old value in the field, and the new 
value in the field.

Procedure

Identifying the Object Name - Part 1 of 2
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1. At the SAP Easy Access menu, choose Tools  ABAP Workbench  Development  Workflow 
Definition Tools  Events  Event Creation  Change Documents  Overview  .

2. The Change Document Object: Overview screen appears.
3. In general, PRA objects begin with OIU . With this in mind, review the description of the object in order to 

identify the object name that relates to the changes you are looking for.
4. Note the object name (such as OIUREP_MRT_HIST, for example).

Identifying Data Changed in the Object - Part 2 of 2

1. At the SAP Easy Access menu, choose Tools  ABAP Workbench  Development  ABAP Editor  .
2. The ABAP Editor: Initial Screen appears.
3. In the Program field, enter RSSCD100 . Then choose Execute .
4. The Display Change Documents screen appears.
5. In the Object class field, enter the object name that you identified in the Change Document Object 

transaction (OIUREP_MRT_HIST, for example). Complete other fields as required.

6.
In the From date field, today's date defaults. To generate an overview that spans a broad range of dates, 
change the date in the From date field as required.

7. Choose Execute .
8. The Change Documents for Object Class <X> screen appears.
9. Double-click on an object to review the Detail: Display screen. You will then be able to review the data 

related to the change, such as user ID, date, time, transaction code, field name, the old value, and the new 
value.

20.5 Revenue Report Viewer 

Use

Use this transaction to view a variety of revenue reports.

For each report, the following categories of information may be available, depending on the data that the 
system generates:

● Errors display errors that occurred during the execution of the batch job
● Sysout displays information about how many records or transactions were generated
● Reports provide details about the data that was generated from the batch job

Note
The system displays data for these categories only when data is available; that is, if the system has not 
generated data for a particular category, you cannot access a view of a blank report without data.
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Activities

To access the Report Viewer, choose Logistics Production and Revenue Accounting Revenue Accounting
Report Viewer  .
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21 PRA Archiving 

Purpose

Production and Revenue Accounting (PRA) includes archiving features that allow you to create and store 
archive files with data from the SAP ERP System resulting from business processes that, once complete, no 
longer require the data.

Constraints

PRA Archiving does not support data retrieval for prior period adjustment (PPA) purposes.

21.1 Data Archiving with Archive Development Kit (ADK)

Context

Data Archiving removes mass data, which the system no longer needs, from the database, but which must still 
be available for reporting. For the most part, SAP's data archiving concept is based on the archiving objects of 
the Archive Development Kit (ADK).

Archiving Objects

Archiving objects describe the structure and context of the data to be archived. Predefined archiving objects 
are available for the applications for which data is to be archived. In data archiving, the system writes the data 
to archive files according to the relevant archiving objects and stores these.

Example
Financial Accounting documents are archived using the archiving object FI_DOCUMNT. This archiving object 
includes the document header, company code-specific postings, change documents, and related texts.

Steps for Data Archiving

Data archiving takes place in individual steps to ensure that only successfully archived data can be deleted. 
These are the three main steps:

SAP Oil & Gas (PRA - Production and Revenue Accounting)
PRA Archiving C U S T O M E R 659



● Writing the data to be archived to a new archive file
● Storing the archive files in an external store (optional)
● Deleting the archived data from the database starting from the archived files you have created

The following illustration describes the data archiving procedure.

Figure 1: Data Archiving in the SAP System

Procedure

1. Familiarize yourself with the specifics of ADK-based data archiving.

More information:

Properties and Features of Data Archiving [page 661]

Archiving Object [page 662]

Archive Administration [page 664]
2. Make the settings required for Customizing for data archiving.

More information: Customizing for Data Archiving [page 698]
3. Execute the data archiving.

More information: Executing Data Archiving [page 720]
4. Use the options for viewing and analyzing archive files.

More information:

Archive Information System [page 737]
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Archive File Browser [page 764]

Table Analysis [page 788]

Next Steps

Data Archiving in SAP NetWeaver AS [page 796] (available archiving objects)

21.1.1  Properties and Features of Data Archiving

Use

Properties of Data Archiving

As data archiving is integrated into the application, you have to be familiar with the semantics of the application 
data. Data archiving displays the following properties over and above saving table contents:

● Hardware independence
As the encryption of the numeric fields, for example, the integer is dependent on the hardware, information 
has to be added to the archived data about the hardware used.

● Release independent
As the data structure can depend on the SAP release, information about the record layouts and field 
definitions is also archived.

● Dependencies between data
Dependencies between data objects can be checked and taken into account for archiving.

● Company and business structure
Due to the possible dependence of archived data on the organizational structure of the company, the 
relevant information is also archived.

Data Archiving Features

● Data security
As a result of the separation between writing the data to the archive file and deleting the data from the 
database, the archiving transaction can be restarted if you encounter transfer errors. You can only delete 
the data once it has been successfully archived. You can achieve maximum security by optionally storing 
the archive files in an external storage system before deleting the archived data. You can define the storage 
time in archiving object-specific Customizing.

● Connection to an external store
You can use the following options for storing archive files:
○ Tertiary storage media, such as WORMs This can be done manually or automatically using the SAP 

Content Management Infrastructure (which also contains the ArchiveLink/CMS interface).
○ Hierarchical storage management systems (HSM systems) in the file system. The HSM system 

manages the archive files automatically. For storage of the archive files, the HSM system can also use 
tertiary storage media.

● Data compression
During archiving, data is automatically compressed by up to a factor of 5. However, if the data to be 
archived is stored in cluster tables, no additional compression takes place.
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● Archiving without database backup
As the data is either in the database or an archive file, you can archive data without database backup 
during normal system operation. However, SAP recommends that you backup archive files before storing 
them.

● Access to Archived Data
As the archived data has only been removed from the database and not from the application, it is available 
at any time. Archive Administration enables the following types of access:
○ (Read) access to a single data object, such as an accounting document
○ Analysis of an archive file (sequential read)
○ Reloading to the database (if supported for the archiving object)

● Automatic conversion of old archive files
When archived data is read, the system automatically makes the conversions required by hardware and 
software changes.
The Archive Development Kit (ADK) can make allowances for changes to database structures after the data 
was archived and for changes to hardware-dependent storage formats. The conversion does not affect the 
archived data. The following items are changed during automatic conversion:
○ Database table schema (new and deleted columns)
○ Data type of a column
○ Column length
○ Code page (ASCII, EBCDIC)
○ Number format (such as the integer on various hardware platforms)

If database structures in an application have undergone more changes than the ADK can handle (for 
example, if fields have been moved from one table to another or if one table has been divided into several 
separate tables), then a program is provided by the relevant SAP Business Suite solution for the 
permanent conversion of existing archive files.

● Memory space gain
As gaining an increase in memory space improves the performance of the application programs, you 
require information about the memory requirement of the data to be archived in the database and also the 
memory requirement of the archived files created.

1. Call up the ABAP Dictionary ( Tools ABAP Workbench Development Dictionary ).
2. Enter the name of each individual table, and choose Display.

21.1.2  Archiving Object

Use

The archiving object contains specifications for the archiving of your application data. It describes which 
database objects need to be bundled in order to obtain a completed business object that can be interpreted at 
the time of archiving, regardless of the technical conditions (such as release or hardware status).

An archiving object has a name of up to ten characters in length. You need this name to be able to execute the 
assigned archiving activities in Archive Administration (transaction SARA). The function for calling data 
archiving is often integrated in the application menu and the object name is set as the default.

Predefined Archiving Activities
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The archiving activity options (programs and steps to be executed) are defined in the archiving object. You 
create and define archiving objects with transaction AOBJ.

More Information

Sample Data Description Using an FI Document [page 663]

Data Object [page 663]

21.1.2.1  Sample Data Description Using an FI Document

Use

To ensure that archived FI documents remain available for evaluation, you need to store the technical and 
business environments together in the archive file. The respective data description ensures this.

The archiving object for FI documents FI_DOCUMNT, includes the following data, which is stored in different 
database tables:

● Document header
● Document segment accounting
● Document segment control data
● Document segment posting procedures
● Document segment CPD data
● Document segment change data
● Change documents
● SAPscript texts

21.1.2.2  Data Object

Use

A data object is the application-specific instance of an archiving object. While the archiving object describes 
only the logical connectivity of the data, the corresponding data object contains all of the application data from 
the database that is needed for the complete and consistent archiving of a business object.

A business object can contain the following types of data:

● Master data objects, such as material masters, customer masters, bills of material
● Transaction data objects, such as financial accounting documents, billing documents, and deliveries.

Structure of a Data Object
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A data object consists of the following:

● Header containing general information for identifying the data object
● Items that contain application data

Archiving

The Archive Development Kit (ADK) ensures that data objects are written sequentially to an archive file. All data 
objects in the archive file are set up according to the specifications in the archiving object.

More Information

Archiving object [page 662]

21.1.3  Archive Administration

Use

The most important actions relating to data archiving take place in Archive Administration. Archive 
Administration offers only those actions that have been defined for the archiving object.

You can access Archive Administration as follows:

● Transaction code SARA

● Menu path Tools Administration Administration Data Archiving
● Application Menu

Executing the Archiving Actions

You can schedule the following actions, for example, as a background job in Archive Administration:

● Preprocessing
● Creating archive files
● Deleting data from the database
● Storing archive files
● Postprocessing
● Reading archive files
● Filling or emptying the index for archive files

More information: Executing Data Archiving [page 720]

Administration

You can display and evaluate administration information in the overview of all archiving sessions for an 
archiving object.

More information:

Archive Administration: Overview of Archiving Sessions [page 672]

Calling Archiving Session Administration [page 673]
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Other Functions

You can choose the following menu options direct from the application bar or, depending on the action chosen, 
using Goto or Environment:

● Network Graphik [page 670]
● Reload [page 730]
● Customizing [page 698]
● Job Overview: Offers an overview of current archiving jobs and the functions available for processing them.
● Logs [page 692]
● Administration [page 672]
● Stored Files: Enables you to search for stored archive files according to various selection criteria.
● DB Tables [page 667]
● Information System [page 737]
● Statistics [page 688]
● Interrupting and Continuing [page 679]
● Check/Delete [page 695]: Cross-archiving-object check and delete function - available using Environment.

21.1.3.1  Archive Development Kit

Definition

The Archive Development Kit (ADK) is a tool for developing archiving solutions. It also prepares the runtime 
environment for archiving. From a technical viewpoint, it is an intermediate layer between the application 
program and the archive that provides all the functions required for archiving data.

Use

The ADK functions are required for archiving and for subsequent access to archived data. The ADK 
automatically performs the hardware-dependent adjustments (such as codepage and number format) and 
structural changes that are required when archive files are created. When the archive files are accessed later, 
the ADK temporarily converts data that was archived using earlier releases of the respective SAP Business 
Suite application (in the case of SAP R/3, this applies to releases back to and including 2.1).

Integration

The following graphic illustrates the ADK's role in the archiving concept.
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See also:

Archive Development Kit (Extended Function Library Applications)

21.1.3.2  Authorization Check

Definition

Authorization object S_ARCHIVE checks the authorization to carry out various archiving object programs. The 
Archive Development Kit (ADK) performs the check when an archive file is opened for one of the following 
actions:

● Write
● Delete
● Read
● Reload
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Use

The following authorizations can be given per archiving object and solution (such as SAP Financials or SAP 
Human Capital Management):

● Everything is permitted
Write, read, and reload archives; execute delete programs; change mode in archive management (notes)

● Change mode in archive management
Maintain notes

● Read and analyze archives and display mode in archive management

Furthermore, you need the S_DATASET authorization to read and write data. There may also be additional 
access authorization checks for specific application components.

See also:

Authorization Checks in Archiving Programs

21.1.3.3  Tables and Archiving Objects

Use

You use transaction DB15 to determine all the archiving objects that archive the data records from a specific 
table, or to display all of the tables for a specific archiving object. You can also call various statistics for the 
utilized database storage space.

Integration

This function is integrated in data archiving so that you have the option of calling it up from archive 
administration (transaction SARA) with DB tables.

Features

Archiving Objects

This pushbutton takes you to the part of the screen in which you can determine archiving objects. When you 
enter a table in the Objects for Table field and select Display Tables, you can display the archiving objects for 
this table.

Tables archived

This pushbutton takes you to the part of the screen in which you can determine tables. When you enter an 
archiving object in the Tables for Object field and select Display Objects, you can display the tables for this 
archiving object.
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Note
When you display archiving objects, those with the following properties are not included:

● Read, but do not delete
● Archive using a view or a structure
● Archive using an archiving class for which no table information is maintained (transaction ACLA)

By default, the system displays only tables whose data records are deleted during archiving. By selecting All 
Tables, you can, however, display all tables that are linked to the archiving object (with the exception of those 
mentioned above).

More information: Displaying Archiving Objects and Tables [page 668].

Space (Statistics)

This transaction provides information from SAP tables that are filled by statistics determination runs. This also 
provides further information, such as the time and number of the last archiving session and various details on 
the client used.

21.1.3.3.1  Displaying Archiving Objects and Tables

Use

You use an archiving object to archive exactly those tables that are defined in this archiving object in 
transaction AOBJ. If you do not know which table a specific archiving object archives, or which archiving 
objects archive the contents of a specific table, you can use this procedure to find out.

Various export, filter and search functions are also available.

Procedure

Choose Administration CCMS DB Administration Data Archiving (transaction DB15). . Alternatively, 
you can call Archive Administration (transaction SARA) and select DB tables.

The Tables and Archiving Objects screen appears.

Tables

1. To display a table for a specific archiving object, enter the name of the object in the Table for Object field 
and choose Enter.

Note
By default, the system displays only tables whose data records are deleted during archiving. To display 
all tables that the archiving object processes, choose All Tables.

2. To display all the archiving objects for one of the listed tables, select the table and then choose Display 
Objects.
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The corresponding archiving objects are listed in the top part of the screen.

Archiving Objects

1. Choose Archiving Objects.
2. To display an archiving object for a specific table, enter the table name in the Object for Table field and 

choose Enter to confirm.

Note
In addition to the transparent tables, you can also enter pool or cluster tables here. DB15 determines the 
transparent tables for the pool and cluster tables.

3. To display all the tables for one of the listed archiving objects, select the archiving object and then choose 
Display Tables.
The corresponding tables are listed in the bottom part of the screen.

Caution
DB15 does not display any archiving objects with the following properties:

○ Read data, but do not delete
○ Use views or structures to archive data indirectly

21.1.3.4  Network Graphik

Use

You can use the network graphic to show any existing dependencies between archiving objects. It shows 
business process flows and contexts that can influence the archiving sequence. In particular, at the start of an 
archiving object, you can use the network graphic to obtain a good overview of related documents.

Caution
Like a map, the network graphic is only for orientation purposes. It is not intended to show all the available 
document types and dependencies that exist in the system. This means that the network graphic cannot be 
used as a programming model for business processes.

Features

In an archiving session, you must take into account any dependencies between archiving objects that require a 
specific archiving sequence. In general, you cannot archive data for an archiving object that has preceding 
objects until these preceding objects have been archived.
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You can use the network graphic to determine whether the archiving object that you want to use has preceding 
objects. If so, the preceding objects should be implemented before the current archiving object. The nodes in 
the network graphic represent the archiving objects. A node displays the following information:

● Achiving object name
● Application name
● Short description
● Date of last archiving displayed in the following colors:

○ Green: Archiving and deletion successful
○ Yellow: Successfully archived, but not yet deleted,, or Archiving still running or Delete in progress or 

Delete canceled
○ Red: Not yet archived or Archiving canceled

The network graphic is a standard tool for creating and displaying network plans and hierarchies.

Activities

You can use the network graphic to call Archive Management (transaction SARA) at the same time as the 
required object name:

1. Double-click the archiving object for which you want to perform an action (such as write or delete).
You access Archive Administration. The system copies the name of the archiving object automatically.

2. You can now select the action that you want to carry out and schedule the relevant background job.

More Information

Calling the Network Graphic [page 670]

Archive Administration [page 664]

21.1.3.4.1  Calling the Network Graphic

Prerequisites

You are on the Archive Administration: Initial Entry screen of the transaction SARA.
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Procedure

● 1. If you want to display the network graphic for all archiving objects, leave the archiving object name field 
empty.
If you want to display all the predecessors of a particular object, enter the name of the archiving object 
in the Object Name field.

2. Choose Goto Network Graphic .
The network graphic is displayed for the specified archiving object or all registered archiving objects.

Note
If you have called the network graphic for all archiving objects, you can increase the display area by 
enlarging the rectangle in the bottom right-hand corner of the screen. Use the mouse to change the 
rectangle.

21.1.3.5  Access to Archived Data

Use

Data that has been archived using SAP Data Archiving has been removed from the database, but not from the 
application component. The data is still available for read access and analysis. In some cases, archived data 
can even be reloaded into the database.

Prerequisites

A prerequisite of read access and reload access, is that the file can be found in the file system. You can check 
this in Archive Administration.

Features

Note
The uses of archived data described here are technically possible, but are not currently implemented in all 
application components. For more information, refer to the application-specific sections of the 
documentation on Data Archiving in the SAP Library.

They following types of access are possible:

● (Read) access to a single data object, such as an accounting document
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Direct access or single document access requires an index that can be filled either during archiving or at a 
later point. A complex search of the documents stored in the archive files, in which all orders of an article in 
a particular batch are required for a product recall action, is not possible.
The Archive Information System (AS) supports direct access using archive information structures, which 
are a type of index that can be generated automatically either whilst the archive files are being written, or at 
a later point.

● Analysis of an archive file (Sequential Read)
It is possible to run an analysis for one or several archiving sessions. The results of the analyzed data 
objects are displayed in a list. Furthermore, some archiving objects offer the option of a combined analysis. 
With this option, you can link current data and archived data in the database.

● Reloading to the Database
Archived data does not usually need to be reloaded because it remains accessible to the applications. 
There is also a large amount of data that cannot be reloaded or for which reloading is problematic. For this 
reason, reload programs do not exist for all archiving objects.

21.1.3.6  Archive Administration: Overview of Archiving 
Sessions

Use

On this screen, you can display and edit administration information about archiving sessions.

Features

Within a status area, archiving sessions are, by default, organized in groups of 20. The sessions are ordered 
according to the following statuses:

● Archiving Sessions with Errors: The write process terminated before the first archive file was created.
● Incomplete Archiving Sessions: The write process has not been completed, the deletion program did not 

run for all archive files, or a write process was terminated.
● Completed Archiving Sessions: Both the write process and the delete phase were completed successfully.
● Archiving Sessions to be Reloaded: The content of the archiving session is to be reloaded into the 

database.
● Archiving Sessions Created during Reload: The archiving session contains data that could not be reloaded 

into the database during the reload. The archiving session is not accessible again until the reload program 
has been run successfully.

● Replaced Archiving Sessions: The archiving session was reloaded or converted.
● Invalid Archiving Sessions: The archiving session has been marked as invalid.
● Archiving Sessions Flagged for Archiving: The administration data for the archiving session can be archived 

and deleted using archiving object BC_ARCHIVE.
● Interrupted: The archiving session was interrupted. This was done either manually by the user or because 

the interruption parameters were reached (for example, the maximum runtime or a total number of data).
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You can call up detailed information about sessions and files on the following screens:

● Archiving Session Detail [page 674]
● Archive File Detail [page 676]

The Goto menu offers access to the following:
● Customizing [page 698]
● Job Overview Offers an overview of all archiving jobs and the functions available for their administration. 

For more information on the job overview, refer to .
● Logs [page 692]
● Stored Files: Enables you to search for stored archive files according to various selection criteria.
● Retrieved Files: Allows you to search for archive files that were retrieved into the file system, for a 

comprehensive analysis, for example. These archive files are no longer needed and can be deleted after 
they have been used. See Deleting Retrieved Archive Files [page 678].

● DB Tables [page 667]
● Information System [page 737]
● Statistics [page 688]
● Interrupting and Continuing [page 679]

See also:

Calling Archiving Session Administration [page 673]

21.1.3.6.1  Calling Archiving Session Administration

Procedure

1. Call Archive Administration (transaction SARA).

2. In the Object Name field, enter the name of the archiving object.

3. On the initial screen, choose Administration.

4. On the overview of archiving sessions, call the required function.
○ View the details of an archiving session or an archive file.
○ Store the archive file or retrieve the stored file, if there is a connection to the storage system.

More information:
Storing Archive Files [page 726]
Retrieving Stored Archive Files [page 727]

5. If necessary, use the tool bar to call the following functions:
○ Overview of the current spool request for the archiving sessions
○ Function for storing or retrieving archive files
○ Customizing settings
○ Overview of all archiving jobs and the functions available for their processing
○ DB Tables
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○ Information System
○ Statistics

6. To go to additional functions, choose Goto.

21.1.3.6.2  Displaying Archiving Session Details

Prerequisites

You are on the Archive Administration: Initial Entry screen of the transaction SARA. The name of the archiving 
object is entered in the Object Name field. 

Procedure

● 1. Choose Administration.
This takes you to the Archive Administration: Overview of Archiving Sessions [page 672] screen.

2. Position the cursor on the list of archiving sessions with the relevant status and expand the list.
3. Position the cursor on the required archiving session.
4. Choose Detail Screen.

The Archiving Sessions Details [page 674] dialog box appears.

Next Steps

Displaying Archive File Details [page 675]

21.1.3.6.2.1   Archiving Session Details 

Use

You can display detailed information for each archiving session.

Features

General Information

674 C U S T O M E R
SAP Oil & Gas (PRA - Production and Revenue Accounting)

PRA Archiving 



● System ID for the system used for the archiving session
● Archiving session number
● Date, time, and user for the session
● Number of the spool assigned to the session

Current Jobs for the Session

This area only appears if there are still active read or write jobs for the current session. To go to the job 
overview, choose Display Job. Here you can release, cancel, or delete individual jobs.

For the current job, the following job activities can be indicated:

● Active: The job has status "ready", "scheduled", or "active".
● Terminated: The job was terminated.

Changeable Settings

You can create a note and a long text for the session or mark it for archiving or as invalid. You should mark a 
session as invalid if, for example. you discover after archiving that the data selection was incorrect. Invalid 
sessions are no longer offered for archive selection.

Mark Several Archiving Sessions for Archiving or as Invalid

You can use the report RSARCH_FLAG_SESSIONS to mark several archiving sessions

● For archiving
● As invalid

When selecting the archiving sessions, you can also differentiate between sessions whose archive files are in a 
storage system, and sessions for which no accessible archive files exist.

You can use this report, for example, to mark all the archiving sessions created prior to a specified date for 
archiving or as invalid. This can be useful, for example, as an initial run when archiving archive administration 
data using the archiving object BC_ARCHIVE.

See also:

Displaying Archiving Session Details [page 674]

21.1.3.6.3  Displaying Archive File Details

Prerequisites

You are on the Archive Administration: Initial Entry screen of the transaction SARA. The name of the archiving 
object is entered in the Object Name field.
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Procedure

● 1. Choose Administration.
This takes you to the Archive Administration: Overview of Archiving Sessions [page 672] screen.

2. Position the cursor on the required archiving session.
3. Expand the archiving session
4. Position the cursor on the required archive file.
5. Choose Detail Screen.

The Archive File Details [page 676] dialog box appears.

Next Steps

Displaying Archiving Session Details [page 674]

21.1.3.6.3.1   Archive File Details 

Use

You can display an archive file status dialog box for all archiving sessions except for incomplete sessions where 
no archive files have been created.

Features

General Information

● Archive file name
● Date and time or archiving
● Number of data objects
● Size of archiving file in MB
● Status of the archive file
● Information for storing the file in a storage system
● Index status

Archiving Status

An archive file can have the following statuses:

●
Write Complete: The archive files have been written, but the data objects in the database have not been 
(completely) deleted.

●
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Delete complete: Previously archived data objects have been deleted from the database.

●
Reloaded: Data objects in the archive file have been reloaded into the database.

●
Converted: The contents of the archive files have been written to a new archive file with conversion 
programs delivered by SAP.

●
Saved: The content of the archive file is a backup copy of the data in the database.

Storage Status

An archive file can have the following storage statuses:

●
Not stored: The archive file is still in the file system.

●
Storage in Progress: The request to store the archive file in a storage system is running.

●
Stored: The archive file has been successfully stored in a storage system.

●
Storage Error: The archive file was not successfully stored.

●
Retrieval in Progress: The request to reload the archive file in the file system has been issued.

●
Retrieval error:: The file could not be reloaded into the file system.

●
Storage Incomplete: The archive file could not be completely stored in a storage system.

Index

An index for an archive file can have the following statuses:

●
Index Built: The index for this archive file was successfully built.

●
Index Deleted: The index for this archive file was deleted.

●
No Index Exists: No index exists for the archive file.

Accessibility Status

An archive file can have the following accessibility statuses:

●
Accessible: The archive file can be accessed in Archive Administration.

●
Not Accessible: The archive file cannot be accessed in Archive Administration.

Changeable Settings
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The dialog box can also contain the following changeable information:

● Note written by the user
● File name of the archive file
● Platform-independent path specified during archiving in archiving object-specific Customizing
● The physical file name

Activities

Displaying Archive File Details [page 675]

21.1.3.6.4  Deleting Retrieved Archive Files

Use

This function enables you to delete copies of archive files retrieved to the file system that are stored in an 
external storage system. This is usually the case if you no longer need the copies and want to access the stored 
files directly.

Features

Overview of the Retrieved Archive Files

The program RSARCH_LIST_RETRIEVED provides you with the retrieved archive files. You can restrict the 
selection to archiving objects, archiving sessions, archiving files and Content Repositories. The list contains the 
following information about the retrieved archived files:

● Archive file name
● Related logical file path
● Creation date
● Content Repository name
● Document ID in the storage system
● Status of the stored file in the storage system
● Storage date and time

Deleting Archive Files

To delete retrieved copies of stored archive files, select the relevant entries and the list and choose Delete 
Retrieved Files. The program deletes the archive file on operating system level and automatically adjusts the 
administration entries in archive administration. After this, you can again access archive files directly in the 
storage system.

You can delete retrieved archive files only if the original archive files have the status ONLINE in the storage 
system, and the access check of the stored archive file is performed successfully. The system checks whether 
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the header information in the archive files corresponds with the administration data in archive administration. 
If it does not, you cannot perform the deletion.

For files that do not have the status ONLINE in the storage system, you can double-click on the Status field or 
use the Errors Occurred pushbutton to display additional information about the cause. If this information is not 
available, no message is displayed.

Activities

You can call up the program RSARCH_LIST_RETRIEVED either from ABAP program execution (transaction 
SA38) or from archive administration. To do so, choose Goto Retrieved Files .

21.1.3.7  Interrupting and Continuing Archiving Sessions

Use

In order that Data Archiving can be seamlessly integrated into the production system, you can interrupt an 
active archiving session that is still in the write phase and continue it at a later time. This enables you to react, 
during archiving, to specific time constraints or hard-disk space shortages. You can continue and complete 
interrupted archiving sessions when you have more time or more storage space.

Integration

This function is a part of the Archive Administration (transaction SARA) and requires the support of the write 
program.

Prerequisites

If you want to interrupt an archiving session, the following prerequisites must be fulfilled:

● The archiving object must be registered in transaction AOBJ as interruptible, so that the Archive 
Development Kit (ADK) is able to inform the write program of the interruption request.

● The write program is able to process the interruption request.
● The archiving session must be run in production mode (not test mode) and be in process.
● The settings in transaction AOBJ allow the delete phase to start before the write phase has finished.

If you want to continue the interrupted archiving session, the following prerequisites must be fulfilled:

● The session was interrupted using this interruption concept. Archiving sessions that were interrupted for 
other reasons or that were terminated by Archive Administration cannot be continued.
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● The delete phase must be completed for the data that was archived up to the point of interruption (status 
Completed).

Features

The write phase of an interruptible archiving session can be interrupted either implicitly (based on the values 
that are specified in Cross-Archiving Object Customizing [page 698] or explicitly (manually by an Application 
Programming Interface (API) Remote Administration Function.

Activities

1. Explicitly Interrupting an Archiving Session [page 681]
2. Implicitly Interrupting an Archiving Session [page 680]
3. Continuing an Interrupted Archiving Session [page 682]

21.1.3.7.1  Implicitly Interrupting an Archiving Session

Prerequisites

● The archiving object supports interruption.
● In Cross-Archiving Object Customizing, you have specified the runtime in hours or the storage space in MB, 

or both.

Context

When scheduling an archiving session, you realize that the time slot available or the amount of storage space is 
not sufficient. However, you want to start the archiving session, interrupt it, and continue it later.

Procedure

● 1. Start the archiving session as usual.
2. For each data object that function module ARCHIVE_SAVE_OBJECT writes, the ADK determines 

whether it is necessary to interrupt the archiving session.
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ADK calculates the following:
a. The time that has elapsed since the write job was released.
b. The storage space, by adding the size of already closed archive files to the size of the archive file that 
is currently being written.

3. As soon as one of these values is reached, the ADK triggers the interruption by raising the exception 
TERMINATED_REQUESTED.

Note
The write program must be able to process the exception and call function module 
ARCHIVE_CLOSE_FILE.

4. The ADK sets status of the archiving session to Incomplete as usual, but also marks it as Interrupted.

Results

The archiving session was interrupted and can be continued later. To continue an interrupted archiving session, 
see Continuing an Interrupted Archiving Session [page 682].

21.1.3.7.2  Explicitly Interrupting an Archiving Session

Prerequisites

● The archiving object supports the interruption of an archiving session.
● The archiving session to be interrupted is in the write phase.
● You are on the Archive Administration: Initial Entry screen of the transaction SARA. The name of the 

archiving object is entered in the Object Name field.
Alternatively, you can interrupt an archiving session from archive administration.

Context

You want to interrupt an active archiving session manually and continue it later.

Procedure

● 1. Choose Goto Interrupt .
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2. Select the archiving session(s) to be interrupted. You have the following options:
○ All interruptible archiving sessions for all interruptible archiving objects
○ All interruptible archiving sessions for the specified archiving object
○ Specific archiving sessions that you can select in Archive Selection

Note
The selection of the archiving sessions is always cross-client if the archiving objects used are cross-
client.

3. After you have selected the relevant archiving session, confirm your interruption request by choosing 
Execute.

Results

The archiving session is interrupted before the system starts writing the next data object. In archive 
administration, the session is marked as Interrupted.

21.1.3.7.3  Continuing an Interrupted Archiving Session

Prerequisites

● The delete jobs have been run for the archive files in the archiving sessions that were interrupted (the 
archiving session has the status Completed).

● You are on the Archive Administration: Initial Entry screen of the transaction SARA. The name of the 
archiving object is entered in the Object Name field. 

Alternatively, you can continue an archiving session from administration.

Context

You can use this function to continue archiving sessions that you interrupted earlier.

Procedure

● 1. Choose Goto Continue .
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2. Select the archiving session(s) to be continued.
You have the following options:
○ All interrupted archiving sessions for all interruptible archiving objects
○ All interrupted archiving sessions for the specified archiving object
○ Specific archiving sessions that you can select in Archive Selection

Note
The selection of the archiving sessions is always cross-client if the archiving objects used are 
cross-client.

3. Once you have entered the Start Time and Spool Parameters, schedule the continuation job by 
choosing Execute.

Results

The archiving session is continued at the specified time - that is, the data objects that still have to be archived 
(in accordance with your selection criteria) are written to archive files.

21.1.3.8  Database Actions Before and After Archiving

Use

When archiving application data, the way in which the database data is organized plays a central role. 
Therefore, you should only use database actions can be used to optimize organization of data in the database 
before and after archiving.

Process

1. Database Actions Before Archiving [page 683]
2. Database Actions After Archivng or Deletion [page 684]

21.1.3.8.1  Database Actions Before Archiving

Use

Archiving application data helps to prevent storage and performance bottlenecks. Since relocating data can, in 
some circumstances, in itself, impair performance - this is the case if you need to access archived data - you 
need to consider carefully what data to archive.
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To determine whether or not you should archive data, consider the following questions:

● For memory problems: Can more memory be assigned to the table (MAXEXTENT, Tablespace)?
If the answer is yes, and if you will need to access the archived data and you have no performance 
problems, you should consider enlarging the table. You can find the exact description in the SAP 
NetWeaver AS Documentation SAP Database Guide: Oracle (BRSPACE for Oracle) or ABAP Dictionary, 
section Tablespaces und Extents database-independent parameterization, MaxDB).

● How likely is it that you will need to access the archived data again and how often?
If you need to access the archived data often and there are no performance problems, assign more 
memory to the tables in question (see above).

● For performance problems: Are you using an optimal index for the access?
In some circumstances, a suitable index may be available but not being used. This depends on the 
database optimizer.
You can check which index is actually used to access data by Performing an SQL Trace [page 685]. For 
more information on indexes, refer to the SAP NetWeaver AS documentation ABAP Dictionary and search 
for appropriate sections using "index" as your search term.

● Does the application perform a full table scan on the tables that contain the data to be archived?
If the answer is yes and the table is fragmented, it may help to reorganize the table before archiving so that 
new records and any records that remain in the database are physically contiguous.

Caution
Note that reorganization takes a long time and may need to be repeated after archiving.

Throughput during a reorganization:

- With export/import: approximately. 60-100 MByte/hour

- With unload/load: approximately. 250-300 MByte/hour

21.1.3.8.2  Database Actions After Archiving or Deletion

Use

Oracle: Reorganization of the Index

If data has been archived or simply deleted and the associated tables were accessed via an index, the index 
should be reorganized. Deleting table entries leaves holes in the table which are still indexed. Reorganization 
can shorten the access paths, reducing response times.

For databases with a cost-based optimizer (CBO): Refresh the database statistics

If your database uses a cost-based optimizer, you must choose Update Statistics to recalculate the access 
paths.

Oracle: Reorganization of Tablespaces and Dbspaces

Whether you should reorganize the tablespace depends on the reason for archiving.

● Do you expect a lot of new data for the archived tables?
If so, you should not reorganize.
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On the other hand, if, for performance reasons, you have archived data that is no longer needed in the 
system and the table is otherwise rarely changed, you should reorganize.

● Do you want to make space for other tables?
If so, you should reorganize the tablespaces and dbspaces of both the tables and the indices.
This procedure is described in the SAP NetWeaver AS documentation SAP Database Guide: Oracle 
(BRSPACE for Oracle databases) and the ABAP Dictionary, section Tablespaces and Extents (database-
independent parameterization, MaxDB).

21.1.3.8.3  Performing an SQL Trace

Procedure

● 1. Open a new window and choose System Utilities Performance Trace .
The Trace Requests screen appears.

2. Choose Trace On to activate the trace.
3. Perform a typical database access in the first window (for example, an application transaction or the 

transaction SE16).
4. Choose Trace Off to deactivate the trace. Examine the SQL statement with List Trace.
5. Position the cursor on one of the PREPARE, OPEN, or REOPEN statements, and choose Explain SQL.

The system displays detailed information. The index used is specified in the line beginning with Index.

21.1.3.9  Archive Selection

Use

When executing certain archiving actions, it is necessary to select individual archive files or entire archive 
sessions and make them available for the relevant action. You do this using Archive Selection, which you access 
from the initial screen of the relevant action.

Archive selection is relevant for the following actions:

● Delete
● Read
● Build Index
● Reload
● Postprocessing
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Prerequisites

Depending on the action, there are various criteria that define whether archiving sessions and archive files are 
displayed in the archive selection

Criterion 1:

Archive File Status

Table 170:

Action Criterion

Delete Archive file has the status Archived or Stored (if the sequence "Store before deletion" has 
been selected in Customizing)

Read Archive file has the status Archived or Deleted or Saved.

Build Index Archive file has the status Deleted and the file is in the file system

Reload Archive file is in file system and the session has the corresponding status (see criterion 5)

Postprocessing All archive files have status Deleted

Criterion 2:

The archive file must contain at least one data object. If you have performed an archiving session and 
maintained the variants so that no data objects were archived, the archive file is automatically deleted and no 
longer offered for selection.

Criterion 3:

If a file is not accessible in the file system, the file is not offered for selection. A file is only offered for read if all 
the files in a session are accessible.

While checking the accessibility of a file, the system performs a read access for each file. This check process 
can take a long time if a large number of files are involved. To optimize this process the access check can be 
activated or deactivated according to archive files in the file system and archive files in an optical archive in 
archiving object-specific Customizing.

Criterion 4:

In the case of client-dependent archiving objects, the system only offers you sessions for the current client.

Criterion 5:

An archiving session can only be reloaded if it has the status Complete or Archiving session is reloaded.

Features

You can select complete archive sessions or specific archive files from the archive selection window, which you 
can access by choosing Archive Selection, from the initial screen of the archiving action.
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Activities

Selecting Archive Files [page 687]

21.1.3.9.1  Selecting Archive Files

Prerequisites

● You have selected one of the following actions and are in the screen from which the relevant action is 
started:
○ Delete
○ Read
○ Build Index
○ Reload
○ Postprocessing

● At least one of the archive selection criteria is valid for this action.
More information: Archive Selection [page 685]

Procedure

● 1. Choose Archive Selection.
The archive selection screen appears for the selected action.

2. To select all files belonging to an archiving session, select the appropriate checkbox.
As a confirmation, the small rectangle to the right of the checkbox is filled.

3. To select individual files belonging to an archiving session, expand the required node and select the 
relevant checkbox.
As a confirmation, the small rectangle to the right of the checkbox is only half-filled.

Note
You can select all sessions or cancel the selection by choosing Select All or Deselect All.

Note
The reload program can only ever process complete archiving sessions. For this reason, you cannot 
select individual files for reloading.

4. Confirm the file selection by choosing Continue.
You return to the initial screen.
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Results

You have selected the archive file(s) for processing. If you have also entered the start date and spool 
parameters, you can schedule the required archiving action.

Next Steps

Entering Spool Parameters [page 735]

Entering Start Date [page 736]

21.1.3.10  Statistics

Use

When writing, deleting, reading, or reloading, the system automatically generates statistical data on each 
archiving run (such as the storage space that has been freed in the database by deletions, or the number of 
deleted data objects), and stores it persistently in the database.

Data archiving administrators can analyze these key figures so that they can better plan future archiving 
projects and provide the necessary resources. Statistics also provide pertinent information on the role of data 
archiving in reducing the volume of data in the database.

Features

Statistics are collected by the Archive Development Kit (ADK). This occurs during the write, delete, and reload 
processes. In other archiving contexts, for example execution of preprocessing, postprocessing, or conversion 
programs, no statistical data is collected.

You can call the analysis transaction either directly from the initial Archive Administration screen (transaction 
SARA), or from the Management screen in Archive Administration, using the Statistics pushbutton. 
Alternatively, you can use the SAR_DA_STAT_ANALYSIS transaction.

As well as being displayed directly in the analysis transaction, the statistical information flows into the standard 
log of the write, delete, read, and reload program. You can analyze it there as well. As a prerequisite, the 
relevant application must call the standard log. In the programs mentioned, the standard log is output in the 
write program only, in both test mode and productive mode. In other programs, it is only output in productive 
mode. In other archiving contexts, such preprocessing, postprocessing, or conversion programs, no standard 
log is issued.

Selection

Statistical information is displayed on the basis of the selection data entered here. This includes:

● The client in which the archiving session was executed
● The name of the archiving object
● The date on which the archiving session data was created
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● The status of the archiving session

Archiving Session Status

When selecting the archiving sessions for reporting, you can choose between archiving sessions with the 
following statuses:

● Incomplete
● Complete
● Replaced

To select a status, enter the corresponding code. You can mark one indicator, or a combination of several.

The status used here is the same as the archiving session status in the management part of Archive 
Administration. You can find more information under Archiving Session Details [page 674].

Displaying Statistical Information

To display statistical information, choose the Display Statistics pushbutton.

Note
Via Choose Layout, you can change various statistics display settings, such as column width, column order, 
or column selection. You can also save this changed display as a user-specific layout variant. For a display 
that is easier to use, for example, you can hide columns that do not interest you.

In the full display (that is, if a user-layout has not been defined), the following information is displayed:

Table 171:

Column Explanation

Session number Number of archiving session

Object Name of archiving object

Client Client in which the archiving session was executed

Date Date on which the archiving session was executed

Status Status of the archiving session (incomplete, complete, replaced)

Disk space Space on the (hard) disk occupied by the archiving session

Header data Proportion of header data in the archiving session that classifies and describes 
the actual data

Total DB storage space (write) Virtual storage space in MB that an incomplete archiving session occupies in 
the database

DB table storage space (write) Occupied table storage space in the database in MB

DB index storage space (write) Occupied index storage space in the database in MB

DB cluster storage space (write) Occupied cluster storage space in the database in MB
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DB structure storage space (write) Occupied structure storage space in the database in MB

Total DB storage space (delete) Virtual storage space in MB that was deleted from the database by a com­
pleted archiving session

DB table storage space (delete) Deleted table storage space in the database in MB

DB index storage space (delete) Deleted index storage space in the database in MB

DB cluster storage space (delete) Deleted cluster storage space in the database in MB

DB structure storage space (delete) Deleted structure storage space in the database in MB

Total DB storage space (reload) Virtual storage space in MB that was reloaded into the database by a replaced 
archiving session

DB table storage space (reload) Reloaded table storage space in the database in MB

DB index storage space (reload) Reloaded index storage space in the database in MB

DB cluster storage space (reload) Reloaded cluster storage space in the database in MB

DB structure storage space (reload) Reloaded structure storage space in the database in MB

Written data objects Number of data objects that were written for an incomplete archiving session

Deleted data objects Number of data objects that were deleted from the database for a complete 
archiving session

Reloaded data objects Number of data objects that were reloaded into the database for a replaced ar­
chiving session

Number of delete jobs Number of executed delete jobs for an archiving session

Length of write job Length in hours of the write job for an archiving session

Length of delete job Average length in hours of the delete job for an archiving run

Length of reload job Length in hours of the reload job for an archiving session

Caution
When calculating storage space in the database, the system uses the length of the respective object types in 
the ABAP dictionary. The value determined in this way can therefore only be an indication of the actual 
storage space in the database.

Archiving Statistics Information

Statistics information is saved persistently in the database table ADMI_STATS. You can archive it together with 
archive management data using the archiving object BC_ARCHIVE.

Activities
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Creating Statistics [page 691]

More Information

Archiving Archive Administration Data (BC-CCM-ADK) [page 823]

21.1.3.10.1  Creating Statistics

Prerequisites

You are on the Archive Administration: Initial Entry screen of the transaction SARA. The name of the archiving 
object is entered in the Object Name field. 

Note
Alternatively, you can call the statistics function from the archive management in Archive Administration, or 
in transaction SAR_DA_STAT_ANALYSIS. If you use this transaction, you must enter client and archiving 
object manually.

Context

You can display statistical information that was automatically generated by the archiving programs (write, 
delete, read, reload). Statistical information provides useful data on the individual archiving sessions for the 
database administrator.

Procedure

● 1. Choose Statistics.
The Display Statistics for Data Archiving screen appears.

2. In the Selection area, enter the date on which the archiving session was carried out.
The client and archiving object are prefilled. However, you can change these values.

3. In the Archiving Status area, select the required status for the archiving sessions for which you want to 
call statistics.
You can select one or more checkboxes.

4. Choose Display Statistics.
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Results

The statistics are displayed in line with the entries made in the selection and status parameters.

More information: Statistics [page 688]

21.1.3.11  Logs

Use

This function provides a central access to the logs generated during data archiving. You can call this function 
from within Archive Administration by choosing Logs or Goto Logs  as well as from Archive 
Administration.

Features

The following logs are written when an archiving program, such as a preprocessing, write, or delete program, is 
executed, and can be displayed in this function:

● Job Overview
Information on the background jobs of the archiving program

● Job Log
Log of the different steps of an individual background job

● Spool List [page 694]
List generated by the archiving program and stored in the spool

● Application Log
Log of all processed objects (summarized and detailed)

Job overview, job log, and spool list are generated only by programs that are executed in the background. The 
application log can be generated for programs that run in the background and in dialog mode.

Note
Whether or not the log of the processed objects is to be updated in the application log, meaning that an 
application log is generated, can be set in the variant maintenance of the corresponding program in the 
entry field Log Output. See Variant Maintenance for Archiving Jobs [page 733].

Note
Note that not all archiving objects offer the updating of an object log (entry field Detailed Log in variant 
maintenance).

Log Display

In the log function, the left area of the screen shows the available logs, organized by archiving object, action (for 
example, preprocessing, write, delete, and so on) date and time. The newest log is highlighted. If cross-
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archiving-object logs were created, you can view them at the end of the log tree under the entry Cross-
Archiving-Object (see below).

Under Process Control, you can see whether the process was started in the test or the productive mode. If the 
process control could not be determined, the field remains empty.

In the Archiving Session column, you can see the number of the archiving session that was generated by the 
corresponding program (for write programs) or processed (for example by delete programs). If the session 
number could not be determined (for example, in preprocessing programs), the field remains empty. In case of 
reload programs, the Original Session column contains the number of the reloaded session.

Due to technical reasons, the job overview, the job log, and the spool lists can only be displayed as fullscreen.

The Application Log is displayed directly on the right-hand side of the screen. It is used to inform the user 
about the results of processing the business objects he or she has selected. For example, in the write program 
the user learns which business objects have been archived and which could not be archived and why.

You use the two tab pages to choose between a summarized and a detailed application log (if available). f 
detailed information is available for an object, you can display it by using the magnifying glass icon in the Detail 
column. Click on the question mark icon in the Long Text column to view the message long text. If no 
application log was created, the relevant message text is displayed. Possible reasons for this are, for example, 
that the relevant archiving program does not support this function or the user wanted the log output in the list 
(spool) and not in the application log.

Cross-Archiving-Object Logs

Cross-archiving-object logs are created during the execution of the cross-archiving-object check and delete 
[page 695] function. In the log display, these logs appear at the end of the log tree under Cross-Archiving-
Object. The logs are sorted by action, date and time of the action, and archiving object. For example, if you want 
to display the logs of all archiving objects for which the system performed a cross-archiving-object check, 
expand the Preprocessing node in the tree structure under the above-named heading and double-click the node 
with the desired date. In the right-hand area of the log display, the application log of the cross-archiving-object 
check session you have chosen appears. In the summarized view, the log contains a consolidated list of all 
summarized log messages of the archiving objects included in the check (these are listed as subnodes in the 
log tree). Due to performance reasons, the detailed messages of the different archiving objects are not 
included in the detail view.

It is not possible to display information on the next lower level, that is, on archiving object level. When you 
choose a node (document symbol) below the archiving object, the messages for this particular archiving object 
are shown in the form of a summary and as detailed information.

Activities

● You can limit the display of the logs to one specific archiving object by entering the object in the initial 
screen of Archive Administration. If you want to access the logs of all archiving objects, you must leave this 
field empty.

● To display the log for a specific log entry, select the entry in the log entries list and with a right mouse click 
choose the corresponding log, for example, the job log or the application log.

● To access only cross-archiving-object logs, first choose Check/Delete in Archive Administration and then 
Logs.
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● You can delete selected application logs from the system by choosing Environment Delete Application 
Logs . This function corresponds to the central delete function of logs using , the only exception being 
that the object ARCHIVING is already entered per default.

See also:

Variant Maintenance for Archiving Jobs [page 733]

Standard Log [page 694]

21.1.3.11.1  Standard Log

Definition

The executing program creates a log during reading, writing, deleting, or reloading. This is either a standard log 
or an application-specific log that is described in archiving object-specific documentation.

Structure

Depending on the archiving action you have performed, the standard log can contain information about the 
archiving session or the archiving file, as well as information about the processed business objects.

Archiving Session Archive File-Specific Log

● Number of archiving sessions
● Number of processed data objects
● Size of archiving session in MB
● Amount of header data in %
● Table space in MB occupied for

○ Tables
○ Indexes

● Number of processed table entries

This information is written exclusively in the list (spool).

Business Object-Specific Log

It is used to inform the user about the results of processing the business objects he or she has selected. For 
example, in the write program the user learns which business objects have been archived and which could not 
be archived and why.

First the summarized version of the is displayed. If the user wants the detailed version, he or she can request it 
on the selection screen of the relevant archiving program (see Variant Maintenance for Archiving Jobs [page 
733]). If detailed information for an object is available, you can display the required object by double-clicking 
it. If detailed information for a message is available, you can display it by double-clicking the message.

If no application log was created, the relevant text is displayed. Possible reasons for this are, for example, the 
relevant archiving program does not support this function or the user wanted the log output in the application 
log and not in the list (spool).
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You can call up the standard log with the Archive Administration: Overview of Archiving Sessions view with Spool 
List. If the user has defined in variant maintenance that the business object-specific information is to be output 
in the application log, you can display this information in archive administration with Logs.

21.1.3.12  Cross-Archiving-Object Check and Delete

Use

This function is used to schedule the cross-archiving object check or delete programs. These programs enable 
you to execute an archivability check or to delete application data from the database for several archiving 
objects at once.

Using these programs allows for a more pronounced separation between the moment of the archivability check 
and the actual write phase. It also allows you to merely mark data that has been archived for deletion from the 
database, instead of executing a delete session immediately. The data is later deleted with the cross-archiving-
object delete program (see below).

By de-coupling the archiving phases, you can better control the archiving process and integrate it in the 
running system. Time-consuming program runs such as the archivability check or the physical deletion of data 
can be separated from the write phase, and be executed when the system is not busy. This concept is therefore 
particularly suitable for archiving large volumes of data.

Prerequisites

The cross-archiving-object check and delete functions can be used for all archiving objects that support these 
functions. To check if this is the case for a specific archiving object, see the archiving documentation for that 
application, available in the SAP Library.

Before you schedule either of these two programs you must activate the archiving objects to be considered in 
the Customizing for Cross-Archiving-Object Programs view.

More information: Check and Delete

Features

Check

Here you schedule the cross-archiving-object check program, with which you want to execute an archivability 
check for several archiving objects at once. During the check the program marks all business objects that fulfill 
the archivability criteria and are therefore ready to be removed from the database, with a specific status.

Different applications use different statuses to mark data for archiving. The statuses used can therefore 
change from one archiving object to another. SAP Customer Relationship Management, for example, uses the 
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status Archivable and has the technical ID I1100. A business object, such as a CRM sales order, is considered 
to be archivable if it fulfills the following criteria:

● It is closed, meaning that it has the status Completed. This means that it is no longer changed in the 
application.

● It has reached its set residence time. The residence time should be chosen in such a way that it only covers 
data that is very seldomly accessed for reading.

In addition to these general criteria, there may be additional, object-specific criteria for determining the 
archivability of business objects. These are described in the corresponding documentation available for the 
archiving object in question.

The business objects marked for archiving can then be archived in a second step using an archiving-object-
specific write program. The deletion of the archived data then takes place via an archiving-object-specific 
delete program, or a cross-archiving-object delete program, if supported by the archiving object (see below).

Deletion

Here you schedule the cross-archiving object delete program. The program selects the business objects that 
were already archived and those only marked for deletion, and deletes them from the database. If this function 
is not supported by the archiving object, the Delete pushbutton is not offered.

The status used by the delete program for the selection of the data is application specific and can therefore 
differ from one archiving object to another. In SAP Customer Relationship Management, for example, the 
Deletable status has the technical ID I1102 and the Archived status the ID I1101. More information on whether a 
specific archiving object uses this status and what it is called is available in the corresponding documentation 
in the SAP Library.

Displaying the Log

The Logs function is used to display the application logs generated during the cross-archiving-object check and 
delete functions. For more information, see Logs.

Activities

You make the cross-archiving-object check and delete program settings in Archive Administration in Cross-
Archiving-Object Customizing Check and Delete .

You schedule the cross-archiving-object check and delete program in Archive Administration. To do so you 
must enter a variant, where you can make the following settings:

● In the Server Groups field, enter the group of application servers on which the processes are to run. If no 
server group is available, you can create one using Computing Center Management System (CCMS).

● In the Number of Parallel Processes field, enter the number of processes that are to be started in parallel.
● Under Process Control, you determine whether the process is to run in the test or production mode. In test 

mode the check or deletion process is only simulated and no actual changes occur on the database. The 
test or production mode settings you make in this variant override the settings in the Customizing variant. 
See Check and Delete and Variant Maintenance for Archiving Jobs.

Note
Both programs support parallel processing, meaning that it is possible to divide their processes among 
several jobs and application servers. This is generally positive in terms of performance, but also 
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generates a greater system load, as several tasks are being executed concurrently. Parallel processing 
cannot be used if no server group is specified.

21.1.3.12.1  Cross-Archiving Object Check Program

Use

The cross-archiving-object check program is used for the following purposes:

1. Selection of the data objects to be checked
2. Running the check
3. Setting the check status

The Check Process

First the data objects to be checked are selected using a special function module. The purpose of the 
preselection function module is to select the business objects based on the specifications entered in the 
Customizing variant. The function module takes the residence time and the resubmission date into account.

Through the preselection it is possible to exclude irrelevant data objects from the actual check. The result is a 
list of relevant objects that are transferred to the check program.

The check program then calls the check function module of the application to check the preselected data 
objects and if applicable, set their status to Archivable. The list generated by the preselection module is 
grouped into packages for parallel processing.

To prevent an object from being checked again and again, for every checked object the program enters the date 
of the last archivability check in a field in the corresponding header table. This date and the resubmission date, 
which can be specified in Customizing, are then used during the next program run to calculate whether the 
object can be checked again. Objects with the Archivable status are not checked again.

For SAP Customer Relationship Management archiving objects, the check function module initiates the 
sending of BDocs (Business Documents), after the check status has been set. BDocs contain change 
information about the archived business objects that are to be considered by the connected mobile systems.

The advantage of the background check is that it facilitates a more automated and therefore faster archiving of 
business objects. This type of check, however, also means a higher use of resources. Generally, SAP 
development decides whether the archivability check is executed via a cross-archiving-object check program 
or through an archiving-object-specific preprocessing program. In some cases you can choose freely.

Activities

The Customizing settings of the cross-archiving-object check program are made in Cross-Archiving-Object 
Customizing in the Check and Delete [page 701] function. The scheduling of the program takes place in 
Archive Administration with the Check/Delete [page 695] function.
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21.1.4  Customizing for ADK Data Archiving

Use

In Customizing for data archiving, you to set parameters that affect the data archiving process.

Prerequisites

● You have Customizing authorization.
● Data types are entered.
● Organizational data is entered.

Areas

Archiving Customizing can be divided into the following areas:

● Cross-Archiving-Object Customizing [page 698]
● Archiving-Object-Specific Customizing [page 703]
● Basis Customizing [page 717]
● Application-Specific Customizing

Some applications provide the option of specifying archivability criteria for application data, to be used 
during data archiving. Examples would be the residence time for sales documents or the account type life 
and document type life for accounting documents. If it is possible to enter archivability criteria, this 
function appears in the Customizing of the application in question and in Archiving Customizing of the 
corresponding archiving object.

Note
For more information on archiving-object-specific and application-specific Customizing, see the 
application-specific sections of the archiving documentation available in the SAP Library.

21.1.4.1  Cross-Archiving-Object Customizing (ADK Archiving)

Use

The settings that you make here apply on a cross-application and cross-archiving object basis for all archiving 
objects.

The cross-archiving object Customizing includes the following functions:

● Technical Settings [page 699]
● Check and Delete [page 701]
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21.1.4.1.1  Technical Settings

Use

With this function you can make the following settings to control the data archiving process. These settings 
apply to all archiving objects.

Data Archiving Monitor

Using this indicator, you can either switch the data archiving monitor (transaction SAR_SHOW_MONITOR ) on or 
off.

If you set this indicator before the data is archived, the archiving-relevant information about the write and 
delete jobs is updated. You can analyze this information using the Data Archiving Monitor. In addition, Alerts 
(error messages) are triggered if there are errors.

The Data Archiving Monitor also provides the following information:

● Overview of all archiving objects that were executed
● Detailed information about individual archiving sessions
● Progress report on processed archive files
● Help with the analysis of open alerts

The Data Archiving Monitor is part of the CCMS monitor group (transaction RZ20 ), and is available under 
SAP CCMS Monitor Templates Database Data Archiving .

For more information, see .

Check Access for Archive Selection

With this function you can check whether an archive file is available for access in archive administration, when 
you select archives for reading, deletion, analysis or reloading. The check can be performed separately for 
stored archive files and archive files that are still in the file system.

● If you select For Files in File System, the access check covers all archive files in the file system.
● If you select For Stored Files, the access check covers all archive files that are in a storage system.

Archive files for which the access check was negative are shown as "not accessible" in the selection screen.

Note
The access check for stored files requires accesses to the storage system. This means that the check can be 
very time-consuming and should only be used after careful consideration.

Verify Archive Files

With this function you can specify that archive files receive additional verification information, which is to be 
analyzed at a predetermined point in time. The saving of this additional information does not affect the size of 
the archive files. The verification information is necessary for later analysis during deletion, reading or 
reloading.

The information is used to verify the state of the archive files before the file is accessed. Corrupt files are 
recognized and reported at once, and as a result the data is not deleted from the database.
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When archive files are written the system automatically saves the verification information. With the Delete, 
Read or Reload indicator, you can determine when this verification information is to be analyzed. You can set 
more than one indicator.

Implicit Interruption of the Write Phase

If supported by the archiving object, you can interrupt the write phase and resume it later. You can specify the 
time of interruption using the following criteria:

● Max. Duration Hours
Here you specify how much time (in hours) has to pass since the write job was started, before the write 
session of all archiving objects that support interruption is stopped.

● Max. MB per Session
Here you specify the amount of data (in MB) that has to be reached for the write phase of all archiving 
objects to be interrupted automatically.
Both interruption criteria are independent of each other: The criterion that is first fulfilled automatically 
triggers the interruption; the other criterion does not have to be fulfilled.

Note
You can see whether an archiving object supports the interruption function or not in transaction AOBJ, if 
the Interruption Possible indicator has been set.

Server Group for Background Processing

Here you can specify on which application server or servers the archiving jobs (write, delete, read, and so on) 
are to run in the background, irrespective of the archiving object. If no server group exists yet, you can create it 
using transaction SM61 .

The system distributes the archiving jobs across the application servers of the server group.

Preprocessing, postprocessing and write jobs that were scheduled via Archive Administration (transaction 
SARA ) have the following characteristics:

● These jobs are scheduled with a higher priority (job class A).
● If the specified server group contains an application server that runs on the database server, then the jobs 

are scheduled there.

Note
The higher prioritization of the write jobs and the fact that the jobs are scheduled on the database 
server, decreases the network load during data selection and when the archive files are written to a file 
system that belongs to the database server.

Note
Constraints on the side of the application server may increase the runtime of the entire archiving 
process, especially if fewer background work processes are active as delete programs.

Choose only those servers for a server group on which background work processes are active during 
archiving.
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If you have created a server group and entered it in cross-archiving-object Customizing, then other activities 
such as reloading, reading of archive files, and index build/delete functions, are performed on that server 
group.

More Information

Basis Customizing [page 717]

Archiving Object-Specific Customizing [page 703]

Implicit Interruption of an Archiving Session [page 680]

21.1.4.1.2  Setting Up Check and Delete Programs

Use

You can set up the cross-archiving object check and delete program according to your requirements. For 
example, individual parameters for the selection of the business objects to be checked for a specific archiving 
object, or you can activate specific archiving objects for the cross-archiving-object check or delete.

The check is based on the archivability of business objects. You can execute the check for multiple archiving 
objects in parallel. The deletion of business objects is also possible for multiple archiving objects.

Prerequisites

The cross-archiving-object check and delete functions can be used for all archiving objects that support these 
functions. Therefore, only this objects are offered In Customizing.

Procedure

You make the settings for the relevant parameters in the detail view for an archiving object. To go there, double-
click the line with the required object, for example, BC_ARCHIVE (Archive Administration data).

You can set the following parameters:

● General Settings
○ Check active

If you select this checkbox, the archiving object is taken into account by the next session of the cross-
archiving-object check program, This covers all archiving objects for which you have selected the 
checkbox. The program periodically reads a control table to see which archiving objects are still active. 
Only those parameter values that were initially (at the time the program is started) read from this table 
by the check framework program are processed. In the standard system, this checkbox is deselected.
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Note
Framework programs control the cross-object check and delete programs. They are responsible for 
starting the corresponding check or delete function module in the application. This module then 
does the actual work.

Note
Changing the Customizing settings during the runtime of the check program: Activating an 
archiving object does not affect the running program. An archiving object that was deactivated 
during the runtime of the program is removed from the program run, if it has not been processed at 
that point in time. If you want to stop the program prematurely, you must deactivate all active 
archiving objects.

○ Delete active

Note
This indicator is offered only for an archiving object if the object supports this function. If this is the 
case, you can use the object-specific delete program.

If you select this checkbox, the archiving object is taken into account by the next session of the 
cross-archiving-object delete program, This program runs in the background periodically and 
covers all archiving objects for which you have selected the checkbox. The program deletes all 
business objects with the Archived or Deletable status (however not Archivable). In the standard 
system, this checkbox is deselected.

● Settings for the Check Program
○ Number of Calls for Preselection Module

Determines total number of times the preselection function module is called. As soon as this value is 
reached, the archiving object is removed from the program session. The default value is 10,000 calls.

Note
The check program works with two archiving-object-specific function modules: The preselection 
function module and the check function module.

○ Package Size of the Preselection Module
Here you define the number of business objects that are selected in the database and passed to the 
check function module of the application per call of the preselection function module. The default 
value is 50,000 objects.

○ Package Size of the Check Module
The framework program divides the business objects transferred during the preselection process into 
subpackages, which are then processed in parallel. The package size is the number of objects that are 
processed per call of the check function module. The default value is 500 objects.

○ Resubmission Interval in Days
Here you define after how many days a business object, which was not archivable during a previous 
check, can be checked again. By setting the corresponding value, for example 10 days, you can prevent 
already checked business objects from being checked again, as this would unnecessarily prolong the 
check process. The default value is 10 days.

In the Active Variant field, you can set the variant to be used by the check program. It defines which data is 
to be processed by the check program.
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● Settings for the deletion program

Note
These settings are only offered for an archiving object, if the object supports this function.

○ Number of Calls for Preselection Module
Determines total number of times the preselection function module of the delete program is to be 
called. As soon as this value is reached, the archiving object is removed from the program session.
The preselection module of the delete program selects all the business objects with the deletable 
status, groups them and passes them to the cross-archiving-object delete program.

○ Package Size of the Preselection Module
Here you define the number of business objects that are selected in the database and passed to the 
delete function module of the application per call of the preselection function module.

○ Package Size of the Delete Module
Here you define the size of the subpackages that are to be processed by the delete program in parallel.

More information:

Cross-Archiving Object Check and Delete [page 695]

Cross-Archiving Object Check Program [page 697]

21.1.4.2  Archiving-Object-Specific Customizing (ADK 
Archiving)

Use

These settings are valid only for the relevant archiving object. You can set the following parameters:

● Technical Settings
○ Logical file name [page 704]
○ Size of an archive file [page 704]
○ Settings for the deletion program [page 705]
○ File storage to storage system [page 707]

● Check and Delete [page 701]
This function enables you to navigate to Customizing for cross-archiving-object checking and deleting. 
Unlike when you access from cross-archiving-object Customizing, you can only make settings for 
Customizing of the current archiving object.

● Archive Routing [page 709]
You use this to define the rules and conditions for the definition of the Content Repositories that are used 
to store archive files.
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21.1.4.2.1  Technical Settings

Use

You use this function to make the following settings to control data archiving. These settings are valid only for 
the relevant archiving object.

● Logical file name [page 704]
● Size of an archive file [page 704]
● Settings for the deletion program [page 705]
● File storage to storage system [page 707]

21.1.4.2.1.1  Logical File Name

Use

This is where you enter the logical file name that is used for the archiving object when you store the archive files 
in the file system. During runtime, this logical name is converted to a platform-specific physical file name under 
which the archive files are stored in the file system.

Features

For information on how to define a logical file name, see Defining Logical Path and File Names [page 718]. This 
also provides information on the interplay between the logical and physical file and path names and the 
settings that you need to make.

Note
Provided you have not defined a logical file name that differs from the standard, you do not need to make 
any further settings.

21.1.4.2.1.2  Size of an Archive File

Use

This parameter specifies the maximum size that an archive file can reach when running a write program.
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Features

You have the option of specifying the

● Maximum size in MB
● Maximum number of data objects

. The value that is reached first triggers the creation of a new archive file. If you leave both fields blank, only one 
archive file is created.

Many archiving objects have a maximum files size of 100 MB by default. The maximum number of data objects 
is set to 0 by default. For these archiving objects, the maximum size of the archiving file determines the file 
size.

Note that the maximum size of an archiving file is limited by the operating system and also by the external 
storage system if one is connected.

Note
Since the action Start Deletion Program is triggered automatically for each archive file, you can carry out 
delete and write jobs in parallel if relatively small archive files are created. This parallel activity can have a 
positive effect on the runtime of an archiving session, as the database is used more efficiently. If a file is too 
small, the number of processes rises and the system is negatively affected.

Note
The size should usually be between 20 and 100 MB. The size must not exceed 2 GB, or no index can be 
constructed, thereby preventing single document access.

21.1.4.2.1.3  Settings for the Delete Program

Use

You define the control parameters for running the delete program here.

Features

● You can set up a Test Mode Variant by modifying the parameters accordingly. A test mode variant does not 
delete data from the database.

● You can set up a Production Run Variant by modifying the parameters accordingly. A production run variant 
deletes the archived data from the database.

Caution
Delete program variants are client-specific. You must therefore make the variant settings in all the 
clients for which you want to carry out archiving sessions.
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When archiving for the first time using a selected archiving object, the relevant test mode and 
production mode variants for the delete program must be fully maintained. Check whether both 
variants exist. Note especially, that if a production mode variant is not available, data is not deleted form 
the database when the delete program is run.

During a delete job, you specify when the delete program is to be run in the background:

● If you select the Not Scheduled, the delete program is not run automatically but can be run at any time 
following archiving.

Note
Delete jobs can also be scheduled without using Archive Administration (transaction SARA). You so so 
using an external job scheduler or the program RSARCHD. For more information, see Scheduling Delete 
Jobs Outside of Archive Administration.

● If you have selected the Start Automatically button, the delete program is run automatically immediately 
after an archive file is generated. See also the note under Archive File Size [page 704] here. If it was 
specified in Customizing that the file storage is to take place before the delete phase, the delete program is 
not started until the file has been stored.
This radio button is of interest primarily if you want to save the archive files before the delete phase. If there 
is a long time period between the write phase and the delete phase, there is a danger that the data could be 
changed before it is deleted, which means that the data in the archive and in the database are no longer the 
same. The delete phase should therefore be carried out as soon as possible after the write phase.

Note
Since Before Images has been deactivated for the rollback segments, there should be enough space 
available (Oracle's Rollback Tablespace).

● If you have selected the After Event radio button, the delete program is run automatically once a specific 
event has occurred. You select the relevant event by using the F4  input help for the Event field. an event 
requires that a parameter be set (an argument), enter the required parameter in this field. A parameter 
qualifies an event. See also .
Once all delete jobs for an archiving session are complete, the ADK issues the event 
SAP_ARCHIVING_DELETE_FINISHED. The event parameter is the number of the archiving session. You 
can use this event for event-driven scheduling of accumulated archiving jobs, succh as the automatic 
backup of archive files using external tools.

Note
You can use transaction SM62 to display and maintain events.

● You can use the Build Index indicator to specify whether an index is to be constructed for a particular 
archiving object. You can use this index to access specific data objects from the archive file (single 
document access).

Recommendation
Instead of using this function for single document access, we recommend that you use the Archive 
Information System (AS) [page 737].
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21.1.4.2.1.4  File Storage to Storage System

Use

You can specify here whether an archive file is to be transferred automatically after successful processing to a 
connected storage system. This can be done manually or automatically using the SAP Content Management 
Infrastructure (which also contains the ArchiveLink/CMS interface). You can also specify the sequence of the 
delete and storage phases.

Prerequisites

A storage system is linked to the SAP Business Suite software.

Features

To start automatic storage of the archive file, select the Start Automatically indicator. Select the relevant 
content repository.

Note
If rules and conditions have been defined for the specified archiving object for Archive Routing, it is no longer 
possible at this point to manually select the content repository as described above. During the archiving 
process, the Archive Routing settings always override the manual selection of the content repositories. In 
this case, instead of an input field for the content repository, the system displays the Archive Routing button, 
which you can use to access Archive Routing to maintain the rules and conditions.

More information:

Archive Routing [page 709]

Routing of Archive Files to Different Content Repositories [page 711]

Under Sequence, you can specify when the storage is to take place:

● If you select Delete Before Storage, the archive file is not stored until it has been processed by the delete 
program. If the delete program is run in test mode, automatic storage is not carried out. This option 
improves performance.
You can use this setting to perform storage manually if no delete program has been run for the archive file. 
In this case, the system informs you that this does not match the selected sequence. You must then ensure 
that the file is not stored at the same time as the delete program is active.

● If you select Store Before Delete, the archive file is stored as soon as the write program has created the 
archive file, but before the delete program has edited it. The delete program can therefore only remove the 
contents of an archive file from the database once the archive file has been stored. option offers enhanced 
backup, as the archived data is not deleted until it has been stored.
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During storage before delete, you can choose Delete Program Reads from the Storage System to control the 
read behavior of the delete program during the delete process:
○ Indicator selected: After storage, the stored archive file is deleted from the file system. Consequently, 

during the delete phase, the delete program reads the archive file from the storage system. ensures 
that the data is only deleted from the database if it was successfully stored in the storage system.

○ Indicator not selected: After storage, the archive file is not deleted from the file system. The delete 
program reads the archive file from the file system. This setting results in improved performance of the 
delete program without neglecting backup considerations.

○ If in the settings for the delete program, the radio button Start Automatically is also selected, the 
delete program is started automatically following storage. It therefore makes no difference whether the 
delete program is run in test or production mode.

Similarly, if you select After Event,delete jobs are scheduled, but they are not run until triggered by the event 
that has been configured in the settings for the delete program.

21.1.4.2.1.5  Settings for the Postprocessing Program

Use

Here you can schedule a postprocessing program to run after the delete phase. Postprocessing programs carry 
out operations following an archiving session, such as updating statistics and cleaning up secondary indexes. 
Most archiving objects do not require a postprocessing program.

Prerequisites

● The archiving object being used has a postprocessing program.
● To start the postprocessing program, you need to fulfill the following prerequisites:

○ The last delete program in the archiving session is finished.
○ No archive file has the status Archived, Archiving in Progress, or Delete in Progress.

Features

In the Variant input field, you define with which variant you want to schedule the postprocessing program.

By selecting the Start Automatically checkbox, you define that the postprocessing program starts 
automatically after the delete phase.
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21.1.4.2.2  Archive Routing

Use

You can use this function to create rules and conditions, based on which archive files are automatically routed 
to specific areas in the file or storage system. You have the following options: You can enter one or morel logical 
file names to determine one or more directories in the file system into which the archive files are written. You 
can also enter one or more content repositories to which the archive files are to be routed during the store 
phase.

Which of these two options you choose depends on whether you are using a file system or a storage system 
connected through ArchiveLink in your archiving strategy. However, it is also possible for you to specify both a 
logical file name and a content repository for one archiving session. In this case, the specified directory would 
be used as an exchange directory before the storage phase. It is also possible to specify only directories at first 
and then to extend the rules later by specifying content repositories for storage of the archive files.

The criteria used in the rules and conditions for both directories and content repositories should be on the 
organizational unit level (such as company code) or time-based (such as fiscal year).

Due to legal compliance issues, companies, especially those with international locations, are increasingly 
forced to keep archived data separately in order to comply with different retention requirements for different 
kinds of data, lines of business or countries. Compared to the manual selection of content repositories or the 
use of a standard directory such as ARCHIVE_GLOBAL_PATH, Archive Routing offers companies more 
flexibility and automation options for this purpose, especially as the latter permits you to specify only one 
content repository for all data of one archiving object.

Integration

Customizing

The routing rules and conditions are entered for individual archiving objects in Archive Routing. The function is 
available under Archiving-Object-Specific Customizing in Archive Administration (transaction SARA). If no rules 
have been entered, the directory or content repository are selected the traditional way. For more information, 
see Defining Logical Path and File Names [page 718] and File Storage to Storage System [page 707].

Archiving Process

The system checks the rules during the write phase of the archiving process. If you are also storing your archive 
files, then the system checks the rules again during the store phase. It is important to note that Archive Routing 
does not use the actual contents of the archive file to determine the directory or content repository, but the 
selection criteria entered in the variant for the write session. Note that the set of data covered by the selection 
criteria in the variant does not have to be exactly the same as the set of data covered by the routing rules and 
conditions. However, it is important rather the set of data for the variant selection is within the set of data 
specified by the rules. If it is the case, the archiving session is carried out and the archive files are routed to the 
appropriate directory or content repository. If not, the archiving session is terminated.
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Features

In Customizing, you can create rules for each archiving object that determine which directory or content 
repository is to be chosen based on the selection criteria of the write program variant. For each rule, you enter 
conditions that contain a selection criterion and a corresponding value or interval. It is possible to create one or 
more rules per archiving object and one or more conditions per rule. The complexity of the rules depends on 
how specific your criteria for separating your archived data into different directories or content repositories is.

The smallest unit for which a directory or content repository can be determined using Archive Routing is an 
archiving session. This means that the individual archive files, and therefore all the data objects (documents) in 
an archiving session are routed to one and the same directory or content repository. If you want to route data 
to different directories or content repositories, you must start a separate session for each directory or content 
repository.

Example

You define the following rules and conditions for archiving object SD_VBAK:

Table 172:

Sales Organization Creation Date Content Repository Logical File Name

0001 Any A1

0002 01.01.2000 to 12.31.2002 A2

0002 01.01.2003 to 12.31.9999 A3

These rules are checked during the write phase of the SD_VBAK archiving session. If the selection criteria of 
the write variant match the values entered in the rules and conditions, as described above, then the data is 
routed to the appropriate content repository during the storage phase. If not, the archiving session is 
terminated during the write phase. In this example, no logical file name was specified. This means that prior to 
the storage phase the data is written to the previously defined standard exchange directory (determined, for 
example, by ARCHIVE_GLOBAL_PATH).

More Information

Routing of Archive Files to Different Content Repositories [page 711]

Routing of Archive Files to Different Directories [page 715]
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21.1.4.2.2.1  Routing of Archive Files to Different Content 
Repositories

Use

This process describes how you can use archive routing to define rules and conditions that enable archive files 
to be stored in specific content repositories automatically during archiving. The actual storage process is also 
described here.

Process

1. Define Rules and Conditions for Archive Routing
You define the rules and conditions in the Customizing settings for specific archiving objects in archive 
administration (transaction SARA) under Archive Routing.
1. Archiving Object

You first specify here the archiving objects for which the content repository is to be determined using 
archive routing. By specifying a content repository here, you can override the content repository 
entered in the technical settings.
The system requires this information so that it can assign a content repository. Archiving is not 
possible without this.

2. Rules
You select an archiving object and enter one or more rules with the respective content repository here.

3. Conditions
You select one of the rules and enter the condition(s) that the system can use to determine a content 
repository that is suitable for the rule. Enter a selection here, such as airline or posting date and the 
associated value or interval. (Note the following: You can only enter single values and not ranges for 
selection values such as airline. The single value, such as the ID LH, is entered in the From field.) You 
can use the possible entries (F4) to select the selection values.

2. Routing of Archive Files
During an archiving session, the system checks the rules and conditions you have specified twice: Once 
during the write phase and then again during the storage phase.
As described under Archive Routing [page 709], it is essential that the system uses the selection values or 
the content of the write program variants to determine the content repository in which the archive files in 
an archiving session are to be stored. You should therefore ensure that the data quantity covered by the 
selection values in the write variant is found within the data quantity defined by the rules. If this is not the 
case, the system terminates the archiving session during the first check before the write phase.
Archive files are first routed during the storage phase if all conditions described here are met and it was 
possible to uniquely determine a content repository.
You can only define one content repository for each archiving session. If you want to use more than one 
content repository for the same archiving object, you must start a separate archiving session for each 
content repository.

Note
Following storage: Changes to the routing rules do not usually affect archive files that have already been 
stored. When an archive file is created, the system transfers the content repository to archive 
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administration and then always reads it from there. This means that the system also finds an archive file 
even if the new routing rules would mean that it would be stored in a different content repository.

The storage is not reorganized even if the routing rules are changed. This means that archive files that 
have already been stored are not moved.

Result

During the storage phase, the system stored the archive files in the content repository according to the rules 
that you specified.

Example

The following examples show various archive routing scenarios.

You have created the following routing rules in archive routing:

Table 173:

Sales Organization Creation Date Content Repository Logical File Name

0001 Any A1 (rule 1)

0002 01.01.2000 to 12.31.2002 A2 (rule 2)

0003 01.01.2003 to 12.31.9999 A3 (rule 3)

In words, these rules mean the following:

● Archive files for sales organization 0001 are stored in content repository A1.
● Archive files for sales organization 0002 and a creation date between 2000 and 2002 are stored in content 

repository A2.
● Archive files for sales organization 0002 and a creation date up to and including 2003 are stored in content 

repository A3.

Note
The creation date refers to the selection field "Created On" in the write variant and not the date on which 
the archive was written.

Example 1:

You start an archiving session with the following variant:

Selection variant
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Table 174:

Sales organization From 0002 to

Created On From 01.01.2000 to 31.01.2000

Archive files that are to be generated using this variant should be stored in content repository A2. The sales 
organization is the sales organization in the second rule and the date range is found in the date range for the 
same rule.

Example 2:

You start an archiving session with the following variant:

Selection variant

Table 175:

Sales document From 1 to 100.000

Sales Organization From 0002 to

Created On From 01.01.2000 to 31.01.2000

Or From 01.01.2001 to 31.01.2001

Without From 06.01.2001 to

This variant means that sales documents are to be archived if their document number is found between 1 and 
100,000, which belong to sales organization 0002 and were created in January 2000 or January 2001 but not 
on 6.1.2001.

The system would determine content repository A2 for these selection values. The system ignores the line in 
the sales document, since this selection criterion does not appear in the rules. The system ignores the last line, 
since this selection is already found in the range between 01.01.2001 to 01.21.2001 This leaves the following for 
archive routing:

Selection Variant

Table 176:

Sales Organization From 0002 to

Created on From 01.01.2000 to 31.01.2000

From 01.01.2001 to 31.01.2001

This is suitable for the requirements in rule 2.

Example 3:

Selection Variant

Table 177:

Sales Organization From 0002 to
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Created On Greater or equal to 01.01.2003 to

The system was unable to determine any content repository here. It initially appears that the third rule should 
apply and the system would use content repository A3. This is not however the case, since the system does not 
know here that all data that is equal or later to 1.1.2003 is automatically suitable for the range "From 1.1.2003 to 
12.31.9999".

See also:

If the archive routing function available in the standard system does not meet your requirements, you can use 
the Business Add-In (BAdI) ARCH_ROUTING_EXTERN. For more information, see Business Add-In: Archive 
Routing [page 714]..

21.1.4.2.2.1.1  Business Add-In: Archive Routing

Use

You can implement the Business Add-In (BAdI) ARCH_ROUTING_EXTERN (for the Routing of Archive Files to 
Directories [page 715] in the file system this BAdI is only available as of the next major release of SAP 
NetWeaver), if the standard Archive Routing function does not sufficiently meet your specific requirements. 
The main purpose of this BAdI is to replace the standard Archive Routing process with customer-specific code. 
This is possible for individual archiving objects. The BAdI is filter-dependent, with the archiving object being the 
filter.

An active implementation of this BAdI for an archiving object replaces the entire Archive Routing for that 
archiving object. In this case the system uses neither the rules as described under Archive Routing [page 709] 
nor the content repository specified in technical Customizing (V_ARC_USR). Other application-specific 
settings are not run either. The basic concept of Archive Routing, however, remains the same - the content 
repository is still determined using the information in the selection variant.

The BAdI has two methods for determining the content repository from the selection variant:

● PARAMS2CREP
● PARAMS2PATH_EXTENSION

A detailed description of these methods is available in the system documentation of this BAdI.

Caution
From a technical standpoint it is possible to insert other information into a customer-specific program for 
determining the content repository, than that taken from the selection variant. However, keep in mind that 
the content repository is not physically determined until the storage phase. During the write phase it is 
merely checked. This means that the algorithm should be delivered at both points in the process. The 
system itself (ADK) only remembers the content repository at the time of storage.
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21.1.4.2.2.2  Routing of Archive Files to Different Directories

Use

This process describes how you can use archive routing to define rules and conditions that enable archive files 
to be automatically stored in specific directories in the file system during archiving. The way in which archive 
files are actually stored is also described here.

If you are not using a storage system that is connected using ArchiveLink, or you initally want to only store your 
data in the file system, you can specify logical file names in Archive Routing to define directories in which 
archive files can be stored automatically. If archive files are subsequently to be stored in content repositories, 
you can subsequently assign the correct content repository to the rules. The system observes this assignment 
in the storage location.

Prerequisites

In Basis Customizing (transaction FILE), you have defined logical file names for use in Archive Routing and 
assigned them to the individual logical file names. For more information, see Defining Logical Path and File 
Names [page 718].

Process

1. Define Rules and Conditions for Archive Routing
You define the rules and conditions in the Customizing settings for specific archiving objects in archive 
administration (transaction SARA) under Archive Routing.
1. Archiving Object

You first specify here the archiving objects for which the directory is to be determined using archive 
routing.

2. Rules
You select an archiving object and enter one or more rules with the respective logical file names here.

3. Conditions
You select one of the rules and enter the condition(s) that the system can use to determine a directory 
that is suitable for the rule. Enter a selection here, such as carriier ID or booking date and the 
associated value or interval. (Note the following: You can only enter single values, such as carrier ID, 
and not intervals for selection values, The single value, such as the ID LH, is entered in the From field.) 
You can use the possible entries (F4) to select the selection values.

2. Routing of Archive Files
During the write phase of an archiving session, the system checks the rules and conditions that you have 
specified in the Customizing settings for specific archiving objects.
As described under Archive Routing, it is essential that the system uses the selection values or the content 
of the write program variants to determine the directory in which the archive files in an archiving session 
are to be stored. You should therefore ensure that the data quantity covered by the selection values in the 
variant is found within the quantity defined by the rules. If this is not the case, the system terminates the 
archiving session during the first check before the write phase.
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Archive files are first routed to the respective directories during the write phase in the production mode, if 
all conditions described here are met and it was possible to uniquely determine a directory using the 
logical file name.
You can only define one directory for each archiving session. If you want to use more than one directory for 
the same archiving object, you must start a separate archiving session for each directory.

Result

During the write phase, the system stored the archive files in the directory according to the rules and 
conditions that you specified.

Example

Before archiving using SD_VBAK, define the routing rules as follows:

Table 178:

Sales Organization Creation Date Content Repository Logical File Name

0001 Z_MY_LOG_FILE1

0002 01.01.1999 to 12.31.1999 Z_MY_LOG_FILE2

0002 01.01.2000 to 12.31.2000 Z_MY_LOG_FILE3

0002 01.01.2001 to 12.31.2001 Z_MY_LOG_FILE4

In words, these rules mean the following:

● Archive files for sales organization 0001 are created in the directory associated with the logical file name 
Z_MY_LOG_FILE1.

● Archive files for sales organization 0002 and a creation date during 1999 are created in the directory 
associated with the logical file name Z_MY_LOG_FILE2.

● Archive files for sales organization 0002 and a creation date during 2000 are created in the directory 
associated with the logical file name Z_MY_LOG_FILE3.

● Archive files for sales organization 0002 and a creation date during 2001 are created in the directory 
associated with the logical file name Z_MY_LOG_FILE4.

Archive files are not stored, since no content repository was specified. They remain in the file system. However, 
they are created in the directories for the corresponding logical file names. Once archives have been generated 
for both sales organizations, you decide to store the archive files. To do so, you extend the rules as follows:

Table 179:

Sales Organization Creation Date Content Repository Logical File Name

0001 A1 Z_MY_LOG_FILE1
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0002 01.01.1999 to 12.31.1999 A2_1999 Z_MY_LOG_FILE2

0002 01.01.2000 to 12.31.2000 A2_2000 Z_MY_LOG_FILE3

0002 01.01.2001 to 12.31.2001 A2_2001 Z_MY_LOG_FILE4

Since the files have already been generated for the rules you defined previously and routed to the appropriate 
directories, you can easily store these here.

These examples show it can be necessary to change routing rules for sessions that have not yet been stored. 
This is often the case if a storage system is to be introduced at a subsequent stage.

More Information

Routing of Archive Files to Different Content Repositories [page 711]

21.1.4.3  Basis Customizing (ADK Archiving)

Use

In Basis Customizing you can specify the file names under which the archive files are to be created. The logical 
file name is composed of a name and a path. The path is a logical path, meaning that you must follow 
predefined conventions that determine the physical format of the path during runtime (platform-specific) 
based on your specifications. File names and file paths can be client-specific (transaction SF01) or cross-client-
specific (transaction FILE).

For more information, see Defining Logical Path and File Names [page 718].

Recommendation
We recommend that you maintain the platform-independent file names as cross-client files names.

Note
If you want to transfer archive files to a storage system using the SAP Content Management infrastructure, 
ensure that the correct content repository is set up in Archiving Object-Specific Customizing [page 703].
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21.1.4.3.1  Defining Logical Path and File Names.

Use

To specify the platform-specific physical path and file name under which the archive files (which were created 
during archiving using this archiving object) are to be stored, you define logical path and file names assign 
them to the archiving object.

Note
By default, the system uses the logical file name ARCHIVE_DATA_FILE and the logical path name ARCHIVE 
GLOBAL PATH. Consequently, the names only need to be changed if they have to be adjusted to meet 
special requirements.

Prerequisites

● If you intend to transfer the archive files to a storage system using the Content Management Service 
(includes ArchiveLink and the CMS interface) , you must ensure that this storage system has access to the 
archive files.

● In the case of HSM systems, you must make sure that the archive files can be written to the file system of 
the HSM system.

Procedure

1. Defining logical path names

1. Start transaction FILE.
Alternatively, from the initial screen for Archive Administration (transaction SARA), choose Customizing

Basis Customizing Cross-Client File Name/Paths .
2. To enter a new path name, select an existing path name, such as ARCHIVE_GLOBAL_PATH, or choose New 

Entries. This must be as descriptive as possible.
3. In the Logical File Path Definition dialog structure, double-click on the Assignment of Physical Path and 

Logical Paths substructure.Double-click to select a syntax group or create a new syntax group.
4. Assign a physical path name to the logical path name.

Caution
When assigning path names, the symbol <FILENAME> must appear at the end. At runtime, this symbol 
is replaced by the physical file name (without path name). No part of the physical file name in the path 
name must be defined.

Recommendation
If you want to store your archive files, enter the placeholder <F=ARCHIVELINK> in the logical path. With 
<F=ARCHIVELINK><FILENAME> the files are created directly in the basis path of the content repository 
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that has been assigned to the archiving object. This way you can avoid an internal copy process during 
the store phase.

Recommendation
You have created the subdirectory "data_archiving" for archive files in the global directory. You then 
specify a path name:

· <P=DIR_GLOBAL>/data_archiving/<FILENAME> (Syntax group UNIX)

· <P=DIR_GLOBAL>\data_archiving\<FILENAME> (Syntax group WINDOWS NT)

In a heterogeneous system landscape (such as UNIX and Windows NT servers) all system-specific syntax 
groups must be maintained. Ensure that the definitions for the various syntax groups point to the same 
directory.

1. Save your entry.

2. Defining Logical File Names

Note
Logical file names client-specific (transaction SF01) or cross-client-specific (transaction FILE). A client-
specific definition always overrides a cross-client definition. Therefore, ensure that in every client any 
unnecessary client-specific definitions are deleted.

The following describes the procedure for creating a cross-client definition using the transaction FILE. You 
create the client-specific definition in the same way using transaction SF01.

1. Start transaction FILE for cross-client file names.
Alternatively, from the initial screen for Archive Administration, choose Customizing Basis 
Customizing Cross-Client File Name/Paths .
For client-specific definitions, from the initial screen for Archive Administration, choose Customizing
Basis-Customizing Client-Specific File Names .

2. To enter a new file name, select an file path name, such as ARCHIVE_DATA_FILE, or choose New Entries. 
This must be as descriptive as possible.

3. Double-click on the Logical File Name Definition, Cross-Client dialog structure.
You can access the Change View: Logical File Name Definition, Cross-Client: Overview screen.

4. Maintain the Physical File and Logical Path fields.
In the Physical File field, enter the physical file name you require.
The following parameters are of particular interest here:
○ PARAM_1: Two-character application abbreviation (such as HR; CO, MM) for classifying the archive 

files in the system. The value is determined from the definition of the relevant archiving object at 
runtime.

○ PARAM_2: Single-character alphanumeric code (0-9, A-Z). If, when a new archive file is created, an 
existing file with an identical physical name would result in a conflict, the ADK increases this value. This 
must therefore always be a part of the physical name.

○ PARAM_3: At runtime, this parameter is filled with the name of the archiving object. In archive 
administration, this enables you to check the file contents or to store the archive files by archiving 
object.
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Recommendation
To enable maximum space in the name range for the archive file, the following entry is 
recommended for this field:

<PARAM_1>_<DATE>_<TIME>_<PARAM_2>.ARCHIVE

In the Logical Path field, you assign the logical path name defined previously to the current logical file 
name. You can assign a logical path name to multiple logical file names.

5. Save your entry.

3. Assigning a Logical File Name to the Archiving Object

Once you have defined the logical path name and file name, you need to assign the logical file name to the 
archiving object. Proceed as follows:

1. In the initial screen for Archive Administration, enter the name of an archiving object and choose 
Customizing.Under Archiving Object-Specific Customizing, choose Technical Settings.

2. In the Logical File Name field, enter the required logical file name .
3. Save your entries.

21.1.5  Executing Data Archiving

Prerequisites

● You have defined the necessary settings.
More information: Customizing for Data Archiving [page 698]

● You have executed or checked the necessary preparatory steps according to the checklist for data 
archiving.
More information: Archiving Checklist [page 721]

Context

In addition to the main steps (creation and storage of archive files and the deletion of archived data from the 
database), data archiving also includes other activities. These include scheduling preprocessing an 
postprocessing as well as reloading or reading archive files.

Procedure

● 1. Call Archive Administration.
More information: Archive Administration [page 664]
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2. Enter the archiving object.
When you call from the application, the system automatically transfers the archiving object to Archive 
Administration.
You can branch to the network graphic to view the available archiving objects, their status and possible 
dependencies. From the network graphic, you can access the initial screen for Archive Administration 
by double-clicking an archiving object.

3. Select the required Activity for the archiving object and schedule the corresponding background job.
1. Optional: If you want to prepare data for archiving(for example, selecting the delete checkbox), 

schedule the preprocessing program.
More information: Scheduling Preprocessing for Data Archiving [page 722]

2. Schedule the creation of archive files as your first archiving step.
More information: Creating Archive Files [page 723]

3. Schedule the storage or the deletion of archived data. Decide on the sequence of these actions 
according to the following criteria:
○ If security is your main concern, you should schedule the storage of the archive files first. In 

addition, you can set the delete program to read the data from the storage system and not 
from the file system.

○ If the performance of the archiving program is more important to you, schedule the delete 
program first. To do so, you need to have selected the Delete before Storage checkbox in 
archiving object-specific Customizing.

More information:
Storing Archive Files [page 726]
Deleting Archived Data from the Database [page 728]

4. Optional (if offered by the archiving object): Schedule the postprocessing program.
More information: Scheduling Postprocessing for Data Archiving [page 729]

5. Fill (or empty) an index for the archive files. The index is required for the display of individual 
documents belonging to archiving objects.
More information: Filling and Emptying the Index [page 731]

6. Access archived files, if necessary.
More information:
Retrieving Stored Archive Files [page 727]
Reading Archive Files [page 732]

7. In emergencies only (if data was archived incorrectly): Reload data to the database.
More information: Reloading Archived Data [page 730]

21.1.5.1  Archiving Checklist

Use

This checklist helps to ensure that you complete the necessary archiving steps and that you perform them in 
the correct order.
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Procedure

Before the first archiving session

1. In Basis Customizing, check that the logical file names are entered.
2. In cross-archiving object Customizing, check that the Central Repository for storage is maintained using 

the SAP Content Management Infrastructure.
3. In application-specific Customizing, check that the residence times are defined.

Before using an archiving object for the first time

Check archiving object-specific Customizing settings:

● Was the file name correctly assigned?
● Are the deletion program variants maintained? (Note that the variants are client-specific)
● Is the maximum archive file size correctly set?
● Is the delete program set to run automatically?
● Is index creation scheduled?

For each archiving session

1. Ensure that the user department and system administration coordinate their activities.
2. Check the network graphic to determine whether interdependencies exist (do other data objects have to 

be archived first?)
3. Schedule the archiving session (create variant).
4. If the delete program does not start automatically, start it manually.
5. If the archive files are not to be stored automatically by the Content Management Infrastructure,, trigger 

storage manually.

21.1.5.2  Scheduling Preprocessing for Data Archiving

Context

You have the option of preparing the data in the database for archiving. For example, the preprocessing 
program selects the data for archiving.

Procedure

● 1. Call Archive Administration (transaction SARA).
2. On the initial screen, enter the name of the archiving object in the Object Name field.
3. Choose Preprocessing.

This takes you to the Archive Administration: Preprocessing screen, in which you can schedule a 
background job for the program.
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4. Use the F4  help to choose a variant. If there is no variant available, choose Variant and enter the 
relevant variant.

Note
You can use a variant only in one job. Otherwise you risk the data being archived more than once. If 
you use a variant again, a dialog box notifies you of this. Choose Jobs with Selected Variant to access 
the overview of all jobs that already have variants created. In the job overview, you can delete jobs 
that use a specific variant.

5. Enter the start date and the spool parameters.
More information:
Entering the Start Date [page 736]
Entering Spool Parameters [page 735]

Note
You use the Archive Directory to determine the amount for available storage space in the current 
object-specific archive directory.

Results

You have now entered all data required for the background job. To create the job, choose Execute.

21.1.5.3  Creating Archive Files

Context

Archiving begins with the creation of an archive file. This includes the following steps:

1. Creating an archive file with the write program
2. Reading the data to be archived from the database (in background processing)
3. Writing the data to the archive file

The creation of an archive creations continues until archiving is complete or until a restriction defined in 
archiving object-specific Customizing (maximum size or an archive file or maximum number of objects in 
archive file) has been reached. If archiving is not completed due to a restriction, the write program creates an 
additional archive file for the data that has not been archived.

If a restriction defined in Customizing is reached during archiving, Archive Administration continues with the 
deletion phase (if none of the following checkboxes have been selected in archiving object-specific 
Customizing. Start Automatically and Deletion Phase before Storage).
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Note
It is always possible to schedule a write job, even outside of Archive Administration (transaction SARA), by 
using an external Job Scheduler. This enables an improved reconciliation of the data archiving processes 
with the other processes in your system environment.

More information: Scheduling Write Jobs Outside of Archive Administration.

Virus Scan

When you write archive files, you can run a virus scan on the data to be archived. The virus scan checks all data 
objects, which contain records with XSTRING fields (length of Byte sequence variable) or X fields (Byte 
sequence). Only these byte sequences or date types potentially contain viruses.

The ADK virus scan is integrated in the virus scan interface for SAP NetWeaver. You can activate and 
implement it as described there. The virus scan profile is called /SARC/ARCHIVING_ADK. It is deactivated 
when delivered. When the profile is active, the message " Virus Scan with Virus Scan Profile/SARC/
ARCHIVING_ADK Active" appears in the job log of a write job. This message is always issued, even if no 
suspicious data objects has been detected.

If a virus is found, the ADK issues the message as follows: Virus <Name> found in Object <Structure 
Type> <Component>. The write program terminates with a system exception. The relevant session is handled 
the same as other terminated session (for example, technical reasons) in Archive Administration. Non-infected 
archive files that were written and completed correctly before the termination, remain intact.

Write Run Followed by Event

After the creation of all archive files for an archiving session has been completed, the Archive Development Kit 
(ADK) triggers the system event SAP_ARCHIVING_WRITE_FINISHED. As a result of the reaction to the system 
event, you have the option of scheduling subsequent archiving jobs automatically. These include refilling 
indexes or value help as well as saving archive files prior to deletion. The event parameter is always the number 
of the archiving session.

For additional automation of the archiving process, you can transfer the archiving session number to the 
function module ARCHIVE_GET_FILES_OF_SESSION. This determines the platform-independent name and 
path of the archive files that were written for an archiving session.

To define new jobs, use transaction SM36. To maintain events, use transaction SM62.

Procedure

● 1. Call Archive Administration (transaction SARA).
2. On the initial screen, enter the name of the archiving object in the Object Name field.
3. Choose Write.

A new screen, on which you can schedule a background job for the write program, appears.
If archiving for the archiving object was executed or interrupted and if archiving files that have not yet 
been processed by the relevant deletion program still exist for the archiving session, the systems 
points this out.
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Caution
Multiple archiving of data can lead to problems. For this reason, some archiving objects required 
that data does not exist multiple times this could lead to incorrect results, for example, in totals 
formation.

Make sure that:

○ The new write job you want to plan does not select any data contained in the archived files that 
have not yes been processed by the deletion program.

○ No variants with overlapping selection values are used at the same time.

Note
If the variant you have chosen is already being used in another jobs, display these with the Jobs 
with Selected Variant pushbutton and delete if necessary.

4. Use the F4  help to choose a variant. If there is no variant available, choose Variant and enter the 
relevant variant. For more information about variant maintenance, see Variant Maintenance for 
Archiving Jobs [page 733].

Caution
If, in archiving object-specific Customizing for the deletion program, the Start Automatically 
checkbox is selected and you have chosen a product variant for the write program, the deletion 
program then starts its product variant. This means that after archiving, the data is deleted from the 
database.

5. Enter the Start Date [page 736] and the Spool Parameter [page 735].

Note
Before you start archiving, you can use the Archive Directory pushbutton to determine the amount 
for available storage space in the current object-specific archive directory. However, this function is 
not suitable for HSM system.

Results

You have now entered all data required for the background job. To create the job, choose Execute.

Note
After all archive files have been completely written for a run, ADK starts the system event 
SAP_ARCHIVING_WRITE_FINISHED. This triggers subsequent processes, such as file backup using external 
tools.

The Goto menu offers access to the following:

● Customizing [page 698]
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● Job Overview Offers an overview of all archiving jobs and the functions available for processing them. For 
more information on the job overview, refer to .

● Administration [page 672]
● DB Tables [page 667]
● Information System [page 737]

Note
You can view the logs for the started process from the initial screen of Archive Administration by 
choosing Logs [page 692].

21.1.5.4  Storing Archive Files

Prerequisites

● An external storage system is linked to your SAP System. If you use a Hierarchical Space Management 
system (HSM) as a store, enter the file path in transaction FILE,

● The content repository, to which you want to transfer the file, has been maintained in archiving object-
specific Customizing for the archiving object.

● You are in Archive Administration of the archiving object for which you want to store files.

Context

If you have not specified in archiving object-specific Customizing that archive files are to be transferred 
automatically after their creation to a connected storage system, you can store the archive files retroactively by 
using the SAP Content Management Infrastructure.

Procedure

● 1. Choose Storage System.
The Store/Retrieve Archive Files menu selection screen appears.

2. Choose Store Files
The Archive Administration: Store/Retrieve Archive Files selection screen appears.

3. Use Archive Selection, to select the archive files you want to store and specify the start date.
4. Confirm the storage request by choosing Execute.

The selected archive files will be transferred to the storage system at the specified time.
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Next Steps

Retrieving Stored Archive Files [page 727]

21.1.5.5  Retrieving Stored Archive Files

Prerequisites

● You are in Archive Administration of the archiving object from which you want to retrieve files.
● The archive files for retrieval are accessible from Archive Administration.

Context

You use SAP Content Management Infrastructure (also contains the ArchiveLink/CMS interface), to retrieve 
archive files stored in a storage system into the SAP system for further processing such as evaluation.

Procedure

● 1. Choose Storage System.
The Store/Retrieve Archive Files menu selection screen appears.

2. Choose Retrieve Files
This takes you to the Archive Administration: Retrieve Files screen.

3. Use Archive Selection, to select the archive files you want to retrieve and specify the Start Date for the 
retrieval.

4. Confirm the retrieval by choosing Execute.

Results

The selected archive files will be retrieved into the SAP system at the specified time for further processing.

See also:

Storing Archive Files [page 726]
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21.1.5.6  Deleting Archived Data from the Database

Prerequisites

● In Archive Administration, there are archiving sessions for which the delete phase is not yet complete.
● You have waited for the write phase to be completed.

More information: Settings for the Delete Program [page 705]

Context

In the third archiving step (after creating and storing archive files), Archive Administration starts the delete 
program. This reads the archived data from the archive file and deletes it from the database.

Depending on the settings you have made in archiving object-specific Customizing, the deletion process for an 
archive file can run at the same times as the creation of new archive files.

If you want to save the archive files prior to deletion or if you the next available timeframe for the delete phase 
is insufficient, you can schedule the delete program manually. You do the scheduling in Archive Administration 
(transaction SARA), directly with an external job scheduler, or you use the program RSARCHD.

Note
If you do not carry out deletion until after the archive file has been stored, you can make a setting in 
Archiving Object-Specific Customizing so that the system will read archive files the from the storage system 
during deletion. In this way, you can detect early on errors that might arise when transferring or saving the 
archive files in the storage system.

Delete Run Followed by Event

After all delete jobs for an archiving session have been completed, the Archive Development Kit (ADK) triggers 
the system event SAP_ARCHIVING_DELETE_FINISHED. As a result of the reaction to the system event, you 
have the option of scheduling subsequent archiving jobs automatically. These include refilling indexes or the 
value help as well as saving archive files. The event parameter is always the number of the archiving session.

For additional automation of the archiving process, you can transfer the archiving session number to the 
function module ARCHIVE_GET_FILES_OF_SESSION. This determines the platform-independent name and 
path of the archive files that were written for an archiving session.

To define new jobs, use transaction SM36. To define events, use transaction SM62.

Note
You can also schedule event-controlled delete runs to start automatically. You can define the event that 
triggers the delete program in the Settings for the Delete Program group box in archiving object-specific 
Customizing.
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Procedure

● 1. Call Archive Administration (transaction SARA).
2. On the initial screen, enter the name of the archiving object in the Object Name field.
3. Choose Delete.

This takes you to a screen in which you can schedule a background job for the program.

Note
If you only want to run the delete program for test purposes (so that the data is not deleted from the 
database), select the Test Mode checkbox.

4. Choose Archive Selection.
This takes you to a dialog box that contains the archiving sessions for this archiving object. This should 
be the current archiving session.

5. If you want to edit a complete archiving session, select an archiving session and choose Continue. You 
return to the initial screen.
f you want to edit one or more specific archive files, expand the archiving session. Select the required 
archive files, than choose Continue.

6. Enter the start date and the spool parameter.
More information:
Entering the Start Date [page 736]
Entering the Spool Parameter [page 735]

Results

You have entered all data required for the background job. Start the job with Execute.

Note
You can view the logs for the started process from the initial screen of Archive Administration.

More information: Logs [page 692]

21.1.5.7  Scheduling Postprocessing for Data Archiving

Prerequisites

A postprocessing program exists for the archiving object (not all archiving objects have a postprocessing 
program).
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Note
The postprocessing program processes the data after the archiving session in the database, for example, by 
deleting log data that is no longer required or by updating statistics. For this, no access to the archive files is 
required. Postprocessing is not usually necessary.

Procedure

● 1. On the initial screen for Archive Administration, choose Postprocessing.
2. On the Archive Administration: Postprocessing screen, you schedule the archiving job by entering the 

variant, the start date, and the spool parameter.
More information:
Creating the Archiving Job Variant [page 733]
Entering the Start Date [page 736]
Entering the Spool Parameter [page 735]

Note
You use the Archive Directory pushbutton to determine the amount for available storage space in 
the current object-specific archive directory.

Results

You have scheduled a background job and can execute it.

21.1.5.8  Reloading Archives

Prerequisites

Caution
The reloading function is intended for emergencies, such as an error in Customizing or selecting the wrong 
documents for data archiving. Therefore, data should be reloaded immediately after the erroneous archiving 
session. If you reload the data later you may end up with inconsistencies in your database.

● You are on the Archive Administration: Initial Entry screen of the transaction SARA. The name of the 
archiving object is entered in the Object Name field. 
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● Archive Administration has access to the archive files to be reloaded.

Note
When reloading data, the system can only process complete archiving sessions. Archive files can be 
reloaded completely or partially. In either case the archive file is marked as reloaded. Objects that were 
not reloaded are written to a new archive file.

Procedure

● 1. Choose Goto Reload .
This takes you to a screen in which you can schedule a background job for the program.

2. Choose Archive Selection.
This takes you to a dialog box that contains the archiving sessions processed by the delete program.

3. Select the desired archiving session and choose Continue.
You return to the initial screen.

4. Enter the Start Date [page 736] and the Spool Parameters [page 735].

Results

You have now entered all data required for the background job. To create the job, choose Execute.

See also:

Creating Archive Files [page 723]

Archive Selection [page 685]

21.1.5.9  Filling and Emptying the Index

Prerequisites

You are on the Archive Administration: Initial Entry screen of the transaction SARA. The name of the archiving 
object is entered in the Object Name field.
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Procedure

● 1. Choose Index.
The Filling and Emptying Index dialog box appears.

2. Choose Fill Index or Empty Index.
3. Define the variant, select the archive, and enter the start date and the spool parameter.

More information:
Selecting the Archive [page 685]
Entering the Start Date [page 736]
Entering the Spool Parameter [page 735]

4. Choose Execute.

21.1.5.10  Reading Archive Files

Use

In addition to the data in the online database, archived data can also be read or analyzed. When data is 
analyzed, it is read sequentially and elementary information such as item number, customer, and order date is 
displayed in list form. It is possible to run an analysis for one or several archiving sessions. Not all archiving 
objects offer an analysis program.

Prerequisites

● The archive files to be read are accessible from Archive Administration.
● There is at least one read program for the archiving object used.
● You are on the Archive Administration: Initial Entry screen (transaction SARA). You enter the name of the 

archiving object in the Object Name field.

Procedure

1. Choose Read.
This takes you to the Archive Administration: Start Read Program screen, where you can schedule jobs.

2. In the Batch/Dialog field, you define whether the read program will run in the background (batch) or online 
(dialog).

3. In the Read Program field, enter the required read or analysis program and choose Execute.
Depending on the selected archiving object, you access a specific selection screen. You more information, 
see the documentation for the relevant archiving object.

4. Enter the your selection and choose Execute.
This takes you to the Archive Administration: Select Files to Read dialog box. For more information, see 
Archive Selection [page 685].
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5. Select the archive file that you want to read or analyze and confirm the selection by choosing Continue.

The Goto menu offers access to the following:

● Customizing [page 698]
● Job Overview Offers an overview of all archiving jobs and the functions available for processing them.

More information: .
● Administration [page 672]
● DB Tables [page 667]
● Information System [page 737]

More Information

Archive Information System [page 737]

Reporting Information Structures [page 742]

21.1.5.11  Variant Maintenance for Archiving Jobs

Use

When you schedule jobs for the execution of archiving programs, such as the preprocessing, write or delete 
programs, you must enter a variant. The purpose of this variant is to define which data is to be processed and 
to allow the user to make other settings that are necessary for the processing of the data.

These variant settings can be made when you are scheduling jobs, using the Maintain function.

Features

Variant maintenance is always dependent on the corresponding archiving object. Therefore, the variants may 
vary considerably depending on the archiving object. These differences, however, occur mainly in the section of 
the variant maintenance, in which the data selection takes place. For more information about the variant 
maintenance for a specific archiving object, see the corresponding documentation for the archiving object in 
the SAP Library.

The rest of the variant maintenance is the same for most archiving objects. The following settings are possible 
(depending on the type of program to be scheduled: write, delete, and so on).

Under Process Control, you determine whether the process is to run in the test or production mode.

● Test Mode
In the test mode, the program is only simulated. Depending on the program, either no archiving files are 
written, or no data is deleted from the database.

● Productive Mode

SAP Oil & Gas (PRA - Production and Revenue Accounting)
PRA Archiving C U S T O M E R 733



In this mode the data is physically processed, according to your selection criteria and, if applicable, 
additional archiving-object-specific criteria. For example, during the delete phase data is actually removed 
from the database by the delete program.

Additional settings you can make in the variant maintenance function:

● Detailed Log
In this field you can decide whether a detailed log ( Complete option) is to be generated in addition to the 
summarized log during the execution of the program. The summarized log contains each message only 
once. For each message the number of affected objects is listed as well as an example of an object.
The detailed log contains all processed objects including the corresponding messages. If you choose 
Without Success Messages, no success messages are written to the detailed log.

Recommendation
Detailed logs should only be generated if you are processing a small number of objects, or, for example, 
in the test mode. Otherwise the program may terminate, due to a memory overflow.

● Log Output
Here you can determine, whether the log should be output into the List (spool for background programs), 
to the application log, or to both.
The advantage of the application log output is that the log messages are displayed during the program 
runtime. (With background programs this occurs every 30 minutes and with dialog programs, every 10 
seconds). Logs that were output to the list can only be viewed after the program has finished.
With the list output you have the option to automatically store the log in a storage system (see Spool 
Parameters under job scheduling). Logs that were written to the application log can only be stored 
manually from within the display view. Moreover, logs that were output to the list, are automatically 
removed when the corresponding background job is deleted. Logs written to the application log must be 
deleted manually.
All logs can be displayed from within Archive Administration by choosing Goto Logs . For more 
information, see Logs [page 692].

● Comment on Archiving Session
Here you can enter a short text that helps you identify and better find the archiving session in Archive 
Administration.

See also:

Logs [page 692]

21.1.5.12  Entering the Start Date and Spool Parameters

Use

On the initial screen for scheduling the following archiving activities, you need to enter the start date and the 
spool parameters:

● Write
● Delete
● Read
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● Fill and Empty the Index
● Store and Provide Archive Files
● Schedule Preprocessing
● Schedule Postprocessing
● Reload

Features

The Start Date and Spool Parameters pushbuttons are followed by a traffic light icon and a note. The table lists 
the three possibilities.

Table 180:

Traffic Light Note

Red The values are not entered.

Yellow The values have already been maintained in this session, for the current action or the values 
for the spool parameters were taken from the user settings or from the user-specific print pa­
rameters.

Green The values are entered.

Activities

Entering the Start Date [page 736]

Entering the Spool Parameters [page 735]

21.1.5.12.1  Entering Spool Parameters

Prerequisites

You are in Archive Administration (transaction SARA) and have selected one of the following actions:

● Write
● Delete
● Reload
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Note
If the spool parameters are already maintained in the user-specific print parameters, these values are 
automatically copied Otherwise, you only have to maintain the spool parameters once after entering the 
Archive Administration transaction. The settings remain valid until the end of the archiving session.

Procedure

● 1. Choose Spool Parameter.
The Background Print Parameters screen is displayed. Here, you can maintain the settings for the 
printing the archiving log.

2. Enter the general parameters for the printer, number of printouts, and number of pages.
3. Under Attributes, you can maintain a range of further attributes for spool requests.
4. Choose Continue.

Results

The spool parameters for printing the archiving log are entered. If you have also made your archive selection 
and entered the start date, you can now schedule the required archiving action.

Next Steps

Entering the Start Date [page 736]

21.1.5.12.2  Entering the Start Date

Prerequisites

You are in Archive Administration (transaction SARA) and you have selected one of the following actions: Write, 
delete, or reload.

Note
You have to enter the start date only when you execute the first action of an archiving session. The start date 
is retained until the end of the archiving session.
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Procedure

● 1. Choose Start Date.
You reach the screen for maintaining the start date values.

2. Choose one of the buttons for defining the desired start date, and maintain the parameters in the fields 
available.
To schedule periodic jobs, use the Period Values function to enter the required start values.
Use the Restrictions pushbutton to define restrictions for the start date.

3. Choose Continue.

Results

You have entered the start date for the archiving action. If you have also made your archive selection and 
entered the spool parameters, you can now schedule the required archiving action.

Next Steps

Entering the Spool Parameter [page 735]

Selecting Archive Files [page 687]

21.1.6  Archive Information System

Use

The Archive Information System (AS) is a generic tool for indexing data archives that is fully integrated into the 
SAP data archiving environment . The indexes that are created, and which are called the Archive Information 
Structure, let you display the archived data.

Note
In this documentation the terms archive information structure and information structure (or infostructure) 
are used as synonyms.

Features

The archive information structure includes the following components:

Archive Retrieval Configurator (ARC)
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The ARC enables you to create archive information structures with the help of field catalogs, and to fill the 
structures with data from the archive. The archive information structure, which represents a kind of archive 
index, provides the basis for archive data reporting.

In the Archive Retrieval Configurator, you can decide whether you want to store your archive information 
structures on the standard database of the SAP system or on a secondary database (Sybase IQ). Storing 
archive information structures on a Sybase IQ database provides faster access to your data and relieves the 
SAP system database as the archiving indexes are stored on an "external" database. For more information, see 
SAP Library for SAP ERP under Cross-Application Functions in SAP ERP Cross-Application Components
Information Lifecycle Management .

Archive Explorer

The Archive Explorer enables fast searches of archived data. It does this by accessing the archive information 
structures that have been created and then stored in transparent database tables using the Archive Retrieval 
Configurator. Furthermore, the Archive Explorer allows direct access of individual data objects in the archive, 
which can then be displayed in both technical and application-specific views.

See also:

Using the Archive Information System [page 738]

21.1.6.1  Using the Archive Information System

Use

This process describes the step-by-step procedures for using the Archive Information System (AS).

Note
Reloading archived data can lead to problems with the Archive Information System, as the available 
information structures are not updated automatically.

More information: Procedure for Reloaded Archives [page 743]

Procedure

1. Checking available information structures

First you should check if an information structure already exists that you could use for reporting archived data. 
You can then change this information structure to suit your needs. If there is no information structure available 
that you can use, you can create a new one.

2. Creating the information structure

You define the information structure to be used for archive reporting. In doing this, you specify which source 
fields from the archive are copied to which fields in the information structure. You do this with the help of 
application-specific field catalogs, which are included in the features of the Archive Information System.
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An information structure is only ever valid for one archiving object. Multiple information structures can be 
defined for one archiving object. For more information, see Creating Information Structures [page 739].

3. Activating the information structure

After you have created an information structure, you need to activate it. Alternatively you can use a standard 
information structure, provided that it fits your requirements.

At this stage, the system generates a transparent database table and the reporting program. For more 
information, see Activating Information Structures [page 740].

4. Filling the information structure

During an archiving delete run all (activated) archive information structures belonging to an archiving object 
are filled automatically. To do so, the Archive Development Kit (ADK) transfers all data records found in the 
archive to the AS interface. From the defined infostructure, the AS filters the data from the data records 
transferred and enters it in a transparent database table together with an access key. This table serves as the 
basis for later searches.

As well as the automatic fill using the delete program, an information structure can also be filled later for 
already available archives This can be useful if you want to fill the information structure, report data that was 
already archived, or if you have changed the fields of an information structure. For more information, see Filling 
Information Structures [page 741].

5. Reporting information structures

In Archive Explorer, define the archiving object and the information structure from which you want to report. In 
the selection screen, where necessary, specify the display parameters for the archived data. Select a data 
object from the list of data objects and, where possible, specify the view in which it is to be displayed. For more 
information, see Reporting Information Structures [page 742].

Note
As well as standard reporting, there is also a special ad-hoc reporting function available that enables direct 
reporting from archives. There is no need to fill the archive information structure with data from the archive.

21.1.6.1.1  Creating an Information Structure

Procedure

1. On the initial screen for Archive Retrieval Configuration (ARC), choose Archive Infostructure Create .

2. Enter the required data.

This includes the name of the new archive information structure, the archiving object for which the 
information structure is intended, as well as a field catalog that you can select by choosing the F4 input 
help. In the field on the right you can also enter a short text for the information structure.

3. Choose Create.
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4. In the Selectable Fields frame, select all the fields that you want to include in the information structure.

5. Choose Include Selected Fields.

The selected fields are included in the information structure in the Infostructure Fields frame.
6. Save your entry. Choose Return to go back to the ARC entry screen.

Next Steps

Activating and Deactivating Information Structures [page 740]

21.1.6.1.2  Activating and Deactivating Information Structures

Procedure

You are in the initial screen of the Archive Retrieval Configurator (ARC).

Activating an Information Structure

1. Choose Archive Infostructure Activate . The information structure is activated. This structure will be 
filled automatically during the next delete phase for this archiving object.

2. Optional: If necessary, you can fill an active information structure for existing archives retroactively.
More information: Filling and Emptying Information Structures [page 741]

The consequences of activation are:

● The archive info structure can be reported in the Archive Explorer.
● You can display status information about this information structure.
● You cannot make any changes to the information structure.

Deactivating an Information Structure

In the menu, choose Archive Infostructure Deactivate .

This ensures that the system ignores this information structure during the next delete phase for the archiving 
object or if the archive information structure is filled retroactively.

Note
You can make changes to an inactive information structure. However, if you make changes, note that you 
might also have to regenerate the table. When doing this, you must delete the data in it. Finally, you must 
refill the information structure.
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21.1.6.1.3  Filling and Emptying Information Structures

Prerequisites

● You are in the initial screen of the Archive Information System (transaction SARI).
● The information structure to be filled has been created and activated.

Note
An information structure can only be filled for archive files that have already been processed by the delete 
program.

Procedure

Filling Information Structures

1. Choose Status.
You are now in Status Administration:

2. Enter the name of the archiving object for which you want to fill and information structure.
3. Choose Status per Infostructure.

This takes you to the selection screen for archive information structures.
More information: Status per Infostructure [page 746]

Note
When filling the info structure, you can also select individual archiving sessions. Choose Status per 
Archive.

4. Select the archive infostructures that are to be filled with data from the archive.
5. Choose Fill Structures and enter your desired processing type in the dialog box that appears. Confirm your 

entry. The information structure is filled.

Note
Alternatively you can trigger the filling of an info structure from the Archive Retrieval Configurator entry 
screen. Enter the relevant information structure and then select Environment Fill Structure . This 
takes you to the Status per Info Structure screen.

Emptying Information Structures

1. Select the archive information structures or archiving session that you want to empty.
2. Choose Empty Structures.

The system empties the information structures.
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21.1.6.1.4  Reporting Information Structures

Prerequisites

● You have created and filled the information structure on which reporting is to be based.
● The initial screen of the Archive Explorer appears.

Procedure

● 1. Enter the name of the information structure. It must be active.
To select an information structure, you can also enter the name of an archiving object and use F4  to 
display all active information structures belonging to the object.

2. Choose menu option Archive Infostructure Reporting .
This takes you to the Archive Explorer selection screen.

3. Enter selection criteria to establish which data you want the reporting to read.
If you do not want to restrict the selection, choose Execute.

4. Choose Execute.
The system displays the information structure list. It contains all of the data that the reporting program 
has read from the fields contained in the information structure.

5. Double click on the entry you want to access the archive directly. If more than one view is defined for 
this object, a dialog with a choice of views appears.

Note
Depending on the archiving object, the dialog box offers a technical view or a business view or both. 
Multiple business views are also possible.

6. Select the desired view and confirm with Continue.
This takes you to the table overview for the selected data object.

7. To display the table contents, click on the magnifying glass symbol for a table (similar to the display 
function in transaction SE16).

Results

You are now at the lowest level of data, that is the field level for the archived object. You can take the 
information directly from the table.
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Next Steps

Ad Hoc Reporting [page 761]

21.1.6.1.5  Procedure for Reloaded Archives

Context

After archived data has been reloaded, the system does not automatically update the archive information 
structures, so the Archive Information System status display displays an error. You must therefore perform the 
update manually.

Prerequisite

● Archived data has been reloaded into your system.
● You are in Status Administration of the Archive Information System.

Procedure

● 1. Choose the Status per Archive view.
2. Select all of the archiving sessions whose files were reloaded (these sessions have the status 

Reloaded).
3. Empty the information structures for the reloaded archive files using Empty Structures. You can usually 

do this online. Scheduling as a background job is not necessary.

Results

The reloaded files have now disappeared from the display. If new archive files have been created during the 
reload, proceed as follows:

1. Continue with the Status per Archive view.
2. Select the archiving sessions that were created by the reload (these sessions have the comment Created 

by reload from <session>).
3. Fill the information structures for the newly created archive files.

More information: Filling and Emptying Information Structures [page 741].
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Note
If you performed this sequence in reverse order, in certain circumstances, the fill status of the newly 
created archive files can appear as Incorrect. If this occurs, empty all of the information structures for 
which the fill status is Incorrect. Perform the steps according to the standard procedure.

21.1.6.1.6  Status

Use

The Status function allows you to check whether an information structure has already been filled. Using this 
information, you can then fill or empty specific information structures. Furthermore, you can check the actual 
indexing as well as the retention of archive files.

You can go to the status screen either from the initial screen of the archive information system or from the 
Archive Retrieval Configurator (choose Environment Fill Infostructure ).

Prerequisites

There must be at least one activated information structure for the archiving object.

Status per Archive

This function provides a list of the available archiving sessions and the information structures assigned to 
them. You can see from the list for which archiving sessions the activated structures have been completely 
filled.

More information: Status per Archive [page 745]

Status per Infostructure

This function provides a list of the statuses of the activated information structures. From this, you can see 
whether an information structure has been completely filled with all archived data or data otherwise removed 
from the database.

More information: Status per Infostructure [page 746]

Checking Indexing

This function checks the actual indexing of an archive file, that is, it checks whether data has been passed from 
the source fields to the information structure. The affected archive files are marked accordingly.

You can call the Check Indexing function from the Extras menu.

Displaying File Residence

This function checks the residence of an archive file, that is, it checks whether Archive Administration can 
access the file. The affected archive files are marked accordingly. A file can only be used to fill an information 
structure if is accessible by Archive Administration. Otherwise direct access to the data object is only possible 
with the Archive Explorer.

You can call the Display Residence function from the Extras menu.

Filling or Deleting Information Structures
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● Use Fill Structures to fill information structures with data from the archive.
● Use Empty Structures to delete the contents of information structures.

More Information

Filling and Emptying Information Structures [page 741]

Procedure for Reloaded Archives [page 743]

21.1.6.1.6.1  Status per Archive

Use

The following status information is displayed:

● Archiving session identification, date, and status
● Information structure fill status per archive file
● Description of the information structure
● Name and status of the archive file

Note
Choose Compress to restrict the display to the archiving sessions. This gives you a better overview when you 
want to select individual sessions. This function cannot be applied to individual archiving sessions.

The traffic light displays the following statuses:

Green: The system has already filled an information structure for this session.

Yellow: The system has filled an information structure for this session, however, all of the archive files could not 
be fully reported.

Red: The system has not yet filled an information structure (indicated by -) or has only partially filled an 
information structure.

An archive file can have the following statuses:

1) Complete

This archive file has been completely incorporated into the specified archive information structure.

1) Errors

This archive file has not been completely incorporated into the specified archive information structure.

1) -

This archive file was not selected when the archive information structure was filled.

The Complete status tells you that these archive files have been searched completely for source fields. 
However, it does not tell you anything about the indexing of the files, that is, whether data has actually been 
moved from the source fields to the information structure. You can check the indexing with the help of the 
Check Indexing function in the Extras menu.
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More Information

Status per Infostructure [page 746]

21.1.6.1.6.2  Status per Infostructure

Use

The following status information is displayed:

● Description of the information structure
● Archiving object name
● Archiving session identification, date, and status
● Information structure fill status per archive file
● Name and status of the archive files

Note
Choose Expand to display the complete list of status information. This expands the list to include the fill 
status for the information structure. The name and status of the archive file are also displayed. This function 
cannot be applied to individual information structures.

The traffic light displays the following statuses:

● Green: The system has fully reported all archiving sessions for this information structure.
● Yellow: The system cannot report, or can only partially report, some of the archiving sessions for this 

information structure.
● Red: The system has not yet reported any archiving sessions for this information structure (indicated by 

"-").

An archive file can have the following statuses:

● Complete
This archive file was completely incorporated when the archive info structure was filled.

Note
The status tells you that the archive file has been searched completely for source fields. However, it does 
not tell you anything about the indexing of the file, that is, whether data has actually been moved from 
the source fields to the information structure. You can check the indexing with the help of the Check 
Indexing function in the Extras menu.

● Erroneous
This archive file was not completely incorporated when the archive info structure was filled.

● -
This archive file was not selected when the archive info structure was filled.
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More Information

Status per Archive [page 745]

21.1.6.1.7  Creating Database Indexes

Use

To avoid long runtimes when archive information structures are accessed, we recommend that you create a 
database index for every infostructure. The index helps speed up accesses to the database table of the 
infostructure. If you are using an infostructure that does not have a database index, you can use this function to 
create an index.

Recommendation
Do not create your own database indexes for SAP infostructures, because this may create problems during 
the transport of the infostructures, due to naming conventions. Instead, copy the relevant SAP infostructure 
into your own namespace and then create an index for the new infostructure.

Integration

The data of the infostructure is saved in the database table, which is generated when the infostructure is 
activated, that is, directly in the production system. Because productive systems are protected against 
changes to cross-client objects (settings in system change option), it is not possible to create database indexes 
for generated Archive Information System tables. Instead, you can use the function described below, provided 
by the Archive Information System, to do so.

Features

To create a database index for an infostructure, simply define it The index will then be generated when you 
activate its infostructure in the database. The index definition is stored in table AIND_STR8.

To use the function for the definition of a database index from the Archive Information System, choose 
Customizing Goto Database Index .

You will see a table whose rows correspond to the fields of the index you want to define. The columns of the 
table have the following meanings:

Table 181:

Column Meaning
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Index Name Name under which the index is saved in the ABAP dictionary

Position Position of a field in the index

Field Name Technical name of the filed in the infostructure

Assign the relevant fields to the table. If you need the field MANDT (Client), then you must incorporate it 
manually.

Note the following when you work with database indexes for archive information structures:

● Entries in table AIND_STR8 are transported automatically together with the infostructure. You only need to 
trigger the transport manually if the infostructure itself is not to be transported.

● If you delete an infostructure, the corresponding entries in table AIND_STR8 are also deleted.
● If you remove a field that is also part of an archive index from an infostructure, you must adapt table 

AIND_STR8 manually, otherwise you will encounter problems when you try to activate the infostructure.
● The system only recognizes index definition entries if no database table exists yet for the infostructure. 

Therefore, you may have to delete the database table of the infostructure. You can find this function in the 
Archive Information System under Customizing Utilities Delete Table .

Note
Creating or changing a database index for an already existing infostructure generally means long 
runtimes, because you must deactivate the infostructure, delete the corresponding tables, activate the 
infostructure, and then refill it. You can use program ASCORRINDX to make changes to database 
indexes without having to delete the corresponding infostructures and fill them again. For more 
information about how to use this program see the corresponding program documentation.

Example

The index definition for the standard infostructure SAP_FI_DOC_002 contains the following rows:

Table 182:

Index Name Position Field Name

LIF 10 MANDT

LIF 20 LIFNR

LIF 30 BUKRS

REF 10 MANDT

REF 20 AWKEY

When you activate the infostructure a database table with two indexes is creates: The index LIF contains the 
fields MANDT, LIFNR, and BUKRS (in that order), and the index REF contains the fields MANDT and AWKEY.
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21.1.6.1.8  Partitioning

Use

The database tables that are generated when you create new archive information structures can become 
extremely large over the duration of their usage. This puts an increased pressure on the database and makes it 
more difficult to handle the infostructures and tables. To combat this effect, you can use partitioning to divide 
up the infostructures in such a way that the system distributes the data across several tables instead of writing 
it into one single table. This facilitates the administration of the database, which is more difficult with large data 
volumes.

Features

Configuration of Partitioning

You can call partitioning from the Archive Retrieval Configurator (transaction SARJ) by entering an 
infostructure and choosing Goto Partitioning .

To configure the partitioning function, in the From Date field, enter the date as of which the system is supposed 
to write the entries for the infostructure into a new table. The date refers to the creation date of the archiving 
session. If required, you can also enter the name of the table that is to be generated in the Table Name field. If 
you do not want to specify a name, the system automatically generates a table name that corresponds to the 
infostructure. The tables are not generated until the first data record is written, which would be either during 
the delete phase or during the subsequent filling of the infostructure.

Example
The following configuration data has been entered for partitioning:

Table 183:

From Date Table Name

01.01.0001

01.02.2005

14.04.2005

Based on these entries, the system would generate a separate database table for the following time periods: 
"Until 01.31.2005", "02.01.2005" until "04.13.2005"and as of "04.14.2005".

For a detailed example of a partitioning scenario, see Example: Partitioning an Infostructure [page 753].

Caution
The configuration entries for partitioning logically belong to the infostructure. This means it is cross-client 
and is transported and shipped together with the infostructure. Changing the configuration settings means 
a modification of the infostructure. Therefore, never change the partitioning of infostructures that are not 
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part of your namespace. This particularly applies to the SAP infostructures (those shipped by SAP) in 
customer systems. For more information, see Copying Infostructure Data [page 751].

The partitioning concept is so flexible that you do not have to specify that partitioning is to take place from the 
outset. In the case of large data volumes, rebuilding the infostructure would be very resource intensive. This 
means that data that has already been built does not need to be changed. All accesses to the Archive 
Information System remain intact. This applies to the Archive Explorer and to programmed accesses with the 
function module AS_API_READ or other interfaces to the Archive Information System.

Predefining Tables

In addition to partitioning you also have the option of predefining a table or several tables for a specific 
infostructure. This has the following advantages:

● The name of the predefined table is determined when configuration takes place. You can choose a name 
from within your namespace or a name that matches your requirements. If you do not specify a table name 
the system automatically generates a name, which you cannot influence.

● The table you specify is generated in the development or Customizing system and is then transported to 
the production system. This allows you to still make changes to the table, such as other technical settings 
or a different short text. In addition, the table has the same name in all systems, which is not the case for 
the automatically generated AS tables (ZARIX tables). This facilitates the administration of the system 
landscapes.

When you specify a table in the configuration, the system checks whether this table already exists. If so, it 
checks whether the table matches the infostructure and rejects the entry you made if necessary. If the table 
does not exist, the system asks you whether you want to generate the table. If you say yes, the table is 
generated in such a way that it corresponds to the infostructure.

Note
We recommend that you always instruct the system generate these tables. This means you can be sure that 
the structure of the table always matches the infostructure. We also recommend that you enter the same 
data for the object directory entry as that of the infostructure. This is particularly important for package 
assignments.

Displaying Partitioning

You can use the display function to view the current settings of the partitioning of an infostructure. You can call 
up the display function from within the status management of the Archive Information System by choosing 

Goto Partitioning  or from within the display of an infostructure in Customizing by choosing Technical 
Data.

● Partitioning Configuration
This area on the display screen shows how partitioning was configured.

● Current Partitioning
This area shows which tables the system used during which time periods so far. For the time periods that 
were entered in the configuration and that appear in this area, the system uses the assigned table also in 
the future. When the first record for the corresponding interval is written to the infostructure, the system 
sets the Change On date for that particular table. The entry that does not have a change date contains the 
table that was generated when the infostructure was first activated (normal AS table). This table only 
serves as a reference structure for partitioned infostructures.
Tables that have the G (Generated) indicator, have been generated.
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If an entry only has the indicator N (Read Only) indicator, it means that the Archive Information System 
does not write any more entries to this table. It only reads from this table. This happens when you change 
partitioning, by, for example, grouping several time periods together. this is the case, the system sets the 
tables used up until then for the individual tables to read only mode.

● Assignment of Tables and Files
This area shows all the archive files that have entries in the infostructure. It lists the corresponding tables 
where the entries can be found. This relationship is unique. A table always contains the complete set of 
entries of an archive file. The system uses this information especially for the deletion of infostructure 
contents.

See also:

Example: Partitioning an Infostructure [page 753]

21.1.6.1.8.1  Copying of Infostructure Data

Use

You can use this function to copy data from one infostructure to another.

Similar to other standard objects in the SAP system, SAP infostructures cannot be changed without running 
the risk of a modification. This also includes changes to the partitioning of SAP Infostructures. If, however, a 
SAP Infostructure contains data that you want to copy, you must delete all that data and rebuild it, in order for 
the data to be copied to one of your own infostructures. This procedure is possible, but, depending on the 
amount of data to be copied, can take a long time.

A good alternative for your purpose is the function for copying infostructure data.

Prerequisites

The prerequisites must be fulfilled so you can copy data from one infostructure to another.

● The target infostructure already exists. The system only copies the data from source infostructure, not the 
definitions of the data.

● Both infostructures are consistent. This applies to the definition of the infostructures and for their fill 
status. The copying of infostructure data is not a correction program.

● The source infostructure may not have a predefined table in the partition configuration. f the source 
infostructure lies within your own namespace (such as a customer-specific infostructure), you first remove 
this table from the configuration of the source infostructure. After you have copied the data you can enter 
this table in the configuration of the target infostructure.

● The source infostructure contains all the fields of the target infostructure. In addition, all the key fields of 
the target infostructure must also be key fields of the source infostructure. Note that the target 
infostructure may have fewer fields than the source infostructure.

● The field types of the target infostructure correspond to the field types of the source infostructure. This 
only applies to the technical field types. The data elements may be different, but not the field length.

● The target infostructure should be empty.
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Recommendation
To avoid functional changes or problems when using the AS modules, we recommend that you fill the 
target infostructure on the basis of the same field catalog as that of the standard infostructure that you 
want to copy.

Features

You can call this function from within the Archive Retrieval Configurator (transaction SARJ) by choosing 
Utilities Copy Data  or by executing the program AS_DATA_MOVE.

To copy the data you need to enter a Source Infostructure and a Target Infostructure.

Executing this function only takes a few seconds. It may, however, take longer, if the infostructures contain 
several thousand archive files, for example. However, the runtime does not depend on the number of entries in 
the infostructures. After you have executed the program, the source infostructure is empty and inactive. The 
target infostructure contains the data of the source infostructure and is active if it was active before, or if the 
source infostructure was active.

The data transfer does not actually take place through copying, but rather by "moving" the tables. The system 
simply assigns the tables of the source infostructure to the target infostructure by entering the tables of the 
source infostructure into the current partitioning of the target infostructure and adjusting the status 
administration. For this simple moving of data to take place, however, the above prerequisites must be fulfilled.

Example

You have an active SAP infostructure that already contains a large amount of data. This infostructure does not 
use partitioning and does not have any predefined tables. You want to copy the data of an SAP infostructure to 
one of your own infostructures. To do this, proceed as follows:

1. In the development or Customizing system (the system in which you make the developments and changes 
that are not permitted in the productive system) you create your own infostructure. The new infostructure 
should look exactly like the infostructure to be copied.

2. You make the desired changes to the new infostructure. In particular, you can configure the partitioning.
3. You transport the new infostructure into the productive system and leave it as inactive.

Note
Make sure that during the next step no archiving session, delete session, or filling of an infostructure 
takes place for the archiving object in question.

4. In the productive system, you copy the data of the SAP infostructure to the new infostructure (see above).
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As a result of this procedure, the infostructures now have the following characteristics:

Table 184:

The SAP infostructure is The new infostructure is

Inactive Active

empty and without references to any tables. Filled for those archive files for which the SAP infostructure 
was built

See also:

Example: Partitioning an Infostructure [page 753]

21.1.6.1.8.2  Example: Partitioning an Infostructure

Use

You have an infostructure that already contains a large number of entries. The related ZARIX table is becoming 
to large. Since the infostructure has not been partitioned yet, you want to do so now.

You want to change the infostructure so that no more data can be written to the existing table. You also want to 
set up the partitioning so that the data for the current year, the last two years, and the next three years are 
written to a separate table.

To do this, proceed as follows:

1. Configure partitioning in the development or Customizing system (the system in which development and 
changes that are not permitted in the live system take place) as follows:

Table 185:

From Date Table Name

01.01.0001

01.01.2003

01.01.2004

01.01.2005

01.01.2006

01.01.2007

01.01.2008

1. You transport these settings to the live system. It does not matter whether you enter the changes to 
the partitioning configuration in a transport oder or whether you transport the infostructure from 
somewhere else. A complete definition of the infostructure is always sent to the target system.
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2. Continue archiving in the live system as usual.
After you have transported the configuration to the live system, the partitioning of the infostructure looks 
like this:

Table 186:

From Date To Date Table Name Change Date G N

01.01.0001 31.12.9999 ZARIXBC62 X

The infostructure is not partitioned yet. Table ZARIXBC62 is already a very large database table for the 
existing infostructure. As long as you do not make any new entries in the infostructure, read access is from 
this table only. Not until further set up of the infostructure does the system generate a new table, which it 
then fills. It is ensured that the system does not add any additional data to the old table since the 
configuration of the partitioning covers the entire period for which data can be entered. After an additional 
archiving session, partitioning could look like this:

Table 187:

From Date To Date Table Name Change Date G N

01.01.2005 31.12.2005 ZARIXBC64 28.06.2005 X

01.01.0001 31.12.9999 ZARIXBC62 X

The system has now generated database table ZARIXBC64 for the period from 01/01/2005 to 
12/31/2005 that is specified in the configuration. In 2006 the system will create the next table. Read 
access is possible from both tables.
You have two options for how to proceed: Either you use partitioning only for new entries to the 
infostructure or you ensure that old entries are entered according to partitioning.
○ Partitioning for new entries only

In this case you do not need anything. New entries are written automatically to the infostructure 
according to partitioning. When you delete the infostructure for older files, the system recognizes that 
these entries are still in the old table ZARIXBC62. Once the infostructure is no longer set up for old 
files, then table ZARIXBC62 is empty and the actual partitioning corresponds completely to the 
configuration.
Information from the configuration relating to the period prior to 2005 is not required for this scenario.

○ Partitioning for all entries
If you also want the partitioning to correspond to the configuration for the older files, you need to 
delete the infostructure for all old sessions and then recreate it. In this case, the system uses the 
configuration entries for the periods prior to 2005 and generates the relevant tables.
However, this procedure is usually not necessary and therefore we do not recommend it. It is 
necessary only if the old table cannot be handled, even if no more new entries are made to it.
It is possible to combine both methods or to do a partial implementation.
After a conversion, you can remove empty tables that are no longer needed by deactivating the 
infostructure and then immediately reactivating it. The system deletes tables that have been created 
unnecessarily.
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21.1.6.2  Archive Retrieval Configurator

Use

The ARC allows you to create and configure information structures that are required by the Archive Information 
System (AS) to execute archive searches.

Features

Creating Archive Infostructures

You use this function to create a new information structure based on application-specific field catalogs.

More information: Creating an Information Structure [page 739]

Activating an Information Structure

With this, you can activate an available information structure so that during a subsequent archiving program 
delete phase of the archiving object it automatically fills with data from the archive.

More information: Activating and Deactivating Information Structures [page 740]

Filling Information Structures

This function allows you to fill an information structure with data from the available archives if the delete 
program has already processed those archives. Normally this is not necessary because activated information 
structures are filled automatically during the archiving program delete run.

More information: Filling and Emptying Information Structures [page 741]

Field Catalogs

This function enables you to create new field catalogs or change customer-specific field catalogs.

More information: Field Catalogs [page 755]

Other Functions

Additional ARC functions allow you to empty, deactivate, change, display, and delete archive information 
structures.

21.1.6.2.1  Field Catalogs

Use

A field catalog includes all of the fields that can be selected when creating or maintaining an archive 
information structure. You can use it to specify which fields are incorporated in the information structure, and 
whether they should be key fields or data fields. You can decide whether key- or data fields should be 
incorporated into the information structure. The fields contained in a field catalog are always archiving object-
specific.
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You can create new field catalogs and edit existing ones.

Note
Standard catalogs, which are designed to cover most application requirements, are supplied with the 
standard system's archive information system. You should therefore create your own field catalogs only if 
the fields contained in the standard catalogs do not meet your requirements.

Note
If the standard transaction in the application permits only standard SAP field catalogs, the system does not 
take customer-specific field catalogs into account.

Prerequisites

You need to have some expert knowledge to use this function. For example, you should be familiar with the data 
model of the archiving object up to table level.

Features

Editing Available Field Catalogs

You can change the definition of the available field catalogs, for example, by adding further source fields or 
changing the allocation of data- and key fields. The procedures for creating field catalogs are applicable in this 
case (see below).

Note
You must copy a standard field catalog from the SAP namespace into your own namespace before you make 
any changes to it, that is, before you change it to a customer-specific catalog. All entries that begin with 
"SAP" belong to the SAP namespace and you should not make changes to them.

Creating New Field Catalogs

To create a new field catalog, you have the following options:

● Use fields from a source table
● Use fields from multiple source tables

For more information, see Creating Field Catalogs (One Source Table) [page 757].

Deleting Field Catalogs

Before you delete a field catalog, you must first delete all of the archive information structures that use this 
field catalog. A deletability check prevents the deletion of catalogs that are still in use. If you try to delete an 
SAP standard field catalog, the system issues a warning message to this effect.
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21.1.6.2.1.1  Creating Field Catalogs (One Source Table)

Procedure

● 1. In the initial screen of the Archive Retrieval Configurator (ARC), choose Environment Field 
Catalogs  and then New Entries.

2. Enter the name of the field catalog (it cannot begin with SAP), a description, and the archiving object 
for which the field catalog is intended.
In the fields File in Index and Offset in Index, you can specify how the name of the archiving file and the 
offset of the data object are included in the information structure. You can use the following values:
○ Values for file names

Table 188:

Value for file names Description

D Includes the file name as a data field. This is the mini­
mum value. It causes the archive file name to be en­
tered in the data area of the structure table.

K Includes the file name as a key field. Select this value 
if the entries in the table would otherwise not be 
unique.

○ Values for the offset

Table 189:

Value for offset Description

D Includes the offset name as a data field. This value is 
sufficient for a direct access to archived data.

K Includes the offset name as a key field. Select this 
value if the entries in the table would otherwise not 
be unique.

No value The offset is not included in the structure table. 
Choose this setting if you do not want direct access. 
This allows you to reduce the size of the structure ta­
ble.

Note
If you include the offset as a key field, you must also include the archive file as a key field, otherwise 
a clear distinction between archived objects by the offset cannot be guaranteed. If an archived 
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object, such as a sales document, has already been clearly identified by the document number in 
the field catalog key, then you do not need to include the offset in the key.

3. To perform the field assignment, first select the catalog and then the Field Selection node in the 
navigation area. Choose New Entries and enter the required data.
○ You can choose the field number and target field yourself. The name of the target field appears in 

the generated table and should have a definition that makes sense for reporting. The field number 
describes its position in the information structure and serves as a sort criterion.

○ However, the source field must correspond with the actual field name from the source table.
○ The source field entered directly in the field selection is also the reference field. The data type of 

the relevant field in the information structure is derived from this reference field.
○ The source table must be a table for which the archiving object in the information structure writes 

data to the archive. These tables are maintained in the transaction AOBJ for the archiving objects.
○ If you mark a Key field, that field is included in the key to the structure table. A table's key fields 

must come at the beginning, that is, the field numbers of the key fields must be smaller than the 
field numbers of the data fields. Furthermore, the key fields must be connected, that is, no non-key 
fields are allowed to come between key fields.

○ The Mandatory Key Field checkbox is valid only for key fields. If you select this checkbox, the data 
record will be included only if the relevant field in the source table is not empty.

Note
Tables that are processed by archiving classes can also be used as source tables. However, to do so, 
you must create a normed read function module for each archiving class used.

4. Save your entries.

21.1.6.2.1.2  Creating Field Catalogs (More than One Source 
Table)

Prerequisites

● You have created a field catalog with at least one field.
● You are at the field selection for the field catalog.

Context

You can add additional source fields to field catalogs. This means:

● For key fields, the system establishes field similarities between the join conditions of the different source 
tables.
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● The system can fill data fields with data from different source tables in an archive information structure.

Note the following special features:

● For each source table, there must be a unique combination of fields in the key of the information structure. 
This means that there can never be two data records with the same value combination within one data 
object.

● For each key field, the system establishes the field similarity between the reference field and the additional 
source fields.

● The system fills the information structure with archive data using an outer join based on the field 
combination. The system writes a record for the data object if at least one of the source tables contains 
data.

● When the system is filling an information structure, an incorrectly defined field catalog can cause a 
program termination. Read the long text in the error message Q6234. Here you can also find a detailed 
example of how to create field catalogs.

● The source field entered directly in the field selection is also the reference field. The data type of the 
relevant field in the information structure is derived from this reference field. The fields entered in 
Additional Source Fields must be compatible reference field type.

Procedure

● 1. Choose the field to which you want to add source fields.
2. In the navigation frame, choose the Additional Source Fields node.
3. Choose New Entries and enter the source table and the source field that are to be joined with the target 

field.
4. Save your entries.

Results

There is now a logical link (join) for key fields between the target field and the additional source field. When the 
system fills the information structure, it moves the contents of the source fields assigned to the target field to 
the data fields.

21.1.6.3  Archive Explorer

Use

The Archive Explorer enables you to search for archived data and allows individual objects to be displayed from 
the archive.
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Integration

You can go to the Archive Explorer from either the initial screen of the archive information system or from the 
Archive Retrieval Configurator (choose Environment Archive Explorer ).

Prerequisites

To use Archive Explorer, you need to perform the following activities:

● Create a suitable archive information structure
● Activate the information structure
● Fill the information structure

Features

On the Archive Explorer selection screen, the fields appear as in the archive information structure.

In the selection screen, you can define which archived data should be read by the Archive Explorer reporting 
program. An object list from the set information structure is displayed as a result of this selection, from which 
you can access single data objects in the archive.

A standard viewer is available to display the data objects. Independent of the underlying archiving object, there 
are also application-specific viewers. The interface used can also be used for customer-specific extensions.

Activities

Report information structure [page 742]

More Information

Creating an Information Structure [page 739]

Activating and Deactivating Information Structures [page 740]

Filling and Emptying Information Structures [page 741]

760 C U S T O M E R
SAP Oil & Gas (PRA - Production and Revenue Accounting)

PRA Archiving 



21.1.6.3.1  Reporting

Use

You can use this function to report from the archive information structure that was created for the selected 
archiving object.

Prerequisites

You have created and built the archive information structure to be reported.

Features

Depending on the selection criteria entered, the system displays an object list for the archive information 
structure. You display a data object by accessing the archive directly. If an application-specific view is realized 
for the archiving object used, you can choose between the technical or the application-specific presentation of 
the data objects.

Activities

Reporting Information Structures [page 742]

More Information

Ad Hoc Reporting [page 761]

21.1.6.3.2  Ad Hoc Reporting

Use

You can use this function to report from the archive information structure that was created for the selected 
archiving object, without this structure having to be filled first .
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Prerequisites

The archive information structure to be reported has been created and activated.

Features

Depending on the selection criteria entered in the selection screen, an object is displayed for the set archive 
information structure.

To display a data object, the system accesses the archive directly. If an application-specific view is realized for 
the archiving object used, a dialog box appears in which you can choose between the technical or the 
application-specific presentation of the data object.

Unlike the standard reporting function, which requires that the archive information structure is filled with data 
from the archive, the ad hoc reporting function reads directly from the archive. This enables you test archiving 
and report archived data that has not yet been deleted from the database.

Activities

Report information structure [page 742]

More Information

Report [page 761]

21.1.6.3.3  Using List Variants

Use

In the Archive Explorer, you can save list variants with which you specify, for example, a selection of fields to be 
displayed.

Integration

You can operate the variant functions using the menu entries and function buttons of the SAP List Viewer.
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Features

You can create both user-specific and cross-list variants to display the data for an archive information structure 
as well as the table contents (as part of the technical view).

List Variants for Archive Information Structures

In the display of information structure data (the first list in the Archive Explorer), list variants are stored per 
archive information structure. A list variant is only valid for the archive information structure for which it was 
created and cannot be used for other archive information structures.

Once an archive information structure has been changed (but has kept the same name), the related list 
variants can still be used. However, a list variant can be invalidated by the change, for example, where the field 
displayed in the list variant has been deleted from the archive information structure. You should therefore 
modify the list variants accordingly.

Example
Example: When you display the archive information structure CO_ORDER_001, use the list variant 
MY_VARIANT to specify that the fields AUFNR (Order Number) and KTEXT (Short Text) are to be displayed. 
You cannot use these variants for the archive information structure CO_ORDER_002, even if both archive 
information structures have identical structures.

If the archive information structure CO_ORDER_001 is changed so that the fields AUFK and KTEXT no longer 
appear, then the list variant MY_VARIANT can still be used. However, is pointless as no fields are displayed. 
You can therefore modify these variants using the relevant function of the ALV to fit the changed archive 
information structure.

For the archive information structure CO_ORDER_002, you can also create a list variant called MY_VARIANT. 
However, this is not identical to the list variant of the same name for CO_ORDER_001.

List Variants for Tables

The technical view for single document display is used to display the table contents for the selected data 
objects. You can save list variants per table here, which are independent of the archive information structure 
used. A list variant created for a specific table is only valid for this table and cannot be used for other tables. 
However, a list variant for a specific table is always independent of the archive information structure used. This 
is also valid where the archive information structure belongs to different archiving objects. Therefore, it does 
not matter which archiving object was used to archive the table entries.

Example
Example: You are using the archiving objects SD_VBAK and PP_ORDER and the related archive information 
structures SD_VBAK_001 or PP_ORDER_001. Both archiving objects contain the table COEP. To display the 
table COEP, save the list variant MY_VARIANT in the Archive Explorer. In contrast to the above list variants, 
this variant is only assigned to the COEP table.

You can then use MY_VARIANT to display the COEP table, and it does not matter whether you enter the 
Archive Explorer via the archive information structure SD_VBAK_001 or PP_ORDER_001.

Activities

In the Archive Explorer list display, you can access the list variant functions. Choose Settings Display 
Variants .

SAP Oil & Gas (PRA - Production and Revenue Accounting)
PRA Archiving C U S T O M E R 763



More information: Documentation about the SAP List Viewer

21.1.7  Archive File Browser

Use

Archive File Browser (AFB) provides functions for displaying the contents of archive files. It offers a technical 
view of the archived tables in much the same way as the Data Browser does for data from the database.

Implementation Considerations

The AFB is a technical tool for data archiving administrators and anyone who needs to investigate problems 
with data archiving and in archived data.

The data is only displayed in technical form, there is no business view formatting. The system structures the 
data from a technical point of view according to session, file and data object. AFB ignores application-specific 
connections (such as logical data objects that are composed from several technical data objects). Some 
archived structures (for instance COVP11) do contain the actual data for particular database tables (for 
example, COEP and COBK).

Integration

● You do not need to make any system settings in Customizing to be able to use the AFB.
● Make sure that the user has the necessary authorizations, and that it is possible to access the archive files.

For more information, see Archive Files [page 765].
● To accelerate the start of the AFB, you can set the selection of archive files for the start of the transaction.

More information: Speeding up the Start of the AFB [page 786].

Features

● Displaying the Contents of Archive Files and Archiving Sessions
The AFB displays archived files. The way the data is structured corresponds to the structure in the archive. 
Evaluations of archived tables together with data in the database are not offered.
More information:
Archive Files [page 765].
Displaying Data Object [page 767].

● Searing for archived data
In addition to a search for archive files, a technical search for field contents is also possible in which the 
AFB searches for the contents of fields in a table (similar to transaction SE16).
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When making the search, the AFB always reads through the files and focuses on finding missing data. The 
focus on completeness, even at the cost of poor performance.
More information:
Searching for Table Contents [page 778]
Searching Efficiently for Table Entries [page 783]

Constraints

● The search for data in the AFB is not intended for the retrieval by end users, but for finding missing data.
● When searching for data in the AFB, no index of the archived data is constructed. To do so, use the Archive 

Information System [page 737].
Comparison with the Archive Information System

Table 190:

Archive Information System (AS) Archive File Browser (AFB)

The main focus is on creating an index for archive files. 
This index can be used to find archived data quickly.

When searching for the contents of archive files, the AFB 
reads through the area to be searched sequentially.

Search is only possible using specific criteria (fields in info 
structures)

Search is possible using any fields

The index can be used by applications such as the Docu­
ment Relationship Browser or line item reports for cost 
accounting to access archived data quickly.

No comparable interface

To access archived data, you have to first create and acti­
vate an info structure. In the production system this usu­
ally involves time and effort.

Access to archived data is possible immediately.

Business views, consequently also of interest to end users Technical representation of data, only of interest to admin­
istrators

21.1.7.1  Archive Files

Definition

The AFB operates using data objects. An archive file is divided into a header and several data objects. A data 
object is often an instance of the business object that corresponds to the archiving object.

Example
For archiving object SD_VBAK the data for an individual sales order is saved in one data object. However, 
this type of correspondence does not have to apply to every archiving object.
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Structure

A data object always consists of exactly the data that is written to the archive by the write program between 
calling up the function modules ARCHIVE_NEW_OBJECT and ARCHIVE_SAVE_OBJECT. Consequently, 
everything that can be read between the first and second call up of function module 
ARCHIVE_GET_NEXT_OBJECT belongs to the same data object.

The AFB operates using these data objects. Except for the hex display, the AFB always displays exactly one 
object. During the search, the system looks for data objects that correspond to particular criteria.

You can specify a data object by entering the archive file and the offset, or by entering the archive file and the 
number of the data object. In the AFB there is always a current data object that is represented at least by the 
entry of archive file and offset. The system often displays the number of the data object in addition. All 
displaying functions and functions for relative navigation ( Next File, Previous File, Continue) relate to the 
current object.

Sequence of archive files

The AFB always arranges archive files and data objects according to the same pattern. The data is sorted 
according to archiving object, session and archive file key. The runs are always displayed in descending order, 
so that the most recent runs are at the top.

The AFB sorting rules:

● Files are arranged alphabetically in ascending order according to their archiving objects.
● More recent archiving runs come before older ones
● Within the sessions the files are in ascending order

Use of this sort order:

● In the archive file overview
● When searching in the list of the files to be searched
● During the search the files are dealt with in this order
● For the functions for relative navigation ( Next File, Previous File, …) this sequence is used as the basis.

Authorization checks

In addition to checking the authorization to access the archive (authorization object S_ARCHIVE), checks have 
been implemented in the AFB that allow or forbid the display of archived data in a similar way as for the Data 
Browser (transaction SE16). This involves the display authorization for authorization object S_TABU_DIS. The 
authorization to display data from a table should not change due to it being archived. The same should apply 
for archived data as for data from the database.

Required authorizations for different areas

Table 191:

Area Prerequisite
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Data Object User requires display authorization for the table to be dis­
played. This means not all data is necessarily displayed for a 
data object (you receive corresponding messages in the 
log).

If the user does not have authorization for any of the tables 
of the data object, then nothing is displayed for the current 
data object.

Table User requires display authorization for the table. Only those 
tables for which the user has authorization can be displayed.

Hex display User requires display authorization for all tables that relate 
to the archiving object of the file to be displayed.

If the user lacks authorization for one or more tables then 
nothing is displayed for the archive file.

Search A user can only search for the content of tables for which he 
or she has authorization.

21.1.7.2  Displaying Data Objects

Context

You want to display a data object with AFB.

Procedure

● 1. Expand the navigation tree in the archive files overview until you can see the key for the archive file you 
want.

2. By double-clicking the key of the archive file call up the first data object of this file. On the Data Object 
tab page, you will see the data object with an overview of the table entries it contains.

3. Use the scroll keys to navigate to other data objects.
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21.1.7.3  User Interface for the Archive File Browser

Use

The user interface is made up of the following areas:

Table 192:

Interface Area Description

Archive files overview Overview divided according to archiving object, session, and 
file.

More information: Archive Files Overview [page 768]

Header information This area shows you which archive file and which data object 
are displayed.

More information: Header Information [page 771]

Scroll keys For navigating in the data objects and files.

More information: Navigation [page 775]

Display area To display data. Here you see the content of the archive file 
in the desired view. In this area you can define and execute a 
search.

More information: Display Area [page 772]

Messages Collection of notifications and error messages that are gen­
erated.

More information: Messages [page 774]

21.1.7.3.1  Archive Files Overview

Use

On the left side of the screen, the system displays an overview of the archive files in the form of a tree structure. 
The files are grouped according to archiving object and archiving session. The files themselves are the end 
nodes of the tree structure.

You can set the fields displayed and also influence the quantity of archive files displayed using a filter function. 
You can also determine an initial layout (including filter criteria).

For an overview of the screen areas in AFB, see User Interface [page 768].
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Features

Double-click on an archive file in the overview to open a file. The first data object in this file for the current data 
object appears in the display area. In the case of functions that select a data object (relative navigation, find), 
the system expands the archive file for the current data object in the overview and selects it.

You can show the following fields in the archive files overview using the layout editing:

Fields in the archive file overview

Table 193:

Field Description

Number Number of data objects in the archive file The system auto­
matically totals this number at the archiving sessions level. 
The total refers only to the files in the overview; not to all of 
the files in the system.

If, for example, you have set the filter so that only archiving 
sessions from a certain creation data are displayed, then the 
total at archiving object level contains only the data objects 
of the files for these sessions, and not for every file of the ar­
chiving object.

The AFB obtains the number of objects from archive admin­
istration. When certain errors occur, you may find that these 
differ from the actual number of objects in an archive file

User Name of user who started the archiving. This field remains 
blank on archiving object level.

Size (MB) File size in MB, shown to three decimal places. This number 
is determined from archiving administration, and may (like 
the number of data objects) differ from the actual size in cer­
tain circumstances.

The file size is totaled at the level of the sessions and archiv­
ing objects, using the same mechanism as for the number of 
data objects.
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Description The texts for the relevant object are displayed depending on 
the level in the tree structure:

Level

Displayed Text

Archiving Objects

Description of the Archiving Object

Archiving Sessions

Comments about the archiving session that can be entered 
for some archiving objects when scheduling the write pro­
gram.

Archive Files

Comments on the file that can be changed in archive admin­
istration.

Date Creation date of the archive session or archive file.

This field remains blank on archiving object level.

Time Creation time of the archive session or archive file.

This field remains blank on archiving object level.

Activities

Layout of the Archive Files Overview

The layout of the archive files overview contains the selection of the tree structure columns (except the 
hierarchy column), and also the sequence and width of the columns. In addition you can also save the current 
filter criteria with the layout.

The layout editing contains the following functions:

Table 194:

Layout Function

Select Choose a layout already saved, with filter criteria if appropri­
ate, and use on the overview.

Change Change the current field selection and field sequence.

Save Save the current layout. You can choose whether you want 
to save the layout user-specific or cross-user, and whether 
the system should save the filter conditions with the layout.
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Manage Manage the saved layouts. In particular, you can delete a lay­
out and select a layout as a default. The effect of the default 
is that when you next start the AFB, this layout is used auto­
matically, together with any filter conditions.

Filter in the archive file overview

The AFB loads certain data to the main memory for each file that is displayed in the overview. Consequently, 
the time taken to start the transaction and also the memory usage depend very much on how many archive 
files are being processed. You can use filters to influence this quantity.

To change the current filter criteria, choose Set Filter.... You can choose any field that is displayed in the 
overview as a filter criterion, this includes the archiving object, session, or file key. The system always uses all 
criteria directly for the selection of the archive files. This means that both the creation date and time relate only 
to the archive files. The Name field refers only to the comments for the archive file. File size and number of 
objects refers to the number of archive files, and not to the totals at higher levels.

It is possible to save the filter criteria when you save a layout. When you choose a layout or start a transaction 
with a predefined layout, the system uses the related filter.

For more information, see Speeding up the Start of the AFB [page 786].

21.1.7.3.2  Header Information

Use

The header information contains the current data object. For an overview of the screen areas in AFB, see User 
Interface [page 768].

Features

In the header information, you can place the cursor directly on a particular data object within an archive file.

Header Information Fields

Table 195:

Field Description and Notes

Archive File Archive file for the current data object

This archive file is also expanded and selected in the archive 
file overview unless this selection has been changed man­
ually or you are currently evaluating a background search 
and the hit is not located within an archive file from the over­
view.
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Data Object The number of the current data object within its archive file

This field usually displays a value between one and the num­
ber of data objects in the archive file. In the Hex Display, you 
may also find data object number 0 (zero). Then the begin­
ning of the archive file is displayed. If you enter the offset of 
a data object directly in the field Offset, then Unknown ap­
pears in the Data Object field. The field is ready for input as 
soon as a data object has been selected for the first time.

Note
You should note that direct entry can entail a long run­
time, as the archive file may be read sequentially.

From Number of data objects in the archive file

Offset Offset of the current data object

To find a data object as quickly as possible, enter a value in 
the Offset field.

Note
Note that if you enter the offset direct, the functions 
Previous Data Object and Next Data Object can no longer 
be used.

21.1.7.3.3  Display Area

Use

The AFB offers three different views in the display area of the current data object or the archive file currently 
being displayed.

● The Data Object view represents all of the tables entries for the data object.
● The Table view represents an individual table of the archiving object.
● The Hex Display represents the content of the archive file in a highly technical form without additional 

formatting.

For an overview of the screen areas in AFB, see User Interface [page 768].

Features

Data Object
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In the Data Object view, the system formats the archive file content in such a way that the content of all table 
entries for the current data object is visible. The table entries are displayed in the same form as they are found 
in the archive. You receive a list where the table name is in the first field, followed by the content of the relevant 
entry formatted as a character string.

The list is displayed using the SAP List Viewer and offers its standard functions.

Note
Note that the standard functions of the SAP List Viewer refer only to the current data object. A search is 
then made using only the data of the current data object.

For the display, the system formats every table entry as an individual character string. This means special 
attributes for the individual fields are lost. You may find that a table is too wide to be displayed in its entirety. By 
double-clicking you can obtain field-by-field formatting of the corresponding record.

Note
If you want a different format for a particular table, select an entry for the required table and switch to the 
Table view. The system then automatically displays all entries for this table from the current data object.

The table entries are displayed in this view in the same order as they were written to the archive, unless the 
data was saved using archiving classes. Data for archiving classes is displayed with the other data for the 
current data object in accordance with the entries that were not saved using archiving classes.

Table

The Table view displays the entries for the current data object that relate to a particular table. The data is 
formatted field-by-field. The view of the table is similar to that of the Data Browser (transaction SE16).

The list is displayed using the SAP List Viewer and offers its standard functions.

Note
Note that the standard functions of the SAP List Viewer refer only to the current data object. A search is 
then made using only the data of the current data object.

In the Table Name field, you enter the name of the table for which you want to see the entries. You will usually 
find this field has already been defined if you have already selected a data object.

You can use the input help to receive a selection of all tables that are archived with the archiving object for the 
current file. In the event that no data object has been selected, you receive all tables for all archiving objects in 
the archive file overview. If you enter the table directly, you have to choose data release to refresh to list.

Note

Choose Settings Technical Field Names  or Field Labels to switch between the display of technical 
names and field labels, as required. This affects all parts of the AFB in which field labels occur, for example, 
in a search.

Depending on the view with which you previously looked at the current data object, the table name is 
predefined as follows:

· In the Data Object view, one entry is usually selected. The table for this entry is displayed with the Table view.
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· The search switches automatically to the Table view at the first hit. The table, which is also used in the search 
criteria, is displayed.

· In all other cases, the table name is predefined in such a way that the table is suitable for the archiving object 
of the current data object. If the table no longer matches the archiving object through navigation to a data 
object for a different archiving object, then the system selects a new table.

If you branch from the Table view to the search but have not yet selected a table for the search criteria, the 
system automatically transfers the table being displayed.

Hex Display

The system presents the content of the archive file in raw format in the hex display,

Note
This view is particularly useful if you want to look at the archive file header, or if the file is defective and this is 
the only way you are able to display it.

The data in the file is represented in hex format (00 to FF for every byte). In the first column you see the offset 
in the archive file for the first byte in each line. 32 bytes then follow in every line, in eight groups each having 
four bytes. In the area on the right, you can see the equivalents in plain text. The respective character coding is 
taken into account (including unicode). This means it is possible that only 16 characters (for example) relate to 
the 32 bytes As the data in the archive file is present in compressed form, the header can only be recognized 
from the plain text representation at the beginning of the archive file. It is not possible to recognize the data 
itself this way.

The part of the archive file that is displayed is determined by the offset and the number of displayed bytes. The 
system uses the offset displayed in the header information. In this way, all navigation functions can also be 
used for the hex display.

Note
The hex display recognizes the data object with the number 0 that represents the beginning of the file.

You can enter the number of bytes displayed in the Area Displayed field on the Hex Display tab page.

Analysis of Defective Files

You can use the hex display to analyze defective files that you are not able to display with the other views. To do 
this, you have to have detailed and extensive knowledge of the structure of the archive files. The hex display 
bypasses the usual mechanism for accessing files (meaning the function modules for the ADK). However, no 
files can be analyzed this way that are found in the archive store ( SAP ArchiveLink).

21.1.7.3.4  Messages

Use

Each message or error message that is generated during a session with the Archive File Browser is collected in 
a log in the lower area of the AFB. For an overview of the screen areas in AFB, see User Interface [page 768].

774 C U S T O M E R
SAP Oil & Gas (PRA - Production and Revenue Accounting)

PRA Archiving 



Example
Examples of errors include error messages when accessing archive files or the message at the end of the 
search.

Features

The messages are displayed in the log as a list, with the latest message at the top.

Log Line Fields

Table 196:

Field Meaning

Type Severity of the Message

Message Context Information about the archive file relating to the message

If the message cannot be assigned directly to an archive file, 
then the action which triggered the message is displayed.

Message Text Message short text

Long Text Icon indicating whether or not there is a long text for the 
message

Note
You can read the long text of a message by double-clicking the message.

Note
Use Delete Messages to delete all of the messages collected up to that point from the list (and from the 
memory).

21.1.7.4  Navigation in the Archive File Browser

Use

The Archive File Browser offer an overview of archive files and data objects. More information: User interface 
[page 768]
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Features

The the fields in the Header Information [page 771], the Archive File Overview [page 768] and the scroll keys 
give you various options for navigating in archive files and outside of archive files. You can combine some of 
these options.

Opening Archive Files

Double-click on an archive file in the overview to open a file. The first data object in this file for the current data 
object appears in the display area.

Various methods for selecting a file:

● By double-clicking on an archive file key, this file is selected
● By double-clicking on a session, the first file in the session is selected
● By double-clicking on an archiving object, the first file of the latest session that appears in the overview is 

selected

System actions depending on the view selected

Table 197:

Tab page before double-click Result

Documentation or search The system selects the first data object in the Data Object 
view.

Data object or table The system selects the first data object , no change to the 
view.

Hex display The display starts with the beginning (data object 0, offset 
0) of the selected archive file, no change to the view.

Scroll keys

You will find the scroll keys for the relative navigation between the archive file overview and the display area.

Note
The first data object of an archive file means in the case of the hex display the data object number 0 (zero), 
that is, the start of the archive file. With every other view the first data object literally means the very first 
data object in the archive file.

Navigation using Scroll Keys

Table 198:

Scroll Keys Features

First File The system highlights the first data object of the first file.

Previous File The system highlights the first data object of the file that is 
in the overview in front of the file for the current data object.
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Previous Data Object The system highlights the data object that is in front of the 
current data object.

In the event the current data object is the first data object in 
the archive file, the system highlights the last data object of 
the previous archive file.

Caution
Note that this procedure can be time-consuming, as it 
may be necessary to read the entire archive file in se­
quence.

Recommendation
This function is not recommended if you are entering an 
offset direct.

Next Data Object The system highlights the data object that is in front of the 
current data object.

If the current data object is already the last data object of 
the archive file or the archive file cannot be accessed, the 
system highlights the first data object in the following ar­
chive file.

Recommendation
This function is not recommended if you are entering an 
offset direct.

Next File The system highlights the first data object of the next ar­
chive file in the overview.

Last File The system highlights the first data object of the last archive 
file in the overview.

Continue Search The system determines the next hit in the search.

Note
This button is only active if you have started either a 
search or the background search report.
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21.1.7.5  Searching for Table Contents

Use

You can use the search for table contents to search archive files. You search for data objects that meet specific 
criteria. These are selection criteria for a specific table.

The system searches the files sequentially and displays the data objects. If you want to search larger archive 
files or a large number of files, you can execute the search in the background.

Features

You have the option of performing the search online or scheduling the search query as a background job and 
evaluating the result at a subsequent stage.

For more information, see Searching for Table Contents Online [page 779] and Searching for Table Contents in 
the Background [page 780].

Activities

If you search using Search or Start Search, the system searches for the selected files in the order in which they 
are displayed in the archive files overview. The system only searches through files that could actually contain 
the table from the selection criteria. The system obtains this information from the definition of the archiving 
objects, and not direct from the archive files.

Once the system has found a matching data object, it switches to the view Table and displays the table entries 
from the search criteria, meaning it displays all entries for the data object, and not just those that match the 
selection.

At this point you can switch to the other views, and use all of the other navigation options.

By choosing Continue Search, you can continue the search. Using this function you can do a complete search 
through each of the files you want to search, in succession.

Note
When the system finds a matching data object, it only switches to the view Talle if you are not already in one 
of the other views Data Object, Table or Hex Display.

Search Procedure

The system checks whether the file for the current data object is in the search area. If this is the case, the 
system continues the search with the next data object. If the current data object is the last in its file, the system 
continues with the first data object of the next file in the search area.

If the current file is not in the search area, the system continues with the next file that is found in the search 
area. The next file in this case is determined by the sequence in the archive file overview.
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When carrying on with a search, the current search criteria are always used, and these may differ from the 
search criteria at the start of the search.

Note
You can navigate freely between two search steps as necessary, and also change the search area and search 
criteria.

If the system has reached the end of the search area, it generates a corresponding message and deactivates 
the Continue Search function. It makes no difference whether the end of the search area was actually reached 
by the search or by any of the other navigation functions.

21.1.7.5.1  Searching Online for Table Contents

Procedure

● 1. In the Archive File Browser, you find the area Files to be Searched on the tab page Search on the top left 
of the screen. Drag the files to be searched from the archive files overview to this area by drag and 
drop.

Note
Check that the Search Mode [page 782] defined is Online Search.

For more information about the area Files to be Searched, see Areas Covered by the Search [page 
781].

2. In the Search Criteria area, select the table whose fields you want to use for the search. You can enter 
the table directly or use Other Table.
For more information about the area Search Criteria, see Areas Covered by the Search [page 781].

3. Choose Field Selection to define the fields for the search.
4. Enter the values that you want to use for the search.
5. Choose Start Search to start the search.

The system starts searching through the selected files. The search stops with the first hit. The system 
automatically switches to the Table tab page and displays the contents of the table that you specified 
in the search criteria.

Note
The Find Next button is activated.

6. Choose Find Next.
The system now resumes the search with the current data object. You can repeat this process until the 
search reaches the end of the search area. The system then displays a corresponding message.
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21.1.7.5.2  Searching for Table Contents in the Background

Context

You may find the online search is often unsuitable for searching through several or large archive files, and it is 
better to run time-intensive processes in the background. The Archive File Browser gives you the option of 
saving your search requests, processing them in the background, and evaluating the results later.

Recommendation
Finding table contents in the background should only be used for ad hoc search requests. If you regularly 
need to access archived data quickly, you are recommended to use the Archive Information System [page 
737].

Procedure

● 1. Determine which files you want to search and the search criteria. For more information, see Searching 
for Table Contents Online [page 779].

2. On the Search tab page, you choose Save for Background Search.
3. In the following dialog box, enter a unique text as the search description. You will later need to use this 

text to identify your search.
The system saves your search request. The selection of files to be searched and the search criteria all 
belong to the search request. In addition, a new entry appears in the Search Mode area bearing the 
description you entered.

4. Schedule program ASAFBSEARCH in the background using transaction SA38.
Program ASAFBSEARCH processes all pending search requests. All files are always read through 
completely. The program determines all hits.

5. Once the program has finished, start the AFB using transaction AS_AFB.
6. Select a search request and choose Load Search Results.

Results

The system loads the search area, the search criteria and the results of your search. The result covers both the 
hit list and any messages that are generated.

Note
Both the search area and the search criteria can no longer be changed or are no longer ready for input. The 
Search Mode [page 782] switches from Online Search to Background Search Report.
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As with the online search, you can navigate in the search result using Start Search and Continue Search. The 
system functions in the same way as with the search in dialog mode, except that you are unable to change the 
search.

Note
If you want to exit the results of the background search report in order to enter a new search, switch to the 
Search tab page and choose Online Search in the Search Mode area.

Messages when searching in the background

The system saves any messages that are generated along with the search results. Error messages may occur 
during the search. For example, if archive files cannot be accessed or are corrupted. These messages are 
displayed in the course of the background search report, just as for the online search.

21.1.7.5.3  Search Areas

Use

Files to be Searched

In this search area, you define which files are to be searched. The files are represented as a list of archive file 
keys. The sequence of the files corresponds to the display in the archive files overview. The search is made in 
the archive files overview from top to bottom. Only those files that are located in the search area are searched.

Caution
You should note that if you remove files from this area before you choose Cont. Search, these files are no 
longer included in the new search.

You can transfer additional files from the archive files overview using drag and drop. If you use an archiving 
session or archiving object in the search area instead of individual files, then all archive files that are in the 
overview under this session or object are included in the area to be searched.

Search Criteria

In this search area, you define which table contents you want to search for in the archive files. It is only ever 
possible to search for the contents of an individual table. You either enter this table direct or select it using 
Another Table. Only those tables matching the archiving objects of the files to be searched are offered. If you 
have not yet defined any files to be searched, then all tables for all archiving objects from the archive file 
overview are used. When you choose a new table, the system automatically proposes the first ten fields of this 
table as the selection criteria. You can change this selection using Field Selection. You can select a maximum of 
75 fields.

More Information

Search Mode [page 782]
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21.1.7.5.4  Search Mode

Use

In the search mode area, you determine using the Online Search and Background Search Report functions 
which database the system chooses for the Start Search and Cont. Search (Continue Search) functions.

● Online Search: the system searches through the archive files direct.
● Background Search Report: the system evaluates the results of a background search previously carried out.

To switch between the two options, choose Load Search Results.

● Load Search Results: You want to choose the results of a background search and make them available for 
the evaluation. To do this, the list of the files to be searched and the search criteria stored with the search 
request are downloaded and displayed.

Note
If results for the search request downloaded are already available, the system changes the search mode 
to Background Search Report, and changes are not possible. If no results are available, the system 
changes the mode to Online Search and changes to both the search area and search criteria are 
possible.

To start the search report, choose Start Search.

Change of Search Mode to Online Search

When you change the search mode from Background Search Report to Online Search the search results are 
discarded for the time being, and you can change the search area and criteria.

Note
If you have already started the background search report, the function Cont. Search continues to be active. 
You can use this function to find the next hit online. However, the files are searched and not the result of the 
background search.

Change of Search Mode to

Background Search Report For a manual change from Online Search to Background Search Report you must 
have at least one search request with results. Only in this case can you switch to Background Search Report.

If a previously completed search request has already been downloaded, the system uses this. Otherwise the 
system selects the completed search request that is uppermost in the list.

List of Search Requests

The list of search requests contains the possible search requests and informs you which of these requests has 
already been processed by search program ASAFBSEARCH.

List of Functions for Search Requests

Table 199:

Function Description
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Save for Background Search For more information, see Searching for Table Contents in 
the Background [page 780].

Load Search Results For more information, see Searching for Table Contents in 
the Background [page 780].

Refresh To download the search requests again. The selection repre­
senting the processing status is updated.

Delete Entry To delete search requests You can delete completed re­
quests and requests not yet processed.

21.1.7.5.5  Searching Efficiently for Table Entries

Context

You can use the Archive File Browser to always include all files that exist in the system in the search area, define 
the search criteria and then choose Start Search. Using this procedure it can be a long time before you get a 
result. As a rule, the maximum runtime of a dialog step is limited, meaning that in many cases you may not 
actually get a result.

The following options are available depending on the situation:

● Use the Archive Information System
● User entries prior to archiving
● Restrict search area
● Search in the background

Procedure

● ○ Use the Archive Information System
In many systems in which archiving takes place, the Archive Information System [page 737] is also 
active. Any info structures that have been created should also be used here. In this situation, the 
Archive Information System essentially offers more efficient access to archived data than the Archive 
File Browser. The prerequisite for this is that the appropriate archive information structures are 
available and have been constructed.

○ User Entries Prior to Archiving
In archive administration (transaction SARA) you can see which selection criteria were used at the 
start of an archive session. To see how the archiving was started, choose the context menu (right 
mouse button) for the user entries made for an archiving session. You can often use this information to 
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identify which table entries could be contained in the files for the session. You should then only search 
through files that could also contain the data.

○ Restrict Search Area
You do not have to make the system search through all of the available archive files. You can for 
example only select archive files for sessions that match the user entries. If a time restriction is 
possible, you should set an appropriate filter in the overview of the archive files before including the 
archive files in the search area.

○ Search in the Background
Perform the search in the background, particularly if you are interested in more than the first hit.

Example
For more information, see Examples of Efficient Working with the AFB [page 784].

21.1.7.6  Using Archive File Browser Efficiently

Use

The following examples and explanations should assist you in using the Archive File Browser efficiently.

● You want to find a data object in an archive file.
More information: Finding Data Object in Archive File (Example) [page 784]

● You want to find a data object with a specific offset in an archive file.
More information: Finding Data Object with Offset in Archive File (Example) [page 785]

● During the search you want to skip several data objects or an archive file.
More information: Skipping Data Objects or an Archive File (Example) [page 786]

● You want to speed up the start of the Archive File Browser.
More information: Accelerate Start of Archive File Browser [page 786]

● You want to analyze corrupted files.
More information: Analyze Corrupted Files [page 787]

● You want to view the header data of the archive file.
More information: Displaying Header Data of the Archive File [page 788]

21.1.7.6.1  Finding Data Object in Archive File (Example)

Use

You want to find data object 17 in archive file 003755-001BC_SFLIGHT as quickly as possible.
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Procedure

1. Choose Find above the archive files overview.
2. In the following dialog box, enter the file key 003755-001BC_SFLIGHT. If the system does not find the file, 

check the filter settings in the archive files overview.
3. Double-click the file key 003755-001BC_SFLIGHT.
4. Enter the number of the data object, in this case 17, in the Data Object field and choose data release.

Result

The system reads archive file 003755-001BC_SFLIGHT up to the 17th data object, and displays this in the Data 
Object view. From there you can then navigate to other views or to other data objects.

21.1.7.6.2  Finding Data Object with Offset in Archive File 
(Example)

Use

This example shows you the fastest way to find the data object with offset 301451 in Archive File 
003755-001BC_SFLIGHT in the Archive File Browser.

Procedure

1. In the archive file overview, choose Find.
2. In the dialog box, enter the file key 003755-001BC_SFLIGHT.

If the system does not find the file, check the filter settings in the archive files overview.
3. Double-click file key 003755-001BC_SFLIGHT.
4. In the Offset field, enter 301451 and confirm your entry.

Result

The system displays the data object with this offset, or you receive an error message if no data object begins 
with this offset.
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21.1.7.6.3  Skipping Data Objects or an Archive File (Example)

Use

You establish that during the search, meaning you have chosen Start Search or Continue Search, that although 
hits may occur in the next 10 data objects or within the current file, they are of no interest to you, so you want 
use the normal navigation to skip them.

Procedure

Table 200:

Area that you want to skip Procedure

10 data objects Add 10 to the current data object number and enter the re­
sult in the Data Object field.

An archive file Choose Next File

You can also choose the next file in the overview by double-clicking, or if you are in the online search, delete the 
current file from the search area.

Note
Make sure that the current data object is not included in the search with the Continue Search. If the current 
data object has not been selected through the search, you have to check yourself whether it meets your 
selection criteria, or you must go back one data object before you choose Continue Search.

21.1.7.6.4  Accelerate Start of Archive File Browser

Context

When you start the Archive File Browser, loading the archive file overview in particular can be very time-
consuming. We therefore recommend creating a filter for the overview and defining this as a default setting.

Procedure

●
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1. Having started the AFB, select the filter function over the archive files overview. Choose fields that 
significantly restrict the search, such as the number of the archiving session or the creation date.

2. Choose Save Layout... in the drop-down menu for editing the layout of the archive files overview. Check 
that Filter Conditions is selected.

3. Enter a name and a description for the layout. Save the layout.
4. Choose Manage Layout... and select your layout as a default setting.

Results

When you next start the Archive File Browser,only those archive files that match the filter will be included in the 
overview.

Note
While you are working with the AFB, you can change the filter criteria at any time if you want to work with 
other archive files.

21.1.7.6.5  Analyze Corrupted Files

Use

In the Archive File Browser, you can use the Hex display to analyze corrupted archive files.

Procedure

In the archive file overview, select the corrupted file by double clicking it. The AFB attempts to read the first 
data object from the file and display this in the Data Object view.

This is either successful or the system displays the corresponding error messages in the log according to the 
type of error involved. You can toggle to the Hex display and analyze the file in all cases. To analyze the file, you 
require a good understanding of the structure of archive files.

Note
You cannot make corrections to the archive file using the Archive File Browser.
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21.1.7.6.6  Displaying Header Data of the Archive File

Use

You want to display the header data of an archive file in the Archive File Browser.

Procedure

Switch to the hex display. In the archive file overview, select the the required archive file.

Result

The system displays the header data of the archive file on the right-hand side of the screen.

21.1.8  Table Analysis

Use

You use the table analysis to distribute the table entries to the selected fields. A table analysis counts the table 
entries and assigns the number of entries found to the selected field values (for example, organizational units 
or periods) You use Analysis Variants [page 792] to determine the fields for the table analysis.

Integration

The analysis of the contents of a table is often necessary in the data archiving environment.

Features

● You can use the table analysis to analyze the distribution of table entries to the selected fields. For more 
information, see Performing Table Analysis [page 789].

● To perform a table analysis, you always need an analysis variant. For more information, see Analysis 
Variant [page 792].

● You can supplement a table you would like to include in an analysis with virtual fields. For more information, 
see Virtual Fields [page 794].

● You have multiple options for monitoring the space table analyses use on the database. For more 
information, see Reorganizing Table Analysis [page 791].
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In addition you can display or delete analysis variants, and display analyses performed in the background.

Activities

Transactions used within table analysis

Table 201:

Function Transaction Code

Table Analysis TAANA

Analysis Variant TAANA_AV

Virtual Fields TAANA_VF

Example

Table BKPF contains document headers for financial accounting. Each document is assigned to a company 
code. By using table analysis you can identify how many entries relate to a particular company code.

21.1.8.1  Performing Table Analysis

Procedure

Analyzing Individual Tables

1. Using transaction TAANA you can access the screen Table Analysis: Administration.

2. Choose Table Analysis Execute .A dialog box appears.
3. Enter the name of the table. Depending on this table, the system offers the analysis variants available for 

selection in the input help for the Analysis Variant field.
4. Select at least one analysis variant, or else create one.

Note
The system offers analysis variant DEFAULT for every table. This variant contains no fields. Therefore it 
determines the total number of entries in the client in which it is performed.

If an adequate analysis variant does not exist, the following options are available for creating analysis 
variants:

○ To create an ad hoc analysis variant specifically for a current table analyses, use Ad Hoc Variant. This 
variant is not saved on the database, and is available only for the table analysis that you are currently 
scheduling. For more information, see Creating an Ad Hoc Analysis Variant [page 793].

○ Use the transaction TAANA_AV to create an analysis variant. It is saved to the database and you can 
use it multiple times. For more information, see Creating Analysis Variant [page 792].

5. If you want to restrict the number of records to be analyzed, choose Data Selection. The Data Selection for 
Table <Name> window appears.
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Enter the criteria with which you want to restrict the selection. By default, the system suggests the fields 
that are either part of the table's primary key or are defined for secondary indexes. If necessary, you can 
add additional fields to the selection by choosing New Field Selection. You can also restrict the number of 
entries to be analyzed using Maximum Number of Entries. Save your entries.

Note
While selecting the data, and later, when displaying the result, you can use the options in the Settings 
menu to switch between technical field names and field labels.

6. Select the desired type of process control and choose Continue.

Recommendation
To improve performance, we suggest analyzing large tables in the background, not online.

7. Specify a start time for background processing. Save your entries. When you perform the analysis online, it 
is started immediately.
The table and analysis variant you selected for analysis are displayed on the left side of the screen.

Note
While the table analysis is being performed, you can Refresh the current data.

8. Double-click the table analysis on the left side of the screen to display it.
The table analyses on the left side of the screen are sorted by table name, name, analysis variant, and time 
of analysis.
The result of the analysis is displaed on the right of the screen. If you restricted the number of records to 
be analyzed before the analysis, the Data Selection button is displayed. You can use this button to display 
the values of the selection restrictions that applied for the selected analysis.

Analyzing Multiple Table in One Step

If you want to analyze multiple tables in one step, proceed as follows:

1. Use transaction SA38 to start program TAAN_PROCESS_MULTIPLE. A selection screen appears.

Recommendation
To improve performance, we suggest analyzing large tables in the background, not online (transaction 
SA38, Program Execute in Background ).

2. Enter the table you want to analyze.
3. Enter the relevant analysis variant and start the program.

Use transaction TAANA to view the results of the table analysis (see above).

Result

The various field values with the number of related table entries in the evaluation are displayed in accordance 
with the analysis variant you selected. The list is sorted in descending order by number of table entries.
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21.1.8.2  Reorganizing Table Analysis

Procedure

You have several options for monitoring and regulating the space table analyses use on the database.

Reorganizing Table Analyses

Table 202:

Reorganization Options Description

Retain most recent table analysis for each table and analysis 
variant

The system only retains the latest analysis with the status 
Completed for each table and analysis variant and deletes all 
other table analyses.

Exception:

Analyses with the status Scheduled as Background Job and 
In Process are retained.

Delete table analyses that were performed before a certain 
date.

All of the analyses performed before a specified date are de­
leted. The reference date is the start date of the analysis.

Refresh table analyses that were performed before a certain 
date.

All of the analyses performed before a specified date are de­
leted. A new analysis for the relevant table is performed us­
ing the same analysis variant.

We recommend reorganizing table analyses regularly (choose Utilities Reorganize Analyses... ), since the 
results of all table analyses are saved in the database tables (TAAN*), and may use up a considerable amount 
of space .

Analysis variants have been provided to enable you to determine the space used by the analyses. The usage of 
space is specified as the number of table rows in table TAAN_DATA. You can find most of the information about 
analyses you have performed in this table.

Analysis variants for determining space usage

Table 203:

Analysis Variant Meaning

TAANA_ANALYSE_BY_OBJECT Space usage for each table and analysis variant

TAANA_ANALYSE_BY_DATE Space usage for each month and year in which you have per­
formed analyses
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21.1.8.3  Analysis Variant

Use

To perform a table analysis [page 788], you always need an analysis variant. This relates to only one table and 
describes which fields are to be analyzed.

Depending on the usage type there are two kinds of analysis variant available:

● To create an analysis variant for future table analyses, use transaction TAANA_AV. The definition of this 
variant is saved on the database, and can be used for future table analyses.

● To create an ad hoc analysis variant for currently scheduled table analyses, use transaction TAANA. The 
definition of this variant is not saved on the database, and as a result is only available for the table analysis 
that you are currently scheduling.

Features

● Creating an analysis variant
○ For information on analysis variants that you can also use for future table analyses, see Creating an 

Analysis Variant [page 792].
○ For information on analysis variants that you can only use for currently scheduled table analyses, see 

Creating an Ad hoc Analysis Variant [page 793].
● Displaying an Analysis Variant

In transaction TAANA_AV, you can find on the left hand side of the screen a list of all the analysis variants 
created, sorted by table names. To display an analysis variant, double-click on it. The analysis variant is 
then displayed on the right side of the screen.

● Deleting an Analysis Variant
To delete an analysis variant, display the variant you want to delete on the right side of the screen. Choose 

Edit Delete .

21.1.8.3.1  Creating Analysis Variants

Context

To perform a table analysis [page 792], you always need an analysis variant [page 788]. This relates to only one 
table and describes which fields are to be analyzed.

The system saves the analysis variant to the database; it can then be used for future table analyses.
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Procedure

● 1. With the transaction:
○ TAANA_AV or alternatively

○ Starting from the table analysis (transaction TAANA), choose Environment Analysis Variant
to go to the change mode for analysis variants for the table analysis.

2. Choose Edit New Entries  and enter the name of the table for which you want to create an 
analysis variant.

3. Enter the name of the analysis variant that is in your namespace.
4. Choose Fields. The system offers you all table fields for selection.

Note
The system first displays the fields contained in the ABAP Dictionary (DDIC). Then it displays the 
virtual fields defined in the table analysis.

Note
An analysis variant should contain as few field as possible (three to four fields). You should only 
choose fields with a low selectivity, meaning with few characteristic values. Fields having high 
selectivity, for example document numbers, mean that the results list for a table analysis is unduly 
long, which both reduces its usefulness and also takes up too much space in the database.

5. Select the relevant fields or create virtual fields if necessary. For more information, see Virtual Fields 
[page 794].

6. Save the analysis variant.

Results

The new analysis variant is displayed on the left-hand side of the screen.

21.1.8.3.2  Creating an Ad Hoc Analysis Variant

Context

An ad hoc analysis variant is only available for the currently scheduled table analyses. The definition of this 
variant is not saved on the database, and therefore is available only for the table analysis you are currently 
scheduling.
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Procedure

● 1. With transaction TAANA you can access the screen Table Analysis:. Administration.

2. Choose Table Analysis Execute . A dialog box appears.
3. Enter the table name.
4. Choose the input help for the Analysis Variant.
5. In the dialog box Analysis Variants: Selection, choose Ad-Hoc Variant.
6. Select the fields for the analysis variant.
7. Choose Continue.

Alternatively, you can restrict the analysis to part of a table field, for example, to perform an 
aggregation on the year for date fields. To do this, you use the DDIC definition of the table you want to 
analyze to specify the fields you want to aggregate as subfields, and to specify the offset and length 
required. Enter the values in the offset and length subfields, for example, offset = 0, length = 4 if you 
want an aggregation over the year for a date field.

Note
You can only specify subfields for fields with ABAP types C (text field), N (numeric text field), D 
(date field), T (time field), and P (packed number). With type P this function is particularly useful for 
fields containing timestamps (DDIC data type TIMESTAMP or TIMESTAMPL). The standard format 
of these timestamps is "yyyymmddhhmmss" or "yyyymmddhhmmss.sssssss", whereby the year 
can be aggregated (subfield length 4) or the month of the year (subfield length 6).

8. Apply the analysis variant.

Note
You do not need a transport request for the ad hoc variant.

21.1.8.3.3  Virtual Fields

Use

Virtual fields enable you to perform the following analyses within table analysis:

● Analyze one part of a table field

Example
The table contains a date field, and you would like to examine the distribution of the data across the 
year.

● Analysis with a field that is not contained in the table to be analyzed but whose value can be determined 
from either the available table fields or, if necessary, from other tables.
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Example
The table does not contain a field naming the archiving object that can be used for archiving a data 
record.

Within table analysis you can create as many virtual fields as you require for each table. Such fields are treated 
in the same way as all other table fields. Virtual fields are not shown with separate IDs in transactions TAANA 
and TAANA_AV.

All of the virtual fields you have already created for the relevant table are available for analysis variants or ad 
hoc variants.

For more information, see Analysis Variant [page 792] and Performing Table Analysis [page 789].

Features

● Create virtual field
For more information, see Creating Virtual Fields [page 795].

● Displaying Virtual Field: All virtual fields you have created are listed in the left screen area, sorted according 
to table name. To display a field in the right screen area, double-click on it.

● Deleting a Virtual Field: Proceed as detailed under "Displaying a virtual field" and choose Edit Delete .

21.1.8.3.3.1  Creating Virtual Fields

Procedure

● 1. The following alternative access options are available:
○ Enter the transaction TAANA_VF.

○ Enter transaction TAANA and choose Environment Virtual Fields .

○ Enter transaction TAANA_AV and choose Environment Virtual Fields .

2. Choose Edit New Entries  and enter the name of the table for which you want to create virtual 
fields.

3. Enter a name for the new field. Make sure it is within your namespace.
4. Enter the data for the value determination, and technical attributes of the field.
5. Save your entries.
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21.1.9  Data Archiving in SAP NetWeaver AS

The following table shows the archiving objects provided:

Table 204:

Objects in SAP NetWeaver Application Server Archiving Object

User changes US_USER [page 797]

Authorization changes US_AUTH [page 798]

Profile changes US_PROF [page 800]

Work items WORKITEM [page 802]

IDocs IDOC [page 804]

Table changes BC_DBLOGS [page 817]

Link Entries ArchiveLink ARCHIVELNK [page 821]

Archive administration data BC_ARCHIVE [page 823]

Change documents CHANGEDOCU [page 829]

SAP product PRODUCT_MD

 

 

21.1.9.1  Archiving User and Authorization Changes (BC-ADM-
SEC)

Archiving User and Authorization Changes (BC-ADM-SEC)

You can archive change documents of the following types that are generated in the course of user and 
authorization maintenance:

● Users: Changes in assigned authorizations and other characteristics; changes in passwords

In transaction SU01 (user maintenance), choose the menu entry Environment → Archive and Read.

● Profile: All changes

In transaction SU02 (profile maintenance), choose the menu entry Environment → Archive and Read.

● Authorizations: All changes

In transaction SU03 (authorization maintenance), choose the menu entry Environment → Archive and Read.
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21.1.9.1.1   Archiving User Change Records (BC-ADM-SEC)

You can archive change records for the following changes to user master records:

● Authorization changes and changes to other user characteristics
● Changes to user passwords

Object Definition

The archiving object US_USER is used to archive password change records from table USH04. The object 
US_PASS archives records of changes to user master records other than password changes. In this way, for 
example, changes in the authorizations in a user master record are recorded. These recordings are stored in 
the USH02 table.

Technical Information

Unless you are archiving a large number of change records, an archiving run should have no significant effect 
on the performance of your system. The user change records require the following memory space 
(uncompressed):

● US_PASS password change records: 300 bytes
● US_USER user change records: 100 bytes

Dependencies

When you archive user change records, it does not have any effect on other archivable data. There are no 
particular dependencies or relationships between user change records and other archivable data.

You can use the archiving objects US_PASS and US_USER within the framework of Information Lifecycle 
Management. To be able to do this, you must activate the related business functions. The system then shows 
the ILM Actions group box. Using these actions, you can, for example, run archiving during which the system 
evaluates the retention periods entered in Information Retention Manager. You can also create snapshots 
(copies) of data, and you can delete data that does not meet your criteria.

Space Criteria and Storage Duration

We recommend a storage duration of 10 years for all user and authorization change records.

Change records are archived according to the date that you specify. All records older than the date specified 
are archived. Old archives are not automatically deleted.
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Log

The log files generated by archiving and deleting records are stored in the SAP spool system. The archiving log 
records the number of change records archived. The delete log lists the change records that were deleted after 
the archiving session.

Creating an Archive File

Choose Tools   → Administration   → User Maintenance.Then choose Users,followed byEnvironment → Archive 
and Read, and then the required archiving function.

The archiving function calls the standard archiving interface, where the correct archiving object is already 
specified.

You need only specify (or create) an appropriate report variant, specify the start time and printing 
specifications for the background processing of the report, and schedule the report with Create job.

See also the documentation on the archiving procedure in general. You will find this documentation in the first 
section of this document.

Executing the Deletion Program

You must explicitly delete archived records after an archiving session has been successfully completed. Be sure 
to check the archiving log to be sure that the archiving session has been completed successfully. Also, be sure 
that you specify the same date for the deletion program. Otherwise, too many or too few change records will be 
deleted.

 

 

 

21.1.9.1.2   Archiving Authorization Change Records (BC-ADM-
SEC)

You can archive change records for all changes to authorizations.

Object Definition

The archiving object US_AUTH is used to archive change records for changes to authorizations from table 
USH12.
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Technical Information

Unless you are archiving a large number of change records, an archiving run should have no significant effect 
on the performance of your system. An authorization change record requires about 100 bytes 
(uncompressed).

Dependencies

Archiving authorization change records does not have any effect on other archivable data. There are no 
particular dependencies or relationships between authorization change records and other archivable data.

You can use the archiving object US_AUTH within the framework of Information Lifecycle Management. To be 
able to do this, you must activate the related business functions. The system then shows the ILM Actions group 
box. Using these actions, you can, for example, run archiving during which the system evaluates the retention 
periods entered in Information Retention Manager. You can also create snapshots (copies) of data, and you can 
delete data that does not meet your criteria.

Space Criteria and Storage Duration

We recommend a storage duration of 10 years for all user and authorization change records.

Change records are archived according to the date that you specify. All records older than the date specified 
are archived. Old archives are not automatically deleted.

Log

The log files generated by archiving and deleting records are stored in the SAP spool system. The archiving log 
records the number of change records archived. The delete log lists the change records that were deleted after 
the archiving session.

Creating an Archive File

Choose Tools → Administration → User Maintenance.Then choose Manual Maintenance → Edit Authorizations 
Manually (transaction SU03), followed by Utilities Archive and Read, and choose the archiving function.

The archiving function calls the standard archiving interface, where the correct archiving object is already 
specified.

You need only specify (or create) an appropriate report variant, specify the start time and printing 
specifications for the background processing of the report, and schedule the report with Create job.
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See also the documentation on the archiving procedure in general. You will find this documentation in the first 
section of this document.

Executing the Deletion Program

You must explicitly delete archived records after an archiving session has been successfully completed. Be sure 
to check the archiving log to be sure that the archiving session has been completed successfully. Also, be sure 
that you specify the same date for the deletion program. Otherwise, too many or too few change records will be 
deleted.

 

 

21.1.9.1.3   Archiving Profile Change Records (BC-ADM-SEC)

You can archive change records for all changes to profiles.

Object Definition

The archiving object US_PROF is used to archive change records for changes to authorization profiles from 
table USH10.

Technical Information

Unless you are archiving a large number of change records, an archiving run should have no significant effect 
on the performance of your system. A profile change record requires between 0.5 and 1 KB (uncompressed).

Dependencies

Archiving profile change records does not have any effect on other archivable data. There are no particular 
dependencies or relationships between profile change records and other archivable data.

You can use the archiving object US_PROF within the framework of Information Lifecycle Management. To be 
able to do this, you must activate the related business functions. The system then shows the ILM Actions group 
box. Using these actions, you can, for example, run archiving during which the system evaluates the retention 
periods entered in Information Retention Manager. You can also create snapshots (copies) of data, and you can 
delete data that does not meet your criteria.
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Space Criteria and Storage Duration

We recommend a storage duration of 10 years for all user and authorization change records.

Change records are archived according to the date that you specify. All records older than the date specified 
are archived. Old archives are not automatically deleted.

Log

The log files generated by archiving and deleting records are stored in the SAP spool system. The archiving log 
records the number of change records archived. The delete log lists the change records that were deleted after 
the archiving session.

Creating an Archive File

Choose Tools   → Administration   → User Maintenance.Then choose Manual Maintenance →Edit Authorizations 
Manually(transaction code SU03), followed by Utilities  → Archive and Read, and choose the archiving function.

The archiving function calls the standard archiving interface, where the correct archiving object is already 
specified.

You need only specify (or create) an appropriate report variant, specify the start time and printing 
specifications for the background processing of the report, and schedule the report with Create job.

See also the documentation on the archiving procedure in general. You will find this documentation in the first 
section of this document.

Executing the Deletion Program

You must explicitly delete archived records after an archiving session has been successfully completed. Be sure 
to check the archiving log to be sure that the archiving session has been completed successfully. Also, be sure 
that you specify the same date for the deletion program. Otherwise, too many or too few change records will be 
deleted.
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21.1.9.2   Archiving Work Items

Definition

Archiving object WORKITEM for archiving and deleting work items.

Use

Archiving Work Items

The system archives all data (not including runtime data) that belongs to a work item. You can display archived 
work items, but you cannot reload them into a system.

You can only archive completed workflow work items. This involves archiving all work items that are dependent 
on this workflow work item as well. A work item that depends on superordinate work items cannot be archived 
on its own.

You archive log data, workflow manager data, dependent work items and work item attachments (for example, 
graphics files).

The other objects in the container of a work item are archived only as references. Do not delete them.

Criteria for Archiving

You can only archive those work items that have one of the following statuses:

● Completed
The execution of the work item is completed.

● Logically deleted (CANCELLED)
Execution of the work item is no longer useful or required for the workflow logic.

Structure

Archiving Work Items

Choose Tools → Business Workflow or Development → Workflow and then Administration → Workflow Runtime 
→ Reorganization → Archive Work Item. For more information about the archiving procedure, see Executing 
Archiving.

To define the required variants, use the following selection criteria. This determines which work items to 
archive:

● Work item ID (work item number)
● Task identifier
● Actual agent of the work item
● Date when the work item was created
● Date when the work item was completed

Deleting Archived Work Items
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Choose Tools → Business Workflow or Development → Workflow and then Administration → Workflow Runtime 
→ Reorganization → Archive Work Item. For more information about the archiving procedure, see Executing 
Archiving.

You can specify whether the deletion program started after the archiving process is to run in test mode. You 
specify whether or not the deletion program is started in general Archive Customizing [page 698].

To directly Delete Work Items that have not been archived, choose Tools → Business Workflow or Development 
→ Workflow and then Administration → Workflow Runtime → Reorganization → Delete Work Item. For 
performance reasons, use the report RSWWCIDE for container anchors (Type C work items).

Note
If you want to delete work items that meet the archiving criteria but that you do not want to archive, you 
should nevertheless archive them, as it is better performance-wise to use the delete program of the 
archiving object WORKITEM than to delete the work items directly. Carry out the archiving procedure and 
then delete the archive file containing the archived work items manually in the file system.

Displaying Archived Work Items

Choose Tools → Business Workflow or Development → Workflow and then Administration → Workflow Runtime 
→ Reorganization → Archive Work Item. For more information about the archiving procedure, see Executing 
Archiving.

If you select Analyzing, the report RSWWARCR is used for reading and displaying archived work items.

Note
This report is only intended to be a template for your own customer-specific report, since the data selection 
from the archive and the subsequent data formatting is generally customer-specific. The customer-specific 
adaptations are made after the function module SWW_WI_LIST_ARCHIVED_READ is called.

Displaying Archived Work Items for an Object

The display of an archived work item is useful, for example, of you want to use the archive to determine the 
workflow followed to release a specific document.

To display archived work items specific to an object, use the Archive Information 
System).sapurl_link_0001_0001_0001 The system automatically determines the archive that contains the 
archived data. Otherwise you need to know the archive.

To use the archive information system, activate the archive information structure

For more information, see Using the Archive Information System [page 738].

To display archived work items for an object, choose Tools → Business Workflow or Development → Workflow 
and then Administration → Workflow Runtime → Reorganization → Display Workflows from Archive. You can 
determine the archived workflows for a given object.

The display is in the form of a restricted workflow log, without detailed data.

Note on the archive information structure

SAP recommends that you use archive information structure SAP_O_2_WI_001. This is necessary if you are 
using ABAP classes or XML objects. If you are using only BOR objects, and are already using archive 
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information structure SAP_BO_2_WI_001, you can continue to use it, but we recommend that you switch to the 
extended archive information structure SAP_BO_2_WI_001.

To do this, proceed as follows:

1. In transaction SARI, activate archive information structure SAP_BO_2_WI_001.
As a result, both archive information structures are available at the same time.

2. Fill the new structure for the available archive files in the Status Management of transaction SARI.
3. In transaction SARI, deactivate archive information structure SAP_BO_2_WI_001.
4. In Customizing of transaction SARI, delete the archive information structure SAP_BO_2_WI_001.

Integration

Specify technical values for the archiving session, such as name, path and maximum archive file size, as well as 
the settings for the delete program, in Customizing [page 698].

 

21.1.9.3  Archiving IDocs

Use

IDocs are stored in several database tables. To keep these tables (and the access times) small (to reduce the 
database load) without losing any IDocs, you can archive the IDocs at the operating system level. These 
archives can then be moved to external storage media, such as disks (using ArchiveLink) or magnetic tape.

Prerequisites

In Customizing, you specify where the archive files are located physically (that is, which storage media are 
used). For more information, see Cross-Application Components (CA) -> Archiving Application Data -> 
Introduction to Data Archiving -> Customizing [page 698].

Activities

● Displaying or changing the archivable status [page 805]
When can I archive IDocs?

● Archiving functions for IDocs [page 806]
How are IDocs written to and read from archive files?

804 C U S T O M E R
SAP Oil & Gas (PRA - Production and Revenue Accounting)

PRA Archiving 



Caution
Make sure that you do not archive IDocs that may still be needed by the application.

● Deleting Links with IDocs [page 814]
When do I delete IDoc links (for example, with application documents?

● Archiving: Technical Realization [page 809]
How does archiving work from a technical perspective?

More Information

●
General archiving information

21.1.9.3.1  Displaying or Changing the Archivable Status

Context

Certain IDoc statuses are classified as archivable in the standard system, whilst others are not. You can display 
or change this classification.

Note
The current status of an IDoc must be archivable before the IDoc can be archived.

Procedure

1. Choose the ALE Customizing transaction SALE Set Up System Monitoring IDoc Status Display Edit 
IDoc Status Values (WE47) .

2. To change entries, choose  .

3. Select the required status. By double-clicking you can call a detail screen, in which you can display or 
change the archivability.

4. By using  or  you can display or change all statuses one after another.
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21.1.9.3.2  Archiving Functions for IDocs

Use

Data is usually archived via the central transaction SARA. In the case of IDocs, the corresponding tables are 
addressed via the archiving object IDOC.

Integration

Various processing methods are assigned to the IDOC archiving class: In the standard system, therefore, 
IDocs can be:

● Archived [page 807]
● Deleted from the database [page 807]

● Reloaded from an archive [page 730]: On the initial screen, choose Goto Reload

Example
All of the IDocs generated by sales orders (message type ORDERS, IDoc inbound processing) in the 
month of January are to be archived and subsequently deleted from the database tables. To do this, 
choose the "Archive" processing method in the standard system and enter a time period and message 
type as report variants.

In addition, you can display the following:

● Archive [page 675]
Several IDocs are usually archived in one archive or archiving session, that is, the IDocs are grouped 
together in one session. An archiving session is complete when the IDocs have been deleted from the 
database tables and exist only as archive files.

● The IDoc numbers of one or several archives or archive files [page 808]
● The IDocs (that is, control record, data- and status records) of one or several archives
● IDocs from archives, that contain certain character strings (IDoc search) [page 808]

This function is not a method of the IDOC archiving object, but rather an IDoc interface monitoring tool and 
hence only available from the initial node.

Activities

You can also access the central transaction SARA by choosing Tools Administration Administration
Data Archiving . Here you enter the archiving object IDOC. When you select 'enter' the methods entered above 
are displayed for selection.

In object-specific Customizing [page 703], you can define the maximum size of the archive files [page 704] and 
that the table entries are to be be deleted from the database immediately after the archive files have been 
generated. With large datasets this can improve the performance.
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In the standard system, the IDocs are selected for archiving according to certain criteria, for example the time 
at which the IDocs were last changed (new status record). You can also define your own selection criteria. For 
more information, see subsection Archiving:Technical Implementation [page 809]

21.1.9.3.2.1  Archiving and Deleting IDocs

Prerequisites

The IDocs to be archived have an archivable status [page 805].

Procedure

1. Go to the central archiving transaction with SAP Menu Administration System Administration
Administration Data Archiving (transaction code SARA) . If necessary, check the object-specific 
Customizing [page 703]:
Here, for example, you can set the indicator "detailed statement" in the variant to the deletion program: If 
required, this can be entered in the archiving log of each individual IDoc which is archived. However, this 
can lead to very large logs which do not necessarily contain useful information.

2. Enter the archiving object IDOC and choose the required action, here .
A warning will be displayed if some of the archiving sessions for the archiving object IDoc are still 
incomplete. You can ignore the warning but you then run the risk of possibly archiving some IDocs twice.

3. Define the  start date of the archiving session and the  spool parameters (print output).
The traffic lights should now be green, indicating that these parameters have been maintained. Please note 
that you can set the archiving mode for the print output to Store Only and therefore avoid printing every 
individual archiving log. Enter the object type IDOC as the attachment parameter and use the F4 Help to 
select a suitable document type for the object type. Also enter a free text as additional information for the 
archiving report.

4. Choose  to create a report variant. As selection parameters, enter the message type and a time period 
within which the IDocs received their last, current status.

Note
You can specify whether you want to perform this variant as a Test run or Production run, in the Process 
Flow segment on the selection parameter screen. If you choose Test, you get statistics of the processed 
IDocs. For a detailed log, select Detailed Log.

Choose  and save your variant.

5. Return to the archiving screen and choose  .
If you selected immediately as the start date in step 3, the message New archiving job was generated is 
displayed in the message bar at the bottom of the screen.

6. You can check whether your archiving session is complete by selecting Job overview. If you choose 
Administration, an overview of the completed and incomplete archiving runs is then displayed. If IDocs 
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which match your selection parameters were found in the database tables, your archiving session is 
displayed as a folder full of archive files.

7. If not defined differently in object-specific Customizing [page 705], your IDocs are still located in the 
database after archiving, that is, your archiving session is incomplete. To delete the IDocs, you must 
schedule a deletion job with the appropriate variant. Choose the archive file from which the IDocs are to be 
deleted from the database.

21.1.9.3.2.2  Listing IDoc Numbers in Archive

Procedure

● 1. Choose Evaluate in the initial screen of the central archiving transaction.
2. Choose Execute.

The system displays the complete archiving sessions.
3. Select one or several sessions or files contained within and confirm your selection.

A list of IDocs from the archive files selected is displayed. As well as the IDoc number, the "logical" 
message, for example, is output (output fields of report RSXARCR [page 812]).

21.1.9.3.2.3  IDoc Search

Use

Users should be able to find IDocs not only by means of the address information or control information in the 
control record but also according to the business data they contain. Questions like the following example 
should also be able to be answered: "Which IDocs contain purchase orders for my material XY?"

The IDoc search function can be used to answer such questions. You can search for IDocs both in the database 
and in archive files.

Features

The function searches for character strings, that is, you must enter the value of a segment field as it appears in 
the field itself (avoiding full stops and commas whenever possible).

You can enter a maximum of two values in two segment fields as selection criteria. If two values are entered, 
both must be present in the IDoc in the corresponding segment fields for the IDoc to be included in the list of 
results (normal AND link in selection fields).
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You can also choose to only give the value instead of the segment field. This means that all data records (more 
precisely: the field SDATA in the data records) are searched for in a non-structured manner in the character 
string, that is to say, the character string which is found may span several segment fields.

If you select Quick Search mode, the search can be limited to a maximum of one hit in each IDoc, that is, the 
system terminates the search in the current IDoc after one hit.

The search can and should also be restricted by entering additional search criteria which require values from 
the control record (in the same way as the other monitoring programs): creation time, partner and message, 
direction, and so on.

Activities

1. Choose transaction WE09 ( SAP Menu Tools IDoc Interface/ALE Administration Services IDoc 
Search by Contents WE09 ).

2. Choose the Data Source button to specify whether you want to search for IDocs from the database or the 
archive (or both) .

3. If you have set the Archive flag, you can select files using the archive information system or manually.

Note
To be able to search in the archive information system, you must have

○ Deleted the IDocs from the database (complete archiving session)
○ Created an archive info structure in the central transaction SARA

4. Specify all available selection parameters, to restrict the IDoc search as far as possible.

21.1.9.3.3  Archiving: Technical Implementation

Use

The IDoc archiving tools were developed with the Archive Development Kit [page 665] ( ADK), which supports 
object-oriented programming methods. This has led to the use of archiving object IDOC, which contains the 
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necessary database tables [page 813] and the archiving class IDOC, which has the function modules required 
for processing.

The archiving object IDOC is accessed "from outside" using reports which (indirectly) call the ADK function 
modules. The selection parameters for these reports are configured in the variant maintenance function for the 
central archiving transaction. The ADK function modules, in turn, use the function modules from archiving 
class IDOC to access the database tables. The figure below illustrates this object-oriented structure.
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All the function modules in the archiving class IDOC belong to the function group EDIA. This function group 
also includes the function modules which the archiving programs use to call the ADK functions.
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Caution
In computer literature, data and the corresponding functions are sometimes combined in classes (for 
example, in C++). As you can see, the term "class", as used here, refers to the "archiving object" which 
contains the data (the lines in the database table), as well as the "archiving class" IDOC, which contains the 
corresponding functions.

The reports supplied with the standard system can be used as sample reports to write your own reports with 
selection parameters which meet your requirements. For more information about standard reports, see 
Archiving: Descriptions of Standard Reports [page 812].

21.1.9.3.3.1  Authorizations for IDoc Archiving

Use

Note
You need only the general archiving authorization.

21.1.9.3.3.2  Archiving: Descriptions of Standard Reports

Use

The following section contains information about the initial reports and the function module which they call 
from the function group EDIA. This function module, in turn, calls the ADK standard class function modules. 
The reports are addressed by the central archiving transaction SARA.

In order to address programs through the central archiving transaction SARA, you must replace the standard 
reports with the programs in transaction AOBJ.

Table 205:

Name Description Selection Parameters

RSEXARCA Writes IDocs to the archive.

Calls EDI_ARCHIVE_IDOCS.

Uses the subroutine 
INITIALIZE_STATUS_QUALITY 
(function group EDIA) to check whether 
the IDocs can be archived.

● Time at which the control record 
was last changed

● Time of IDoc creation
● Current status
● Logical message
● Direction
● IDoc number
● Partner
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RSEXARCD Deletes archived IDocs from the data­
base.

Calls EDI_DELETE_ARCHIVED_IDOCS.

Archive files from incomplete archiving 
sessions

RSEXARCR Reads IDocs from an archive.

Calls EDI_READ_IDOC _ARCHIVE. Dis­
plays the following control record fields 
for each IDoc:

● Logical message
● Status
● Date and time at which the control 

record for the IDoc was last 
changed

● Direction
● IDoc number

Archive files from complete archiving 
sessions

RSEXARCL Retrieves IDocs from the archive into 
the database. Calls EDI_RELOAD_IDOC 
_ARCHIVE. Checks for client or IDoc 
number conflicts via IS_RELOAD­
ING_POSSIBLE (subroutine for func­
tion group EDIA). Writes the new status 
"35" for outbound IDocs, "71" for in­
bound IDocs ("reloaded"). "Detailed 
statement" indicator as for RSEXARCA.

Archive files from complete archiving 
sessions

RSEXARCI Creates index in table EDIDOCINDX. 
Calls ADK function module directly.

None: Reads the archive files of the 
IDOC object class.

RSEXARCJ Removes index in table EDIDOCINDX. 
Calls ADK function module directly.

Date up to which the indexes should be 
deleted.

Number of records after which a data­
base COMMIT should be transmitted.

21.1.9.3.3.3  Database Tables

Use

Definition
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The IDOC archiving object for archiving IDocs consists of the following IDoc database tables:

Table 206:

Table Description

EDIDC Contains the IDoc control record

EDID4 Contains the IDoc data records

EDIDS Contains the IDoc data records

21.1.9.3.4  Deleting Links with IDocs

Context

As the IDoc number increases, not only the data records table gets bigger. The tables which contain links with 
application documents, for example, also get bigger and from time to time should be emptied of obsolete 
entries.

Note
IDocs links are always archived with them.

Procedure

● 1. Start the program RSRLDREL.
2. Enter a suitable end date.

The end date is suitable if all links that were generated before are no longer needed. For example, if you 
have already archived and deleted [page 807] all IDocs before this date and the application documents 
are also archived, you no longer need the corresponding links (exception: Application documents and 
IDocs are to be retrieved from the archive into the SAP System).

3. Select Selection by link type and enter a link type. Also refer to the table below.
Alternatively, you can do the selection by object/role. If, for example, you want to delete all links with 
standard orders, then you should make your selections according to object type BUS2032 (standard 
order) in the function APPLOBJ.

Table 207:

If you want to delete the following links... Then select the link type...
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Application document with outbound IDoc IDC0

Inbound IDoc with application document IDC1

Outbound IDoc with application document in the target 
system

IDC9

Inbound IDoc with application document from the up­
stream system

IDCB

Inbound IDoc with communication IDocs in distributed 
systems

IDC2

Copy of an IDoc with its original IDC3 (inbound), IDC7 (outbound)

Inbound IDoc with outbound IDoc from the upstream 
system

IDC4

IDoc with TID ( , ALE audit). Does not work with deletion 
criterion. Both objects not available.

IDC8 (inbound), IDCA (outbound)

Outbound IDoc with reference IDoc (type IDCREF01) IDRF

○ You want to delete links last. Choose Both objects not available. If now, for example, only the 
application document is available, you can actually display the numbers of the linked IDocs from 
the document, but no longer the IDocs themselves.

Note
This option does not work for links with TIDs (for ALE audit) although they appear to be there.

○ You want to delete the links if at least one of the two objects is no longer there (option One object 
not available). Then, for example, you can no longer display the numbers of IDocs that have already 
been deleted from an application document.

○ You generally want to delete all links that meet the other selection criteria. Select Without 
existence check.
You can perform a test run. Then the system only notifies you of the number of links that meet the 
selection criteria, but does not delete them.

21.1.9.3.5  Data Aging for IDocs

The data aging object BC_IDOC supports data aging (see also ).
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Use

IDocs are stored on the database in the tables EDIDC (control records), EDID4 (data records), and EDIDS 
(status records). To relieve the working memory, IDocs can be moved from the HOT area to the COLD area 
depending on their status and time. This procedure is called Data Aging for IDocs. The moved IDocs are still 
visible in the system, they can be deleted or archived but can no longer be changed or processed. The aging 
object BC_IDOC contains the tables EDID4 (data records) and EDIDS (status records).

Prerequisites

Your database must support data aging. Note the following in particular:

●

Activities

1. Determining the Status
IDocs that are in a currently archivable status can be moved to the COLD area. You should check your 
IDocs for this (Displaying or Changing the Archivable Status [page 805]). IDocs that can still be processed 
are excluded from data aging. This affects the following IDoc status values:
○ 64 IDoc is ready to be transferred to the application
○ 66 IDoc waiting for predecessor IDoc (serialization)
○ 51 Application documentation not posted
○ 75 IDoc is in the inbound queue
○ 69 IDoc was edited

2. Maintaining the Residence Times
Only IDocs that were not changed or edited in the last 14 days are taken into consideration for data aging 
when using standard settings. If, however, you want to use longer or shorter times, for example, for specific 
message types or partners, use transaction Residence Times for Message Types or Partners 
(WEIDOCDAAG).
You can store different times for the following key fields:
○ Message type
○ IDoc Type
○ Enhancement
○ Sender or receiver report
○ Partner type
○ Partner number
○ Direction (inbound or outbound)

A more specific entry overwrites a less specific entry.
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Example

Table 208:

Table Field Example 1 Example 2

Message type ORDERS ORDERS

IDoc Type ORDERS04

Enhancement

Partner port MYREMOTE

Partner type

Partner number

Direction

Residence time 3 12

The example above shows the following case:

IDocs with the message type ORDERS should be taken into consideration for a data aging run after just 3 
days (Example 1). In contrast to this rule, IDocs of partner port MYREMOTE (sent as ORDERS04) are left in the 
HOT area for 12 days (Example 2).

21.1.9.4   Archiving Table Change Logs (BC-DWB-CUS)

 

Definition

The archiving object BC_DBLOGS is used for archiving Customizing table change logs. The SAP system logs 
Customizing table changes if:

1. The Log Data Changes checkbox has been selected in the technical settings for the table.
2. Logging is active.

Note
Logging can be activated and deactivated for a particular client using the profile parameter rec/client.

Use

We recommend that you archive the change logs periodically, for example, quarterly or annually.

Structure

The logs are saved in the table DBTABLOG. The archiving object archives this table only.

The following functions are available for BC_DBLOGS:

Function/Program Assignment
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Table 209:

Function Program

Write BC_DBLOGS_WRI

Delete RSLDARCH02
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Read ● RSLDARCH03 (for the entire archiving session)
● BC_DBLOGS_READ_AR_BY_INDEX

Caution
Archiving automatically generates a comment in the 
archiving session management entry. This comment 
contains the time period that was archived. Do not 
delete this text.

Read

For a read by program RSLDARCH03, the archive contents 
are output in the form of a print list. You can evaluate and 
print the table logs using the (transaction SCU3).

For a read by program BC_DBLOGS_READ_AR_BY_INDEX, 
the results are output in the form of an ALV Grid. Under Ex­
tras, you can choose the data source from which the data is 
read. The options that are available depend on whether you 
call the program in archive management (transaction SARA) 
or in the ABAP Editor (transaction SE38). Using the ABAP 
Editor, you can specify whether the data is read from the da­
tabase or from the archive. If you choose to access the ar­
chive, then you can either select the archived data manually, 
or you can read the data from the Archive Information Sys­
tem based on an index. The prerequisite for reading the data 
from the Archive Information System is that you have acti­
vated the info structure SAP_BC_DBLOGS in transaction 
SARI. This info structure is filled automatically after each ar­
chiving run. However, you can also generate it explicitly in 
transaction SARI.

Integration

This archiving object does not depend on any other archiv­
ing objects.

Log entries are archived independently of the client.

You can use the archiving object BC_DBLOGS within the 
framework of Information Lifecycle Management. To be able 
to do this, you must activate the related business functions. 
The system then shows the ILM Actions group box. Using 
these actions, you can, for example, run archiving during 
which the system evaluates the retention periods entered in 
Information Retention Manager. You can also create snap­
shots (copies) of data, and you can delete data that does not 
meet your criteria.
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21.1.9.4.1  Technical Data (BC-BEW-CTL)

Technical Data (BC-BEW-CTL)

An internal run-time analysis run in a highly-loaded development system showed that ca 100.000 log entries 
are archived in an hour.

 

 

21.1.9.4.2   Variant Settings for Archiving (BC-DWB-CUS)

Use

Archiving checklist [page 721]

Features

In the change logs, you specify which time interval is archived. You must specify the date and time of the 
beginning and end of the time interval.

The system shows the ILM Actions group box if you are using the archiving object in Information Lifecycle 
Management and have fulfilled the prerequisites for this (for example, you have activated the corresponding 
business functions). You can use these actions to archive data during which, for example, the retention periods 
entered in the Information Retention Manager can be evaluated. Additionally, you can create snapshots 
(copies) of data or destroy data that matches the requirements.

Under Log Settings you can specify the type of log (a complete detailed log or a partial log) and the type of log 
output. You can also enter a comment for the archiving session. For more information, see Logs [page 692].

 

 

21.1.9.4.3  Archiving Object-Specific Customizing (BC-DWB-
CUS)

Archiving Object-Specific Customizing (BC-DWB-CUS)
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Use

Archiving Object-Specific Customizing [page 703]

Activities

A data object is defined as 1.000 table entries for the object BC_DBLOGS for the input field Maximum no. of 
data objects in the group box Archive file size.

By contrast, the Commit counter in the group box Deletion program settings refers to table entries not data 
objects.

 

 

21.1.9.5  Archiving Link Entries (BC-SRV-ARL)

Archiving Link Entries (BC-SRV-ARL)

Definition

The archiving object ARCHIVELNK is used to archive ArchiveLink link entries.

Use

A link entry is a unique reference from a document stored in an external storage system (using ArchiveLink) to 
a business object generated in the SAP application component.

To create the link between the business objects in the SAP application and the documents in the external 
storage system, you must carry out the following administrative tasks in the SAP System:

● Definition of document types
● Definition of storage systems
● Assignment of document types and object types to storage systems and link tables

The business object is assigned to the corresponding stored document in the link table in the database.

You can specify an expiry date for each link entry. When the expiry date is reached, you can archive the link 
entry/entries and delete them from the database using the ADK archiving transaction.

Structure

When you implement the archiving object ARCHIVELNK , data from the various ArchiveLink link tables is 
archived. For information on table names and the number and names of link entries, choose Tools → Business 
Documents, → Miscellaneous → Stored Documents → Stored documents → Expiry date → Display or Analyze.

The following functions are available for ARCHIVELNK :

Table 210:

Action Report

Archive OAARCH04
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Delete OAARCH06

Reading OAARCH05

To call the transaction for archiving link entries, choose Tools → Administration → Administration → Archiving .

21.1.9.5.1   Application Customizing (BC-SRV-ARL)

Use

As well as basic Customizing for archiving, you must make settings in ArchiveLink basic Customizing for the 
generation of link entries:

● Maintain document types and classes
● Maintain storage systems
● Maintain links and link tables

You must also define retention times for the link entries.

Features

ArchiveLink Basic Customizing

For information about ArchiveLink Customizing, see . You can also find the IMG activities for ArchiveLink in the 
Implementation Guide (IMG), under SAP Web Application Server → Basis Services → ArchiveLink → Basic 
Customizing.

Retention Times for Link Entries

You should maintain retention times when you maintain the links. The retention period is the number of months 
after which a link entry for a stored document can be removed from the link table.

Activities

For more information on setting or changing the retention period, see Setting Retention Periods (BC-SRV-ARL) 
[page 823].
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21.1.9.5.1.1  Setting Retention Periods (BC-SRV-ARL)

Setting Retention Periods (BC-SRV-ARL)

1. Choose Links, and enter the required retention period in months in the field Retention period.
2. Choose Tools → Business Documents → Miscellaneous → Stored Documents → Stored documents → Expiry 

date → Change
3. Enter the required business object.
4. Enter the corresponding document type.
5. Specify whether or not it is a test run.
6. If it is a test run, a list of all the link entries with the newly calculated expiry date is displayed.

To change the expiry date, you need administration authorization for ArchiveLink (see ).
7. Choose Program → Execute.

A message confirming that the deletion date has been re-calculated is displayed.

21.1.9.6   Archiving Archive Administration Data (BC-CCM-
ADK)

Definition

You can use archiving object BC_ARCHIVE to archive and delete archive administration data.

Use

You can use this archiving object to store information about archiving sessions that were selected for archiving 
in the management of archiving objects.

Structure

Tables

The archiving object BC_ARCHIVE consists of the following tables, from which data is archived and deleted 
(valid for both ADK and XML archiving objects):

Table 211:

Table Description

ADMI_RUN Header data for archiving sessions

ADMI_FILES Archive files for archiving sessions
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Table Description

ADMI_VARIA Content of archiving program variant

ADMI_SKIP Address of data objects that should be skipped

<Info-Tab> Archive file info table for an archiving object

ADMI_XRUN Archive files for archiving sessions of XML archiving objects

ADMI_XDOCS Resources (XML Archiving)

In addition, the archiving object uses the archiving class TEXT, which covers the following tables:

Table 212:

Table Table name

STXB SAPscript: Texts in non-SAPscript format 

STXH STXD SAPscript text-file header 

STXL STXD SAPscript text-file lines

Programs

BC_ARCHIVEis shipped with the following programs:

Table 213:

Program Function

BC_ARCHIVE_PRE Preprocessing

RSAADMAR Write

RSAADMLO Delete

RSAADMRL Reload

 

See also:

Archive Administration Data (BC-CCM-ADK) [page 828]

Reloading Data [page 730]

 

 

 

 

 

 

824 C U S T O M E R
SAP Oil & Gas (PRA - Production and Revenue Accounting)

PRA Archiving 



21.1.9.6.1   Variant Settings for Preprocessing (BC-CCM-ADK)

Use

You can use this program to set the To Be Archived indicator for several archiving sessions through mass 
processing. The program can process archiving sessions for ADK and XML archiving objects.

Features

Selection Criteria

Under Archiving Sessions you can restrict the sessions to be marked using the following criteria:

● Archiving Session
Number of the archiving session

● Archiving Object
Archiving object to which the session belongs

Further Selection Criteria

Under Further Selection Criteria you can use additional criteria to further restrict your selection:

● Date of Archiving Session
Creation date of the archiving session

● Started by
User that started the archiving session

Additional Selection Criteria for ADK Archiving Objects

For ADK archiving objects you can enter the following additional selection criteria:

● Stored in Archive System
Of the selected sessions, the program only marks those sessions for archiving, for which all archive files 
have been stored in the storage system.

● Sessions without Accessible Files
Of the selected sessions the program only marks those sessions for archiving for which no archive files are 
accessible in the file system and for which no archive file has been stored in the storage system.

Additional Selection Criteria for XML Archiving Objects

For XML archiving objects you can enter the following additional selection criteria:

● Sessions without Accessible Resources
Of the selected sessions the program only marks those sessions for archiving for which no accessible 
resources exist.

Additional Settings

The Processing Control, Log Options, and Archiving Session Note settings are standard settings that also apply 
to archiving objects. For more information see the general archiving documentation under Variant Maintenance 
for Archiving Jobs [page 733].
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See also:

Archiving Archive Administration Data (BC-CCM-ADK) [page 828]

 

 

 

21.1.9.6.2   Variant Settings for Writing (BC-CCM-ADK)

Use

When you schedule the write program you must enter an already existing variant or create a new one. The 
variant contains selection criteria for the administration data that you want to archive.

Features

Further Selection Criteria

Here you can enter criteria to select the data to be archived. The selection can take place using the client and 
the archiving object.

Additional Settings

The processing options, the log options, and the archiving session note are standard settings that also apply to 
other archiving objects. For more information see the general archiving documentation under Variant 
Maintenance for Archiving Jobs [page 733].

See also:

Archiving Archive Administration Data (BC-CCM-ADK) [page 828]
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21.1.9.6.3   Variant Settings for Reloading (BC-CCM-ADK)

Use

You can use this function to reload archive administration data that was archived using archiving object 
BC_ARCHIVE back to the database.

Prerequisites

Archiving sessions must exist for which the delete program ran in production mode.

Features

Further Selection Criteria

Here you can select the data to be reloaded. You can make your selection based on Client or Archiving Object.

Additional Settings

The Processing Options, the Log Options, and the Log Output option are standard settings that are also valid 
for other archiving objects. For more information see the general documentation under Variant Maintenance 
for Archiving Jobs [page 733].

Activities

After you have reloaded the data, the system removes the To Be Archived indicator, so that the reloaded 
information is displayed directly in Archive Administration (Archive Administration, Management Action). The 
system does not create a new archiving session during reloading. Instead, the archiving session for which the 
data was reloaded remains in Archive Administration under Completed Archiving Sessions and can still be 
evaluated there.

After reloading has been completed, the system issues a list of reloaded administration data.

See also:

Archiving Archive Administration Data (BC-CCM-ADK) [page 828]

Reloading Data [page 730]
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21.1.9.6.4   Archive Administration Data (BC-CCM-ADK)

Setting the To Be ArchivedIndicator

Before you can archive the administration data of archiving sessions, you must indicate that these sessions are 
ready to be archived. You have two options for setting this indicator:

● manually (for individual sessions)
● automatically (for several sessions; mass processing)

Setting the To Be Archived Indicator Manually

1. Call Archive Administration (transaction SARA) and enter the archiving object for which you want to 
archive administration data.

2. Choose Management to display the relevant administration data.
3. Double click the desired archiving session and in the dialog box that appears choose the change mode.
4. Choose the To Be Archived indicator. Sessions for which you set the indicator in this manner appear 

subsequently as Archiving Sessions Marked for Deletion in Archive Administration.

Setting the To Be Archived Indicator Automatically

If you want to archive the administration data of several archiving sessions, it is recommended that you set the 
To Be Archived indicator automatically through the preprocessing program. The program can process archiving 
sessions of ADK and XML archiving objects. You can select the archiving sessions to be archived in the 
selection screen of the preprocessing program, see Variant Settings for Preprocessing (BC-CCM-ADK) [page 
825].

Archiving the Administration Data

In Archive Administration enter the archiving object BC_ARCHIVE and schedule archiving as usual.

Caution
You can only archive administration data if no further jobs exist for the selected sessions. This means that 
there may not be any entries left in the job overview of the archiving object.

Result

The archiving session you started writes the selected session information to one archive and deletes it from the 
database (whether or not the data is deleted depends on the Customizing settings for the automatic start of 
the delete program, and the variant you chose). The new archiving session then appears in the archive 
administration data of BC_ARCHIVE.
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21.1.9.7  Archiving Change Documents (BC-SRV-ASF-CHD)

Background

Application programs write change documents for statutory or technical reasons. They must sometimes be 
retained for a long time. Documents which no longer require direct access can be archived, to reduce the 
database load. They are then saved in these archives for the statutory or technically-required period.

Technical Implementation

The archiving tools for change documents were developed with the Archive Development Kit [page 659] (ADK), 
which supports object-oriented programming methods. This refers to the archiving object CHANGEDOCU that 
contains the required database tables and the archiving class CHANGEDOCU with the function modules to 
process them. If you want to access the archiving object CHANGEDOCU, you have to use a report. All of the 
function modules in the CHANGEDOCU archiving class belong to the SCD5 function group. This function group 
also includes the function modules which the archiving programs use to call the ADK functions.

Database tables

The CHANGEDOCU archiving object for archiving change documents contains the following database tables:

Table 214:

Table Description

CDKEYTAB Virtual table with the object key (only in archive, not in data­
base)

CDHDR Change document header in the database

CDPOS Change document items in the database

CDPOS_UID Change document item key per table, if it is > 70 characters. 
CDPOS-TBAKEY contains the UID for this entry.

CDPOS_STR The change document item for STRING fields in CDPOS-
TBAKEY then contains the UID for this entry.

Authorizations

If you want to archive, you need authorization for:
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● Archiving in general

For more information, see User Authorization Checks [page 666]

Integration

You can display archived change documents with the Archive Explorer (transaction SARE).

To display each table in archiving object CHANGEDOCU using the Archive Information System [page 737], you 
need an information structure based on the standard field catalog SAP_CHANGEDOCU1 delivered by SAP. The 
information structure must be set up and active.

For more information about information structures, see also Using the Archive Information System [page 738].

21.1.9.7.1   Variant Settings for Writing (BC-SRV-ASF-CHD)

Use

When you schedule the write program you must enter an already existing variant or create a new one. The 
variant contains selection criteria for the change documents that you want to archive.

Features

Selecting Documents

In the Change Documents frame, you can select the documents you want to archive based on the following 
criteria:

● Change doc. Object
Name of the change document whose entries are to be archived, such as ADRESSE

● Object value
Value assigned to the change document object, such as BC010000002852

Further Selection Criteria

Here you can further restrict the set of documents to be archived:

● From Date
Date as of which the change was executed

● To Date
Date up to which the change was executed

● From Time
Time as of which the change was executed

● To Time
Time until the change was executed
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● Transaction code
Name of the transaction in which the change took place

● Changed by (User Name)
Name of the user, who made the changes

Additional Settings

The processing options, the log options, and the archiving session note are standard settings that also apply to 
other archiving objects. For more information see the general archiving documentation under Variant 
Maintenance for Archiving Jobs [page 733].

See also:

Creating Archive Files [page 723]

 

 

21.1.9.7.2  Descriptions of Standard Reports

Use

This is an overview of the archiving programs to write, read, delete and reload change document data.

Caution
These programs only archive the change document data. Connections to master data arh lost.

If you want to archive the change document data with its master data, the developers of these archiving objects 
must put the archiving class CHANGEDOCU in their archiving object.

Table 215:

CHANGEDOCU_WRI Change documents: Write program

CHANGEDOCU_DEL Change documents: Deletion program

CHANGEDOCU_READ Read selected change documents from the database or 
from the archive

CHANGEDOCU_REL Change documents: Reload program

RSSCD7AR Change documents - Write program

CHANGEDOCU_WRI

The data for the archive object CHANGEDOCU is written from the database into the archive.

You can specify the following selection parameters:

● Change document object
(CDHDR-OBJECTCLAS e.g. MATERIAL)
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● Object value
CDHDR- OBJECTID e.g. 000000000000004711)

● From Date
● To Date
● From Time (HH:MM:SS)
● From Time (HH:MM:SS)
● Transaction Code
● User name of changer

In the flow control, choose:

● Test mode
(No archiving - only simulation and output of the statistics)

● Production Mode
(actual archiving)

In the detail log, you can choose:

● No detail log
● No success messages
● Complete

In the log output, you can choose:

● List
● Application log
● List and application log

You can enter a name for this archiving session, in the archiving session notes.

CHANGEDOCU_DEL

Deletes the change documents from the tables CDHDR, CDPOS, CDPOS_UID (from SAP Basis Release 6.20), 
CDPOS_STR (from SAP Basis Release 7.0), which were archived in a selected archive.

Flow Control:

● Test mode
(no deletion from DB - simulation and output of statistics)

● Production Mode
(Delete from DB)

CHANGEDOCU_READ

Displays the change documents from the tables CDHDR, CDPOS, CDPOS_UID (from SAP Basis Release 6.10), 
CDPOS_STR (from SAP Basis Release 7.0), which were archived in a selected archive, or saved in the database.

There are two ways to selecta a data source:

● Database
● Archive

Selection of archived change documents:

● Change document object
(CDHDR-OBJECTCLAS e.g. MATERIAL)

● Object value
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(CDHDR- OBJECTID e.g. 000000000000004712)
● Transaction Code
● User name of changer

Time restriction:

● From Date
● To Date
● From Time (HH:MM:SS)
● From Time (HH:MM:SS)

Changed document caused by:

● User
● Transaction Code

CHANGEDOCU_REL

Reads the archived data in selected archives and writes it (fills the chabge document data) in the database 
tables CDHDR, CDPOS, CDPOS_UID, CDPOS_STR. Duplicate entries are prevented.

You select the archives from among those offered. (Your archiving session names are useful here).

21.1.9.8  Archiving Long Text Logs (BC-SRV-ASF-AT)

Definition

Archiving of logged long texts with the archiving object S_AUT_LTXT.

Note
The archiving object LO_CHVW has been revised within the framework of a project to standardize and 
optimize data archiving. You can use the standardized archiving object by activating the business function 
Data Archiving: Standardization of Archiving Objects (DA_ARCHOBJ_STANDARD_1). For more information 
see Data Archiving: Standardization of Archiving Objects or refer to the business function documentation in 
the Switch Framework (transaction SFW5).

Use

A complete archiving cycle has the following 3 main steps:

● Executing the preprocessing program:
The data to be archived is prepared for the write program.

● Generating the archive files:
With the help of the write program, the long texts to be archived are sequentially written to newly 
generated archive files. Note that archiving is client-dependent.
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● Executing the deletion program:
Once the long texts to be archived have been completely written to the archive files, the deletion program 
removes them from the database. For security reasons, the system first reads the archived data, and does 
not start the deletion run until this read operation has been completed successfully.

Recommendation
SAP recommends that you perform the Delete Long Text Logs function (program S_AUT_DEL) prior to the 
start of archiving. As a result, you ensure that irrelevant data records are not archived.

You should reload archived data into the database only in exceptional circumstances. For example, it may be 
necessary to reload data if you discovered immediately after archiving that too much or the wrong data was 
archived. This data should be reloaded as soon as possible after archiving has been carried out.

Caution
After a release upgrade or code page switch, a reload of archived long texts may lead to a loss of data, and 
therefore must not be carried out.

The reload program cannot be started if data of a non-archived preprocessing program exists. If necessary, 
discard this data using the program S_AUT_ARCH_UNDO.

When you reload archived data, note that active info structures for the reloaded archive files must be manually 
deconstructed (transaction SARI Status ).

The archiving programs use the Codepage information to format the data. A different data conversion may be 
required depending on the current code page at the time of long text logging.

Caution
If you changed the code page of the systems (for example as a result of an upgrade from SAP R/3 4.6C to 
SAP ERP including a switchover to a two-byte Unicode code page), you have to record in the system the time 
at which this code page switch took place. Specifying the wrong code page may result in loss of data.

You record the change in the code page in Customizing under SAP NetWeaver Application Server System 
Administration Evaluation of Table Changes Document Code Page Migrations .

Structure

The archiving object S_AUT_LTXT archives the following tables:

● AUT_D_STXH_ARCH
● AUT_D_STXL_ARCH
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The following programs are available for the archiving object:

Table 216:

Function Program:

Preprocessing S_AUT_ARCH_PRE

Write S_AUT_ARCH_WRI

Delete S_AUT_ARCH_DEL

Reload (to be run in exceptional cases only) S_AUT_ARCH_REL

21.1.9.8.1  Variant Settings for the Preprocessing Program 
(BC-SRV-ASF-AT)

Use

The preprocessing program prepares the long text data for the write program, in order to save time during the 
writing of the archive files.

Features

On the selection screen of the preprocessing program, you can enter an end date for archiving in the Long Text 
Logs area. All the long texts that were created up to this date are prepared for archiving.

Caution
This date must be in the past. In addition, it cannot fall in a period for which long texts were already archived.

You can enter a package size in the Options area. This defines the intervals (measured in number of long texts) 
in which changed data is permanently stored on the database. If the packet size is too high, the program may 
terminate. The optimal value depends on the configuration of your database system. The default value in the 
system is 1000.

Information on the other general selection options is available under Variant Maintenance for Archiving Jobs 
[page 733].

If data exists that resulted from a previous preprocessing program, but was not archived, the preprocessing 
program cannot be restarted. A restart of the preprocessing program is only possible once this data has been 
removed from the system. This can be done either by ending the archiving cycle that was started (write 
program and deletion program), or by discarding the data of the preprocessing program using program 
S_AUT_ARCH_UNDO.
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21.1.9.8.2  Variant Settings for the Write Program (BC-SRV-
ASF-AT)

Use

The write program writes the long texts to archive files.

Prerequisites

It is essential that the preprocessing program has been completely finished before the write program is run.

Features

On the selection screen of the write program, you can choose between test and production mode in the 
Processing Options area.

If the write program of the archiving object is executed in test mode, the system only simulates the archiving in 
accordance with the selection criteria you entered. An archive file is not created. You receive statistics on the 
table entries that would have been written to the archive in production mode, as well as the size and number of 
archive files that would have been created.

In production mode of the write program for the archiving object, the system creates archive files in 
accordance with your selection criteria. You receive statistics on the table entries that were written to the 
archive, as well as the size and number of archive files that were created.

In addition, you can enter a comment on the archiving run, which for example contains information about the 
archived periods. This comment appears at the following points:

● In the overview of archiving runs in archive administration (transaction SARA). It can also be changed here.
● During manual selection of archive files (e.g. evaluation programs). Here it facilitates selection of the 

archive files.

If you are using the archiving object within the framework of Information Lifecycle Management and the 
prerequisites for this are satisfied (such as activation of the associated business functions), the ILM Actions 
frame is also shown. With the aid of these actions, you can carry out an archiving in which the retention periods 
defined in the Information Retention Manager are evaluated. Furthermore, you can make snapshots (copies) of 
data or destroy data that satisfies the appropriate criteria.

More Information

Variant Maintenance for Archiving Jobs [page 733]
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21.1.9.8.3  Variant Settings for the Deletion Program (BC-
SRV-ASF-AT)

Use

Once the data objects have been written to the archive files, they are deleted from the database.

Features

It is essential that the write program has been completely finished before the deletion program is run. Here, you 
can schedule the deletion program per archive file. You can do this manually or automatically. While the write 
program is running, you are not able to start the deletion program.

Note
In the Implementation Guide, you can enter specifications regarding the running of the deletion program for 
the archiving object under SAP NetWeaver Application Server System Administration Data Archiving
Archiving-Object-Specific Customizing .

As in the write program, on the selection screen of the deletion program, you can choose between test and 
production mode in the Processing Options area.

If you execute the deletion program of the archiving object in test mode, data is not deleted from the database; 
the deletion is only simulated. You receive statistics on the table entries that would have been deleted from the 
database in production mode.

If you execute the deletion program of the archiving object in production mode, the archived data is deleted 
from the database. You receive statistics about the deleted table entries.

21.1.9.8.4  Tracking Details for Archiving

Use

If you want to track details of the archiving, you can use the transaction S_AUT10 in enhancement mode to 
carry out an evaluation of the logs of the table AUT_D_ARCH_HIST.

Prerequisites

In the standard system, logging is not active for AUT_D_ARCH_HIST. If you want to use this function, you must 
use the transaction S_AUT01 to activate table logging for the table AUT_D_ARCH_HIST.
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Features

In the evaluation of the table logs, you get the following detailed information:

● Selection data of the preprocessing program (what data was included in this run)
● Status of the archiving run: Empty (does not contain any data), Preprocessing Program Executed, Deletion 

Program Executed or Reload Program Executed
● Number of the archiving run in the Archive Development Kit (ADK)
● Date/Time/User who ran the preprocessing, write, or deletion program or the program 

S_AUT_ARCH_UNDO

21.1.9.8.5  Evaluating Archived Long Texts

Use

You can display the archived long texts using the Archive Explorer of the Archive Information System [page 
737]. You can also access archived texts directly from the transaction S_AUT10.

Prerequisites

For you to be able to carry out evaluation using the Archive Explorer, at least one archive info structure must be 
active and fully set up.

Features

Archive Explorer

SAP supplies the archive info structure SAP_S_AUT_LTXT as the minimum instance of an archive info 
structure. For the archiving object S_AUT_LTXT, the field catalog SAP_S_AUT_LTXT is available. On the basis of 
this, you can create your own info structures, if you want to select further fields.

If the archive info structure was not active at the time of archiving, you must set it up manually (in the 
transaction SARI under Status).

For the evaluation of referenced long texts, there must be no period for which data exists on the database that 
is followed by a period for which data is archived. The program determines the long text on the basis of the data 
in the archive. Under these conditions, it cannot be guaranteed that the displayed texts are correct. For 
example, the system could display a long text that resulted from a later change, because this is the next 
available change in the archive. Archive the reloaded period again, or take organizational measures to ensure 
that the reference target of a long text does not fall within the reloaded period.

Direct Access
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In enhancement mode of the transaction S_AUT10, under Long Text Logs you can directly access the archived 
long texts. To do so, specify that the system is to read from the archive when you choose the data source. You 
will find further information on the transaction S_AUT10 under .

21.2 PRA Archiving Features 

Use

Production and Revenue Accounting (PRA) Archiving provides archiving functionality for the following 
application components:

Table 217:

Production Valuation

Contractual Allocation Tax Reporting

Ownership Journal Entry

Prerequisites

The PRA Archiving functionality has been tested thoroughly with a large amount of data in one of your 
company’s test clients before being used in your company’s “live” SAP ERP System.

The number of days that the system retains Ownership transfer request objects for PRA Archiving is specified 
in Customizing under Industry Solution Oil & Gas (Production and Revenue Accounting) → Ownership → Owner 
Request → Owner Request Global Settings . The number of days should be greater than or equal to the spool 
retention period.

The maximum archive file size for each PRA Archiving object is specified in transaction AOBJ under 
Customizing Settings .

Activities

To access the Data Archiving transaction, from the SAP Easy Access menu, choose Tools → Administration → 
Administration → Data Archiving

Using the PRA archiving objects, either select Write to store data in archive files, or use Delete to delete data 
from the database completely. For more information about the options available for each PRA archiving object, 
see PRA Archiving Objects [page 840] .
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21.3 PRA Archiving Objects 

Definition

Provide a means for you to remove certain types of Production and Revenue Accounting (PRA) data from the 
database.

Use

Table 218:

Object Description(Techni­
cal Name)

Type of Data Processed Prerequisites Results - Notes

Production (OIUPR_VOL) ● Archiving of measure­
ment point volumes

● Archiving of measure­
ment document tables

● Deletion of well comple­
tion volume data

● Relevant delivery net­
work is allocated

● In PRA Contractual Allo­
cation (CA), the delivery 
network/sales date 
combination has a sta­
tus of either closed or 
archived , and in Valua­
tion, it is Posted 
completely .

The system changes the sta­
tus of the delivery network to 
Archived so that subsequent 
reallocations in CA and Valu­
ation are not carried out be­
fore running Production.

ContractualAlloca­
tion(OIURV_CA)

● Deletion of measure­
ment point and well 
completion volumes

● In PRA Balancing, bal­
ancing reports are final-
ized.

● In CA, the delivery net­
work/sales date combi­
nation has a status of ei­
ther closed or archived , 
and in Valuation, it is 
Posted completely .

The system changes the sta­
tus of the delivery network to 
Archived so that subsequent 
reallocations in CA and Valu­
ation are not carried out be­
fore running Production.

You can use the Read option 
to view data archived in CA at 
a later date as required.
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Object Description(Techni­
cal Name)

Type of Data Processed Prerequisites Results - Notes

Ownership(OIUOW_TRF) ● Archiving of ownership 
transfer documents

● The number of days that 
the system retains Own­
ership transfer docu­
ments for PRA is speci­
fied in Customizing un­

der Industry 
Solutions Oil & Gas 
(Production and 

Revenue Accounting)

Ownership Owner 

Request Owner 
Request Global 

Settings  .
● The number of days 

should be greater than 
or equal to the spool re­
tention period.

You can use the Read option 
to view data archived in Own­
ership at a later date as re­
quired.

Valuation(OIURV_VAL) ● Archiving of Combined 
Run data

● Valuation documents for 
the delivery network/ 
sales date/ frequency 
combination have been 
posted successfully and 
completely

You can use the Read option 
to view data pertaining to the 
Combined Run report at a 
later date as required.

Note: Valuation history infor­
mation that is required for re­
versals is available in RJE ta­
bles, and data from these ta­
bles will not be archived.

Tax Reporting(OIUTX_REP) ● Archiving of reporting 
history data

● Reporting is finalized for 
the month in which data 
is being archived

None.

Royalty Report­
ing(OIURY_REP)

Journal Entry(OIUH_JE_GL) ● Archiving of data from 
the Journal Entry inter­
face tables that is 
posted to the General 
Ledger (GL)

● Archiving of GL history 
data

● Offsetting entries are 
posted in GL and all re­
cords total to zero

None.

See also:

Data Archiving for Production and Revenue Accounting [page 839]
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22 PRA Data Management 

Purpose

The goal of PRA Data Management is to allow seamless access to PRA data, across more than one PRA 
installation (more than one PRA instance). Another goal is to increase performance by bringing data that is not 
immediately needed into secondary databases. The overall effect is greatly improved performance for your 
PRA system. This solves the problem of too rapid data growth.

Most customers can generalize that twenty percent of their data residing in their system is used eighty percent 
of the time. As data ages, archiving is normally the standard solution used to reduce data volume in the ERP 
system (see PRA Archiving [page 659] ). Archiving requires the data to be "business complete" (in other words, 
not change any more). However, certain business scenarios require aged data to be changed. Standard 
archiving is not the ideal solution for those cases, and thus SAP offers the PRA Data Management solution.

PRA PDM addresses that need to have large amounts of accessible data without the burden of having a huge 
database for common everyday usage, by splitting the data into several databases.

There are two central parts of PDM:

● PDM Engine – runs "behind the scenes" and selects the relevant instance (storage location) from the 
secondary instances. It can also merge data among instances.

● PDM Administrator Workbench – Allows the PDM Administrator to move data between instances, view 
table information, jobs, and table history (see: Using the PDM Administrator Workbench [page 844] ).

The main benefits of implementing and using PDM are:

● Decreased data volumes
● Decreased data access times
● Much more efficient SQL statement processing times

The primary PRA installation contains the current data, and the historical data is distributed across one or 
more secondary installations (instances).
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Communication between the instances occurs through a database connection:

● Primary storage (ERP system)
● Secondary storage (ERP system)

Implementation Considerations

You should implement PRA-PDM if data volumes are high enough to warrant this solution to improve 
performance. PDM offers the advantage of being able to access vast amounts of data, while simultaneously 
keeping your online database at a reasonable size. However, when access to the aged data is required, the 
access may take longer (and the complexity of the overall PRA solution increases). PDM should thusonly be 
implemented in cases in which the ability to change aged data is an absolute requirement.

All instances/databases that are set up should be in synch with your company's overall backup plan and 
recovery procedures.

Features

When a user runs a program or process in the PRA system, the PDM Engine does the following:

1. Decides which instance the relevant data is on
2. Retrieves the data from the relevant instance(s).

In addition, PDM can do the following:

● Can merge the data, if multiple instances are used
● Presents the data to the PRAprogram/installation
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● Updates the data in all relevant instances, if database updates are required by the PRA process
● Speed up SQL processing times

The PDM Administrator can decide to customize the system. For example, the administrator could set up the 
system as follows:

● Instance A = 36 month data retention
● Instance B = 60 month data retention
● Instance C = 80 month data retention

● The PDM Administrator is used to monitor and manage all PRA Data Management activities.

22.1 Using the PDM Administrator Workbench 

Use

Use the PDM Administrator Workbench to carry out all activities required for the monitoring and management 
of PDM, including:

● Obtaining a logical view of all tables in their execution groups, which have been PDM-enabled
● Scheduling and moving data among the various instances (schedule a job for data movement)
● Obtaining the current status of each table
● Obtain a list of all jobs that have been scheduled to move data for a particular table or group
● Obtain the split details for each table on each instance
● Test database connections
● Check PDM references
● Display the record count for a table: the list shows the year, the number of records in that year, and that 

number as a percentage of the records.

Procedure

● From the SAP Easy Access menu, choose Logistics Production and Revenue Accounting Tools 
Partitioned Data Management PDM Adminstrator Workbench.

The PDM Administrators' Workbench appears.

The PDM Administrators' Workbench is the central workplace for managing and moitoring PDM tables, data, 
and activities.

On the PDM Administrator Workbench, the left part of the screen is the Table List. It lists all PDM-relevant 
tables.

● In the tree control on the left part of the screen, select the relevant table, by double-clicking on it.

The table that you selected is now displayed in the right section of the screen, in the Table field. Based on the 
table you seelected, you can now select a screen tab in the right portion of the screen. The screen tabs are for 
the following:
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Table 219:

Screen tab: Allows you to:

Current status View basic information on the table: database connection, 
retention months, and nearline date. The current status tab 
displays a list of the storage locations (instances or data­
bases) for the table selected from the tree control structure 
that you selected. Each line on the list represents a different 
storage location, and allows you to see exactly how the data 
is currently split for that particular table (note that the list is 
display only).

Split logs View information on the background jobs and certain other 
details (job name, status, start time, etc.) that pertain to the 
table.

Split details View nearline data: the oldest month for which data can be 
found for that table in the secondary instance, for the table.

Move Data

Job Status

History View a high-level overview of all the data movements for the 
selected table. Whether or not the data movement was part 
of a scheduled job or it was an ad-hoc movement, the details 
should be displayed on this list.

● To schedule a job, select Define Background Job . The Define Background Job for Data Move dialog box is 
displayed. On that dialog box, select the relevant settings (group ID, global path, and Job Class (priority of 
the job), and the server name. Make your settings and then select Start Conditon , or Submit Job . the job is 
submitted and begins.

● To test the database connections, from the SAP Easy Access menu, choose Tools Test Connection(s).
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23 Destruction of Vendor Audit Table 
Content with a Data Destruction Object

You use the data destruction object OIUDP_RP_AUDIT_DELETE to destroy Vendor Audit Table content 
determined by the SAP Production and Revenue Accounting EoP utility for vendor replacement.

The data destruction object OIUDP_RP_AUDIT_DELETE is assigned ILM object OIUDP_RP_AUDIT_DELETE.

Table 220: Tables from which records are destroyed

Table Table Name

OIUDP_T_AUDIT PRA: DPP Audit Table

ILM-Related Information for Destruction Object

You use the standard fields to create ILM policies. No separate condition field is created for the data 
destruction object.

Available time reference - START_RET_DATE - Start of Retention Period.

Time offsets used are:

● END_OF_MONTH – End of Month
● END_OF_QUARTER – End of Quarter
● END_OF_YEAR – End of Year

Available Policy Categories

RST: Residence Rule

RTP: Retention Rule

Additional Checks by the Data Destruction Program

The vendor should exist in the audit table, and the retention period is considered before data destruction is 
executed.
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Defining a Variant for the Data Destruction Object

A variant can be created for the destruction program OIUDP_RP_AUDIT_DELETE_DES, which can be used 
during the execution of the data destruction via ILM (that is, transaction ILM_DESTRUCTION).

Authorization

Authorization check is done at the transaction OIUDP_AUDIT_DELETE.

Related Information

Checking the ILM Object Assignment [page 847]
Finding Data Destruction Objects [page 848]

23.1 Checking the ILM Object Assignment

This task explains how to check the ILM object assignment to the data destruction object.

Procedure

1. Execute transaction IRM_CUST.
2. Navigate to object category Specific Customizing.

Related Information

Destruction of Vendor Audit Table Content with a Data Destruction Object [page 846]
Finding Data Destruction Objects [page 848]
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23.2 Finding Data Destruction Objects

This task explains how to find data destruction object OIUDP_RP_AUDIT_DELETE proceed as follows.

Context

Procedure

1. Execute transaction DOBJ.
2. To search for the data destruction object, choose Position.
3. Double-click data destruction object OIUDP_RP_AUDIT_DELETE to view more information such as the 

data destruction program and the component.

Related Information

Destruction of Vendor Audit Table Content with a Data Destruction Object [page 846]
Checking the ILM Object Assignment [page 847]
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Important Disclaimers and Legal Information

Coding Samples
Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system 
environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and 
completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP 
intentionally or by SAP's gross negligence.

Gender-Neutral Language
As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as 
"sales person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun 
does not exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks
The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not 
warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any 
damages caused by the use of related information unless damages have been caused by SAP's gross negligence or willful misconduct. All links are categorized for 
transparency (see: https://help.sap.com/viewer/disclaimer).
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